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Introduction 

Becoming a Power Publisher 

Please don't skip this introduction. Yes, we know that many 
authors use the introduction just to say hello. Many 

readers, therefore, skip to Chapter One so they can get right 
to business. 

This introduction, however, has several crucial functions. 
First, it explains the most productive, efficient way to use 
Publishing Power with ventura. Second, it explains how to 
prepare your computer system so you can work along with the 
projects. Third, it contains a key formula you will use over and 
over again. The Thntura Formula explained at the end of this 
introduction is the foundation for the rest of the book. 

Goals and objectives 
Publishing Power with Thntura will help you tap the full 
potential of Xerox Ventura Publisher. 

It's no secret that Ventura has more horsepower than ordinary 
page layout programs. Ventura can create virtually any type 
of document, from one-page ads to 500-page directories and 
anything in between. 

With Ventura, you have the power to create almost any docu
ment. The samples on page ii were all created entirely with 
Ventura. 
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Yet with all that power at their disposal, some users complain. 
They feel like a beginning driver who hasn't learned to shift 
into high gear. They can get Ventura up and running, they can 
point it in the right general direction, but they can't seem to 
fine-tune its performance for maximum productivity. 

This book will move you into the fast lane. Best of all, it will 
show you how to stay in control the whole time. You'll know 
where to start and where to go next, no matter what kind of 
document you are preparing. In short, you will always be in 
the driver's seat. 

How do we plan to accomplish these goals? First, we put you 
behind the wheel right from the start. In every chapter, you 
"test drive" Ventura by creating an actual business document. 
There's no better way to acquire skills than with hands-on 
practice. Second, you start with simple documents before 
moving on to difficult ones. For example, Part One teaches 
fundamentals. You can follow along even if you are new to 
Ventura. Part Two, on the other hand, shows how to rev up 
your publishing with advanced techniques. 

Don't be too impatient. Ventura Publisher is one of the most 
powerful applications ever written for the IBM PC. It will take 
some time before you reach expert status. To make the journey 
easier, we start each project with a roadmap, a before-and
after look at the document that shows where you are starting 
and where you are going. As we proceed, we provide you with 
signposts to check your progress. Simply check your results 
against the sample screens and printouts. You will always 
know if you're on the right track. 

Why this Book is different 
Publishing Power with Ventura differs from other books and 
tutorials. First, it is not just a beginner's session. It is a 
complete training course in Ventura, from novice to advanced. 
Second, it takes you step-by-step through real-life applica
tions. If you complete all the chapters, you will have a per
sonallibrary of industrial-strength business documents and 
style sheets. You will also have the skills to modify those 
documents to fit the unique requirements of your business. 
Third, Publishing Power provides more than how-to skills. It 
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also teaches you strategies, systems, techniques, and for
mulas for working through design problems. 

We believe that if you follow the examples in this book, you 
will be able to gain full control over Ventura's sophisticated 
capabilities. You will be able to create virtually any kind of 
document - books, ads, newsletters, manuals, forms, reports 
- right on your desktop. 

Now that's true publishing power. 

How to use this book 
Publishing Power with Ventura contains two sections. Part 
One, Getting Started, teaches basic skills. Part Two, Ad
vanced Documents, teaches advanced techniques as they 
apply to specific business applications. Part Two also includes 
a chapter that teaches the advanced features of Ventura's 
Professional Extension. We recommend that everyone com
plete Part One (Chapters One, Two, and Three). Even ex
perienced Ventura users should skim Part One, because it 
does more than clarify basic features. Part One also provides a 
systematic plan for using Ventura. The advanced chapters in 
Part Two assume that you understand the building blocks 
explained up front. 

How to use part two 
AI though Part One is essential, not everyone needs to go 
through all of Part Two. The method you use for the second 
half will depend on your needs. If you are an occasional user, 
produce only one type of document, or are short on time, select 
chapters that teach the skills you need right now. If you later 
expand to different documents, return to Part Two to learn 
more. Table 1 suggests an abbreviated curriculum based on 
the type of document you produce. 



How to use part two v 

Table 1. An Abbreviated Curriculum 

Document to Produce Chapters to Study Key Skills 

Part One Basic skills 

Multi-Chapter, footnotes, indexing, 
Chapter Eight - A Book table of contents, equations, update 

Books counters, chapter templates 

Chapter Nine - A Technical Manual Frame anchoring, auto-numbering, 
figure numbering, spot color 

Chapter Ten - Using the Profes- Advanced typography, cross refer-
sional Extension ences, tables 

Corporate Part One Basic skills 

Documents Chapter Four - An Invoice Box Text 

Part One Basic skills 

Chapter Seven - A Directory Preformatting text, databases and 
Directories, Ventura, chapter templates 

Catalogs Multi-Chapter, footnotes, indexing, Chapter Eight - A Book chapter templates 

Chapter Nine -A Technical Manual Frames and anchoring, auto-number-
ing, figure numbering 

Part One Basic skills 

Marketing Chapter Four - An Invoice Box Text 

Chapter Five - An Advertising Flyer Advanced graphics and typography 

Chapter Nine -A Technical Manual Spot color 

Part One Basic skills 

Chapter Three - A Two-Column- Newsletter-style layout, captions 
Newsletter sizing and scaling images 

Newsletters, Magazines Chapter Four - An Invoice Box Text 

Chapter Five - An Advertising Flyer Advanced graphics and typography 

Chapter Six - A Three-Column- Advanced newsletter-style layout, 
Newsletter captions, table of contents,calendar, 

Chapter Ten - Using the Profes- Advanced typography sional Extension 
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On the other hand, if you plan to use Ventura for many 
different documents, try to finish Part Two from start to 
finish. Completing all ten chapters guarantees that you will 
understand Ventura's full range of features. 

If you have installed the Professional Extension 
If you have installed Ventura's Professional Extension, your 
screen will show several more dialog box options than the 
sample screens in this book. Do not be concerned if your 
screen looks slightly different. It will not effect your ability to 
complete the step-by-step instructions. 

We suggest you master the basics in Chapters One through 
Nine before you tackle the advanced table editing and typo
graphic features of the Professional Extension explained in 
Chapter Ten. 

How each chapter is organized 
Each chapter is divided into four sections: skills checklist, 
theory, tutorial, and tips. The skills checklist at the beginning 
gives you an overview of learning skills and key words. A 
glance at the list tells you what you will learn. 

The theory section discusses the concepts and principles be
hind each chapter. Take the time to read the background 
information before you start the hands-on project. That way 
you will understand why you are making specific selections. 

The tutorial section includes detailed instructions in bite-size, 
easy-to-follow steps. Usually, you can produce the desired 
result just by imitating the sample screens. 

Finally, the tips section summarizes and expands on the tech
niques mentioned throughout the c~apter. Some people like to 
skim through these tips before starting. 

A note to instructors 
If you are using Publishing Power for classroom instruction, 
you should know that each chapter has one or more stopping 
points. If you have time for extended sessions, ignore them 
and proceed straight through. However, if you want to pause 
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periodically, you will find clearly marked break points, with 
instructions on how to stop and resume. 

Instructors may also want to assign advance reading. We 
suggest that students prepare by reading the theory section at 
the beginning and skimming the tips section at the end. 

A final tip for instructors: If you want to focus on certain 
techniques, you can confine the classroom session to one por
tion of a chapter. Step through the project yourself up to the 
point at which you wish to begin. Save your work and dis
tribute this partially completed chapter to students on floppy 
disks (or via network). Have the students load up the partially 
completed project at the beginning of the session. That way 
you and they can concentrate only on the specific skill you 
wish to present. 

The ground rules 
While we are explaining how to use this book, we should 
acquaint you with a few gr.ound rules. The checklist that 
follows spells out six conditions. These are the assumptions 
that operate during the self-paced publishing projects. Before 
starting with Chapter One, make sure that your system 
matches all six. 

WARNING: You may have difficulty recreating the examples if you do not meet all the 
assumptions explained below. 

1. You are using Ventura 2 or higher. The sample projects in 
this book use Ventura 2 features. If you have installed the 
Professional Extension, your screen will include Table mode 
(in the Side-Bar) and several additional dialog box options. 
The slight variations you see between your screen and ours 
will not affect your ability to follow along. 

The sample style sheets on the accompanying Publishing 
Power software disk will not work with version 1 or 1.1 Con
tact your local dealer or Xerox for upgrade information if you 
are working with the older version. 

2. Ventura is located on drive C:. If you use a different letter 
for the hard disk containing Ventura, substitute that letter 
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whenever you see C:. Consider, for example, an exercise that 
asks you to move to the C: \POWER subdirectory. If your hard 
disk is D:, you would type D: \ POWER instead. 

3. You have the original Ventura examples intact on the 
C: \ TYPESET subdirectory. If you have moved these style 
sheets or picture files, or if you have modified them in any 
way, copy the originals from the Ventura installation disk 
labelled ''Examples.'' The command "COpy A: &*. STY 
C: \ TYPESET" will copy all the style sheets you will need for 
this book. The commands "COpy A: * . IMG C: \ TYPESET" and 
"COpy A: *. GEM C: \TYPESET" will copy all the picture files 
you will need for the book. You do not need to copy these files 
unless 1) you have erased the examples or 2) you answered 
"no" during installation when Ventura asked if you wanted to 
install the examples . 

.. NOTE: If you have modified the example style sheets in any 
way, delete or move them from the \ TYPESET subdirectory 
and recopy the originals from the installation disk. 

4. You have a Hercules-compatible graphics adapter. The 
sample screens in this book were created from a Hercules
compatible monitor. If you have a VGA, an EGA, a CGA, or a 
big-screen monitor instead, your display may look slightly 
different than the illustrations. This should not affect your 
ability to follow along. 

5. You use a mouse. To gain the maximum productivity from 
Ventura we recommend a mouse. If you do not have a mouse, 
refer to the section "Operation without a mouse" in the Xerox 
Ventura Publisher Reference Guide. 

6. (Optional) You have installed PostScript as one of your 
printer choices. Although you can follow along without install
ing a PostScript printer, a few of your dialog boxes will look 
slightly different from the examples. You may want to install 
PostScript as a second printer while you work through the 
projects. That way your screen will match our examples. You 
can quickly and easily install PostScript as a printer choice 
even if you do not own a PostScript printer and even if you 
have already installed Ventura. Simply reinstall the program. 
When it asks if this is the first time you are installing, answer 
No. Then select PostScript as one of your printer choices. 
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printer choices. When you load Ventura, select Set Printer 
Info from the Options menu and change to a PostScript 
printer. Before you print at the end of each chapter, switch 
back to your original printer. 

Rules for Ventura prep 
Each chapt~r contains a section called Ventura prep. This 
section explains the file management operations to create the 
sample document. These operations include loading and 
renaming text files, loading and renaming style sheets, load
ing graphics files, and saving chapters. What you do in this 
section depends on whether or not you own the Power disk. 

The Power disk 
The optional Power disk contains the sample text files from 
Appendix A, thereby saving you the trouble of typing them in 
yourself. In addition, it has style sheets and, in a few cases, 
sample chapters, for the advanced documents in Part Two. 
These samples give you a headstart. You can order the Power 
disk with the postage-free card at the back of the book, or by 
phoning New Riders's toll-free number. 

If you own the Power disk 

If you already own the Power disk, go to Appendix C to learn 
how to install it on your hard disk. During the tutorial, turn to 
the Ventura prep subsection marked with the disk icon: 

I!!I!I!~I!I!I!I 
If you do not own the Power disk 

Appendix A gives a complete print out of all the text files and 
the style sheets used in the book. If you do not own the Power 
disk, turn to the subsection in Ventura prep displaying the no 
disk icon: 



x The Ventura formula 

This section will tell you which text file and style sheet to copy 
from Appendix A. 

The Ventura formula 
One important task remains before you are ready for Chapter 
One: a brief explanation of the strategy that forms the founda
tion for this book. Every Ventura document, no matter how 
complex, is made up of just three parts: text (the words), a style 
sheet (the format), and pictures (the illustrations). Typically 
the text comes from word processing files and the pictures 
from graphics files, while the style sheets are created with 
Ventura Publisher. This formula helps explain how the 
software operates. It also becomes a good model for working 
with Ventura Publisher: 

Text + Style + Pictures = Chapter 

This formula illustrates not only the components, but also the 
best order for building a document. As we will show you, this 
simple idea is a powerful tool. It can serve as a blueprint for 
any document, long or short. Table 2 illustrates how the For
mula will guide the construction of our projects. 

Table 2. Using the Ventura Formula 

Text Load the text file(s) 

Style 
Load a style sheet 

Apply it to the text file 

Pictures 
Create the frame(s) for the picture(s) 

Load the graphics file(s) into the frame(s) 

Chapter 
Save the chapter 

Print the chapter 

As Ventura authors and consultants, we've talked with 
hundreds of users. Most have similar troubles. When con
fronted with the complexities of page design and the power of 
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Ventura, they don't know where to start. They flounder be
cause they don't have a systematic approach. When they do 
get underway, they get lost among the menus. Or they forget 
key steps and have to redo the document. In short, they're 
often a bit confused. 

It doesn't have to be that way. As you will see in the next three 
chapters, the Ventura Formula can rescue you from confusion. 
No matter how complex the project, you can always fall back 
on the Formula. As you grow proficient, you may decide to 
modify the Formula or abandon it entirely. As you are learn
ing, however, it should be the foundation for everything you 
do. We have used it throughout this book. 

Rather than belabor the theory, let's see it in practice by using 
the Formula to prepare a business report. Turn to Chapter 
One for your first hands-on Ventura project. 



Chapter One 
Skills Checklist 

Theory 
o How Ventura manages files and 

builds chapters 
o Renaming and relocating files with 

Ventura prep 
o The Ventura user interface 
o Multi-Chapter - a built-in copying 

function 

Text 
o Loading and placing text 
o Renaming and relocating text 

I 

Style 
o Loading a style sheet 
o Renaming and relocating style sheets 
o The Ventura Formula - easy rules 

for faster formatting 
o The secret of the "Big Three" dialog 

boxes 
o Why you should always start 

formatting with Body Text 
D How to create a standard spacing unit· 

Picture 
o Adding a frame 
o Using padding to separate text from 

pictures 
o Loading and placing a picture 

Chapter 
o Saving and printing 
o How to back up Ventura chapters 
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A Single-Column Report 

Theory 

Ready to start putting Ventura through its paces? This first 
chapter provides a solid grounding in Ventura fundamen

tals. It also demonstrates how the Formula guides you step
by-step through a work session. The checklist to the left sum
marizes some of the skills you will acquire. You will find a 
similar list in every chapter. 

A few preliminaries before we begin. All the projects in this 
book start with a before-and-after look at the document. In 
other words, we start by showing you where you are going. 
Then it's on to the sample project. In most cases, you can 
produce the results just by imitating the screens on the page. 
When you see an explanation followed by an illustration, 
simply make your dialog box match the one in the book. 

That's all there is to it. Merely by following along, you will 
learn to handle Ventura like a pro. 

We know you are eager to get started. Before you get behind 
the controls, however, you need to understand a few fun
damentals. The hands-on practice will make more sense if you 
understand how Ventura manages files. 

Parts of a chapter 
Most other programs do all their work in one large file. By 
contrast, Ventura works with many different files. A master 
file, called the chapter file, stores pointers to other files, plus 
instructions on how to assemble these files onto the page. 
When you format on screen or print on paper, the chapter uses 
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instructions on how to assemble these files onto the page. 
When you format on screen or print on paper, the chapter uses 

Text 

Chapter 

Figure 1·1. Ventura chapter files contain pointers that specify the 
location of the other component files. 

its pointers to find the files it needs, and then uses its instruc
tions to put the document together (Figure 1-1). 

What kinds offiles go into a document? The Ventura Formula 
provides the answer: 

Text + Style + Pictures = Chapter 

As Ventura builds a document, it creates additional files on its 
own if it needs them. For instance, if you put captions on the 
page, Ventura creates a separate caption file. If you use the 
drawing tools, Ventura opens a graphics file. When it opens 
these files, Ventura uses the same name as the chapter, but 
with a different extension. Thus, if the chapter is called 
SAMPLE.CHP, the caption file becomes SAMPLE.CAP and 
the graphics file SAMPLE.VGR. Table 1-1 gives a more in
depth look at the components of a typical Ventura chapter. 

Renaming and relocating files 
One more bit of theory about Ventura's file management and 
you will be ready to start the project. Ventura permits you to 
rename and/or relocate most of the files that make up a chap
ter. Ventura doesn't care where you store those files, as long as 
you tell it where to find them. 
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Table 1-1. Typical file names for a Ventura chapter 

File Type File Name(s) File Contents 

Text file created with word proces-
SAMPLE.TXT sor and imported into Ventura (can 

TEXT 
be more than one) 

Caption file created and named by 
SAMPLE.CAP Ventura to match the chapter 

name 

STYLE SAMPLE.STY Style sheet with format instruc-
tions 

Picture file created with outside 

PICTURE.IMG graphics program and imported 
into Ventura (can be more than 

PICTURE one) 

Ventura graphics file for drawings 
SAMPLE.VGR created inside Ventura to match 

the chapter name 

SAMPLE.CHP Chapter file containing pointers to 
all other files 

CHAPTER 
Chapter information created and 

SAMPLE.CIF named by Ventura to match the 
chapter name 

In Ventura's eyes, the location of a file is part of its name. The 
four files below are completely different as far as Ventura is 
concerned: 

A:\SAMPLE.TXT 
C:\SAMPLE.TXT 
C:\TEMP\SAMPLE.TXT 
C:\POWER\SAMPLE.TXT 

Renaming and relocating are accomplished in the same 
fashion (in fact, we use the word rename to mean either 
function). Although the procedure is slightly different for dif
ferent files, the principle is the same. By entering a new name 
and/or a new location, you tell Ventura where to find it in the 
future. 
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• You make a copy of the file under the new name at the new 
location (you will have to delete the old one if you don't 
want it anymore). 

• You change the pointers in the chapter file. From then on, 
Ventura looks for that file under the new name in the new 
location (Figure 1-2). 

C:\ POWER 

CHAPTER 

C:\TEMP 

C:\POWER\ 
NEW.TXT 
'1111. 1. Gn.& T .. t. TIIit S. aw. 
OrwlL'DI:d.'l'b» .. ",, __ Owu 
~AarI"»""lIOnar.. _0..._,.. ...... "'"' .... 
olOnok-.8WI_lhokllox!. 

Figure 1-2. When you save and rename a file, you change 
the pointers in the chapter file. From then on, Ventura looks 
for that file under the new location. 

WARNING: Do not use standard DOS functions to move Ventura chapters. Use 
Ventura's Multi-Chapter function instead, as taught at the end of this chapter. 

DOS is able to copy files, but it does not change the pointers 
inside the chapter file. If you reopen the chapter at the new 
location, Ventura will be unable to reassemble the document. 
It will look for the files in their old locations, because the 
pointers were never changed. 

By contrast, Ventura's built-in copying function not only 
moves the files, but changes the pointers as well. In addition, 
it moves all the files at once. By telling Ventura to copy a 
chapter, you are telling it to copy not only the chapter file, but 
also every other file associated with that document. You do not 
have to specify the individual files. Ventura remembers them 
for you, finds them on the disk and copies them to their new 
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location. This copying function is located in the Multi-Chapter 
dialog box. 

- TIP: Even though the name Multi-Chapter implies that it is 
intended only for multiple chapters, you can also use Multi
Chapter to copy a single chapter. You will have several oppor
tunities for hands-on practice with Multi-Chapter in both Part 
One and Part Two. 

So much for your first exposure to the principles behind Ven
tura Publisher. You will need to learn additional theory before 
you're ready to strike out on your own. In the meantime, 
however, we suggest concentrating on the project that follows 
without worrying too much about the wherefores and whys. 
We will present more fundamentals in Chapters Two and 
Three. 
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Report on InstallatIon and ImplementatIon of 
Ventura Publisher 

Executive Summary 

Before 

XYZCorporatioDbla6mbarll:cdo.ll.propamtoim.pleme4tVed.IftPublilba'~ftwat(l.OD 

o.xiatinamMAT..c:omp.tibiecomputcrsu~1bro .. boutu..C:OIDfNly. TbcIMukotdlJ; 
CommuDcattoDa dcpartmout will ovcnco and. ~fYilO 1hia project. Mubtill. eo .. 
munictltto"mak:CllltbofoUowiIIoS~ 

.UJ,e.ofVoDlUraio_orydcpattDlaltfOfaDpv~uaiGatioDiltM.b 

• Deaisnatioaofanin-holBCdcaktoppublilhia.sspocialiatwiOlNpOGlibili.tytOl' 
traiDi.DS.~ao;1~ 
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«lmpaa.y. Company-wide UKo(Vormra willrcduc;epubliahiDs/priD.tiIllcoUl by :U1ll0,," 
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minltmUD.tandardaror5rapbiedcaiSDaDI1qUlllity;aD4.udoi;umoDtI~by1b6pWlic 
will rcil1foru tho aamo UnIIS'O-

We have idcmified potential use.a m liv-o dcpart:mcda; IDCft wiD ~ do"tClopcd" UMa 

becom6 mo~profieieat with VtDturaald dac:over ...... pplic:atio. 

AccountlngO"pirtma:nt: 
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Report on Installation and 
Implementation of Ventura 
Publisher 

Executive Summary 

XVZ Corporation has BtT1be.rked on a program to '""lament 
Ventura Publisher softWl1/'e on existing IBM AT-compatible 
cofTlJutersasneeded throughoutthecDmpany_ The Marketing 
Cornrnmicatlons department witl oversee and supervisethl. 
project. Marketing Communications make. the tollowlng 
recommendations: 

• Use of Ventura In wary department tOt all publishingJcom
rrunicatlonstuks 

• Designation of an In-house desktop publishing specialist 
with respansibfllty for training, maintenance and standards 

• A company-wide training program to teach basic Ventura 
skill, 

• AdvancedworkshopB ss needed to teach spaclallzed skills 

Use of Ventura Company-WIde 

Thethree-month pilot program undertaken by Marketing Cam· 
rnmlcatlons has deterrrined that Ventura Publisher can be 
used far fNery type r:I document currently produced by the 
cofTlJany. Company-wide use of Ventura will reduce publish· 
lng/printing costs by 35% (Her the nmet two years (see chart 
next pagel. It will reducetha confUSion and duplication af start 
now In evidence, Whereby fNfYl/department l'Iad dfNeioped 
different (and often incompatible) solutions to publishing 
problerrs. It will also perrritthe company to establish and 
enfarcBBppearanceand Imege &tandl1/'ds. Since Ventura Pub· 

Theory 

After 
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Planning the report 
The first step in producing a business document is to consider 
its purpose and audience. Your goal is two-fold: (1) to make the 
appearance appropriate to the readership and (2) to make the 
document easier and more efficient to use. Ventura's vast 
array of capabilities can help you achieve both goals. 

Our first project is a business report. We use the word "report" 
to refer to a simple, straightforward document, usually in
tended for internal use (as opposed to proposals and annual 
reports, which often go outside the company). Target readers 
are other members of the company, usually at your own level 
or higher. Since reports often summarize difficult or dull infor
mation, they must use page design to make that information 
easily accessible. They should include charts, graphs, and 
other illustrations when possible, to help get the message 
across. 

Because a report is an internal document, it does not demand 
high-end, cutting-edge graphic effects. At the same time, be
cause most reports go up the ladder to management, they 
need a professional image: clean, simple and uncluttered 
without being loud or flashy. Look at the ''before'' example of 
the report. It is a typical report from the days before desktop 
publishing. Here are a few ways to enhance its effectiveness 
and appearance: 

• An easy-to-read line length 

• Bullets to make lists stand out 

• A header and page numbers to help readers find their way 
around 

• Prominent headlines and subheads 

• Spacing based on a uniform, standard unit 

• Additional white space for an open look 

You will implement these ideas in this project. 
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Before you start 
We assume that you are sitting in front of your computer with 
Ventura Publisher on the screen. If you have not already 
powered up Ventura, type: VP at the DOS prompt (VPPROF if 
you are using the Professional Extension). 

II If you have the Power disk 
If you are using the optional Power disk, you should have 
installed it already following the instructions in Appendix C. 
If not, stop and do so now. 

If you do not have the Power disk 
You do not need to do anything special yet. Read on. 

If you just started Ventura, the screen will be empty. If not, 
and there is a previous document active, select New from the 
File menu to clear the screen. Do not worry about what file 
names appear at the top of the screen. You will be changing 
the files you use anyway. 

The Ventura user interface 
Your screen should look similar to Figure 1-3. If it does not, 
select the View menu and Reduced View. If you are new to 
Ventura, take a moment to familiarize yourself with the key 
features of the Ventura user interface as shown in Figure 1-3. 

The Menus at the top of the screen drop down when you point 
to a name with the mouse cursor. Move the cursor over the 
menu you want until it is displayed in reverse video (white on 
black). Then click the left button on your mouse to select an 
option. Menu options displayed in gray are not available for 
selection. 

The Title Bar displays the current chapter and style sheet. As 
you step through the projects in this book, check to make sure 
the names of the chapter and style sheet in the Title Bar 
match the ones we show in the sam pIe screens. 
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Menus ----+I 

Zero point 

Mode Selector 

Title Bar 

Addition Button - __ _ 
Scroll up 
one line 

Vertical 
scroll bar 

Assignment List 

Current Selection 
Box 

Page Number 
Horizontal L:l.. ______________ .....!;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;i!1::1 scroll bar 

Figure 1-3. The Ventura interface. 

The Mode Selector shows four pictures at the top of the Side
Bar. Each picture represents one of the four major modes in 
Ventura: (from left to right) Frame, Paragraph, Text, and 
Graphic mode. In Figure 1-3, Frame mode is enabled. Each 
mode allows you to perform a group of related tasks: 

• Frame mode lets you create new frames on the page and 
place text and pictures inside. You can also cut, copy, paste, 
or delete frames. 

• Paragraph mode lets you define, change, and apply a set of 
formatting rules, called tags, to individual paragraphs. 

• Text mode lets you add or delete text on -screen, as well as 
change its font and attributes (for example, bold or italic). 

• Graphic mode lets you. add, delete, copy, size, or paste 
graphic lines, rectangles, circles, and Box Text (text inside 
a box). 

The Addition Button lets you add a frame, tag, or text at
tribute, depending on which mode is enabled. Click on the 
Addition Button to choose the action (or function) specified in 
the Addition Button. 

The Assignment List displays an alphabetical listing of items 
that you can choose for Frame, Paragraph, and Text mode. (In 
the Professional Extension, items are listed for Table mode.) 
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Pop-up menu 

Button controls 

Before you start 

The Current Selection Box shows the name of the selected file, 
tag, graphic, or text attribute. 

The Page Number shows the number and side (Right or Left) 
of the page. / 

The Sizing Buttons (also known as ''handles'') show the frame 
that is currently selected. 

The Column Guides display the borders of the columns. You 
can turn them on or off. They do not print out. 

The Page (referred to as the Underlying Page in earlier ver
sions of Ventura) is the blank frame that appears when you 
first start Ventura or when you select New from the File 
menu. You define the size and orientation of the Page in the 
Page Size & Layout dialog box from the Chapter menu. You 
can place text and pictures directly onto the Page, or you can 
put text and pictures into frames on top of the Page. 

-NOTE: If you are using the Professional Extension, you have 
a fifth mode called Table mode. See Chapter Ten. 

The other key feature of Ventura's user interface is the dialog 
box. Let's take a moment to review the major controls inside 

" (Figure 1-4). 

SIZING & SCALING 

Upper left X: 
Frane Width: 

c::J ~r left Y: 29,08 a c:] 
FrClte Height: 14,00 

[!] - Help menu 

Horiz. Padding: Vert. Padding: 00,00 picas & points - Measurement 

Picture Scaling: I Fit in Fra~e I """i.l(1 
Aspect Ratio: I Maintained I ',M'M' 

X Crop Offset: 01,00 Dc::J YCropOffset: 92,01 Dc:] 
Scale Width: 26,00 Scale Height: 16,09 

m I Cancel I 

Figure1-4. 
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Pop-Up menus appear when you place the cursor over an 
option followed by the double up-down arrow symbol. The 
pop-up menus show you all possible choices available for one 
option. To make your choice, place the cursor on the arrow 
symbol and click the left mouse button. Now hold down the 
button and drag the cursor up or down until you highlight the 
option you want, then release. 

'-NOTE: For easier viewing, we've chosen to hide the up-down 
arrows in all our illustrations. 

Help menus are included in each dialog box. To get on-line 
help, click on the question mark inside the square and follow 
the prompts. 

At any point you can cancel a dialog box choice by pressing 
Ctrl-X. To save your choices in a dialog box, press the Enter 
key or click the OK button. You'll get plenty of practice using 
dialog boxes as soon as you begin the tutorial section. 

Our starting configuration 
Ventura Publisher is easier to work with if you use the Op
tions menu to make the selections shown in Table 1-2. There's 
nothing that says you can't configure Ventura differently. 
However, our experience has shown that these settings make 
page design easier and more accurate. 

As you progress, you may decide to use other settings that you 
find more suitable to your own working style. In the begin
ning, however, we suggest that you follow these suggestions. 
Otherwise, your display and your results may differ slightly 
from ours, making it more difficult to follow along. 

Take a moment now to make sure all your settings in the 
Options menu match those shown in Table 1-2. Select th~ 
Options menu and choose each option in turn. 
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Table 1-2 Suggested settings for use with this book 

Option Setting What It Does 

Generated Tags: Shown 
Displays tags created by Ventura at the bottom of the 
Assignment List 

Text to Greek: 6 
Speeds screen redraw by showing unreadably small 
text as blocks 

Set Preferences Keep B~ckup Files: Yes 
Ventura automatically makes a backup copy of all 
related chapter files each time you save 

On-Screen Kerning: None 
Speeds up screen drawing by eliminating screen 
kerning 

Auto-Adjustments:None Does not automatically adjust the inter-line spacing 
when you change the font size 

Pop-Up Menu Symbols: Shown Displays arrow symbol next to choices that offer 
pop-up menus in dialog boxes 

Horizontal and Vertical Units: Displays ruler in picas to match the units we use in 
Picas this book 

Set Ruler 
Horizontal Zero Point: 00,00 picas Sets the zero point at the upper left corner of the 

Vertical Zero Point: 00,00 picas Page 

(Optional) Can be used even if you do no have a 
Device Name: PostScript PostScript printer so font dialog boxes match those 

Set Pri nter Info in the book 

Width Table: Uses the default width table so style sheet can be 
WENTURA\OUTPUT.WID interchanged between systems with different printers 

Show Side· Bar Menu reads "Hide Side-Bar" Displays Side-Bar on left side of screen 

Show Rulers Menu reads "Hide Rulers· Displays rulers on top and left side of the Page 

Show Column Menu reads "Hide Column Displays lines to show the boundaries of the 

Guides Guides" columns. Makes it easier to line up frames on the 
Page 

Show Tabs & Menu reads "Hide Tabs & Displays on-screen the visible marks in the text 

Returns Returns" denoting tags, returns, line breaks, footnotes, etc. 
Makes text editing easier 

Turn Column Display reads "Turn Column Snap Forces frames to align with the edges of the column 
Snap On Off" 

Turn Line Display reads "Turn Line Snap Forces the frame to align vertically with the Inter-line 
Snap On Off" spacing of Body Text 
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When you are finished, check that your settings in the Set 
Preferences dialog box and in the Options menu match ours in 
Figure 1-5 and Figure 1-6: 

Set Preferences ... 
Set Ruler ... 
Set Printer Info .. . 
Add/ReMoYe Fonts .. . 

Hide Side-Bar AW 
Hide Rulers 
Hide ColUMn Guides 
Hide All Pictures 
Hide Tabs & Returns AT 
Show Loose Lines 

Turn Collum Snap Off 
Turn Line Snap Off 

t1ulti - .n.i'.n.-~F'!"" 

Figure 1-5. 

SET PREFERENCES [!] 
Generated Tags: Shm"n 

Text to Greek: 6 
Keep Backup Files: Yes 

Double Click Speed: 3 
On-Screen Kerning: None 

Auto -Adjustrrlents: None 
Pop-Up Henu Syrrlbols: Hidden 

Henu Type: Drop -Dm"n 

Decimal Tab Char: 046/ (ASCI I) 

OK I Cancel I 

Figure 1-6. 

If you cannot duplicate the results in a project, check to see 
that you are configured as shown in Figure 1-5 and Figure 1-6 . 

.. NOTE: You will/earn more about these settings as you work 
through the projects in the book. 
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Step one - file maintenance 
If you don't tell Ventura where to put a file, it defaults to the 
location used last. The original default location is the 
C: \ TYPESET subdirectory. Many beginners continue to store 
all their files in that one single directory. It soon becomes too 
crowded. 

If you installed the optional Power disk for this book, you 
created a subdirectory called C:\POWER. This subdirectory 
stores sample documents and style sheets - the starting 
points for your documents. As part of this first project, you will 
create a subdirectory to store the results. From now on, you 
will always place your documents into this new subdirectory. 
Although you can create subdirectories in DOS, you can also 
do so within Ventura. Let's try it right now. Follow the step
by-step instructions below at your computer to create a sub
directory called C: \ TEMP. 

W Select DOS File Ops from the File menu. 

N~:lB 

Open Chapter ... 

Save AS 
Save As ... 
nb<':lr~~'k)r~, , , 

load Text/Picturoe .. . 
load Diff. Style .. . 
Save As New Style .. . 

To Proint ... 

1m Move the cursor to the File Spec line and click once. Then 
press the Esc key to clear the line. Type: c: \TEMP 

W Choose Make Directory and Done. 
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DOS FILE OPERATIONS 

File Spec: C:\TEMPI--I __________ _ 

Operation: I Select Different File Specification I 
ItMWm§ddi1i@ij I Remove Directory I 
I Delete Matching File(s) I 

Done 
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If you already have a C: \ TEMP subdirectory, choose another 
name. In future chapters, substitute that name whenever you 
see C:\TEMP . 

.. TIP: The best way to organize the hard disk is to create a 
separate subdirectory for each project, and use it to store al/ 
the files for that project - text, style, pictures, and chapter. 

Ventura prep 
File management is one of the most difficult aspects of 
desktop publishing . Novice users sometimes encounter 
problems: 

• They can't find files when it comes time to load them into 
Ventura 

• They use the DOS copy command improperly and cannot 
get the chapter to load 

• They make permanent, unwanted changes to original text 
files 

• They destroy new versions by copying the old one on top 

• They forget to save and thereby lose their work 

To avoid such problems, you will start every project with a 
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Ventura prep section. You will load, rename, relocate, and 
save all the files for the exercise before you begin working. 
After you practice this file maintenance a few times, we hope 
it will become a habit. 

By taking these steps at the beginning of every document, you 
can avoid losing work. In addition, you can easily take a 
break. Because all the files you will need are already loaded 
and renamed, all you have to do is save the chapter and quit. 
When you are ready to resume, you simply load Ventura, open 
the chapter and start where you left off. 

WARNING: Renaming and relocating files does not take effect until you save the 
chapter. If you quit without saving, you lose the benefit of the Ventura prep process. 

You will step through the Ventura prep section in the same 
order as the Ventura Formula: text, style, pictures, chapter. If 
you are used to working with DOS, it may take you a few 
times before you are comfortable with Ventura's methods. 
Although you can type in paths and file names, as in DOS, it 
is usually faster to navigate with the mouse. 

We will step you through the Ventura prep process the first 
few times until it becomes second nature. It may seem lengthy 
at first, but with experience you can perform the entire 
process in a few moments. 

II If you have the Power disk 
Follow the steps outlined below to load, place and rename a 
text file called 1 RPRT. TXT. This text file is provided on the 
optional Power disk. If you did not purchase the disk, skip to 
the section below titled "If you do not have the Power disk." 

When you load text, Ventura retrieves the original word 
processing file. It does not make a separate copy. It temporari
ly places hyphens in this file, then makes it a permanent part 
of the chapter by storing a pointer. This pointer tells Ventura 
where to find the text file the next time the chapter is loaded. 

m Select Load TextiPicture from the File menu. 



Step one - file maintenance 

-_ ...... 
t-k~B 
Open Chapter ... 

Save 
Save As ... 
f-lb<':lr~don, , , 

load Text/Picture ... , 
load D~ff. Style .. . 
Save As New Style .. . 

To Print ... 
DOS File Ops ... 
Quit 
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~ Choose Type of File: Text, Text Format: ASCII, # of Files: 
One, Destination: List of Files, and OK. 

LOAD TEXT/PICTURE IT] 
Type of File: .. I Line-Art I I I~age I 
Text Forfllilt: I Generated I rmm I WordStar 3 I I WS 4.8/5.9 I 

I MS-!ford I I WordPerfect I I ~M~l'ite I I B-Bit ASCII I 
~ I MultiMate I I PRN-to- Table I Ilfol'dPerfect 5 

I Writer I 
II of Files: liD I Sevel'al I 

Destination : ImlDlDIi I Text Clipboard I [I!~iifJ[~~;.~;.;:;EJ 

~ I Cancel I 

The Item Selector dialog box appears. Its listing shows both 
file names and subdirectories. Subdirectories are distin
guished by a diamond in front of the name. 

In the next section, you will practice moving around the hard 
disk with the mouse. To move "backward," you click on the 
Backup button in the upper lefthand corner of the listing box. 
To move "forward" to a given subdirectory, click on the 
diamond that precedes its name, or the subdirectory name 
itself (Figure 1-7). 
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ITEM SELECTOR .:'" File filter 

Directoryline - Directory: C:\TYPESEQ _________ -II 

Backup button Selection: 1-1 __ . ~ f- Selection line 

Subdirectory name - -. BUS INESS t 
I--+ NEWSLET 

+ TECHDOCS 
&BOOK-P1.STY 

File name &BOOK-P2.STY 
&BRO-L2 .STY 
&BRO-P3 .STY 
&INV-P1 .STY 
&LSTG-P2.STY 

.. f- Scroll bar 

I I OK 
,;;;;;;;;;. 

," f-- Scroll arrow I Cancel 

Figure1-7. The Item Selector lets you locate any file on your 
hard disk. Use the Backup button to move to the next 
higher level of subdirectories. Open a subdirectory by click
ing on the diamond or the subdirectory name. 

To move to a new subdirectory, click on its name: 

1m Click on the Backup button until the C: \POWER subdirec
tory appears on the list (preceded by a diamond). Click once 
on the diamond or the name to move to that subdirectory. 
The Directory line now reads C:\POWER\*.TXT. 

To find the file you need, click on the scroll arrows to move 
down or up one line at a time. Click on the gray area to move 
one screen at a time. To move a distance you select, press and 
hold the mouse button to drag the scroll box in the direction 
you want to move. 

!ill Use the scroll box and arrow to scroll through the list of text 
files until you see 1 RPRT. TXT. 

~] Select the file 1 RPRT. TXT by clicking once on 1 RPRT. TXT 
and once on OK. 



Place the text file 

ITEM SELECTOR 

Directory: C:\PO\tIER\*.THT _______ _ 

1RPRT • TXT 
2PROPOS .TXT 
3tiEWSHED.TXT 
3NB~SLGO . nn 
3tiEWSOtiE.TXT 
3tiEWSTWO.TXT 
SAD .TXT 
6NEWSL T1. TXT 
6tiEWSlT2.TXT 

Se lection : 1 RPRT . nnl 
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-NOTE: Once you click on a file, its name appears on the 
Selection line. You can also select a text file by typing the 
name directly onto the Selection line and clicking OK or press
ing the Enter key, or by double-clicking on the file. 

Ventura loads the file and the name lRPRT.TXT appears in 
the Assignment List. If the Underlying Page is selected when 
you load a text file, Ventura automatically places the file on 
the Page. 

-NOTE: If you are in Paragraph, Text, or Graphic mode when 
you load a file, Ventura will not place the file on the Page. 

If you do not have the Power disk 
To follow along, you will exit Ventura and load a word proces
sor. You will type the text lRPRT.TXT from Appendix A and 
save it in ASCII file format under the name and location 
C:\POWER\lRPRT.TXT. Then you will return to Ventura 
and follow the steps in the section above for loading the text 
file. 

Place the text file 
After you load a text file you must place it - that is, tell 
Ventura where you want it to appear. You can place text onto 
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the Page, or into separate frames on top of the Page. For this 
business report, you will place the text onto the Page. 

-NOTE: Ventura may have already put the file on the Page 
without your intervention. If you select an empty frame or a 
Page before loading a single filet Ventura assumes that you 
want the file in that locationt and places it without being asked. 
If Ventura placed the file for yout read through the following 
section without dOing anything. 

Select the Page 
m Enable Frame mode by clicking on the Frame button in the 

Mode Selector. 

~l Select the Page by clicking once anywhere on the Page. 

Notice the eight black handles, known as sizing buttons, 
around the border of the Page. They show you what has been 
selected and where Ventura is going to place the text. 

~ Click once on the file name lRPRT.TXTin the Assignment 
List to place the file onto the Page. 

The text fills the Page. The text file name is displayed in the 
Current Selection Box (Figure 1-8). 

Figure 1-8. 
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Don't worry if your screen differs slightly from the example 
shown here. You may have started the project with something 
other than the DEFAULT. STY style sheet. That other style 
sheet may have different margins and columns. You will soon 
load a different style sheet. 

Because you placed the file on the Page, Ventura continues to 
make new pages until the entire file is placed. If you were to 
press the PgDn key to move ahead in the document, you would 
find the additional pages already created. 

Rename the text file 
Once the file is on the Page you can change its name and/or its 
location. When you make changes to text they are reflected 
back to the original file. If you do not want the original to be 
permanently modified, you must rename it before you save the 
chapter. 

II! Select File TypelRename from the Edit menu. 

Cut Fr)al:~~:~ lkJ 1. 

Copy Fr)al:~~~ tlkJ 1. 

Pa~)'te Fr)d~:~e lm~' 

1 nt)' Sp~:JG'hll I hH:l, , , AC 

Edit Sp~:~Gi~:ll I tel:! , " An 

RenlOve T ext/F ile I I I 

File Type/Renar~e I I I 

m Move to the New N arne line and press Esc to clear the line. 
Then type in the new location and name: 
C:\TEMP\lREPORT.TXT 

m Click on ASCII and OK to close the dialog box. 
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FI LE TYPE / RENAME 

Old Name: C:\POWER\1RPRT.TXT ______ _ 

New Name: C: \TEMP\ 1 REPORT. mT ______ _ 

Text F orlilat : I Generated I IimDI I WordStar 3 I I ws 4.0/5.0 

I "S·Word I I WordPerfect I I Xyl~rite I la·Bit ASCII I 
~ I MultiHate I I PRN·to· Table I ll~ol'dPerfect 5 

I Writer I 

Ventura prep 

WARNING: If you did not make a C:\TEMP subdirectory, Ventura will not know where 
to relocate this file. Go back to the section "Step one - file maintenance" to learn 
how to make the C:\TEMP subdirectory . 

.. TIP: You can correct typing mistakes by pressing the Back
space key to delete one character to the left, or the Del key to 
delete one character to the right. Use the Esc key to clear the 
line. 

If you prefer, you can save the file in your favorite word 
processing format instead. Follow the steps above and choose 
the text format you want rather than ASCII. 

Load a style sheet 
To continue the Ventura prep, you will load one of the original 
style sheets included with the Ventura software package. . 

WARNING: If you have moved or changed the style sheets in any way since buying 
Ventura, reload the originals as explained in the Introduction to this book. 

m Select Load Diff. Style from the File menu. 



Load a style sheet 

Chapter ... 

Save AS 
Save As .. . 
Abandon .. . 

load Text/Picture ... 

To Pf'int ... 
DOS File Ops ... 
Quit 

1-23 

m Use the Backup button to find the C: \ TYPESET subdirec
tory. The Directory line reads C:\TYPESET\*.STY. Now 
select the style sheet &PRPT-PI.STY and click OK. 

ITEM SELECTOR 

Directory: C:\TYPESET\*.STY _______ _ 

• :mmm::::m:m:::: *. STY :::mm::mm::::m:: 

RNBJS-P3.STY t 
&PHOti-P2.STY .......... 
&PREl-P1.STY 
&PRPT-P1.STY 
&PRPT-P2.STY ~ ......... . 

&TBL-P1 .STY 
&TBL2-L1.STY 
IHCHD-P1.STY 
RTDOC-P1.STY , 

Selection: &PRPT -P1.STY/ 

OK 

I Cancel I 

If you cannot find the style sheet, check that you are in the 
correct subdirectory. Scroll down the listing until &PRPT
PI.STYappears. 

-NOTE: You can move from subdirectory to subdirectory either 
by clicking on the Backup button and the diamonds, or by 
typing the desired subdirectory onto the Directory line and 
pressing Enter. 
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Rename the style sheet 
If you save a chapter without renaming the style sheet, you 
will permanently change the original. It's better to leave the 
original intact for future use, and rename the new version. 

1m Select Save as New Style from the File menu. 

New 
Open Chapte ....... 

Save AS 
Save As .. . 
Abandon .. . 

load Text/Pictu .... e .. . 
load Diff. Style .. . 

To P .... int ... 
DOS File Ops ... 
Quit 

1m Move the cursor to the Directory line, press Esc and type: 
C: \ TEMP \ * . STY and press Enter. 

The Item Selector searches the C:\TEMP subdirectory for 
files with the .STY extension. Because you haven't put any 
here yet, the list is blank. 

m Move to the Selection line and type: lREPORT and click OK. 
Ventura stores the style sheet as C:\TEMP\lREPORT.STY 
(Figure 1-9) . 

.. TIP: Ventura automatically assigns a .STY extension to style 
sheets and. CHP extensions to chapter files. You do not need 
to type them in. 

The new style sheet name appears in the Title Bar at the top 
of the screen. 



Load a picture file 

ITHI SELECTOR 

Directory: C:\TEMP\*.STY _________ _ 

I\::::::::mmm::::::!! *. STY :m::mm:m:mmm 

t 

................................ ' .. " ........ 

Figure 1·9. 

Selection: 1REPORT~._ 

~ 
I Cancel I 
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Load a picture file 
Loading pictures is very similar to loading text. In fact, you 
use the same option from the File menu: Load TextlPicture. As 
with text, you first load the file onto the Assignment List and 
then place it where you want it. 

~ Select Load TextlPicture from the File men ll;. 

m Select Type of File: Line-Art, Line-Art Format: GEM, # of 
Files: One, and OK. 

LOAD TEXT/P ICTURE 

Type of File: I Text I 'Mid I Image I 
Line-Art ForMat: I!mII I AutoGad .SLD, I Lotus .PIC , I Mentor Gr I 

I VideoShow' I ~IAG PIGr I ,PostScript I 
~ I HPGL' I liS Windmls , 

'* of Files: III I Several' 
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Ventura displays the Item Selector, which you will use to 
choose a picture file to load. 

~ If you are not already in the C:\TYPESET subdirectory, 
click the Backup button until C:\TYPESET shows on the 
list (preceded by a diamond). Click once on the name to 
move to that subdirectory. The Directory line now reads 
C:\TYPESET\*.GEM. 

m Scroll down until you see NOZZLE.GEM. 

m Select NOZZLE.GEM and click OK (Figure 1-10). 

ITEM SELECTOR 

Directory: C:\TVPESET\*.GH1, _______ _ 

• mmjjjjjjjjjjjjjjmm *. GHI jjjjjjjjjjjjjjjjjjjjjjjjjj 

• BUSINESS 
• NBISlET 
• TECHDOCS 

COlUltlBIR .GEt1 

'.~.~~.~~~.~.~.~.~.~.' 

t 

............................................ ~ 

................................ , ........... . • 

Se lection : NOZZl E .6Et11 

OK 

I Cancel 1 

Figure 1·10. Selecting NOZZLE.GEM from the Item Selector. 

Ventura loads the file. The name NOZZLE.GEM appears in 
the Assignment List. Do not place the picture for the moment. 
Later in this chapter you will draw a frame and place this 
picture inside it. 

-NOTE: Although you can rename text files and style sheets 
with Ventura, you cannot rename picture files. You must exit 
Ventura and use the DOS Rename command to rename a 
picture file or use a third-party utility like Desktop Manager. 

Save the chapter 
When you save a chapter for the first time, use Save As from 
the File menu to specify the new name and location. 



Save the chapter 

m Select Save As from the File menu . 

• :nr.. 
New 
Open Chapter ... 

Save 
- . 

Abandon... ~ 

load Text/Picture .. . 
load Diff. Style .. . 
Save As New Style .. . 

To Print ... 
DOS File Ops ... 
Quit 
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m Move the cursor to the Directory line and press Esc. Type in 
the new location C: \ TEMP \ * . CHP and press Enter or click 
OK to move to that subdirectory. 

~ Move to the Selection line and type in the name: lREPORT 
and click OK. 

ITEW SELECTOR 

Directory: C:\TH1P\*.CHP ________ _ 

Selection: 1REPORT~. ___ 

.............................................. 

.............................................. 

~ I Cancel I .............................................. 

.. NOTE: If you lose a chapter through a computer malfunction, 
you may be able to restore it from the backup files. 

Ventura maintains backups of all key files, provided you 
choose Keep Backup Files: Yes from the Set Preferences dialog 
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box in the Options menu. Each time you save a chapter Ven
tura renames the backup files with a $ extension. Thus the 
backup filename for SAMPLE.CHP is SAMPLE.$HP. 

The backups represent files as they were the last time you 
saved the chapter. To restore the backups, you must return to 
DOS. Delete the original files. Then rename the backups to 
their original names. Thus, you would rename SAMPLE.$HP 
to SAMPLE.CHP. SAMPLE.$TY would become 
SAMPLE. STY, etc. Be sure you delete and rename all the 
chapter files, including those with the extensions CHP, STY, 
VGR, CAP, and CIF files. 

til Stopping point 

Text 

You have reached the first of our recommended breaking 
points for Chapter One. Before you do anything else, save 
what you have done so far. 

~ Press Ctrl-S (or Select Save from the File menu). 

At this point you can stop and shut down the computer if you 
do not have time to continue. To restart, load Ventura and 
open the sample chapter, C:\TEMP\lREPORT.CHP. If you 
have the time, you should simply go straight to the next 
section without stopping. 

Even if you plan to continue on without stopping, we recom
mend that you save your work to prevent loss in the event of a 
power surge or computer malfunction. 

Even though you haven't yet started to work on the actual 
document, you have already acquired a collection of valuable 
Ventura skills. Most Ventura users learn about file main
tenance the hard way - by accidentally destroying or losing 
some of their work. The Ventura prep section you just com
pleted is the key to avoiding such disasters. 
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What to do if you make a mistake' 
If you've never made a mistake and don't ever plan to, you can 
skip this next section. Otherwise, you may want to know what 
to do in the event of a maj or error. If you goof and can't recover, 
you can always choose Abandon from the File menu. Abandon 
reverts to the previous version - that is, it goes back to where 
you were the last time you saved the file. For this reason, you 
may want to save fairly often. If you make a serious mistake, 
it may be simpler just to go back to the previous version with 
the Abandon option. 

Now you are going to step through the construction of the 
sample document. In case you don't have time to finish the 
entire project in one session, we will suggest another stopping 
point about halfway through. 

The normal progression through a Ventura document follows 
the Formula: Text + Style + Pictures = Chapter. You already 
have a head start on the text portion, since you loaded and 
placed a text file during Ventura prep. Normally you would do 
some text editing at this stage. However, to prevent this first 
project from dragging on too long, we will postpone teaching 
you about text editing until the next chapter. Instead, you will 
take a quick look at moving around and viewing the Page. 

Move around the page 
Before proceeding to the style section of this sample project, 
take a moment to practice getting around. To move a few lines 
at a time, click on the arrows at the ends of the scroll bars at 
the far right of the screen. To move one screen at a time, click 
on the gray area. To move a distance you determine, drag the 
scroll bar (click and move while holding the mouse button 
down). 

To move to the next page, use the PgDn key on the numeric 
keypad. Use the PgUp key to move to the previous page. Press 
the Home key to move to the first page of a chapter and the 
End key to move to the last. 
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WARNING: If the keys on the numeric keypad do not work, it's likely that you 
accidentally enabled keyboard mode. You can turn it off by pressing the Ctrl and the 
right Shift key (you will hear a beep). 

View the page 

Style 

Ventura provides four views of the page. You will experiment 
with three of them in this exercise. 

• Use the View menu to cycle between Enlarged, Normal, and 
Reduced Views (Figure 1-11). 

Facing Pages View 

Reduced View AR 
NorMal View (1x) AN 

FraMe Setting AU 
Paragraph Tagging AI 
Text Editing AO 
Graphic Drawing Ap 

Figure 1-11. To zoom in, press Ctrl-E 
or select Enlarged View from the View 
menu. 

You can also use keyboard shortcuts to cycle between different 
views. Press Ctrl-E, Ctrl-N, and Ctrl-R to change from En
larged to Normal to Reduced View . 

.. TIP: To zoom into a selected area, place the mouse cursor 
where you want the upper left corner of the magnified view. 
Then press Ctrl-E (or Ctrl-N). 

In accordance with the Formula (Text + Style + Pictures = 
Chapter), the next section is concerned with style. More 
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specifically, you will load an existing style sheet and modify 
some of its tags. 

A style sheet contains formatting rules.' Some apply to the 
overall Chapter - margins, columns, vertical rules, and so 
forth. Others, called tags, apply to individual text elements. 
Style sheets are the key to Ventura's power. In fact, they are so 
powerful and so sophisticated they can intimidate a beginning 
user. Ventura has so many options you may have trouble 
knowing where to begin or remembering where you've been 
already. Fortunately, there are several easy ways to make 
sense of style sheets. 

Rules of thumb 
Three rules of thumb can help keep you from becoming disor
ganized and forgetting important steps. 

'-TIP: Concentrate on three key menus during the style phase: 
Chapter, Frame, and Paragraph. 

'-TIP: Format the overall chapter before the individual text para
graphs. 

'-TIP: Work from left to right (from Chapter to Frame to Para
graph) and from top to bottom (from Font to Alignment to 
Spacing, etc.) in the menus. 

These three suggestions are guidelines only. You will find 
occasional exceptions to these rules as you work through the 
publishing projects. Nevertheless, they work well together. 
Most chapter formatting occurs in the Chapter and Frame 
menus. Most of the individual text formatting occurs in the 
Paragraph menu. Thus, if you move from left to right (Chap
ter to Frame to Paragraph), you automatically perform chap
ter functions first. 

When we say to work from top to bottom, we do not mean that 
you must open each and every dialog box in a given menu. In 
the very beginning you may indeed want to do so, as a way of 
learning your way around. As you grow more accomplished, 
you'll soon know which menu options to ignore. But even if 
you skip menu options along the way, it's best to work from the 
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top to the bottom of the menu. If you work randomly you're 
likely to overlook an important menu choice. 

You will follow these rules of thumb while in the style section 
of this first document. You will concentrate on the Chapter, 
Frame, and Paragraph menus. You will start with the design 
choices that affect the entire document - margins, columns, 
headers, footers, and so on. These layout decisions are applied 
to all the pages of the chapter. 

You will begin with the first option in the Chapter menu. 

Open the Page Size & Layout dialog box 
m Select Page Size & Layout from the Chapter menu. 

m Choose Orientation: Portrait, Paper Type & Dimension: 
Letter, Sides: Single, Start On: Right Side. Click OK to 
close the dialog box. 

PAGE lAYOUT 

Orientation: Portrait 
Paper Type & Dblension: Letter', 8.5 x 11 in. 

Sides: Single 
Start On: Right Side 

Page Size & Layout contains several options that affect the 
size of the Page and how pages are printed. Figure 1-12 
summarizes the effects of some of these choices. 

Single sides applies to documents that are printed on only one 
side. Later in the book you will work with double-sided docu
ments, where print appears on both sides and such things as 
headers and footers and margins may be different for the left 
and right versions of the page. 



Create a header with page numbers 

B.5x11 in. 5.5xB.5 in. 
Portrait size Half size 

11x17 in. 
Landscape 

Figure1-12. Letter, Half and Landscape are the most common 
paper size options. 

Create a header with page numbers 
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Our rule of thumb says that you should work from top to 
bottom in the Chapter menu. In this document, you will not be 
concerned with the Chapter Typography dialog box, or with 
any of the counting options. You can, therefore, move down to 
the Headers & Footers option. 

Although we are using a header as an example, most of the 
concepts you are learning apply equally to footers. You can 
achieve similar effects in footers instead of headers, or you can 
combine both headers and footers on one page. For example, 
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you could place the document title in the header and the page 
numbers in the footer. In this example, however, you will place 
both a descriptive title and a page number in the header. 

II Select Headers & Footers from the Chapter menu. 

Page Size & Layout .. . 
Chapter Typography .. . 

Update Counters .. . 
Auto-Numbering .. . 
R~:Jnw:~b~:Jr> Ch<.:lph:u'. An 
Re-Anchor Frames ... 

Turn Header On 
Turn Footer On 
Footnote Settings ... 

Insert/Remove Page ... 
Go to Pa e... AG 

R Select Define: Right Page Header, Usage: On. 

g On the line labeled Left, type: 
Ventura Implementation 

This action positions the report title (''Ventura Implementa
tion") on the left side of the page. 

R Move the text cursor to the line labeled Right (click once 
next to the word "Right"). Now type: Page followed by a 
blank space. 

m Choose the Page # button from the bottom of the dialog box. 
The page numbering code, [P#], appears on the line. Then 
click OK. 



Create a header with page numbers 

HEADERS & FOOTERS 

Define: I left Page Header I Right Page Header 

I Left Page Footer I I Right Page FooteI'I 

Usage: Ell []£[I 
Left: Ventura Ir,plelllentation, _________ _ 

Center: 

Right: Page [PI:I1!f--------------

Inserts: I Chapter It I I Page It I I 1st Match I I Last Match I 
I Text Att!'. I I Copy To Facing Page I 
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When you enter the page numbering code [P#] in the Headers 
& Footer dialog box, you tell Ventura to display the current 
number of each page in the header. If you prefer, you can also 
enter such codes into dialog boxes by typing them directly. 
Most people, however, prefer to use the buttons, thereby 
eliminating the need to memorize codes. 

As soon as you close the dialog box, the header you created 
appears at the top of the page. (Since you are working with an 
existing style sheet, the format of the header has already been 
defined. Later you will change its style.) However, most 
reports do not include headers and footers on the first page. 
Let's turn the header off for the first page only while permit
ting it to remain on the following pages. Move further down 
the Chapter menu. 

m Check to make sure you are on page one. If not, press Home 
to return to the first page of the document. 

m Select Turn Header Off from the Chapter menu. 

-NOTE: When you turn the header (or footer) off, the Chapter 
menu displays uTurn Header On" or IITurn Footer On." This 
menu option affects the current page only. 



1 - 36 

.. -
Page Size & layout .. . 
Chapter Typography .. . 

Update Counters .. . 
Auto-Numbering .. . 
R~:Jr~~u:~b~:w Ch<':lpt~:Jr> AB 
Re-Anchor Frames ... 

Headers & Footers ... 
- • I - I 

Turn Footer Off 
Footnote Settings ... 

Insert/Remove Page ... 
Go to Pa e... AG 

Style 

Change the margins 
Since you are finished with the Chapter menu, the rule of 
thumb says you should now move to the Frame menu. 
Proceeding top to bottom, you come first to Margins & 
Columns. You will use this option to increase the margins 
from their original setting. 

m Enable Frame mode (click the Frame button in the Mode 
Selector) and select the Underlying Page by clicking the 
mouse cursor anywhere on the workspace. 

tl Select Margins & Columns from the Frame menu. 

If the dialog box shows measurements in units other than 
picas &\points, place the mouse cursor anywhere on top of the 
unit measurement (e.g. inches or centimeters) and click until 
"picas & points" appears. If you are unfamiliar with picas and 
points, simply enter the settings for the time being. We will 
explain this measurement system in Chapter Two. 

m Leave the top and bottom margins at 06,00 picas & points. 
Move the cursor to the Left line, press Esc to clear the line 
and type: 09,00. Then move to the Right line, press Esc 
and type: 09,00. Then click OK. 



Reset the header to the new margins 

MARGINS & COLUl4N8 

** of Colu~ns: a [I] m [!] []] m m []] 
Settings For: I Left Page I ma'PNS 

ColuflIn 1: 
2: 
3: 
4: 
5: 
6: 
7: 
8: 

Widths 
33 l Oe 
oo,I1H 
oo,I1H 
00,113 
00,113 
OO,f.!e\ 
oo,f.!f.t 
oo,f.!f.! 

Gutters 

00,00 
no,oo 
00,00 
00,00 
00,00 
on,oo 
oO,no 

Margins 
Top: e6,ea picas & points 

Bottofll: B6,Ba 
Left: B9,Ba 

Right: B9, Bal 

Calculated Width = 51 l BB 
Actual Fra~e Width = 51 l Ba 

Inserts: I Hake Equal Widths I I Copy To Facing Page I 
I Cancel I 

Reset the header to the new margins 
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Take a moment to look at the header on page two. It is aligned 
with the old margin settings. That's because Ventura sets the 
margins of the header equal to the margins of the Page. 
Because you built the headers before you changed the margins, 
the header margins remain at the old value. Therefore, you 
must now reset the header to match the new margin settings. 
Here's how. 

i1 Select Headers & Footers from the Chapter menu and turn 
Usage: Offfor both the right and left page header. Click OK. 

This turns the header off for the entire document. Your set
tings are retained even though the header is no longer active. 

[ij Now reselect the same dialog box and turn Usage: On. 
When you return to the document you will discover that the 
headers have been reset to match the current margins . 

.. TIP: In actual practice, you may want to want to vary our 
left-to-right rule of thumb, and change the margins before 
creating the header. This way you can eliminate the extra step 
of changing the header margins. 

If you are feeling overwhelmed about now, remember this: you 
are learning valuable tips and techniques at the same time 
that you are learning basic skills. If you meet a concept that 
confuses you, don't stop. Go on to the next section. Come back 
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to the trouble spot later. Then you will see things from a new 
(and calmer) perspective. Believe it or not, everything will 
begin to fall into place. 

Modifying tags 
That's all the chapter formatting you will do for this first 
document. Now let's take a look at formatting individual para
graphs. 

To Ventura, a paragraph is any line or lines of text that ends 
with a carriage return. A paragraph may be a single letter, a 
word, or several lines of text - as long as it is ended by 
pressing the carriage return (Figure 1-13). 

Desk File Edit View Chapter Frane Paragraph Graphic Options 

• ~:~~:~~:~~:~~:~~:~~:~~:~~:~~:rC:\tYPESn\1PRGilIt«f:CHP--(jpRGHfj.jif:STiir]~:~~~~:~~!~~:~~'~~:~~:~~:~~ • 
t 
t-

R. 
~~ R~port on Installation and Impl~mpntation of Ventuza Publishprll 

~~, 
Paragraphs ~ ....... --r--__ ~ 

~ _ Summaryl 

~ XYZ Corporation has ~mbarked on a program to impl~m~nt VpntUIa Publisher 
~ software on existing IBM AT-compatible computm as needed throughout the 

company. The Marketing Communications dppartment will oversee and supmise 
this project Marhting Communications makps th~ followi~ rmmm~ndations:1 I 

;;:;:::::; 

Use of Ventuza in pvpry department for all publishinglcommunications tasksl l 

+\ 

Figure 1-13. Ventura considers every line that ends with a Return as a 
separate paragraph, even "empty" lines. 

You can make Ventura treat two or more sentences as one 
paragraph if you end a line with a line break (press Ctrl
Enter) instead of a carriage return. The line break appears as 
a backward arrow on the screen. Line breaks are useful when 
you want to break up information on separate lines, but you 
don't want to change the format (Figure 1-14). 

For the most part, the formatting of individual paragraphs 
occurs in (surprise!) the Paragraph menu. The bad news: the 
Paragraph menu gives some users headaches because it packs 
so much power into so little space. The good news: we have a 
suggestion to make it simpler. 
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Desk File Edit View Chapter Frane Parasraph Graphic Options 

• ~:~~:~~:~~'~~t~~'~~'~~~~t~~,~~T C:\TEliP\fRlpORf:-ciiii--(lRtPORT:sWf'j~'~~t~~:~~'~~:~~t~~:~§:§§t~~t~~ • 
t 

r-

Report on Installation .J 
. f s ~ Line breaks and Implementation 0 .J -:(t 

Ventura Publisher' _____ it: 
tit-- Paragraph 

I-I!I!!! return 

+1 

Figure 1-14. Line breaks let you start a new line without ending the 
paragraph . 

.. TIP: Roughly 75% of all paragraph formatting is done in the 
first three dialog boxes: Font, Alignment, and Spacing. 

If you follow our previous suggestion to work from top to 
bottom, you'll soon make a discovery. By the time you finish 
with Font, Alignment, and Spacing, you've probably ac
complished most of what you needed to do. In the beginning, 
concentrate your efforts on the "Big Three" dialog boxes and 
you'll soon gain a sense of control. 

Let's pause for a moment to remind ourselves where we've 
been and where we're headed. You've completed the text por
tion of the report and now you're working on style. You've 
completed the chapter formatting and you're ready to start 
formatting the individual paragraphs. As you proceed 
through the rest of the style section, you will assign tags to 
individual paragraphs. Tags include attributes such as font 
type and size, alignment, spacing, and so forth. The style 
sheet you loaded at the beginning of the chapter comes with 
pre-defined tags. 

Assigning a tag begins by enabling Paragraph mode and 
selecting a paragraph. While the paragraph is still high
lighted, you tell Ventura which tag you want by clicking on a 
name from the Assignment List. The Assignment List in
cludes all the style sheet's tags in alphabetical order. 
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.. NOTE: The tags that begin with a 'Z" are generated by Ven
tura. You will learn about generated tags in Chapter Two. 

Your next question might be "Which paragraph should I work 
on first?" Here's a guideline that applies to all documents: 

.. TIP: When you are ready to start working on individual para-
graphs, format Body Text first. 

As you will discover later in this chapter, the choices you make 
for Body Text affect the rest of the document. Thanks to 
Ventura's style sheet approach, the changes you make to the 
first Body Text paragraph are automatically reflected in each 
and every Body Text paragraph throughout the document. 
There is no need to format each one individually. Any format 
change to one tag affects them all. 

Change the Body Text font 
m Enable Paragraph mode (click on the Paragraph button 

from the Mode Selector). 

m Change to Normal View to select the first Body Text para
graph "XYZ Corporation has embarked ... " (Figure 1-15.) 

Figure 1-15. 

B Select Font from the Paragraph menu. 

~ Choose Face: Helvetica, Style: Normal, Color: Black, and 
Size: 012.0 points. Click OK (Figure 1-16). 
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''Body Text" FONT 

Tillles 
Courier 
SYlllbol 
fly ant Garde Gothic Book/Dellli 
ITC BooklWl Light/DePli 
Helyetica Narrow 
Palatino 

CustOM Size: 1}12.~ points 

Oyerscore: Off 
Strike' Thru: Off 

Underline: Off 
Double Under line: Off 

§j§j Sty Ie :jj§j §j Co lor m 

I..l.!~ht; White 

Bold 
t. .. ltaHc 
rf-Italic 
B- Italic 

Red 
Green 
Blue 
Cyan 
Yellow 
Magenta 

Figure 1·16. The Font dialog box for PostScript printers. 

If you do not have a PostScript printer 
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Your Font dialog box may differ slightly from the one shown 
here if you did not choose PostScript as your printer. Do not 
worry about the slight variation (Figure 1-17). As you can see, 
there are only two differences. One is that you substitute 
Swiss for Helvetica. The second is that you choose the point 
size from a list rather than entering it on a line. 

"Body Text" FONT 

Cusi;OI:l Siz.e: 012.0 p()inb' 

OYerscore: Off 
Strike -Tht'u : Off 

Under line: Off 
Double Under line: Off 

~j~: Style m§! §! Color m 

Ll.!3ht; ~'hite 

Bold 
l. .. ltaHc 
rf-Italic 
lHtal:ic 

Red 
Green 
Blue 
Cyan 
Yellow 
Magenta 

Figure 1·17. The Font dialog box for the Hewlett-Packard LaserJet. 

All of the documents in the first section are constructed with 
the two basic fonts: Times and Helvetica. If you have a non-
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PostScript printer, you know these fonts as Dutch and Swiss. 
As you may recall, we recommend that you install PostScript 
as one of your printer options even if you do not have a 
PostScript printer. You can switch to a PostScript printer 
during the projects with Set Printer Info from the Options 
menu. By selecting PostScript as your printer your screens 
will match the ones in the book. Then you would switch back 
(using Set Printer Info again) to your actual printer when it's 
time to print. 

However, if you prefer not to install or use PostScript, you can 
use another printer. When you see instructions to use Post
Script fonts, substitute your own font names instead. When 
you see Times, substitute Dutch. When you see Helvetica, 
substitute Swiss. (As an aid to remember which is which, it 
may help to recall that Helvetica is another name for Switzer
land.) 

.. TIP: If you did not install a PostScript printer, substitute Dutch 
whenever you see Times; substitute Swiss whenever you see 
Helvetica. 

Change the Body Text alignment 
Most dialog boxes have multiple choices. We do not have the 
time to discuss every choice for every dialog box the first time 
we encounter it. For the moment, make the choices we suggest 
and leave the others unchanged. Rest assured that almost 
every choice in every dialog box is covered somewhere in the 
ten chapters of Publishing Power with Ventura. 

im With the Body Text paragraph still highlighted, select 
Alignment from the Paragraph menu. 

im Choose Horz. Alignment: Justified and click OK. 



Change the Body Text spacing 1 - 43 

"Body Text" ALIGNt1ENT m 
Horz. Alignment: Justified 
Vert. Alignment: Top 

Text Rotation: None 
Hyphenation: USENGLSH 

Successive Hyphens: 2 
Overall Width: Colurl\n -'Hde 

First Line: Indent 
Relative Indent: Off 

In/Outdent Width: (UJ,OOI picas & points 
In/Outdent Height: 001 lines 

In Fr'nt:1 RiBht; t;n Ht:JG'lJ:!<:ll: (0)00 
M~~xil:\w:\ Rot;':At;~::d Htd,t3ht;: (0) 00 

Change the Body Text spacing 

I Cancel I 

The Spacing dialog box is one of the most complex, so take a 
deep breath. We need to spend a few paragraphs to get you 
started in the right direction. If you bear with us for a few 
minutes, you will have an easier time from now on. 

The Spacing dialog box controls both vertical and horizontal 
spacing. Vertical spacing is handled in the top half (Above, 
Below, Inter-Line, Inter-Paragraph) and horizontal spacing is 
handled in the bottom half (In From Left, In From Right). 

Vertical spacing has four variations: Above, Below, Inter-Line, 
and Inter-Paragraph. Above, Below, and Inter-Paragraph add 
space between paragraphs. Inter-Line puts space between 
lines (Figure 1-18) . 

.. TIP: Use Inter-Line Spacing for al/ tags. Use Above Spacing if 
you need additional space above the paragraph. Do not use 
Below unless you cannot get the effect you want with Above 
and/or Inter-Line. Avoid Inter-Paragraph. 

In other words, for additional space between two paragraphs, 
add Above Spacing to the lower paragraph. For instance, 
Figures 1-19 and 1-20 show what two paragraphs look like 
before and after you add Above Spacing. 

Limiting spacing to Above and Inter-Line has advantages. 
Above spacing can be suppressed when a paragraph starts at 
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Body Text 

Head level 1 

Desk File Edit ViBlf Chapter Fralle Paragraph Graphic Options 

• 1[:~~i~~:~ii~li:~~:~~:~~i~~:~~:~~rc:\m1P\iRtpoRf. cHP--(1RIpORT§T\if1i:~~i~~:~~!~~:~~:~~:~~:~~!~~;~~: • 

+, 

Report on Installation and 
Implementation of Ventura 

C;:~~IiSher 
-Executive SummatY.. 

Figure 1-18. 

Desk File Edit ViBlf Chapter Fralle Paragraph Graphic Options 

+, 

:sheets. Every document produced with these style sheets will automatically, 
!meet minimum standards for graphic design and quality; and all documents! 
jseen by the public will reinforce the same image. : 

!We have identified potential uses in five departments; more will be developed! 
:as users become more proficient with Ventura and discover new applica~ 
~ions. ! 

Accounting Department: 1 

!Creation and maintenance of electronic forms, including purchase orders,: 
!inlloices, collection notices, plus formatting of financial statements and! 
:reporls. The creation of direct m ail flyers, brochures and, resuhing in im ~ 
!provedtumaroundtime and reduced fees from outside agencies and service! 

i~~~.~.~.~.~~ ............................................................................................................ J 

Figure1·19. Here are two paragraphsbefore adding Above 
Spacing. 
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I 

I 

Style 

the top of a column by choosing Add in Above: When Not at 
Column Top. What's more, if two paragraphs have conflicting 
Above and Below spacing, Ventura uses the larger value of the 
two. If Body Text had 18.00 fractional pts Below Spacing and 
Headl had 24.00 fractional pts Above Spacing, Ventura would 
use the 24.00 fractional pts from Headl to add space between 
the paragraphs (Figure 1-21). 

If you start by setting Below to zero, you don't have to worry 
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Desk File Edit lJiB\! Chapter Frare Paragraph Graphic Options 

isheets. Every document produced with these st)o1e sheets will automatically; 
:meet minimum standards for graphic design and qual~y; and all documents: 
iseen by the public will reinforce the sa me image.' ! 
iWe have identified potential uses in five departments; more will be developed: 
ias users become more proficient with Ventura and discover new applica~ 

t 

I 
Body Text--+--.... rons

. I I I Head level 1 

+ 1 

!Accounting Departmentll : 

iCreation and maintenance of electronic forms, including purchase orders,i 
iinvoices, collection notices, plus form atting of financial statem ents and: 

t=~~.~.~:.~ ........................................................................................................... .! 

Figure1-20. With Above Spacing you add extra space above 
the Head1 paragraph to separate it from the Body Text. 

Desk File Edit lJiB\! Chapter Frare Paragraph Graphic Options 

-, 

• ~l~~l~~l~~l~~l~~l~~l~~l~~l~~l~~lr C: \ TEMP' ui EPORf~i:Iii -Hi!EPOR fs TY) ·1Il~~l~~l~~l~§l~~l~~l~~i~~:~~l~~ + 
t 

+1 

We have identified potential uses in five departments; more will 
be developed as users become more proficient w~h Ventura 
and discover new apPlicationsS- Body~ext 

C 
18fractlonalpts 

24f1amonal pts BeIowSpacing 
AIIa.oe Spacing • 
HeadllNell ---+ Accounting Department: 

Creation and maintenance of electronic forms, including pur
chase orders, invoices, collection notices, plus formatting of 
financial statements and reports. 

I: 
~ 

b 

I 
I , 

Figure 1-21. When conflicts arise between the spacing values of tags, 
Ventura chooses the largest value. 

about one tag overriding another, and you always know where 
your spacing effect was created. 

It is important to be consistent when working with Ventura. If 
you follow the tip above you will minimize the confusion some 
beginners experience with the Spacing dialog box. It's a 
simple system for first-time users. Nevertheless, there are 
exceptions to this rule. We'll explain the exceptions as you get 
to them. In general, however, you can get the look you want 
about 80% of the time using just Above and Inter-Line. 
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Let's put this rule of thumb into practice with the paragraph 
you were working on previously. 

m With the paragraph "XYZ Corporation has embarked ... " 
still highlighted, select Spacing from the Paragraph menu. 
Click on the unit of measurement until it reads fractional 
pts. 

§::1 Move the cursor to Above, press Esc to clear the line, and 
type: 14 

There is no need to type the .00. Ventura treats blanks as 
zeros. Thus, 14.00 and 14._ are the same. 

m Move the cursor to Below. Press Esc to clear the line. Leave 
it blank. 

Since Ventura treats blanks as zero, leaving the line blank is 
equivalent to entering 00.00. 

m Move the cursor to Inter-Line. Press Esc and type: 14 

m Move to Inter-Paragraph. Press Esc to clear the line. Leave 
it blank. 

S Choose Add in Above: When Not At Column Top. Click OK. 

When Not at Column Top eliminates the above spacing if the 
paragraph occurs at the top of a page or column (Figure 1-22). 

"Body Text" SPACING [I] 
Above: 14. fractional pts 
Below: 

Inter-line: 14. fractional pts 
Inter-Paragraph: ~.== 

Add in Above: I Ah,ays I When Not at ColUMn Top 

Settings For: I Left Page I mdkG. 
In Fr'oM left: 00,00 picas & points 

In FrOM Right: 00,00 

Inserts: I Copy To Facing Page I 

I Cancel I 

Figure 1·22. 
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Here's a second tip on vertical spacing: 

'-TIP: Spacing values should be an integer multiple of the inter-
line spacing of Body Text. 

You create a more pleasing page design by using standard 
vertical spacing, including spacing above headings, captions, 
subtitles and padding around pictures. That unit should be 
equal to or a multiple integer of Body Text's inter-line spacing. 
With consistent vertical spacing you can be assured that text 
will align across columns (Figure 1-23). 
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Figure 1-23. To align across columns, make spacing 
an integer of Body Text spacing. 

In the example above, Inter-Line was 14.00 points, and we 
chose 14.00 fractional pts for Above. Other good choices might 
have been 07.00 fractional pts, 28.00 fractional pts, 42.00 
fractional pts or other multiples of 14.00. If the inter-line 
spacing had been 12.00, then 06.00, 24.00 and 36.00 would 
have been valid options. 
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About horizontal spacing 
Hang in there. You're halfway home. You've covered vertical 
spacing. Stick with it for a few more paragraphs as we"'explain 
the horizontal spacing options in the Spacing dialog box. 

-TIP: Treat In From Left and In From Right as "extra" margins 
when the original margins set in the Frame menu are not 
enough. 

In certain cases, you want an overall margin for most of the 
document, but different, smaller margins for other text ele
ments. In such a case, use the Spacing dialog box to create 
secondary margins with In From Left and In From Right. 

Create a secondary margin for Body Text 
Try creating a secondary margin for the Body Text tag with In 
From Left. Shortening the line length will make the text 
easier to read. 

U Select Spacing from the Paragraph menu or press Ctrl-X to 
bring up the last dialog box. If necessary, change the unit 
measurement. (Put the mouse cursor on top of the measure
ment units next to In From Left spacing and click until 
picas & points shows.) 

ri Make In From Left spacing 06,00 picas & points. Click OK. 

"Body Text" SPACING 

Aboye: 14.00 fractional pts 
Below: 00.00 

Inter-Line: 14.00 fractional pts 
Inter-Paragraph: 00.00 

Add in Aboye: I Always I When Not at ColuMn Top 

Settings For: I Left Page I I@iH'UWS 
In FrOM Left: 06,001 picas & points 

In FrOM Right: 00,00 

Inserts: I Copy To Facing Page I 

I Cancel I 
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., NOTE: In From Left is measured from the edge of the margin 
not from the edge of the paper. 

When you return to the document, the Body Text now starts 
six picas & points from the original left margin (Figure 1-24) . 

Figure 1-24. 

........................................................................................................................ ~ 

R.porto" ."'"",,. .. , Im •• m.","." ,IV.",,,, P"""h"::. 

Execulive Summary 

XYZ Corporation has embarked on a program to implemen\ 
Ventura Publisher software on existing IBM AT'compatiblei 
computers as needed throughoul the co mpany. The M arketinci 
Communications department will oversee and supervise this 
project. Marhting Communications makes the followin,J 
recommendations: i 
Use of Ventura in every deparlm ent for all publishingJcom~ 
munications tasks . 

You have already used the Big Three: the Font, Alignment, 
and Spacing options. Since there is nothing more that needs to 
be done to Body Text, you are ready to move to another text 
paragraph. 

__ Stopping point 
You have reached another recommended stopping point. If 
your time is limited, save your work and exit Ventura. Return 
to complete the project when your schedule permits. 

Change the Title tag 
If you are restarting after leaving Ventura, select Open Chap
ter from the File menu to open C:\TEMP\lREPORT.CHP. 

If Body Text should always be the first tag you modify, what 
should be the second? We recommend starting at the top and 
marching through in order. The next paragraph is the title. In 
the next few steps, you will apply the Title tag. Then you will 
modify it by changing its font, alignment, and spacing. 
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m Select the paragraph ''Report on Installation and Im
plementation of Ventura Publisher." Select Title from the 
Assignment List to apply the tag (Figure 1-25). 

Figure 1-25. 

r lililn.i'i!Iii .. ~.,,"j,)ffill.lli.lii 
• Executive Summary ! 

XI'Z Corporation has embarked on a program to implemeni 
Ventura Publisher software on existing IBM AT'compatibl~ 
computers as needed throughout the company. The Marketing 
Communications department will oversee and supervise thi~ 
project. Marketing Communications makes the following 
recom mendations: i 
Use of Ventura in every departm ent for all publishingJcom~ 
munications tasks ! 

m Select Font from the Paragraph menu. Make the Size: 
024.0 points and click OK. 

Change the Title alignment 
m Select Alignment from the Paragraph menu. Choose Horz. 

Alignment: Left and Hyphenation: Off. Leave the remain
ing settings unchanged. Click OK. 

"Title" ALIGNto1ENT 

Harz. AlisnMent: 
Vet"t. Alism,ent: 

Text Rotation: 
Hyphenation: 

Successive Hyphens: 
Overall ~lidth: 

First Line: 
Relative Indent: 

In/Outdent Width: 
In/Outdent Heisht: 

Left 
. Top 
None 
Off 
UnliMited 
ColuMn-Wide 
Indent 
Off 

00.001 inches 
001 lines 

In Fr'ol,l RiBh~; t;o lh,)t;'hlal: nn.on 
M"lX·l.l,IUH RtJ~;.('lb'~d Ht'rl.Hht;: 00,00 

Cancel 
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The title appears flush against the left margin. 

Notice that you turned off hyphenation. Titles and display 
type over 18.00 fractional pts. should generally not be 
hyphenated. 

Adjust the Title spacing 
m Select Spacing from the Paragraph menu. Verify that the 

units of measurement are displayed as fractional pts. 

m Move to Above, press Esc to clear the line and type: 42.00 

m Move to Below and press Esc to clear the line. Leave it 
blank. Move to Inter-Line, press Esc and type: 28.00 

m Move to Add in Above and choose Always. Click OK. 

As you can see, the settings in the Spacing dialog box adhere 
to the rule of thumb. You set Below Spacing to zero and 
created the space between paragraphs with Above Spacing. 
Because the Body Text inter-line spacing is 14.00 fractional 
pts, you used a multiple of 14 for the inter-line and above 
spacing in the Title tag. 

WARNING: As you proceed through the additional tags, your results may not match 
the book unless you select Auto-Adjustments: None from Set Preferences in the 
Options menu (Figure 1-26). 

SET PREFERENCES [!] 
Generated Tags: Shmm 

Text to Greek: 6 
Keep Backup Files: Yes 

Double Click Speed: 3 
On-Scpeen Kepning: None 

Auto -Adj usblents : None 
Pop-Up ~1enu Syr'lbols: Hidden 

Nem~ Type: Dpop -Down 

Deci(llal Tab Char: 0461 (ASCII) 

OK I Cancel I 

Figure 1·26. 
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The Auto-Adjustments setting in the Options menu affects the 
settings you use in the Spacing dialog box. If Auto-Adjust
ments is set to Styles, Ventura will automatically adjust the 
inter-line spacing of a tag each time you change its font size. If 
you increase the font size by 20%, Ventura will increase the 
inter-line spacing by the same percentage. This automatic 
adjustment may seem like a convenience. In practice, how
ever, it usually results in hard-to-use fractional spacing. We 
recommend spacing related to the standard unit of the Body 
Text. Auto-Adjustments throws off this standardization. For 
these reasons, we recommend working with it off. Instead, you 
will manually adjust spacing as necessary. 

In addition, as you get further along, we will not tell you each 
and every choice to make in each and every dialog box. In
stead, we will mention only the changes. You will leave every
thing else unchanged. If you have Auto-Adjustments set to 
Styles, the inter-line spacing may differ from what we expect 
you to have. 

The Head level 1 tag 
Now that you are finished with the Title tag, you are ready to 
move on to the next paragraph down the page. Tag it as Head 
level 1 and then change the way it looks. 

il Select the next paragraph "Executive Summary." Select 
Head level 1 from the Assignment List (Figure 1-27). 

Figure 1-27. 

r····················································· ...................................................... ··············1 

lReport on Installation and 
ilmplementation of Ventura 
lPublisher 

i§i!"M"Wufici 
XVZ Corporation has embarked on a program to implemeni 
Ventura Publisher software on existing IBM AT·compatibl~ 
computers as needed throughout the company, The Marketing 
Com munications I thi~ 
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The format that appears is part of the original style sheet that 
you loaded at the beginning of the project. For instance, the 
ruling line below was created by selecting the Ruling Line 
Below option in the Paragraph menu (you'll learn more about 
ruling lines later in the book) . 

.. NOTE: If you are curious to know how a format was created, 
look for clues in the Paragraph menu options. Exploring on 
your own can lead to discoveries. But before you start to 
experiment, save the chapter. Then, if you make a mistake, 
you can choose Abandon to return to the last saved version. 

Change to the abbreviated format 
Now that you have assigned the Head level 1 tag, you can go 
through the "Big Three" - Font, Alignment, and Spacing - to 
change its appearance. 

To speed the process, we will use a shorter method to note 
changes. For example, to change the Head level 1 font we will 
use: 

m Font Size: 018.0 points 

This abbreviated format means that you should open the Font 
dialog box, change the point size to 018.0 points, leave every
thing else unchanged, and click OK to close the dialog box . 

.. NOTE: Make only the changes indicated. Leave anything not 
listed the way you found it when you opened the dialog box. 
After making the indicated changes, click OK to close the 
dialog box. 

Change the Head level 1 spacing 
You will use Above Spacing to add extra space between the 
Head level 1 and the Title tag. 

m Spacing Above: 42.00 fractional pts 
Inter-Line: 28.00 fractional pts 
Add in Above: When Not at Column Top 
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The Bullet tag 
~ Select the paragraph "Use of Ventura in every depart

ment ... " and tag it as Bullet (select Bullet from the Assign
ment List). (Figure 1-28.) 

Figure 1-28 . 

X,(Z Corporation has embarked on a program to implemeni 
Ventura Publisher software on existing IBM AT -com patiblei 
computers as needed throughout the company. The M arketin~ 
Communications department will ollersee and supervise this 
project. Marketing Communications makes the followin~ 
recommendations: : 

.'obl\li"';li4lJn .• MiNim5IbM'41;;';;;1ii1Ii4;~ 

Designation of an in-house 

.. NOTE: You may have to scroll up or down the page to find the 
paragraph to select. 

The attributes from the original style sheet are applied to the 
paragraph. 

To change the tag, you will step through Font, Alignment, and 
Spacing. Since you have already encountered these dialog 
boxes several times, we will list the changes in abbreviated 
form. 

m Font 

m Spacing 

Face: Helvetica 

Above: 07.00 fractional pts 
Below: 00.00 fractional pts 
Inter-Line: 14.00 fractional pts 
Add in Above: When Not at Column Top 
In From Left: 06,00 picas & points 
(or 72.00 fractional pts) 

When you are finished, the Bullet tag should look similar to 
Figure 1-29: 
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Figure 1-29. 

iExecutive Summary 

XVZ Corporation has embarked on a program to implemenl 
Ventura Publisher software on existing IBM AT -compatiblei 
computers as needed throughout the company. The Marketinci 
Communications department will oversee and supervise this 
project. Marketing Communications makes the followind 
recommendations: : 

• Use of Ventura in every department for all publishing/com; 
munications tasks : 

Designation of an in-house desktop publishing specialist wit~ 
responsibility for training, maintenance and standards i 
A company-wide training program to teach basic Ventura skill~ 

Select multiple paragraphs 
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Next, you will tag three more paragraphs as Bullet using the 
Shift-Click technique. Shift-Click lets you tag several para
graphs at one time. Click on the first paragraph as you would 
normally. Then hold down the Shift key while clicking on the 
additional paragraphs. All the paragraphs are highlighted 
simultaneously and the Current Selection Box shows the word 
Multiple. 

-.. TIP: Use Shift-Click whenever possible when giving several 
paragraphs the same tag name. 

m Select the paragraph "Designation of an in-house ... " While 
holding down the Shift key, select the paragraph "A com
pany-wide ... " Without releasing the Shift key, select the 
third paragraph "Advanced workshops .... " 

m When all three paragraphs are selected, release the Shift 
key. Then choose the Bullet tag from the Assignment List. 

When you have finished, your document should look like Fig
ure 1-30. Now you will finish the page by assigning the Head 
level 1 tag to the paragraph immediately below the bullets. 



1 - 56 

Figure 1-30. 

XVZ Corporation has embarked on a program to implemenE 
Ventura Publisher software on existing IBM AT-compatibl~ 
computers as needed throughout the company. The MarketinQ 
Communications department will oversee and supervise thiS. 
project. Marketing Communications makes the foliowinQ 
recom mendations: i 
• Use of Ventura in every department for all publishing/com~ 

munications tasks : 

• Designation of an in-house desktop publishing specialisi 
with responsibil~y for training, maintenance and standards: 

• A company-wide training program to teach basic Ventur~ 
skills : 

• Advanced workshops as needed to teach specialized SkillSI: 

Use of Ventura Company-Wide 

Style 

m Select the paragraph "Use of Ventura Company-Wide" and 
tag it as Head level 1 (Figure 1-31). 

Figure 1-31. 

Thethree-month pilot program undertaken by 
municalions has determined that Ventura 
used for every twe of document currently 
compa.ny. Company-wide use of Ventura 
ing/printing costs by 35% over the next 
next page). It will reduce the confusion and 
now in evidence, whereby every department 
afferent (and often incompatible) solutions 
problems. K will also permit the company to 
enforce appearance and im age standards. 

The Head level 2 tag 
Next go to page two, where you will assign the Head level 2 
tag and change its attributes. 

~ Press the PgDn key to go to page two (if necessary, scroll to 
the top of the page). 
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m Select the paragraph "Accounting Department:" and tag it 
as Head level 2. 

With the paragraph still highlighted, make the changes 
shown below in abbreviated form. 

m Font Size: 014.0 points 

m Spacing Above: 28.00 fractional pts 
Below: 00.00 fractional pts 
Inter-Line: 14.00 fractional pts 
Add in Above: When Not at Column Top 
In From Left: 06,00 picas & points 

Ii Use Shift-Click to assign the Head level 2 tag to the follow
ing paragraphs: "Advertising Department," "Market Com
munications," "Internal Publications," and "Engineering." 

Complete the tags 

Pictures 

You have made all the changes to tags. All that remains in the 
style section is to assign these tags to a few more paragraphs. 

m Select the paragraph "In-House Desktop Publishing 
Specialist" and tag it as Head levell. 

Because of the tag's Above Spacing, the paragraph is forced 
on to the next page. 

m Press PgDn to go to the next page (page three). 

m Select the two paragraphs at the bottom of the page that 
begin "It will explain ... ," and "It will teach ... "and tag them 
as Bullet. 

m Now select the paragraph "Company-Wide Basic Training 
for Ventura" and tag it as Head levell. 

~ Press PgDn to go to the next page. 

m Select the paragraph "Advanced Workshops" and tag it as 
Head level 1. 

Congratulations. You have finished the style portion of this 
document. By now you should already be seeing some im-
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Add a frame 

Pictures 

provement in the appearance of the report. Before you finish 
this first project, you will add a picture by drawing a frame on 
the page and placing a picture file inside. 

Before placing a picture, you must add a frame to contain it. 
Check to make sure the rulers on the top and left side of the 
screen are displayed in picas. If not, use Set Ruler from the 
Options menu to change the units. Click once on the 0,0 
square in the upper left corner. This sets the zero point to its 
original position and ensures that your rulers match ours 
(Figure 1-32). 

Figure 1-32. 

VenlUra Impl e m e nlali 0 n 

make better use of this new tool and 
value to them 

• k will teach the basic skills needed to imple 
sheets designed by the desktop publishing 
she will show attendees the rudimentary skills 
printing a document. 

The teaching portion of the seminar will be acco 
completing the first three chapters of POWER 
WITH VENTURA, a self-paced teaching guide 
panying software disk. Each attendee will receive 
book for further self-study as desired. Marketing 
tions also recom m ends that every Ventura 

Now you will go to the second page and add a frame. 

m Select Go to Page from the Chapter menu. Choose Selected 
Page: 0002 and click OK. 

Ventura takes you to page two. 

m Enable Frame mode. 

m Click on the Addition button from the Side-Bar. The words 
Add New Frame are highlighted (Figure 1-33). 
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Figure 1-33. 

lisher uses style sheets to store for 
company can create a library of 
them into style sheets. Every document 
style sheets will automatically meet minimum 
graphic aesign ana quality; and all documents 
public will reinforce the same image.' 

We have identified potential uses in fi~e departm 
be developea as users become more proficient 
ana discover new applications .• 

Accounting Department:' 
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m Place the corner of the cursor where you want the upper left 
corner of the frame to appear. Use the ruler to position the 
frame cursor so it lines up with the left margin of the Body 
Text and the top of the column guide (Figure 1-34.). Perfect 
accuracy is not important for this first attempt. 

Figure 1-34. 

VenIJJalmpiementation 

us~s style" sheets to store" 
company can create a library of appr"o~e<1 desrgr 
them into style sheets. Every document 
style sheets will automatically meet minimum 
graphic aesign and quality; and all documents 
public will reinforce the same image. 

We have identified potential uses in fi~e depart 
be developea as users become more proficient 
ana discover new applications. 

Accounting Department: __ Illl 

It may help to position the frame if you change to Normal 
(Ctrl-N) or Enlarged (Ctrl-E) View. 

m Press and hold down the mouse button. When the cursor 
changes to a picture of a pointing finger, drag the lower 
right corner of the frame downwards and to the right mar
gin. Release the mouse button when you reach the 21-pica 
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posi tion on the vertical ruler and position 42 picas on the 
horizontal ruler (Figure 1-35). 

Figure 1-35. 

Ventura's column snap and line snap force the new frame to 
line up properly. Column Snap forces the frame to align with 
the margins. Line Snap, which is automatically set to Body 
Text's inter-line spacing (14.00 fractional pts), makes the the 
frame an integer relationship to the other page elements. 

If you have a problem placing or sizing the frame use one of 
the following tips: 

• To delete a frame, select it and press the Del key (or select 
Cut Frame from the Edit menu). 

• To adjust the size of the frame, point to one of the black 
sizing buttons around the frame. Then press and hold down 
the mouse cursor until the pointing finger appears. Then 
push or pull the frame into shape. 

• To move a frame, place the cursor anywhere inside the 
frame (not on one of the sizing buttons) and hold down the 
mouse button. When the four-way arrow appears drag the 
frame to a new location. 

Add padding to the frame 
After you set the location of the frame,· you should add some 
padding - extra breathing space that keeps surrounding text 



Place the picture 1- 61 

from touching the border of the frame. In the following ex
ample, you will set vertical padding to 14.00 fractional pts
the standard spacing unit derived from Body Text. 

The vertical padding option places a white space buffer both 
above and below the frame. Thus, in the example above, the 
frame will have 14.00 fractional pts of padding at the top and 
14.00 fractional pts at the bottom. Text will not be allowed to 
come within 14.00 fractional pts at top or bottom. 

~ With the frame still highlighted, select Sizing & Scaling 
from the Frame menu. 

SIZING & SCALING 

Flow Text Around: On 

Upper left X: ::.:: a c:J Upper left Y: ~.~~ a c:J 
Fralle Width: Frane Height: 

Horiz. Padding: OO.BO Vert. Padding: 14:001 fractional pts 

Pictm'e S~;aUJ1B: LnLi.~.Ir~~~i.J fJ~~}~!.~~fi.:I~~!!~~~J 

AspeGt Ratio: L~~i~i~~l~~~~LJ D!l~~~£~~~LJ 

X Crop Offset: 00 .(~) r-;F-~-"] Y Crop Offset: ((~)l ',0000 L~J C=.] 
Scale Width: OO,(}O •. -..... : L. ..... _: Scale Height: 1\ 

~ Choose fractional pts as the unit of measurement. 

m Move to the Vert. Padding line, press Esc to clear the line, 
type: 14.00 and click OK. 

The frame now has a 14-point cushion of white space above 
and below it. 

Place the picture 
m With the new frame still selected, select the picture file 

NOZZLE.GEM from the Assignment List. 

The picture appears inside the frame (Figure 1-36). 
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Chapter 

Figure 1-36. 

lisher uses style sheets to store formatting information, the 
company can create a library of approved designs and code 
them into style sheets. Every document produced with these 

Chapter 

With text, style and picture finished, you need only complete 
the chapter portion of the report. 

Print the chapter 
The only real test of a document is how it looks on paper. In 
the chapter section of this project, you will print the report 
you just created. Then we will show you how to back it up on 
a floppy disk using Ventura's Multi-Chapter function. 

m Press Ctrl-S to save the chapter. 

m Select To Print from the File menu. 

WARNING: If you installed PostScript as your printer for the purposes of this project, 
but you do not have a PostScript printer, use Set Printer Info to switch back to your 
original printer. Chapter Three contains a detailed explanation of the Set Printer Info 
dialog box. 

m Choose Which Pages: All, Printing Order: 1st to Last. Leave 
all other settings alone. The Configuration line should 
match the default printer you selected when you installed 
Ventura. Click OK to print a single copy of the four-page 
report (Figure 1-37). 
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PRINT INFORMATION (POSTSCRIPT - Ultimate) 

Which Pages: All 

F rorQ Page: ElEIl111 
Through Page: 9999 

Number of Copies: 01 

Collated Copies: OFf 
Printing Order: 1st to Last 

Paper Tray: Default 
Crop Marks: OFf 

Spot Color Overlays: Off 
I-iult"i . Ghp. PI'.int. r .n~.~~~: e(,)f.)h.int.~d 

Figure 1·37. 

Device Name: POSTSCRIPT 
Output To: COH1: 
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I Cancel I 

Ventura displays a message that it is printing. If you need to 
cancel the printing command, press Esc. Ventura will then 
give you the choice of stopping or continuing. 

Back up a chapter 
As explained earlier, Ventura uses pointers to keep track of 
the files in a chapter. If you use DOS to back up a chapter with 
the COpy command, you will move all the files to a new 
location but the pointers will still be set to the old location. The 
chapter will load from the new location, but when the chapter 
looks for the text, style, and picture files it needs it will be 
unable to locate them. The chapter will still be looking for 
them at the old location. 

To solve this dilemma, use Multi-Chapter from the Options 
menu to back up chapters. This utility not only copies the 
files, it automatically changes the pointers to correspond to the 
new locations. 

Ventura permits you to create a publication, which can be a 
collection of many chapters. You can then copy or print all of 
the chapters in the publication with a single command. You 
will practice this skill in Chapter Three. But you don't have to 
create a publication just to copy a single chapter. Here's how it 
works: 

m Place a formatted floppy disk in the A: drive. 
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m Select Multi-Chapter from the Options menu. If you 
haven't already saved the chapter, Ventura will ask you if 
you want to Save or Abandon your changes. Choose Save. 
The Multi-Chapter dialog box appears and the name of the 
current chapter, C:\TEMP\lREPORT.CHP is highlighted 
in the list (Figure 1-38). 

NUL TI -CHAPTER OPERATIONS 

Figure 1·38. 

m Select Copy All. 

Hew 
Open 
£:lr.me 

gi.wl.~" , 
Save As ... 

Add Chapte ...... 
Remove Chap 

Ppint, , , 
tli.\kl.~ 'mG", 
Hi.~kt.~ Index", 
flema'lbm', , , 
Copy All ... 

The Copy All dialog box appears (Figure 1-39). 

COPY All 

SOURCE (froR this file) 

PUB or CliP: C:\ TEMP\ 1 REPORT . CHP _______ _ 

DESTINATION (to these directories) 

PUB & CHPs: A:\! 
STYs & IUDs: A:\'~------------

Text Files: A:\, ____________ _ 
Graphic Files: A:\ ____________ _ 

Ililage Files: A:\, ____________ _ 

Goomand: I Make All Directo ... ies the Same As the First I 

Figure 1·39. 
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The name of the chapter is displayed at the top of the dialog 
box. The destination lines show the disk drive and subdirec
tory to which each file will be copied. When you first select 
Copy All, Ventura will "guess" where you want to copy the 
files. You will change this guess to the actual destination (the 
A:\ drive). 

~ Move the cursor to the line PUB & CHPs. Press Esc to clear 
the line and type: A: \ 

As you can see, you have the option to copy different kinds of 
files to different subdirectories. In this case, however, you will 
copy all the chapter files to the A:\ drive. Luckily, Ventura has 
a feature that makes it unnecessary to type A:\ on each line. 

~ Choose Command: Make All Directories the Same As the 
First. Click OK. 

Ventura copies all the files to the A:\ drive. When the copy 
function is complete, you return to the Multi-Chapter dialog 
box. 

00 Choose Done to close the Multi-Chapter dialog box. 

If Ventura asks you if you want to abandon or save changes 
made to the publication, click on Abandon to return to the 
work area. 

Once you have completed printing and backing up the chap
ter, you can go onto the next project or exit from Ventura. To 
exit: 

~ Select Quit from the File menu. 

If you haven't saved recently, Ventura will ask you if you want 
to Save or Abandon. Choose Save. 

You made it. You created a business document with Ventura. 
Al though some of the new concepts and theory may have been 
tough going for beginners, you have already learned many of 
the basics - basics you will reuse again and again. Along the 
way, you made a big improvement in the appearance and 
efficiency of the sam pIe report. 

And you can do even more to enhance basic business docu
ments. Turn to Chapter Two for more ideas and techniques for 
power publishing with Ventura. 
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~ Tips and techniques 

Text tips 

D Use File 'l'ypelRename from the Edit menu to relocate text 
files (copy them to a new subdirectory) or to convert them to 
a different word processing format. 

o Do as much editing, changing, adding, and spell checking 
as possible in the word processor before bringing the file 
into Ventura. Text editing in Ventura is slower and less 
efficient. 

Style tips 

D Always rename the style sheet at the beginning of the work 
session to avoid corrupting the original. 

o To avoid confusion, many users give the style sheet the 
same name as the chapter (for instance, SAMPLE. CHP and 
SAMPLE. STY). 

D Perform the Chapter formatting first, then move to in
dividual paragraph formatting. 

D You will feel less confused if you concentrate on the Chap
ter, Frame, and Paragraph menus during the style phase of 
a document. 

D Work from left-to-right and from top-to-bottom in Ventura's 
menus to avoid overlooking important operations. 

D When working in the Paragraph menu, focus on the Font, 
Alignment, and Spacing menus. 

o Use Inter-Line spacing for every tag. Use Above spacing if 
necessary to provide additional separation from the preced
ing paragraph. Use Below spacing only if you cannot get the 
effect you want with Inter-Line and Above. Use Inter-Para
graph only as a last resort. 

D If possible, make all vertical spacing an integer multiple of 
Body Text's inter-line spacing. This applies to spacing 
above and below headlines, subheads and bullets, as well as 
to frame sizes and frame padding (white space around 
pictures). 
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o For faster tagging, use Shift-Click to select several para
graphs at once. 

Chapter tips 

o Use Save As to rename (and/or relocate) the chapter at the 
beginning of every work session. Once you have renamed 
the chapter you can save it as you go along simply by 
pressing Ctrl-S. 

o Create a separate subdirectory for each project. If the docu
ment is very large, subdivide the hard disk even further. 

o Never use DOS copy to move chapters and associated files. 
Use M ul ti -Chapter so the internal pointers are changed to 
match the new location. Exception: You can use DOS to 
move files between two identically configured computers. 
For instance, you could move SAMPLE.CHP from the 
C:\TEMP subdirectory of one computer and put it on the 
C:\TEMP subdirectory of a second computer. As long as 
each and every file is found in the same location on both 
computers, the chapter will load properly on the new com
puter. 

o You can type the new subdirectory location on the Directory 
line and move to it by pressing Enter (or clicking OK). 
However, the easiest way to navigate around the hard disk 
is with the mouse and the backup button. 



Chapter Two 
Skills Checklist 

Theory 
o Understanding picas and points 

o Preformatting text in your word 
processor 

o Inserting special characters with 
bracket codes 

Text 
o Ventura's editing tools 
o Adding text attributes with Text mode 

Style 
o The benefit of a two-column page 

format 

o Adding and changing tags 

o Creating a title page 
o Creating a page break tag 

o Setting off lists with bullets 

o USing horizontal tabs to make a table 

Pictures 
o Placing text inside a frame 

o Adding a ruling line around a frame 

o Attaching captions to frames 

Chapter 
o Print the current page 
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A Two-Column Proposal 

A lthough you may not realize it yet, you have already 
acquired a solid grounding in Ventura fundamentals just 

by completing the first chapter. Chapter Two reinforces these 
basics while teaching the new skills summarized in the check
list to the left. 

Why you should not get discouraged 

Theory 

This may be a good time to reassure novice users. If Ventura 
seems a bit intimidating during the first few weeks, remember 
that you are really tackling two things at once. First, you must 
learn the software, not a trivial task considering that Ventura 
is one of the most powerful packages ever written for a per
sonal computer. At the same time, you must learn about 
layout and design, a separate (and complex) discipline of its 
own. This dual struggle frustrates some beginners. The best 
solution is to keep practicing. 

After each chapter, you may want to apply what you've 
learned to a real-life project. If you get stuck, go back to the 
book for guidance. Remember, mastery of Ventura is a matter 
of hands-on experience over a period of time. The more docu
ments you work on, the sooner you'll gain confidence and 
reach true proficiency. If you continue to follow along with the 
projects in the book, things will soon fall into place. 

In this section, we will introduce you to the measuring system 
the professionals use when working with Ventura. The second 



2-2 Theory 

half of the theory section discusses how to preformat text with 
your word processor to save production time in Ventura. 

Picas and points 
Most Americans are comfortable with inches. But for desktop 
publishing, the method called printer's measure or the point 
system is superior. Since type sizes are always specified in 
points, it makes sense to use printer's measure for everything 
on the page so you don't waste time converting back and forth. 
In addition, the point system has units that are much smaller 
than inches, so it is rarely necessary to complicate things with 
fractional units. By contrast, using inches requires you to 
make many fractional computations. 

For these reasons, printer's measure is the easiest way to talk 
to a page layout program. (Most programs let the user choose 
between inches, centimeters or printer's measure.) The two 
most important units in printer's measure are points and 
picas. 

Points are very small unit, about 1f72 inch. They are used to 
measure type sizes and rules. The point size of a typeface is 
roughly the measurement from the highest ascender (the top 
of a ''b'' for instance) to the lowest descender (the bottom of a 
"g"). This is only an approximation, since point sizes originate 
from the metal body used to carry type in the days before 
phototypesetting. The best way to get familiar with point sizes 
is by example. You'll soon develop an eye for the most common 
sizes. 

Picas are a larger unit. Don't confuse them with the 
typewriter style of the same name. They are equal to 12 points 
(about 1fs inch). Printers and typographers use picas to 
measure lines, margins and columns. Table 2-1 will help you 
convert common sizes from one system to the other. 
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Table 2-1. Conversion table for common measurements. 

Inches Picas & Points Fractional Pts. 

V6 in. 1 pica & points 12 fractional pts. 

V4 in. 
01,06 picas & points 18 fractional pts. (1 pica and 6 points) 

11.3 in. 02,00 picas & points 24 fractional pts. 

1h in. 03,00 picas & points 36 fractional pts. 

1 in. 06,00 picas & points 72 fractional pts. 

5 112 in. 33,00 picas & points 

81/.2 in. 51,00 picas & points 

11 in. 66,00 picas & points 

Preparing text for Ventura 
You can make life with Ventura a lot easier if you learn how to 
prepare text files for Ventura in advance. All the sample files 
that you use for the publishing projects in this book are al
ready prepared for you, so you won't have to worry about 
doing it now as long as you have the Power disk. Still, we want 
you to understand the theory so you can use it for files you 
create on your own. Preformatting text files can save you time 
in Ventura. 

You've probably heard the expression "less is more." When 
creating text files for Ventura, however, less is less when it 
comes to inserting global formats such as indents, centering, 
page numbering, and so forth. The less you format with the 
word processor - the less formatting, the less extra spaces, 
the less extra carriage returns - the less work you will have 
when you bring the file into Ventura. At best, global format
ting from a word processor is ignored by Ventura. At worst, it 
creates extra spaces, tabs, or characters that must be manual
ly removed. 
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.. TIP: Do as little global formatting as possible with the word 
processor. Perform global formatting in Ventura instead. 

Here are some of the things you should not do with the word 
processor. Do not: 

• Center text 

• Justify text 

• Indent the first line of a paragraph 

• Create temporary (secondary) margins 

• Put more than one space after a period, colon, or 
question mark 

• Put more than one carriage return between paragraphs 

• Put more than one tab stop between columns 

As you can see, we recommend only one carriage return be
tween paragraphs. Although this reduces the time spent 
deleting extraneous returns in Ventura, it does make the file 
hard to read in the word processor. Luckily, Ventura has a 
built-in feature to handle this problem: the @PARAFILTR ON 
= code. By using this code you can put an extra carriage return 
between paragraphs and Ventura will filter it out for you. 

The @PARAFILTR ON = code must be inserted as the very 
first line of the document and it must be typed correctly, or 
Ventura will ignore it. Make sure you place a space before and 
after the word "ON" and a space before and after the equals 
sign (Figure 2-1). 

One advantage a word processor has over Ventura's current 
version is an easy search and replace function. For instance, 
you could use search and replace to remove all extra spaces 
after periods. Likewise, if you make a text change throughout 
a document - for example, substituting one name for another 
- do it with search and replace before starting Ventura. 

We said that ''less is less" for global formatting. When it comes 
to formatting individual paragraphs, however, we could say 
the opposite: more is more. The more individual formatting 
you do in the text file, the more efficient you'll be. 
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Figure 2-1. Place the @PARAFILTR ON = code as the first line of a 
document to filter out double carriage returns between paragraphs. 

Individual formatting in text files 

2-5 

Individual formatting falls into two categories. The first is 
text attributes: boldface, italics, underlines, etc., when applied 
to a few words within a paragraph. The word italics in this 
sentence is an example of individual formatting (if the entire 
paragraph was in italics, it would be considered global format
ting). The second category is typographic characters. Ventura 
Publisher provides the capability to insert true typographic 
characters, including characters that don't appear on the com
puter keyboard, such as the em dash (-), the copyright sym
bol (©), and so on . 

.. TIP: You can enter text attributes and typographic characters 
with Ventura, but it's faster with a word processor. 

Bracket codes 
Some people use the search and replace to convert standard 
keyboard characters into true typographic characters. For 
instance, after typing the text file, they search and replace 
characters such as " or - with the bracket code that repre
sents true open (") and closed (") quotes and an em dash (-). 
When Ventura encounters the bracket code, it substitutes the 
correct typographic character and displays it on -screen. 
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Other people use keyboard macros instead of search and 
replace. They program the keyboard to insert the proper 
bracket codes as they go along. Thus, they might program the 
key combination Alt-C to insert the code <189>. When Ven
tura sees this bracket code, it inserts the copyright symbol 
( © ) onto the page. Figures 2-2 and 2-3 show a coded para
graph from a word processor and the same paragraph in 
Ventura. 

Figure 2-2. Bracket codes are used to insert true typographic 
characters in Ventura. 

F:w~···~ti~iiY··ih·~~gh·i·th~i··d·~~·~p··j;~bii~~g·~~;;jd···~;,;jY··h~~·~··~d~~~i~g~~··f·~~l 
~ne or two departments," said Prpsident Zygniewski, "but our study revealed! 
~hat it could save time and money throughout the company while improving! ihe appmance and effectinness of our documents."~ 1 

Figure 2-3. Ventura displays the bracket codes as true typographic 
characters. 



Bracket codes 2-7 

Table 2-3 provides the proper substitutions and codes for the 
most common typographic characters not available from the 
keyboard, as well as their keyboard shortcuts (if any). You can 
use this table as a reference whether you use the search and 
replace method or the keyboard macro method. 

Table 2-3 Common Typographic Characters 

Character Symbol Code Keyboard 
Shortcut 

open quote " 169 Ctrl-Shift-[ 

close quote " 170 Ctrl-Shift-] 

em dash - 197 Ctrl-] 

en dash - 196 Ctrl-[ 

copyright © 189 Ctrl-Shift-C 

registered ® 190 Ctrl-Shift-R 

trademark 1M 191 Ctrl-Shift-2 

bullet . 195 

cents symbol ¢ 155 

pounds symbol £ 156 

yen symbol ¥ 157 

franc symbol f 159 

section sign § 185 

paragraph ~ 188 

ellipsis ... 193 

degree symbol 0 198 
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.. TIP: If you set Auto-Adjustments to It and - in the Set 
Preferences dialog box (Options menu) Ventura will automat
ically convert all standard keyboard quotes ('') and hyphens 
(-) to true open and closed quotes and em dashes when it 
loads a text file. 

The next time you begin a project with Ventura, try preparing 
the text files with the guidelines we give in this chapter. Look 
through the text files in Appendix A for exam pIes of how to 
prepare text in advance. 

Planning the proposal 
In the first chapter you prepared an in-house document. Now 
you will work on a document that you might send to a prospec
tive customer outside your company. 

The typical proposal serves as a sales document. Sometimes it 
goes to another department in the same company, or to upper 
management. Often, however, it is sent to customers. Since a 
proposal may go to the outside world, it must represent your 
company in the best light. The graphic design should work 
together with the words to reinforce the image your company 
wishes to project. 

AI though we kept our example short to conserve time and disk 
space, a real-life proposal may be many pages long. It may 
also incorporate graphics and/or financial tables. The docu
ment needs headers or footers for easy reference, plus cap
tions to help readers correlate the visuals with the text. 

Take a look at the ''before'' and "after" pictures of the proposal. 
Here are some of the effects you will work on in this chapter to 
improve its appearance: 

• A separate title page 

• A banner headline 

• A two-column format to get more information on the page 
while enhancing readability 

• A spreadsheet file integrated with the text 
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Ventura Prep 

II If you have the Power disk 
For the purposes of this publishing project, we will assume 
that you have prepared a text file (2PROPOS. TXT) and a 
spreadsheet file (LOTUS.TXT) in accordance with the prefor
matting tips given in the theory section. (In actual fact, the 
sample text files on the Power disk have been preformatted 
for you.) Now they are ready to be loaded into the Assignment 
List. 

Loading multiple files 
In Chapter One you learned how to load one file at a time. 
Now we will show you how to load several files at once. 

1m If you are continuing from the last project, select New from 
the File menu to clear the work space . 

.. NOTE: You can only use the New option after you have 
opened an existing chapter. It is not available when you start 
Ventura for the first time. If you are starting from the DOS 
prompt, Ventura begins with an untitled chapter and you do not 
need to select New from the File menu. 

1m Select Load TextlPicture from the File menu. 

~ Select Type of File: Text, Text Format: ASCII, # of Files: 
Several, Destination: List of Files, and OK. 

~ If necessary, use the Backup button to find the C: \POWER 
subdirectory. Click on the diamond to go to the POWER 
subdirectory. The Directory line should read 
C:\POWER\ *.TXT. (If the Directory line reads differently, 
press ESC to clear the line, type C:\POWER\ *.TXT, and 
press Enter.) 

Scroll through the listing un til you see the file 
2PROPOS.TXT. Select the file by double-clicking on the name 
or by typing the name on the Selection line and pressing 
Enter. This action loads it into the Assignment List. 
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After the first file is loaded, the Item Selector reappears and 
you can continue to load the next file. 

~ Scroll through the file listing again to locate the text file, 
LOTUS. TXT. To return to the document select the file name 
and choose OK, or double-click on the name, which has the 
same effect. 

~ Click OK to return to the work space. 

- NOTE: From this point on, when we ask you to select an item, 
use whichever selection method you prefer - typing the name 
on the selection line, double clicking, or clicking on the name 
and then OK. 

If the Page is selected when you load a file, Ventura immedi
ately places the file on the Page. When you load several files 
at once, Ventura can't judge which files should be placed 
where, so it doesn't place any of them. When you are ready to 
place a file, first select the Page, then select the text file from 
the Assignment List. 

Renaming the document files 

We want you to get in the habit of renaming text files, style 
sheets, and chapters immediately to avoid making permanent 
changes to the originals. Start by renaming the text files. 

To rename the text files, you must place them one at a time 
onto the Page. Once they are placed, use File TypelRename to 
rename them and relocate them to a different subdirectory. 

m Select the Underlying Page. When the sizing buttons are 
visible around the border of the Page, select the text file 
name LOTUS.TXT from the Assignment List. 

Ventura places the text on the Page. Now rename and relocate 
the file. 

m Select File TypelRename from the Edit menu. 

~ Move to the New Name line, press ESC, and type: 
c: \ TEMP \ TABLE. TXT Choose ASCII and OK (Figure 2--4). 
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FI LE TYPE / RENAME 

Old Name: C :\POWER\LOTUS. TXT _______ _ 

New Name: C: \ TEHP\ TABLE. TXT;-I _______ _ 

Text Forl11at: I Generated I IiliJI I WordStar 3 I I tIS 4.13/5.13 

Figure 2·4. 

I HS-Iford I I WordPerfect I I XyWrite I IS-Bit ASCII I 

~ Il1ultHlate I I PRN-to- Table I 
I Writer I 

Ventura Prep 

The new file name, TABLE.TXT, appears in the Assignment 
List (Figure 2-5). 

Phase F our1500.00 1500.oo~750. 00 

Newfilename Phase Five2S00.002S00.002500.00 

TOTALS$ 131 00.00$9525.00$9370.00 

Figure 2·5. 

Next you will remove the first file and place the second text 
file on the Page. 

m Select Remove TextlFile from the Edit menu. 

Ventura displays the file name, TABLE. TXT in the dialog box. 

B Choose Remove from: Frame and click OK. 
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.. TIP: You can also remove a file from the Page by selecting 
another file from the Assignment List. Ventura automatically 
replaces one text file with the other. 

Now place the proposal text on the Page. 

m Select the file name 2PROPOS.TXT from the Assignment 
List. 

Rename the second text file. 

~ Select File TypelRename from the Edit menu. 

m Move to the New Name line, press ESC to clear the line, 
and type: C:\TEMP\PROPOSAL.TXT 

m Choose ASCII and OK. 

Leave the file on the Page . 

.. NOTE: File Type/Rename works for text files only. Use the 
DOS command Rename to rename picture files before or after 
the Ventura work session. 

Load and rename a style sheet 
Mter renaming the two text files, load the style sheet. 

~ Select Load Diff. Style from the File menu. Use the Backup 
button to locate the style sheet &PRPT-P1.STY in the 
C: \ TYPESET subdirectory. Then load it into the document. 

Now save the style sheet with a new name. 

m Select Save as New Style from the File menu. Locate the 
C: \ TEMP subdirectory with the Backup button. At the 
Selection line type: 2PROPOS and click OK. 
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ITEM SElECTOR 

Directory: C:\TEHP\*.STY ________ _ 

11!!!!!mml!!!!!l!!!!!l! *. S TV l!!mmml!!!!!l!!!!!l! 

1REPORT .STY t 
r-

................................ ............ ...... 

......................................... " ... • 

Selection: 2PROPOS~. ___ 

~ 
I Cancel I 

Ventura Prep 

Rename and save the chapter 
Now save the new chapter with the new text and style sheet. 

m Select Save As from the File menu. 

m Find the C: \ TEMP subdirectory. Move to the Selection line 
and type: 2PROPOS. Click OK. 

If you do not have the Power disk 
~ Use your favorite word processor to type in the two text 

files PROPOSAL. TXT and TABLE.TXT from Appendix A. 
Save them (or copy them) in the C:\TEMP subdirectory. 
Then follow the steps explained above to load the text files, 
and to load and rename the style sheet and chapter files. 

-NOTE: If you want, you can use any text file in place of the 
ones we include in Appendix A. However, it will be harder to 
follow along and match your screen with our sample illustra
tions unless you use the same text. 

Now that you've organized the chapter files, you are ready to 
begin. Where to start? As you know from the previous chapter, 
the Ventura Formula (Text + Style + Pictures = Chapter) 
helps with that question. As always, therefore, you will begin 
with text. 
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Text 

Ventura'S editing tools 
Although it is usually easier to edit large sections of text with 
a word processor, Ventura provides a text editing toolkit for 
last-minute changes. You can cut, copy, and paste text or 
change the attributes of selected words within a paragraph. 

Change text attributes 

Assignment 

Before you begin, check to make sure the zero point is set 
correctly. Click once on the 0,0 square in the upper left corner 
of the Page. You may also want to use Normal or Enlarged 
View so you can easily position the text cursor. 

~ Enable Text mode (click on the Text mode button in the 
Mode Selector). When you click on the work space, the 
mouse cursor turns into an " I-beam" (Figure 2-6). 

Figure 2·6. 

When you enable Text mode, Ventura displays attributes -
Normal, Bold, Italic, Small, and so forth - in the Assignment 
List and the words Set Font in the Addition Box. 

In Chapter One you changed the font using Paragraph mode. 
But as you can see, Ventura also allows you to change text 
attributes in Text mode. What's the difference? 
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.. TIP: Use Text mode to change one or two words within a 
paragraph. Use a paragraph tag to change the text attributes 
of an entire paragraph. 

Let's use Ventura's text-editing tools to italicize several key 
words in the proposal. The italics will add emphasis and set 
them off from the rest of the paragraph. To italicize the text, 
first select the text then select the attribute. 

m Change to Normal (Ctrl-N) or Enlarged View (Ctrl-E). 

m Move the cursor in front of the "M" in the word "Market 
Research" near position 38 picas on the vertical ruler. Press 
and hold the mouse button as you drag the cursor to the end 
of the word "Research." The selected text appears in reverse 
video. Release the mouse button (Figure 2-7). 

~ilm: proposes to accomplish and complete this project in five phms, as described in mor~ ~ 

Ii 
: : 

I····~ BmaDJjrYz will analyze commercially available products for suitability. l'hase: : 

wUI .. "'.,." '" I""" ,~"" 00,,"," ..... ,'" .. , '~m.,"".ll .. ' !'. 

Heeds. XYZ will gain an in-depth knowledge of ABC's computerization needs· 
on-site an:! telephone interviews. We will consider such areas as:ft I 

I;! 

Figure 2-7 . 

.. NOTE: The traditional rule is not to italicize punctuation. 
Therefore, try not to select periods and commas when italiciz
ing (or bolding) a phrase. 

Now make the text italic. 

m Select Italic from the Assignment List. The words "Attr. 
Setting" appear in the Current Selection Box (Figure 2-8). 
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Figure 2-8. 

;XYZ proposes to accomplish and complete this project in five phases, as described in more: 
iietall:ft : 
: : 

~haseOneft i _1;..,* XYZ will analyze commercially available products for suitability. Phasj 
pne will culminate in an in-depth report outlining alternatives and recommendations. ~ i 

~haseTWO~ 1 
: : 
Ivaluate Needs. XYZ will galn an in-depth knowledge of ABC's computerization needs' 
~rough on-site and telephone interviews. We will consider such areas as:ft i 
: : 
:Word processing and editorial requiJemen1s~ i .. 
, i 
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The action you just took placed markers into the text file to 
turn the italics on and off. If you were to return now to the text 
file in your word processor, these markers would be visible as 
bracket codes (Figure 2-9): 

Figure 2-9. 

In Ventura, however, the markers are invisible on the screen. 
Nevertheless, you can locate them using the left and right 
arrow keys and the Current Selection Box at the bottom of the 
Side-Bar. 
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-NOTE: Ventura places the hidden text attributes immediately 
before and after the word or phrase that was italicized, bolded, 
underlined, etc. 

ml Place the cursor between the ''M'' and the "a" in Market 
Research and click once. Press the left arrow key on your 
keyboard several times until the words "Attr. Setting" ap
pear in the Current Selection Box. This shows the location 
of the hidden marker. 

- NOTE: To remove the text attributes, select the text then select 
Normal from the Assignment List. Or, use the arrow key to find 
the hidden marker (the words "Attr. Settings" appear in the 
Current Selection Box) and press the Del key. 

Dragging the mouse is one way to select text. However, there 
is a more accurate way called the "Shift-Click" method. 

II Place your text cursor before the "E" of "Evaluate Needs" 
(two paragraphs down from ''Market Research" near posi
tion 44 picas on the vertical ruler) and click once. While 
holding down the Shift key, move the text cursor to the end 
of the phrase (after the "s") and click again. Now release the 
Shift key. 

II Now select Italic from the Assignment List. 

- NOTE: You can change the amount of text selected by moving 
the cursor to another position and clicking again while holding 
down the Shift key. You can move forward or backward. 

~ Press PgDn to go to the next page and scroll to the top of the 
page. 

~ Use the Shift-Click method to select the three following 
phrases and make them italic as explained above: "Installa
tion," "Data Conversion," and "Training and Implementa
tion." 

When you are finished applying text attributes, your screen 
should look like Figure 2-10: 



Edit text 

Edit text 

Figure 2-10. 

Convmion. Oncethesystemisinstalled,XYZ will supervise the conversion of cunenti 
and pUblications to an electronic forIn. Ihis will include the use of optical charactei 

, whenevpr possible to mil'limizp the time and cost of data entry, Whm it is not: 
optic illy md existil'lg information, XYZ will supervise data entry personnel who: 
thp data iI'Ito thp computm. XYZ will dpsign and implement custom keyboardl 

programs to facilitatp data pntry, 11 i : 
i ::' 

and lmplemenldli()ff. With thp system up and running and data converted 
, for~, XYZ,will train ABC personnel in proper computer, procedurps, use, of , 
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Now use Ventura's cut and paste tools to rearrange the copy in 
the proposal. It works like this: First you select the text you 
want (by dragging or by using the Shift-Click method). With 
the text highlighted, you then select Cut Text or Copy Text 
from the Edit menu. Mter you cut or copy text, Ventura stores 
it in temporary memory, called the Text Clipboard. To insert 
text from the Clipboard onto the page, select Paste Text from 
the Edit menu. 

- TIP: Use keyboard shortcuts to speed text editing. Press Del to 
cut, press Shift-Del to copy, and press Ins to paste. 

Ii Press PgUp or Home to go back to page one. Select the 
paragraph starting with "Market Research" as shown 
below. Make sure you include the end of paragraph mark 
«lD in the text selection by dragging the cursor down to the 
beginning of the next paragraph (Figure 2-11). 

-NOTE: If the paragraph symbol is not displayed on-screen, 
select Show Tabs & Returns from the Options menu (or press 
Ctrl-T). 
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Figure 2-11. 

:XYZ proposes to accomplish and complete this project in five phases, as described in 
~etail:ft 

rhaseOneft 

Mar/:p! R~Si?iJlch KYZ WIll analyze commelClally available products for suitabilIty Phas 
ne WIll c\llmmale m an in-dppth report outlim alternatives and recommendations ft 

Needs. KYZ wiD gain an in-depth knowledge of ABC's computerizationneed~ 
................. "'.,;~ W. will ~"". w. mu... I 

m Press the Del key . 

Text 

.. NOTE: If you delete the wrong text, press the Ins key immedi-
ately to paste the text back on the page. Then try again. 

The text is cut from the document and placed on the Clip
board. Now you can paste it into a new location: 

m Place the cursor before the word "Evaluate." Click the cur
sor once. 

m Press the Ins key (Figure 2-12). 

{.rf:etReseazc!l, XYZ will analyze commercially available products for suitabIlity Phase 
ne WIll culmimte in an in-depth report olJtlimr altematives and recommendatioTIS ft 

.-····~IE~'aluatQ Needs. XYZ will gain an in-depth knowledge of ABC's computerization needs 
.mrsite and telephone interviews. We wiD consider such areas as:ft 

processing and editorial requiremenlsft 

Figure 2-12. 
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.. NOTE: Text remains in the clipboard until something else is cut 
or copied. 

~ Select the text starting with "Evaluate Needs" and ending 
with "Speed and throughput requirements" as shown in 
Figure 2-13. (Be sure to include the end of paragraph mark 
in your selection. If you have trouble, move the cursor down 
below the line and to the beginning of the next paragraph.) 

Figure 2-13. ' 

~ Press the Del key. 

Now paste the text back into the document below the para
graph "Phase One." 

m Place the cursor in front of the "P" of "Phase 'lWo" and press 
Ins. 

Mter you rearrange the text, click once anywhere on the work 
space to deselect the text. Your screen should look similar to 
Figure 2-14: 

.. NOTE: Do not be concerned if the italics change or disappear 
during cut and paste. Sometimes when you move text in a 
document, you also move a text attribute. Use Normal and 
Italic from the Assignment List to get the text looking the way 
you want again. 
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Style 

: :, 
~;'::vaJlW~J'(~'fI1S XYZ will gain an in-depth knowledge of ABC's computerization need~ :, aa.._ on-site ani telephone intemews. We will considel such ams as:ft l 

processing am editorial requirementsft I : , 

~'" "" ,,_ ,""'~.... I:.: 

rhaSeTwoft 

~lli~tRes~ar.ch xyz will analyze commercially mila~e products for suitability. 

Figure 2-14. 

Style 

Nice work. With just a little practice, you've learned the basics 
of text editing. 

You will begin the style portion of this project by completing 
the chapter layout. Then you will add tags to a style sheet and 
use a special tag named Page Break to isolate text on a page. 
These steps may save you some of the mistakes and confusion 
we experienced as first-time Ventura users. 

Page layout strategy 
Let's take a moment to review the formatting strategy we 
introduced in Chapter One, a strategy that helps you stay on 
course when working on the style of a document. First you 
make the global changes to the chapter. Then you tag in
dividual paragraphs, starting with Body Text. As you make 
changes, you step through the menus from left to right, and 
from top to bottom. 

Change the page layout 

m Select Page Size & Layout from the Chapter menu. Choose 
Sides: Single and Start On: Right Side. Click OK. 
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Bu ild the footer 
Next, build a footer that includes the name of the proposal and 
the page number. 

m Select Headers & Footers from the Chapter menu. 

m Choose Define: Right Page Footer, Usage: On. Move to the 
Left line and type: ABC Proposal 

m Move to the Right line and type: Page followed by a space. 
Then choose the Inserts: Page # button. The [P#] code 
appears on the line, instructing Ventura to insert page 
numbers in the footer. Click OK to close the dialog box. 

HEADERS & FOOTERS 

Define: I left Page Header , I Right Page Header I 
I Left Page Footer' 

Usage: m [QE] 

Right Ilage Footer 

Left: ABC Proposal ___________ _ 

Center: 

Right: Page [PI:I]II--___________ _ 

Inserts: 'Chapter It , 'Page It , ,1st Match' I Last Match, 

I Text Attr. I I Copy To Facing Page I 

Now turn off the footer for the first page only. 

~ Verify that you are on page one. If not, press Home. 

Il Select Turn Footer Off from the Chapter menu. 

Change to two-column format 
Mter making the footer, you're ready to change the page 
margins and columns. As we explained earlier, a two-column 
page layout lets you fit more text on a page and enhance its 
readability. When you change from one to two-column format, 
watch how easily Ventura reflows the text. 

~ Enable Frame mode. 
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m Click the cursor anywhere on the work space to select the 
Underlying Page. 

l~ Select Margins & Columns from the Frame menu. Choose # 
of Columns: 2. Make the top and bottom margins 06,00 
picas & points and the left and right margins 07,06 picas & 
points. Do not press OK yet. 

Mter you set the page margins, you enter the column and 
gutter widths. To make the columns equal widths, enter the 
first column width, then enter the gutter width (the space 
between columns), then choose Make Equal Widths. Do things 
in this order to ensure that Ventura accurately calculates the 
columns. 

-NOTE: The Make Equal Widths button does not stay high
lighted after you choose it. 

W Move to the Column 1 line, press Esc to clear the line, and 
type: 1700 

m Move to the first line of the Gutters column, press Esc and 
type: 0200 

m Choose Make Equal Widths. Click OK. 

MfiRG INS & COlUt4N8 

** of ColuMns: OJ D II] [I] m [I] m []J 
Settings For: I left Page I Wnl;i:W 

Widths Gutters Margins 
ColUMn 1: 17,0°1 B2,BO Top: 06,00 picas & po 

2: 17,00 00,00 BottOJ~: 06,01} 
3: m,l!WI no,oo left: 07,86 
4: 00,f.!0 Right: 07,06 
5: OO,f.!f.l 00,00 

6: 00,00 on,oo 
7: 00,f.!0 (}O,OO 

Calculated Width = 51,OB 
B: m,0f.l 

on,oo 
Actual Frame Width ~ 51,BB 

Inserts: I Make Equal Widths I I Copy To Facing Page I 
I Cancel I 
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Turn column balance on 
To balance the text in adjacent columns, turn Column Balance 
on in the Chapter Typography dialog box. Without Column 
Balance on, Ventura fills the first column with text before 
starting the second. With Column Balance on, Ventura fills 
both columns equally. (You will notice the effects of column 
balance on page two.) 

~ Select Chapter Typography from the Chapter menu. 
Choose Column Balance: On and click OK. 

CHAPTER (DEFAULT) TYPOGRAPHY SETTINGS 

Widows (Min lines at Top): 2 
Orphans (Min lines at Botto(ll): 2 

Colu(Iln Balance: On 
Move Down To 1st Baseline By: Cap Height 

Pair Kerning: On 

Modifying individual tags 

I Cancel I 

Since there are no more overall changes to make, you can 
begin to tag individual paragraphs. Start with Body Text, 
because its inter-line spacing is the basis for all other tags. 
Once you complete Body Text, proceed systematically through 
the document from top to bottom. You can achieve most of the 
effects you want with the Font, Alignment, and Spacing op
tions in the Paragraph menu. In this section, you will build up 
your tagging repertoire by learning about the Breaks menu. 
But first let's modify the Body Text tag. 

Change the Body Text tag 
The only change you need to make to Body Text is in the 
Alignment dialog box. 
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m Enable Paragraph mode. 

m Select the paragraph that begins "XYZ Corporation 
proposes to advise ... " (Figure 2-15). 

Figure 2-15. 

ponsulting Proposal to ABC Compan~ 

~Oj~ct D ~cription 

YZ Corporation propos~ to advise ABC 
~ompany on all aspects of desktop publish
'ng systems, including needs ana\~sis 

product and mark~t surveys, spellcations 
,nd purchase and s st~m implementahon 

~heinitia\short-termgOal is to computenzel 
'he production of ABC's internal and exter~ 
ilal publications using personal computerS: 
~nd desktop publishing software, rhi~ 
~hort-1erm goal must be substantially . 
~leted before the ~nd of ABC's 

The tag name Body Text appears in the Current Selection 
Box. Make the following changes: 

~ Alignment 

In/Outdent Width: 01,00 picas & points 

- NOTE: Ventura measures indents from the left margin of the 
column, not the left edge of the page. 

m Spacing 

Inter-Line: 14.00 fractional pts 
Inter-Paragraph: 00.00 fractional pts 

Change the tags on the title page 
Now that you've finished changing the Body Text tag, you can 
change the other tags on the title page of the proposal. 

m Select the first paragraph "Consulting Proposal to ABC 
Company" and tag it as Title (Figure 2-16). 
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Figure 2-16. 

" M'],I,~RIl'\Itt !: 
XYZ Corporation 

i September 1, 1969 1 
: Consulting Proposal to ABC Company: 
i Project Description 1 
: XYZ Corporation proposes to advise 
~C Company on ill aspects of deskto~ 
~ublishing systems, including need~ 
ianllysis, product and market surveys; 
~ecificati ons and purchase, and syste4 
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-.. TIP: If you tag the wrong paragraph, just retag it as Body Text 
and select again. 

The current format of the Title tag is part of the original style 
sheet you loaded at the beginning of this project. Now you will 
modify its design to better suit the new page design. You will 
make the Title tag stand out on the page by centering it 
frame-wide, enlarging its type size, and adding extra space 
above and below. When you are finished the paragraph will 
look like Figure 2-17 . 

....................................... -....................• ~ .............................................................. ! 
, , 

i ! 
, , , , 
: : , , 

! i 
Consulting propo1,a'l,to ABC Com pany 

Speed and throughput reguirements 
i September 1,1989 i i Phase Two , 
: ConsultirJi Proposal to ABC Company: : MarKet Jiesmcli. XYZ will analyz~ 
i Project Description 1 ~ommerchlly available products for: 
: XYZ Corporation proposes to advise: suitability, Phase One will culminate in ari 
~BC Company on ill aspects of deskto~ irrdepth report outlining alternatives and! 

Figure 2-17. 
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fI Font 

~ Alignment 

fI Spacing 

Face: Times 
Size: 024.0 points 

Overall Width: Frame-Wide 

Above: 98.00 fractional pts 
Below: 28.00 fractional pts 
Inter-Line: 28.00 fractional pts 

Style 

A note about spacing: In Chapter One we said that (1) you 
should avoid using Inter-Paragraph spacing and (2) you can 
do without Below spacing about 75% of the time. The Title tag, 
however, is an exception to the rule. Because it is a banner 
headline - a headline that stretches across two or more 
columns - it usually requires extra space below to separate it 
from the following text. 

After changing the attributes of the Title tag, apply it to the 
next paragraph. 

m Select the paragraph "XYZ Corporation" and tag it as Title 
(FigUre 2-18). 

I'to ABC Company 

.: ' 

: .: 

XYZ C~r oration 

Figure 2-18. 

Add a new tag 
( 

The next paragraph to tag is the date. To make it better match 
the Title tag, you will center it frame-wide and make it 12-
point Times Bold. Since there are no tags in the Assignment 
List with these attributes, you will add a new tag. 
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To make a new tag, Ventura copies the attributes from an 
existing tag to the new one. Then you add or subtract at
tributes to the new tag name until you get the right effect. 
Here are the steps to add a new tag. 

1. Enable Paragraph mode. 

2. Select a paragraph with attributes similar to the tag you 
want to add. 

3. Select Add New Tag from the Side-Bar. 

4. Type in the name of the new tag. 

5. Go through the Paragraph menus and add or subtract 
attributes to achieve the right effect. 

Don't worry if this sounds confusing at first. You will get the 
hang of it as soon as you work through a few examples. So let's 
get started. Create a tag named "BodyCenter" and apply it the 
date paragraph. 

~ Select the paragraph "September 1, 1989." 

• Select Add New Tag from the Side-Bar. 

e Move to Tag Name to Add and type: BodyCenter and click 
OK to close the dialog box. 

ADD NE~I TAG [!] 
Tag Name to Add: BodyCenter~ 

Tag Name to Copy From: Body Text ____ 

I Cancel I 

Ventura copies the attributes of Body Text - its Font, its 
Alignment, its Spacing, etc. - to the new tag. 
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Modify the new tag 
Now that you've added a new tag, you can change its at
tributes. Simply work through the Paragraph menu from top 
to bottom until you achieve the right effect. 

m Font Style: Bold 

a Alignment Horz. Alignment: Center 
Overall Width: Frame-Wide 
In/Outdent Width: 00,00 picas & points 

m Spacing Add in Above: When Not at Column Top 

Add a page break 
With the first three paragraphs tagged, the title page is com
plete. Now you must separate the title page text from the rest 
of the document. To do this you use a special Page Break tag. 
The Page Break tag includes a Page Break: After (Breaks 
menu) that pushes everything after it onto a new page. The 
Page Break tag was already defined in the original style sheet 
with the Breaks options from the Paragraph menu. 

Here's how to use the Page Break tag to create a separate title 
page. 

Make sure that Show Tabs & Returns is turned on from the 
Options menu (the menu will read "Hide Tabs & Returns"). 
This allows you to see an on-screen display of all the text 
symbols (tabs, returns, line breaks, etc.). 

~ Enable Text mode. Place the text cursor after the "9" in the 
word "1989." The words "Paragraph End" appear in the 
Current Selection Box. Now press the Enter key once. This 
action creates an empty paragraph, that is, a paragraph 
containing an end of paragraph symbol «JD and no text 
(Figure 2-19). 
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Figure 2-19 . 

XYZ C7Pprationt i.,:: i 

~em~ 1~ 198911 
: I : 

Consulting Proposal to ABC Compa.ny~ i EYllulii KiM!. XYZ will gain an in~ 
Proj~ct Description!! : ilepth knowledge of ABC's computerin-: 

! XYZ Corporation proposes to idvise1 jion needs through on-site and telephon~ " 
ABC Company on all asp~cts of deskto~ lnt~ryjews. W ~wiU consider such mas as:ft! 
publishing systems, including nuds: : Word processing and roitorill require-: 
~nalysis, product and market survEysj ~entsft i 
~ecifications and purchase, and system! ! Graphicsrequirementsft 1 
Implementation I ' : 1aserprintmequirementsft ' 
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.. TIP: You can apply tags to empty paragraphs as well as to text. 

Now tag the empty paragraph as Page Break, just as you 
would tag any other paragraph. 

m Enable Paragraph mode. 

m Select the empty paragraph (click on the '1I symbol) and tag 
it as Page Break (Figure 2-20). 

XYZ Corprrationt 
: : 

~em~r 1~ 198911 

~ i 
: : 

i i 
: ' 

Figure 2-20. 

The remaining text is pushed on to the second page. To under
stand this effect, leave the empty paragraph highlighted and 
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select Breaks from the Paragraph menu. There you see that 
the Page Break: After option was specified (Figure 2-21). 

"Page Break" BREAKS 

Page Break: ~ I Before I IiImI I Before & After 

I Before/Until left I I Before/Until Right 

Coluflln Break: m I Before I I After I I Before & After 

line Break: ~ l:ai~A' ~ I Before & After 

Next Y Position: 1;t-lQW" I Beside last line of Prev. Para I 
Allow Within: ~ ~ 

Keep With Next: I Yes I IDDI 

Figure 2·21. 

[][] I Cancel I 

The page break effect is an important one. Use the Page Break 
tag whenever you want to start text on a new page. Try to 
avoid the common mistake of entering a string of carriage 
returns to force text to another page (Figure 2-22). 

XYZ Corporation' 

~ElDlIer I, 19891 

• • • • • • • • • • • 
Figure 2-22. Wrong. To create a page break, use a page break tag
not a string of carriage returns. 

This is not the right way to make a page break. If you later 
add text, or change the attributes of a tag, some of the extra 
carriage returns will "float" onto the next page causing every-
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thing in the document to be pushed out of place. Remember to 
use the Page Break tag instead. 

e Stopping point 
You have finished page one and reached a stopping point for 
Chapter'l\vo. Continue on to page two if time permits. Ifnot, 
you may wish to save the chapter, then print out page one. 
Check that your document matches Figure 2-23. 

Consulting Proposal to ABC Company 

XYZ Corporation 

September I, 1989 

Figure 2·23. 



2 - 34 Style 

Apply a tag to multiple paragraphs 
If you are beginning fresh, open the chapter 
C: \ TEMP\2PROPOS.CHP and start from where you left off. 

Go to page two to continue tagging. 

~ Press PgDn to go to page two 

!m Tag the paragraph "Consulting Proposal to ABC Company" 
as Title. 

Next you will change the Head level 1 tag. Since there are 
several Head level 1 tags on the same page, you can use the 
"Shift-Click" selection method to tag multiple paragraphs at 
one time. 

1m Select the paragraph "Project Description." 

!lm While holding down the Shift key, select the paragraph 
"Statement of Work." Tag both paragraphs as Head levell 
(Figure 2-24). 

Figure 2-24. 

: XYZ Corporation proposes to idvise1 
~C Company on all aspects of deskto~ 
~ublishing systems, including need~ 
:analysis, product and market surveys;' 
\specifications and purchase, and Systeml 
~mplementation. 11 1 
: Ihe initial short-term goal is to com-: 
~uterize the production of ABC's internaE 
:and external pUblications using personal: 
~omputm and desktop publishingl 
~oflware. IhisshorHerrn goal must be subi 
stantially completed before tile end or. 
~'s fiscal year six montlls from now.l 
~he I~-range objective is to integrate a1~ 
~f ABC's publications into a company": 

system with common 
am shared output 

Change the Head level 1 tag 

~oromerciallY anihbh producb 
Suitability. Phase One will culminate in an: . 
1n-deptll report outlini~ alternatives an~ ~; 
recoromendations.lI : ;~ 
i P1iaseIhreell i . 
i instalM()TI Once ABC makes it pur-l 
:chase decision, XYZ will oversee installa~ 
iion, setup and conversion. INs will in~ 
:elude integration of hardwar~, software and: 
~eriphmls,plusthe initial setup. Setup willi 
~nclude tile creation of electronic formats~ ;: 
style sheets am document templates for. 
~euse by ABC persolll'leU 1 
: Phase lour1l . 
i IJala (.'fmmsion. Once the system 

XY'Z will supervise the 
databases and 

With the two paragraphs still highlighted, change the tag. 
First remove the ruling line below that was specified in the 
original style sheet, then change its Font, Alignment, Spacing, 
and Breaks. 
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~ Select Ruling Line Below from the Paragraph menu. 
Choose Width: None and click OK. 

"Head level 1" RULING LINES BElOW 

Itidth: None 
Color: Black 

Pattern: Solid 
Dashes: Off 

Space lIIove Rule 1: 00.00 
[~'~:.] [~:] Height of Rule 1: 01.<)H Custom Indent: 00.00 

Space Below Rule 1: 00.00 Custo" Width: 00,00 
Height of Rule 2: 00.00 

Space Below Rule 2: 00.00 Dash Width: 00,00 
Height of Rule 3: ()(),OO Dash Spacing: eo ,00 fractional pts 

Space Below Rule 3: 00,00 C.~.E.::] 
Overall Height: 01,<)8 

~ Font Face: Times 
Size: 018.0 points 

~ Alignment 

i1 Spacing 

Horz. Alignment: Center 

Above: 28.00 fractional pts 
Inter-Line: 28.00 fractional pts 
Add in Above: When Not at Column Top 

When you are finished, the tag should look like Figure 2-25: 

To keep Head level 1 from becoming isolated at the bottom of 

Consulting ProPo~l io ABC Com pany~ 

Project DescIiptionl i i Emoflearningmiuseff 
, i i Speed al'd throughput requirementsff 
: XYZ Corporation proposes to irlvise: : Phase Iwoff . 
~ Company on all aspects of deskto~ i MarKel Resmch XYZ will ana1yz~ 
~ublishing systems, including need~ ~ommercially available products for: : 
~nalysis, product and muket surveys~ ~uitability, Phase One will culminate in ari : 

cations and purchase, and syst~ in-depth report outlining alternatives an~ : 
jmpiE?ment:ationl ~ecommendations.ff : 

Figure 2-25. 



2 - 36 Style 

a column or page, use the Breaks option Keep With Next. 
Keep With Next guarantees that a tag stays next to the para-
graph that follows it. \ 

II Select Breaks from the Paragraph menu. Choose Keep 
With Next: Yes and click OK. 

"Head level 1" BREAKS 

Page Break: III I Before I I After I I Before & After 

I Before/Until Left I I Before/Until Right 

Colul1ln Break: III I Before I I After I I Before & After 

Line Break: ~ l:iji.i4j I After I I Before & After 

Next Y Position: 1!i.iQOfiiI 
Allow Within: .. ~ 

Keep With Next: .. ~ 

I Cancel I 

.. NOTE: Headlines, headings, and subheads should have Keep 
With Next set to Yes to keep them from becoming isolated at 
the bottom of a page or column. 

The Head level 2 tag 
Now tag each paragraph on page one that begins with the 
word "Phase" as Head level 2. You may want to change to 
Reduced View so that all four paragraphs are visible at once. 

E Select the first paragraph "Phase One." Then use Shift-
Click to select the paragraphs, ''Phase Two," ''Phase Three," 
"Phase Four." and ''Phase Five" (Figure 2-26). Tag them as 
Head level 2. (If you select the wrong paragraph, simply 
click on it again to deselect it.) 
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Figure 2-26 . 

systems, Including needS: 
and market surv;ys;' 

and purchase, and system: 
Implllmenilati01'l.I i 

The initial shorHmn goal is to corrrl 
~uterite the production of ABC' s interna~ 
and ~temal publications using pmona~ 
~omputl1!S and desktop publishing; 
~oftware. Thisshort-term goal must be sub-l 
~tantially completed before the end of. 
~'s fiscal year six months from now.; 
~he long-range objective is to integrate al~ 
~f ABC's publications Into a company~ 
~de system with common proce:!ms;' 

["";::::.: :~:::~: ! 

: MilEif lifSfllCII. XYZ will analyz~ 
:comnlmhlly available products for. 
1rultability. Phase One will culminate in a~ 
in-depth report outlining alternatives andi 
rcommendation~ 11 i 
iU-iM! 1 
1 Ins/uhlio!! Once ABC makes it pur~ 
i:hase decision, XYZ will oversu ilIstalla~ 
~ion, setup and conversion. This will in~ 
~ludeintQgration of hardware, software and[ 
ileripherals,plusthe initial setup, Setup willi : 
~nclude the cmtion of electronic formatsJ : 
style sheets and document templates for. : 
~euse by ABC personnel ~ !: ':' 
~ i' 
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.. NOTE: Because of the above spacing in the Head level 2 tag, 
the phrase "Phase Five" will move to the next page as soon as 
it is tagged. 

Change Head level 2 tag 
Now change the attributes of the Head level 2 tag. 

m Font Face: Times 

m Spacing Above: 14.00 fractional pts 
Inter-Line: 14.00 fractional pts 
Add in Above: When Not at Column Top 

Like Head levell, Head level 2 includes a Break: Keep With 
Next to prevent it from becoming isolated at the bottom of a 
page or column. 

a Breaks Keep with Next: Yes 

Check that the tag you just completed looks like Figure 2-27. 

Select the Bu lIet tags 
The next tag you encounter is the Bullet tag. You will make 
the bullet size larger and you will reduce the Above and In 
From Left Spacing. 
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Figure 2-27. 

and d ~sktop pUblishing: 
~oftW'll~. l:hissllOr\-tlmll goal must b~ sub-! 

completed biole th end of: 
fiscal ym six months from now,: 

long-range objectiv~ is to integrate al~ 
ABC's publications into a companY-: 

~de system with common procl!luresl 
Fatabas~ and shared output dmces.. i 

1 Statement of Workf I 

i XYZ proposes to accomplish and conJ. 
~lete this project in fiH phms, asl 
i:I~cribed ill mor~ d~taU:1I : 

~onl!lI j 
: EVIluali Kiids. XYZ will gain an irr-l 

three' : 
: InslallaQm Onc~ ABC mak~ it pur~ 
~hasedecision,XYZ will ove13e~ installa~ 
,ion, s~tup and conversion This will in~ 
~lud~integration of hardwll~, software and: 
~eriphm1s,plustheinilialsetup, Setupwrui 
~c1ude the creation of electronic formatsl : 
~tyl~ she~ls and docum~nt tmplat~ for. .:': 
~euse by ABC personnel ft ! . 
~SeJDlrIl i 
: Dala C(Jf1Vi[siOlI Onc~ Ih system 
Installed, XYZ will supervis~ th~ 
~ion of curr~nt databas~ and 
lo an ~lectronicform. This will ' 
~s~ of optical character recognition 
~ver possible 10 minimize Ih~ lime 
~f data entry, Whe~e it, is not 
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fI Select the following five bullet paragraphs using the Shift-
Click method and tag them as Bullet. 

"Word processing and editorial requirements" 

"Graphic requirements" 

"Laser printer requirements" 

"Ease of learning and use" 

"Speed and throughput requirements" 

.. TIP: As long as you keep the Shift key depressed, you can 
scroll up and down the page to select multiple paragraphs. 
Select the first bullet at the bottom of the first column, hold 
down the Shift key, then scroll to the top of the second column 
and select the rest of the bullets. 

Change the Bullet tag 
With the paragraphs still highlighted, you can change the 
attributes. 

~ Spacing Above: 00.00 fractional pts 
Below: 00.00 fractional pts 
Inter-Line: 14.00 fractional pts 
Add in Above: When Not at Column Top 
In From Left: 01,00 picas & points 
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.. NOTE: If you tend to confuse Spacing/In From Left with Align
ment/Indent, remember this rule of thumb: Alignment/Indent 
affects only the first few lines of a paragraph. Spacing/In From 
Left affects every line. 

~ Breaks Keep With Next: No 

Setting the Keep With Next option to No allows Ventura to 
split a list of bullets across a column or a page. Otherwise, if 
the list is too long, Ventura pushes all the bullets to the next 
column or page, leaving a big, empty gap in the document. 

Increase the Bullet size 
To change the size of the bullet itself, use the Special Effects 

dialog box in the Paragraph menu. 

~ Select Special Effects from the Paragraph menu. Choose 
Set Font Properties. 

''Bullet'' SPECIAL EFFECTS 

Special Effect: I None I I Big First Char I _ 
COl11l11ands: Set Font Pl'opel'ties, 

Show Bullet As: a [!] II] [!] 0 D 8 D [!] c:J 
o 0 IT] I Hollow Box I I Filled Box I I Other I 

Bullet Char: 1951 (ASCII) 

Indent After Bullet: B1,BB picas & points 

The Set Font Properties dialog box looks familiar, doesn't it? 
It's the same Font dialog box you've seen before. You simply 
got here a new way. The changes you make in this dialog box 
will affect only the bullet, not the rest of the paragraph. 

1m Enter Size: 014.0 points. Then click OK to return to the 
Special Effects dialog box. Click OK again to complete the 
effect and return to the document. 
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Change the Footer tag 
Footers are among the special tags that Ventura creates on its 
own called "generated" tags. These tags are given names that 
begin with the letter Z (for instance, Z_HEADER for the 
header, Z_FOOTER for the footer, and so on) to distinguish 
them from others in the Assignment List. As with all tags, you 
can change the attributes of a generated tag simply by work
ing through the options in the Paragraph menu. Let's change 
the font of the Z_FOOTER tag so it matches the rest of the 
proposal . 

.. NOTE: If you do not see any generated tags in the Assignment 
List, check to make sure that Generated Tags: Shown is 
selected in the Set Preferences dialog box in the Options 
menu. 

1m Select the footer on page two. 

~ Font Face: Times 
Style: N-Italic 
Size: 010.0 points 

When you are finished, the footer should look like Figure 
2-28: 

Figure 2-28. 

1 XYZ proposes to accomplish aM com~ 
~hte this projPct in five phases, a~ 
ilescribed in mon d~aiI:I! : 

~Onl!l l 
1 Efllult~ Needs. XYZ will gain an irM 
~epth knowledge of ABC's computerlni 
non needs through on-site and telephon~ 
interviews. Wewill consider such amsas:W: 
1 • Vi ord processing and editorial re~ 
: quimnentsll : 

t ... ~ .. 9.!~p'l)!.~!.~!'¥.~.!l:\~!!~~ ................... ..l 
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Finish tagging the document 

Pictures 

Mter you change the footer, finish tagging the remaining 
paragraphs in the document. 

l1 Press the End key to go to the last page of the document. 

R! Tag the paragraph "Project Costs" as Head levell. 

Now that you've completed the text and style sections of this 
project, let's continue with pictures. 

To add a picture to a document, you load a picture file and 
place it in a frame. You can make a frame any size or shape to 
fit with the page design and the artwork. 

In Chapter One, you added a frame to hold a picture. How
ever, frames can also contain text. One common example is a 
spreadsheet file. Instead of retyping a worksheet from 
scratch, you can load it into Ventura and place it in a frame. 
Once you have it in the frame, you can format it into a table. 
In this section, you will learn how to place and format a simple 
spreadsheet file. 

For this project, you will place and format the TABLE. TXT file 
from the Power disk, which has already been prepared for you. 
If you don't have the Power disk, you can type in the file from 
AppendixA. 

Add the frame 
Before you place a text file, you must add a frame to contain it. 

-NOTE: Placing text files in frames allows you to place several 
different text files on the same page. 

To make frame placement easier, make sure Column and Line 
Snap are turned on ~Options menu). If they are on, the Op
tions menu will read "'1.Urn Column Snap Off' and "'1.Urn Line 
Snap Off." These snap-to functions ensure that frames align 
with the margins and the inter-line spacing of Body Text. 

l1 Go to page three. 
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iI Switch to Reduced View (press Ctrl-R). Then make sure you 
reset the zero point to the upper left corner of the Page 
(click once on the 0,0 square). 

E Enable Frame mode. 

E Select Add New Frame from the Side-Bar. 

iI Starting at position 29 picas on the vertical ruler, place the 
upper left corner of the frame next to the left margin. Then 
hold down the mouse cursor until it turns into a pointing 
hand. 

= While holding down the mouse button, drag the lower right 
corner of the frame downwards and to the right. When the 
bottom of the frame aligns with the right margin of the 
page and reaches about 50 picas on the vertical ruler, 
release the mouse button (Figure 2-29). Don't worry about 
exact placement yet. 

Figure 2-29. 

Resize the frame 
Now that you put the frame in the approximate position, you 
can fine-tune its placement. The Sizing & Scaling dialog box 
allows you to precisely control the placement and size of 
frames. The dialog box uses the terms ''Upper Left X" and 
"Upper Left Y." Upper Left X shows the horizontal distance 
from the edge of the page to the upper left corner of the frame. 
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Upper Left Y shows the vertical distance from the edge of the 
page to the upper left corner of the frame (Figure 2-30). 

Figure 2-30. Upper Left X is the horizontal distance from the edge of 
the page to the upper left corner of the frame. Upper Left Y is the vertical 
distance. 

~ Select Sizing & Scaling from the Frame menu. Make sure 
the unit measurements are set to picas & points. Make the 
Upper Left X: 07,06 picas & points (if this is not the current 
value, press Esc to clear the line and type in 07,06 picas & 
points). Make the Upper Left Y: 29,00 picas & points. Make 
the frame width 36,00 picas & points and the frame height 
21,00 picas & points. 

SIZING & SCAlINS 

Flow Text fnJund: In 

Upper left K: 87,06111 c::J ~er left V: 29,00 a c::J 
Frallle Width: 36,00 Frallle Hei!ilt: 21 ,00 

Ibriz. PaOJing: 00,00 Vert. Padding: 90,00 picas & points 

PhitUrt~ Sf:alirtg: LflL~~~~t~:~~£~J [~~~}I~~J.i~~I~~£~r~~J 

nsp\~ct Rdt"iO: L~~J!i~i~~!i~~J Dn~1~~f~~J 

X Crop Offset: (~l)OO :-+T-:-'; Y Crop Offset: ()O)(~l [,"iT:-; 
Scale Width: (~lIOO ~ .. -.. - ... _ .. _. Scale Hei!ilt: (lOI(~l ,_ ... _ ... ,_ .. _ ... 

! Cancel! 
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Place the spreadsheet file 
After you position and size the frame, place the sample 
spreadsheet file. 

e Switch to Normal View (press Ctrl-N). 

m With the frame still highlighted, select the text file name 
TABLE.TXT and place it in the frame (Figure 2-31). 

l 

Figure 2-31. 

!-
l'tlas~Tlr~e+160o.0()t1600.00<0.01f i 
l'tlas~Four+1SOO.00+1SOO.00+3750.00~ i 
l'tlas~Fiy~2S00.00+2soo.00+2SOO.00ft : 
w~m~~"~ 

Add margins to the frame 
To center the spreadsheet text within the frame, add margins 
to the frame. These margins will affect only the selected 
frame. They will not affect the Underlying Page beneath the 
frame . 

.. NOTE: Frames that you place on top of the Page can have 
their own margins and columns, independent of the Page. 

m Margins 
& Columns 

Top: 02,00 picas & points 
Bottom: 02,00 picas & points 
Left: 02,00 picas & points 
Right: 02,00 picas & points 
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Place a box around the frame 
Next visually separate the frame from the above text by 
making a ruling box around the frame. 

m Select Ruling Box Around from the Frame menu. 

m Choose Width: Frame. Make sure the unit measurements 
are set to fractional pts. Give Rule 1 a height of 00.50 
fractional pts. Click OK. 

RULING BOX AROlIfD 

Width: Fral1\e 
Color: Black 

Pattern: Solid 
Dames: Off 

Space Above Rule 1: 00.001 
Height of Rule 1: 00.50 

Space Below Rule 1: 00.08 
Height of Rule 2: 00.08 

Space Below Rule 2: 00.08 
Height of Rule 3: 00.08 

Space Below Rule 3: 00. OB 
Overall Height: 00.50 

[f] 

1, .. 00 

Dash iii idth : no, on 
Dam Spacing: oo,()() fractional pts 

When you are satisfied with the appearance of the frame, you 
can continue to format the table. 

Format the table 
There are several ways to format tabular material, but the 
easiest and simplest way is to use horizontal tabs . 

.. TIP: Use horizontal tabs for tables that do not exceed one line 
per entry, and vertical tabs (explained in Chapter Eight), for 
more tables with multiple lines. If you require very complex 
table formats, we recommend using the Table Editing feature 
in the Professional Extension (explained in Chapter Ten). 

Ventura allows up to sixteen tab positions per paragraph, 
with left, right, decimal, or center alignment. The sample 
table uses both right-aligned and decimal tabs. To format the 
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table properly you need to create two new tags - one for the 
table heading and one for the table listings. 

Format the table heading 
First you must add a new tag for the table heading and modify 
its Font, Alignment, and Spacing. 

m Enable Paragraph mode and select the paragraph 
"JANUARY, FEBRUARY, MARCH." 

m Select Add New Tag from the Side-Bar. Move to the Tag 
Name to Add line and type: Tbl.Head 

ADD NEW TAG [!] 

Tag Name to Add: TblHead~ 

Tag Name to Copy From: Body Text ____ 

m Font 

11 Alignment 

~ I Cancel I 

Face: Helvetica 
Style: Bold 
Size: 010.0 points 

Horz. Alignment: Left 
In/Outdent Width: 00,00 picas & points 

-NOTE: We changed the alignment of the tag to Left because 
tabs will not display when text is justified. 

Set the fi rst tab stop 
Now you will place tab settings at 15,03, 23,03 and 29,03 picas 
& points from the left margin of the frame. One at a time, you 
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will choose the number of the tab, select the tab alignment, 
and enter the tab location . 

.. NOTE: Tab locations are measured from the left margin. Be
cause the left margin of the frame is 02,00 picas in from the 
frame edge, Ventura begins measuring each tab location 
02,00 picas in from the edge. 

§ Select Tab Settings from the Paragraph menu. 

Tab number 1 is already selected for you. 

m Set the unit measurement to read picas & points. 

m Choose Tab Type: Right, Tab Shown As: Open Space. Move 
to the Tab Location line, press Esc, and type: 15, 03 

Do not choose OK yet, since you still have more tabs to set. 

"TblHead U TAB SETTINGS 

Tab Number: I + I 1 I + I 
Tab Type: Right 

Tab Shown As: Open Space 
Tab location: 15J931 picas & points 

leader Char: Spaces 

leader Spacing: 0 
Auto-leader: Off 

Set the second tab stop 

032 (ASCII) 

OK I Cancel I 

II Choose Tab Number: 2 by clicking once on the right arrow 
next to the Tab Number line. Choose Tab Type: Right, Tab 
Shown As: Open Space. Move to the Tab Location line, 
press Esc, and type: 23, 03 
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"TblHead!' TAB SETT INGS 

Tab Number: I + I 2 I. I 
Tab Type: Right 

Tab Shown As: Open Space 
Tab Location: 23.B31 picas & points 

Leader Char: Spaces 

Leader Spacing: B 
Auto-Leader: Off 

B32 (ASCII) 

OK I Cancel I 

Pictures 

Set the th i rd tab stop 
m Click again on the right arrow again to choose Tab Number: 

3. Then choose Tab Type: Right, Tab Shown As: Open 
Space. Move to the Tab Location line, press Esc, and type: 
29,03 

"TblHead!' TAB SETT INGS 

Tab Number: I + I 3 I. I 
Tab Type: Right 

Tab ShmJn As: Open Space 
Tab Location: 29.B31 picas & points 

Leader Char: Spaces 

Leader Spacing: B 
Auto-Leader: Off 

B32 (ASCII) 

OK I Cancel I 

~ Click OK to close the Tab Settings dialog box. 
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Format the listings 
If tab settings seem confusing at first, don't worry. The more 
tables you format, the easier tabs will become. You'll get more 
practice with tabs right away by formatting the table listings. 

m Select the paragraph "Phase One ... " and tag it as TblHead. 

m Select Add New Tag from the Side-Bar. At the Tag N arne to 
Add line type: TblList then click OK. 

ADD NEW TAG [!] 

Tag Name to Add: TblList~ 

Tag Name to Copy From: TblHead. __ 

I Cancel I 

When creating a new tag, Ventura starts by copying the at
tributes of an old one. It makes sense,. therefore, to copy from 
the tag that is most similar to the new effect you want. In this 
case, TbIHead is nearest to the final format . 

.. TIP: When adding a new tag, always copy from the tag that is 
nearest in appearance and format. 

Since you copied from TbIHead, the listing tag should be 
pretty close to the correct style. To finish the tag, change the 
font style to Normal and change the Above Spacing. 

m Font Style: Normal 

= Spacing Above: 14.00 fractional pts 
Add in Above: Always 
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Set the tab stops 
Since the font, alignment, and spacing are already correct, 
you need only modify the tab settings to get the new TblList 
tag to look the way you want. When you choose tab settings 
this time, use decimal tabs to line up the numbers with the 
decimal character in each column of the table. 

L1 Tab Settings Tab Number: 1 
Tab Type: Decimal 
Tab Shown As: Open Space 
Tab Location: 14,00 picas & points 

Tab Number: 2 
Tab Type: Decimal 
Tab Shown As: Open Space 
Tab Location: 22,00 picas & points 

Tab Number: 3 
Tab Type: Decimal 
Tab Shown As: Open Space 
Tab Location: 28,00 picas & points 

Check the appearance of your tag with Figure 2-32 . 

Figure 2-32. 

.lANUART· i 
Phase One- 5000.0~ 1 
~Two+2SOO.00+1175.00tB95.00" i 
~Three+1600.00+1600.00+0.0ft i i 
~Four·1500.00'1500.00+3750.00f : 
~Five+2SOO.00+2500.00'250o.od,!! i 
IOTALOO3'OO.oo.sg525.00tS937:0l 

i i 

FEBRUARY· MNlCHf 

2750.00. 1225.001 

-NOTE: If your table doesn't match our illustration, check the 
tab locations for the TblHead and TblList tags. 
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Apply TblList to the other paragraphs 
Now that you've completed the attribute and tab settings for 
the new tag, apply it to the remaining paragraphs in the table. 
Remember, you can select multiple paragraphs using the 
Shift-Click method. 

E Select the five paragraphs shown in Figure 2-33 and tag 
them as ThlList. 

JANUARr· FEBRUARY· MNlCHf 

Phase One- SOOo,or 2750.00- 1225.001 

111111. 9111111i IBilh ;E~tDltl 

IllIIill Imlllll~ la-II!III II iii 

IllIIill ~illllll\ ElI&I~h II-ilil. 

IllIIill· a~hlll; ~1&llh 91111111 

M ',,",fili 8,16 ,iioi.i 

Figure 2-33. 

Add a caption 
To put the final touch on the spreadsheet, attach a caption and 
label to the frame. 

Ii Enable Frame mode and select the frame that contains the 
spreadsheet. 

m Select Anchors & Captions from the Frame menu. 

E Choose Caption: Below and OK. 
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ANCHORS & CIllTlONS 

Rnchor: 

Caption: Below 

Label: 

Inserts: I Table ~ II Figure ~ II Chapter ~ II Text Attr. I 

A blank caption frame appears below the existing frame. 

Enlarge the caption frame 
~ Click in the caption frame so the sizing buttons appear. 

m Place the cursor on any handle at the bottom of the frame. 
Press and hold down the mouse cursor until the pointing 
hand appears. Drag the frame downwards about 3 lines 
and release the cursor. You should see an end offile marker 
( D) in the middle of the frame. If the marker is not visible, 
stretch the caption frame downwards a few more lines. 

The caption frame should look like Figure 2-34: 

Figure 2-34. 
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Add the caption text 
II Enable Text mode. Place the cursor in front of the end of file 

marker in the caption frame. Type: Project Costs for 
Desktop Publ.ishinq Inpl.ementation 

Format the caption text 
You've just created your first caption. Now you can change its 
format just as you would change any other tag. Notice that the 
caption paragraph is another one of Ventura's generated tags, 
as signaled by a name beginning with Z_ - in this case, 
Z_Caption. 

lij Enable Paragraph mode. Select the caption paragraph 
"Project Costs for Desktop Publishing Implementation." 

~ Font 

~ Alignment 

m Spacing 

Style: Bold 
Size: 012.0 points 

Horz. Alignment: Center 
Overall Width: Frame-Wide 
In/Outdent Width: 00,00 picas & points 

Inter-Line: 14.00 fractional pts 

Your caption should look like Figure 2-35: 

Figure 2-35. 



2 - 54 

Chapter 

Chapter 

- NOTE: If the caption text disappears from view, do not be 
concerned. Simply enable Frame mode, select the caption 
frame, and stretch it downward until the text appears. 

Now that you've completed text, style, and picture, it's time to 
complete the chapter part of the proposal. But first take a 
breather and save your work. 

m Select Save from the File menu (or press Ctrl-S). 

Print the current page 
To evaluate the editorial and stylistic changes you've made on 
screen, and to determine if you've achieved a more pleasing 
page design, print out the proposal. This time we will show 
you how to print the current page of a chapter. 

m Select To Print from the File menu. 

S Choose Which Pages: Current and OK. 

PRIHT IHFORt1RTIOH (POSTSCRIPT - Ultimate) m 
Which Pages: Current 

From Page: 00031 
Through Page: 0003 

Humber of Copies: 01 

Collated Copies: Off 
Printing Order: 1st to Last 

Paper Tray: Default 
Crop Marks: 0 ff 

Spot Color Overlays: Off 
HuHJ.· Ghp. Pd.nt. r.ih~s; GOf!lb.int.~d 

Device Name: POSTSCRIPT 
Output To: Filename 

Ventura prints out the current page. 

I Cancel I 

To print out the entire report, press Ctrl-X to bring up the To 
Print dialog box, choose Which Pages: All and click OK. Ctrl-X 
is a keyboard shortcut that recalls the last dialog box. 
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In the first two chapters you have learned how to build a 
report and a proposal using basic Ventura techniques. In the 
next chapter, you will polish off the remaining fundamentals 
while learning how to construct a new and important type of 
document - the newsletter. 

Tips and techniques 

Text tips 

D Use a word processor to globally search and replace double 
spaces before loading a text file into Ventura. 

o When you prepare text in your word processor for Ventura 
follow these guidelines. Do not: center or justify text; indent 
the first line of a paragraph; create temporary margins; put 
more than one space after a period, colon, or question mark; 
put more than one carriage return between paragraphs; or 
put more than one tab stop between columns. 

o Use the @PARAFILTR = ON code to filter out extra carriage 
returns in a text file. It must be inserted as the very first 
item in the document and it must be typed accurately or 
Ventura will ignore it. 

o If you want to load a single file into Ventura without it 
automatically being placed on the Page, select Load 
TextlPicture from the File menu while you are in Para
graph, Thxt, or Graphic mode. 

o Rename text, style sheet, and chapter files before you make 
any changes to the document. Renaming files eliminates 
the possibility of permanently changing the originals. 

o Use a word processor to make changes to large sections of 
text. Use Ventura's text-editing tools to make small, last
minute changes to text. You can cut, copy, or paste text or 
change text attributes of selected words within a para
graph. 

o Use Text mode to change one or two words within a para
graph. Use a paragraph tag to change the attributes of an 
entire paragraph. 

D Keyboard shortcuts can be used to speed up text editing in 
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Ventura. Press Del to cut text, Shift-Del to copy text, and 
Ins to paste text. 

D When you cut or copy text, it remains on the Clipboard 
until something else is cut or copied. This feature allows 
you to insert text from one chapter to another. Simply copy 
or cut the text, close the current chapter, then open another 
chapter. Press Ins to insert the text into the new chapter. 

Style tips 

D To make column widths equal, enter the value of the first 
column width, then the first gutter width, then choose 
Make Equal Widths from the bottom of the Margins & 
Columns dialog box. Use this order so that Ventura makes 
the column widths equal. 

D Turning Column Balance on from the Sizing & Scaling 
dialog box tells Ventura to fill all columns on the page 
equally. Without Column Balance on, Ventura fills the first 
column before starting the next. 

D Ventura measures the In/Outdent Width from the left mar
gin of the column. 

D When you create a new tag, always copy from the tag that 
is nearest in appearance and format the new tag to the 
effect you want. 

D To isolate text on a page, use a Page Break tag instead of a 
string of carriage returns. If you change a tag or add extra 
text, the carriage returns will "float" to the next page and 
push everything in the document out of place. 

D You can use the Shift-Click method to tag multiple para
graphs. 

D Headlines, headings, and subheads should include a 
Breaks: Keep With Next: Yes to keep them from becoming 
isolated at the bottom ofa page or a column. 

D Headers, footers, and captions are tags that are automat
ically generated by Ventura. Like all tags their attributes 
can be changed by working through the paragraph menu 
options. Generated tags have names that begin with a Z to 
distinguish them from other tags in the Assignment List. 
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Picture tips 

o The Sizing & Scaling dialog box allows you to precisely 
control the position and size of a frame. 

D Use horizontal tabs to format a table that does not exceed 
one line per entry. Use side-by-side paragraphs (see Chap
ter Eight) to format more complex tables. 

o The tab location is always measured from the left margin. 

D Turn off all tabs you do not use in a tag definition. Unused 
tab settings just take up extra memory. 

D The caption labels you type directly into the Anchors & 
Captions dialog box can only be edited through that dialog 
box. For longer captions, type text directly into the caption 
frame. 



Chapter Three 
Skills Checklist 

Theory 
o Frames versus the underlying page 

o Newsletter-style layout 

Text 
o Typing text inside a frame 

o Creating a text file inside Ventura 

o Faster tagging with function keys in 
Text mode 

Style 
o Double-sided page format 

o Vertical rules 

o Renaming and removing tags 
o How to create leader dots 

o More effects with ruling lines 

Pictures 
o Sizing and scaling an image 

o Creating caption labels 

Chapter 
o Manually inserting a page 
o Creating a publication 

o Backing up multiple chapters with 
Multi-Chapter 

o Printing selected pages 

o Switching printers properly 



Chapter Three 

A Two-Column Newsletter 

Theory 

Now that you've gained some momentum with Ventura, are 
you ready to step up the pace? In Chapter Three, you will 

create a newsletter, a document with different design require
ments than business reports and proposals. This project will 
introduce you to some of Ventura's most powerful features. 
The checklist on the left lists some of the techniques you will 
learn. 

By the time you've finished with Chapter Three, you'll have 
been exposed to all of Ventura's fundamental skills. You'll be 
equi pped with the basic tools to construct virtually any type of 
document. You are not ready to graduate, however, until you 
understand the difference between frames and the Underly
ing Page, and how to use this difference to build newsletter
style layouts. 

Understanding frames 
Ventura uses frames to contain text and pictures. You can 
draw frames anywhere on the page. 

To work on a frame - to change its size or to place something 
inside - you must first select it. To select a frame, enable 
Frame mode, then click once anywhere inside the frame 
boundary. Black sizing buttons appear around the edges (Fig
ure 3-1). 

You can use these sizing buttons to change the size of the 
frame. Place the cursor on top ofa button and press the mouse 
button until the pointing finger appears (Figure 3-2). Now 
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Figure 3-1. The black sizing buttons show which frame you 
selected. 

Theory 

drag the mouse - that is, move the mouse while holding the 
button down. When the frame is the proper size, release the 
button. 

Oq 
w .. -.J 

Figure 3-2. A pointing hand appears when you resize a 
frame. 

You can also move frames with ease. Place the mouse cursor 
anywhere inside the frame. Press and hold the button until 
the four-way arrow appears (Figure 3-3). Then drag the frame 
to the new location (move the mouse while holding the button 
down). 
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D"D 
b~;~~j 

Figure 3-3. A four-way arrow appears when you move a 
frame 

3-3 

You can copy a frame onto the frame clipboard (also called 
temporary memory) and then paste as many copies as you 
want onto the Page. Initially, the copy is invisible because it 
appears on top of the original. When you move the copy away, 
you will see the original underneath. You can also overlap 
frames (Figure 3-4). 

Figure 3-4. You can overlap multiple frames on the Page. 

All frames have a boundary. That boundary can be invisible. 
Or, if you prefer, you can put a ruling line above, below or 
around the frame. The thickness of the ruling line is up to you. 
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As you can see in the Figure 3-5, the boundary acts as a 
container. You can place text or pictures inside. 

Picture in frame --••• rti 
Rule above and 
below frame --I-r-I2Jt--t=~~ --~ 

Text in frame 

Double ruling box 
around frame 

Frames can have 
their own margins 

Frames can have 
their own columns 

~ .............................................. j 

Figure 3-5. A frame acts as a container to hold text or pic
tures. 

Suppose, that you pour a long file into a small frame. Ventura 
fits as much of the text as it can, then waits. You can draw 
additional frames to contain the rest of the text file. You can 
link these frames so the text file chains from one to the next. 
Frames can have margins and columns inside their boun
daries. For instance, you might place a margin inside a frame 
to keep a picture from butting up against the edge (Figure 
3-6). Or, you might create two columns within a single frame. 

Figure 3-6. 
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If you place a frame on top of the Page, the margins and 
columns of the frame will override the margins and columns of 
the Page. For instance, in Figure 3-7, a three-column frame 
has been placed on top ofa two-column Page. 

Figure 3-7. Frames can have different columns and mar
gins from the Underlying Page. 

You can also create a caption for any frame. This caption is a 
separate, smaller frame attached to the original. If you move 
the original frame, the caption moves with it. The text of the 
caption is contained within the caption frame (Figure 3-8). 

Figure 3-8. A caption frame is a separate frame attached to the 
original. 
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-NOTE: You cannot change the size of the Underlying Page 
interactively with the sizing buttons. You must change its size 
through the Sizing & Scaling dialog box. 

But the Page differs in one key aspect. When you place a text 
file into a frame, Ventura fits as much as possible, then waits 
for you to tell it where to put the rest. When you put text onto 
the Page, on the other hand, Ventura fits as much as possible 
onto the first page, then automatically creates as many pages 
as necessary to accommodate the rest of the file. 

Frames versus Pages 
You have placed text on the Page in the previous two chapters. 
Placing text on the Page is the method of choice when most of 
the chapter is made up of a single text file. But some docu
ments contain many different text files. Newsletters are a 
prime example. Theoretically, you could combine all the copy 
for a newsletter into one large file, and then format that file on 
the Page. In practice, however, it is much easier to keep each 
article as a separate text file. 

But how do you keep the articles separate when you bring 
them into Ventura? Simple: you draw frames on top of the 
Page. Then you place the articles into those frames. 

By the way, you can combine both frames and pages in the 
same document, as we did in Chapter '!\vo. The bulk of the 
proposal was in a single text file on the Page. The worksheet, 
however, was a separate file that resided inside a frame. That 
frame had been drawn on top of the Page. 

Newsletter-style layout 
Let's summarize what we've learned. Frames create boun
daries that separate files. You can use frames to place one text 
file into the left column and a second file into the right column 
(Figure 3-10), When you put text into a frame, it flows to the 
end of that frame. Even if there is text left over, Ventura does 
not create additional frames. Instead, it remembers where it 
left off, and waits for you to place the remainder. You can put 
part ofa file into column one on the page one, and continue the 
rest of it onto page two (Figure 3-11). 
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Figure 3-10. Frames allow you to place different files on 
the same page. 

Xerox release8 2.0 

D 

Figure 3-11. Text in frames can flow from one page to another. 

Theory 
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Ventura remembers this path. As you make editing changes, 
the text automatically flows back and forth between page one 
and page two. In addition, articles can "leap-frog" one another. 
This automatic link between frames on different pages is 
sometimes called "chaining." 

.. TIP: When building newsletter-style documents composed of 
several different text files, put the text into frames, not onto the 
Page. 

How do you know where to position the frames? Simple: for
mat the Page with the correct margins and columns. Then use 
the Page as a guideline. Thanks to Ventura's snap-to features, 
your frames will automatically align with the columns on the 
Page . 

.. TIP: Use the Page to create a snap-to grid for positioning 
frames in a newsletter-style layout (Figure 3-12). 

[--------1 f---------, :--------1 
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". I 
I " I I II I 
I II I 
"I I 
"I I 
"I • 
I It I 
I II , 
I II I 
I II , 
I II I 
I I, , 
• II I 

t " I 
I " , 
"I I 

:!! 1 

l _______ Jl ________ J , ______ J 

Figure 3-12. To create a newsletter-style layout, 
first create a snap-to grid by formatting the 
Underlying Page (A). Then stretch frames over 
the Page (B,C,D). You will place your text and 
pictures inside the frame. 
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There is one more crucial principle you need to know before 
you are ready to start building a newsletter: Ventura can only 
flow text in a 'rorward" direction. 

We put quotes around the word forward, because it means 
different things to Ventura than it does ordinarily. On a page
by-page basis, the meaning is straightforward. Ventura can
not flow text backwards to a previous page. 

The "forward-only" restriction also applies on a single page 
with several frames. On a single page, however, the flowing 
order depends on which frame was drawn first. Ventura can 
flow text from the first frame to the second frame, but it 
cannot flow ''backward'' from the second frame to the first. 

The position on the page makes no difference. Ventura deter
mines text flow strictly on the basis of the order the frames 
were placed on the page. For instance, in Figure 3-13, Ven
tura can flow text from frame #1 to frame #2 - not the reverse 
(Figure 3-13). 

Figure 3-13. Since frame #1 was drawn first, text can flow from frame 
#1 to frame #2. Text cannot flow in the reverse direction. 

WARNING: The sample project in this chapter uses numbered frames. Draw these 
frames in the order shown. If you draw them in a different sequence you may be 
unable to flow the text properly. 

Fortunately, Ventura provides a simple method for changing 
the order of frames. To make a frame the "last" one, simply 
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select the frame, delete it, and reinsert it again. In Ventura's 
eyes, it is now the last frame on the page. If you accidentally 
draw frames out of order, use this method to correct the 
problem. 

You will use the principles explained above to construct the 
newsletter in this chapter. First you will format the Page. 
Then you will draw frames on top, using the margins and 
columns of the Page as your guide. Finally, you will put text 
into the frames. 
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Planning the newsletter 
The goal of a newsletter is to provide timely information to a 
specialized audience. This chapter's example is a corporate 
newsletter, an in-house organ for the fictitious XYZ Corpora
tion. 

Most newsletters are 8.5xll in. The simplest design consists 
of two pages stapled together or printed on both sides. Even 
the most complex newsletters rarely exceed 24 pages or so. 
Overall design should be informal and relaxed to help convey 
a sense of timeliness. The best design is simple, open and 
uncluttered. 

Look at the ''before'' picture of the newsletter. Below is a list of 
the methods you will use to enhance its appearance and effec
tiveness. 

• Large type for a logo 

• Rules to separate and define different sections 

• A kicker and a banner headline 

• A table of contents 

• Two-column format 

• Uniform spacing to align text across columns 

Ventura prep 
As you did in the previous two chapters, you will start the 
project by loading and renaming the text, style, picture and 
chapter files. 

II If you have the Power disk 
For this project you will load four files at once. Later in the 
chapter, you will place them into frames - one for the logo, 
one for the headline, and two for articles. The text files are 
provided on the Power disk and should have previously been 
copied to the C:\POWER subdirectory according to the direc
tions with the disk. These files have been preformatted with 
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tag names and non-keyboard character codes. (Refer to Chap
ters Two and Seven for more on preformatting.) 

-NOTE: If you did not purchase the Power disk, skip to the 
section below entitled "If you do not have the Power disk. " 

m If you are continuing from the previous chapter, select New 
to clear the last project from the screen. Ventura removes 
the text files and frames but keeps the style sheet. 

~ Select Load TextlPicture from the File menu. 

m Choose Type of File: Text, Text Format: ASCII, # of Files: 
Several, Destination: List of Files, and OK. 

LOAD TEXT/PICTURE 

Type of File: III I Line'Art II looge I 
Text Fornat: ,Generated, IilIII 'NordStar 3 , ,!tS 4.8/5.9 , 

, "S'Word' 'WordPerfect' ,Xy!trite , 'B' Bit ASCII' 

, DCA' I MultiMate I 'PRN·to· Table , ~~~~I 

,!triter, 

*I of Files: ~ ,;;; .. 

Destination: 'Dj"IIIM 'Text Clipboard I [I!~~f.!l~~~.~i.;:iEJ 
I Cancel I 

m Find the C:\POWER subdirectory and scroll through the 
list until you find the file 3NEWSHED.TXT. Select the file. 

Mter you select the first file, Ventura loads it, then redisplays 
the Item Selector so you can load more files. 

~ Load the files 3NEWSLGO.TXT, 3NEWSONE.TXT, and 
3NEWSTWO. TXT. When you are finished, choose Cancel or 
OK to close the dialog box. 
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Rename the text files 
In Frame mode, you will place each of the text files on the 
Page in turn. 

m Using File TypelRename from the Edit menu, rename the 
files as shown below: 

Load from C:\POWER 

c: \POWER\3NEWSHED.TXT 

c: \POWER\3NEWSLGO.TXT 

c: \POWER\3NEWSONE. TXT 

C: \POWER\3NEWSTWO.TXT 

Save to C:\TEMP 

C:\TEMP\3HEAD.TXT 

C: \ TEMP\3LOGO.TXT 

C: \ TEMP\3NEWS-l.TXT 

C: \ TEMP\3NEWS-2.TXT 

B Use Remove TextJFile from the Edit menu to remove the 
last text file from the frame. Remember to remove them 
from the frame but not from the list offiles. 

Load and rename a style sheet 
As before, you will be modifying one of the style sheets 
provided with the Ventura program disks. 

m Select Load Diff. Style from the File menu . 

• Use the Backup button if necessary to go to the 
C: \ TYPESET subdirectory. Load the style sheet named 
&NEWS-P2.STY. 

m Select Save as New Style from the File menu. 

m Go to the C: \ TEMP subdirectory and save the new file as 
3NEWS.STY. Then click OK. 

Load a picture 
m Select Load TextlPicture from the File menu. Choose Type 

of File: Image, Image Format: GEMIHALO DPE, # of Files: 
One, and OK. 

iI Move to the C:\TYPESET subdirectory and load 
CHANEL.IMG. 
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If the picture is placed on the Page, use Remove TextlFile to 
remove it from the frame (not from the list offiles). 

-NOTE: CHANEL.IMG was copied to the \TYPESETsubdirec
tory during Ventura installation. If you have deleted or moved 
this file, use DOS to copy it back from the original Ventura 
examples disk. 

Rename the chapter 
When you have finished loading and renaming the text and 
style sheet files, save the chapter with a new name. 

m Select Save As from the File menu. Go to the C:\TEMP 
subdirectory and type in the new chapter name, 3NEWS, 
and click OK. 

If you do not have the Power disk 
II Exit from Ventura. 

Text 

mUse your word processor to type in the text files 
3HEAD.TXT, 3NEWS-1.TXT, 3NEWS-2.TXT and 
3LOGO.TXT from Appendix A. Copy them to the C:\ TEMP 
subdirectory. 

m Then load Ventura and proceed through the Ventura prep 
section starting at "Load and rename a style sheet." 

Normally you would place the text files at this point. However, 
since you will be putting those files into frames, and not onto 
the Page, you must deviate slightly from the Ventura For
mula. The only change is to delay placing the text files until 
you build frames to contain them. To build these frames, 
proceed to the Style section. 
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Style 
Your goal is to create frames of the right size and position to 
hold the text files. To make this job easier, first construct the 
Underlying Page. Then you can use the Page as a guide for 
placing frames. 

-NOTE: Remember our rule of thumb: complete the chapter 
formatting before the individual text paragraphs. This rule is 
even more important when using newsletter-style layout. 

Change to double sides 
The in-house newsletter will be printed on both sides of the 
paper, so you must switch to double-sided page layout. Ven
tura then makes a mirror image of headers, margins, etc., 
from the right to the left page. For instance, the page number 
format on the right side of a right-page header will be copied 
to the left side of the left-page header. 

~ Select Page Size & Layout from the Chapter menu. Choose 
Sides: Double, and Start On: Right Side. 

Change the margins 
Now increase the size of the page margins and the gutter 
margin. You are altering the original style sheet to make the 
columns shorter and to add more white space around the 
edges of the page. 

~ Enable Frame mode. 

1m Select Margins & Columns from the Frame menu. Make 
the top and bottom margins 04,06 picas & points, the left 
and right margins 06,00 picas & points. Make the Column 
1 width 18,06 picas & points and the first gutter 02,00 picas 
& points. Make the Column 2 width 18,06 picas & points. 
Choose Copy to Facing Page and click OK. (The Copy to 
Facing Page button does not stay highlighted after you 
choose it.) 



3 - 18 

MARGINS & COlU"NS 

~ of Colul1lns: IT] II m m []] m m [[] 
Settinas For: I left Paaa I Wnl",. 

Colullln 1: 
2: 
3: 
4: 
5: 
6: 
7: 
8: 

Widths 
18,96 
18,96 
OO,f.If.I 
~,~~ 
OO,f.lf.t 
OO,f.lf.! 
OO,f.lf.! 
OO,f.lf.! 

Gutters 

92, 9°1 nO,no 
00,00 
O(),OO 
00.00 
00.00 
00,00 

Margins 
Top: B4.B6 picas & points 

Bottolll: 04.06 
left: 06.00 

Right: 06.00 

Calculated Width = 51,OB 
Actual Fral1le Width = 51,09 

Inserts: 1 Make Equal Widths 1 I Copy To Facing Page I 
I Cancel I 

Style 

Create a vertical rule 
Vertical Rules creates a ruling line between columns. The rule 
is always the same height as the columns. 

m Select Vertical Rules from the Frame menu. 

m Place the cursor on the Rule 1 Width line and change the 
unit measurement to fractional pts. 

m Select Settings For: Right Page, Inter-Col. Rules: On, 
Width: 00.25 fractional pts. Choose Copy to Facing Page to 
mirror these settings to the opposite page. Click OK to close 
the dialog box. 

VERTICAL RULES [!] 
Settings For: I left Page I 'imijlgma 

Inter-Col. Rules: On Width: 99.251 

Rule 1 Position: 99,09 picas & points 
Rule 1 Width: 90.09 fractional pts 

Rule 2 Position: 09,09 
Rule 2 Width: 00.99 

Inserts: Copy To Facing Page 

OJ< I Cancel I 



Add a header 3 - 19 

Add a header 
To complete the chapter format, add a header that includes 
the newsletter's name, the page, and the month of the issue. 

m Select Headers & Footers from the Chapter menu. 

m Choose Define: Right Page Header, Usage: On. Move to the 
Left line and type: The Newsl.etter, move to the Center 
line and type: Page [Pi], and move to the Right line and 
type: Fal.l./Winter 1989 

-NOTE: You can also use the Inserts: Page # button to insert 
the [PI] code. 

m Choose Copy to Facing Pages to mirror the header settings 
to the left page. Click OK to close the dialog box. 

HEADERS & FOOTERS 

Define: 'left Page Header' Right Page Header 

, Left Page Footer , 'Right Page Footer' 

Usage: II I Off I 
Left: The Hewsletter __________ _ 

Center: Page [PIl1 ____________ _ 

Right: Fall/Winter 198911--_________ _ 

Inserts: I Chapter It I I Page It I I 1st Match I I Last Match I 
, Text Attr. , Copy To Facing Page, 

Now turn the header off for the first page only. 

m Select Turn Header Off from the Chapter menu. 

Fine-tune the chapter format 
Now that you are warmed up, we're going to pick up the pace 
and show you how to use some special typographic techniques 
to fine-tune the chapter format. 
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il Select Chapter Typography from the Chapter menu. 

There's a lot to the Chapter Typography menu. We will ex
plain only those options you need for this project - so don't 
panic. The other options we will leave for later chapters. 
Because Chapter Typography is complex, you may want to 
read through this section more than once. 

Let's start with the option: Widows and Orphans. 

A widow is a single line of text at the top of a frame or column. 
An Orphan is a single line of text at the bottom of a page or 
column. The Widows and Orphans option lets you control the 
number of lines you will permit on a page. 

Normally, the default setting for both widows and orphans is 
2. However, for a newsletter-style document, we suggest that 
you disable Widows and Orphans completely (by setting both 
values to 1). With Widows and Orphans turned off, Ventura 
can place a single line of text at the top or bottom of a frame. 
This makes it easier for text files to reach the bottom of the 
frame and reduces the change for a white-space gap at the 
bottom. 

m Move to the Widows (Min Lines at Top) line and choose 1. 
Move to the Orphans (Min Lines at Bottom) line and once 
again choose 1. 

Next, verify that Column Balance is off. With Column Balance 
on, Ventura fills all the columns on the Underlying Page 
equally with text. In a newsletter-style document, however, 
you achieve balanced columns by placing text files in in
dividual frames on the Page. 

m Choose Column Balance: Off. Do not close the dialog box 
yet. 

The next option, Move Down to 1st Baseline By, lets you 
control the position of text at the top of a column or page. You 
can choose either Move Down to 1st Baseline: By Cap Height 
or Move Down to 1st Baseline: By Inter-Line. 
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Move Down to 1st Baseline by Cap Height places the baseline 
of the first line of text so the tops of capital letters touch the 
top of the column guide. On the other hand, Move Down to 1st 
Baseline by: Inter-Line, positions the baseline a distance 
equal to the tag's inter-line spacing. Both methods affect the 
way that Ventura will flow the text on the page (See Figures 
3-14 and 3-15). 

1 rary 0 pro esslOna -qua 1 y S yes ee s. e s 
library will consist of over fifty different business 
cal documents including reports and proposals, fo 
house flyers, newsletters and manuals for XYZ's 
documentation. Using one of the pre-defined tern 
XYZ employees can obtain the benefits of graphi 
and typesetting. All they will need to do is select 
propriate style sheet and use it to process their do 

"The average consumer is becoming increasin 
to high-quality graphic design," said President Zy 
"They have come to expect it. In the future, comp 

Continued on page 2 

Figure 3-14. Mhough the differences between By Cap Height and By 
Inter-Line are not obvious at first glance ... 

library will consist of over fifty different business 
cal documents including reports and proposals, fo 
house flyers, newsletters and manuals for XYZ's 
documentation. Using one of the pre-defined temJ: 
XYZ employees can obtain the benefits of graphic 
and typesetting. All they will need to do is select a 
propriate style sheet and use it to process their doc 

"The average consumer is becoming increasing 
to high-quality graphic design," said President ZYl 
"They have come to expect it. In the future, comp, 
do not produce attractive documents will be at a d 
vantage. We are determined that the documents w 
Continued on page 2 

Figure 3-15 .... they can add up in a multi-column document.The only 
change between these two examples is that the top one is By Cap Height 
and the bottom is by Inter-Line. 
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The position of the text baseline affects the alignment of text 
across columns. For best results in a newsletter, we suggest 
that you 1) choose Move Down to 1st Baseline By: Inter-Line 
and 2) make all vertical spacing an integer multiple of Body 
Text. That way you get 

• an integral number of Body Text lines per page 

• a more uniform-looking page 

• text that is aligned across multiple columns 

Now go ahead and change the baseline position of the text. 

~ Choose Move Down To 1st Baseline By: Inter-Line. Then 
click OK to close the dialog box. 

CHRPTER (DEFRULT) TYPOGRRPHY SETTINGS 

Widows (Min Lines at Top): 1 
Orphans (Min lines at Bottom): 1 

Column Balance: Off 
Moye Down To 1st Baseline By: Inter-Line 

Pair Kerning: On 

I Cancel I 

You made it. You got through the hardest part of the Chapter 
Typography menu. Now catch your breath and take a moment 
to save your work . 

.. TIP: Save every 15 minutes or less to reduce the risk of losing 
work due to a computer glitch, software crash, or power out
age. 
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From now on, we will not remind you to save. We will assume 
that you are regularly pressing Ctrl-S as you progress through 
the chapter. 

With the structure of the Underlying Page complete, you can 
draw frames on the Page. 

Before you start, go to the Options menu and confirm that 
Line Snap and Column Snap are turned on (when Column 
and Line Snap are on, the Options menu displays "Turn 
Column Snap Ofl" and "Turn Line Snap Ofl") and that the 
column guides are visible (the Options menu displays "Hide 
Column Guides"). 

These snap-to features help line up frames properly. Thanks 
to Column Snap, frames automatically snap to the column 
guides on the Page. Use the ruler to gauge the approximate 
height. 

-TIP: Before you place any frames, check that the zero point is 
reset to the upper left corner of the Page (click the 0,0 square 
in the upper left corner). Otherwise, the ruler settings on your 
screen will not match ours. 

m Enable Frame mode. Select Add New Frame from the Side
Bar. Place the frame cursor at the upper left corner of the 
dotted column guides on the Page. 

m Press and hold down the mouse button. Drag the lower 
right corner of the frame downwards and to the right. 

II Release the button when the bottom of the frame reaches 
the right margin and lines up with position 16,06 picas on 
the vertical ruler (Figure 3-16). 
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t ................... ..! ..................... .1 

Figure 3·16. 

m Repeat the step above to place all the frames on the page. 
Place the frames in the numeric order (1 through 6). Use 
Figure 3-17 as a guide before you fine-tune the frame size 
as explained in the next step. 

Try to get the frame sizes approximately right, but don't worry 
about precise placement yet. Some users prefer to make the 
initial placement in Reduced View, before switching back to 
Normal View for fine-tuning. 

'-NOTE: If you place a frame in the wrong position, delete it and 
try again, or move it with the mouse cursor. 

Mter drawing the frames, you can use the Sizing & Scaling 
dialog box to make sure they match the values shown in 
Figure 3-17 . 

• Select each frame in turn. 

B Select Sizing & Scaling from the Frame menu. If necessary, 
change the frame height, width, or upper left X,Y position. 

'-TIP: You can use Ctrl-X to bring up the Sizing & Scaling dialog 
box again. Ctrl-X is the shortcut for "recall the last dialog box. " 
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Figure 3·17 

Frame #3 
Upper Left X: 06,00 picas 
Upper Left Y: 23,06 picas 

18,06x20,00 picas 

Leave a one-pica space 
/ be_nlheliames 

Frame #5 
Upper Left X: 06,00 picas 
Upper Left Y: 44,06 picas 

18,06x 7,00 picas 

Frame #1 
Upper Left X: 06,00 picas 
Upper Left Y: 04,06 picas 

39,00x11, 00 picas 

Frame #2 
Upper Left X: 06,00 picas 
Upper Left Y: 15,06 picas 

39,00x08,00 picas 

02,00 picas 

Frame #4 
Upper Left X: 26,06 picas 
Upper Left Y: 23,06 picas 

18,06x37,00 picas 

Frame #6 
Upper Left X: 26,06 picas 
Upper Left Y: 60,06 picas 

18,06x01 ,00 picas 

/ 
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For instance, Figure 3-18 shows the correct Sizing & Scaling 
settings for frame #1. 

SIZING & SCALING 

Flow Text Inlund: & 

Upper left X: 86,00 a c.:J lMJer left Y: 04,86 a c.:J 
FraJlle Width: 39,OB FraJlle Hei~t: 11 J~ 

Horiz. Padding: OO,OB Vert. Padding: 00,00 picas & points 

Pi.Gtur'\; Sc:alirI9: [fIfJ~~~~~:~~£J [!~J~~}~;'~~~~~i~~~J 

Aspect Ra~io: r§~~!iE~!i~i1J m!~F!f~~] 

X Crop Offset: ~))OO [~~JL':~J Y Crop Offset: 00,00 r-;:'lr:-l 
Scale Width: ~))OO Scale Hei~t: OO,(~) ,_ .. ,_ .. , '_ .. _ .. -

~ ICancel! 

Figure 3·18 . 

.. NOTE: Don't be concerned if the small'Jump text frame" at the 
bottom of the page overlaps the frame above it. Later, when 
you change the Body Text inter-line spacing, you will make the 
frame line up with the bottom column guide. 

Add a ruling box around the TOe 
Before you place the text, add a Ruling Box Around the frame 
reserved for the Table of Contents (frame #5). This box will 
visually separate the Toe from the adjacent articles. 

~ Select frame #5. 

11 Ruling Box 
Around 

Place the text files 

Width: Frame 
Height of Rule 1: 00.25 fractional pts 

With the frames in place and correctly sized, you are ready to 
place the text files. Since the text files were pretagged, they 
will be partially formatted as soon as they are placed. You will 
do the rest of the formatting later. 

!& Select frame #1, then place the file 3LOGO.TXT by select
ingits name from the Assignment List (Figure 3-19). 
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Figure 3·19. 

~ Select frame #2 and place 3HEAD.TXT inside of it (See 
Figure 3-20). 

Figure 3·20. 

II Select frame #3 and place 3NEWS-l. TXT inside. 

Ventura fits as much of3NEWS-1.TXTinto the frame as it can 
and then stops. To continue placing the text file, select 
another frame and click again on the file name in the Assign
ment List. 

m Select frame #4 and select 3NEWS-l. TXT again from the 
Assignment List. 
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Ventura picks up where it left off and flows more of the file 
into frame #4. It stops again when the frame is filled. Later 
you will place the remainder of the article on page two. Before 
going on, check to make sure your first page resembles the one 
we show in Figure 3-21. 

The Newsletter 

... _-
Pre.ident approve. de8ktop publishing 
company-wide 

Figure 3-21. After placing the text on the first 
page, your page should look like this 
illustration. 

Create a table of contents 
To create a table of contents, you will type text directly into a 
frame. The text you enter will be treated as a separate file 
when you save the chapter. 

-.. NOTE: Text typed into a separate frame is saved as part of the 
caption file unless you rename it as shown below. 

~ Enable Text mode. Change to Normal or Enlarged View. 
Make sure Show Tabs & Returns is selected from from the 
Options menu. Click the cursor anywhere inside frame #5. 

The end of file marker appears at the top left corner of the 
frame. 
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-TIP: Remember, you can zoom into a selected area on the 
page by placing the mouse cursor at the spot which will be the 
upper left corner of the magnified view and pressing Ctrl-N or 
Ctrl-E. 

li Place the text cursor in front of the marker and type: Table 
of Contents [Enter] 

Now type the TOe entries, line by line. Press the tab key once 
between the text and the page number (Figure 3-22). 

Figure 3-22 

Conttntsf 
PrtSi4en! awoves desklop pu~1ishlnr11 
XYZhnsspe<illisl-2! 
lItw p1ln! tomes on·lineo3! 
People on the movt'Sll 
LeHerstolhee4ilor<SI 
CDnda~ 

President approves desktop 
publishing [Tab] 1 [Enter] 

XYZ hires specialist [Tab] 2 [Enter] 

New plant comes on-line [Tab] 3 [Enter] 

People on the move [Tab] 5 [Enter] 

Letters to the Editor [Tab] 6 [Enter] 

Calendar [Tab] 8 [Enter] 

-NOTE: If you make a mistake you can delete a letter by 
pressing the backspace or Del key. 
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Once you type text into a frame, you can give it a name and 
save it in the text format of your choice (Figure 3-23). 

~ Enable Frame mode. Select the table of contents frame 
(frame #5). 

The default file name, ''FRAME TEXT," appears in the Cur
rent Selection Box. 

m Select File TypelRename from the Edit menu. 

~ Move to the New Name line. Press Esc to clear the line and 
type:C:\TEMP\3NEWSTOC.TXT 

~ Choose Text Format: ASCII and click OK to close the dialog 
box. 

FILE TYPE / RENAME 

Old Hallie: 

Hew Hallie: C:\ TEMP\3NEWSTOC. nnl....--_____ _ 
Text Fornat: I Generated IIimDJ I WordStar 3 I I ~s 4.13/5.0 

Figure 3·23. 

I MS-Word I I WordPerfect I I XyWrite II 8-Bit ASCII I 
I DCA I I MultiMate I I PRN-to- Table I I WordPerfect :5 I 
I Writer I 

This saves the table of contents text as the file 
3NEWSTOC.TXT in the C:\TEMP subdirectory and displays 
the new file name in the Assignment List. 

There's one thing left on the first page: thejump text at the 
bottom of the page. You will create it just as you created the 
TOC text: by typing directly into the frame. This time, how
ever, you will not give it a new file name. Because you are not 
renaming the file, the text you type will be stored in the 
chapter's caption file. 
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11 Enable Text mode and click anywhere inside frame #6 (See 
Figure 3-24). Then type: Conti.nued on paqe 2 

Figure 3·24 

til Stopping point 
Are you keeping up with the pace? If not, take a moment to get 
out of your chair and stretch. When you're recharged, sit back 
and review what you've done and what remains to be com
pleted in the style section. First you made format changes to 
the overall chapter. Then you laid out page one by adding 
frames and placing text inside. 

Now you are ready to tackle page two. Once this layout work 
is complete, you can begin to format the text by working 
systematically through each paragraph in each frame. 

If you must stop now, save your work by pressing Ctrl-S, then 
select Quit from the File menu. Return to this spot in the text 
when you are ready to resume the project. Otherwise, move on 
to the next section now. 

Insert a page 
If you are starting up again, load Ventura and open the chap
ter C:\TEMP\3NEWS.CHP to begin where you left off. Once 
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you are on page one of the document, you are ready to proceed 
with the instructions that follow. 

When you place text in frames (as opposed to putting it on the 
Page), Ventura does not create new pages automatically. 
Therefore, you must manually insert a new page. 

~ Select InsertlRemove Page from the Chapter menu. Choose 
Operation: Insert New Page After Current Page. Click OK. 

INSERT/REHOUE PAGE 

Operation: I Insert New Page Before Current Page I 
Insert Ne~l Page After Current Page 

I RerIlove Current Page I 

Ventura inserts the new page and moves you to it. 

At this point, you can add frames to the new blank page as you 
did earlier on page one. Use Figure 3-25 to gauge the ap
proximate positions and sizes. 

You can use several strategies for placing frames on the page. 
One idea is to draw the frames in approximate position, then 
return to each frame one by one to check its position with the 
Sizing & Scaling dialog box (as explained below). In that case, 
we recommend that you press and hold the Shift key as you 
click on the Add New Frame button. As long as the Shift key is 
depressed, Ventura will let you continue to draw frames 
without the need to choose the Add New Frame button each 
time. 
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------I---- Frame #7 
Upper Left X: 06,00 picas 

Frame #8 Upper Left Y: 04,00 picas 

Upper Left X: 06,00 picas 18,06x02,00 picas 
Upper Left Y: 06,06 picas 

18,06x16, 00 picas 

Frame #10 
Upper Left X: 26,06 picas 
Upper Left Y: 04,06 picas 

18,06x34, 00 picas 

Leave a two-pica space 
between frames for the caption 

Frame #9 / 
,/ 

Upper Left X: 06,00 picas 
Upper Left Y: 22,06 picas 

18,06x39, 00 picas 

Frame #11 
Upper Left X: 26,06 picas 
Upper Left Y: 40,06 picas 

18,06x21, 00 picas 

Figure 3·25 
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If you prefer, you can draw and position each frame as you go. 
First; draw the frame as closely as you can. Then, with the 
frame still highlighted, choose Sizing & Scaling, you can 
return to this dialog box for the next frame by pressing Ctrl-X, 
a keyboard shortcut that tells Ventura to bring up the last 
dialog box again . 

.. NOTE: If you make a mistake, you can a/~ays delete a frame 
by pressing the Del key or selecting Cut Frame from the Edit 
menu. 

Finally, you can also create frames by drawing the first one, 
then copying it to the clipboard. Create new frames by press
ing the Ins key to put a copy on the page. Move the copy into 
position and change its size. This is particularly useful when 
creating multiple frames of the same size. 

Size and scale the frames 
After adding the frames, check the dimensions one by one 
with Sizing & Scaling from the Frame menu. Use Figure 3-22 
as your guide. 

Place the text 
Finish placing the text files by selecting the frame, then 
choosing a file name from the Assignment List. At this stage, 
don't worry whether or not the text fits perfectly inside the 
frame. 

D! Select frame #8 and place the remainder of text file 
3NEWS-1. TXT inside. 

R Select frame #9 and place 3NEWS-2.TXT inside. 

~ Select frame #10 and place 3NEWS-2.TXTinside. 

When you have finished, change to Reduced View to check 
that your screen looks similar to Figure 3-26: 
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Figure 3·26. 

Add jump text on page two 
m! Enable Text mode. 

m! Change to Normal or Enlarged View. Place the text cursor 
anywhere in the small frame (frame #7) at the top of the left 
column (Figure 3-27). Type: Continued from page 1 

Figure 3-27. 

As before, the text you type into the frame is automatically 
saved to the caption file the next time you save the chapter. 
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Mission accomplished. Since frame #11 is reserved for a pic
ture file (to be added later), you have finished the basic layout. 
Now you can start tagging. As always, you should start with 
Body Text and then step through the document from begin
ning to end. 

Format the Body Text 
You may want to change to Normal View (Ctrl-N) as you tag 
the document. 

~ Press the Home key to return to the first page of the 
document. 

~ Enable Paragraph mode. 

~ Select the paragraph in frame #3 that begins ''We initially 
thought ... " (Figure 3-28). Refer back to Figure 3-17 if 
necessary to recall the frame numbers and positions. 

Figure 3·28. 

~ Alignment 

~ Spacing 

: Prtsillent Xlvier Y. Zygniewsli .1UI000netd tod.y his; 
~PJlfOVII of. 12'1!1onth p'an to insll.n desktop publishing: 
;'orkstitions in key depuJments Ihroughoul XYZ Co~: 
~o"'tion. The lIInounl:OlTlent follow, 1 Ihree'month ,,1ot: 
i;tuly unducU by the Marketing CommuniCitions: 
Dewtmonlf : 

'We mlt,.lly thought Ih,t de,lI.p publlShmg would 
nly have JdVintiiges for one or two depar1men151"saJd 
~resldent Zygmew,kl, "but our study "led thlt 11 
• tuM save flme and money throughout eompanj 
Jl\l\€; troprovlfl-: th", i~tt:'t..rU.f~ li",d ~ff .. ~t\~"re<:.s i)f (llJf 

~('~UTl pnts" 
: Sevnl tecnnologi<ll Idv.nees MIl. Ihe company': 
;"ide shlegy fwi'ole. Fim, XYZ WI$ l'ole 10 slind>: 
;"di~ on I single soflwlre pognm fO( .11 .pplic.lions.: 
:rhi, sll.ndudmtion will rt<I~ 51,rtup, tnining .nd: 
~pportcosls. Second, \he seleded soflwire,Xerox Veil': 
1\1", I'IIbtisher, will run on the IBM KT· Ind AT~ollt: 
~.tiblo compulers .toldy in pllce II KYZ. Many of the; 
j)thlr soflwire pldages would hm required the pu~: 
fhue of new or wompatibl. mnpul.rs. Mr. Zyg.! 

Horz. Alignment: Left 

Inter-Line: 12.00 fractional pts 
Add in Above: When Not At Column Top 
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- NOTE: From this point on, any spacing values not specified 
should be set to 00.00 fractional pts (or 00,00 picas & points). 
In the example above, for instance, you would set Above, 
Below, and Inter-Paragraph to 00.00 fractional pts. 

Format the Logo 
A newsletter's nameplate, or logo, should be the dominant 
element on the page. It should be easy to read and large 
enough so it doesn't vie for attention with the credo or the 
headlines. 

~ Go to frame #1. Select the paragraph "The Newsletter," 
which has been defined as the Masthead tag in the original 
style sheet. Let's change some of its attributes. 

m Font Size: 072.0 points 

- NOTE: Your printer may not be capable of 72-point type. 

You have several choices if your printer cannot produce 72-
point type. First, you can use the Set Printer Info dialog box to 
switch to PostScript just for the on-screen examples. Switch 
back before printing. When you switch back, Ventura will 
make an attempt to substitute font and font sizes. 

Second, you can simply use your original printer, and sub
stitute the largest font available in place of 72-point type. 
Keep the line spacing and other selections the same so your 
screen will match the book's as closely as possible. Your ex
ample will not look quite as good at printout time, but you 
should be able to follow along for learning purposes without 
any problems. 

Third, you can add a 72-point font to your system, either by 
buying it from a third-party vendor, or by generating it with a 
font building program. 

Don't worry yet about the way the logo looks (Figure 3-29). In 
a moment you will adjust it to fit. First work through the 
Paragraph menu and change the Alignment and Spacing. 
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Figure 3·29. 

m Alignment 

• Spacing 

Overall Width: Frame-Wide 

Below: 12.00 fractional pts 
Inter-Line: 48.00 fractional pts 

Style 

The logo is too large for the current frame. You could reduce 
the font size, but that would diminish the impact of the logo. 
Instead, you can use one of Ventura's typographic functions to 
tighten up the spacing between individual characters. This 
technique, called tracking, has two benefits: It fits the word 
into the frame and it enhances its readability. Tracking is 
most often used to improve the look of large banner headlines. 
Headlines tend to appear loose if spaced with the same 
proportion as sub-heads or Body Text. Figure 3-30 shows how 
different tracking values affect the apperance of a headline. 

By changing the tracking of the Logo tag you can make it fit 
into the frame without changing the font size or the frame 
size. 
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Very tight The Newsletter 
Tight The Newsletter 

Normal The Newsletter 
Loose The Newsletter 

Very Loose The Newsletter 
Figure 3·30 

m Select Paragraph Typography from the Paragraph menu. 

lm Choose Automatic Pair Kerning: On, Letter Spacing: Off. 
Choose Tracking: Tighter. Press Esc to clear the tracking 
line and type 0.048 Ems. Click OK. 

'Masthead" TYP06RfIIHY SETTINGS m 
Automatic Pair Kerning: On 

letter Spacing: Off Up to: O. 100 [I~S 
Tracking: Tighter O.~ E"s 

Grow Inter-Line To Fit: On 

Minitlutl Space Width B.6SS * (space width) = 0.167 ["S 
Nortlal Space Width 1.BSS * (space width) = 0.278 ["S 

Maxiriurl Space Width 2.000 * (space width) = 0.555 EllS 
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-NOTE: Don't worry if the text overlaps on-screen. When you 
print out the document, the text will appear correctly. 

There's a lot of power in the Paragraph Typography dialog 
box. For now, we'll talk about tracking and leave the other 
features for later. Tracking controls the space between letters. 
It is measured in ems. An em space is equal to the point size of 
the type. For 10-point type, an em space is 10 points, for 
18-point type it is 18 points, and so on. 

- TIP: Standard spacing is generally too wide for display type 
larger than 24.00 fractional pts. To make your pages look more 
professional, use tracking to tighten display type. 

Once you adjust the tracking, the logo should fit neatly into 
the frame on one line. Ifnot, use tracking to tighten it further. 

Change the Credo paragraph 
If you continue with our suggested top-down order, the next 
paragraph you should format is the credo. You will change the 
font and increase the width of its ruling line. 

m Select the next paragraph in frame #1 starting with ''News 
and Information .... " 

m Confirm that it is tagged as Credo. 

m Font Face: Times 
Style: Normal 

m Alignment 

m Spacing 

Overall Width: Frame-Wide 

Inter-Line: 18.00 fractional pts 

Now add a ruling line below. Notice that when you widen the 
rule, you also add extra space above it. The extra white space 
helps visually separate the rule from the text. 

m Select Ruling Line Below from the Paragraph menu. 
Choose Width: Frame. Make Space Above Rule 1: 06.00 
fractional pts and Rule 1: 10.00 fractional pts. 



Create a dateline 

"Credo" RULItii LINES BELOW 

Width: FraMe 
Color: Black 

Pattern: Solid 
Dashes: Off 

Space Above Rule 1: 06 . 001 
Height of Rule 1: 10.08 

Space Below Rule 1: 80.08 
Height of Rule 2: 80.08 

Space Below Rule 2: 00.08 
Height of Rule 3: 80 . 88 

CustOrt Indent: 00,00 [~::J -
CustOrt Width: OO,()O 

Dash Width: 00 .00 
Dash Spacing: oo.()() fractional pts 

Space Below Rule 3: 80.08 a c:J 
Overall Height: 16.88 

3 - 41 

When you are finished the frame should look like Figure 3-31: 

Figure 3·31. 

Cost $lvings predictodf : : 

resident approves des~t~p publishing 
pany-wideD 1 i 

: i 

Create a dateline 
Next you will create a dateline that puts two different tags
Date and Volume - on the same line. 

~ Select the next paragraph "FalllWinter 1989." 

Since this paragraph was already pretagged, the tag name 
(DATE) appears in the Current Selection Box. However, since 
the format for this tag doesn't yet exist in the style sheet, 
Ventura displays it with Body Text attributes and in all caps 
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in the Assignment List. You will adjust its font, alignment, 
and spacing and add a rule below . 

• Font Size: 008.0 points 

m Alignment Horz. Alignment: Left 
In/Outdent Width: 00,00 picas & points 

m Spacing Inter-Line: 12.00 fractional pts 

~ Select Breaks from the Paragraph menu. Confirm that Line 
Break is set to Before. 

Now add a frame-wide rule below the tag. 

~ Select Ruling Line Below. Choose Width: Frame. Enter 
06.00 fractional pts of Space Above Rule 1, and give Rule 1 
a height of 00.25 fractional pts (Figure 3-32.) 

"DATE" RULHIG LlHES BELOt! 

Width: FraMe 
Color: Black 

Pattern: Solid 
Dashes: Off 

Space Above Rule 1: 06.88 
Height of Rule 1: 00.251 

Space Below Rule 1: 00.88 
Height of Rule 2: 00.88 

Space Below Rule 2: 00.88 
Height of Rule 3: 00 • BB 

m 

1 M."" 
CustOM Indent: 00.00 CT] [.:] 

CustOM Width: 00.(}0 

Dash Width: 00.00 
Dash Spacing: 00.00 fractional pts 

Space Below Rule 3: 00.00 a c:J 
Overall Height: 06.25 

Figure 3·32. 

Change the Volume tag 
Now you will select the paragraph pre-tagged as Volume. To 
allow it to reside on the same line as the Date, make it 
right-justified and set the Line Break after the tag instead of 
before. (A Line Break Before would cause a break between the 
date and the volume paragraphs.) 

~ Select the last paragraph in frame #1, ''Vol.1 No.4." 

m Font Size: 008.0 points 
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m Alignment Horz. Alignment: Right 
In/Outdent Width: 00,00 picas & points 

IJ Breaks Line Break: Mter 

Check that your screen resembles Figure 3-33 (if you do not 
see the tab and end of paragraph symbols, make sure Show 
Tabs & Returns is turned on in the Options menu). 

Desk File Edit View Chapter Frane Paragraph Graphic Options 

• !~§i~~!~~!§§!~~!§~!§~!~~i~~i~~!~~rC:\TfiIJ\:iiEWS. i:Iii - (3"00; STY) i~!~~i~~!§~!~~!§~!~~!~~!~~i§~!~§!~~ + 

,0 I' ,1'1 I'. ,12
' ,liD ,13

' I~ t 

.!.. 

'1. 

nn-EJJ-ewsletter,i % 

~ • .: ,o. ... ',I,m.lI" 1"'~PIO:""flh' XY2 C.~"""". w' .J I 
i Cost savings predictedl I I ..... 
iPresident approves des~top publishing =:!.I:!.I:!.I:!.I:!!. 

icom pany -wideD 1 l ~ 
i 1 1 , 

Figure 3·33. 

You've just learned a valuable skill: How to make two different 
tags reside on the same line. As you saw, the trick is to give the 
first tag a line break before and the second tag a line break 
after. 

You have to be careful when putting two paragraphs on the 
same line or the text will overlap. In the example above, you 
kept them separate by making one flush left and the other 
flush right. You could also have used In From Left and In 
From Right spacing to separate the two. 

Add the Kicker tag 
A kicker is a lead-in heading that introduces a headline. Since 
the tag name and format does not exist in the current style 
sheet, you will add a new tag. 

~ Select the paragraph "Cost savings predicted." 

m Select Add New Tag from the Side-Bar. 



3 - 44 Style 

m When the dialog box appears, move to the Tag Name to Add 
line and type: Kicker (Figure 3-34). 

ADD NEW TAG 

Tag Name to Add: Kicker~ 

Tag Name to Copy From: Body Text ____ 

~ I Cancel I 
Figure 3·34. 

Format the Kicker tag 
~ Font Face: Helvetica 

Style: N-Italic 

m Alignment 

m Spacing 

Size: 012.0 points 

Overall Width: Frame-Wide 

Above: 12.00 fractional pts 
Inter-Line: 24.00 fractional pts 
Add in Above: When Not at Column Top 

Now you will add a ruling line below the kicker to separate it 
from the headline. 

~ Ruling Line 
Below 

Width: Text 
Space Above Rule 1: 03.00 fractional pts 
Height of Rule 1: 00.25 fractional pts 

By selecting Text in the Ruling Line Below dialog box, you are 
telling Ventura to make the ruling line exactly as long as the 
text. If you write a longer kicker, the rule will automatically be 
lengthened. For a shorter kicker, the rule will be shortened. 
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Change the Headline tag 
To make the headline in frame #2 easier to read, increase its 
size and its inter-line spacing. 

m Select the paragraph,"President approves desktop publish
ing company-wide" in frame #2. 

m Font 

m Spacing 

m Paragraph 
Typography 

Size: 030.0 points 

Below Spacing: 00.00 fractional pts 
Inter-Line: 30.00 points 
Add in Above: When Not at Column Top 

Tracking: Tighter 
Ems: 0.035 

When you are finished making these changes, the headline 
should look like Figure 3-35: 

Figure 3·35. 

Are you beginning to notice improvements? By enlarging the 
logo and the headline and adding rules, you have made the 
front page easier to read and less cluttered. 

We realize you are working very hard in this chapter. You are 
duplicating the steps you must go through in real life to 
construct a professional-looking newsletter. Although taking 
the "real-life" approach means spending a few extra minutes, 
it pays off. By the end of this chapter, you will be familiar with 
all of Ventura's basic functions. Stick with it. 
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Add a BodyFirst tag 
To distinguish the lead-in paragraph from Body Text, you will 
create a tag called BodyFirst. The tag will be aligned flush left 
with no first-line indent. 

m Select the paragraph that begins "President Xavier Y. Zyg
niewski announced ... " in frame #3. 

m Add New Tag 

m Alignment 

Tag Name to Add: BodyFirst 

In/Outdent Width: 00,00 picas & points 

The first paragraph should look like Figure 3-36: 

Figure 3·36. 

Change the TOC Title 

1 Cost sm"ngs predicted' 

iPres ident appro~e~ des ktop 
1Publishingcom p~~y-wideD 
: : : 

~esident XIVier Y. Zygniewsli U\nounced touy his! l....UId Mve re'fUred the pwcha.se of 
~pproYlI of. 12'monlh plln to insan desl<top publish' i ~a1j"OI. comput .... Mr. Zygniewsl:i 
;ing workslltion5 in key de~l1nents througl\OIIt XYZ: Inew soflvNe will 'De phise4 in over I 
~rpo"liln. Th. announMent follows I three' : ~eriod 01\ I depulment·by-.\epartrntnl 
~onth pilot study conduned by the Markeling Com-: iUng with Marbling 
~unic.tions De~l1nentf ': : "We are delighted 
: "We initidly thoughtlhlt desl<top pub~shinl l'IOull : ~esktop publishing for 
~1y M¥'ld¥lntlges fer one or two de~lmenls," : jMmlger of Mlrkeling 
isaid President Zygniewsl<~ ''but our study rem1ed : ~JSSing on whit we learn in 

it could sm tim, and MOnty Ihroughoullht com- : lnd seminars for employees in 
wJule improving the Ippearwe U\d effe/livr : ~e Marbling . 

ow documenls." : 1 desktop publishing sp.dllisl 

The last frame (frame #5) on the page includes the text for the 
table of contents. To format the TOC, first tag the text, then 
change the tag attributes. 

m Select the paragraph "Table of Contents" and tag it as TOC 
Title, which was already defined in the original style sheet 
(Figure 3-37). 

~ Font Face: Times 

~ Alignment Horz. Alignment: Left 
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r able of Contents 
PnsfdtnllplI'Ovts 41sidoJ publishillr 
XYZ litiS sJldllis.. 21 
Ntw plull <omes OII'lInt< 31 
PtoJlt on Ihlrnovt- 51 
LtlWslolhttdilOl' Sf 
CIIIMII'" &:I 

Figure 3·37. 

Use the In From Left spacing option to move the TOe Title in 
from the left margin of the frame. 

!H Spacing Above: 12.00 fractional pts 
Inter-Line: 12.00 fractional pts 

• Ruling Line 
Below 

In From Left: 01,00 picas & points 

Width: Text 
Height of Rule 1: 05.00 fractional pts 
Space Below Rule 1: 30.00 fractional pts 

After adding the ruling line below, the TOe Title should look 
like Figure 3--38 

PrtsilmllPlI'ovts 4esidoJ publishinr 
XYZ lites .pedlli." 21 
Ntw plant comes OII'line- 31 
PtoJle on IhlJnove- 51 
Letl«slolheedilol'" Sf 
CIIeMII'" &:I 

Figure 3·38. 
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-.. TIP: We used Below Spacing to visually separate the Title of 
the TOe from the following TOe entries. 

Modify the TOe entry tag 
g Select the paragraph "President approves desktop publish

ing ... " and tag it as TOC entry. 

g Font Face: Times 
Style: Bold 

g Spacing Above: 18.00 fractional pts 
Inter-Line: 06.00 fractional pts 

You will use Tab Settings to create leader dots. As the name 
implies, these dots help lead the eye across the page. They are 
useful for indexes, tables of contents, and other lists. 

1m Select Tab Settings from the Paragraph menu. Choose Tab 
Number: 1, Tab Type: Right, Tab Shown As: Leader Char., 
Tab Location: 17,00 picas & points. Then choose Leader 
Char: ( ... ) and Leader Spacing: 1. 

"TOC entry" TAB SETTINGS 

Tab Number: I + I 1 I + I 
Tab Type: Right 

Tab Shown As: Leader Char 
Tab Location: 17.BBI picas & points 

Leader Char: 

Leader Spacing: 1 
Auto-Leader: Off 

B46 (ASCII) 

I Cancel I 

g Tag the remaining paragraphs in the table of contents as 
TOC entry. (Hint: use the Shift-Click method to tag them 
all at once.) 

~The finished TOC should look like Figure 3-39. 
-- _ ..... \ 
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K'rZU'osspedllist· .••.••.•..•..••.•... 21 

IfeIplDtc ... sta·li11e •••.•..•..••.•... 31 

Figure 3-39. 

Add the Jump tag 
There's only one more paragraph to tag on page one: the jump 
text. 

m! Select the paragraph "Continued on page 2." 

m! Add New Tag 

• Font 

E Alignment 

Tag Name to Add: Jump 

Style: N-Italic 
Size: 010.0 points 

In/Outdent Width: 00,00 picas & points 

-NOTE: If necessary, adjust the frame size so the text aligns 
with the bottom of the column guide. 

Mter you finish making these changes, your screen should 
look similar to Figure 3-40. 

Do not be concerned if your screen doesn't match ours exactly. 
Different monitors and slight differences in frame sizes can 
vary the position of elements on the page. The important 
thing is to understand how to adjust for these differences. You 
may have to experiment with font size or frame size to make 
the small jump text appear correctly. Remember, we are 
giving you guidelines, not a rigid structure for creating docu
ments. You should feel free to explore on your own if you don't 
like the way something turns out. 
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••..•.••.••.••• .31 

•.••.••.•••••.••.••• 51 

.••....••.•........ 61 

••..•.••.••.•..•••.. ID 

Figure 3·40. 

~ the only \ene!iIs. "We Itt ftmly convinet4 tlllt i 
;thel\!Yl desktop publishini proBrIIII will su\stanlillly : 
~mprovt the 100]( Ind the impld of XYZ's 4ocu· : 
~ts,"gjd Mr. Deplhoml. 'f you Wlnt I document : 
!trtllld with fmpOrtl1lCl, it must 100lc important Vtn· : 
!l11f1 Pubijsl\4r will SWt e .... y dlpirtrnlnl thl lbility to : 
"'till gnI~looJdni PlgtS.''11 : 
: The n .... desktop pu\li>hing >p.eilli51 wm be : 
inilins I nnry of pr.itsSionl\-qul.1ity style slIeets, : 
!XYZ employees can 0\1Iin the benefits of gnphic : 
ilesi~ Ind Iypesetli~ mn if they 11m no >p.eill : 
itrlinin,. An they wm need to do is select III 1)1' : 

~roprllt. slylo sheoImd use H to process tllet docu· j 
'Conlitut4tfapip2ll •.•....••....•.........•...•.•...•••..•.. , 

Style 

e Stopping pOint 
With only a page to go, take a break and admire your work. 
(Hint: Save what you've done so far before you start patting 
yourself on the back.) Your efforts have paid off: The newslet
ter is really shaping up. If you must pause, you can quit now 
and resume at a later time. Otherwise, continue on to the next 
section. 

Assigning function keys 
If you are starting up anew, load Ventura and open the chap
ter C:\TEMP\3NEWS.CHP. Before you go to page two, we 
want to introduce another time-saving Ventura feature that 
speeds up tagging. 

Until now you have always tagged text with the mouse while 
in Paragraph mode. You can decrease formatting time by 
assigning tag names to Function Keys in the Update Tag List 
Option (Paragraph menu). By assigning key tags to each of 
the 10 function keys, you can edit and tag simultaneously, 
without switching back and forth between Text and Para
graph modes. Here's how: 

~ While you are in Paragraph mode, select Update Tag List 
from the Paragraph menu. 
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.. NOTE: You can also bring up the Assign Function Keys dialog 
box by pressing Ctrl-K. If you press Ctrl-K while you are in 
Paragraph mode, Ventura displays the Update Tag List dialog 
box. Then you choose Assign Func Keys button to view the 
function keys. If, however, you press Ctrl-K while you are in 
Text, Frame, or Graphic mode, Ventura automatically displays 
the Assign Function keys dialog box. 

E If Ventura asks you if you want to Save or Abandon your 
work, choose Save. 

E Choose Assign Func Key from the dialog box. A list of ten 
function keys appears. 

U Move to the F2 line and type: BodyFi.rst 

E Now complete the dialog box as shown in Figure 3-41. 
Make sure you match the existing tag names character for 
character and space for space. Click OK to return to the 
dialog box. Click OK again to return to the document. When 
Ventura asks if you want to Save, Save As, or Abandon the 
changes to the style sheet, choose Save. 

ASSIGN FUNCTION KEYS 

F1: Address -- F2: BodyFirst_ 
F3: Bullet --- F4: Byline __ _ 
F5: Credo F6: Date --- ----
F7: Deckhead __ 
F9: Jump __ _ 

FB: Headline 
F1B: Body Tex~ 

I Cancel I 
Figure 3·41. The Assign Function Keys dialog box. 

Notice that we have listed the tags in the same alphabetical 
order as they are found in the Assignment List. Alphabetical 
order makes it easier to remember which tags are assigned to 
which function keys. However, feel free to use any order that 
makes sense to you. For instance, you might choose to assign 
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Headl to Fl, Head2 to F2, and so on. Many people reserve the 
FlO key for Body Text, to follow the convention established 
with the style sheets that come with Ventura . 

.. TIP: It is generally best to assign tag names to function keys in 
the same alphabetical order as they appear in the Assignment 
List. If you have more tags than function keys, assign the most 
commonly-used tags to the ten keys. 

Now go to page two and try out the new function key assign
ments. 

m Press End to go to the last page of the document. 

~ Go to frame #9. Enable Text mode. Place the text cursor 
anywhere within the paragraph "By Joe Smith." Press the 
F4 key to tag it as Byline (See Figure 3-42). 

Figure 3·42. 

Mukeling COJnmW\iations Otparlmenl hIS 
.xperionctd desl<top publishilli (DTPI 

h.1p XYZ mU. Iht hnsition 10 the ntw 
Ms,lltld'n,formerlyth'prtsidenlofhEr 

IiWn lonsu~ing I'inn', is I not.d .uthority on .lectronic 
~ub1ishiJlg in genEr.\lnd Ventura Publish .... ftware 

Now you will use the function keys again to tag the first 
paragraph of the article as BodyFirst. 

m Place the text cursor anywhere in the paragraph "The 
Marketing Communications Department ... " Press F2 to tag 
it as BodyFirst. 
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.. TIP: If you forget which tags are assigned to which function 
keys while you are tagging in Text mode, press Ctrl-K to bring 
up the Assign Function Keys dialog box and review the key 
assignments. When you are finished, click OK to close the 
dialog box. 

m Go to small frame (frame #7) at the top of the page. Move 
the text cursor to the paragraph "Continued from page 1." 
Press F9 to tag the paragraph as Jump . 

.. NOTE: You can use function keys to apply tags, but you must 
switch to Paragraph mode to change or add tags. 

Change the Z_Header tag 
Now you will continue to format page two by adding a ruling 
line below the header text. As you will see, you can change the 
appearance of the header just as you can change any other 
paragraph on the page. The difference, however, is that any 
changes apply to all the headers throughout the document. 

Il Enable Paragraph mode. Select the header paragraph 
"FalllWinter 1989 Page 2 The Newsletter," (Figure 3-43) 

~ 12 1$ 24 
, I" """ " ,I", """" I, I I' 'I" I' ,I" "I" " 

iLll/Winter 1989+ PiL e 2" 

I········· .. ······· .... ···· .... ····· .. · .. ····· .... ············· ...... ~ 
1(.1mtlju,~ ltWI1 PJ.t~ 1Q I 

:ment. Librilries (If style sheets including 'business, tech': 
:nical documents, and newsletters will be developed for: 
:in· house use throughout RYZ Corporil tion. I : 
1 L'The ilverage consumer is becoming increilsingly d·l 
~uned to high'quality graphk design," said President : 

Figure 3·43. 

~e il gr 
~iesign 
~tyles~ 
~nyone 

:ta.sk of 
~YZ. 1 
~:hoose 

Il Alignment Overall Width: Frame-Wide 
In/Outdent Width: 00,00 picas & points 
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9 Ruling Line 
Below 

Style 

Overall Width: Frame 
Space Above Rule 1: 02.00 fractional pts 
Height of Rule 1: 10.00 fractional pts 

Add a Headline2 tag 
Since the original style sheet contained only one tag for head
lines, you will add a second tag to achieve a different look. The 
new Headline2 tag will include a rule with a custom width. 

D Select the paragraph "XYZ hires DTP specialist" in frame 
#9. 

D Add New Tag 

m1 Font 

9 Alignment 

9 Spacing 

Tag Name to Add: Headline2 

Face: Helvetica 
Style: Bold 
Size: 024.0 points 

Overall Width: Frame-Wide 
In/Outdent Width: 00,00 picas & points 

Above: 24.00 fractional pts 
Inter-Line: 24.00 fractional pts 
Add in Above: When Not At Column Top 

m Select Ruling Line Above. Choose Width: Custom. Make the 
Height of Rule 1: 06.00 fractional pts and the Space Below 
Rule 1: 06.00 fractional pts. Now switch from fractional 
points to picas & points by clicking on top of the unit 
measurements several times. Next move to Custom Width, 
press Esc to clear the line and type: 14,00 and click OK. 



Change the Deckhead tag 

"Headline2" RULlHG L1t1ES ABOVE 

Width CustOI1l 
Color Black 

Pattern Solid 
Dashes Off 

Space Above Rule 1: 00,00 
Height of Rule 1: 00,86 

Space Below Rule 1: 00,86 
Height of Rule 2: 00,80 

Space Below Rule 2: 00,00 
Height of Rule 3: 00,00 

m 

1.3.00 
Custor. Indent: 00,00 a c:J 
Custor. Width: 14,801 

Dash Width: 00,00 
Dash Spacing: OO,()() picas & points 

Space Below Rule 3: 00,80 a c:J 
(}yerall Height: 91,80 

Change the Deckhead tag 
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Only two more tags to change. Then we will show you how to 
rename and remove tags and you will be ready to move on to 
the picture section. 

A deckhead is a short lead-in paragraph that follows the 
headline and introduces the body copy. Change the format of 
the deckhead paragraph. 

R Select the paragraph "Joan Belden joins Marketing Com
munications ... "in frame #9. 

R Font 

R Spacing 

Face: Helvetica 
Style: B-Italic 

Above: 12.00 fractional pts 
Inter-Line: 12.00 fractional pts 
Inter-Paragraph: 00.00 fractional pts 

The finished tag looks Figure 3-44: 
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Figure 3·44. 
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Change the Byline tag 
~ Select the Byline paragraph "By Joe Smith." 

m Font Style: N-Italic 

m Spacing 

Rename a tag 

Above: 12.00 fractional pts 
Below: 00.00 fractional pts 
Inter-Line: 12.00 fractional pts 

After tagging the text, take a moment to clean up the Assign
ment List. Remove tags you don't need, and rename tags with 
unclear names. When you rename and remove tags, the 
results are reflected in the current style sheet and in every other 
document that uses that style sheet. If you do not want to 
rename or remove a tag in every document, remember to 
choose Save As and enter a different style sheet name when 
you close the dialog box. 

In this section you will rename the tag "Masthead" to "Logo." 
Then change the DATE and VOLUME tags from all caps to 
upper and lower case. Since this is the only document so far 
that uses the style sheet 3NEWS.STY no other documents will 
be affected by these changes. 
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-NOTE: The masthead is a listing of the staff and publisher of 
the newsletter that is normally placed on the inside or last 
page. People commonly confuse the terms logo and mast
head. 

m Select Update Tag List from the Paragraph menu and 
choose Save. 

m Scroll through the tag name list at the top of the dialog box 
until you see the name Masthead. Click once on the name 
to highlight it. 

Ii With the name selected, choose Rename Tag. Move to the 
New Tag Name line and type: Logo then click OK. 

RENAME TAG [!] 

Old Tag Name: Masthead __ 

New Tag Name: logOI~ ______ _ 

Cancel 

~ Scroll through the list again and highlight the tag name 
DATE. Choose Rename Tag. Then move to the New Tag 
Name line and type: Date 

Ii Repeat the step above to rename the VOLUME tag to 
Volume (from all caps to initial capital only). 

-NOTE: Do not use Ctrl-X to bring up the Rename Tag dialog 
box again. This will cancel the Update Tag List dialog box 
without saving your changes. 
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Remove a tag 

Pictures 

R While you are still in the Update Tag dialog box, scroll 
through the tag name list until you see the name Address. 
Click once on the name to highlight it. Choose Remove 
Selected tag, then click OK. The Remove Tag dialog box 
appears. 

REMOVE TAG 

Tag Name to Remove: Address~ 

Tag Name to Convert to: Body Text ____ 

~ I Cancel I 
~ Click OK again to close the dialog box and choose Save to 

save your changes . 

.. NOTE: When you remove a tag, Ventura converts all occur
rences of this tag to Body Text unless you tell it otherwise. 

Give yourself another pat on the back. You've completed the 
style portion of this document. With text and style complete, 
you're ready to add a picture to your newsletter. In this section 
you will load and place a picture, and then add a caption. 

~ Make sure you are on page two. 

~ Enable Frame mode. Click anywhere on the empty frame 
(frame #11). 

~ Select CHANEL.IMG from the Assignment List. 
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The picture is placed into the frame. Now size the picture to 
fill the frame. 

-NOTE: If the picture is not visible, select Show This Picture 
from the Options menu. 

m Select Sizing & Scaling from the Frame menu. 

~ Choose Fit in Frame and Aspect Ratio: Maintained. 

SIZIHG & SCALIH& 

Flow Text fround: ~ 

Upper left K: 26 J 861 a c:J ~er left V: 48 186 a c:J 
Frallle Width: 18J 86 Frallle Hei!IJt: 21 1 00 

Horiz. Padding: 00189 Uert. Padding: 88 100 picas & points 

Picture Scaling: ,_;;%; I By Scale Factors I 

Aspect Ratio: "M"'" I Distorted I 
K Crop Offset: OOJOB a c:J V Crop Offset: 09 100 a c:J 

Scale Width: U~)06 Scale Hei~t: :~i /()() 

Choosing Fit in Frame and Aspect Ratio Maintained fits the 
picture in the frame and maintains the same horizontal and 
vertical proportions. 

Once the picture has been placed, you can add a caption to the 
frame. In the previous chapter, you created a caption by 
typing directly into the caption frame. This method allows you 
to create long captions and edit them in text editing mode. 

This time you will create a caption label. Caption labels are 
entered and edited in the Anchors & Captions dialog box. They 
cannot be entered or changed in text editing mode. Chapter 
Nine explains how to use caption labels for automatic num
bering. Right now, however, you will simply use this feature to 
add a short, unnumbered label. 

§ Select Anchors & Captions from the Frame menu. 

a Choose Caption: Above. Move to the Label line and type: 
Ms. Joan Belden and then click OK. 
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AHGIIlR8 R CAPTHli8 

Anchor: 

Captioo: Aboye 

label: Ms. tklan Belden'l-l _________ _ 

Inserts: I Table ~ I I FiSlI'e ~II Chapter ~ II Text Attr. I 

.. NOTE: If the caption frame overlaps the frame above it, don't 
worry. Later you will resize the frame to fit the space. 

At this point you can change the attributes of the caption label 
you just created. 

m Enable Paragraph mode. Select the paragraph "Ms. Joan 
Belden." 

Notice that the Current Selection Box displays a generated 
tag name: Z_LABEL CAP. Ventura automatically assigned 
this tag to the label when you typed it into the Anchors & 
Captions dialog box. You can change this tag in Paragraph 
mode as you would any other. 

m Font 

m Spacing 

Style: B-Italic 
Size: 010.0 points 

Above: 06.00 fractional pts 
Inter-Line: 10.00 fractional pts 
Add in Above: Always 

After you change the attributes, shorten the caption frame 
one line length so the caption text is visually separated from 
the text above. 

~ Enable Frame mode. 

~ Select one of the sizing buttons on the caption frame menu 
and reduce the frame by one line snap unit (Figure 3-45). 
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Figure 3-45. 

-NOTE: If you make the frame too small, select Sizing & Scal
ing from the Frame menu and make the frame height 02,00 
picas & paints. 

Print selected pages 
Having added a picture, you are ready to print the newsletter 
to see the results of your changes. The To Print option (File 
menu) lets you specify which pages to print and the order in 
which to print them. 

m Save the chapter (press Ctrl-S). 

m Select 'Ib Print from the File menu. 

~ Choose Which Pages: Selected. Move to Through Page, 
press Esc, and type: 0002 

m Choose Printing Order: 1st to Last and click OK. 
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PRINT INFORMATION (POSTSCRIPT - UltiMate) 

Which Pages: Selected 

FrOM Page: e001 
Through Page: 00021 

NUMber of Copies: e1 

Collated Copies: Off 
Printing Order: 1st to Last 

Paper Tray: Default 
Crop Marks: 0 ff 

Spot Color Overlays: Off 
Nl.llt,.i·Ghp, PI'.int r.nt.~~~: GOl"lb.inf.~(.i 

Device Nane: POSTSCRIPT 
Output To: COM1: 

_II~'" I Cancel I 

Ventura prints both pages of the newsletter. 

Chapter 

'-NOTE: Because of the image on page two of the newsletter, 
the document will take longer to print. 

Understanding set printer info 
This is a good point to introduce you to the Set Printer Info 
dialog box. This selection from the Options menu allows you to 
change printers. Take a moment to glance through the sample 
dialog box in Figure 3-43. 

SET PRINTER INFO (POSTSCRIPT· UltiRate) 

Device Natle: I HP LJ+, JOB dpi I 'NitiijJIQ' 

Screen Fonts: EGAI (Use those ~atchin9 this file extension.) 

Output To: CillIJI LPT211 LPT31 IiDI COH2 I I Direct I I Filenallle I 

Width Table: C:\lJENTURA\OUTPUT .lflD _________ _ 

Coollland: I Load Different Width Table (i.e., Font Metrics) I 

Figure 3·46. 
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Let's consider each line and its function. At the top is Device 
Name. As you can see from the example above, this line 
permits you to choose between different printers. If you in
stalled only one printer during VPPREP then only one printer 
name will appear on the Device Name line . 

.. TIP: To add a new printer after installing Ventura, insert Ven
tura Disk #1 into the A: drive and type VPPREP , just as you did 
when originally installing the program. Answer No when 
VPPREP asks you if you are installing for the first time so you 
will not have to redo the entire installation. 

Switching printers is not as simple as making a choice from 
the Device Name line. You must also confirm that the width 
table matches the printer. The width table is a separate file 
that tells Ventura how much space to allow for each character. 
The last line in the dialog box, Quality, signals whether or not 
the width table matches the printer. If Quality says "Ul
timate," then you have a correct match. If Quality reads 
"Draft," you have a mismatch. 

Suppose you choose a new device name and notice that 
Quality says "Draft." To switch to the correct width table, click 
on the Load Different Width Table button. Ventura will dis
play an item selector. Width tables are clearly labeled with 
names similar to printer names. Pick the one that matches 
your printer, then click OK. When you will return to the Set 
Printer Info dialog box, the Quality line will read "Ultimate." 

.. TIP: Use Draft quality to mimic one printer with another. For 
instance, you could use a LaserJet Plus to imitate a PostScript 
typesetter for proofing purposes. Select the LaserJet device, 
but use the PostScript width table. Although the output will not 
be very attractive, the line endings will be accurate. 

The Screen Fonts line enables you to add screen fonts that 
more closely mimic printed fonts. Adding screen fonts is out
side the scope of this project. The Output To line lets you 
change the printer port. For example, if you switch your 
printer from COM! to COM2, there is no need to reinstall 
Ventura. Just make the correct selection on this line. From 
then on, Ventura will send its output to the COM2 serial port 
instead. 
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The Width Table line enables you to confirm which width 
table is in use. It is originally set for the default width table, 
called OUTPUT. WID. Under most circumstances, OUT
PUT.WID is the best choice for the documents you create. 
Ventura saves the name of the width table with the style 
sheet. As long as a style sheet specifies the default OUT
PUT.WID, it can be used on another system, even if that 
system has a different printer. OUTPUT. WID automatically 
matches the printer in use on that particular computer. 

Back up a publication 
You have already encountered Multi-Chapter, which you use 
to back up individual chapters. You can also combine chapters 
into what Ventura calls apublication. The chapters that make 
up a publication can be copied or printed as a group. 

Create a publication 
You will use Multi-Chapter to create a publication called 
PART_ONE. You will use this publication to back up all three 
of the chapters you created in the first section of this book. 

m Place a formatted floppy disk in the A: drive. 

[ij Select Multi-Chapter from the Options menu. If you 
haven't saved recently, Ventura asks you to Save or Aban
don your changes. Choose Save. 

The Multi-Chapter dialog box appears and the current chap
ter, C:\TEMP\3NEWS.CHP appears highlighted in reverse 
video at the top of the list. 

~ Choose Add Chapter. 

Ventura displays the Item Selection box. 

m With the Backup button, locate the C:\TEMP subdirectory 
and scroll through the listing until you find the 
lREPORT.CHP chapter. Select the chapter. 

Ventura returns you to the Multi-Chapter Operations Box. 
Use the same Add Chapter function to add 2PROPOS. CHP to 
the publication list. 

[ij Choose Add Chapter. Select the chapter 2PROPOS.CHP. 
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MUll (-CmPTER (IIERATIOtlS m 
!!!!!i!!!!!!!!§!!!!!!!!!!!!i!!Il!!!!!!! C: \ TEtfl\UltT (TLED. PUB !!!!!!!!!!!!!!i!!!!!i!!!!!i!!!!!!!!!!! Hew 

C: \ TEMP\3NEWS. CHP Open 
~ C:\TEMP\1REPORT .CHP [::tmu.~ 

C: \ TEMP\2PROPOS. CHP .............. . 

I-, 

Save the publication 

Save ••• 
Save As ... 

AddChaptel" ••. 
fll.~I"I(.wt.~ I::l)i.~l.) 

Pdnt ... 
tli.~I<I.~ mt:: .•• 
HiJkl.~ [nam< ••• 
fll.ml.l!'lhel' ••• 

£:0\.))1 AU ••• 

[EJ 

m While still in the Multi-Chapter dialog box, select Save As. 

m Use the Backup button to find the C:\TEMP subdirectory 
and enter the name PART_ONE (notice the underline char
acter between the "T" and the "0"). Click OK. 

ITEM SELECTOR 

Directory: C:\TEMP\*.PUB ________ _ 

Iliiiiiiiiiiiliiiiiiimm *. PUB mmmiiiiiiiiiiiliiiii 

t -
.... _ ......................... '_ ....... .. 

................................ , ........... . 

................................ , ........... . 

............. " ................. 'II ........... . 

Copy the publication 

Selection: PART_OHE.~ 

~ 
I Cancel I 

• Make sure that none of the chapters is highlighted. 
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If a chapter is highlighted, you will copy just that chapter 
instead of the publication. To deselect a chapter, click 
anywhere inside the dialog box. 

m Select Copy All. 

The name of the publication is displayed at the top of the 
dialog box. The destination lines show the disk drive and 
subdirectory to which each file will be copied. Tell Ventura 
which disk and subdirectory you want to use. 

i1 Move the cursor next to the PUB & CHPs: line, press Esc to 
clear the line and type: A: \ 

i1 Choose Make All Directories the Same As the First. The 
click OK. 

COPY ALL 

SOURCE (fron this file) 

PUB or CHP: C:\TEMP\PARCOHE.PUB, ______ _ 

DESTlNATlOH (to these directories) 

PUB & CHPs: A:\\ 
STYs & WIDs: A:\r-------------

Text Files: A:\ ___________ _ 
Graphic Files: R:\ ___________ _ 

1P18ge Files: A:\ ___________ _ 

COl1llJland: Hake All Directot'ies the Sane As the First 

Ventura copies all the files for all three chapters to the A: 
drive. When the copy function is complete, you return to the 
Multi-Chapter dialog box . 

• If you have the time, print the publication by selecting 
Print from the Multi-Chapter dialog box . 

• Choose Done. When Ventura asks you if you want to aban
don or save changes made to the publication, click on Aban
don to return to the work space. 

Congratulations - you made it through Ventura boot camp. 
Getting started from scratch is always the hardest part. Now 
that you've completed basic training you're in shape for al-
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most any assignment. You've got the know-how to make docu
ments more professional, more pleasing, and more effective. 

In the next section of this book, you will use this fundamental 
knowledge as the jumping off point. Part Two will teach you to 
put Ventura through its paces by creating a series of special
ized, high-performance documents. 

Some of you may not plan to go on to Part Two immediately. 
We recommend that you skim the theory sections of the ad
vanced chapters even if you can't take the time to complete the 
exercises. Chapter Four, for instance, introduces the impor
tant concept of thumbnail sketches. Thumbnail sketches are 
such time-and-trouble-savers that some Ventura instructors 
won't let their beginning students start a document until they 
have completed a sketch. 

Tips and techniques 

Frame tips 

D To select a frame, click once anywhere inside its boundary 
while in Frame mode. 

D To resize a frame, place the cursor on a sizing button on the 
edge of the frame and drag with the mouse to the new size. 

D To move a frame, place the mouse cursor anywhere inside 
the frame. Hold down the mouse button until the four-way 
arrow appears. Then drag the frame to a new location. 

D Once you copy a frame into the clipboard, it stays there 
until you replace it with another frame (or until you exit 
Ventura). 

D You can copy several frames into memory at once. Use 
Shift-Click to select the frames, then delete them or copy 
them to temporary memory. 

D You can move frames and their contents from one chapter 
to another using temporary memory. Open the first chapter. 
Place the frames you want to move onto one page, then copy 
or delete them to put them into temporary memory. Now 
open the second chapter. (Abandon the changes to the first 
chapter so it will revert to its original form.) Enable Frame 
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mode and press Ins. The frames will appear inside the new 
chapter. 

o If you will be drawing many frames with similar attributes 
(frame backgrounds, ruling lines, etc.), use the clipboard to 
speed the process. Draw one frame and change its at
tributes. Copy it to memory. Now paste copies for the suc
ceeding frames. This is faster than changing line and back
ground attributes one by one for each frame as you draw it. 

o Ventura can flow a long text file from one frame to another. 
Select the first frame and click on the file name in the 
Assignment List. Now select the second frame and click on 
the file name again. If you make additions or deletions to 
the text, it will flow back and forth between the frames. 

o Ventura cannot flow text ''backwards.'' It cannot flow text to 
a previous page. In addition, it cannot flow text to a pre
vious frame (one that was drawn on the page first). 

o Use sizing & scaling from the Frame menu to fine-tune the 
size and position of frames. 

o Think of the Page as a page-sized frame that automatically 
repeats itself if necessary to accommodate large text files. 

o You can change the size of the Page with Sizing & Scaling 
just as if it were an ordinary frame. 

o For documents with several text files, such as newsletters, 
place text into frames rather than placing it on the Page. 

D When creating a newsletter-style document with frames, 
format the Page first and use it as an invisible snap-to grid 
for drawing frames. 

Text tips 

D You can type text directly into frames while in Ventura. 

D Text typed in frames is stored in the caption file unless you 
specify otherwise. To save to a different file, select the 
frame, then use File TypelRename from the Edit menu to 
specify the file name and format you want instead. 

o Use the function keys to tag paragraphs while in Text 
mode. First assign tag names to different function keys 
using Assign Function Keys from the Update Tag List 
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dialog box (Paragraph menu). Then you can retag any para
graph in Text mode just by pressing a function key while 
the cursor is anywhere within that paragraph. 

D You can assign a tag to multiple paragraphs in Text mode. 
Drag the cursor through (or use Shift-Click) the para
graphs you want to tag. When all the text is highlighted 
press a function key. 

D Assign function keys alphabetically, or in any fashion that 
makes the assignments easy to remember (for example, Fl 
for Headl, F2 for Head2, etc.). 

D If you cannot remember which tags are assigned to which 
function keys while you are in Text mode, press Ctrl-K to 
bring up the Assign Function Keys dialog box. Click OK to 
close the dialog box. 

D If you press Ctrl-K while you are in Paragraph mode, Ven
tura displays the Update Tag List dialog box. Choose As
sign Function keys to review the function key assignments. 
Then click OK twice to return to the work space. If you are 
in Text, Frame, or Graphic mode, Ventura automatically 
displays the Assign Function Keys dialog box. 

Style tips 

D To place two tags on the same line, give the first tag a line 
break before. Give the second tag a line break after. 

D There are two ways to keep two tags on the same line from 
overlapping. First, you can align one flush left and the 
other flush right. This method is satisfactory as long as the 
text is short enough that the tags will not meet in the 
middle and overlap each other. Second you can use In From 
Left and In From Right (Spacing, Paragraph menu) to 
confine each tag to a specific area. 

D Create leader dots with the Tab Settings dialog box. In
stead of showing the tab as an open space, show it as leader 
dots. The dialog box also lets you vary the spacing between 
the dots. 
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Picture tips 

D Use Ventura's caption label function for brief captions, or 
captions that must be numbered (for example, ''Figure I
I"). Use the Anchors & Captions dialog box to type them in 
or to edit them. Longer captions are typed directly into the 
caption frame in Text mode. 

D Caption labels are automatically tagged by Ventura and 
can be modified in Paragraph mode like any other para
graph. 

Chapter tips 

D Use the Last to 1st print option if your printer produces 
pages face up. If it puts out pages face down, use the 1st to 
Last option. 

D You can install additional printers by reusing the VPPREP 
installation program. You will not have to go through the 
entire process. Ventura will only copy over the new fonts 
and drivers you need. 

D Use Set Printer Info from the Options menu to switch from 
one printer to another. Be sure to change width tables at 
the same time. 

D You can mimic one printer with another by using a different 
width table. The most common use of this capability is to 
use a non-PostScript laser printer to preview pages that 
will ultimately be sent to a PostScript typesetter. 

D To copy or print several chapters at once, place them into a 
publication using Multi-Chapter from the Options menu. 
Then copy or print the entire publication. 





Chapter Four 
Skills Checklist 

Theory 
o How Graphic mode works 
o Easy drawing with the snp-to grid 

o When (and when not) to use Box 
Text 

o Modifying generated tags 

Text 
o Typing and editing Box Text 

Style 
o Adding text attributes to the header 

o Line and fill attributes 

o Using leader dots for a tear off line 
D Creating an underscore 

o Number lists with decimal alignment 

Pictures 
o Enhancing graphic shapes with line 

and fill attributes 

o Adding lines and arrows 

o Showing graphics on all pages 

Chapter 
o Updating page counters 

D Inserting a page 

o Printing multiple copies 



Chapter Four 

An Invoice 

Theory 

Welcome to Chapter Four, where you will learn a simple 
but highly effective strategy for creating a standard 

business form. In this first advanced chapter, we will be show
ing you a lot of new techniques and features. The checklist on 
the left lists some of the skills you will learn. 

Like all of the advanced section, Chapter Four assumes that 
you understand the basics from Part One. We will move faster 
than we did before. We will assume you can handle standard 
functions such as loading and placing files, adding and chang
ing tags, etc., with a minimum of instructions. We will save 
step-by-step explanations for techniques you haven't seen 
before. 

Most of this chapter's sample document is built using 
Ventura's Graphic mode. You will find it easier to follow along 
if you understand these three important concepts: 

• How Graphic mode works 

• The snap-to grid 

• Box Text 

Graphic mode 
Ventura has tools for building lines, circles, rectangles, and 
Box Text (text inside a rectangle). You can use these shapes to 
draw simple artwork, create tables, add crop marks, annotate 
illustrations from other programs, or to build forms. Once 
you've learned to operate these tools, you'll find important 
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uses for them in many kinds of documents. Nevertheless, we 
recommend using a specialized, stand-alone graphics program 
to create complex illustrations, just as we recommend using a 
stand -alone word processor to create more than a paragraph 
or so of text. 

How graphic mode works 

Sizing buttons 

The five key points explained below will help you understand 
how the Graphic mode operates. We use the term shapers) to 
refer to lines, boxes, or circles created in Graphic mode . 

.. Key Point #1: Every shape is attached to a "parent," which can 
be a frame or the Page. 

If you move, copy, or delete the parent, the shapes are moved, 
copied, or deleted as well . 

.. Key Point #2: The parent is the frame or Page that is active 
when you select a graphic shape. 

The parent can be the Page itself, or a frame on top of the 
Page. Anything you draw is attached to that parent. In both 
Frame and Graphic mode, look for the sizing buttons that 
indicate which frame is active (Figure 4-1). 

Figure 4-1. Sizing buttons are displayed around the edge of the active 
frame or Page. 
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Parent frame of 
graphic shape below 

.. Key Point #3: Shapes do not have to be near the parent frame, 
but they must be on the same page. 

There is no restriction on the placement of shapes on a page. 
They can be inside the parent frame; touching the parent 
frame; or completely removed from the parent frame, as long 
as they are on the same page. For instance, you could place a 
tiny frame in the upper left corner of the page, and then draw 
a shape in the lower right corner. That shape would still be 
tied to the parent, even though the two are nowhere near each 
other on the page (Figure 4-2). 

Figure 4-2. You can place a graphic shape anywhere on the page. It 
doesn't need to be near the parent frame . 

.. Key Point #4: Different shapes can have different parents even 
if they are on the same page. 

To choose a new parent frame, select a new frame in Graphic 
mode. The new frame will be the parent to any shapes you 
draw from now on . 

.. Key Point #5: You can make a shape repeat on al/ pages of the 
document. 

Normally, when you draw a shape on the Underlying Page it 
appears only on that page. If you want to make the shape 
appear in the same position on every page of the document, 
you select Show On All Pages from the Graphic menu. 
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.. NOTE: In earlier versions of Ventura, the shapes you attached 
to the Underlying Page automatically repeated on every page 
in the document. In Version 2, you must select Show On All 
Pages (Graphic menu) to make the shapes display throughout 
the document. 

The five points above are the major factors to consider when 
using Graphic mode. There are additional tips at the end of 
the chapter. If you have never used Graphic mode before, you 
may want to read through the tips now. Then, after you've had 
some practice drawing shapes, you can review the list again. 

The snap-to grid 
The most important part of graphics drawing is getting 
shapes the right size and position. Ventura's Column Snap 
and Line Snap functions do not work in Graphic mode. For
tunately, Graphic mode has its own snap-to grid function. 

The snap-to grid is the secret to working painlessly and 
productively in Graphic mode. If you know how to set up a 
good grid, Ventura does the hard work for you. The Grid 
Settings feature is found in the Graphic menu. It allows you to 
turn the grid snap on and off, and to set the horizontal and 
vertical grid spacing. 

The invisible grid starts from the upper left edge of the page, 
dividing it into horizontal and vertical units. Take a look at 
Figure 4-3, which shows how a typical grid would appearifits 
lines were visible. Figure 4-3 has both horizontal and vertical 
units set to six picas. The tick marks on the ruler show that 
the first grid lines begin six picas from the left edge of the 
paper and six picas from the top edge of the paper, and con
tinue in six-pica increments. 

The grid acts like a magnetic field. Any shape you place on the 
Page snaps to the nearest invisible line. You cannot misalign a 
shape; Ventura won't let you. With the grid shown in Figure 
4-3, for example, you can draw a box that is six picas on each 
side; or 12 picas; or 18 picas - or any shape with measure
ments in units of six (Figure 4--4). You cannot, however, draw 
a 10-pica box. To do that, you would have to change the grid 
settings to 2, 5, or 10. 



Planning the grid 

Figure 4-3. If you could make the snap-to grid visible, you would be 
able to see how n divides the page into horizontal and vertical units. 

Figure 4-4. Any shape you place on the page automatically snaps to 
the nearest grid unn. (Grid made visible for illustration purposes only.) 

4-5 

Planning the grid 
Once you understand that the grid is measured from the 
upper left corner of the page or frame no matter what the 
margin settings are, then you can plan the grid settings to 
coordinate with the overall page design. 

First you must consider the size of the grid setting. With a 
large grid setting it is harder to make mistakes. If you want to 
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draw six-pica boxes and you set the grid at six picas, it will be 
hard to go wrong. 

Next consider the margin settings. For instance, to draw a 
row of six-pica boxes across the page, you might set your page 
margins and your grid settings to six picas. The grid would let 
you line up the shapes with the margin. But if you were 
drawing those same boxes on a page with four-pica margins, 
the boxes would not line up with the margin. The grid would 
allow the shapes six picas from the edge of the paper, or 12 
picas, or 18 picas - but not four picas (Figure 4-5). 

4 -pica margin 

Figure 4-5. The six-pica shapes will not align with the four-pica margin 
in this illustration. To line up boxes with the margins, make the grid 
setting a common denominator of the shapes and the margins. 

To line up boxes with the margins, set the grid to the common 
denominator of the shapes and the margins. For instance, you 
might choose two picas for the grid setting in the example 
above. Two picas is the lowest common denominator between 
the six-pica boxes and the four-pica margins. You could even 
turn the grid off and align the boxes by eye. However, you will 
never be as accurate manually as Ventura's automatic grid. 

In some cases, you might want to change the grid as you go 
along. For instance, you might select six picas to draw six-pica 
boxes, then switch to two picas to draw narrower boxes. Be 
careful, though. If you change the size of the boxes you have 
already drawn, they will automatically snap to the new grid 
settings. 
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.. NOTE: Each frame can have a different grid setting. If you are 
working inside multiple frames, make sure they al/ have the 
same grid settings to avoid confusion. 

You will learn more about how to use the snap-to grid by 
following along with this chapter's project. 

Box Text is the third and final concept you should understand 
before tackling the invoice. Box Text is a special type of 
graphic shape. I t is drawn, placed, and sized just like an 
ordinary rectangle. But when you release the mouse key, the 
end of file marker ( 0 ) appears inside the rectangle. Then you 
can switch to Text mode to type your own text directly in to the 
box (Figure 4-6). 

tI 

TYIEinyourowntext in the 
BcJtTexlshape 

Figure 4-6. Type your own words into the Box Text shape. 

The name Box Text leads some users to believe that the text 
must always appear inside a visible rectangle. In fact, you can 
make the rectangle "invisible" so the text is the only thing that 
shows. This is a convenient way to stick a word or two 
anywhere on the page without regard to the margin or frame 
boundaries. Box Text, like all shapes, can appear anywhere on 
the same page as the parent frame (or Page). 

You can vary the lines and the background shading of Box 
Text to create a variety of effects (Figure 4--7). When combined 
with Ventura's line drawing function, Box Text is a handy way 
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Figure 4-7. By changing Box Text's line and fill attributes, you can 
create a variety of effects. 

Theory 

to create callouts -labels that point to a particular feature of 
an illustration. 

WARNING: Not all of the effects shown in Figure 4-7 are available with all printers. 

You may have to test your printer to see just how well it 
performs at overlapping one graphic shape with another. With 
many PostScript printers, for example, you cannot place Box 
Text with a white background over a frame with a pattern 
background. The Box Text will show on screen, but it will not 
print out. Here's how to trick most PostScript printers into 
printing overlapping graphics: First draw a solid white rec
tangle shape over the frame background. Then place a white, 
hollow, transparent Box Text shape on top of the rectangle. 
This double overlap effect· allows you to print out Box Text 
shapes on patterned backgrounds. 

Box Text versus frame text 
In some ways, Box Text resembles text in small frames. In
deed, there are many situations when you can create the same 
effect with frame text as with Box Text. Perhaps the easiest 
way to distinguish between them is to say that frame text can 
be a separate file (if you want it to be). Box Text, by contrast, 
must 'always be typed by the user directly into the chapter, 
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where it is stored in the caption file. As a general rule, you 
should use frames to place more than two dozen words or so. 
Use Box Text to place smaller amounts of text. At the end of 
the chapter we give you more tips on when to use frames and 
when to use Box Text. 

Box Text versus rectangles 
A final point about Box Text: Sometimes you should use it 
instead of the standard rectangle drawing tool. If you simply 
want a box without any words inside, the rectangle tool is fine. 
But if you think that you might want to place text inside at 
any time, use the Box Text tool instead. You will be able to 
type text into this rectangle at a later time. 

For example, when creating the form in this chapter, we used 
Box Text to build all the empty boxes and columns. Because of 
this, an operator could fill in the form on-screen (Figure 4-8). 

Order Date OJst.omer No. • 

11/4'88 

Item No. Item Des:ription 

234Ce 41/41 Cedar Table 

Figure 4-8. Use Box Text instead of a rectangle if you plan to enter text 
inside a shape. 

The Z_BOXTEXT tag 
Now that you understand the graphic capabilities of Box Text, 
let's take a closer look at the "text" part of Box Text. Box Text, 
like headers, footers, and captions, is a generated tag (Z_BOX
TEXT). You can format it with the attributes in the Paragraph 



4 - 10 Theory 

menu, rename it to another tag, or remove it from the Assign
ment List. In this chapter's invoice, for example, all the text is 
created via Box Text, then formatted with different tags from 
the style sheet. 

Mter reading the theory behind Graphic mode, you're ready to 
put the theory into practice. While you work on the invoice, 
you may find it helpful to refer back to this theory section or 
refer ahead to the tips at the end of the chapter. 
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Planning the invoice 
An invoice is a standard business form for billing information. 
Its goal is to present separate categories of information in an 
orderly fashion, while making the most important numbers 
stand out. For example, you want it to be very easy for your 
customers to spot how much they owe you. Our example uses 
boxes, lines, and shading to differentiate and clarify informa
tion. 

There are other design considerations. For instance, many 
invoices are divided into two parts so customers can return 
one portion with their payments. The design should include a 
place for the company address on both halves of the form, so 
customers know where to write or call even if they have 
already sent off the other half. In addition, the customer's 
mailing address should be positioned to show through a stand
ard-size window envelope. 

The method offill-in must also be part of your planning. If the 
form will be filled out with a typewriter, make the (Body Text) 
inter-line spacing in increments of one pica, so it matches the 
standard line spacing of typewriters. If it will be filled out by 
hand, make sure the blanks and boxes are large enough for 
easy writing. 

The invoice you make can be used as a camera-ready master 
and sent to a printer, or it can be filled in on-screen on an "as 
needed" basis. 

A thumbnail sketch 
It is easier to work with Ventura if you draw a simple 
thumbnail sketch before starting. In the first three chapters, 
the "after" versions of the sample documents have served this 
role. As you begin creating documents of your own, spend a 
few moments planning the design with pencil and paper 
before loading Ventura. Creating a thumbnail sketch forces 
you to do some hard thinking and decision-making up front. 

The suggestion to "start with a thumbnail sketch" is probably 
found in more books on page design than any other piece of 
advice. Certainly, advance planning can speed the process of 
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producing pages in Ventura. Here are a few of the elements to 
consider as you draw the sketch: 

• Margins 

• Columns 

• Gutters 

• Size of frames or Box Text 

• The upper left starting position of frames or Box Text on the 
page 

Do as many of the calculations as possible while preparing the 
sketch. Jot down dimensions and positions of key page ele
ments. While you're at it, figure out the horizontal and verti
cal grid units by finding a common denominator between the 
margins and the size of the shapes. It is much easier to do 
calculations on paper than in your head while staring at a 
dialog box. 

Look at the pictures of the thumbnail sketch and the final 
version of the invoice. Here are some of the techniques you 
will use to achieve these effects: 

• Snap-to grid 

• Black type on a patterned background 

• Lines and line attributes 

• Box Text, rectangles, and tint screens (fill patterns) 

• Automatic invoice numbering in the header 

• Dotted tear line 

Ventura prep 
As always, prepare for the project by loading and renaming 
files to their proper location. 

Start a new chapter 
If you are continuing directly from Chapter Three, select New 
from the File menu to start a new chapter. Selecting New 
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removes the current chapter and text from your screen, but 
retains the current style sheet . 

• Select New from the File menu. 

II If you have the Power disk 
If you have the Power disk, complete the next two steps, then 
ski p to the text section. 

ml Use Load Diff. Style to load the style sheet 4FORM.STY 
from the C: \POWER subdirectory. Then select Save As 
New Style to save and rename it as C:\TEMP\4IN
VOICE.STY. 

Save and rename the chapter so you can safely save your 
progress under the correct name just by pressing Ctrl-S. 

~ Select Save As and save the chapter as C:\TEMP\4IN
VOICE.CHP . 

.. NOTE: Save As makes a copy of the files (.CHP, . VGR, .CIF, 
etc.) linked to the chapter. It does not make a copy of the 
picture files. 

Since all the text for this document is created with Box Text 
shapes, you do not need to type in a separate text file for this 
project. 

If you do not have the Power disk 
You will find it a bit more difficult to follow along without the 
Power disk in the advanced section. The Power disk includes 
sample style sheets, text files and (in a few cases) sample 
chapters with most of the basic work done already. You need 
only work on advanced techniques and skills to complete the 
document. 

Nevertheless, with just a bit more work on your part it is 
possible to complete all the sample documents without the 
disk. In general, you must take these four steps: 
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1. Type in the text file for that chapter from Appendix A using 
a word processor. Then load it in to the \ TEMP subdirectory. 

2. Load one of the style sheets that come with Ventura instead 
of the style sheet from the Power disk. In each advanced 
chapter, we give you brief suggestions on which style sheets to 
use and what modifications to make. 

3. Modify the columns and margins as necessary to match the 
Power style sheet using the illustrations provided. 

4. Find the tag table in Appendix B and change or modify the 
tag attributes. The tag table describes the style sheets that 
come with the Power disk. If you don't have the disk, you must 
enter these attributes manually before you start the project. 

For this chapter, we recommend starting with the &INV
P1.STY sheet from the \TYPESET subdirectory. (If you can
not find it, then copy the style sheet from the original Ventura 
Examples Disk.) 

m Load the &INV-P1.STY style sheet into the new chapter 
and then save it under the new name C:\ TEMP\4IN
VOICE.STY. Change the margins and columns to match 
Figure 4-9. 

If you do not have the Power disk, manually format your Page 
as shown in the Figure 4-9. 

m Change the tags to match the attributes provided in the tag 
table in Appendix B. 

All the text in this chapter is created with Box Text. You do not 
need to load a separate text file. 

Mter loading and renaming the style sheet, save and rename 
the chapter file. 

~ Select Save As from the File menu and save the chapter as 
C: \ TEMP\4INVOICE.CHP. 
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6,00 
picas 

Live Area: 
36,00 x 54,00 picas 

Trim size 51 x 66 picas 
(8.5 x 11 inches) 

Right page 

Figure 4·9 The margins and column settings for the Invoice. 

6,00 
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Ventura prep 
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The Ventura Formula provides a solid strategy for completing 
most documents, but you must vary it slightly for documents 
where you place text in frames and boxes. In Chapter Three, 
for example, you placed text files after building frames to 
contain them. Similarly, to create this chapter's invoice you 
will add text after building boxes. Here's the order to follow: 

• Format the Page 

• Build a snap-to grid 

• Draw the Box Text shapes 

• Add your own text to the boxes 

Mter you enter the text to the boxes you can proceed with the 
rest of the Ventura Formula . 

.. NOTE: The Ventura Formula is a handy rule of thumb to get 
you started. As you become more proficient, you will discover 
new strategies to fit your personal style. 

Whether you loaded the style sheet from the Power disk or 
recreated it on your own, you should have the correct values 
for the paper size, starting page, and margins and columns. To 
complete the chapter layout you only need to enter the header 
text. Header text is not stored in the style sheet (although the 
header format is). 

Build the header 
Since you learned how to create basic headers in Part One, we 
are now going to show you some advanced techniques. 

You already know that you can change the attributes of the 
header text using the Paragraph menu. In this example, you 
will learn how to make similar format changes using text 
attribute codes in the Headers & Footers dialog box. By using 
the dialog box, you can make part of the header display in one 
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format (which you set in the dialog box) while another part 
displays a different format (which you set with the Paragraph 
menu). 

If you refer back to the "After" picture earlier in this chapter, 
you will notice that the "Invoice No." portion of the header 
displays in 14-point Times, but the "1001" portion is in 18-
point Courier Bold. Now we will show you how to achieve this 
effect. 

Change text attributes in the dialog box 
In the instructions that follow, you will change text attributes 
in the Headers & Footers dialog box. To do so, you will make 
use of the buttons at the bottom of the dialog box to enter a 
generic code. After you choose a button, you must then erase 
part of the code and put in the information you want to use. 
For instance, choosing the Text Attr. button inserts the code 
<D>, which is the code to turn off all text attributes. To turn 
on the text attributes you want, you must substitute another 
code inside the brackets. For instance, you could substitute 
the letter B inside the brackets to specify bold or I for italic. 
Keep in mind that all the buttons in the dialog box merely 
serve as a shortcut. You could just have as easily typed <B> or 
<I> right from the start. However, most people find that it is 
faster to use the buttons, since they eliminate the need to 
memorize the correct codes. 

-NOTE: The buttons at the bottom of the dialog box are for 
convenience only. If you prefer, you can type in the codes 
without using the buttons. 

m Select Headers & Footers from the Chapter menu. Choose 
Define: Right Page Header, Usage: On. Move to the Right 
line and type: No. followed by a space. 

m Choose the Text Attr.button and delete the letter "D" (do not 
delete the right and left brackets). Then type the following 
codes inside the brackets: BF1P18 
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You have just inserted the codes for three text attributes. Let's 
look at each one in turn . 

• B tells Ventura to make the following text bold. 

• Fl tells Ventura to switch to font #1, which is Courier. 
(Ventura assigns numbers to fonts. The Xerox Ventura Pub
lisher Reference Guide lists the font number codes). 

• P18 tells Ventura to change the point size to 18 points. 

Now you will tell Ventura to display the current page number 
after the word "No." As you will see, Ventura's page counter 
will then automatically number the invoices in sequence when 
you add a new page. 

~ Move the cursor after the right bracket and choose Inserts: 
Page #. The page numbering code [P#] appears on the line. 

To complete the header dialog box, turn off the attributes at 
the end of the line. 

Ii Choose Inserts: Text. Attr. 

The last <D> symbol tells Ventura to return the font to nor
mal. 

Make sure the dialog box looks like Figure 4-10: 

HERDERS & FOOTERS 

Define: I Left Page Header I Right Page Header 

, Left Page Footer I 'Right Page Footer I 
Usage: m I Off I 
Left: 

Center: 

Ri!tlt: Ho. (BF1P1B)[P*I](D>IJ-_________ _ 

Inserts: I Chapter It I I Page It I I 1st Match I ,last Match I 
I Text Attr. I I Copy To Facing Page I 

Figure 4·10. 
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Mter you close the'dialog box, the header appears at the top 
right corner of the page (Figure 4-11). 

8od~ Tc)Ct 

Logo 

LosoAddress 

Figure 4-11. 

Change the page number 
Right now the header displays the number 1. With Ventura's 
Update Counters feature, you can make a document begin on 
any page number. For example, let's make the first page start 
at 100l. 

~ Select Update Counters from the Chapter menu. Choose 
Which Counter: This Page, Update Method: Restart Num
ber, Restart Number: 1001, and Number Format: 1,2. 

IJlDATE COUNTERS 

lI1ich Counter: I Chapter IIIIIM LIE!~.:.I~1Ji,Iji.:.J f..:Jf}I~~I:~jji~!] 

I Initial Page II Initial Table II Initial Figure I 
Update Method: I Previous Number + 1 IIII'IIM 

Restart Number: 19911 

Nulilber Format: '12 
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When you select Which Counter: This Page, you change the 
numbering starting with the current page only. On the other 
hand, when you select Which Counter: Initial Page, Ventura 
resets the numbering starting with the first page in the docu
ment. In both cases, the subsequent pages follow sequentially. 

Since the invoice number is based on the current page num
ber, it will change as soon as you click OK and return to the 
page (Figure 4-12). 

NO.1 001 

Figure 4·12. 

Once you finish the header, the chapter layout is complete. 
Now you can begin to add the boxes, starting with the lower 
half of the form and then continuing with the top half. The 
dimensions in Figure 4-13 will help you gauge the size of the 
shapes. 

Reset the zero point 
It's easier to draw the invoice shapes if you reset the zero point 
of the ruler so it lines up with the upper left corner of the 
column margin. Here's how: 

m Change to Reduced View (press Ctrl-R). 
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picas picas picas 

03,00 picas 

03,00 

Figure 4·13 Use this illustration as a reference while building Box Text shapes for this chapter's invoice project. 

Style 
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II Place the cursor on the zero point square (0,0) in the upper 
left corner of the Page. Press and hold the mouse button 
until the four-way arrow appears. Drag it downwards until 
the horizontal and vertical crosshairs line up with the 
upper left corner of the column margin. Then release the 
mouse button. Notice that "0" on the horizontal and vertical 
rulers now lines up with the upper left corner of the column 
margin (Figure 4-14). 

Figure 4·14. 

WARNING: If you do not reset the zero point as we explained above, your horizontal 
and vertical rulers will not match the rulers we show in the project's illustrations. 

Select grid settings 
After you reset the zero point, you are ready to draw. 

To help you accurately line up graphic shapes, you should use 
Grid Settings from the Graphic menu. You will set the 
horizontal and vertical spacing to the largest common meas
urement between the margins and the graphic shapes. In this 
example, we recommend that you set the horizontal spacing to 
01,06 picas & points and the vertical spacing to 03,00 picas & 
points. 

m Enable Graphic mode (click on the Graphic button in the 
Mode Selector). 

m Select the Box Text tool from the Side-Bar. 
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~ Now select Grid Settings from the Graphic menu. Change 
the unit measurements tp picas & points. 

~ Choose Grid Snap: On. Make the Horizontal Spacing: 01,06 
picas & points and Vertical Spacing: 03,00 picas & points. 
Click OK. 

GRID SETTINGS 

Grid Snap: On 

Horizontal Spacing: 81,86 picas & points 

Vertical Spacing: 03,001 

I Cancel I 

Draw Box Text 
m; Place the upper left corner of the Box Text 21 picas down 

from 0,0 so it lines up with the left page margin. 

m; Drag (press and hold down the left mouse button) the box 
downwards and to the right until it lines up with position 
51 picas on the vertical ruler and 6 picas on the horizontal 
ruler. Release the mouse button (Figure 4-14). 

The end of file marker ( 0 ) appears inside the shape. 

-NOTE: You may have to change to Normal or Enlarged View 
to see the end of file marker. 

If you need to change the dimensions of a shape after it is 
drawn you can resize it with the cursor. Place the cursor on 
one of the black sizing buttons around the outside of the 
shape. Then press and hold the mouse button until the point
ing hand appears. Stretch the shape to the new size and 
release the mouse button. To delete a shape, select it and press 
the Del key (or select Cut Graphic from the Edit menu). 
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End of file marker --ll1I+-a-F=\IB-.u;...... 

Figure 4·15. 

~ Now move the shape until it snaps to the horizontal and 
vertical grid. 

Change line attributes 
When you are satisfied with the size of the first Box Text, save 
the line and fill attributes so they will automatically apply to 
the other Box Text shapes you draw. 

~ Select Line Attributes from the Graphic menu (or press 
Ctrl-L). 

~ Choose Thickness: Thin and Color: Black. Make both End 
Styles: Square. Choose Save To and click OK. 

LINE ATTRIBUTES for BOX TEXT 

Thickness: Thin 

Color: Black 

End Styles: .J _ .J_ 

Defaults: I Load From... I I Save To... I 

I Cancel I 



4 - 26 Style 

.. NOTE: The Save To button does not stay highlighted after you 
choose it in the dialog box. 

Save To stores these line attributes as default values. Ventura 
remembers your choices the next time you draw a Box Text. 

Let's take a moment to explain Ventura's application of end 
styles, which can be confusing. Ventura doesn't care which 
end is left or right. It only cares which end was drawn first. 

Look again at the Line Attributes dialog box. The End Styles 
field on the left applies to the starting point. The End Styles 
field on the right applies to the ending point. This holds true 
whether you draw from left to right, from right to left, from 
top to bottom, or from bottom to top. 

Change fill attributes 
R With the Box Text still selected, select Fill Attributes from 

the Graphic menu (or press Ctrl-F). Choose Color: White, 
Pattern: Hollow, Result: Transparent, and Defaults: Save 
To. Now click OK. 

FIll ATTRIBUTES for BOX TEXT 

Color: White 
Pattern: Hollow 

Result: 

D 
DeFaults: I load FroPl ... 

Copy the Box Text 

I Opaque I 
T f"·anspa .... ent 

Save To ... \ 

OK I Cancel I 

Now that you've made one Box Text, we will show you a 
shortcut for the next four. Instead of using the Box Text tool to 
draw each shape, use the copy and paste commands to 
reproduce four copies of the original. 
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• With the first Box Text still selected, press Shift·Del (or 
select Copy Graphic from the Edit menu). 

You have just copied the Box Text onto the Graphic clipboard . 

.. NOTE: Ventura uses the same copy and paste procedures for 
Graphic, Text, and Frame mode. Since Ventura treats aI/ three 
independently, you can copy or delete to three clipboards at 
the same time. 

Paste the Box Text 
m Press the Ins key (or select Paste Graphic from the Edit 

menu). 

You will see the screen redraw itself, which is your sign that 
Ventura has pasted a new Box Text onto the Page. Otherwise 
you might not know for sure, since Ventura pastes the copy 
directly on top of the original. 

Move the copy 
Once you paste the copy, you can move it to a new position. 

Ii Press and hold the cursor anywhere in the middle of the 
Box Text until the four-way arrow appears. With the mouse 
button still depressed, move the Box Text to the right of the 
original as shown in Figure 4-16. 

Figure 4·16. 
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~ Repeat the above step by pasting and moving three more 
Box Text shapes into place. The snap-to grid should make 
aligning the shapes easy (Figure 4-17). 

Figure 4·17 . 

.. NOTE: Once you copy a shape onto the clipboard, it remains 
there until replaced by something else. To insert another copy, 
simply press the Ins key again. 

Stretch the last Box Text 
Now you will stretch the last Box Text so it lines up with the 
right edge of the right page margin. 

m Select the last Box Text (the one on the far right). 

m Place the cursor on any black sizing button on the right 
side. Press and hold down the mouse button until the point
ing hand appears. 

m Stretch the Box Text until it lines up with the right page 
margin. Release the mouse button. The Box Text is now 
twice the size as the other shapes (Figure 4-18). 

Resize Box Text 
You will shorten four of the Box Text shapes to make room 
above for the next Box Text shape. 
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Figure 4·18. 

a! Click on the right-most shape. Then as you hold down the 
Shift key select the three shapes to the left (the left-most 
Box Text is not selected). The word MULTIPLE appears in 
the Current Selection Box. 

-NOTE: If you accidentally click on the wrong graphic shape, 
while holding down the Shift key, click on the shape again to 
"deselect" it. Then choose another shape. 

After all four shapes are selected, you can resize them 
together. 

a! Place the cursor on the black sizing button at the upper 
right corner of the right-most Box Text. Press and hold the 
mouse button until the pointing hand appears. Drag the 
boxes downwards one snap grid unit (Figure 4-19). 

See how quick and easy it is to draw when you use a grid? Now 
that you've resized the four boxes, you're ready to draw the 
next Box Text shape. 

Draw Box Text 

a! Select the Box Text tool from the Side-Bar. 
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Figure 4-19. 

'-NOTE: You can draw several shapes, one after another, by 
holding down the Shift key while you draw. The cursor stays in 
the current shape drawing mode (Box Text, rectangle, line, or 
ellipse) and you can draw a second shape without reselecting 
a graphic tool from the Side-Bar. 

m Line up the Box Text cursor with the upper right corner of 
the first rectangle. Stretch it down one snap grid unit and 
all the way over to the right so it lines up with the right 
column margin (Figure 4-20). 

Figure 4-20. 
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Draw more shapes 
Now that you have the basics of Graphic mode under your 
belt, you can draw the bottom section of the form. 

II Select the Box Text tool. 

II Align the cursor with the bottom left corner of the righ t
most box. Stretch the Box Text down one snap grid unit and 
over to the right margin (Figure 4-21). 

Figure 4·21. 

Now you will add another Box Text shape immediately below. 

~ Select Box Text. 

~ Aligrt the cursor with the lower left corner of the Box Text 
just drawn. Stretch the shape down one snap grid unit and 
over to the right column margin. The bottom of the shape 
extends below the column guide (Figure 4-22) . 

.. NOTE: You could also copy and paste the graphic to create 
the second shape. 

Draw the final shape 
Only one more shape and you are finished with the lower half 
of the form. 

~ Select the Box Text tool. 
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Figure 4·22. 

m Align the cursor with the lower left corner of the left-most 
column. Stretch the shape down two grid snap units (06,00 
picas & points) and over two columns to the right, as shown 
in Figure 4-23. 

Figure 4·23. 

Stopping point 
Good work. You've already completed more than half of the 
invoice. Now that you've learned how to draw and resize 
shapes, the second part of the invoice should be easy. Take a 
moment to evaluate your progress. You may want to change to 
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Normal or Enlarged View to make sure each shape is correctly 
placed. Check that your screen matches Figure 4-24. 

No. 1001 

Figure 4·24 Check to make sure your form matches this illustration 
before you continue. 

This is a good point in the exercise to take a break and save 
your work (press Ctrl-S to save). If you're short on time, quit 
now and start again later. If your schedule permits, continue 
on to the next section without stopping. If you're in a real 
rush, you can simply read through the next few pages without 
actually drawing in the rest of the box text, and skip to the 
section titled "ReCap," where we show you how to type in your 
own text. However, we highly recommend that you complete 
the entire project if you possibly can. The more time you 
devote to practice now, the easier it will be to do your own 
projects later. And drawing the last shapes should only take a 
few more minutes. 
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If you are starting again after a break 
If you are starting fresh, reload Ventura and open the chapter 
C:\TEMP\4INVOICE.CHP. Continue to the next section 
where you will finish drawing the invoice. 

Change grid settings 
To create the narrower boxes in the top portion of the form 
(refer back to Figure 4-12), make the vertical spacing smaller. 
The horizontal grid spacing stays the same. 

11m Make sure you are in Graphic mode with the Page selected. 

m Grid Settings Grid Snap: On 

Draw Box Text 

Horizontal Spacing: 01,06 picas & points 
Vertical Spacing: 01,00 picas & points 

You will now draw the next five box shapes, which will contain 
the words Date, Invoice #, Charges, Credits, and Balance. Use 
the same shortcut you did to create the first set of boxes -
draw one shape, then copy and paste it to make four more. 

-NOTE: Depending on your display screen, you may find it 
easier to draw these smaller shapes if you change to Normal 
(Ctrl-N) or Enlarged (Ctrl-E) View. 

1m Select Box Text. 

11m Starting at position 19 picas on the vertical ruler, draw a 
Box Text shape that is 02,00 picas high and 06,00 picas 
wide. Since the vertical spacing is 01,00 picas & points and 
the horizontal spacing is 01,06 picas & points, the box is 
two snap grid units high and four snap grid units wide 
(Figure 4-25). 

You will now copy the Box Text to the clipboard and paste it 
back onto the page. 

1m With the first Box Text still selected, press Shift-Del to 
place a copy into the clipboard. 
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Figure 4-25. 

Paste and place the copies 
iI Press the Ins key to paste a copy back onto the page. 

iI Insert three more Box Text shapes to the right of the first 
ones and move them so they line up side-by-side as shown 
in Figure 4-26. Then stretch the last Box Text so it snaps to 
the right page margin. Mter you make the copies, the in
voice should look like this: 

Figure 4·26. Here's what your invoice should look like at this stage. 
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Add Box Text for the tear off line 
You will add another Box Text above the five just drawn. You 
will use it later to contain the dotted tear off line. (The dotted 
line itself will be created with the Tab Settings option from the 
Paragraph menu.) 

m Select the Box Text tool. 

m Starting at position 17 picas on the vertical ruler, stretch 
the Box Text shape so it measures 02,00 picas high and the 
width of the entire column (Figure 4-27) . 

.. NOTE: If your monitor won't allow you to draw the Box Text the 
entire column width, stretch it as far as you can to the right. 
Then scroll to the right side of the page and stretch the Box 
Text to the right margin. 

Figure 4·27. 

Add two Box Text shapes 
Now you will add two more Box Text shapes to contain the text 
"Please Return Top Portion With Payment" and "Amount of 
Payment $." Initially, these shapes will overlap the Box Text 
shapes below them by one pica. Later, when you change the 
line and fill attributes, the overlap will become "invisible." 

~ Select Box Text. 

~ Starting at position 16 picas on the vertical ruler, draw a 
Box Text shape that measures 02,00 picas high and 21,00 
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picas wide. Draw a second shape next to the first and make 
it 02,00 picas high and 15,00 picas wide. It will automat
ically snap to the right page margin (Figure 4-28). 

2 picas t 

a a 

a a D a 

Figure 4·28. Draw the two shapes that appear shaded in the above 
illustration . 

., NOTE: The shading in the Figure 4-27 is to help you distin
guish the shapes on-screen. Do not fill them in with a pattern. 

Draw the final shapes 
Only six more shapes to go. Now that you've had some prac
tice, you're ready to step out on your own. For the last part of 
the layout, refer to Figure 4-29 for placing and drawing the 
final shapes. 

Here are some tips to help you get started: 

., TIP: Reset the zero point to line up with the upper left corner of 
the Box Text that will contain the word uDATE" (Figure 4-29) . 

., TIP: Use the zero point and rulers to align and measure 
shapes. Simply place the zero point of the ruler on one corner 
of the shape. Then count off the tick marks to measure the 
width and height of the shape. 
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A Recap 

/ 

Figure 4·29. Finish by drawing the six shapes that are shaded in this 
drawing. 

Style 

- TIP: If you draw a Box Text that is too small for the text size 
inside it, Ventura displays the message, 'This frame has text 
which won't fit on any page ... " To cancel the message, choose 
OK. Then draw a larger Box Text or make the Box Text font 
smaller. 

When you finish, your screen should look like Figure 4-30: 

At this point, you have built a header and added Box Text. 
Now you are ready to add text. As explained earlier, you will 
type this text directly into the Box Text shapes. You will use 
Text mode to enter your own words. (You may want to change 
to an Enlarged View while you type.) 

Add the logo text 
Start at the top of the page and work downwards. Do not be 
concerned yet with appearance of the text, which you will 
later reformat with tags from the style sheet. 

~ Enable Text mode. 

il Place the cursor in front of the end of file mark in the 
top-most shape (Figure 4-31). 
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No.100l 

Figure 4·30. 

Figure 4·31. 
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1m Now type: 

XYZ [Ctrl.-Enter] 
CORPORATION [Enter] 

Style 

The line break (hold down the Ctrl key and press Enter) tells 
Ventura to treat the first two sentences as the same para
graph even though they are on separate lines. Line breaks are 
useful when you want information on separate lines, but you 
don't want to bother retagging each line. 

Add the logo address 
~ With the text cursor still in the first box, type: 

123 Main Street [Ctrl.-Enter] 
Los Angel.es, CA 90000 [Ctrl.-Enter] 
(213) 555-1111 

Add the shipping address 
When typing the shipping address, make a line break after 
each sentence so Ventura treats all the lines as one para
graph. 

~ Place the cursor in front of the end of file mark in the 
shipping address box (immediately below the top box) and 
type: 

Ship to: [Ctrl.-Enter] 
International. Paper Co. [Ctrl.-Enter] 
1701 Broad Street [Ctrl.-Enter] 
Phil.adel.phia, PA 19000 

Add the amount of payment 
Now place the text cursor in the Amount of Payment box 
(Figure 4-32). Type: Amount of Payment [Space] $ 

Add the remaining text 
To add the rest of the text, remain in Text mode and reposition 
the text cursor from box to box. Use Figure 4-33 as your guide. 
Don't worry about matching the font of the illustration. 
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XV2 J 
CORPORATIONlI 
123 Main SlreetJ 
Los Angeles, CA 90000J 
(213)555-1111D 

~------------------------------------r-------------------------~: :: 

Figure 4·32. 

Intematlonal Paper Co. 
1701 Broad Street 
Philadelphia. PA 19000 I 
Ship 10: 

D'. 

DATE INVOICE It 

xyz 
CORPORATION 
123 Main Street 

~21S:~~I_~~'1~A 90000 

No. 1001 

I ACCOUNT I DATE 

CHARGES CREDITS BALANCE 

PREVIOUS BALANCE 

150.00 100.00 50.00 
150.00 00.00 150.00 

XYZ CORPORATION 200.00 
123 Main S1I"eet 
los Angeles. CA 90000 

PLEASE PAY THIS 
AMOUNT 

Figure 4·33 Use this illustration to finish adding text. 
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Tag the text 

Style 

The style sheet loaded at the beginning of the chapter already 
includes pre-defined tags. This will make formatting go fairly 
fast - all you need to do is apply the right tag to the right 
text. Once you apply the pre-defined tags, we will show you 
how to create the tear offline with a new tag. Otherwise, the 
tags we provide in the style sheet will create the effects you 
need without modification. (If you did not purchase the Power 
disk, you must build the tags on your own from Appendix B.) 

Apply the first tags 
Start at the top of the document and work down. Although 
Box Text starts as a generated tag, you can retag it as any 
other tag name. 

~ Enable Paragraph mode. Select the paragraph ''XYZ COR
PORATION" and tag it as Logo. 

~ Select the company address paragraph and tag it as Logo-
Address (Figure 4-34). . 

Figure 4-34. 

a1 Select the "Ship To" address paragraph and tag it as Body 
Text. 

Ii Use Shift-Click to select the next three paragraphs, "AC
COUNT," "DATE," and "Please Return Top Portion With 
Payment," and tag them as Label. 
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In the Label tag, we used Vert. Alignment: Middle to vertically 
center the text within the Box Text shapes. As a general rule 
use Middle alignment to center text within Box Text or 
frames. Figure 4-35 shows the alignment settings for the 
Label tag. 

"Label" ALIGNMENT 

Horz. Alignlllent: 
Vert. Alignlllent: 

Text Rotation: 
Hyphenation: 

Center 
Middle 
None 
Off 

Successive Hyphens: 2 
Colullln-Wide 
Indent 

Overall Width: 
First Line: 

Relative Indent: Off 

In/Outdent Width: 00,001 picas 8 points 
In/Outdent Height: 001 lines 

In Fr'ol:l Rit:jht; t;t'} Dt'lt';',iJ:H:ll: n{){)O 
M~lX'l.I:lHl:1 Rt',!t~:lt;t:ld Jh:r.i.t3ht;: no) no 

OK I Cancel I 

Figure 4·35. The alignment settings for the Label tag. 

~ Select the paragraph "Amount of Payment $" and tag it as 
LabelLine (Figure 4-36). 

ACCOUNT DATE 
lody fe)(t 

LtllUIl4CIc c c 
1.1stDec1Mol 

LosoAddrtl. 

Figure 4·36. 



4 - 44 Style 

Create an underscore 
Let's pause for a minute to show you how we got the under
score effect in the LabelLine tag above. Open the Tab Settings 
dialog box so you can see what we did. 

m With the "Amount of Payment" paragraph still selected, 
select Tab Settings from the Paragraph menu. 

"labelline" TAB SETTINGS 

Tab Number: I + I 1 I + I 
Tab Type: Off 

Tab Shown As: leader Char 
Tab location: 00,001 picas & points 

leader Char: 

leader Spacing: 0 
Auto-leader: On 

B95 (ASCII) 

01< I Cancel I 

To make the solid line, we turned Auto-Leader on in the Tab 
Settings dialog box. Auto-Leader creates a leader line from the 
end of the paragraph all the way to the right margin. The 
leader character itself is a series of small straight lines (_) 
with no space between. In other words, the solid line was 
created by placing small underline characters side-by-side 
with no spaces between them . 

.. NOTE: Do not be concerned if the lines appear dashed on
screen. When you print out the invoice, the lines will be solid. 

Create the tear off line 
You will use the Auto-Leader technique to construct the 
dotted line in the next Box Text shape. First you will add a tag 
named TearOff. Then you will turn Auto-Leader on to create a 
line to the right margin. In this case, however, the leader 
character will be a dotted line instead of a solid line. 



Create the tear off line 4 - 45 

End of file 
marker 

m Select the end of file marker ( 0 ) just as you would select 
any other paragraph you wanted to tag (Figure 4-37). 

Figure 4·37. 

~ Add New Tag Tag Name to Add: TearOff 

To create the dotted tear line effect turn Auto-Leader on in the 
Tab Settings dialog box. 

m Select Tab Settings from the Paragraph menu. Choose Tab 
Number: 1, Tab Type: Off, and Tab Shown As: Leader Char
acter. Then choose the Leader Character ( ... ) with 1 Leader 
Spacing and choose Auto-Leader: On. 

"TearOff" TAB SETTINGS 

Tab NUlIlber: I + I 1 I + I 
Tab Type: Off 

Tab Shown As: leader Char 
Tab location: 18,661 picas & points 

leader Char: 646 (ASCII) 

leader Spacing: 
Auto-leader: On 

I Cancel I 

The dotted line extends across the Box Text to the margin. 
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I Tag the remaining text 
Now finish tagging the invoice using the pre-defined tag 
names from the Assignment List. Change views as necessary. 

m Select the paragraphs ''DATE,'' "INVOICE #," "CHARGES," 
"CREDITS," and "BALANCE" and tag them as Label. 

m Select the paragraph "PREVIOUS BALANCE" and tag it as 
LabelLeft. 

~ In the Balance column tag "50.00, 150.00, and $200.00" as 
Balance. Then tag "150.00 and 150.00" in the Charges 
column and "100.00 and 00.00" in the Credits column as 
ListDecimal. 

m Select the paragraph "PLEASE PAY THIS AMOUNT" at 
the bottom of the page and tag it as LabelBlack. 

i1 Select the paragraph at the bottom of the page that begins 
''XYZ CORPORATION, 123 Main Street ... " and tag \it as 
Address. 

Number lists with decimal alignment 
If you work with lists of numbers on a regular basis, you may 
want to know how we got all the numbers to line up in the 
columns. (If you do not work with tables, feel free to skip to the 
next section.) The trick is to use Ventura's Decimal Alignment 
feature (Alignment, Paragraph menu). With Decimal Align
ment you tell Ventura how far from the right margin you want 
to position the first decimal point of the paragraph. For the 
Balance tag in the example above, we specified In From Right 
To Decimal spacing as 05,06 picas & points. Then all the 
paragraphs tagged as Balance line up under the decimal 
point. Figure 4-38 shows the Alignment dialog box settings 
for the Balance tag. 
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Pictures 

"Balance·' AL IGNMENT m 
Harz. Align~ent: Deci~al 
Vert. Align~ent: Top 

Text Rotation: None 
Hyphenation: Off 

Successive Hyphens: 2 
Overall Width: Colu~n-Wide 

First Line: Indent 
Relative Indent: Off 

In/Outdent Width: BB,BB\ picas & points 
In/Outdent Height: BB1 lines 

In Fro~ Right to Deci~al: B5,B6 
M<'lX'l.j'IUj:1 Rot;~:lt;~'td H~:]it3ht;: (0) 00 

OK I I Cancel I 

Figure 4·38. The Alignment settings for the Balance tag. 

With Text and Style behind you, you can look ahead to the 
next part of the formula: Pictures. Now that you've placed and 
positioned the shapes, you can modify the line and fill at
tributes of the shapes to create new effects. In this section you 
will create a gray pattern (tint screen) effect and make the 
border lines around selected Box Text invisible. 

Change fill attributes 
Start by selecting the shapes you want to fill with a pattern. 

II Enable Graphic mode. 

mUse Shift-Click to select the boxes that will be shaded. Use 
Figure 4-39 as your guide. (You may want to change to 
Reduced View to select the shapes.) 

-NOTE: If you click on the wrong box, simply click it again to 
deselect it. Then select another shape. 

~ Select Fill Attributes from the Graphic menu (or press 
Ctrl-F). Choose Color: Black, Pattern: 2, and Result: 
Transparent and click OK (Figure 4-40). 
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Shlpto: 
Intamadonal Paper Co. 
1701 Broad Slreet 
Philadelphia, PA 19000 

XVZ 
CORPORATION 

123 Main Street 
los Angeles, CA 90000 

(213) 555-1111 

No. 1001 

Plelll8 ReV" Tap Portion Wl1h Payment AmountofPoyment$ ___ _ 

IlYZCORPORATION 
123MalnSfrtHJt 

150.00 
150.00 

50.00 
150.00 

$200.00 

Lo. Angel ... CA «KJOO PLEASE PAY THIS AIIOUNT 

Figure 4·39 Select the boxes that are shaded in this illustration, 

FIll ATTRIBUTES for BOX TEXT 

Color: 
Pattern: 

Result: 

Defaults: 

Figure 4·40. 

Black 
2 

Opaque 

Transparent 

load From ... I I Save To ... 

Cancel 

Pictures 
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Change line attributes 
Now you will remove the lines around selected shapes. 

m Use Shift-Click to select the Box Text shapes highlighted in 
Figure 4-41. 

Figure 4·41. Select the Box Text shapes shown in this illustation. 

-NOTE: Make sure you select the Box Text shapes, "Please 
Return ... ," "Amount of Payment, " and the tear off line. 

tI Select Line Attributes from the Graphic menu (or press 
Ctrl-L). Choose Thickness: None. Click OK. 

LINE ATTRIBUTES for BOX TEXT 

Thickness: None 

Color: Black 

End Styles: ~ I11III ~ I11III 

Defaults: I Load FrOM ... I I Save To ... 

I Cancel I 
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If any of the Box Text still have borders, simply reselect the 
box and change its line attributes to none. 

Check that the invoice resembles Figure 4-42. 

Ship to: 
IntemaUonal Paper Co. 
1701 Broad SIr90t 
Philadelphia, PA 19000 

XVZ 
CORPORATION 

123 Main Slreet 
Los Angeles, CA 90000 

(213) 555-1111 

No. 1001 

PlellM Ae1urn Top Portion WI" Payment Amount of Poyment $ __ _ ................................................................ 

XYZCORPORATtON 
12311a/n SltHt 
Lo_ Angel._, CA 90000 

150.00 
150.00 

50.00 
150.00 

$200.00 

PLEASE PAY TtlIS AMOUNT 

Figure 4·42 After shading some of the boxes, and removing some lines, 
the invoice should look like this, 

Add line and arrow 
To add the finishing touches to the form, you will add an arrow 
after the words "Previous Balance." 

~ Select the line tool from the Side-Bar. When the slanted 
pencil appears, place its "point" after the e in the word 
Balance. You may want to change to Enlarged View to draw 
the line (Figure 4-43). 
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Figure 4·43. 

II Press the Alt key as you drag the line to the right. (The Alt 
key keeps the line perfectly straight as you draw.) Stretch 
the line until it lines up with the letter "B" in the word 
BALANCE on the line above. 

Use the Line Attributes dialog box to put an arrow at one end 
of the line. 

m Select Line Attributes (or press Ctrl-L). Choose Thickness: 
Thin, Color: Black and choose the arrow in the right column 
of End Styles. 

LINE ATTRIBUTES fo~ LINE 

Thickness: Thin 

Co1o~: Black 

End Styles: v I11III I11III 

Defaults: I Load F~olll... I Save To ... 

I Cancel I 
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Show the graphics on all pages 
To create more numbered invoices you will add pages and tell 
Ventura to repeat the graphics on all pages. Because the 
header includes the page numbering code ([P#]), when you 
add a page the invoice number will increase by one. 

You must select all the graphic shapes before you tell Ventura 
to repeat them on all pages of the document. 

m Choose Select All from the Graphic menu (or press Ctrl-Q). 

m Select Show On All Pages from the Graphic menu. 

Bring to Front AA 

line Attributes ... Al 
Fill Attributes ... AF 

Select All AQ 
Grid Sett· 

PW04RPTG.IMG 

To see the shapes repeated, you will insert a new page . 

... NOTE: When you use Box Text as the only text in the docu
ment, Ventura doesn't automatically create a new page for 
you. Therefore, you must insert one manually. 

~ Select InsertlRemove Page from the Chapter menu. Choose 
Operation: Insert New Page Mter Current Page and click 
OK. 

Ventura adds a page and moves you to it. Because you in
serted a page manually, you must update the page counter so 
that the invoice number will change. 

m Select Update Counters from Chapter menu. 

m Choose Which Counter: This Page, Update Method: Pre
vious Number + 1, NumberFormat: 1,2 and click OK. 
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Chapter 

The header now reads "1002." Now every page you insert will 
increase the page number by one (Figure 4-44). 

Figure 4·44. 

XYZ..r 
CORPORATION' 

123 Main StreetJ 
Los Angeles, CA 90000J 

(213) 555-11110 

No.l(1021J 

Now that you've seen the invoice on the screen, let's see how it 
looks printed out. Ventura's print option allows you to print 
multiple copies of a document. When you print this time, tell 
Ventura to make three copies of the form. 

m To Print Which Pages: Current 
Number of Copies: 3 

Ventura prints out three copies of the invoice. Incidentally, 
once a laser printer has processed one copy of a single page, it 
takes less time to make additional copies, because the fonts 
are already in memory. 

In this chapter, you learned how to create a graphics-intensive 
document using Ventura's graphic tool kit. In the next chap
ter, you will learn how to create another document that relies 
heavily on graphics to convey a message: an advertising flyer. 
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Tips and techniques 

When to use Box Text 

Use Box Text to contain text if you want to: 

D Quickly place less than two dozen words. For longer selec
tions, consider using a frame so the text can be placed into 
a separate file if desired. 

D Attach the text to something else. If, for example, you wish 
to create callouts for an illustration, you want the text to be 
tied to that frame. When you move the frame, the Box Text 
automatically moves with it. And since you can anchor a 
frame to a text reference, the graphics attached to the 
frame will move according to the text reference. 

D Move Box Text shapes as a group. Box Text can be grouped 
by attaching them all to the same parent frame. When you 
move the parent you automatically move all the Box Text. 
Frames, on the other hand, cannot be permanently linked 
(although you can temporarily group them using shift-click 
to select several at a time). 

When to use frames 

Use a frame to contain text if you want to: 

D Import a file. You cannot load a file into Box Text. You must 
always type Box Text directly onto the page. 

D Rename the text to a separate file. Even if you originally 
type the text into the chapter, you may sometimes want to 
rename text into a separate file. A stand-alone text file can 
be easily edited or updated with a word processor. 

D Create more than one column inside the rectangle. You can 
create multiple columns inside a frame, but not inside Box 
Text. 

D Flow text around the rectangle. Text can flow automatically 
around a frame. By contrast, Box Text coexists with 
whatever else is in the same space. 

D Put more than one ruling line around the rectangle. Box 
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Text can have only a single ruling line around. Frames can 
have up to three. 

More graphic drawing tips 

D Align Box Text shapes along a grid. The snap-to grid avail
able in Graphic mode is more versatile than the column
and line-snap available in Frame mode. 

o When you draw a shape it appears on that page only. To 
repeat graphic shapes on all pages of the chapter select 
Show On All Pages from the Graphic menu. 

D When selecting the parent, make logical groupings so all 
related shapes can be moved as one by moving the parent. 
For instance, if you were constructing a two-part form 
using frames instead of the Page, you could attach all the 
shapes on the top half to one parent, and all the shapes on 
the bottom half to a different frame. That way the two 
halves could be adjusted independently. 

D Ctrl-Q is the keyboard shortcut for Select All from the 
Graphic menu. This graphics command operates even in 
Frame mode. (It is the only one that works in this manner. 
To use any other graphic commands, you must switch to 
Graphic mode.) 

D Establish snap-to grid settings before you start to draw. 
There may be a few exceptions where you wish to turn grid 
settings off for complete freedom in placing a shape. In 
most cases, your drawings will be more accurate and attrac
tive if you establish a snap-to grid in advance. 

D Set the grid as large as possible. The larger the units of the 
grid, the smaller the possibility for error. 

D Consider the margin when setting the grid. If possible, 
make the snap grid units an integer multiple of the mar
gins so the shapes can also snap to the margin. 

D To move a very small shape, attach it to a larger frame. 
(The frame can be "invisible" if you do not want it to print.) 
Then move the frame. The shape moves with it. 

o To draw several shapes at once, hold the Shift key down 
while dragging the mouse. The cursor stays in shape draw
ing mode and you can draw a second shape immediately. 
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o To speed the creation of identical shapes, use the Save To 
button in the Line Attributes and Fill Attributes dialog 
boxes. This saves the attributes you have just chosen. From 
then on, every shape you draw is identical to the previous 
one. 

o To select several shapes at once, use the same Shift-Click 
method that operates in Paragraph mode. Once you have 
selected more than one shape, you can move, resize, or 
change the attributes of these shapes as a group. 

o To select a shape that is underneath another, hold down the 
Ctrl key while clicking on the shape with the mouse. Each 
time you Ctrl-click, Ventura selects the next lowest "layer," 
no matter how many shapes are piled one on top of the 
other. 





Chapter Five 
Skills Checklist 

Theory 
o How Ventura manages pictures 

o Line-art versus bit-mapped images 

o Encapsulated PostScript 

Text 
o Improving headlines with manual 

kerning 

o Entering non-keyboard characters 

o Understanding letter spacing 

o Reducing loose lines 

Style 
o Combining two page formats in one 

document 
o Improviing display type with 

interactive tracking and kerning 

o Adding columns to frames 

o Adjusting the vertical spacing in 
frames 

o Rotating text 

Pictures 
o Sizing and scaling pictures 

o Cropping pictures 

o Loading and placing PostScript files 

o Creating text runarounds 
o Adding drop shadows to frames 

Chapter 
o Printing to a disk file 

o Creating PostScript files 

o Printing hidden pictures 
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An Advertising Flyer 

Theory 

Advertisements and flyers are invaluable promotional 
tools. In Chapter Five, you will learn how to create a 

self-mailing ad. Although we constructed this project as a 
direct mail piece, many of the techniques apply equally well to 
print advertisements. In essence, we will show you the basics 
of creating an ad plus the added techniques to turn that ad 
into a self-mailing flyer. The checklist on the left lists some of 
the special skills you will learn. 

In Chapter Four, you learned how to use Ventura's built-in 
graphics to create simple box, line, and rectangle shapes. 
These basic shapes are useful for forms, annotations, and 
simple artwork. But for the sophisticated graphics required of 
an advertisement, you need dedicated, stand-alone graphics 
programs. Programs like AutoCAD, Adobe Illustrator, and PC 
Paintbrush provide specialized drawing and painting tools for 
creating high-quality images. Fortunately, Ventura makes it 
easy to import these complex images into a document. 

The advertising project you will complete in this chapter 
depends heavily on graphics effects. You will find it easier to 
follow along if you understand these three key concepts: 

• How Ventura manages picture files 

• The two kinds of pictures 

• How to change the size and position of pictures inside the 
fr~e -
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How Ventura manages pictures 
Mter you create a picture, you load and place it in a frame. 
However, the chapter file doesn't store the image itself, it 
stores a pointer to the picture file with information about how 
to display and assemble the picture in the chapter. Picture 
files cannot be changed from inside Ventura. 

Two kinds of pictures 
Ventura accepts two kinds of picture files: bit-mapped images 
and line-art. Paint programs, scanners, and screen capture 
utilities create bit-mapped images. These images are a collec
tion of thousands of individual dots (or bits). As you draw, the 
computer makes a map of the screen and figures out which 
dots to turn on and off (Figure 5-1) . 

••••••• ........... ••• • •• •• •• I. •• •• •• • • I I • • .. .. •• •• •• •• ••• • •• ........... ....... 

Figure 5-1. W~h a bit-mapped image, the picture is made up of 
individual dots. 

Since an image is a map of the screen, the final quality of the 
picture is only as good as the screen's resolution. Few screens 
can match the 300 dots-per-inch resolution of a laser printer. 
Therefore, at print time, bit-map curves and diagonals appear 
jagged. Despite this trade-off in quality, a paint package can 
provide subtle, artistic effects, shades and shadows that are 
difficult to achieve with line-art. 

By contrast, line-art programs such as AutoCAD, MacDraw, 
and GEM: Draw do not use bit-maps~ They combine basic 
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geometric shapes to build up pictures. Shades, surfaces, and 
planes are rendered as lines, arcs, circles, and other geometric 
objects. Hence the term "object-oriented" graphics. 

These objects are stored as mathematical expressions. A circle 
is described as a center point and a radius, a line is described 
as a starting and ending point, an arc as three consecutive 
points, and so forth. Line-art has several advantages. When 
you print an object-oriented picture, the computer sends its 
description to the printer. The picture is then printed at 
whatever resolution the printer or phototypesetter is capable 
of - 300,600, 1200, or 2500 dots per inch. As a result, lines 
and curves appear smooth (Figure 5-2), 

Figure 5-2. When you print an object-oriented picture, you send its 
mathematical description to the printer. The picture is printed at the 
resolution of the printer or typesetter. 

Line-art has another advantage. You can enlarge or reduce it 
without losing picture quality. You don't have to worry about 
creating it at the same size as the final version. 

Encapsulated Postscript files 
If you have a PostScript printer you can also use a special kind 
of line-art. With the Encapsulated PostScript (EPS) format 
you can create a small facsimile of each of your Ventura 
documents and insert them as line-art in a frame. For in
stance, we used the EPS format to produce the "after" pictures 
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near the beginning of each chapter. When you place a Encap
sulated PostScript file created in Ventura, the picture is not 
displayed on screen. Instead, the picture appears as a large 
"X" (Figure 5-3). The picture, however, is visible when you 
print. You will have a chance to use Encapsulated PostScript 
to build the sample advertisement in this chapter. 

Figure 5-3. Encapsulated PostScript files generated by Ventura 
appear on-screen as a large X . 

.. NOTE: Programs that embed TIFF image or Windows metafile 
representations of PostScript within the EPS file will be visible 
on-screen. 

Sizing and scaling pictures 
Both line-art and images can be scaled and cropped through 
the Sizing & Scaling dialog box (Figure 5-4). 

For many beginners, Sizing & Scaling is one of the most 
difficult Ventura functions to grasp. We will present you with 
basic concepts here in the theory section, but don't be too 
surprised if you don't understand all the ins and outs until 
you've had some hands-on practice. 

The dialog box gives you two options: Fit in Frame and By 
Scale Factors (Figure 5-5). Fit in Frame enlarges the picture 
until it fills the entire frame. (If you've set margins, Ventura 
will fill the frame up to the frame margins.) 
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SIZItti & SCRUNG 

Flow Text RrOllld: In 

Upper Left X: 06,001 a c::J 
Frallle Width: 17,00 

Horiz. Padding: 00,00 

Upper left Y: 13,08 a c:J 
Frallle Height: 22,OB 

I.Iert. Padding: OOIBB picas & points 

Picttre Scaling: 'HgNW; I By Scale Factors I 
Aspect Ratio: "MIl" Distorted I 

H Crop Offset: 00,09 a c::J Y Crop Offset: OBIBO a c:J 
Scale Width: P)OO Scale Height: i?2)OO 

Figure 5·4. 

Figure 5-5. Fit in Frame enlarges the picture to fill the frame up to its 
margins. 

5-5 

When you fit a picture into a frame, you can instruct Ventura 
whether to maintain or ignore the original aspect ratio. By 
setting Aspect Ratio: Maintain Ventura enlarges the picture 
as much as it can without changing the original horizontal 
and vertical proportions. This may leave some extra white 
space around the image. Aspect Ratio: Distorted, on the other 
hand, stretches the picture as necessary to fill the frame even 
ifit has to distort the proportions (Figure 5-6). 

Remember when we warned you earler that Sizing & Scaling 
can be confusing at first? Here comes the part that trips up 
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Aspect Ratio _-++~;';';';;;;;'~I+ 
Maintained 

Aspect Ratio ---I-'t+--~~ 
Distorted 

Figure 5-6. You can maintain or distort the aspect ratio to achieve the 
desired effect. 

many beginners. When you choose Fit in Frame, Ventura 
scales (resizes) the picture for you. If you want to resize the 
picture manually, you must choose By Scale Factors. 

Maybe it's the name that puzzles people. By Scale Factors is a 
fuzzy phrase that doesn't really explain what's going on. Per
haps it will be easier for you to grasp if you think of it as 
Manual Resizing or Changing Dimensions. Here's the idea in 
a nutshell: Ventura displays the old dimensions. You type in 
the new ones. Simple, isn't it? Now let's examine the operation 
in more detail. 

When you choose Picture Scaling: By Scale Factors, Ventura 
displays the picture's original size (on the lines Scale Width 
and Scale Height). To change the size, you enter a new width 
or height (or both). Suppose you start with a picture 06,00 
picas & points wide by 08,00 picas & points tall. To double the 
picture's width, you would choose Picture Scaling: By Scale 
Factors and then enter 12,00 picas & points as the new width. 
After you enter the new width, you can choose whether or not 
to keep the original proportions. Aspect Ratio: Maintain calcu
lates the height to maintain the same proportions as the 
original. In the previous example, if you entered a new width 
of 12,00 picas & points, Ventura would double the height to 
16,00 picas & points to maintain the original width and height 
ratio. With Aspect Ratio: Distorted you can choose any com
bination of widths and heights (Figure 5-7). 
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Desk File Edit View Chapter Frane Paragraph Graphic Options 

• :~~:~~:~~:~~:~~i~~:~~:~~'~~i~-C:\NPESEf\tliTmID.-CHP--fDffOOn:sfYf~~:~~i~~i~~i~~i~~'~~:~~:~~~~ • 
fXif1.) Peas 12,00 peas 01,00 picas t 

Originalsize &fScale Factor: &fScale Factor. 
AspectRatioManain Aspect Ratio Ilstooed 

... 
Figure 5-7. When you increase the size of a picture By Scale Factors, 
you can maintain or distort the aspect ratio . 
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.. TIP: When working with scale factors, the height and width in 
the Sizing & Scaling dialog box represent the current size of 
the picture. To change the dimensions of a picture, enter a new 
height and width. 

Cropping pictures 
While scaling enlarges or reduces a picture, cropping moves it 
up, down, right, or left within the frame to display selected 
portions of the picture. 

With both bit-mapped and line-art images, you can crop inter
actively by moving the picture within the frame with the 
mouse cursor. Here's how: In Frame mode, you select the 
frame containing the picture to crop, and place the mouse 
cursor somewhere in the middle of the frame (or picture). 
Then you hold down the mouse button while pressing the Alt 
key. A picture of a hand appears. You hold the mouse button 
down and drag the hand to move the image (Figure 5-8). 

If you need more precision, you can crop the picture by en ter
ing a positive or negative X or Y offset. The offset is the 
distance the picture moves from its original position. Imagine 
a horizontal and vertical axis starting at the upper left corner. 
You can slide the picture along the horizontal (X) axis or the 
vertical (Y) axis. A positive X offset moves the picture left; a 
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Figure 5-8. You can crop bit-mapped and line-art pictures interactively 
by pressing the Att key and holding down the button as you move the 
mouse inside the frame. 

Theory 

negative X offset moves it right. A positive Y offset moves the 
picture up; a negative Y offset moves it down. 

If you want to practice cropping, try changing one variable at 
a time: enter a positive X offset only, then a positive Yoffset, 
and so forth. Then try combining a positive X and a positive Y 
offset; a negative X and a Y. The more you practice, the better 
you'll be able to visualize the position of the picture in the 
frame. Figure 5-9 shows one example. 

Desk File Edit UiBII Page Frane Paragraph &>aphic Options 

• ~:~~:~~:~~:~~:~~:~~:~~:~~:~f C: \POIlER\II5\SRIfPLE\5SCRlIHD . ClIP (SAD. STY) ~~:~~:~~:~~:~~:~~:~~:~~:~~' • 
XOfbet+4,OO picts mOYl!Sthe XOffsI!t-4,OOpicasmovesthe t 

II pictne4,OO picas to the left picture4,OO picas to the right I JF 

+ 

Figure 5-9. You can also crop pictures by entering numbers into the 
Sizing & Scaling dialog box. 

I 

I 
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Planning the flyer 
Consider the thousands of advertisements you see each year. 
How many do you remember? In a small amount of space an 
advertisement must provoke, lure, entice (or annoy) the 
prospect into reading the copy and (hopefully) buying the 
product. Advertisements also carry another responsibility: 
They project the company name and image to the outside 
world. For these reasons, good design is crucial to the success 
of an advertisement. Some documents - reports, proposals, 
memos - can get by with an adequate page design. But 
adequate is not good enough for an ad. The public is bom
barded by hundreds of advertisements each day. Sales 
materials that are merely average will be ignored. 

The design of an advertisement carries several burdens. First, 
it must attract attention. Second, it must lead the eye into the 
copy and keep it moving. And third, it must reinforce the 
underlying theme and message of the words. Meeting these 
goals requires attention to all the details that make up good 
design - the layout, the typography, the white space, the 
graphics, and so on. Fortunately, Ventura Publisher provides 
the tools to fine-tune your pages so they stand out from the 
crowd. 

This chapter's sample advertisement is a self-mailer - it can 
be folded in thirds, stapled, and mailed without needing an 
envelope. The first page is the mailer. It has been divided into 
three panels as illustrated in Figure 5-10. The top panel (#1) 
is the inner flap. It is tucked inside when the flyer is folded 
and stapled for mailing. The center panel (#2) is the back flap. 
Both the inner and the back flap contain "teaser copy," 
designed to entice the reader into opening the mailer and 
reading further. The bottom panel (#3) is for the address. It 
appears on top when the flyer is folded and contains the 
return address, mailing label, and stamp. 

The second page of this document is the advertisement itself. 
It will be printed on the opposite side from the mailer. When 
the readers open the flyer, they can see the ad as a single, 
full-page unit. 
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Figure 5-10. The first page of the flyer has three panels that can be 
folded for mailing. 
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-NOTE: If your company does not prepare mailers, you can 
skip the instructions for page one and produce only the ad on 
page two. The principles and theories taught for page two 
apply equally to print advertisements. 

The thumbnail sketch for the the advertisement shows you 
some of the techniques you will use to create these effects: 

• Frames on the Page 

• Box Text 

• Textrunarounds 

• Kerned headlines 

• Drop shadows 

• Special non-keyboard characters for a trademark symbol, 
ellipsis, and em dash 

• Typographic controls to fine-tune the headlines and body 
copy 
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Ventura prep 

II If you have the Power disk 
~ If you are continuing from the previous chapter, select New 

from the File menu to clear the screen. 

~ Enable Frame mode and select the Page. 

~ Select Load Text/Picture to load the ASCII format text file 
5AD. TXT from the C: \POWER subdirectory. The text auto
matically flows onto the Page. Use File/Type Rename to 
rename it as C:\TEMP\5MAILER.TXT. 

Because the Page was selected when you loaded the file, 
Ventura placed the file on the Page for you {when you load 
several files, Ventura does not attempt to place any of them. 
You must remove the file from the Page, however, before you 
can add frames to contain text and graphics. 

~ Select Remove TextlFile from the Edit menu. The file name 
SMAILER. TXT appears on the File name line. Choose 
Remove from: Frame. 

-NOTE: As we explained earlier in Chapter Two, Ventura will 
not allow you to rename a text file until it has been placed on 
the Page. 

~ Select Load Diff. Style to load the style sheet 5AD.STY from 
the C: \POWER subdirectory. 

~ Use Save As New Style to save it as 
C: \ TEMP\5MAILER.STY. 

Now load the two PostScript files. 

~ Select Load TextlPictures and choose Type of File: Line-Art, 
Line-Art Format: PostScript, and # of Files: Several. Load 
the two files, 5AD.EPS and 5COURIER.EPS in turn from 
the C:\POWER subdirectory. When you are finished, click 
OK or Cancel to return to the document. 

Next, load the line-art picture. 

m Press Ctrl-X to redisplay the Load/Text Picture dialog box. 
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Choose Type of File: Line-Art, Line-Art Format: GEM. Load 
the file COMPUTER.GEM from the C:\POWER subdirec
tory . 

.. TIP: You can use Ctrl-X whenever you want to redisplay the 
previous dialog box. 

~ Use Save As to save the chapter as 
C: \ TEMP\5MAILER.CHP. 

If you do not have the Power disk 

Text 

~ Using your word processor, type the text file for Chapter 5 
from Appendix A and save it as C:\ TEMP\5MAILER.TXT. 

~ Load the original Ventura style sheet &PREL-P1.STY from 
the C:\TYFESET subdirectory. Change the margins and 
columns to match Figure 5-11. Rename it as 
C: \ TEMP \ 5MAILER. STY. 

~ Change the tags to match the ones listed in the tag table in 
AppendixB. 

~ Load three Ventura sample line-art picture into the Assign
ment List. If you don't have any line-art pictures of your 
own, load the Ventura sample picture COLUMBIA.GEM 
from the C:\TYPESET subdirectory. 

m Save the chapter as C: \ TEMP\5MAILER.CHP. 

In this project, you will use three techniques to place text. You 
will place a file into a frame; you will type text directly into a 
frame; and you will use Box Text. This is a good opportunity to 
apply what you've already learned about text to a design that 
requires a combination of different skills. Like the newsletter 
and form in Chapters Three and Four, this sample document 
relies heavily on text in frames and Box Text. Therefore, you 
will vary slightly from the Ventura Formula and delay placing 
text until you build frames and boxes to contain it. 
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Style 

03,00 picas & points 

One column. 
Live area: 45,00 x 60,00 picas & points 

Trim size: 51x66 picas 
& points (8.5x11 in.) 

Figure 5·11. If you do NOT have the Power disk, change &PREL·P1.STY to match these 
dimensions. 

Style 

Your first task is to size and position frames and Box Text. If 
you start by laying out the margins and columns on the Page, 
you can use them later as a guide. 
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.. TIP: Even when creating a free-form, graphics-intensive docu
ment, start by formatting the Page as a framework. 

Select the page format 
Since this piece is a self-mailer, it will be printed on both sides 
- the mailing information on the outside and the ad on the 
inside. As you know from Chapter Three, a double-sided for
mat allows you to mirror identical headers, footers, margins, 
etc., on right and left pages. For this advertisement, however, 
you will create left and right pages that have completely 
different values (Figure 5-12) . 

.......................................................... 

~ ~ 

~ •••••••••••••••••••••••••••••••• u .................... .. : ................... )i.. ................. , 

Figure 5-12. This project has different formats for the left and right 
pages. 

~ Select Page Size & Layout from the Chapter menu. Choose 
Sides: Double, Start On: Right Side. 

Layout page one 
The style sheet you loaded (or created) contains the column 
and margin settings for the first page. This one-column format 
lets you easily place and size frames for the mailing panels. 
Continue on to add frames and Box Text to the page. 

1m Verify that Column Snap and Line Snap are turned on from 
the Options menu. (The menu displays "Turn Column Snap 
Off' and "Turn Line Snap Off.") 
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m Reset the zero point to line up with the upper left corner of 
the column guide (Figure 5-13). 

Figure 5-13. 

-NOTE: If you reset the zero point (to a point other than the 
upper left corner of the Page), the Upper Left X and Yvalues 
in the Sizing & Scaling dialog box do not change to reflect the 
new ruler positions. The Upper Left X and Y values are always 
measured from the upper left corner of the page. 

Draw three frames on page one 
~ Draw three frames on top of the Page. Draw frame #1 

starting at position 0,0 picas on the ruler. Draw frame #2 
starting at position 21 picas on the vertical ruler and frame 
#3 starting at position 42 picas on the vertical ruler. 

Use the horizontal and vertical crosshairs and rulers, and the 
Sizing & Scaling dialog box to position and size the frames on 
the Page. Figure 5-14 will help you gauge the frame dimen
sions . 

... TIP: For more accuracy, you may want to change to Normal 
View. Place the upper left corner and stretch the frame as 
large as possible. Then enter the width and height of the frame 
through the Sizing & Scaling dialog box. 



Draw three frames on page one 

Frame #1 
Upper Left X: 03,00 picas 
Upper Left Y: 03,00 picas 

45,OOx17,06 picas 

Frame #2 
Upper Left X: 03,00 picas 
Upper Left Y: 23,06 picas 

45,OOx18,06 picas 

Frame #3 
Upper Left X: 03,00 picas 
Upper Left Y: 45,03 picas 

45,00 X18,OO picas 

Figu re 5·14. Draw these three frames on page one. 
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You will notice that the frames are not of equal size; nor are 
they spaced equally. Rather, they have been sized so that the 
smaller inner flap can fold up comfortably beneath the ad
dress flap. 
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Draw Box Text shapes in the bottom frame (frame #3) 
Now that you have placed the three frames, you will add the 
Box Text and rectangle shapes that show the position of the 
return address, mailing label, and stamp in the bottom frame. 
Start by setting a snap-to grid. 

e Enable Graphic mode. Select the bottom frame (frame #3). 

e Select Grid Settings. Choose Grid Snap: On. Make both the 
Horizontal and the Vertical Spacing 01,00 picas & points. 

GRID SETTINGS 

Grid Snap: On 

Horizontal Spacing: 01,001 picas & points 

Vertical Spacing: B1JBB 

I Cancel I 

Draw the return address Box Text 
Draw the return address using Box Text. 

m Reset the zero point of the ruler to line up with the upper 
left corner of the bottom frame (Figure 5-15). 

m Select the Box Text tool from the Side-Bar. Starting at 
position 01,00 picas on the vertical ruler and position 01,00 
picas on the horizontal ruler, draw a box 05,00 picas high 
and 12,00 picas wide . 

.. TIP: Remember, you can check the size of a Box Text or 
rectangle by placing the ruler's zero point on one corner of the 
shape. 
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r'--'--'--'--'--'--'--'--'--'-l 
I I 

L--------l 

Figure 5-15. 

Next you will change the line attributes for the Box Text. 

~ Line Attributes Thickness: Thin 
End Styles (Beginning and End): Square 
Defaults: Save To 

a Fill Attributes Color: White 
Pattern: Hollow 
Results: Transparent 
Defaults: Save To 

Draw the mailing label 
Now you will use the Box Text shape to draw a mailing label 
06,00 picas high and 24,00 picas wide (1 inch by 4 inches, a 
standard label size) in the bottom frame (frame #3). 

a Select the Box Text tool. Starting from position 08,00 picas 
on the vertical ruler and 13,00 picas on the horizontal ruler, 
draw the box 06,00 picas high and 24,00 picas wide (Figure 
5-16). 

Ventura remembers the line and fill attributes from the last 
Box Text. 
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L._._. ________ ._. ___ ._. ______ . _____ . __ . ____ . __ . __ . __ .~ 

Figure 5-16. 

Draw the stamp 
Now you will draw the "stamp" with a rectangle shape. 

m Grid Settings Grid Snap: On 
Horizontal Spacing: 00,06 picas & points 
Vertical Spacing: 00,06 picas & points 

1m Select the rectangle tool from the Side-Bar. Draw a rec
tangle 03,00 picas high and 04,06 picas wide in the upper 
right corner of the frame (Figure 5-17). 

If necessary, move the rectangle into position. 

Figure 5-17. 
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- NOTE: Judge the position as best you can from previous 
illustrations. Accuracy is not essential. 

Change the rectangle's attributes 
~ Line Attributes Thickness: Thin 

End Styles (Beginning and End): Square 
Defaults: Save To 

B Fill Attributes Color: White 
Pattern: Hollow 
Results: Transparent 
Defaults: Save To 

Layout page two 
You have completed the layout for page one. Before you con
tinue, reset the zero point back to its original position at the 
upper left corner of the column margin. As you saw earlier, 
when you place text in frames (instead of on the Page), Ven
tura doesn't automatically create new pages. Therefore, you 
must add one manually. 

m Select InsertlRemove Page from the Chapter menu to in
sert a new page after the current one. 

~ Choose Operation: Insert New Page Mter Current Page 
and click OK. 

On the second page, you will create a two-column format with 
different margins and columns from the first page. The new 
format will make it easier to size and place the frames for the 
finished layout. 

m Enable Frame mode and select the Underlying Page. 

il Select Margins & Columns from the Frame menu. Choose # 
of Columns: 2. Set the top and bottom margins at 03,00 
picas & points. Make the left and right margins 08,00 picas 
& points. Make the Column 1 width 16,03 picas & points 
and the first gutter width 02,06 picas & points. Choose 
Make Equal Widths and click OK. 
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MARGINS & COLUMNS 

** of Columns: CD II m m []] m m []J 
Settings For: 'en,;;,. I Right Page I 

ColurIln 1: 
2: 
3: 
4: 
5: 
6: 
7: 
8: 

Insel"ts: 

Widths 
16,031 

16,03 
f.jg ~ f.!f.l 
f.jg,I'lf.l 
f.jg,I'lH 
f.jg,1'l0 
f.jg ~ I'lf.! 
f.jg~f.!0 

Gutters 

02,06 
oO,no 
nO,no 
00,00 
()(),OO 
()O,OO 
00,00 

11ake Equal Width 

Mal"gins 
Top: 83,BB picas & points 

Bottorll: 83,80 
Left: 88,80 

Right: 88,80 

Calculated Width = 51,80 
Actual Frame Width = 51,80 

~ I Copy To Facing Page I 
[][] I Cancel I 

Style 

- TIP: As a general rule, always enter the top, bottom, left, and 
right margins before you enter the column widths. If you want 
all the columns equal, use this sequence: enter the first 
column width, then the first gutter width, and then choose 
Make Equal Widths. If you want unequal columns, enter the 
first column width, then the first gutter width, and then man
ually enter the second column width. 

Add frames to page two 
Once you set the margins and columns for page two, you are 
ready to add the frames. Use the ruler plus Line and Column 
Snap to accurately position the frames as shown in Figure 
5-18. Use the Sizing & Scaling dialog box to verify the posi
tion and size of the frames. 

m Draw the frames on page two using Figure 5-18 as a guide. 

- NOTE: We intentionally placed the bottom-most frame (frame 
#6) so it extends below the bottom column guide. 

Add a ruling box around the center frames 
To make the two center frames (frame #6 and #7) stand out on 
the page, and to enclose the pictures that will be placed inside, 
add a Ruling Box Around. 

E Select the left frame (frame #6). 
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Frame #4 
Upper Left X: 08,00 picas 
Upper Left Y: 03,00 picas 

35,00x12,08 picas 

Frame #5 
Upper Left X: 08,00 picas 
Upper Left Y: 19,00 picas 

35,OOx02,08 picas 

Frame #6 
Upper Left X: 08,00 picas 
Upper Left Y: 22,11 picas 

Frame #7 
Upper Left X: 26,09 picas 
Upper Left Y: 22,11 picas 

16,03x21 ,00 picas 16,03x21 ,00 picas 

Frame #8 
Upper Left X: 08,00 picas 
Upper Left Y: 46,11 picas 

35,00x13,04 picas 

Frame #9 
Upper Left X: 08,00 picas 
Upper Left Y: 60,02 picas 

35,OOx04,03 picas 

Figure 5·18. Draw frames matching these dimensions on page two. 
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E Select Ruling Box Around from the Frame menu. Choose 
Width: Frame. Give Rule 1 a height of 00.25 fractional pts 
and click OK. 



5-24 Style 

RULING BOK AROUND m 
Width Fralile I Color Black 

Pattern Solid 
Dashes Off 

36.00 
Space Aboyc Rule 1: 00.00 

Height of Rule 1: BB. 251 Custom Indent: 00,00 
Space Below Rule 1: lIO.OO Custor. Width: OO,()() 

Height of Rule 2: lIO.OO 
Space Below Rule 2: lIO.OO Dash Width: 00,00 

Height of Rule 3: eo.oo Dash Spac ins: 00,00 fractional pts 

Space Below Rule 3: (10.00 Dc:] 
Overall Height: BO.25 

Repeat the step above for the right picture frame (frame #7). 
When you are finished the frames should look like Figure 
5-19: 

Figure 5-19. 

Change the number of columns in one frame 
When you place a frame on the Page, Ventura gives it a single 
column and sets all the margins to 00,00 picas & points. With 
Margins & Columns you can change the margins of a frame. 

Select the frame reserved for the body copy (frame #8). 

m Select Margins & Columns. Choose # of Columns: 2. (Notice 
that Ventura remembers the two-column and gutter set-
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tings from the Page.) Leave the column and gutter settings 
as they are and keep all the margins at 00,00 picas & 
points. Then click OK to close the dialog box. 

MARGINS & COLUMNS 

tI of Columns: OJ II m m m m m [[] 
Settings For: 'eU';;,. I Right Page I 

ColUMn 1: 
2: 
3: 
4: 
5: 
6: 
7: 
B: 

Widths 
16,1331 

16,133 
11R,f.!!1 
11R,f.!A 
~,~~ 
OO,f.i0 
11R,f.!!1 
11R,1!l!1 

Gutters 

B2,B6 
00,00 
00,00 
00,00 
00,00 
00,00 
00,00 

Margins 
Top: 00,130 picas & points 

BottOM: 0B,0B 
Left: 0B,0B 

Right: 00,BB 

Calculated Width = 35,80 
Actual Frame Width = 35,00 

Inserts: I Make Equal Widths I I Copy To Facing Page I 
I Cancel I 

Now the frame has the same column and gutter settings as 
the Page (even though the column guides are not visible inside 
the frame). 

Add text to page one 
With the frames in their proper place you can enter the text. 
Start on page one and work frame-by-frame until you have 
placed all the text. 

m Press PgUp to go to page one. 

m Enable Text mode and click the text cursor anywhere inside 
the top frame (frame #1). 

- NOTE: You may want to change to Normal or Enlarged View 
as you type in the text. 

Type the first teaser 
Use a non-keyboard character to create the ellipsis at the end 
of the first teaser headline. At this point, do not worry about 
the appearance of the text. You will format it later. 
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m Type: 

Introducing a cure for the common document 

Now make the ellipsis: 

Style 

~ Hold down the Alt key and use the numeric keyboard to 
type: 193 

Then release the Alt key. 

Type the second teaser 
Now enter the second headline, which includes another non
keyboard character - the em dash in frame #2. 

~ Place the text cursor anywhere in the middle frame '(frame 
#2), and type the text shown in the Figure 5-20. Place a line 
break (press Ctrl-Enter) at the end of each line. 

(To make the em dash, hold down the Alt key and type: 197 on 
the numeric keypad, or type Ctrl-D. 

Figure 5-20. 

Type the return address 

'\0 turn your ideas 'into J 
professiona\-looking documents - J 

\ on your desktop! [] 

Now move to the bottom frame (frame#3). 

~ Type the text into the Box Text shape as shown in Figure 
5-21. Place line breaks (press Ctrl-Enter) at the end of each 
line. If the text doesn't fit, make the Box Text shape bigger. 



Type the mailing address 

Figure 5-21. 

Type the mailing address 
1m Type in the mailing address in Figure 5-22. 

Figure 5-22. 

~Y2 Corporation.] 
23 Main Street.] 

"os Angeles, CA 90000 [] 
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E Enable Graphic mode ,and select both address boxes. 
Change their line attributes to none. 

m Line 
Attributes 

Thickness: None 
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Add text to page two 
Continue on to page two and finish adding text. 

m Press PgDn to go to page two. 

t1 Enable Text mode. 

m Place the cursor inside the top frame (frame #4) (Figure 
5-23) and type: 

The Ventura [Ctrl.-Enter] 
Makeover 

Figure 5-23. 

m Now place the text cursor in the second frame (frame #5) 
(Figure 5-24) and type: 

Take a great idea [tab] [Alt-193] [tab] and make it 
greater 

Place a text file on page two 
The two frames in the middle of the page are reserved for 
pictures. Skip them for now and move to the frame that is 
second from the bottom (frame #8). It will contain the body 
copy you loaded at the beginning of the project. 

00 Enable Frame mode and select the frame. 

m Select the file 5MAILER. TXT from the Assignment List. 
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a great idea·.:.-and makeil 

Figure 5-24. 

Ventura flows the text into the frame and stops (Figure 5-25). 
Do not be concerned that the text doesn't fill the frame. When 
you get to the picture section, you will insert a small frame 
between the text columns, which will reflow the text to the 
end of the frame. 

if.-'-'-'-'-'-'-'-'-'-'-'-'-'-'-'-'-'-'-'-'-'-'-'-'-'-~'y._:"'_._._._._._._._._._._._._._._._._._._._._._._._._.~ 
~10W you can give an ordinary per": ~eek only, when you come in for Ol 

~onal computer Ihe power of a pr01 ~o-risk demonstration. we willi 
tessional print shop. With Xero~! ~edesign one of your corporate! 
!v'entura Publisher and expert train": aocuments, while you watch! But: 
~g from the people at XY2 Cod ~urry- our offer is limiled. Ca~ 
poration. you can learn 10 creale! {213) 555"1111 today.C : 
professional"quality documents! ! ! 
using a personal computer and an! : ! 
lnexpensive laser prinler. For thisl i ! 

t-___________J 'I.-____J 
L._ ... _ ... _ ... _ ... _ ... _ ... _ ... _ ... _ ... _ ... _ ... _ ... _ ... _ ... _ ... _ ... _'.'_' .. _ ... _ ... _ ... _ ... _'.'_' .. _._._ ... _ .. __ ... _1 

Figure 5-25. 

Type the remaining text on page two 
Now you will place text in the bottom-most frame (frame #9) 
(Figure 5-26). Use a non-keyboard character to create the 
registered sign after the word Xerox. 
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m Enable Text mode. 

m Place the text cursor in the bottom-most frame (frame #9) 
and type: 

Contact your nearest XYZ representative for fur
ther information. [Ctrl-Enter] 
XYZ Corporation, 123 Main Street, Los Angeles, CA 
90000 [Ctrl-Enter] 
Xerox [Alt-190] is a trademark of Xerox 
Corporation. 

Figure 5-26. 

. :week only, when you come in . 
ho-risk demonstration, we 
~ed esign 0 ne 0 f yo ur co rpo 
~ocuments, while you watch! 
~urry - 0 ur offel is limited. Cal 

1'131 555·1\1\ t"'y." 

Apply tags to page one 
Now it's time to format the text. Because the tags have been 
predefined in the style sheet from the Power disk, all you need 
to do is to choose the right paragraph and apply the proper 
tag. Start on page one and apply the first two headline tags. If 
you have questions about any tags or effects, take a few 
moments to examine the appropriate dialog boxes from the 
Paragraph menu. 

- NOTE: If you are not using the pre-defined style sheet from the 
Power disk, you must create the tags as you go along, using 
the tag table provided in Appendix B. 

~ Press PgUp to go to page one. 
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Ii Enable Paragraph mode. 

11 Select the teaser headline in frame #1 and tag it as Head3. 

1m Select the teaser headline in frame #2 and tag it as Head-
Rotate (Figure 5-27). 

o 

~ .•.••••.•...•........••••••••.•.•....•..••.•..•.•••.• oj 

Figure 5-27. 

R In frame #3, select XYZ's return address and tag it as 
Address. 

B Select the mailing address and tag it as BodyCenter. 

Your screen should look like Figure 5-28: 

Figure 5-28. 

XYZ C«ponmnJ 
123MilnSlreelJ 
Los Angeles, CA 9O!XXlD 

-..Do, FW eo...,..,J 
1'01"""' ..... J 

~PAI""""" 
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-NOTE: If your screen shows tab and line break symbols, you 
know that Show Tabs & Returns is on from the Options menu. 

Before you go to page two, let's take a moment to show you 
how we got the effect of rotated text. 

m Select the teaser headline (the HeadRotate tag) in the 
second frame. 

m Now select Alignment from the Paragraph menu. 

Notice that Text Rotation is set to 180. Because we want the 
teaser to appear right-side up when the mailer is folded, we 
made it upside-down - that is, rotated 180 degrees on-screen. 
You can edit rotated text by placing the text cursor through 
the "invisible" rotated text. In practice, however, it is easier if 
you edit your text before rotating it. 

Apply tags to page two 
m Press PgDn to go to page two. 

m Select the first headline "The Ventura Makeover" and tag it 
as Headl. 

~ Select the second headline "Take a great idea ... and make 
it greater" and tag it as Head2 (Figure 5-29). 

Figure 5-29. 
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Leave the main body copy tagged as Body Text. 

m Go to frame #9 and select the paragraph that begins "Con
tact your nearest ... " and tag it as BodyCenter (Figure 
5-30). 

Figure 5-30. 

~ ow you can give an mdinary per-~ 
konal computer the power of a pro~ 
iessional print shop. With Xerox; 
iv entura Publisher and expert train-; 
~ng from the people at XYZ Cor-~ 
poration, you can learn to create; 
professiona I-quality do cum entsi 
~sing a personal computer and ani 
lnexpensive laser printer. For this; 
: i 

~eek only. when you come in for a! -: 
bo-risk demonstration, we willi 
~edesign one of your corporate; ..: 
aocuments, while you watch! But: :~ 
~urry - our offer is limited. Call;: 
i213) 555-1111 today.!] i -: 

I II 

That was fast, wasn't it? The more you tag, the easier it 
becomes. Before you continue, let's examine the Head2 tag 
more closely. You may recall that you entered two tab charac
ters as part of the Head2 text. The first tab setting is a center 
tab and the second tab setting is right-aligned (Figures 5-31 
and 5-32). To position the tabs correctly you should measure 
their locations from the edge of the frame (not the edge of the 
page). The location of the second tab forces the text past the 
visible column guides. We chose this tab location so the text 
would line up with the right-most picture frame. 

-.. NOTE: The second tab setting pushes the text outside the 
normal frame and column boundaries. 
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"Head2" TAB SETTINGS 

Tab Number: I + I 1 I + I 
Tab Type: Center 

Tab Shown As: Open Space 
Tab location: 17 J 86/ picas & points 

leader Char: Spaces 

leader Spacing: B 
Auto-leader: Off 

Figure 5·31. 

"Head2" TAB SETTINGS 

Tab Number: I + I 2 I + I 
Tab Type: Right 

832 (ASCII) 

01< I Cancel I 

Tab Shown As: Open Space 
Tab location: 35 J 86/ picas & points 

leader Char: Spaces 

leader Spacing: B 
Auto-leader: Off 

Figure 5·32. Tab settings for Head2 

832 (ASCII) 

01< I Cancel I 

Style 

e Stopping point 
This is a good place to stop and save what you've done so far. 
Check your progress against the sample page in Figure 5-33. 

If you wish, you can quit now and return to this project later. 
If you have the time, continue on to the next section. In the 
pictures section you will learn some helpful tips and tech
niques. 
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Figure 5·33. 

The Ventura 
Makeover 

Take a great idea 

Now you can give an ordinary per
sonal computer the power of a pro
fessional print shop. With Xerox 
Ventura Publisher and expert train
ing from the people at XYZ Cor
poration, you can learn to create 
professional-quality documents 
using a personal computer and an 
inexpensive laser printer. For this 

and make it greater 

week only, when you come in for a 
no-risk demonstration, we will 
redesign one of your corporate 
documents, while you watch! But 
hurry-our offer is limited. Call 
(213) 555-1111 today. 

Contact your nearest XYZ representative for further information. 
XYZ Cotporation, 123 Main Street, Los Angeles, CA 90000 

Xerox GPis a trademark of Xerox Corporation 
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Pictures 

Pictures 

In this sectio:q. you will add the final graphic touches to the 
advertisement by placIng three line-art pictures into frames 
on page two. 

Place pictures on page two 
An advertisement relies heavily on visual imagery to create 
an impact and convey a message. For this example, you will 
place three pictures. '!\vo of them are Encapsulated Postscript 
Files (which Ventura treats as line-art) and the third is a 
standard line-art picture (in GEM format). If you do not have 
a PostScript printer, leave the two EPS frames blank, or fill 
them. with any picture of your choice. 

-NOTE: EPS files will not print on non-PostScript printers. 

~ Make sure you are on page two. 

m Enable Frame mode. 

m Select the left frame (frame #6) and place the file 
5COURIER.EPS. 

m Select the right frame (frame #7) and place the file 
5AD.EPS (Figure 5-34). 

Figure 5-34. 
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.. TIP: If you see the message, IIYou're about to overwrite an 
existing caption. You won't be able to recover the caption text. 
Is that OK?," choose Yes. Ventura displays this message if you 
previously typed in text or added a caption to the frame. 

When Ventura loads the Ventura-generated PostScript file 
into a frame, it displays an 'X" on the screen. You will not see 
the picture until you print the chapter . 

.. TIP: Since it is impossible to preview a Ventura-generated 
EPS file on-screen, it is important to make the frame size the 
same aspect ratio as the original EPS file. 

Add drop shadows to the frames 
A drop shadow gives the illusion of depth to a two-dimensional 
object. One way to create a drop shadow is to lay one frame on 
top of another. The bottom frame, which is gray or black, is 
offset slightly so that only the two edges show. However, this 
method may not work on' all printers, and slows down some 
others. We recommend a second method: drawing two rec
tangle shapes with a gray screen pattern at right angles to 
each other. 

Before you start drawing, choose a grid value that will make it 
easy to place your shapes on the page. 

II Enable ,Graphic mode and select the left picture frame 
(frame #6). 

II Grid Settings Grid Snap: On 
Horizontal Spacing: 00,03 picas & points 
Vertical Spacing: 00,03 picas & points 

.. TIP: Every frame on the Page can have its own grid settings. 

Draw a horizontal shadow 
~ Draw a rectangle along the bottom edge of the left frame. 

Stretch it to the right to create the bottom shadow (Figure 
5-35). 
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Figure 5-35. 

Change the rectangle's attributes 
Now change the line and fill attributes of the rectangle. 

~ Line Attributes Thickness: None 
Defaults: Save To 

~ Fill Attributes Color: Black 
Pattern: 4 

Draw a vertical shadow 

Result: Transparent 
Defaults: Save To 

m Draw a second rectangle at a right angle to the first as 
shown in Figure 5-36 . 

.. NOTE: Do not be discouraged if it takes some time to draw the 
two drop shadows. If you want, go on to the next section 
(placing and sizing an image) and complete the shadows later. 

When you are satisfied with the size and position of the drop 
shadow, you must use the Send to Back option, so the rec
tangles don't cover up the frame's ruling lines. 

WARNING: If you omit this next step, the ruling lines at the bottom and side of the 
frame will not be visible when you print the page. 



Shadow the second frame 5 - 39 

Figure 5-36. 

m Use the Shift-Click method to select both rectangles. Then 
select Send to Back from the Graphic menu (or press Ctrl
Z), as shown in Figure 5-37. 

Figure 5-37. 

Shadow the second frame 
To eliminate a drawing step, you will copy the drop shadows 
from the left frame (frame #6) to the right frame using the 
following steps. 

m Use Shift-Click to select both rectangles. To copy them into 
the Graphic clipboard, press Shift-Del (or select Copy 
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Graphic from the Edit menu). To paste them back onto the 
Page, press Ins (or select Paste Graphic from the Edit 
menu). While the rectangles are still selected, press and 
hold down the mouse button and drag the shapes over to 
the right frame. Carefully line them up with the edges of 
the frame. You may want to switch to Normal or Enlarged 
View to fine-tune the placement of the rectangles (Figure 
5-38). 

Figure 5-38. 

~ While the two rectangle shapes are still selected, choose 
Send to Back from the Graphic menu. 

Place and size an image 
Now that you've completed the drop shadows, you will place a 
picture of a computer in the next frame (frame #8) the one 
which contains the body copy. First, however, you will need to 
add a smaller frame within the frame to contain the picture. 

~ Enable Frame mode. Add a frame with the dimensions 
shown in Figure 5-39. Position the center of the frame in 
the center of the gutter margin. Use Sizing & Scaling to 
verify its position and dimensions. 
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~o;-'you-can-give-an-o'ldiiiaiv-'pei-:-'--'-learii-'io-c~eate-professiOiiaf~'uaii~ 
~onal computer the documents using a! 
po wer 0 I a pro les' ersonal computer an~ 
~io na 1 pri nt $ ho p. 1.4lPerlfiAX: 18,OOpicasJ n inexpensive laser, 
iWith Xerox Ventura I.4lPerI.elY:49,07picasJ rinter. For this wee~ 
~ublisher and expert W'dtr14,00 picasJ nly, when 'Iou com~ 
,ra in ing fro m the Heigtl(),OOpicas[] n for a no 'ris k1 
people at XYZ Cor' emonsiration, w~ 
poration, you can will redesign one o~ 

omct'JOl ....... XYZ........"..ICtIlk~ 
1VZ ~ lZ3Mri>snot,,,"_,,,,"""""'J 

_iIliso_oI:ncO;lJxnliMC 
L •. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _ .•. _' •. _ .•. _ .• ,J 

Figure 5-39. Draw a frame with the dimensions shown here to contain 
the picture of the computer. 

SIZING & SCALING 

Flow Text ArOllld: On 

Upper Left X: 18,00 a c::J 
Fra~e Width: 14,88 

Horiz. Padding: 00,00 

Upper Left Y: 49,071 a [] 
Fr~e Height: 1B,Oa 

Vert. Padding: 00,00 picas & points 

Pictur'e ~~;aU!1B: Ln!~:3~J~~~~~J [J~J~~~~ri.£~!!~(~J 

Asped Rat in : L~~ilii~~~~~~LJ [J!E~:o.!.£~~~LJ 

X Crop Offset: 00,00 l:_~.J [:~J 
Scale Width: 00,00 

Y Crop Offset: (~l, 00 LTJ C~J 
Scale Height: (~lIOO 
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Ventura automatically flows the Body Text around the new 
frame. Do not be concerned how the text fits into the frame or 
if it matches the illustration we show below. You will have a 
chance to make adjustments later. 

Now you will place the picture of the computer inside. 

00 With the small frame still highlighted, place the file COM
PUTER.GEM from the Assignment List. 
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Scale the image 
Mter placing the picture, you can use the Sizing & Scaling 
dialog box to scale the picture in the frame and to make the 
text runaround. 

11 Select Sizing & Scaling from the Frame menu. Choose Flow 
Text Around: Off, Picture Scaling: By Scale Factor, and 
Aspect Ratio: Distorted. 

Now crop the image. 

11 Enter X Crop Offset: (+) 7,00 picas & points, Y Crop Offset: 
(+) 11,06 picas & points. Scale Width: 30,00 picas & points 
and Scale Height: 30,00 picas & points. 

SIZING & SCALING 

Flow Text Arcmd: OfF 

Upper Left X: 1B,OO a c:J Upper left Y: 49,07 a c::J 
Fra~e Width: 14,00 Fr~e Height: tB,BB 

Horiz. Padding: 00,00 Vert. Padding: 00,00 picas & points 

Picture Scaling: I Fit in Frame I "I'"M 
Aspect Ratio: I Maintained I llitiiil 

X Crop Offset: 07,00 a c::J Y Crop Offset: 11,06 a c::J 
Scale Width: 30,00 Scale Height: 38, OBI 

.. NOTE: You can also interactively crop the image. Place the 
mouse cursor inside the picture frame. Then press the Alt key 
as you hold the mouse button. Slide the image back and forth 
until you achieve the placement you want. 

When you turn Flow Text Around: Off, Ventura allows the text 
to flow into the frame and the over the picture inside it (Figure 
5-40). 
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Figure 5-40. 

Create a text runaround 
Now that you've turned Flow Text Around off, you will now 
place small frames over portions of the computer to create an 
irregular text runaround. Place the frames in a pyramid ar
rangement to make the text run around in a stair-step 
fashion. 

Before you add your frames, make sure that Line Snap is on 
and Column Snap is off (the Options menu). 

-.. TIP: Turning Line Snap on guarantees that the new frames will 
be sized in increments of the Body Text inter-line spacing. You 
will be able to create frames exactly one or two lines deep. 

m Add four small frames over the computer image as shown 
in Figure 5-41. If you want absolute accuracy, check each 
frame's dimensions with the Sizing & Scaling dialog box. If 
you don't have the time, use your best judgment to gauge 
the sizes of the frame. 

Copy fit the body copy 

Now that you've created the text wraparound, it's time to 
copy-fit the text so it fills the frame exactly. With Ventura you 
can copy-fit in several different ways: 

1. Add or delete from the text. 
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Figure 5-41. 

The traditional way to copy-fit is to add or delete words to 
make the text fit the space. If you trim all the excess from your 
copy and the text still won't fit the space, try one of the other 
options. 

2. Change the size of the frame containing the text. 

When text is placed in a frame on top of the Page, you can 
increase or reduce the size of the frame to make the text fit. 
With Line Snap On you can add to or subtract from the frame 
size by one-line increments. 

3. Fine-tune the frame typography settings. 

Initially, Ventura makes all the Frame Typography settings 
equal to the Chapter Typography settings (e.g. Widows and 
Orphans, Column Balance, and Move Down to 1st Baseline). 
You can, however, change a setting in the Frame Typography 
menu so it overrides the chapter settings you defined in the 
Chapter Typography menu. 

In this project, you will adjust the Frame Typography to make 
the body copy fit into the frame. 

I:m Enable Frame mode and select the frame reserved for the 
body copy (frame #8). 

I:m Select Frame Typography from the Frame menu. 

a Choose Widows (Min Lines at Top): 1, Orphans (Min Lines 
at Bottom): 1. 
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I! Select Column Balance: On and Move Down to 1st Baseline 
By: Inter-Line. Then click OK to close the dialog box. 

FRAME TYPOGRAPHY SETTINGS [!] 
Widows (Min Lines at Top): 1 

Orphans (Min Lines at Bottom): 1 
Column Balance: On 

Moye Down To 1st Baseline By: Inter-Line 
Pair Kerning: Default 

_ I Cancel I 

With the baseline position of text changed to inter-line, the 
text will align across columns (Figure 5-42). 

Figure 5-42. 

~~;-y~~-'~;;'gi;~-';'~'-~~di~-~~y'-p-~~'~-''-'-~~~;l-'~~;p~i;~-;~d';'~-i;~;p;~~i~~ 
~onaJ computer the For this week only J. 

ressionaJ print sh ' come in lor a noi 
~eroK Ventura . we wilij 
~pert Ira your cor, 
peopJe at XYZ while yo~ 
you can Jearn to B uf hurry - 0 u~ 
professional-q is limited. CalE 
?ocuments using a 13) 555-1111 today.: 
~ ~ 

Otrr.Id'!IW''''''X''r'Z~_'''''''~ 
JY:I-"" WIlbftSllW,Loo-,C<lOXlOO _!)S._ .. _~ 

1. .... _._._ ..... _. __ ._._ .... _._._ ... ___ .... _ ..... _._._ ... ,_ .... _ .... __ .... _ .... _._._ .... _ ..... _ ..... _ ..... _ ..... _ .... _ ..... _ .... _ ..... _ ..... _ ..... _._.j 

These adjustments should make the text reach to the bottom 
edge of the frame. If not, try adding or deleting a few words 
until it looks right. 

Kern the headline 
Before you complete this project, we'll show you how to make 
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some adjustments to your headlines and body copy. Because of 
space limitations, we will not go through all the fine-tuning 
that would ordinarily occur for an advertisement. We will, 
however, introduce you to the methods. Once you grasp these 
techniques, you can use them to adjust this and other docu
ments until all the details are perfect. 

Kerning is a typographic technique that allows you to selec
tively reduce the amount of space between individual letter 
pairs and leave the rest of the word the same. Kerning (or the 
lack of it) is most noticeable in display type of 18 points or 
larger. Ventura has two ways to kern: automatically and 
manually. 

Automatic pair kerning occurs only if the fonts for your 
printer come with special files called kerning tables (Ventura 
2 includes kerning tables for most printers). Kerning tables 
contain information about special letter pairs that look better 
spaced more closely. Certain letter combinations are improved 
by kerning, such as AV, YO, Ve, LY, and Te. Figure 5-43 shows 
how kerning alters the appearance of the word "wave." 

Unkerned WAVE 
Kerned WAVE 

Figure 5-43 . 

.. NOTE: You will not do any damage if you specify automatic 
kerning for fonts that do not have kerning information. Ventura 
will simply ignore the command. 

In our example, the kerning table contains information that 
told Ventura what to do if it found a capital letter A followed 
by a capital V. More specifically, it told Ventura just how far to 
move the V to the left to improve the appearance of this letter 
pair. Although we used "AV" as an example, most kerning 
tables also include information on 200 or more combinations. 
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To implement automatic kerning, you must take two steps: (1) 
turn it on globally for the entire document and (2) turn it on 
for each tag that you want kerned. You must take both steps. 
Turning kerning on globally has no effect if you haven't turned 
it on for the individual tags. Likewise, turning it on for an 
individual tag does nothing unless you also remember to turn 
it on globally. 

Enable automatic kerning for the headline 
Let's begin by enabling automatic kerning for the headline. 
Later you will do some manual kerning as well. First you 
should verify that kerning is globally on. 

~ Select Chapter Typography from the Chapter menu. 
Choose Pair Kerning: On then click OK. 

m Enable Paragraph mode. Select the headline "The Ventura 
Makeover" in frame #4. 

m Select Paragraph Typography from the Paragraph menu. 
Verify that Automatic Pair Kerning is on, Letter Spacing is 
off, and Tracking is set to 0.040 Ems Tighter. Click OK. 

"Head1 H TYPOGRAPHY SETTINGS m 
j:krt;Oalatic Pair Kerning: On 

Letter Spacing: Off Up to: O. 100 [I~!)' 

Tracking: Ti!ilter 0 .0401 EI*s 

Grow Inte,."line To Fit: On 

Hinil1un Space Ifidth: 1.000 * (space width) = 0.277 us 
tforl*al Space Ifidth: 2.000 * (space width) = 0.555 &Is 

Haxi .. un Space Ifidth: 3.000 * (space width) :: 0.832 &Is 

_ ICancel 

With the Paragraph Typography dialog box, you can also 
tighten type with the tracking command. Refer to Chapter 
Three for an explanation of tracking. 
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Perform manual kerning on the headline 
You can also kern manually in addition to, or instead of auto
matic pair kerning. For example, here's how to move the "e" in 
the word ''Ventura'' close to the "V". 

1m Enable Text mode. Select the letter ''V'' in the word ''Ven
tura" (Figure 5-44). 

Figure 5-44. 

iI Hold down the Shift key and press the left arrow key 8 
times to move the letter "e" closer to the V. 

-NOTE: When you kern manually, the letter following the 
selected letter moves in the direction of the arrow. 

This moves the "e" closer to the V. The amount of kerning is a 
matter of personal taste. We suggest you experiment with 
different values until you come up with the best look . 

.. NOTE: Do not be concerned if the letters overlap on-screen. 
When you print out the page, the two letters will look right. 

You can also kern manually using the Set Font Addition but
ton in Text mode. Highlight the letter "V' and choose Set Font 
from the Side-Bar. Choose Kern: Tighter and enter the 
amount in Ems to kern. When you close the dialog box you can 
see the result of the kerning. 
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FONT SETTIIIi FOR SELECTED WIT 

~ T~lle~ . 
::::.::":'. Courier 
:::::::::: SYlilbol 
t:::::: Avant Garde Gothic Book/Delli 
It HC Boolawl Light/DeNi 
, Helyetica Narrow 

Palatino 

CustoM Size: 974.9 points 

m 

.:iUi_ Red 
I.:·ltal:ic &-een 

Blue 
Cyan 
Yellow 
Magenta 

N- Italic 
B· Italic 

OYef'SCOre: Off 
Strike' Thru : Off 

Under line: Off 
Double Under line: Off 

Shift: Up 00.99 fractional pts 
Kern: Tighter 8.991 EllS 
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About screen kerning 
You may not notice much difference on the screen when you 
apply kerning. Check Set Preferences from the Options menu 
to see if On-Screen Kerning is on for all display type 18 points 
and larger. 

~ Select Set Preferences from the Options menu. Choose On
Screen Kerning: 18. Click OK. 

SET PREFERENCES [!] 
Generated Tags: Shown 

Text to Greek: 6 
Keep Backup Files: Yes 

Double Click Speed: 3 
On-Screen Kerning: 18 
Auto-Adjustments: None 

Pop-Up Menu Symbols: Hidden 
Menu Type: Drop-Down 

Decimal Tab Char: 0461 (ASCII) 

I Cancel I 

Ventura permits you to select the size at which to show kern
ing on the screen. In general, it is best to show on-screen 
kerning only for large type sizes or not at all. Otherwise, 
on-screen kerning slows down the display. And because of the 
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low resolution of computer screens, it is not effective or ac
curate at lower point sizes. In fact, don't be surprised if your 
monitor doesn't show any visible on-screen kerning. Because 
Ventura uses generic screen fonts, on-screen kerning is an 
approximation at best . 

.. TIP: The only way to accurately gauge the effects of typo
graphic adjustments is to print out the page. 

WARNING: Remember to reset On-Screen Kerning to None before you continue on 
to the next section. 

About letter spacing 
Ventura has another typographic control called Letter Spac
ing. To understand letter spacing, it is first necessary to un
derstand how Ventura justifies text. Although the explanation 
below is not technically thorough, it will help you understand 
the letter spacing option. As it flows text onto the page, Ven
tura fits as many words as possible onto each line before 
moving to the next. If the words do not fit, Ventura adds or 
subtracts space between words, but not between letters. Ven
tura will not reduce the word space beyond the minimum or 
maximum word spacing values. Ventura has default maxi
mum and minimum space widths, but you can change them in 
the Paragraph Typography dialog box (Figure 5-45). 

''Body Text" TYPOGRAPHY SETTINGS rn 
Automatic Pair Kerning: Off 

Letter Spacing: On Up to: 0.1001 EJls 
Tl'acking: Tishtel' o.eoo EJls 

Grow Inter-Line To Fit: On 

Minifi1uM Space ~idth: 0.600 * (space width) = 0.150 Elils 
NorPlal Space Width: 1.000 * (space width) = 0.249 EIIlS 

MaxiMUM Space ~idth: 2.000 * (space width) = 0.498 EIIlS 

Figure 5·45. 
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Quite often Ventura cannot fit the words onto the line without 
exceeding the maximum or minimum values. In that case, it 
searches for the discretionary hyphens that were placed in the 
text file when it was loaded. Ifit can find a hyphenation point, 
Ventura will split a word, so part goes on one line and part 
goes on another. 

Even with the help of hyphenation, Ventura still encounters 
some lines that cannot be justified without exceeding the 
maximum space width. These lines, which have too much 
white space between the words, are known as loose lines. You 
can instruct Ventura to highlight these lines by selecting 
Show Loose Lines from the Options menu. 

There are several ways to reduce the number of loose lines: 

• Manually hyphenate words (sometimes Ventura's hyphena
tion algorithm misses opportunities) 

• Edit your text 

• Allow Ventura to use its Letter Spacing feature to adjust 
the space between individual letters as well as the space 
between words 

... NOTE: Even if you fix the loose lines with letter spacing, 
Ventura will still highlight them on screen. 

Enter letter spacing 
Let's use the letter spacing technique to fine tune the body 
copy. You will tell Ventura that it is allowed to add a small 
amount of space between letters if necessary to justify a line. 

m Enable Paragraph mode and select the Body Text para-
graph in frame #8. 

m Paragraph Letter Spacing: On 
Typography Up to: 0.100 Ems 

Experiment with fixing loose lines 
As we mentioned above, letter spacing is just one of the ways 
you can avoid loose lines in body copy. If you are interested, 
you may want to take some time to experiment on your own to 
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Chapter 

Chapter 

further reduce the number of loose lines in the ad copy. Try 
adding a discretionary hyphen or two (place the text cursor 
where you want and press Ctrl-Hyphen), edit the text, or 
stretch one of the small frames. To continue practicing these 
adjustments, refer to Figure 5-46 for places to hyphenate 
text. Since this is for practice only, do not be concerned if your 
text is off a word or letter. The important thing is to under
stand that you have several powerful typographic tools at 
your command. 

Figure 5-46. 

Now that you've completed the ad, let's see the results of your 
efforts and print the chapter. 

Take a moment to save your work (press Ctrl-S). Then use the 
Print option to print out the entire document. 

- NOTE: Because of the size of the Encapsulated Postscript 
files, you should allow extra' time for printing. 

~ Select To Print from the File menu. Choose Which Pages: 
All. 



Print hidden pictures 

PRINT IHFORt1ATIOH (POSTSCRIPT - Ultil1late) 

Which Pages: All 

Fron Page: 0001\ 
Through Page: 9999 

Hunber of Copies: 01 

Collated Copies: Off 
Printing Order: 1st to Last 

Paper Tray: Default 
Crop Marks: Off 

Spot Color Overlays: Off 
NI.llt.i·Ghp. PI'.int. rilt.~~~; G(.)l')b.in#.~d 

Device Nane: POSTSCRIPT 
Output To: COM1: 

5 - 53 

I Cancel \ 

Print hidden pictures 

Print to file 

If you customarily work with documents that use many pic
tures, you can save time printing a rough draft if you hide all 
the pictures in the document. When you hide pictures, Ven
tura prints out a gray box in place of the picture. 

To hide pictures, choose Hide All Pictures from the Set 
Preferences dialog box (Options menu). When you print the 
document, Ventura first tells you that the document contains 
at least one hidden picture and then asks if you want to print 
all hidden pictures or keep them hidden. Choose Hide Them to 
hide the pictures. 

- TIP: You can a/so use Hide Pictures to decrease screen 
redraw time. 

As you see from the final printed version of the advertisement, 
an Encapsulated Postscript file allows you to take a "snap
shot" of a page and make it part of a document. If you have a 
PostScript printer, you can make your own EPS file by using 
the print option Print To File. Before we conclude this chapter, 
we'd like to show you how you to make an EPS file from the 
second page of this document. 

m Go to the second page (the advertisement itself). 



5 - 54 Chapter 

-.. NOTE: You can only make an EPS file of one page at a time. 

R Select Set Printer Info from the Options menu. 

In this dialog box you can select which printer port (LPTl, 
COMl), to print a file to or you can choose to print to a 
filename. 

m Choose Output To: Filename. 

SET PRINTER INFO (POSTSCRIPT - Ultillate) 

Device Nc.le: I HP LJ+, 38B dpi I 'NU1Miiji 

Screen Fonts: EGAI (Use those llatcl1ing this file extension.) 

Output To: @illl LPT2 II LPT3 II GOI11 II GOM211Direct IIDiNI!!; 

Width Table: C:\VENTURA\DUTPUT .IUD ________ _ 

COIllr.and: I Load Different Width Table (Le., Font Metrics) I 

-.. NOTE: You may want to review Chapter Three for an explana
tion of the other printer options in this dialog box. 

WARNING: Remember to use Set Printer Info to return the settings to the original 
output device (e.g. COM1, COM2) after you are finished making the EPS file. 

E Select To Print from the File menu. Select Which Pages: 
Current and click OK. 

Ventura displays the Item Selector, which asks you for the 
name of the print file. 

11 Move the cursor to the Directory line and replace the 
filename extension COO with EPS. 

11 Locate the C:\TEMP subdirectory and type in the file 
name, 5MAILER.EPS on the Selection line. Click OK. 
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ITEM SELECTOR 

Directory: C: \ TEMP\*. EPS, ________ _ 

Se lection : 5MA I L ER • EPSI 

OK 

.............................................. I Cancel I 

- TIP: Always use the .EPS extension when printing to a 
filename. 

Ventura prints as normal, except the output goes to the file 
instead of to the printer. Once you create an EPS file, you can 
load it into a frame like any other picture. 

Tips and techniques 

Picture tips 

D Use a stand-alone graphics program for complex illustra
tions. Ventura's built-in graphics tools are most useful for 
annotating existing drawings or producing very simple il
lustrations such as organization charts. 

D Ventura does not store or modify outside graphics files. It 
stores a pointer to the file. 

D If you revise a picture with an outside program and give it 
the same name as the old version, Ventura will load the 
new picture the next time you open the chapter. 

D When sizing pictures with By Scale Factors, remember that 
the numbers shown in the dialog box represent the original 
size of the picture. To change the picture, enter the new 
values you want. 

D When using By Scale Factors together with Aspect Ratio: 
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Maintain, Ventura lets you choose the width. Then it auto
matically calculates the necessary height to avoid distort
ing the aspect ratio. 

o Scanned images look better if you leave them at their 
original size. If you must enlarge or reduce, do so in integer 
amounts. 

o A positive X offset moves the picture to the left. A positive Y 
offset moves the picture up. 

o Reset the zero point of the ruler for more accurate position
ing of graphics elements. 

o To create a text runaround, turn Flow Text Around to Offin 
the original frame. Then use smaller overlapping frames to 
keep the text away from the object inside the frame. 

More Box Text tips 

o Use the snap-to grid for easy, precise sizing and placement 
of Box 'Iext. 

o Once the first Box Text looks correct, use the Save To 
buttons in the Line and Fill Attributes dialog boxes. These 
buttons store the attribute settings. From then on, every 
Box Text you draw will have the same attributes. 

o If you must position a Box Text with extreme accuracy, 
attach the upper left corner of the Box Text to the upper left 
corner of a small, invisible frame. Use Sizing & Scaling to 
position the frame. Since the Box Text is attached, it will 
move to the correct position too. 

o If you must size a Box Text with extreme precision, first 
draw a frame of that size. Use Sizing & Scaling to verify the 
size. Then place the Box Text over the sizing frame. You can 
then delete the frame. Be careful to attach the Box Text 
where you really want it, and not to the sizing frame, which 
will be deleted. 

o Use Send to Back and Bring to Front from the Graphic 
menu to force graphics shapes to overlap in the order you 
want them to. 

o See Chapter Four for more tips on Box Text. 
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Other tips 

D Always format the Chapter first, even when creating a 
free-form document. Use the Page as a guide to positioning 
page elements. 

D Type non-keyboard characters by holding down the Alt key 
while typing the decimal code on the numeric keypad. 

D To select a frame underneath another, hold down the Ctrl 
key and click the mouse button on the frame you want. 
Each time you press Ctrl-Click, Ventura selects the next 
layer down. Continue clicking until you see sizing buttons 
around the frame you want. 

D To achieve automatic kerning, you must (1) turn it on 
globally using Chapter Typography from the Chapter menu 
and (2) turn it on for the individual tag using Paragraph 
Typography from the Paragraph menu. 

D Use the Set Preferences dialog box from the Options menu 
to set On-Screen Kerning to None. Screen kerning slows 
down the display and is generally not very accurate. 

D Enter additional discretionary hyphens on-screen with 
Ctrl-Hyphen. 

D To keep Ventura from hyphenating a word, enter a discre
tionary hyphen immediately before the word. 

D Enter additional discretionary hyphens permanently by ad
ding the word to the user hyphenation dictionary. This 
dictionary is called HYPHUSER.DIC and is found in the 
Ventura subdirectory. Use the ASCII mode of your word 
processor to load the file. Then type in the words as you 
want them hyphenated. 

D To permanently prevent Ventura from hyphenating a word 
(such as a product name), enter it into the user hyphena
tion dictionary without a hyphen. 

D To create an EPS file, choose the PostScript printer and 
print the page to a file, using the Set Printer Info dialog 
box. 



Chapter Six 
Skills Checklist 

Theory 
o The grid system 

o Using frames to design a complex 
page layout 

Text 
o Converting file formats from different 

word processors 

o Adding jump text 

o Typing a pull quote 

Style 
o Adding editorial color to frames 
o Improving display type with tracking 

and kerning 

o Using pull quotes for spacing and 
graphic effect 

o Adding style with big first characters 
(drop caps) 

o Understanding chapter and frame 
typography 

o Creating boldface lead-in heads 
o Advanced effects with double and 

dashed rules 

Pictures 
o Building a calendar with Box Text 
o Placing and sizing an image 

o Adding captions to illustrations 

Chapter 
o Saving production time with chapter 

templates 
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A ThreezColumn Newsletter 

Theory 

Producing newsletters is one of the most popular desktop 
publishing applications. With Ventura and a laser printer, 

there is virtually no limit to what you can do. In Chapter 
Three you learned how to build a simple, two-column newslet
ter. In this chapter, you will tackle a second newsletter, a 
three-column format that shows off some of Ventura's ad
vanced design capabilities. You will create this sophisticated 
layout using the skills and effects listed to the left. At the end 
of the chapter we will also explain two time-saving production 
tips that make newsletter production faster and easier. 

The grid system 
It is easiest and most efficient to build newsletters by pouring 
text into frames. The format of the Page determines the size 
and placement of those frames. For example, a two-column 
page presents two columnar alternatives: (1) frames that are 
one column wide or (2) frames that are two columns wide 
(Figure 6-1). 

A three-column Page offers more alternatives. Frames can be 
one, two, or three columns wide (Figure 6--2). 

As you can imagine, four- and five-column pages offer even 
more possibilities. However, more alternatives also mean 
more decisions. In general, four- and five-column grids are 
best left to those with graphic arts experience. 
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Figure 6-1. On a two-column page you can place frames that are one 
column or two columns wide. 

Figure 6-2. When you use a three-column grid, frames can be one, 
two, or three columns wide. 

Theory 

The three-column format is a good compromise (Figure 6-3). 
It is simple enough that production doesn't become too time
consuming. Yet it is also flexible enough to provide the variety 
and visual excitement lacking in one- and two-column for
mats. You can fit more text on the page with three columns 
than with one or two. And you have many more ways to 
present illustrations. In short, you can solve almost any 
layout problem within the framework of a three-column grid. 
For these reasons, it is the most popular newsletter style. You 
will learn it in this chapter. 
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Figure 6·3 Three-column newsletters are one of the most versatile 
and popular design formats. 

The danger of overdesign 
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As you venture into more complex layouts, beware of an affiic
tion that strikes many first-time desktop publishers: Over
designitis. This disease results in an overwhelming urge to 
cram as many fonts, rules, patterns, and other effects onto one 
page as possible. 

Good page design doesn't call attention to itself. For instance, 
when readers pick up a business-oriented newsletter, you do 
not want their first reaction to be surprise, amazement or 
shock. Rather, you want the design to pull them into the page 
and entice them to start reading. Overdesign shouts. It says 
"Stop! Look at me first! See what I can do!" Proper page 
design, by contrast, talks in a quiet voice: "Come on in, make 
yourself comfortable, here's something you'll enjoy .... " 
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So don't let Ventura's power lure you into the trap of over
design. Don't let your layouts become a barrier to communica
tion. Yes, you want enough pizzazz so pages look pleasing and 
professional. But your main goal is to make it easier for busy 
readers to find information. 
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Planning the newsletter 
The first thing you see on the front page of a newsletter is the 
logo or nameplate. The logo draws attention to the page and 
identifies the publication. Most newsletters need a carefully 
thought-out logo design because it sets the tone for the rest of 
the publication. For instance, as you proceed through this 
chapter, you will see how several effects from the logo are 
repeated elsewhere. Newsletters benefit from a design theme 
that is repeated throughout. This consistency improves the 
look while helping readers identify different parts of the pub
lication. 

The headlines are sized in proportion to the logo and to each 
other. This hierarchy - the bigger the story the bigger the 
headline - helps the reader judge which information is most 
important. 

Since this newsletter will be mailed, the back page includes 
space for a label and a stamp. Depending on the amount of 
editorial space you need, you can allocate a full, half, or frac
tion of a page to mailing information. 

As you create layouts of your own, you will discover that 
Ventura contains lots of built-in power you can put to work in 
your newsletters. Here are some of the effects you will learn to 
use to add character and punch to your newsletter designs. 

• Three-column format 

• Frame backgrounds 

• Custom and double rules 

• Big first character 

• Boldface lead-ins 

• Box Text for a calendar of events 

Even though this newsletter is more a complex layout than· 
the one from Chapter Three, the same basic principles apply. 
First you will format the Page. Next you will place frames 
using the Page as your guide. Then you will put text into the 
frames. 
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Verify that the settings from the Options menu are the way 
you want them. In particular, be sure that Column and Line 
Snap are turned on so frames automatically snap to the Page. 
Choosing Show Column Guides also makes it easier to posi
tion frames. 

If you have the Power disk 
Instead of building the newsletter chapter from scratch, you 
will use the sample newsletter chapter from the Power disk. 
The chapter file contains the newsletter style sheet and most 
of the frames for the newsletter text. 

• Open the chapter C:\POWER\6NEWSLET.CHP. 

11 Load the ASCII text files 6NEWSLTl.TXT, 
6NEWSLT2.TXT, 6NEWSLT3.TXT, 6NEWSLT4.TXT, 
6NEWSLT5.TXT, and 6NEWSTOC.TXT from the 
C:\POWER subdirectory. 

• Use Save As New Style to save the style sheet as 
C:\ TEMP\6NEWS.STY 

• Load the image file, WPVP.IMG (GEMIHALO DPE format) 
from the C:\POWER subdirectory. 

-NOTE: If Ventura automatically places the image on the Page, 
use Remove Text/File to remove the image from the frame (do 
not remove it from the list of files). 

Before you place the text files, we want to show you how to 
convert text files from one word processing format to another. 

Converting file formats 
If you publish a newsletter com posed of articles from several 
writers, you are likely to receive files in different formats. 
Ventura can convert from one file format to another. After 
loading a text file you can use File Type/Rename from the Edit 
menu to convert it to a different word processing format. 
Thanks to File TypelRename you can standardize the text 
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format of the newsletter without restricting writers to anyone 
word processor. 

For practice, convert the six ASCII text files you just loaded 
into your favorite word processing format (at the same time 
you rename them). 

Change formats 
Follow these instructions for each of the six files in turn. First, 
place the text file on the Page. Then call up the File 
TypelRename dialog box. Type in the new name (and new 
location) and choose the new file format. As always, you will 
be placing the new file in the \ TEMP subdirectory along with 
the projects from other chapters. Figure 6-4 shows how it 
would look if you were changing 6NEWSLTI. TXT to Microsoft 
Word format: 

FILE TYPE I RENAME m 
Old Hane: C: \POWER\6HEWSl T1 • TXT 

New Halle: C: \ TEMP\6NEWS-1. TXT 

Text ForMat: I Generated I I ASC I I I I WordStCll' 3 I I WS 4.0/5.0 I 
Ildlll' I WordPerfect I I HyWrite I I B-Bit ASCII I 
I DCA I I MultiMate I I PRN-to- Table I I WordPerfect 5 

I Writer I 

• I Cancel I 

Figure 6·4. 

If you were changing to MultiMate format, the dialog box 
would look identical except that the MultiMate button would 
be highlighted instead. 

When you have finished, put the next file on the Page and 
repeat the process . 

.. NOTE: When you place a new file on the Page, Ventura auto
matically replaces the old file with the new one. 
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Here's a listing of the new file names (you can change the 
extension to your own word processing format if you prefer): 

Load from C:\POWER 

6NEWSLT1.TXT 

6NEWSLT2.TXT 

6NEWSLT3.TXT 

6NEWSLT4.TXT 

6NEWSLT5.TXT 

6NEWSTOC.TXT 

Save to C:\TEMP 

6NEWS-l.TXT 

6NEWS-2.TXT 

6NEWS-3.'lXT 

6NEWS-4.TXT 

6NEWS-5.TXT 

6TOC.TXT 

WARNING: Neither the format change or the name change/relocation takes effect 
until you save the chapter. 

Using File Type/Rename merely tells Ventura, ''Please make 
these changes the next time you save to the disk." If you 
abandon the chapter without saving you will lose the changes. 

m After you rename all the text files, use Remove TextlFile to 
remove the last file from the frame. 

m Select Save As to save the chapter as 
C:\TEMP\6NEWS.CHP. 

If you do not have the Power disk 
m Using your favorite word processor, type the text files for 

Chapter Six from Appendix A. Save them under the 
C:\TEMP subdirectory using the names listed in the right 
col umn in the table above. 

m Load the original Ventura style sheet &NEWS-P3.STY 
from the C: \POWER subdirectory. Change the margins 
and columns to match Figure 6-5. Change or add tags 
according to the tag table for Chapter Six in Appendix B. 
Save and rename the style sheet as 
C: \ TEMP\6NEWS.STY. 
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Figure 6·5. 

m Load the sample image file, CHANEL.lMG from the 
C:\POWER subdirectory or substitute your own hit
mapped image in place of the one provided on the Power 
disk. 
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Since the newsletter is composed of text files in frames, it is 
easier to add frames before placing text. Start by formatting 
the Page, then use it as a guide for drawing the frames. 

Verify the page layout 

Add a footer 

Although the 6NEWS.STY style sheet should have the correct 
values for page layout, margins, columns, and global kerning, 
verify that the values match Figure 6-5. 

m Select Headers & Footers from the Chapter menu. Choose 
Define: Right Page Footer, Usage: On. Type: Fa11/Winter 
1989 on the Left line and Page [Pi] on the Right line. 

HEADERS Ii FOOTERS 

Define: !left Page Header ! ! Right Page Header! 

!left Page Footer I 
Usage: Ell I Off I 

Right Page Footer 

left: Fall/Winter 1989 __________ _ 

Center: 

Ri~t: Page [Pl:I]f-1 ___________ _ 

Inserts: ! Chapter It I ! Page It ! I 1st Match I !last Hatch! 

I Text Attr. I I Copy To Facing Page I 

U Choose Define: Left Page Footer, Usage: On. Type: Page 
[Pi] on the Left line and Paginations on the Right line. 

~ Choose Turn Footer Offfrom the Chapter menu for the first 
page of the newsletter. 

Change the chapter typography 
Now you will change the settings in the Chapter Typography 
dialog box to complete the chapter format. (See Chapter Three 
for a detailed explanation of these settings.) 
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m Select Chapter Typography from the Chapter menu. 

m Choose Widows (Min. Lines at Top): 1 and Orphans (Min. 
Lines at Bottom): 1. 

m Choose Move Down to 1st Baseline By: Inter-Line. 

~ Verify that Column Balance is off. 

Chapter Typography settings ensure that the text will align 
across multiple columns and reach the bottoms of the frames. 

Add frames to page one 
~ Place nine frames on page one using Figure 6-7 as a guide 

for their size and position. 

~ Use Sizing & Scaling to fine-tune the size and placement. 

Don't forget that you can use temporary memory to create 
identical frames. See Chapters Two and Three . 

.. NOTE: With Line Snap turned on, the frames (frames #6 and 
#7) at the bottom of the page will extend below the column 
guide. Nevertheless, the text you pour into the frames will line 
up properly with the bottom of the column guide. 

Place the two ''jump text" frames (frames #8 and #9) inside the 
column frames as shown in Figure 6-6. (Shading in the figure 
is for illustration purposes only. Do not add shading.) 

Jump text fr!:lmll--....... p.o;=,.;,;.;,;;,;..-...+-+-+o-----!-' 

Jump text frame ---1~~""~~~iiEEiiEEiiEE:EillEJ t.:::~::·.::.:::~:::.:::::~::::::::~:::.~.:::~::::·.j 

Figure 6-6. 
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Frame #1 
Upper Left X: 04,06 picas 
Upper Left Y: 04,06 picas 

42,00x12,00 picas 

Frame #2 
Upper Left X: 04,06 picas 
Upper Left Y: 16,06 picas 

42,00 X 07,00 picas 

Frame #3 Frame #4 Frame#S 
Upper Left X: 04,06 picas Upper Left X: 19,00 picas Upper Left X: 33,06 picas 
Upper Left Y: 23,06 picas Upper Left Y: 23,06 picas Upper Left Y: 23,06 picas 

13,00x24,00 picas 13,00x24,00 picas 13,00x24,00 picas 

Frame#S 
13,00x02,00 picas ..... 

r-......~ , 
Frame #6 

Upper Left X: 04,06 picas Frame #7 
Upper Left Y: 47,06 picas Upper Left X: 33,06 picas 
27,06x13,00 picas Upper Left Y: 47,06 picas 

Frame #9 
13,00x13,00 picas 

13,00x01 ,00 picas 
/' 

---,;1' 

Figure 6·7. Use this illustration to draw the frames on page one. 
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Add a ruling box around 
When you are finished adding the frames, you will make a 
ruling box around the frame reserved for the logo. 

Ii Select the top frame (frame #1). 

m Ruling Box Width: Frame 
Around Height of Rule 1: 00.25 fractional pts 

Add a pattern 
To add intrest to the page design, put a gray fill pattern inside 
the Logo frame (frame #1). 

Ii Select Frame Background from the Frame menu. Choose 
Color: Black and Pattern: 1. Click OK. 

FRAME BACKGROUND 

Color: Black 
Pattern: 1 

Result: 

Change columns 

-.gN I Cancel I 

Use Margins & Columns from the Frame menu to change the 
bottom left frame (frame #6) to a two-column format. The size 
of the columns inside this frame will match the columns on 
the Page. 

m Select frame #6~ 
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L1 Margins & 
Columns 

# of Columns: 2 
Column 1: 13,00 picas & points 
Column 2: 13,00 picas & points 
Gutter 1: 01,06 picas & points 

Add a ruling box around the TOC 
~ Select the frame that will contain the TOC (frame #7). 

Width: Frame 
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m Ruling Box 
Around Height of Rule 1: 00.25 fractional pts 

Add frames on page two 
If you are using the Power disk, proceed directly to the section 
entitled, "Add a dashed ruling line." 

If you do not have the Power disk and the sample newsletter 
chapter file, use Figures 6-8, 6-9, and 6-10 as guides to layout 
the remaining frames on pages two, three, and four. 

m InsertlRemove Operation: Insert New Page 
Page Mter Current Page 

Use Figure 6-8 to guide the placement of frames on page two. 
Then check for accuracy with Sizing & Scaling. 

Add margins and a ruling box around 
If you do not have the Power disk, you will add margins and a 
ruling box around the frame reserved for the staff box (frame 
#12). Start by adding margins to the frame. This keeps the 
text in the frame from touching the ruling box around it. 

~ Select the frame for the staffbox (frame #12). 

L1 Margins & 
Columns 

Top: 02,00 picas & points 
Bottom: 02,00 picas & points 
Left: 01,00 picas & points 
Right: 01,00 picas & points 

m Select Ruling Box Around. Choose Width: Frame. Give Rule 
1 a height of 00.25 fractional pts. 
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Frame #10 
Upper Left X: 04,06 picas 
Upper Left Y: 04,06 picas 

27,06x48,00 picas 

Frame#12 
Upper Left X: 04,06 picas 
Upper Left Y: 52,06 picas 

42,00x07,06 picas 

/ 

/ 

Frame #13 
13,00x02,00 picas 

Frame #11 
Upper Left X: 33,06 picas 
Upper Left Y: 06,06 picas 

13,00x46,00 picas 

Figure 6-8. If you do NOT have the Power disk, you must draw these frames on page two. 

Style 
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RUl Uli DOl( RROOND m 
Width FraJle I Color Black 

Pattern Solid 
Dashes Off 

36.1"11"1 
Space Above Rule 1: 00.1301 

[~~:~] Height of Rule 1: 00.25 Custor. Indent: 0{} ,00 ~ 

Space Below Rule 1: 00.130 CustOIl Width: O{},()() 

Height of Rule 2: 00.130 
Space Below Rule 2: OO.BB Dash Width: 0{} ,00 

Height of Rule 3: OO.aB Dash Spacing: O{},()() fractional pts 

Space Below Rule 3: 00.B0 Dc:] 
Overall Height: 00.25 

On to page three 
Good work - you're halfway through placing the frames (If 
you have the Power disk, these frames were drawn for you). 
Two more pages to go. Insert another page before drawing the 
frames on page three. 

1m InsertlRemove 
Page 

Add frames to page three 

Operation: Insert a New Page 
Mter Current Page 

U sing the Figure 6-9 as a guide, draw the five frames on page 
three, then check your results with Sizing & Scaling. The 
upper right frame (frame #18) is reserved for a picture and a 
caption. You will add a caption to the picture frame in the 
picture section of the chapter. For now, simply leave enough 
space for the caption. 

Add a ruling box around the picture frame 
To visually separate the picture from the rest of the text, add 
a ruling box around the frame that will contain it. 

~ Select the frame that will contain the picture (frame #18). 

1m Ruling Box Height of Rule 1: 00.25 fractional pts 
Around 
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Frame #14 
Upper Left X: 04,06 picas 
Upper Left Y: 04,06 picas 

13,OOx56,OO picas 

Frame #18 
Upper Left X: 19,00 picas 
Upper Left Y: 04,06 picas 

27,06x24,OO picas 

Allow 03,00 picas for caption frame 

Frame #15 
Upper LeftX: 19,00 picas 
Upper Left Y: 31,06 picas 

13,OOx29,OO picas 

Frame #17 
./ 13,00x02,00 picas 

Frame #16 
Upper Left X: 33,06 picas 
Upper Left Y: 33,06 picas 

13,OOx27,OO picas 

Figure 6·9. If you do NOT have the Power disk, draw these frames on page three. 

Style 



Insert page four 

Insert page four 
am InsertlRemove 

Page 

Add frames to page four 

Operation: Insert a New Page 
Mter Current Page 

Add the two frames shown in Figure 6-10. 

Frame #19 
Upper Left X: 04,06 picas 
Upper Left Y: 04,06 picas 

42,OOx27,OO picas 

Frame #20 
Upper Left X: 04,06 picas 
Upper Left Y: 31,06 picas 

42,OOx29,OO picas 

Figure 6·10. If you do NOT have the Power disk, draw these frames on page four. 
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Add a dashed ruling line above 
To create a fold line, you will add a dashed rule above the 
bottom frame on page four. 

~ Go to page four. 

m Select Go To Page from the Chapter menu (or press Ctrl-G). 
Move to the Selected Page line and enter 0004 

m Select the bottom frame (frame #20). 

m Select Ruling Line Above. Choose Width: Frame, Dashes: 
On. Make the Dash Width: 02.16 fractional pts and the 
Dash Spacing: 02.16 fractional pts. Give Rule 1 a height of 
00.50 fractional pts. 

RUlHIi LINES ABOIIE 

Width: Fra .. e 
Color: Black 

Pattern: Solid 
Dashes: On 

Space Above Rule 1: 00 • BB 
Height of Rule 1: 00.5BI 

Space Below Rule 1: 00.88 
Height of Rule 2: 00 • 88 

Space Below Rule 2: 00.B8 
Height of Rule 3: 00.88 

Space Below Rule 3: 00.B8 
Overall Height: 00.58 

Place text files 

--------] 
36.BB 

CustON Indent: 00,00 [TJ C.:] 
CustON Width: OO,O() 

Dash Width: 02.16 
Dash Spacing: 02.16 fractional pts 

Now that the frames are completed, you are ready to place the 
text. Start with the two articles on page one. 

W Press Home to go to page one. 

W Select frame #3. 

~ Select 6NEWS-1. TXT from the Assignment List. 

Ventura pours as much of the text file it can fit in the frame 
and then stops. 
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.. NOTE: Most of the sample text files have been pretagged. 
Ventura will automatically format these paragraphs as you 
place the text. 

Finish placing the first article. 

II Select frame #4 then select 6NEWS-1.TXT from the Assign
ment List. 

II Select frame #5 then select 6NEWS-1. TXT from the Assign-
ment List. 

You will place the rest of 6NEWS-1. TXT when you get to page 
two. For now, continue working on page one. Place the article 
''Ventura Complements CAD" (6NEWS2.TXT). 

iii Select frame #6 and place the text file 6NEWS-2.TXT. 

Ventura flows the text in the two columns and stops when it 
reaches the end of the second frame (Figure 6-11). You will 
place the remaining text when you get to page three. 

Figure 6-11. 

II Select frame #7 and place the text file 6TOC. TXT . 

.. TIP: You do not have to place al/ of a file at once. Ventura will 
"remember" where you left off when you get to the next page. 
Generally, the most efficient way to work is to do everything 
you can on one page before moving on to the next. 
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Mter placing the last text file, take a moment to compare your 
first page to Figure 6-12. Your newsletter is now starting to 
shape up. 

Figure 6-12. The first page so far. 

Add logo text on page one 
To complete the text on page one, add the logo, headline, 
dateline, and jump text to the proper frames. Change to Nor
mal or Enlarged View (your choice) so you can see the text as 
you type. 

ii Enable Text mode. 

ii Click anywhere in the logo frame (frame #1) and type the 
following three paragraphs: 

PAGINATIONS [Enter] 
NEWSLETTER [Enter] 
Design and Production News for Ventura Publ.ishers 

Add dateline and headline 
~ Click anywhere in frame #2 and type the next two para

graphs: 

Vol.ume 1, Number 1 [Tab] Winter 1989 [Enter] 
Training workshops underway 
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The text in the first two frames should look like the sample 
screen in Figure 6-13. 

Figure 6-13. 

Add jump text 
lm Click once inside the small frame (frame #8) above the 

Table of Contents and type: (Figure 6-14) 

See WORKSHOP next page 

i1 Click anywhere in the small frame at the bottom of the page 
(frame #9) and type: (Figure 6-14) 

See CAD page 3 

.. NOTE: If you do not see the end of file marker after clicking on 
the frame, make the jump text frame larger. Later, you can 
resize the frame so it measures 01,00 pica high. The logo, 
headline, and jump text will be stored as part of the chapter's 
caption file. 

If you wish to place this text into separate files, switch to 
Frame mode. Select the frame containing the text you want to 
put in a separate file. Select File TypelRename from the Edit 
menu. Ignore the name you see listed as Old Name. Clear the 
New Name line and type in the new name and location. Then 
click OK. 
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Trailing workshops 
underwayo,_,,_,,_ .............. l 

Ven'lIacomplements 
CADt,,_,_,_,_ ................. 1 

Newslin~,,_,,_,,_ ............ .. 

1ipofthe mon1fto._"_,, ....... . 

.............................................. 

Figure 6-14. 

Place text on page two 
il Press PgDn to go to page two and enable Frame mode. 

il Select frame #10 and place the text file 6NEWS-3.TXT. 

Now continue the article from page one in frame #11 and put 
a new article into frame #12. 

= Select frame #11 and place the text file 6NEWS-1.TXT. 

m Select frame #12 and place the text file 6NEWS-4.TXT. 

Upon finishing, your page will look similar to Figure 6-15: 

Figure 6-15. Page two as it should appear at this stage. 
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Notice that the text does not completely fill frame #11. What 
do you do with the empty space? You could type in additional 
text. Or you could add something to take up space, like an 
illustration or apull quote (sometimes called a lift out). 

Add a pull quote 
A pull quote is a short quotation or extract that can be used as 
a graphic element to fill space and to attract attention to an 
article. 

To create the pull quote, you will add a small frame inside the 
existing frame (frame #11). To set it apart from the rest of the 
text add vertical padding and rules to the frame. The style of 
the rules is derived from the graphic look of the logo. After you 
add the frame, you will type in the pull quote text. 

!1m While still in Frame mode, select Add New Frame from the 
Side-Bar. 

!1m Make sure that the zero point is set to its original position 
at the upper left corner of the Page (click the 0,0 square in 
the upper left corner of the Page). 

~ Starting at position 19,06 picas on the vertical ruler, draw a 
frame 13,00 picas wide by 09,00 picas high inside frame 
#11as shown in Figure 6-16. You can check for accuracy 
with the Sizing & Scaling dialog box. 

Figure 6-16. 
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Add padding 
Add vertical padding to keep the text from butting up against 
the pull quote frame. 

§ With the frame still highlighted, select Sizing & Scaling 
from the Frame Menu. Make the vertical padding 00,06 
picas & points. 

SIZING & SCALING 

Flow Text f.round: III 

Upper left K: 33,96 • c:J LWer left V: 19,86 • c:J 
Fra/lle Width: 13,9B Fra/lle Hei~t: 99,00 

Horiz. Padding: 00,09 Vert. Padding: 09,B6j picas & points 

Pi(7tilN~ Sf:gli.r!g: [fl~~]~~Ir.:~~£J [~r..~}1.£~}~~I~~!~~~J 

Ihpect Ri,tio: L~~!iE~!i~~J [ln~I~i~~J 

X Crop Offset: 00100 rf-H-~-"j V Crop Offset: 00 100 ["-;:F:-l 
Scale Width: ()OIOO ~ .. -.. - '''-''-' Scale Hei~t: OOI()() ,_ ... _ ... ,_ .. _ .. -

~ \ Cancel I 

You have just added padding of 06.00 fractional pts above 
(00,06 picas & points) and 06.00 fractional pts below the frame 
- a total of 12.00 fractional pts which is equal to the inter-line 
spacing of the Body Text. By making the frame padding an 
integer of the Body Text inter-line spacing, you maintain even 
spacing throughout the document. 

Add ruling lines to the pull quote frame 
With the frame still highlighted: 

., Ruling Line 
Above 

m Ruling Line 
Below 

Width: Frame 
Height of Rule 1: 00.25 fractional pts 

Width: Frame 
Height of Rule 1: 00.25 fractional pts 
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Add the pull quote fext 
m Enable Text mode. Click anywhere inside the pull quote 

frame. Type the following pull quote text using non-key
board characters to create the quote marks. (For example, 
[Alt-169] means "type 169 on the numeric keypad while 
holding down the Alt key." This procedure creates an open 
quote mark when you release the Alt key.) (Figure 6-17.) 

[Alt-169] Anyone who wants to make an impression on 
paper should attend a Ventura training 
workshop. [Alt-170] 

- TIP: You can also enter open and close quotes with Ventura's 
built-in keyboard shortcuts, Ctrl-Shift-[ (open bracket) and Ctrl
Shift-] (closed bracket). 

Figure 6-17. 

Add jump text 
Next type in the jump text at the top of the right-hand column 
and change its attributes. 

m While still in Text mode, click anywhere inside the small 
frame at the top of the right-hand column (frame #13) and 
type: WORKSHOP frompage 1 
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m Select the word ''WORKSHOP'' and change its attributes. 
Highlight the word and choose Bold. Then choose Italic 
from the Assignment List (Figure 6-18). 

Figure 6-18. 

r_uu_uu_uu_u __ u_, 
!~rOmJ'lS.lC i 
~~:;;=;~;;;;;~i~-XYZ-A~ 
~ puts it "Anyone who wmts 10 ,reI 
~te I belter imllmsion on Piller ShOU~ r: t~u:.:::~:::~~;;'I~~J 
feuns. Whither you u. ~ to ge' 
rour 1I'IISSig' to the pubHe or to upp.,j 
r.lIl1gtm.n~ I Iype511Ipl'llrU'''~ 
I'VIS your documents III .dge. Anyon~ 
rhoWlllts 10 keep up should attend on~ 
.. more of the workshops and s.minus.! i All workshops, both buie and ad I 

I 

: "Anyone who wmls to rnulin im'! 
sh01JId attend a : 

Create boldface lead-in heads 
In addition to using headings on a separate line, you can also 
draw the reader's attention to an article with lead-in heads. 
Lead-in heads use boldface, italic, or small capitals for the 
first few words of a paragraph. To create the boldface lead-in 
heads in frame #10, highlight the text (by dragging or the 
Shift-Click method), then choose Bold from the Assignment 
List. 

&] Make sure you are still in Text mode. 

~ Select the two following phrases in the first two paragraphs 
in frame #10 and make them bold: 

"Ventura Workstations ... " 

"Digital Laser Corporation ... " 
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.. NOTE: If you accidentally click your text cursor on the Under
lying Page instead of in the desired frame, Ventura asks you if 
you intend to type text on an empty page. Choose Cancel to 
remove the message. 

The rest of the lead-in heads have been completed for you. 
When you are finished the page should look like Figure 6-19: 

Figure 6-19. Check your progress against this illustration. 

Place text on page three 
rm Press PgDn to go to page three. 

Now you will place the article ''Preformatting Ventura Docu
ments" in frame #14 and frame #15 and the rest of the article 
"Ventura Complements CAD" in frame #16 as explained 
below. 

m Enable Frame mode. 

m Select frame #14 and place 6NEWS-5.TXT. 

m Select frame #15 and place the rest of 6NEWS-5. TXT. 

rm Select frame #16 and place the rest of 6NEWS-2.TXT. 

Your page should look like Figure 6-20: 
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Figure 6-20. At this stage, your page should look like this. 

Add jump text 
• Enable Text mode. Click anywhere inside the small frame 

above the right-hand column (frame #17). Then type: 

CAD from page 1 

• Select the word "CAD." Choose Bold, then Italic from the 
Assignment List (Figure 6-21). 

-NOTE: If you select the wrong attribute from the Assignment 
List, choose Normal to return the text to its original format. 
Then reselect another attribute. 

Figure 6-21. 
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Add text to page four 
You're almost done with the text on page four. 

Use Text mode to create the address panel on page four. 

~ Press PgDn or End to go to page four. 

S Click anywhere in the bottom frame on page four (frame 
#20) and type the following address (use Ctrl-Enter to cre
ate a line break): 

New Riders Publi.shing [Ctrl-Enter] 
31125 Via Colinas, Unit 902 [Ctrl-Enter] 
West Lake Village, CA 91362 [Enter] 

II Start a new paragraph for the postage text and type: 

Bulk Rate [Ctrl-Enter] 
US Postage [Ctrl-Enter] 
PAID [Ctrl-Enter] 
LOS ANGELES, CA [Ctrl-Enter] 
PERMIT # XXXX 

~ Select the text "PAID, LOS ANGELES, CA, PERMIT # 
xxxx" and make it Bold. 

B Now select the text "LOS ANGELES, CAPERMIT # XXXX" 
and make it Small. 

When you are finished, check that your page looks similar to 
Figure 6-22. 

Figure 6-22. At this point, your page four should look similar to this 
illustration. 
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til Stopping point 
This is a good point to stop, take a break and save your work 
(press Ctrl-S). You've already done a lot of work, so we should 
probably remind you the first time through a newsletter is 
always the hardest. Make no mistake - it takes a substantial 
effort to produce a newsletter the first time around. But don't 
become discouraged. Once you've set up your pages and 
finished the first issue, the production gets easier each time, 
particularly if you use the techniques we show you at the end 
of this chapter. 

If you want to take a break now, and start again later, save the 
changes to the document and quit Ventura. When you have 
more time, load Ventura, open the chapter 
C:\TEMP\6NEWS.CHP and start from where you left off. 

If you're ready to forge ahead, proceed directly to the next 
section. 

Tagging the newsletter 
With the text in place, you can format the rest of the newslet
ter with tags. As always, start with the Body Text tag. Then 
proceed from the first frame to the last until all the text is 
tagged. 

~ Go to page one. 

~ Enable Paragraph mode. 

ml Select the second paragraph in frame #3, which starts "Ms. 
Belden will conduct basic skills workshops .... " 

Confirm that the Body Text matches the following attributes: 

m Font 

~ Alignment 

Face: Times 
Style: Normal 
Size: 010.0 points 

Horz. Alignment: Justified 
Overall Width: Column-Wide 
First Line: Indent 
In/Outdent Width: 01,00 picas & points 
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m Spacing Inter-Line: 12.00 fractional pts 
Add in Above: When Not At Column Top 

When you're finished with Body Text, you will then go to 
frame #1 and add a new tag called Logo. 

Add the Logo tag 
The logo is the most important element on the front page. It 
distinguishes a newsletter from others, projects the overall 
tone, and lends consistency from issue to issue. A logo can be 
letters and pictures or just letters and rules combined in a 
visually exciting way. The logo's size should relate to the other 
elements on the page. It should be easy to read without con
flicting with the headlines. 

m Select the paragraph "PAGINATIONS." 

II Add New Tag 

al Font 

Tag Name to Add: Logo 

Style: Bold 
Size: 072.0 points 

WARNING: If you are using a non-Postscript printer, you may not be able to print 
fonts as large as 072.0 points. Use the largest size available to you instead. 

al Alignment Horz. Alignment: Center 
Width: Column-Wide 
In/Outdent Width: 00,00 picas & points 

- NOTE: In this style sheet, tags are copied from Body Text, 
which has a first-line indent of 01,00 picas & pOints. Therefore, 
you must remove this indent for al/ the tags that follow. 

m Spacing Inter-Line: 80.00 fractional pts 
Add in Above: Always 

Now use kerning and tracking to reduce the space between 
the individual letters and improve the appearance of the type. 

m Select Paragraph Typography from the Paragraph menu. 
Choose Automatic Pair Kerning: On, Letter Spacing: Off. 
Make Tracking 0.050 Ems Tighter. 
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'logo" TYPOGRAPHY SETTIrIiS m 
Automatic Pair Kerning: On 

letter Spacing: Off Up to: 0.100 (f:I\~ 
Tracking: Tighter O. ~ EMs 

Grow Inter-Line To Fit: On 

Mini~u~ Space Width: 9.699 * (space width) = 0.150 Ells 
Nor~al Space Width: 1.099 * (space width) = 0.259 EMs 

Maxillull Space Width: 2.099 * (space width) = 9.500 Elts 

You can also track the letters interactively. Enable Text mode 
and select the letters you want to track. With the letters 
highlighted press the Shift key and the left arrow about five 
times. Each time you press the left arrow key you move the 
letters together about .01 Em. (Conversely, you can press the 
right arrow to move the letters further apart.) To find out the 
how much tracking you've done on-screen, choose Set Font 
from the Side-Bar while the letters are still highlighted. 

Add Logo2 tag 
Now you will add a tag named "Log02." 

11 Try to select the paragraph ''NEWSLETTER.'' 

You may find it impossible to select the NEWSLETTER para
graph. The inter-line spacing of the Logo tag is so large (80.00 
fractional pts) that it causes the Logo paragraph to overlap 
the paragraph below. Fortunately, there are a few techniques 
to get around this problem: 

• Select the second paragraph before you tag the Logo para
graph. This is a good method only if you know ahead of time 
that one tag will overlap the next. 

• Tag the Logo paragraph as Body Text. This reduces the 
Logo tag to the size of Body Text and lets you select the 
paragraph below. After you add the Log02 tag (to the 
Newsletter paragraph), retag the paragraph above it as 
Logo. 
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• Change the Frame typography. Select the frame reserved 
for the logo and change the setting for Move Down to 1st 
Baseline By from Default to Cap Height (Frame Typo
graphy, Frame menu). This action raises the baseline of the 
logo text and lets you select the paragraph below. 

-.. NOTE: If you are interested in understanding the subtle dif
ferences between Move Down to 1st Baseline By: Cap Height 
and Move Down to 1st Baseline By: Inter-Line, we encourage 
you to read the next section. On the other hand, if you have 
little interest in advanced typographic techniques, just follow 
the step-by-step instructions and watch what happens. 

Review move down to 1 st baseline 
In Chapter Three we introduced you to the concept of Move 
Down to 1st Baseline By in the Chapter Typography menu. 
Because most beginners have a hard time with this concept, 
we're going to take the time to review it. 

Move Down to 1st Baseline By affects the starting position of 
text at the top of a column or page. For instance, when you 
select Move Down to 1st Baseline By: Inter-Line, Ventura 
posi tions the baseline (the imaginary line on which the text 
rests) of the word PAGINATIONS 80.00 fractional pts from 
the top of the margin (the value of its inter-line spacing). 
When you select Move Down to 1st Baseline By: Cap Height, 
Ventura "hangs" the word PAGINATIONS from the column 
margin by the tallest capital letter in the word. (Imagine the 
word PAGINATIONS hanging down from the top of the 
col umn like laundry hanging from a clothesline.) 

U sing Move Down to 1st Baseline By: Cap Height causes the 
word to be raised upward in the frame (Figure 6-23 and 
Figure 6-24). 
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Figure 6-23. Move Down to 1st Baseline By: Inter-Line. 

Figure 6-24. Move Down to 1 st Baseline By: Cap Height. 

If you're still struggling with this concept, you may under
stand it better if you step through the process. Go ahead and 
change the frame typography and watch what happens. 

Change the frame typography 
~ Enable Frame mode. 

~ Select the logo frame. 

m Select Frame Typography from the Frame menu. 
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II Choose Move Down to 1st Baseline By: Cap Height and 
click OK. 

The word PAGINATIONS is raised up and you can now select 
the paragraph below. 

D Enable Paragraph mode and select the paragraph 
"NEWSLETTER" in frame #1. 

D Add New Tag Tag Name to Add: Logo2 

• Font Style: Bold 
Size: 030.0 points 

• Alignment Horz. Alignment: Center 
In/Outdent Width: 00,00 picas & points 

D Spacing Above: 02.00 fractional pts 
Inter-Line 34.00 fractional pts 
Add in Above: Always 

As you saw earlier, you can use tracking to reduce the in
dividual space between characters and make a headline more 
legible. You can also use tracking to add space between char
acters for special effects. You will now add extra space be
tween letters in the Logo2 tag. 

D Select Paragraph Typography. Choose Ati.tomatic Pair 
Kerning: On, Letter Spacing: Off. Choose Tracking: Looser 
and enter 0.750 Ems. 

When you are finished, the tag should look like Figure 6-25: 

Figure 6-25. 
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Add a ruling line above and below the Log02 tag 
With the paragraph still highlighted, add ruling lines above 
and below. 

m1 Ruling Line 
Above 

m1 Ruling Line 
Below 

Add the Motto tag 

Width: Frame 
Height of Rule 1: 01.00 fractional pts 

Width: Frame 
Height of Rule 1: 01.00 fractional pts 

a1 Select the paragraph "Design and Production News for 
Ventura Publishers." 

m Add New Tag 

a1 Font 

~ Alignment 

Tag Name to Add: Motto 

Size: 012.0 points 

Horz. Alignment: Center 
Overall Width: Frame-Wide 
In/Outdent Width: 00,00 picas & points 

Now use tracking to tighten the spacing between letters. 

a1 Paragraph Letter Spacing: Off 
Typography Tracking: Tighter 

Ems: 0.030 

Add a custom rule to the Motto tag 

To create the effect of a double line - one thick and one thin 
- you will add a custom rule above the Motto tag. Even 
though these two lines look like one unit, they are not. The 
top, thinner rule is part of the Logo2 tag above. The bottom, 
thicker rule will be attached to the Motto tag. 

m With the Motto paragraph still highlighted, select Ruling 
Line Above. Make the unit measurement picas & points. 
Choose Width: Custom. Make the Space Above Rule 1: 
00,01 picas & points. Give Rule 1 a height of 00,10 picas & 
points. Enter a Custom Indent of (+) 06,00 picas & points 
and a Custom Width of 30,00 picas & points. 
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''Hotto'' RULIfti LINES ABlUE 

Width: CustoM 
Color: Black 

Pattern: Solid 
Dashes: Off 

83,00 
SPDce Above Rule 1: 111,81 

Height of Rule 1: 111,10 Custor. Indent: 06,80 • c:J 
Space Below Rule 1: 111,00 Custor. Width: 30,001 

Height of Rule 2: 111,08 
Space Below Rule 2: 111,80 Dash Width: 00,00 

Height of Rule 3: 111,00 Dash Spacing: 00,00 picas & point 

SPDce Below Rule 3: 111,08 • c:J 
Overall Height: 111,11 
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-NOTE: If the text below the motto paragraph disappears 
belows the frame try 1) enlarging the frame, 2) reducing the 
Height of Rule 1, or 3) reducing the Space Above Rule 1. 

Add a Dateline tag 
Now move to the next frame to create the Dateline and Head
line tags. In Chapter Three, you learned how to create a 
dateline by placing two different tags on the same line. Now 
we will show you another way to achieve the same effect, but 
this time with Tab Settings. 

~ Select the paragraph ''Volume 1, Number 1. ... " 

II Add New Tag Tag Name to Add: Dateline 

B Font Style: N-Italic 

II Alignment Horz. Alignment: Left 
In/Outdent Width: 00,00 picas & points 

II With the paragraph still highlighted, select Tab Settings 
from the Paragraph menu. Choose Tab Number 1, Tab 
Type: Right, Tab Shown As: Open Space. Make the Tab 
Location: 42,00 picas & points and the Leader Char: 
Spaces. Click OK. 
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"Dateline" TAB SETTINGS 

Tab NUMber: I + I 1 I + I 
Tab Type: Right 

Tab Shown As: Open Space 
Tab location: 42J881 picas & points 

leader Char: Spaces 

leader Spacing: 0 
Auto-leader: Off 

832 (ASCII) 

I Cancel I 

Style 

Tab settings are always measured from the left margin. By 
setting a right tab at 42,00 picas & points (the width of the 
frame) you position the words ''Winter 1989" flush against the 
right margin. 

Tag the headline 
Since most of the text on this page has already been prefor
matted for you, there are only a few more paragraphs to tag. 

m Tag the paragraph "Training workshops underway" as 
Head1 (Figure 6-26). 

r ainin war kshopsunderwa 

Figure 6-26. 
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~ht se,ond hilt 01 Ih' d.y-loni 
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iUvidul wrrlst.tions. They IYm leam: 
ihe bisi, Venhut siems !l!U$iry toi 
lo.d Ind l<rrn.t their own doownents! 
~. sheeUromXYZ'sgrol'lins! 

- Msi 
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Tag the TOe 
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m Select both jump text paragraphs (in frames #8 and #9) and 
tag them as JumpRight (Figure 6-27). 

Figure 6-27. 
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~ Select the paragraph ''Ventura Complements CAD" and tag 
it as Head2. 

To create the banner headline (''Ventura complements CAD") 
we gave the tag a frame-wide alignment. Ventura stretches 
the text across the full width of the frame. If you are unclear 
about the difference between frame- and column-wide align
ment, open the Alignment dialog box for Head2 and switch 
back and forth a few times . 

.. TIP: You can also create a banner headline by placing text in a 
separate frame that spans more than one column. You used 
this second technique to create the Head1 headline above the 
first article. 

The last format changes on this page are in the Table of 
Contents (TOC) in the bottom right frame (frame #7). Add a 
new tag called DeptTi tIe. 

tm Enable Paragraph mode. 

~ Select the word "INSIDE" in the bottom right frame. 

~ Add New Tag Tag Name to Add: DeptTi tle 
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11 Font Style: Bold 
Size: 018.0 points 

~ Alignment Horz. Alignment: Center 
In/Outdent Width: 00,00 picas & points 

m Spacing Below: 06.00 fractional pts 
Inter-Line: 24.00 fractional pts 

Add tracking to the DeptTitle tag 
You can use tracking to add more space between the letters 
and mimic the graphic effect used in the logo. 

m Paragraph Letter Spacing: Off 
Typography Tracking: Looser 

Ems: 0.800 

Add ruling lines 
A ruling line above and below the DeptTitle tag separates it 
from the TOC entries below. 

m Ruling Line 
Above 

~ Ruling Line 
Below 

Check the page 

Width: Frame 
Height of Rule 1: 01.00 fractional pts 
Space Below Rule 1: 06.00 fractional pts 

Width: Frame 
Space Above Rule 1: 06.00 fractional pts 
Height of Rule 1: 01.00 fractional pts 

Page one is now complete. Take a moment to look carefully for 
changes that might improve the design. For instance, examine 
the TOC title ("INSIDE"). If it does not appear properly 
centered you might want to use Text mode to add a thin space 
(Ctrl-Shift-T) or a figure space (Ctrl-Shift-F) in front of the 
word. (Figure 6--28.) Also, check that the jump text lines up 
with the text in the adjacent column. Ifit does not, adjust the 
size or position of the jump text frame (turn Line Snap off 
temporarily). 
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- TIP: If you come across text alignment problems in a frame-in
tensive document, try adjusting your frames so they do not 
touch. Sometimes, when frames butt up against each other, 
Ventura pushes the text in the upper frame up a line. 

Apply the DeptTitle tag 
m Press PgDn to move to the next page. 

m Ifnecessary, enable Paragraph mode before you continue. 

~ Select the paragraph ''NEWS LINE" at the top of frame #10 
and tag it as Dept'll tIe. 

~ Select the jump text "WORKSHOP from page I" (frame 
#13) and tag it as JumpLeft. 

Add a PuliQuote tag 
Earlier, you created a special frame that separated the pull 
quote from the main text. Now you will enhance its ap
pearance by enlarging the size of the text and adding a second 
ruling line above. This second line echoes the double line 
effect from the logo. 

~ In the pullquote frame (in the middle of frame #13), select 
the paragraph that begins "Anyone who wants .... " 

!m Add New Tag Tag Name to Add: Pull Quote 
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~ Font Style: B-Italic 
Size: 014.0 points 

= Alignment Horz. Alignment: Left 
In/Outdent Width: 00,00 picas & points 

m Spacing: Inter-Line: 14.00 fractional pts 
In From Left: 01,00 picas & points 
In From Right: 01,00 picas & points 

~ Select Ruling Lines Above. Make the Width: Custom. Give 
Rule 1 a height of 00,08 picas & points and the Space Below 
Rule 1: 01,01 picas & points. Make the Custom Indent: (+) 
00,07 picas & points and the Custom Width: 10,00 picas & 
points. 

The pull quote should look like Figure 6-29: 

Figure 6·29. 
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Add a big first character to the Staff Box tag 
Now let's change the text in the staff box frame at the bottom 
of page two. To set it apart from the surrounding text, change 
the text to italics and add a big first character. 

= Select the paragraph from the staff box "Paginations is 
published .... " 

m Font Style: N-Italic 
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., Select Special Effects from the Paragraph menu. Choose 
Special Effect: Big First Character. Choose Set Font 
Properties to bring up the Font dialog box. Choose Style: 
B-Italics, and Size: 024.0 points. Click OK to return to the 
first dialog box. Now choose Space for Big First: Custom 
and make the custom lines 001. Click OK to close the dialog 
box. 

U8tafflloxU SPECIAL EFFECTS 

Special Effect: ~ M@'ijM I Bullet I 
Coooands: I Set Font Properties I 

Space for Big First: I ttomall II1II 9911 lines 

llull.el: Char': non (HSC 11) 

Imi!!Tlt Afh,>p Bdl.!!t: 00,00 pi.ca\>' K PQl!ll:~ 

If you had chosen Space for Big First: Normal, Ventura would 
have made its own best decision where to place the big first 
character. In this particular case - a 24-point big first charac
ter on 12-point lines - it would have chosen two lines. It 
would have set the first character on the baseline of the 
second line, creating a two-line indent. 

When you choose Custom instead, you get to decide which 
baseline to use. By entering 1, for example, you tell Ventura to 
place the big first character on the baseline of the first line. To 
make a big first character start below the first line, enter a 
number greater than one. 

Apply JumpLeft tag 
9 Press PgDn to move to page three. 

9· Select the jump text "CAD from page I" (frame #17) and tag 
it as JumpLeft. 
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Add an end of article symbol on page three 
To distinguish the beginnings and ends of articles in a 
newsletter, it is common to place a special editorial symbol, 
like a square (either hollow or solid) or a small version of the 
logo at the end of the article. In a text-intensive, multi-column 
format, this symbol is easy to spot and guides the reader from 
the end of one story to the beginning of another. We will show 
you how to create a special end of article symbol using the Ins 
Special Item option. You will insert a small hollow box at the 
end of an article on page three. 

- NOTE: You can also create an end of article symbol with a 
character from the international character set or (if you have a 
PostScript printer) Zapf Dingbats. In Text mode, insert the 
code you want by pressing Alt and the number from the 
numeric keyboard. Then highlight the character and choose 
Set Font from the Side-Bar to change the font to either Zapf 
Dingbats or Symbol. 

R Enable Text mode. Place the cursor in front of the end of file 
marker at the end of the middle frame on page three (frame 
#15). (Figure 6-30.) 

Figure 6-30. 

§ Select Ins Special Item from the Edit menu (Ctrl-C). 
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m Choose Box Char or press the F1 function key. 

m When you are asked to insert a hollow or filled box charac-
ter, choose hollow. 

Ventura places the hollow box at the end of the text. Now you 
can interactively change the size of the hollow box. 

= While you are still in Text mode, highlight the box by 
dragging or by using the Shift-Click method. 

m Once it is selected, hold down the Shift key and tap the 
down arrow key until you see the box get smaller. (To 
increase the box, hold down the Shift key and press the up 
arrow key.) 

.. NOTE: If the box does not appear smaller, press the ESC key 
once to redraw the screen. 

When finished, your page should resemble Figure 6-31: 
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Figure 6-31. 

'-NOTE: When you move the text cursor over a box character 
on-screen the words IIBox Character" appear in the Current 
Selection Box. You can cut, copy, and paste a box character 
just as you would any other text character - use the Edit Text 
option in the Edit menu or use the equivalent keyboard 
shortcuts. 

m1 If you want more practice inserting box characters, repeat 
the steps above to add a hollow box to the end of the each 
article in the newsletter. 

'-TIP: You can copy the hollow box to the clipboard and then 
paste it in where you want. 

The final page 
Since the rest of page three is already preformatted, go to the 
last page of the newsletter. 

1m Press End to go to the last page. 

Adding the Address tag 
To complete the style section, you will add two tags that reside 
on the same line: the Address tag and the BulkRate tag. 
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The Address tag 
~ Enable Paragraph mode. 

~ Select the paragraph ''New Riders Publishing .... " 

~ Add New Tag Tag Name to Add: Address 

~ Font Face: Helvetica 

G Alignment Horz. Alignment: Left 
In/Outdent Width: 00,00 picas & points 

~ Spacing Above: 24.00 fractional pts 
Inter-Line: 24.00 fractional pts 
Add in Above: Always 
In From Left: 02,00 picas & points 

As you learned earlier, you can use Breaks to place two tags on 
the same line. The first tag - in this case the Address tag -
uses a line break before. 

m Breaks 

The BulkRate Tag 

Line Break: Before 
Allow Within: Yes 
Keep With Next: No 

Now create the BulkRate tag and change the Line Break to 
Mter so it appears on the same line with the Address tag 
(Figure 6-32). 

~ Select the paragraph that begins "Bulk Rate ... " 

m Add New Tag Tag Name to Add: BulkRate 

1m Font Face: Helvetica 

~ Alignment Horz. Alignment: Center 
In/Outdent Width: 00,00 picas & points 

1m Spacing Above: 24.00 fractional pts 
Add in Above: Always 
In From Left: 30,00 picas & points 
In From Right: 02,00 picas & points 

Using In From Left and In From Right pushes the BulkRate 
tag to the right margin. The In From Left and Right spacing 
prevents the two tags from overlapping. 
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Now place the BulkRate tag on the same line as the Address 
tag. 

~ Breaks Line Break: Mter 

Desk File Edit I)iew Chapter Frall8 Paragraph Graphic Options 

Figure 6-32. 

Add ruling lines to the BulkRate tag 
Add the finishing touches by adding ruling lines above and 
below the margins of the BulkRate tag. 

II Ruling Line Width: Margin 
Above Height of Rule 1: 04.00 fractional pts 

E Ruling Line 
Below 

Space Below Rule 1: 06.00 fractional pts 

Width: Margin 
Space Above Rule 1: 06.00 fractional pts 
Height of Rule 1: 04.00 fractional pts 

.. TIP: We made the ruling line width equal to Margin so it lined 
up with the margin created by In From Left and In From Right 
spacing. 
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Illustrations are an important part of many newsletters. In 
this section, you will import and scale an image file and use 
Box Text shapes to draw a monthly calendar. Let's start by 
adding an illustration and caption to the article on page three. 

Place the picture 
• Press PgUp to move back to page three. 

" Enable Frame mode. 

m! Select the picture frame (frame #18) and place the image 
file WPVP.IMG from the Assignment List. 

Scale the picture 
" Sizing & 

Scaling 

SIZING 8 SCALING 

Flow Text Around: In 

Picture Scaling: Fit in Frame 
Aspect Ratio: Distorted 

Upper left K: 19,OBI. c::J ~er Left V: 04,86 a c::J 
Frallle Width: 27,06 Frallle Hei!ltt: 24)00 

Horiz. Padding: 00100 Vert. Padding: BO,OO picas & points 

Picture Scaling: '-iF@; I By Scale Factors I 
Aspect Ratio: I Maintained l'lm", 

H Crop Offset: 00,00 a [J Y Crop Offset: 00,00 a c:J 
Scale Width: 27,06 Scale Hei~t: 24,00 

• I Cancel I 

By choosing Distorted, you allow Ventura to stretch the 
dimensions of the picture as much as needed to fit it exactly 
inside the frame. 

-NOTE: Because the picture is close to the actual size of the 
picture frame, there is very little visable distortion. 
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Add a caption to the frame 
With the picture frame still selected, add a caption. 

~ Anchors Caption: Below 
& Captions 

Ventura attaches an empty caption frame to the original 
frame. Now add the caption text inside this frame. 

~ Enable Text mode. Place the cursor in front of the end of file 
marker inside the caption frame. Type: 

Insert tag names into word processing files to 
preformat Ventura documents. 

The caption is already formatted for you (Figure 6-33). 

Figure 6-33. 

Draw a calendar 

)1 

~ 
WIIHHD m(opy~ellterollitG!llelyHeIII~SerlJulplllr,ry 

f1tt1f1l1S rf'nlt hl1 RP.RI~t.? ~f'iln:n T .... ili1!f~ .. lI'11rlfllJnAnll 
:.Im apllO' a' 191'''INlld 1.1t .. 
I'~H. 1 ,';'II r tllrl' J.'::'Ift ~Jrf ~~I~~-~ nl 

Many readers consider the calendar the most useful part of a 
newsletter. It lists current and future events in an eye-catch
ing, visual format. By placing the calendar on the back page, 
you make it easy for someone to find and refer to throughout 
the month. 
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a Go to page four. 

Before you begin to draw the Box Text, set up a snap-to grid 
for the frame that will contain the calendar. 

a Enable Graphic mode. 

g Select the top frame. 

lm Grid Settings Grid Snap: On 
Horizontal Spacing: 06,00 picas & points 
Vertical Spacing: 02,00 picas & points 

Draw the title box 
Start the calendar by drawing the Box Text shapes to contain 
the calendar title and the days of the week. 

il Before you draw the first Box Text, reset the zero point of 
the ruler to the upper left corner of the frame (frame #19). 

il Select the Box Text tool from the Side-Bar. Starting at the 
upper left column margin, draw a Box Text 42,00 picas & 
points wide (the width of the frame) by 02,00 picas & points 
high (one grid snap unit). (Figure 6-34.) 

Figure 6-34. 

-NOTE:Remember, you can align the ruler with any edge of a 
Box Text to check its measurements. 
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Now change the line and fill attributes. 

~ Line Attributes Thickness: None 

~ Fill Attributes Color: White 
Pattern: Hollow 
Result: Transparent 
Default: Save To 

Pictures 

Draw the days of the week 
Draw one Box Text for the first day. Then use copy and paste 
to duplicate the shape across the frame. 

§ Switch to Normal or Enlarged View to draw the next shape. 
Starting at position 2 picas on the vertical ruler, draw a Box 
Text 06,00 picas wide by 02,00 picas high (Figure 6-35). 

~ Line Attributes Thickness: Thin 
End Styles: Square 
Default: Save 'Ib 

~ Fill Attributes Color: Black 
Pattern: 2 
Result: Transparent 

Figure 6-35. 
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Copy the shape 
II Press Shift-Del to copy the last shape into the clipboard. 

Press Ins to paste a copy on the page. 

Remember, Ventura pastes the copy on top of the original. 

II Use the mouse to move the shape to the right. Thanks to 
the grid, it will snap into position. 

Complete the remaining boxes 
II Th add the rest of the boxes for the days of the week, copy 

the last Box Text shape, then copy it five times across the 
width of the frame. 

When you are finished, your screen should look similar to 
Figure 6-36: 

Figure 6-36. 

Finish the calendar 
Now you will copy the entire row of boxes four times, using 
Shift-Click to select the entire row at once. 

'-TIP: Be careful when trying to move an entire row of boxes. 
You must avoid accidentally resizing the boxes, or selecting 
just one and leaving all the others behind. 
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To move an entire row, use Shift-click to select all the shapes. 
Now hold down the Shift key and press down the mouse 
button in one of the shapes. Do not move the mouse until the 
four-way arrow appears. If the pointing finger appears in
stead, release the button immediately without moving the 
mouse. Then reposition the cursor and try again. 

With these precautions in mind, complete the following steps. 

Draw the first box 
By changing the vertical grid settings, you make it easier to 
create the right size box. 

m Grid Settings Grid Snap: On 
Horizontal Spacing: 06,00 picas & points 
Vertical Spacing: 04,00 picas & points 

~ Starting from position 4 picas on the vertical ruler draw a 
Box Text 06,00 picas wide by 04,00 picas high. 

Copy the box 
m Press Shift-Del to copy the first box to temporary memory. 

~ Paste a copy of the box back onto the page. 

~ Use the mouse to move the copy to the right until it snaps 
into place. 

Figure 6-37. 
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m Paste five more copies and move them into position to 
complete one row of the calendar (Figure 6-37). 

Copy the row 
Now you will copy the entire row of boxes into the clipboard. 

m Select the first box. Shift-Click to select the remaining 
boxes. Then press Shift-Del to copy the entire row into 
temporary memory. 

~ Press Ins to paste a copy of the row onto the page. 

m Hold down the Shift key and place the cursor in the middle 
of one box shape. Drag the entire row of shapes down one 
grid unit. 

~ Paste three more copies and move them into position to 
complete the calendar (Figure 6-38). 

Desk File Edit View Chapter Frane Paragraph Graphic Options 
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Figure 6-38. 

-NOTE: If you have trouble moving the shapes as a group, 
move them one at a time. 

Add text to the calendar 
Now that all the Box Text shapes are in place, use Text mode 
to enter the calendar text. Use Figure 6-39 as a guide. 
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-NOTE: Use a line break (Ctrl-Enter) to separate lines within a 
Box Text. 

a.ale Workahop 

12 13 14 15 

Ad¥. S .... ln.' 

1. 20 21 22 
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Figure 6·39 Your calendar will look like this after typing in the text and tagging it. 
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Apply tags to the calendar 

Chapter 

Use the predefined tags in the Assignment List to format the 
calendar. 

• Enable Paragraph mode. 

m Select the paragraph "February 1989" and tag it as Cal
Title. 

11 Tag all the days of the week as CalDays. 

Nice work. You should be proud of yourself. After completing 
this project, you're ready to take on any type of newsletter, 
whether simple or complex. Let's take a look at the finished 
product. 

g To Print Which Pages: All 
Printing Order: Last to 1st 

Once you have the final copy in your hands, inspect each page, 
looking for small changes that will improve its appearance. 
Remember, no matter how good it might appear on the screen, 
the true test of your talents shows up after printing. 

Creating a chapter template 
As promised, we're going to finish this chapter with tips that 
speed newsletter production. Once you establish a successful 
format, the hard part has been done. You can reuse your 
newsletter chapter over and over again for future issues. 

Here's how it works. Open the newsletter and save it under a 
new name - TEMPLATE.CHP, for example, or BLANK.CHP. 
Now remove all the text files and graphics files with Remove 
TextlFile from the Edit menu (Figure 6-40). 
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Figure 6-40. 

-NOTE: You do not have to remove the logo text, unless you 
are using the same template for different newsletters with 
different names. 

Now save TEMPLATE.CHP again. From now on, you will use 
this chapter full of blank frames as your starting point. Start 
by renaming the template so you preserve it intact. Then load 
and place text files into the empty frames. Change the 
headers and footers if necessary to reflect the new dates. 
Adjust frame sizes, add frames, edit copy and make any other 
minor changes as necessary to make the new text and pictures 
fit. Newsletters that vary quite a bit from month to month 
may require more extensive adjustments. Even so, you will 
still be finished with the newsletter in a fraction of the time it 
takes to build one from scratch. 

Another time-saving trick 
If you want to save a step, simply use the same file names for 
each issue's text and pictures. This technique is most useful if 
the newsletter format is nearly the same each month. Make a 
copy of the first issue under a new name, but do not remove the 
text and graphics files. Keep this new version in a subdirec
tory of its own, together with all the files that make up the 
chapter. For example, you might call the copy FINAL.CHP 
and store it in a directory called \FINAL because this is the 
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chapter you will use to print the final version of the newsletter 
each month. 

Collect the text and graphics for each new issue in a separate 
subdirectory (for instance, \ JANUARY, \FEBRUARY, 
\MARCH, etc.). When everything's ready to go, copy the text 
files to the \FINAL directory, but rename the files so they 
match the names used in the first issue. Once you've updated 
the files in \FINAL directory, you can load FINAL.CHP. Since 
the file names are the same, Ventura will immediately flow 
the new text and graphics into the old layout. You won't even 
need to place the files. You will, however, need to make some 
minor adjustments before printing. 

5i Tips and techniques 

Text tips 

D After you convert a text file format, or rename it to a new 
location, the changes do not take effect until you save the 
chapter. If you abandon the chapter without saving, you 
will lose the changes. 

D To create a dashed line effect, choose Ruling Line Above, 
Below or Ruling Box Around from either the frame or para
graph and select Dashes On. You can adjust the width of 
the dashes and the space between them. 

D The text you type directly into a frame or caption is stored 
in Ventura's caption file. If you wish to save the text as a 
separate file use File TypelRename from the Edit menu. 
Ignore the name you see listed in Old Name. Type in the 
new name and location and click OK. 

Style tips 

D A pull quote is a short quotation that can be used as a 
graphic element to fill space or add emphasis to an article. 
To make a pull quote, place and size a separate frame 
within a column. Then type the pull quote text directly into 
the frame. Add a new tag called Pull Quote and change the 
text attributes to create the desired effect. 
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D Use tracking to reduce or increase the space between in
dividualletters in a word. 

D To create a banner headline, tag the text as frame-wide, or 
place text in a separate frame that spans more than one 
column. 

D If you choose Space for Big First: Normal, Ventura makes 
its best guess where to place the big first character. When 
you choose Custom instead, you decide which baseline to 
use. By entering 1, for example, you tell Ventura to place 
the big first character on the baseline of the first line. To 
make a big first character start below the first line, enter a 
number greater than one. 

D Use an end of article symbol to show where one article ends 
an another begins. Use the Ins Special Item to insert a 
hollow or filled box at the end of a story. 

Picture and frame tips 

D It is easiest and most efficient to build newsletters by pour
ing text into frames. 

D Frames can have fill patterns and up to three ruling lines 
around. 

D Frames that reside on top of the Underlying Page can have 
the same or different margins and columns as the Underly
ingPage. 

D Make the vertical padding of frames equal to the current 
inter-line spacing of the Body Text tag. 

D If you come across text alignment problems in frame-inten
sive layouts, try adjusting the frames so they do not touch 
each other. Sometimes when frames butt up against each 
other, Ventura pushes the text in the upper frame up one 
line. 

D Be careful when you move a group (a row or a column) of 
graphic shapes together. To avoid accidentally re-sizing 
them, or selecting one by itself, be sure to select them by 
holding down the Shift key before you go to move the boxes. 
After you press the mouse button, do not move the shapes 
until the four-way arrow appears. 
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Chapter tip 

o You can re-use a standard chapter format over and over 
again by converting it into a chapter template. Take the 
original chapter and save it as a new chapter. Then remove 
all the text and picture files. Once they are removed, save 
the new chapter with a name like BLANK.CHP. From now 
on, you will use this chapter, including its frames, headers 
and footers, and so forth, to begin your new projects. 



Chapter Seven 
Skills Checklist 

Theory 
o The power of pretagging 

o Creating a directory from a database 
file 

Text 
o Line breaks versus paragraphs 

o More timesaving tips on preformatting 

Style 
o Live headers and footers that change 

from page to page 
o How to make your own crop marks 

o Advanced typographic effects using 
reverse type 

o Inserting the page number anywhere 
on the frame 

Picture 
o Creating thumb tabs with repeating 

frmaes 

o Adding fill patterns to frames 

Chapter 
o Creating a publication 
o Linking page numbers from chapter 

to chapter 

o Using Multi-Chapter to print a 
publication 

o Using chapter templates to speed 
production 
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A Directory 

Theory 

Combining the power of a database program with Ventura's 
batch formatting allows you to publish professional

quality directories quickly and easilY .. In this chapter, you will 
create a sample directory using the skills and techniques 
listed on the facing page. 

In Chapter Two, you learned the basics of preparing text in 
advance, including how to use bracket codes to enter at
tributes directly into word processing files. In this chapter, 
you will also learn how to enter tag names directly. In addi
tion, we will pass along a few ideas on how to use a database 
program to generate pretagged files for Ventura. 

Because of time and space limitations, you will not actually 
use a database to build the sample document in this chapter. 
However, the text file you will load into the sample document 
resembles a file you would get from a database. If you expect 
to use a database in your real-life applications, you will 
benefit from understanding the theory of using a database to 
generate pretagged files. 

The power of pretagging 
The fastest way to format text from a database is to include ' 
tag names in the text file. As soon as the file is loaded into 
Ventura, the style sheet definitions are automatically applied. 
Pretagging virtually eliminates the need to tag inside Ventura 
and reduces layout time and formatting errors. You can, of 
course, produce sophisticated documents without pretagging. 
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course, produce sophisticated documents without pretagging. 
In the long run, however, this pretagging shortcut saves time 
and increases productivity. 

Rules for pretagging 
When you load a text file, Ventura treats all untagged para
graphs as Body Text. For this reason, you do not need to 
pretag Body Text. All other paragraphs, however, can be 
pretagged using the format @TAGNAME = . The "at" sign (@) 
comes first followed by the tag name (e.g. HEADl, HEAD2, 
etc.), a space, an equals sign, and a second space. Leaving out 
any character or space cancels the tagging instruction. 
Likewise, the tag will not take effect unless it is the first line 
in the paragraph and flush against the left margin. Moreover, 
the tag name in the text file must match the name in the style 
sheet exactly. Ventura doesn't care whether you capitalize or 
not, but it does care that you spell both tag names the same. 

In the files you will load for this chapter, @HeadSection = is 
the tag code for the title of each directory section. @Headl = is 
the tag code for the first-level heading (the single letters that 
precede each alphabetical section); @Head2 = is the tag code 
for the second level heading, and so on. Backward arrows (...1) 
at the end of lines indicate line breaks. Paragraph symbols (en) 
indicate paragraph returns. 

At first glance, it seems like extra trouble to type in tag names 
at the beginning of each paragraph. Once you settle on a 
standard set of names, however, you can store them as key
board macros (with your word processor or a separate pro
gram like Smartkey). Then you can enter tags in quickly by 
pressing a single macro key. Or, as suggested below, you can 
have a database program do the work for you. 

You'll find more tips on pretagging text at the end of the 
chapter. 

Using a database file with Ventura 
Database programs are more practical than word processors 
for generating lists and directories. Businesses use database 
programs to maintain client lists, mailing lists, inventory 
lists, and so forth. You can transform such a list into a Ventura 
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document by having the database program generate an ASCII 
file, which then can be loaded into Ventura. Creating an 
ASCII file can be as simple as printing a report to disk . 

.. NOTE: If you are not familiar with the structure and use of a 
database, you may not understand some of the terminology 
(e.g. fields, records, and so forth) we introduce in the strategy 
section below. Don't worry. Just skip ahead to the planning 
section and read about the Ventura skills you will learn in this 
chapter. You will be able to apply most of these skills to 
practical projects that don't require the use of a database. 

A "raw" ASCII file, however, needs lots of formatting once 
inside Ventura. You can make things even easier by using the 
database to pretag the file. Here's the strategy: 

• Prepare a thumbnail sketch of the directory. Choose names 
for the tags (for instance, Headl, Head2, Company, Phone#, 
etc.). 

• Use Ventura to create a style sheet with matching tag 
names. Format it to match the thumbnail sketch. 

• Sort the database to pull out the specific information you 
need. 

• Specify a database report with the fields in correct order. 

So far you've done nothing out of the ordinary with Ventura or 
with the database. To pretag, however, you must take two 
additional steps: 

• Use the database report generator to insert the tag names 
in front of the fields. 

• Print the report (which now includes the tag names) to 
disk. 

Once you've generated the pretagged ASCII file, you can load 
it into Ventura. The text will be formatted as soon as you place 
the file on the Page. 

Line breaks versus paragraphs 
The sample text file you will use in this chapter contains line 
breaks as well as paragraph returns. For long documents such 
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Line break 

Theory 

as directories, you should get in the habit of using line breaks 
to create new lines whenever both lines have the same tag 
name. Line breaks consume less memory than returns. 
Memory considerations do not come into play for short docu
ments, but they can become a concern with long documents, 
especially those with many lines of small type and memory-in
tensive effects such as leader dots. 

A database can enter line breaks by inserting the bracket code 
<R> in place of a carriage return (Figure 7-1). 

Figure 7-1. Use line breaks instead of returns in a long directory file. 
Ventura's line break code is <R>. 
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-- ....--- ~ 
~ 

~ ~ -~ ~ 
~ '" . .. ...... 

~ 
~ -- a a ~. -- ~ 

.........--
~ ~ ~ 

:""- .......-- ~ 
~ ............... ............... 

" II - ..... "'''' ..... --- ~. ---. ~ ..........-............... ~ 

~ 

l..ANPX4PQ j:p/fMAT 
j co('uhlAlS 14,07 EA 

2, 00 6cJ1"r~A.. 

11 
Adobe,Inc 

1870 Embarcadero Rd. 
Palo Alto, CA 94303 
Product: Po.rlScripl.lUrulralOr.Adobc 
Type Library 
Phone: (415) 852.o27I 

AllIed Unotype Co. 

425 0 .... Av •. 
Hauppauge, NY 11788 
Product: Linolronic 100 and 300 
Phone: (516) 434-2016 

Autodesk, Inc. 

2320 Mannsbip Way 
Sausalito, CA 94965 
Product: AutoCAD.AuIOSkctch 
Phone: (415) 332-2344 

II 
Data....,y Corp. 

12U Terra Bella Ave 
MOUIIIain View, CA 94043 

1888 edition 

Manufacturers 
Product: Modcl730 ScaMer 
Phone: (415) 965-7900 

DIgital Research Inc. 

60 Guden Court 
Mootc:rey, CA 93942 
Product: GEM Desktop. GEM Draw 
Plru. GEM Pailll 
Phone: (408)649-3896 

III 
Hewlett-Packard 

P.O. Box IS 
Boise, ID 83707 
Product: Laserjcl PI ..... Laserjclll. Scan
je' 
Phone: (208)323-3869 .. 

Imagen 

2650 San TClIIlas Expressway 
Santa Clara, CA 95051 
Product: DDL Language 
Phone: (408) 986 -9400 

Manufacturer. A-A 

IO,~O 

(./VG /="tJorel? 

~~ tlc.:LveilCA 

II 
Lotus Development Corp. 

55 Cambridge Parl<way 
Cambridge, MA 02142 
Product: Loou 1-2·3. Symphony. 
Freelance. Graphwrilcr 
Phone: (617)577-8500 

Media Cybernetics 

8484 Geotgia A v •. , Ste. 200 
Silver Spring, MD 20910 
Product: Halo Duluop Publishing Editor 
Phone: (301)495-3305 

M1croPubUshlng 

21150 Hawthorn. Blvd, Ste. 104 
Torrance, CA 90503 
Product: microPublishing Rllporl 
New"cI,.r. VelllwaStyl.Shce" 
Phone: (213) 376-5724 

ChoptBr 1 

7-5 

Before 

After 
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Planning the directory 
Directories are text-intensive documents with detailed list
ings of people, products, organizations, etc. Most directories 
are quick reference guides. They are scanned and skimmed to 
pinpoint information. As such, they should be designed to help 
the reader find facts quickly and efficiently. Since most direc
tories maintain the same format from page to page they are 
fast to format, especially if you pretag the files. 

The landscape page format of this chapter's sample directory 
provides three spacious columns for text. Graphic techniques 
such as reverse type, ruling lines, and thumb tabs help the 
reader spot different sections, headings, and entries. For in
stance, the thumb tabs bleed to the edge of the page. Even 
with the book closed, you can tell where one section begins 
and another ends by the dark edges of the pages. The reverse 
type effect on the heading creates a visual contrast between 
major headings and minor entries and helps establish an 
hierarchical order of information. 

Here are some of the effects and techniques you will learn in 
the directory: 

• Live footers 

• Thumb tabs 

• Landscape layout 

• Reverse type (or shaded type) 

• Crop marks 

• Page numbers anywhere on the page 

This chapter's sample contains two partial sections of a three
section directory. The first section is arranged alphabetically 
by manufacturer, the second by category. You will create each 
section as a separate chapter. At print time, you will use 
Ventura's multi-chapter operation to combine them into a 
single publication. In actual practice, you may find it practical 
to create directories of up to 30-40 pages as a single chapter. 
For longer directories, we recommend breaking the individual 
sections into separate chapters. 
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Ventura prep 

Text 

If you have the Power disk 
Load and rename/relocate the files for this chapter. 

II Load the text file 7LIST.TXT from the C:\POWER sub
directory. Use File TypelRename to save it as 
C: \ TEMP\ 7DIRECT. TXT . 

• Load the style sheet 7LIST.STY from the C:\POWER sub
directory. Save it as C: \ TEMP \ 7DIRECT.STY . 

• Save the chapter as C:\TEMP\7DIRECT.CHP. 

If you do not have the Power disk 
m If you don't own the Power disk, type in 7DIRECT.TXT 

from Appendix A. Save it as C: \ TEMP\ 7DIRECT. TXT. 

m Load &TBL2-Ll.STY from C:\TYPESET. Modify it to 
match Figure 7-2. Add or change tags using the tag tables 
in Appendix B. Save it as C: \ TEMP\ 7DIRECT.STY. 

II Save the chapter as C: \ TEMP\ 7DIRECT.CHP. 

WARNING: When you type in the directory file listings in ASCII format, remember to 
place two carriage returns between each paragraph. Otherwise, Ventura runs all the 
lines of text together. This warning applies to database files you create on your own. 

For this project, you will act as if you have already used a 
database program to generate and preformat the ASCII file 
7LIST.TXT. Although the text file contains tag names, those 
tags have not yet been defined in the style sheet, so all the text 
is displayed as Body Text. When you get to the style section, 
you will build the tags while learning some new graphic ef
fects. 

m Place the text file 7DIRECT.TXT on the Page. 
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Top: 06,00 
picas & points 

Trim size: 
10X7.S in. 

Three columns: 
14,07 picas & points, 

Gutters: 
02,00 picas & points 

Bottom: 06,00 
picas & points 

Style 

Figure 7·2. If you do NOT have the Power disk, modify the right page of & TBL2-L 1.STY to match this illustration with 
Margins & Columns, then copy these settings to the facing page. 

Style 
In the style section you will learn a variety of useful techni
ques, including crop marks, live headers and footers, leader 
dots, and more. 

Chapter layout 
If you loaded the preformatted style sheet from the Power 
Disk, all the chapter settings should be intact. To be on the 
safe side, confirm both the page layout and the margins and 
columns. 

m Page Size & 
Layout 

Orientation: Landscape 
Sides: Double 
Start On: Right Side 



Draw crop marks 

m Margins & 
Columns 

# of Columns: 3 
Settings For: Right Page 
Top: 06,00 picas & points 
Bottom: 06,00 picas & points 
Left: 08,00 picas & points 
Right: 10,00 picas & points 

7-9 

Column 1,2,and 3 width: 14,08 picas & 
points 
Gutter width: 02,00 picas & points 

Draw crop marks 

Crop marks 

Although the size of the paper is llx8.5 in., the paper will be 
trimmed by V2 inch on all four sides to create a page size of 
10x7.5 in. Crop marks (also called trim marks) show the "live 
area" - the area which remains after the paper is trimmed by 
the printer (Figure 7-3). 

Figure 7-3. 

You will create the crop marks in this project using the rec
tangle tool in Graphic mode. Then you will tell Ventura to 
repeat the graphic shapes on every page of the document. 
Before you draw the rectangle, plan the grid settings. Because 
you are trimming the paper 1f2 inch (03,00 picas) on each side, 
you will make the grid settings 03,00 picas & points. This grid 
setting guarantees that the crop marks will be exactly 
03,00 picas from the edge of the Page. 
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II Reset the zero point to the upper left corner of the Page 
(click on the 0,0 square in the upper left corner of the 
screen). 

m Enable Graphic mode. Then select the rectangle tool from 
the Side-Bar. Now set the grid for the Page. 

m Grid Settings Grid Snap: On 
Horizontal Spacing: 03,00 picas & points 
Vertical Spacing: 03,00 picas & points 

m Change to Normal or Enlarged View to draw the crop 
marks. 

m Starting at position 0,0 picas on the ruler, use the rectangle 
tool to draw a 03,00 by 03,00 pica shape. 

The grid settings force the rectangle into position (Figure 7-4). 

Figure 7-4. 

!A 
jAdobe, Inc 
i1870Embarcadero Rd. 
iPaloAlto, CA94303 

-NOTE: If you draw the rectangle and the grid doesn't take 
effect, just set the grid again while the rectangle tool is high
lighted. 

Now change the line attributes. 

m Line Thickness: Thin 
Attributes End Styles: (Beginning and End) Square 

Defaults: Save To 



Draw crop marks 

~ Fill 
Attributes 

Color: White 
Pattern: Hollow 
Result: Transparent 
Defaults; Save To 

7 -11 

-NOTE: You may have to experiment a few times before you 
get the hang of drawing shapes with a mouse. Keep trying until 
you master this new skill. 

Repeat the above steps to place crop marks at the other three 
corners. Your finished page should look like Figure 7-5: 

Figure 7-5. 

Now that you've completed the crop marks for this page, you 
will make them repeat on every page of the directory. 

i1 Choose Select All from the Graphic menu (or press Ctrl-Q) 
to select all the line shapes. 

i1 Select Show On All Pages from the Graphic menu. 

- NOTE: You can also use Ventura's built-in crop mark feature 
from the To Print dialog box instead of drawing marks on the 
page. 

Although Ventura has a crop mark feature in the To Print 
dialog box, we taught you to draw your own crop marks as an 
alternate technique. Ventura's automatic crop marks are 
visible only on the printed page. They cannot be seen on the 
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screen, since they are not selected until print time. By con
trast, if you draw the crop marks you can see them on the 
screen, which helps when you visualize the page design. To get 
Ventura's generated crop marks for this size directory you 
would have to reduce the size of the Page to 10x7.5 in. But 
reducing the size of the Page makes it harder to accomplish 
bleed effects like the thumb tabs in this chapter. 

In general, Ventura's built-in crop marks are most useful 
when working with the Paper Type & Dimension: Half option 
from the Page Size & Layout dialog box, or for those who have 
a printer that creates pages larger than 8.5xll in. In most 
other cases, we recommend drawing the crop marks yourself. 

Build the footer 
Headers and footers are vital to a good reference document. 
They help readers zero in on the facts. For instance, a phone 
book's header shows the first and last names on the page. A 
dictionary's header tells the first and last word on the page. 
Headers and footers that change from page to page are called 
live headers and live footers. 

For this exercise, you will build a live footer that shows the 
first and last entries on each page. The commands to ac
complish this effect are shown in Figure 7-6: 

HEADERS Ii FOOTERS 

Define: I left Page Header I I Right Page Header I 
I left Page Footer I 

Usage: .. I Off I 
Right Pa!le Footer 

left: 1989 Edition, ___________ _ 

Center: [(HeadSection] [(Head1](196}[(Head1J _____ _ 

RiW1t: I!hapter [I!I:IJI-I ___________ _ 

Inserts: I Chapter It I I Page 1:1 I I 1st Hatch I I last Match I 
I Text Attr. I I Copy To Facing Page I 

Figure 7·6. 
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Here are the steps for creating a live footer. 

m Select Headers & Footers. Select Define: Right Page Footer, 
Usage: On. 

m Move to the Left line and type: 1989 Edition 

m Move to the Center line and select Inserts: 1st Match. 
Delete the words "tag name" between the brackets (do not 
delete any of the brackets) and replace them with: Head
Section 

~ Next, use the right arrow key to move past the right brack
et. Press the space bar to enter a space following the right 
bracket. 

You have just given the 1st Match instruction. Ventura will 
look on every page and find the first paragraph tagged as 
HeadSection. It will display this paragraph in the footer. If it 
gets to a page and doesn't find a new HeadSection tag, it will 
use the one from a previous page. 

~ Select Insert: 1st Match again. Delete the words "tag name" 
and replace them with: Head1 

This command tells Ventura to display the first occurrence of 
the Head1 tag in the center of the footer. 

m Move past the right bracket and select Inserts: Text Attr. 
Delete the letter "D" between the brackets and replace it 
with: 196 

You just told Ventura to print an en dash (a dash the size of 
the letter n in the current font). The decimal code for an en 
dash is 196. 

~ Move past the right bracket and select Inserts: Last Match. 
Delete the words "tag name" and replace them with: Head1 

This copies the last occurrence of Head1 to the center footer. 

~ Move to the Right line and type: Chapter followed by a 
space. 

~ Choose Inserts: Chapter #. 

Now you will copy these settings to the left page and modify 
them slightly. 
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iI Choose Inserts: Copy to Facing Page to copy the footer 
settings to the left page. 

= Select Define: Left Page Footer, Usage: On. Move to the 
Right line, press Esc to clear the line, and type: Desktop 
Publ.ishing Directory and click OK. 

When you are finished, your page should look similar to 
Figure 7-7 . 

.... .
A 

==,CA.!U3OJ 
.. ..tScript, DJa.htor, Adobo Typo La'bn,ry 
l'Ilo ... : 
C4")"~02'7l 
ADIed LIAotypo Co. 
41So..rA".. 
Hauppa .... , NY 11111 

..... -l.i:D.otro. too .... 300 
hOMo: 
C'ld).u.20ld 
AWNlIllk,Ia.c. 
2320 MaaU.hipWay 
• ..sto,CA."'''' ..... -AutoCAD,AutoSbk:ll -, 
C''')''~2344 
D 
""""'"P7eo.p. 
U1S To ... 801laA .. 
M01IuiA VMow,CA. 940a 

..... -Mocs.?30Sc:almer 
1'1111_: 
C4")96S-7lIOO 
Dili1ala.o.u::taloc. 
600ard_Coart 
MOD...-.y.CA.nM2 

..... -GBMDoMtop,GBMDraw~,GBMI'aiat 
I'bODO: 
C"')64903896 

Figure 7-7. 

H -P.o. Box. 15 

::-'::83'107 
1Mo1jot ..... I.oMojoOD ..... ;.c 
l'Ilooeo: 
(208)323-184' 
I 
1m ••• 
2OO"Tom_~y 
SaDtaaa,..CA.m.51 

..... -DElL ........ 
Pboae: 
C ... )98.s._ 
L 
....... t>o ... """' .... eo.p. 
"c:u.bri4 .... dtway 

=~dp.MAm"2 

Lo.... 1.2.3, Sympltooy, .,.. .... .... --. (011)'77...,... 
M 
Modlo~ .. 
S484 Goo ... Av.., .... 200 sa_.pri.., MD 209.0 ......... 
..... DooIdDp ... -..".U ... -. CW')4f'-3305 
Microt'ubli.bm, 
21150 HawthOmo Blvd., lite. 104 
To~.CA!N)$O' ......... 

,mc;:ro ....... biDikoportNoWllMtW,VClll1ura ..,..-
I'IlOM: 
~13)37,","'" 

k;cohCorp. 
SDedridtPl.c. 
W.tCaldWoll,NJ(J'7()N 

..... -153Gb ... 
hOM: 
~')18~2000 

...... """ ... 
""901 LaDdia,l"lUk:way 
Fftlmoa.t.CA',,", ......... 
I...NorVliOwDiaplayS}Vclm 
l'Iloa.: 
C4") 770-0.00 
...... n 
P.o. Bo .. 477 
MODD"iD, V.w, CA 9oC(MO 

..... -No-'ot ....... 
C·"),. ... "1 
T 
TdTftlOSyatD .. 
1120 s.1l ADtoaio ltd. 
P'IIIoAlID,CA!N303 

..... -n...... .... -. (413)"""980 
V 
V.J&om.lDc. _I 

Change the footer frame margins 
When the paper is trimmed, it will later lose lf2 in. from each 
side. If you trimmed the page as it is, the footer text might get 
clipped off (Figure 7-8). 

To raise the footer into the live area of the Page, you will 
change the top margin of the footer frame. 

m Enable Frame mode and select the footer frame. 

m Margins & 
Columns 

Top: 01,00 picas & points 



Change the footer frame margins 

jProduct: 
:GEMDesktop,'VJ..Jl.Y.LLI •. aYT.L 
iPhone: 

co",o.. Trim ~ :(408) 649 3896 

" .. ~~... -,....----r--\---:_-_--- -- --- ---- --

Figure 7-8. 
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Notice that the right and left margins of the footer are equal 
to the Page margins (Figure 7-9). You raised the footer text on 
the page by decreasing the top margin from 02,04 picas & 
points to 01,00 picas & points. 

-------_ .. :. 

Figure 7-9. 

-.. TIP: You can also change the position of headers and footers 
by changing the Above Spacing value in the Z_HEADER or 
Z_FOOTER tag (Spacing, Paragraph menu). 

Spacing attributes are stored with the style sheet and can be 
reused if it is easier. Document attributes, such as footer 
margins, are stored with the chapter. They cannot be reused 
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unless you construct a chapter template (as described in 
Chapter Six). Sometimes, however, you cannot achieve the 
effect you want without changing the header or footer mar
gins, especially if you have large trim margins - as is the case 
with this document. 

Building new tags 
Now that you've completed the changes to the Page, you are 
ready to format the tags. Start with the Body Text tag, then 
proceed through the document paragraph by paragraph. 

Verify the Body Text tag 
m Enable Paragraph mode. 

~ Select the paragraph "1870 Embarcadero Rd." at the top of 
the page and check that the Body Text tag matches these 
settings: 

m Font 

m Alignment 

m Spacing 

Build the HeadSection tag 

Face: Times 
Style: Normal 
Color: Black 
Size: 010.0 points 

Harz. Alignment: Justified 
Overall Width: Column-Wide 

Inter-Line: 12.00 fractional pts 
Add in Above: When Not At Column Top 

The HeadSection tag uses a Ruling Line Above to create the 
reverse type effect. Later, in the picture section, we will show 
you how to achieve the same effect by placing white text in a 
solid black frame. ' 

- NOTE: Certain printers may not be able to print out white text 
on a black background. You can, however, achieve a similar 
effect using black text over a gray patterned rule (or frame). 
We will show you how to create both effects. 

m Select the first paragraph "Manufacturers." 
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The tag name, HeadSection, appears in the Current Selection 
Box (Figure 7-10). Now change its font. 

Figure 7-10. 

m Font 

~"""""""""""""""""] 

~~:E~~dero R~J i 
f"0 AHo, CA 91300t : 
froduct I : 
foslScript, JIIustntor, Adobe !ypt Librir)1: 

r holld i 
!~15J 852-()271f : 
:Amed Lillotyp. Co.1 : 
~2S0serAvt.J i 
~Uppi\lg .. NY 117881 : 
'roduct I : 
~iMtrOnX 100 I!Id 3001 : 

~I 
~.wlett·PI.(brdf 
~.O. Box 15J 
iloist, ID 837071 
Product: I 
~jel Plus, we~et D, SUlliet f 
rhollo: l 
!208) 323·38.~f 
~I 
Pn.gen I 
~650 SlII T ..... E>epressw'VJ 
1l<nh CI'rl, CA ~505'1 
~oduct I 
PDL LlIIgUigef ~hOl\l: I : 

--~ 
Style: Bold 
Color: White 
Size: 024.0 points 

Because you just made the text white, it is invisible against 
the white screen. But as soon as you drop a black background 
behind it, the text will become visible again. 

~ Alignment Horz. Alignment: Center 
Overall Width: Frame-Wide 

Frame-wide alignment forces the text to extend across all 
three . columns. 

m Spacing 

~ Breaks 

Below: 24.00 fractional pts 
Inter-Line: 24.00 fractional pts 
Add in Above: AI ways 

Page Break: BeforelUntil Right 

This Page Break selection places a page break before every 
HeadSection tag. As a result, every section of the directory 
starts on a separate right-hand page . 

.. NOTE: If you want the HeadSection tag to start on either a new 
right or a new left page, choose Page Break: Before instead of 
Before/Until Right. 
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Create reverse type 
Now you will create the reverse type effect with Ruling Line 
Above. The strategy behind this effect is simple: You make the 
type white and drop a black ruling line on top of it. 

-NOTE: If your printer is incapable of reverse type, follow the 
substitute procedures explained in the next section. 

You will start by giving Rule 1 a height larger than the type. 
In this example, HeadSection is 24.00 fractional pts and Rule 
1 is 36.00 fractional pts. If you did nothing else, the rule would 
appear above the white type. You can, however, shift the rule 
downwards, by entering a negative value for the Space Below 
Rule 3. If you enter a positive value, Ventura adds space below 
the rule. If you enter a negative value, Ventura subtracts 
space so the rule shifts downwards. 

- TIP: Although it is called Space Below Rule 3, this measure
ment refers to the space below the last rule, whether that last 
rule is the first, second, or third. 

To calculate how many points to shift the rule down, use the 
following formula: 

• Add the ruling line height and the font size 

• Divide the sum by two 

This formula vertically centers the text within the rule. 

Here's the simple math for finding the Space Below Rule 3 in 
our example above: 

• 36 + 24 = 60 (fractional pts) 

• 60 + 2 = 30 (fractional pts) 

You would, therefore, make the Space Below Rule 3 equal to 
negative 30.00 fractional pts to center the type exactly in the 
middle of the rule. The formula, however, is only a starting 
point. In many cases, you will find it necessary to adjust the 
Space Below Rule 3 to create a more pleasing visual effect. For 
instance, in this example, you will use 34.00 fractional pts 
instead of 30.00 for the Space Below Rule 3. This places the 
text slightly above the center of the rule. 
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• Select Ruling Line Above. Choose Width: Frame. Give Rule 
1 a height of 36.00 fractional pts. Make the Space Below 
Rule 3: 34.00 fractional pts. Choose the minus sign to shift 
the rule downwards (Figure 7-11). 

"HeadSection" RULING LIMES ABOVE 

Width: FraMe 
Color: Black 

Pattern: Solid 
Dashes: Off 

Space Aboye Rule 1: 00.88 
Height of Rule 1: 36.88 

Space Below Rule 1: 00.80 
Height of Rule 2: 00.88 

Space Below Rule 2: 00.8B 
Height of Rule 3: 00.88 

Space Below Rule 3: 34.88 
Overall Height: B2.BB 

Figure 7·11. 

36.00 

CustON Indent: OO,(}O [~] c:] 
CustoN Width: 00,00 

Dash Width: 00,00 
Dash Spacing: OO,()() fractional p 

~. 

If you cannot print reverse type 
If your printer is incapable of reverse type, create black text 
on a gray rule instead. Use the same steps as above, but 
change the font color to Black and make the Ruling Line 
Above a gray pattern. For instance you would select: 

• Font Style: Bold 
Color: Black 
Size: 024.0 points 

~ Select Ruling Line Above. Choose Width: Frame, Color: 
Black, Pattern: 3. Make the height of Rule 1: 36.00 fraction
al pts and the Space Below Rule 3: (minus) 34.00 fractional 
pts (Figure 7-12). 
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"HeadSection" RULING LINES ABOUE 

Width: FraMe 
Color: Black 

Pattern: 3 
Dashes: Off 

m 

36.00 
Space Above Rule 1: OIUIO 

Height of Rule 1: 36.BO Custor. Indent: 00,00 CTJ t:.:.:] 
Space Below Rule 1: OO.BO CustoN Width: OO,()O 

Height of Rule 2: OO.BO 
Space Below Rule 2: 00.00 Dash Width: 00.00 

Height of Rule 3: 00.00 Dash Spacing: oo.()() fractional p 

Space Below Rule 3: 34.BO ~ II 
Overall Height: 02.BO 

Figure 7·12. Without special add-on cards, printers such as the 
Hewlett-Packard LaserJet Series II cannot printer reverse type, but they 
can produce black text on a gray background. 

Style 

Change the Head1 tag 

The next paragraph to tag is Headl. You will use the method 
described above to create reverse type. Because the file was 
pretagged, every Head1 paragraph will be effected by the 
changes you make in the following step. 

~ Select the paragraph "A" that was pretagged as Headl. 

~ Font Style: Bold 

~ Alignment 

~ Spacing 

Color: White 
Size: 018.0 points 

Horz. Alignment: Left 
In/Outdent Width: 00,06 picas & points 

Above: 18.00 fractional pts 
Inter-Line: 18.00 fractional pts 

To prevent Ventura from isolating the Headl tag at the top or 
bottom of a page or column, you will choose Keep With Next: 
Yes from the Breaks dialog box. 

t;m Breaks Keep With Next: Yes 



Create the ruling line above 

"Head1" BREAKS 

Page Break: m 'Before' 'After' 'Before & After 

, Before/Until Left' I Before/Until Right 

ColurIln Break: m 'Before' 'After' 'Before & After 

line Break: ~ l:rthliQi ~ 'Before & After 

Next Y Position: '11114161' 'Beside last Line of Pre .... Para' 

Allow ~ithin: ~ ~ 

Keep With Next: ~ ~ 

Create the ruling line above 

I Cancel I 

7 - 21 

Now you will create a black ruling line above the Headl tag 
and move it down over the white type. This time you will make 
the rule a custom width so it is confined to a smaller space 
within the column. 

em Select Ruling Line Above. Choose Width: Custom. Give 
Rule 1 a height of 24.00 fractional pts. Make the Space 
Below Rule 3 (minus) 24.00 fractional pts. Then make the 
Custom Width 24.00 fractional pts. 

"Head1" RULItiG LINES ABOIJE 

Width: CustOfll 
Color: Black 

Pattern: Solid 
Dashes: Off 

Space Above Rule 1: 00.88 
36.99 

Height of Rule 1: 24.88 Custor. Indent: 00.88 a c:J 
Space Below Rule 1: 00.88 Custor. Width: 24.881 

Height of Rule 2: 00.88 
Space Below Rule 2: 00.88 Dash Width: OO,{)O 

Height of Rule 3: 110.88 Dash Spacing: OO.()() fl'actional pt 

Space Below Rule 3: 24.88 Gil 
Overall Height: 00.88 
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.. NOTE: The centering formula would indicate a negative space 
of 21 fractional pts (18 + 24 = 42. 42 + 2 = 21). We have 
increased the Space Below Rule 3 setting by 03.00 fractional 
pts to raise the text slightly above the center line of the rule. 

If you cannot print reverse type 
To make black text on a gray rule, change the font color to 
Black and the rule Pattern to 3. 

Change the Head2 tag 
Now you will change the Head2 tag. 

~ Select the paragraph "Adobe, Inc." 

1m Font 

1m Alignment 

!m Spacing 

Style: Bold 

Horz. Alignment: Center 

Above: 12.00 fractional pts 
Below 12.00 fractional pts 
Inter- Line: 14.00 fractional pts 

The space below separates the title from the entries below. 

1m Breaks Keep With Next: Yes 

Keep With Next prevents the title from being isolated at the 
top or bottom of a column or page. 

!m Select Ruling Line Above. Choose Width: Column. Give 
Rule 1 a height of 02.00 fractional pts. Make the Space 
Below Rule 1 02.00 fractional pts (Figure 7-13). 

~ Select Ruling Line Below. Choose Width: Column. Make the 
Space Above Rule 1 02.00 fractional pts, then give Rule 1 a 
height of 00.50 fractional pts (Figure 7-14). 

Change the Head3 tag 
~ Select the paragraph "Product." 

tl Font Style: Bold 

~ Alignment 

1m Breaks 

Horz. Alignment: Left 

Keep With Next: Yes 



Change the ItalKWN tag 

"Head2" RULItii LINES ABOVE 

Width: ColuMn 
Color: Black 

Pattern: Solid 
Dashes: Off 

Space flbove Rule 1: 00 • 08 
Height of Rule 1: 02.00 

Space Below Rule 1: 02.001 
Height of Rule 2: 00.00 

Space Below Rule 2: 00.00 
Height of Rule 3: 00.80 

Space Below Rule 3: 00.80 
Overall Height: 04.81 

Figure 7-13. 

"Head2" RULItii LINES BElOt! 

Width: ColUMn 
Color: Black 

Pattern: Solid 
Dashes: Off 

Space flbove Rule 1: 02.00 
Height of Rule 1: 00.501 

Space Below Rule 1: 00.80 
Height of Rule 2: 00.88 

Space Below Rule 2: 00.88 
Height of Rule 3: 00.08 

Space Below Rule 3: 00.88 
Overall Height: 02.51 

Figure 7-14. 

CUstON Indent: 00 ,00 [:~::J [,:] 
CustoN Width: OO,()() 

Dash Width: 00 JlO 
Dash Spacing: oo.()() fractional pts 

[II 

1 ~.OO 
CustON Indent: OO,(){) [:~J c:] 
CustON Width: OO,()O 

Dash Width: 00,00 
Dash Spacing: 00,00 fractional p 
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The Breaks dialog box accomplishes two things. Line Break 
Before allows another tag to reside on the same line. Keep 
With Next: Yes keeps the listing from being separated from 
the following tag. 

Change the ItalKWN tag 
m Select the paragraph "PostScript, Illustrator, Adobe Type 

Library." 

The tag name ItalKWN (short for Italics Keep With Next) 
appears in the Current Selection Box. 
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m Font 

m Alignment 

Style 

Style: N-Italic 

Horz. Alignment: Left 
In/Outdent Width: 00,06 picas & points 
Relative Indent: On 

Relative Indent: On positions the tag next to the previous 
paragraph. 

m Breaks Line Break: After 
Keep With Next: Yes 

Line Break: After allows the I talKWN tag to reside on the 
same line as the previous tag. 

Change the ItalSeparate tag 
The next tag encountered is ltalSeparate. It is identical to the 
ItalKWN tag, except that Keep with Next is set to No in the 
Breaks menu. Choosing No permits Ventura to split the text 
to a new column after the tag. 

m Select the paragraph "(415) 852-0271." 

00 Font Style: N-Italic 

00 Alignment 

m Breaks 

Stopping point 

Horz. Alignment: Left 
In/Outdent Width: 00,06 picas & points 
Relative Indent: On 

Line Break: After 
Keep With Next: No 

Here's the stopping point for the chapter. Take a moment to 
save your work and relax. You should also congratulate your
self for all the progress you are making. Before you continue, 
check to make sure your document matches Figure 7-15. 
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Pictures 
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Figure 7-15. Your document should look similar to this illustration at this stage of the project. 

If you don't have time to continue, quit Ventura and come back 
later. Simply open the chapter C:\TEMP\7DIRECT.CHP and 
jump right into the pictures section. 

You are now ready to proceed with the pictures section. If you 
plan to continue without a break, proceed directly to the next 
section. 

Now that you have finished the style section, you are ready to 
make the thumb tabs. As explained earlier, thumb tabs make 
it easier to find different sections of a directory. You will create 
the thumb tabs with repeating frames. As the name implies, a 
repeating frame shows up on every page of the document. 
Before you draw the thumb tabs you must do two things: 

1. Determine how high the thumb tab should be. 

For the three-section directory, the height of each thumb tab 
will be 1/3 of the total column height, or 13,00 picas & points 
(Figure 7-16). 
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Figure 7-16. 

2. Calculate how wide the thumb tab should be. 

You will make the thumb tab wider than necessary, so it will 
bleed off the edge of the paper. Since the margin from the live 
area to the trim edge is 03,00 picas & points, you could make 
the thumb tab 04,00 or 05,00 picas & points - anything larger 
than 03,00 picas & points will extend past the trim area. It is 
easier to position if you use a six-pica frame. Then you can line 
it up with the top column guide and the edge of the paper for 
perfect alignment. 

Create the thumb tab frame 
~ Enable Frame mode. Select Add New Frame from the Side

Bar. 

~ Make sure the zero point is reset to the upper left corner of 
the Page. (Click the 0,0 square at the upper left corner of 
the Page.) 

B Starting at position 60 picas on the horizontal ruler and 6 
picas on the vertical ruler, draw a thumb tab frame 06,00 
picas wide by 13,00 picas high. You may want to change to 
Normal View to draw the frame (Figure 7-17). 



Add a frame margin 

Figure 7-17. 

llfacturers ~ . 

LotusDonlo,lMal Cor,.' 

iss Carnbrnge PukwiyJ 
~bridge, MA 021421 
lI'r04.""t, t..J1us 1-2-J, srnlJl~.ni'; 
:rlWklUl.', Onplu'frild r""no:. {&1,7/ m-S5IJX 
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Verify the position and size of the frame with the Sizing & 
Scaling dialog box. 

SIZING & SCALING 

Flow Text fMund: In 

Upper left X: 6O,BBI a c:J lWer left Y: 96,00 a c:J 
Fraflle Width: 86,00 Fraflle Height: 13,00 

Horiz. Padding: 00,00 Vert. Padding: 90,00 picas & points 

Pi.\~tll1'\~ S(.'alirt9: [JE3~~~t~:!~i.J [!~~lIi.~E.~t~I~~~] 

nSp\~d Rilt-lO: L~~}!j~i~}!j~~J Di.E~~~f~~J 

X Crop Offset: (~)OO :---+-] j-:-"] y Crop Offset: oo)(m r~:'l r:-1 
Scale Width: (~) ) 00 ~.-....... -. Scale Hei!llt: 00 I (~) ' ....... : I ...... ' 

[][J I Cancel I 

Add a frame margin 
By adding a right margin inside the thumb tab frame, you will 
center the text inside the three-pica area that remains after 
trimming. Without the right margin, the text would be 
centered inside the full six-pica width - and part of it would 
get trimmed offby the printer. 

~ With the thumb tab frame still highlighted, select Margins 
& Columns. Make the right margin 03,00 picas & points. 
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MARGINS & COLUMNS 

** of Colulllns: a II] m [!] m m [I] []] 
Settings For: I Left Page I WH'WuS 

Widths Gutters Margins 
Coluron 1: 93,00 00,00 Top: OBJOB picas & points 

2: 00,131-:1 OH,OO Bottoro: OB,OEl 
3: 00,1313 00,00 Left: OEJ,eEJ 
4: oo,f.!f.! Right: EJ3 JEJEJ 
5: oo,f.IH 00,00 

6: 00,1313 00,00 
00,00 7: oo,f.!f.! OH,OO Calculated Width = 06,00 

8: 00,f.!f.1 Actual Fraille Width = 06.eEJ 

Insel"ts: I Make Equal Widths I I Copy To Facing Page I 
I Cancel I 

Add a page number to the thumb tab frame 
To make the vertical text within the frame, you will use line 
breaks as spacers after each letter in the word. 

~ Enable Text mode and type within the thumb tab frame: 

[Ctrl-Enter] 
[Ctrl-Enter] 
[Ctrl- Enter] 
M [Ctrl-Enter] 
f [Ctrl-Enter] 
q [Ctrl-Enter] 
s [Ctrl-Enter] 
[Ctrl-Enter] 

Now you will insert a page number inside the thumb tab 
frame with the Ins Special Item option (Edit menu). With the 
text cursor still at the bottom of the thumb tab: 

E Select Ins Special Item from the Edit menu (or press the 
keyboard shortcut Ctrl-C). 

m Choose Reference or press the F6 key. 

E When asked if you wish to insert a reference to the current 
page or chapter number, choose Page #. The number 1, 
preceded by a degree symbol appears in the thumb tab 
frame. 
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By inserting a page number reference in the frame, Ventura 
displays the current page number in the thumb tab. If you 
turn on Show Tabs & Returns (Options menu) you can see the 
Reference marker (a degree symbol) at the bottom of the 
frame. The word "Reference" is displayed in the Current 
Selection Box (Figure 7-18). 

Figure 7-18. 

-NOTE: Like other text attributes, you can cut, copy and paste 
a page reference using Ventura's editing tools. 

Now you will tag the thumb tab text to make it white. 

~ Enable Paragraph mode. Select the letters "Mfgs" and tag 
them as ThumbTab. 

The white text is invisible against the screen until you change 
the frame background. 

Change the frame's fill pattern 
Now you will change the frame's fill pattern to solid black. 

~ Enable Frame mode and select the thumb tab frame. 

11 Select Frame Background from the Frame menu. Choose 
Color: Black and Pattern: Solid. 
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FRAME BACKGROUND 

Color: Black 
Pattern: Solid 

Result: 

Pictures 

Mm. I Cancel I 

.. NOTE: If you cannot print white text on solid black, make the 
text color black and the frame background pattern gray. 

The thumb tab should look like Figure 7-19: 

lufacturers 

LItIS Dntlo, •• t Ctrp. 

iss Clmbri4ge ParkwlY 
~bridge, MA ~21q2 
iPrea.d: u/ri$ 1-;1-3, S;mpII,n,; 
iFlWoi'llN, Onp/lrtriNt it: {G1?jS?1-$SW 

Figure 7-19. The completed thumb tab. 

Copy the thumb tab frame 

Now you will make a copy of the frame to place on the second 
page of the directory. 

~ With the thumb tab frame still selected, copy it into the 
clipboard (press Shift-Del). 
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Be sure to make this copy before taking the next step. You will 
need to paste in this frame on page two. 

Change the thumb tab frame to a repeating frame 
To make the thumb tab repeat on every right page, turn it into 
a repeating frame. 

~ While the thumb tab frame is still selected, select Repeat
ing Frame from the Frame menu. Choose For All Pages: 
Right, On Current Page: Show This Repeating Frame. 

REPEATING FRAME 

For All Pages: [Q££J I left I l1li I left & Right I 
On Current Page: Show This Repeating Frar'le 

I Hide This Repeating Frame I 

I Show All Hidden Frames I 

'-NOTE: You cannot copy, delete, or change a repeating frame. 
To change a repeating frame, first return it to normal, then 
make the changes, then make it a repeating frame again. 

Create a thumb tab for the left page 
Thumb tabs gain part of their effectiveness because they sit 
back-to-back on both sides of a page. This creates a black area 
that can easily be seen along the edge of the document. To 
mirror the thumb tab from the first page, you will paste the 
copy onto page two, then move it into its new position. 

m Press PgDn to go to page two. 

m Press the Ins key or select Paste from the Edit menu. 

The thumb tab frame will appear in the same position it had 
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on the first page. Now move it to the left page margin, as 
shown in Figure 7-20. 

8·············································1 

Figure 7-20. 

;5Ll5 Wtdd.n Dr. 
Sunnyvlle, CA. 9QOS9'21N 
iProdli.t lMlfIJp 7.lW 

r~M'~ 

Use Sizing & Scaling to position the frame accurately. Other
wise, the two frames may not line up back-to-back. 

~ Select Sizing & Scaling. Make the Upper Left X: (+) 00,00 
picas & points and the Upper Left Y: (+) 06,00 picas & 
points. 

SIZING & SCALING 

Flow T ext ~OlJ1d: On 

Upper Left H: 00,00 a c::J 
Fra~e Width: 06,00 

Horiz, Padding: B9,OO 

Upper left Y: 96 1001 a c::J 
Frane Height: BIBB 

Vert, Padding: 00 199 picas & points 

P1ctm'e ~~:aUJ1H: Ln1~:3!!J~9~~i.J r.}~~~~~;~I~~:I~~I(~J 

Aspel:t; Rabo: LB~iEi~~]~~9.~Ll Li.~EF;r.£~9.~U 

H Crop Offset: OO~()() L~:JC:J 
Scale Width: OO>(~) 

Y Crop Offset: (~lIOO [,·-tT··:'"l 
Scale Height: (~) > 00 , ....... , ....... . 
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Verify frame margins 
Check the frame margins so the text is properly centered 
within the tab. (The margins should be the mirror opposites of 
the margins for the right page.) 

m Margins & Left: 03,00 picas & points 
Columns Right: 00,00 picas & points 

Make the left page thumb tab a repeating frame 
As you did on page one, make the left page thumb tab a 
repeating frame. 

1m Repeating 
Frames 

Create a chapter template 

For All Pages: Left 
On Current Page: Show This Repeating 
Frame 

Now that you've formatted the first section of the directory, 
you can use it to create a blank template. Normally we would 
teach this technique in the chapter section. However, we want 
you to practice starting with a template. As you will see, a 
template speeds production by eliminating the need to rebuild 
headers and footers. 

Save your chapter with its existing name before turning it into 
a template. 

~ Press Ctrl-S. 

Now you will remove the text file from the Page and save the 
chapter under a new name to make a copy, which you will turn 
into a template. 

Remove the text file 
m Enable Frame mode. Select the Page. 

~ Select Remove TextlFile from the Edit menu. Choose 
Remove from: List of Files. 
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REMOVE FILE 

File Nafile: 7DIRECT. TXTI 

Remove from: list of Files 

I Cancel I 
Ventura removes the text file 7DIRECT.TXT from the Assign
ment List. 

m Select Save As from the File menu. Save the chapter as 
C: \ TEMP\DIRPLATE.CHP. 

You just made a template - an "empty" chapter. Now you are 
ready to use it to create the next section of the directory . 

.. NOTE: If you had selected Save As while the text file 
7DIRECT.TXT was still on the Page, Ventura would have 
automatically renamed and relocated the text file to 
DIRPLATE. TXT. 

Load text into the template 
Load the text for the second section. Since the text is 
pretagged and all the tag definitions are present in the style 
sheet, the document is formatted as soon as you load it. 

m Make sure the Page is selected. 

m Load and place the text file 7CATGORY. TXT from the 
C: \POWER subdirectory . 

.. NOTE: If you don't have the Power disk, remember that you 
will have to create this file in advance. 

The text flows onto the Page. 
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Rename the text 
~ While the Page is still highlighted, select File TypelRename 

from the Edit menu. Rename the text file as 
C:\TEMP\7DIRECT2.TXT. 

R Use Save As to save the new chapter as 
C:\TEMP\7DIRECT2.CHP. 

By saving under a new name, you preserve the template in its 
original form. The empty template can be used over and over 
again to create additional directory sections. 

Change the thumb tab 
The thumb tab for the second section of the directory will be 
shifted down so it aligns with the bottom edge of the first tab. 

To make a copy of the original thumb tab, select the frame and 
change it from a repeating frame to a normal frame (remem
ber, you cannot copy a repeating frame). 

Ii Select the thumb tab frame. Select Repeating Frame from 
the Frame menu. Choose For All Pages: Off. 

REPEATING FRAME 

For All Pages: a I Left II Right II Left & Right I 
On Current Page: r::~h.~:~.~.:·.:Ir.~.I~~.:·JI~~.i·:~.~:~.~:~.~:;Ii:~.~i·.:·E~.~.~:~.~.~:~.:·J 

LfiI~~.~:~::::JhI~~::J{~:i~.~:~.~:!.~;I~.~.~iJ:.~.~.~:!.~.~:~::J 
I Show All Hidden Frames I 

Now you are ready to copy the frame. 

WARNING: Do not delete the original frame until you place the copy. You will use the 
original as a guide to line up the second thumb tab. 
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~ Select Copy from the Edit menu (or press Shift-Del). 

Now you will paste a copy on top of the original. 

Pictures 

m Press the Ins key or select Paste Frame from the Edit 
menu. 

Move the frame into place below the first thumb tab, so the 
top edge aligns with the bottom edge of the original (Figure 
7-21). 

Figure 7-21. 

Once the frame is properly placed, delete the original. 

lm Select the top frame and press Del. 

~ Select Repeating Frame from the Frame menu. Choose For 
All Page: Right and On Current Page: Show This Repeating 
Frame. Then click OK. 

Now you will change the text in the frame to read ''Products.'' 

lm Enable Text mode. Delete the text but do not delete the page 
reference symbol C) from the frame. 

lm Now type: 



Make a second thumb tab on page two 

[Ctrl-Enter] 
P [Ctrl-Enter] 
r [Ctrl- Enter] 
o [Ctrl-Enter] 
d [Ctrl-Enter] 
u [Ctrl-Enter] 
c [Ctrl.-Enter] 
t [Ctrl-Enter] 
s [Ctrl-Enter] 
[Ctrl-enter] 
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-NOTE: If you delete the page number by mistake, reinsert 
another page reference. Select Ins Special Item (Edit menu). 
Choose Reference then Page # (See the section II Add a page 
number to the left thumb tab frame" in this chapter). 

Make a second thumb tab on page two 
Go to the next page and repeat the previous instructions to 
create a second thumb tab. 

2. Select the left thumb tab frame. 

3. Make it a non-repeating frame. 

4. Copy it to temporary memory. 

5. Paste a copy on top of the original. 

6. Move the new frame into place below the first thumb tab, so 
the top edge aligns with the bottom edge of the original. 

7. Delete the original once the frame is properly placed. 

8. Make it a repeating frame again. 

9. Change the text in the frame to read "Products" and leave 
the page reference as is. 

When you are finished your screen should look like Figure 
7-22 for page two. 
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Chapter 

Chapter 

Figure 7-22. Page two of the completed directory. 

Because of space limitations, we will not show you how to 
complete the third section of the directory. You would, how
ever, use the identical steps and methods. 

In this section, you will renumber the chapters, place both 
sections into a publication and print the publication. 

Update the page counter 
You will now use the Update Counters option to renumber the 
second chapter to start on page three. (In this teaching ex
ample, the first chapter was only two pages long. Normally, it 
would be much longer. Nevertheless, the principles are the 
same.) Ventura can link the page numbers across chapters in 
a publication. Once you make a publication in the Multi
Chapter dialog box (Options menu) you will renumber the 
chapters so that the second chapter starts on the next page 
number after the previous chapter. 

~ Press Home to go to page one of the chapter 
7DIRECT2.CHP. 

m Select Update Counters from the Chapter menu. Choose 
Which Counter: This Page, Update Method: Previous Num
ber + 1, Number Format: 1,2. Then click OK. 
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lPDATE COUNTERS 

~ich Counter: I Chapter IIIIIM CH.~I~.:I~~J:~.E] [JJiJ~:II~j!~~] 

I Initial Page II Initial Table II Initial Figure I 
~date Method: I Restart Nu~ber I Previous NUlllber + 1 

ftiMber Forlllat: 1,2 

You will not actually see the new page numbers until you 
perform the renumber operation in the Multi-Chapter dialog 
box. 

Since the directory is composed of two chapters, you can use 
Ventura's Multi-Chapter function to print both at once. First 
you will put both chapters into a publication. Then you will 
renumber the chapters. Finally, you will use the Print option 
from the Multi-Chapter dialog box to print both chapters with 
a single command. Although you are using only two chapters 
in our example, you can use this same technique to print 
many chapters at once. 

m Select Multi-Chapter from the Options menu. 

-NOTE: If you have made any changes, Ventura asks if you 
want to Save or Abandon. Choose Save. 

Create a new publication 
~ Select New from the Multi-Chapter dialog box. 

Add the two chapter names from this project to the publica
tion. 

m Select Add Chapter. Select C:\TEMP\7DIRECT.CHP from the 
I tem Selector. 

The chapter appears at the top of the Multi-Chapter dialog 
box. 
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Now add the next chapter. 

~ Select Add Chapter again. Select C: \ TEMP\ 7DIRECT2.CHP 
from the Item Selector. 

Ventura returns you to the dialog box and displays the two 
chapter names (Figure 7-23). 

MULTI-CHAPTER IJlERATIOHS m 
~ini~E~mii~ii~ii:ii~ii~iiiii~ii C: \POW ER \ UH TITLED • PUB iiii!ii~ii~ii!!!~i!~i!iii~ii~ii!i!~! Hew 

C:\TEMP\7DIRECT.CHP Open 
~ C:\TEI1P\7DIRECT2.CHP Gl(J,\\t~ 

Figure 7·23. 

Save ••• 
Save As ••• 

Add Chaptel" ••• 
H1,~r:'lIWt') Ghl,\I,~ 

Pdnt .. , 
1'I1,lk1': WG.,. 
l'l<.,!<t.: [name". 
HenU!'ll!.}t~I' ••• 
I::l.lPY AlL" 

[5J 

Now you are ready to save the chapters as a publication. 

m Select Save As from the Multi-Chapter dialo'g box. Ifneces
sary, use the Backup button to locate the C:\TEMP sub
directory. Then save the publication as C: \ TEMP\DIREC
TOR.PUB. 

ITEM SElECTOR 

Directory: C: \ TEMP\* .PUB _________ _ 

IJ!!!!!!!!!!!!1!!!!!!!!!! *. PUB !!mmmmmmmm 

PART_ONE.PUB ! 
H ..... M ....................... " .......... .. 

................................ " ........... . 

.............................................. 

................................ " .......... .. 

Se lection : D IR EC TOR. PUBI 
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The publication name appears in the Multi-Chapter menu 
bar. Once the publication is created, you can renumber it . 

.. NOTE: If a single chapter is highlighted in the list, Ventura will 
not be able to perform the renumber operation. 

~ Choose Renumber from the Multi-Chapter dialog box . 

• When asked if you want to renumber chapters, pages, 
tables, and figures across the entire publication, choose 
Renumber. 

Ventura displays a message telling you it is renumbering all 
the chapters in the publication. 

After the publication is renumbered, you are ready to print. 

~ While still in the Multi-Chapter dialog box, select Print. 
Choose All, Last to 1st . 

.. NOTE: If your printer puts out pages printed-side down, 
choose 1 st to Last instead. 

PRINT INFORMATION (POSTSCRIPT - UltiMate) [!] 
Which Pages: All 

FrOM Page: 00011 
Through Page: 9999 

NUMber of Copies: 01 

Collated Copies: Off 
Printing Order: Last to 1st 

Paper Tray: Default 
Crop Marks: Off 

Spot Color Overlays: Off 
1-I1.~1't:i . Chp, PI\.in~~ F .i.lf.~,~~: 1::(.)I'~b.in~.~d 

Device NaMe: POSTSCRIPT 
Output To: COM1: 

1 Cancel I 

Ventura prints out both chapters, one after another. When you 
are finished, select Done to return to the work space. 
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Tips and techniques 

Pre tagging tips 

D Always use the format @TAGNAME = . Make sure the tag 
name is the first thing in the paragraph. 

D Ventura assumes that any paragraph without a tag name is 
Body Text. 

D The tag name must precede the rest of the paragraph. 
Ventura applies the tag name until it encounters a hard 
carriage return ('1I). Then it switches back to Body Text, or 
to the next tag name. 

D Put the @ sign in the left margin. If the @ sign is any other 
place in the text file, it will not be recognized as part of the 
tag code. 

D Tag names are not case-sensitive. Ventura doesn't recog
nize any difference between upper and lower case. 

D Always match the tag name in the text file with the tag 
name in the current style sheet. Ventura recognizes any 
minor mismatch between tag names, including spaces. For 
instance, CHAP # and CHAP# would be listed as two 
separate tags in the Assignment List. 

D When Ventura finds tag names in the text file that are not 
part of the current style sheet, it lists them in the Assign
ment List in uppercase and displays them on the screen 
with Body Text attributes. 

D Use the @PARAFILTR = tag to strip out double carriage 
returns in a document. This allows you to retain normal 
spacing (two carriage returns between paragraphs) for 
readability in the text file, but strips out the extra returns 
when you bring the file into Ventura. 

D Tags added in Ventura with Paragraph mode will be saved 
back to the original text file when the chapter is saved. 

D When producing files in ASCII format, make sure to enter 
two carriage returns between each paragraph. 

D The fastest way to format a text generated from a database 
is to include the tag names in the text file. 
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Other tips 

D You can create crop marks manually by drawing line 
shapes on the Page. To repeat them on every page of the 
document, choose Show On All Pages from the Graphic 
menu. You can also use Ventura's built-in crop marks in the 
print option. Use the automatic crop marks when you are 
creating half-size pages, or if you have a printer that can 
print larger than 8.5x11 in. format. 

D You can create live headers and footers that change from 
page to page throughout the document in the Headers & 
Footers dialog box. If you select 1st Match, Ventura places 
the first occurrence of the tag in the header (or footer). If 
you select Last Match, Ventura places the last occurrence of 
the tag into the header (or footer). If Ventura doesn't find 
the tag on a page, it uses one from a previous page. 

D Initially, the frame margins of headers and footers are set 
to vertically center the header. You can raise or lower the 
header or footer by changing the frame margins (in Mar
gins & Columns) or by changing the space above or below 
(in Spacing). The spacing attributes are stored with the 
style sheet and therefore can be reused. The header and 
footer frame margins are stored with the chapter and can 
only be reused by creating a chapter template. 

D A reverse type effect can be created by placing white text in 
a black frame, or by dropping a solid black rule down over 
white text. If you want to use reverse text as a predominant 
effect in your style sheet, it's best to make it as a tag using 
the rule above technique. 

D Some non-PostScript printers cannot print white type on a 
black background. Substitute black type on a gray back
ground. 

D Space Below Rule 3 refers to the space below the last rule in 
the tag (or frame), whether that last rule is the first, second 
or third. If you enter a positive value the Ventura adds 
space below the rule and the rule shifts upwards. If you 
enter a negative space, Ventura subtracts space below the 
rule, so it shifts downwards. 

D The Breaks option Keep Wi th Next can be used to keep tags 
from being isolated at the top or bottom of a column or page. 
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D When you turn select the Relative Indent:On in the Align
ment dialog box, Ventura makes the first line indent equal 
to the length of the last line in the previous paragraph. 
When this is used in combination with the Breaks option, 
you can make two tags reside on the same line side-by-side. 

D To make a thumb tab that repeats on every page of the 
document, use a repeating frame. 

D You can insert a page number anywhere on the page includ
ing captions, frames, and Box Text with the Ins Special 
Item option. 

D Once you make a frame into a repeating frame you cannot 
cut or delete it .. Change it back to a normal frame with the 
Repeating Frame dialog box if you need to make changes. 

D Multi-Chapter allows you to combine a list of chapters 
together into a publication. Once the publication is created, 
you can print all the chapters at once. 

D Once you create a publication you can renumber the chap
ters so the page numbers follow sequentially from chapter 
to chapter. Open a chapter and use Update Counters to 
update the initial page to Previous + 1. The new page 
numbers will not be displayed until you choose Renumber 
from the Multi-Chapter dialog box. 





Chapter Eight 
Skills Checklist 

Theory 
o The parts of a book 

Text 
o Inserting footnote references 

o Adding footnote text 

o Working with true typographic 
fractions 

o Inserting index entries 
o Changing the attribute overrides 

o Preparing text for vertical tabs 
(side-by-side paragraphs) 

Style 
o Using a half-size page layout 

o How to update the page and chapter 
counters 

o Understanding widows and orphans 
o Creating a table with side-py-side 

paragraphs 

o How to use spacing and breaks to 
create multiple columns 

o Adding a big first character to the 
lead-in paragraph 

Chapter 
o Creating and printing a publication 
o Rearranging the chapter list 

o Renumbering a publication 

o Generating a table of contents 

o Creating an index 

o Printing crop marks 



Chapter Eight 

A Book 

Theory 

For book publishers large and small, Ventura can mean 
faster production and lower costs. In this chapter you will 

learn the special Ventura skills that apply to long documents. 
You may need to make a few changes to your current produc
tion practices to accommodate the realities of working with 
Ventura. 

There are three parts to a traditional book: the front matter, 
the main text, and the back matter. Each section has its own 
format and style, but all three work together to complement 
the overall design. It is tempting to put the entire book into 
one large chapter file. For easier production, however, we 
recommend a separate Ventura chapter for each book chapter, 
plus separate Ventura chapters for the front and back matter. 

Preformatting text files in advance can help reduce the bot
tlenecks that typically occur in the book production cycle. By 
establishing standard tag names and using bracket codes, 
authors and editors can format as they write. 
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Chapter Six 

Design Principles 

Getting top-quality books from a desktop publishing sys
tem requires special know-how in two areas: design and 
printing_ This chap1cr discusses !he theory of design- The 
following chap1cr, Chap1cr Seven, outlines the S1cpS 10 
take before going 10 a commercial prin1cr. 

This chapter offers comments on the principles of 
book design as t~y apply to desklop publishing. In some 
cases, the realities of desktop publishing force changes 
from traditional methods. 

Design Terminology 

If you're new 10 page design and typography, you'll 
need 10 learn a few words. You'll encoun1cr this 
vocabulary over and over again in software manuals and 
in conversations with graphic designers and commercial 
prin1crs. This specialized 1crminology applies 10 three 

After 
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Planning the book 
For the example in this chapter, you will use the 5.5x8.5 in. 
half-size format. This size lends itself to text-intensive books 
with only a few illustrations. It is easy and economical to 
produce; it is easy to bind (either perfect, sewn or saddle
stitched); and it fits nicely in your hand. In the corporate 
environment, this format is especially useful for in-house 
booklets and software documentation. 

The page design. taught in this chapter is quiet and under
stated. It has large right and left margins with a generous 
amount of space separating the chapter title and subheads 
from the Body Text. The use of white space conveys an open 
feeling and makes the page more readable. Single horizontal 
rules separate the header and index title from the rest of the 
Body Text. 

In this project, you will use several special Ventura long-docu
ment features: 

• Generating a table of contents 

• Generating an index 

• Inserting footnotes and fractions 

• Big first character 

• Vertical tabs (side-by-side paragraphs) 

• Changing chapter and page counters 

• Printing crop marks 

To learn these long document techniques, you will work with 
four chapters in all: one for a table of contents, two main text 
chapters, and one for an index. 
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Ventura prep 

If you have the Power disk 
!!m Load the ASCII text files BTBL.TXT and BDESIGN.TXT 

from the C:\POWER subdirectory. Using File 
TypelRename from the Edit menu save and rename them 
respectively as C:\TEMP\BTABLE.TXT and 
C:\TEMP\BBOOK.TXT. When you are finished, the file 
BBOOK.TXT should be on the Page. 

-NOTE: Do not load the file 8PRINT.TXT. It will be used later in 
the project. 

Since there are no pictures to place in this document, load the 
proper style sheet. 

~ Load the style sheet BDESIGN.STY from the C:\POWER 
subdirectory and save it under the name 
C: \ TEMP\BBOOK.STY. 

II Save the chapter as C:\TEMP\BBOOK.CHP. 

If you do not have the Power disk 
!!m In your word processor, rename any two existing text files 

as BBOOK.TXT and BPRINT.TXT. Save them in the 
C: \ TEMP subdirectory. Choose files of more than five pages 
if possible. (If you have the time and the energy you can 
type in the two text files for Chapter Eight from Appendix 
A.) Then type in the file BTABLE.TXT from Appendix A and 
save it in the C: \ TEMP subdirectory. 

m Load the &BOOK-Pl.STY style sheet from the 
C: \ TYPESET subdirectory and save it as 
C: \ TEMP\BBOOK.STY. 

m Format the style sheet to match Figure B-1. Then use the 
tag table in Appendix B to format the necessary tags. 

II Select Save As from the File menu to save the chapter 
under the name and location C:\ TEMP\BBOOK.CHP. 
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06,00 
picas & 
points 

06,00 picas & points 

22,06 picas & points 

Trim size 33,OOx51 ,00 picas & points 
(5.5x8.5 in.) Right Page 

06,00 picas & points 

8-5 

04,06 
picas & 
points 

Figure 8·1. If you do NOT have the Power diisk, modify &BOOK-P1.STY as shown here. 

In this section, you will learn a variety of powerful text func
tions. You will enter footnotes, true typographic fractions, and 
index references. If you do not expect to use any of these three 
features, you may skip ahead to the style section. The sample 
text file for this chapter (8BOOK.TXT) has, for the most part, 
been pretagged and precoded for you. 
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Inserting a footnote 
Before you insert a footnote in Ventura, you must set the 
format using Footnote Settings from the Chapter menu. Once 
you choose the format, you create a footnote in two steps: (1) 
you insert the reference into the text file and (2) you type the 
footnote text at the bottom of the page. 

Set the footnote format 
Your first task is to design how the footnotes will appear on 
the page. You only have to do this once for the entire docu
ment. 

m Select Footnote Settings from the Chapter menu. Choose 
Usage & Format: # From Start of Page (User-Defined), 
Position of Number: Superscript. 

Now create a "separator line" to visually separate the footnote 
from the main Body Text above. 

m Make the Separator Line Width 12,00 picas & points, the 
Space Above Line: 01,01 picas & points. Switch from picas 
& points to fractional pts and make the Space Above Line 
14.00 fractional pts and make the Height of Line 00.25 
fractional pts. Then click OK. 

FOOTNOTE SETTINGS 

Usage & ForMat: []£[] 11:* From Start of Page (1,2,3) I 
1:1 Fror~ Start of Page (User-Defined) 

11:1 Frol'll Start of Chapter (1,2,3) I 
Start With~: 0001 

Number Template: 1:* __ 

Position of Number: Superscript 

User-Defined Strings: 1: * 2: 
5: += 6: 

** 3: *** 4: **** 
++ 7: +++ 8: ++++ 

Separator Line Width 
Space Above Line 

Height of Line 

fractional pts 
14.00 
00.251 1 Cancel I 
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The portion in the 
margin 

will not print 

-.. NOTE: Be careful to make the height of the line 00.25 fraction
al pts, not picas & points. If you switch back to picas & points, 
the height will show as 00,00 picas & points. Do not be con
cerned. Your measurements have not disappeared. They are 
simply too small to show up in picas & points mode. 

The separator line is measured from the left edge of the page, 
not from the margin. The left margin is 06,00 picas & points, 
and the separator line is 12,00 picas & points. The portion of 
the separator line in the margin (the first 06,00 picas) will not 
print. The portion on the live area (the second 06,00 picas) will 
print (Figure 8-2). 

!* Text of Footnote 

Figure 8-2. 

The separator line is not yet visible on your screen. It will 
appear after you insert the footnote reference in the following 
step. 

Insert the footnote reference 
After setting the format, you're ready to insert the footnote 
reference in the text file. 

t! Go to page seven and change to Normal View. 

t! Enable Text mode. 

~ Place your cursor after the period at the end of the sentence 
as shown in Figure 8-3. 
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Figure 8-3 . 

.................................................................................... 
aJso encounter a few other phrases:. : 
! Thl'bmline is the invisible line the type sits on Som~ 
~rognllls use this teon am/or display the baselines as ~ 
light gray or dashed line on screen Whether or not the: 
~erm is used by th program, line spacing is measured! 
hom baseline to baseline. U you were using a-point type: 
},.,ith 2 points of leading, the baseline to baseline meas-! 
m.ement would be 10 points (8 + 2~ f : 
! Some programs, including Xerox Ventun Published 
~odify this concept slightly. Ventura Publisher con-! 
ilidm the baseline to be the bottom of the lowest de-: 
~cenier r~ther than the line upon which the body of th~ 
?:yperests.J! ! 
: PAGE FORMAT. There are fOUl basic formats. ElliS/!, 
¥i>J1 has an wen left margin am a ragged right margin.! 

this reason it is often referred to as ragged right.: 
tifNis the reverse: even right margin, ragged lefti 

Text 

.. NOTE: Do not be concerned if there are minor discrepancies 
between the position of text on your screen and the text shown 
here. Different monitors and graphic cards may show more or 
less than our illustrations. 

m Select Ins Special Item from the Edit menu (or hit Ctrl-C). 

~ Choose Footnote (or press F2). 

A small cross shows the location of the footnote reference in 
the text. Ventura also displays the separator line, the footnote 
symbol (an asterisk), and the words "Text of Footnote" at the 
bottom of the page (Figure 8-4). 

Figure 8-4. 

il'oetry otIlen U!;es centered lines. Flush left is 
for special formats. Flush right has few ap-: 

'books outside of titles, tables am charts.. ! 
: Hyphenation am justification are crucial to achieve a: 
~peset look When justifying lines, page layou~ 
~rograms attempt to end lines at the space betwee~ 
~ords. When that is not possible, they insert a hyphen~ 
lam put part of the word on one line and the remainder ~ 
~e line below. I ext can be justified without hyphena-j 

t~_T=:'~:":~__________J 
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Add footnote text 
After you insert the footnote reference into the text, you will 
delete the words "Text of Footnote" at the bottom of the page 
and type in the footnote text. 

m Delete the words "Text of Footnote." Then type: 

For more information on this program, see Inside 
Xerox Ventura Publ.isher by James Cavuoto and Jesse 
Berst (MicroPubl.ishinq and New Riders, Westl.ake 
Vil.l.aqe, CA, 1987) 

- NOTE: If you backspace to erase the footnote text and get the 
message "The paragraph you are trying to tag/edit is made up 
of text that was automatically generated ... , " simply press OK 
to delete the message. 

When you are finished the footnote should look similar to 
Figure 8-5. 

Figure 8-5. 

~1I For more information on this program, see lJiside; 
: Xerox Ventura Publislier by James Cavuoto am: 
1 Jesse Bellit (MicroPublishing m:I New Riders,l i WestlahViIlage,CA,I987)O 1 

The footnote symbol is a generated tag named Z_FNOT# and 
the footnote text is a generated tag named Z_FNOT ENTRY. 
For now, do not be concerned with their appearance. Later 
when you get to the style section of the chapter, you will 
change their appearance. 
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-NOTE: Like headers and footers, footnotes occupy their own 
frames. You can raise or lower the footnote on the page by 
changing the top margins of this frame or by changing the 
space above the tag. You cannot, however, resize the frame. 

To delete a footnote and its text reference, delete the footnote 
symbol (the asterisk) in the text file. When the footnote sym
bol and its corresponding footnote text are deleted, Ventura 
automatically renumbers the remaining footnotes. 

Insert a fraction 

Delete 
fraction here 

In earlier chapters, we taught you how to use bracket codes to 
insert true typographic characters in your word processor. In 
this section we will show you how to enter true typographic 
fractions directly in a text file. The Fraction option in the Ins 
Special Item dialog box (Edit menu) gives you true fractions 
that display as smaller-than-normal letters separated by a 
fraction bar. 

~ Go to page four. 

For this project, you will replace the fraction "1/6" in the 
second paragraph with a true typographic fraction. 

~ In Text mode, place the cursor in front of the fraction and 
press the Del key three times to delete the 1, the separator 
bar, and the 6 (Figure 8-6). 

Figure 8-6. 
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Now you are ready to insert a real fraction. 

lW Without moving the text cursor, select Ins Special Item 
from the Edit menu. 

Re~:~ov~:J l'ext;iFile", 
F i hJ r e iR~:Jna~:~~:l , , , 

m Choose Fraction (or press F4). 

The fraction editing screen appears (Figure 8-7). 

Figure 8-7. 

m Type: 1/6 

Ventura displays the typographic fraction on-screen. 

m Now press Ctrl-D to return to the document, where you will 
see the new fraction format (Figure 8-8). 
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imon sizes. f 
l Picas are a larger unit. Don't confuse 
ltypewrHer style of the same name. They a 
!points (about <>l~ inch). Printers and typo 
lPicas to measure lines, margins and colum 
lshows a page from 1his book with the 
lex pressed in picas and points. (The measu 
ito the full-sized page.)f 

Figure 8-8. After you close the fraction editing screen, the true 
typographic character appears in the main text file. 

Text 

You can also make a fraction that looks like this: i. Select Ins 

Special Item and choose fraction. When the equation editing 
screen appears type: lover 6. Make sure you leave a space on 
both sides of the word over. 

Mter creating a simple fraction, you are ready to learn how to 
index . 

.. NOTE: To create complex mathematical equationss we recom
mend the equation editing capabilities of Ventura's Profes
sional Extension. 

Insert an index 
Indexing is a difficult concept to teach and to learn. The best 
way to master the process is simply to go through it a time or 
two. It is a three-step process: (1) insert index references into 
the text file, (2) generate the index file, (3) format the 
generated index file. For the moment, you will insert sample 
index entries into the text file. Later, in the chapter section, 
you will generate and format the index. 

Before you insert your first index reference, take a moment to 
review the different levels of an index as shown in Figure 8-9. 
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Book covers ...... . 
Bookdesisn ..... " 
Book pub1ishil\g . . . • . 
See Iiso DtsiInGuidelinesf«Books 
Plge format ............ . 

Figure 8-9. 

· .10l 
... 10~ 

· .
101 

· .10~ 
,,9'11 

... 10~ 

'1 
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In Figure 8-9, each major index section is preceded by a letter 
heading - A, B, C , and so forth. The first entry below the 
letter is the Primary Entry (for example, Books in the illustra
tion above). The indented words are Secondary Entries (for 
example, Book covers, Book design, and Book publishing). See 
and See also references can also be secondary entries. For 
instance, "See also Design Guidelines for Books" is a secon
dary entry. Instead of listing a page number, the See and See 
Also references direct the reader to a related entry elsewhere 
in the index. 

Insert an index entry 
To learn how to insert references, you will place a Primary 
Entry and a See Also Entry. 

Ii Go to page five. 

~ Enable Text mode. 

~ Place the cursor immediately in front of the "a" in the word 
"attributes" in the third paragraph. (The word attribute is 
underlined in Figure 8-10 to help you place the text cursor 
on the page. Do not underline the word.) 

U Select Ins Special Item from the Edit menu (or press the 
shortcut Ctrl-C). 



8 -14 

Figure 8-10. 

En dash~ ari half thi ling1h of ihi em. ThiY are usedl 
repr~int -'0" betwein numbm am words, as m 

1955W or "Figure 1-2 n The !wphen is ;veri 
yet. It is used to "hyphenate words. Some desJcto~ 

programs make no distinction be1weeri 

ard in dashes. ft .1:. 

~M8cTgel 
! Unfortunately, differ lint programs use different word~ 
~o refer to type and ils)'illributes. The definitions give~ 
below are ihe most common in ihe desktop publishiri 
~dustry. In some cases, ihey vary from ihose in use bi: 
b'adilionaltyp~e1ters.ft . 
! Type sizes are specified in points as explained 
~ ou must umerstard ihe point system to give 
instructions to the software. Many people refer 
~pe in ihe 9 to 12 point ra~e as 'body type. 

m Select Index Entry (or press the F3 key). 

Text 

= Choose Type of Entry: Index. Place the text cursor on the 
Primary Entry line, type: Attr:ibutes and click OK. 

INSERT/EDIT INDEX ENTRY 

Type of Entry: Index 

Prililary Entry: Attribute~!-________ _ 
Pr iAary S(X't Key: 

Secondary Entry: 
Secondary S(X't Key: 

Ventura inserts a degree symbol C) in front of the word At
tributes. If you do not see the symbol on-screen, make sure 
Show Tabs & Returns is on from the Options menu (or press 
Ctrl-T). 

Now you will add the identical entry on another page. 

= Go to page six. 
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~ Place the text cursor in front of the letter "A" in the word 
"A'ITRIBUTES" (Figure 8-11). 

Figure 8-11. 

~onts"sometimescalled<pi fonts, contain special 
foreign language characters un so on, If 

1 There are other kinds of type available from desktoP; 
~blishing systems, including script, cursin, shadow,l 
:outline and reverse (white lellers on a black back-: 
~ound} These decorative effects can be achieved direct~ 
l.y in some page layout programs, They can also b~ 
i;reatro in a special graphics programs and imported ont~ 
~e page, These unusual typestyles are rarely usro hi 
~ooks ex,cept for covers or chapter openings. ft 1 
1 TYPE ITTRlBUTEs. The same tjlpesWle can vary i~ 
~everal ways. W~hI refers to the thickness of the let-i 
~ers1rokes. Mos1 deslctop publishing programs provid~ 
:only normal and '&old. A few programs offer light as: 
~ell, SlQP~refers to the slant of the letters, either verticati 

normal or roman) or slanted (italic or oblique),l 
of type is ils horizontal width Mos~ 

programs offer only normal propor-: 

ill Select Ins Special Item and press F3. 

ill Select Type of Entry: Index. Place the text cursor on the 
Primary Entry line and type: Attributes and click OK . 

.. TIP: When you insert multiple entries be careful to use identi-
cal spelling and case. 

For instance, if you were to enter the word Attributes as one 
Primary Entry and the word Attribute as the other Primary 
entry, Ventura would create two separate entries in the index. 

Add a see also entry 
Ventura permits you to go back to a reference to make changes 
or additions. Let's return to the previous index reference and 
add a secondary entry. 

m Go to page five. 

~ Place the cursor immediately in front of the degree symbol 
C) that precedes the word "attributes" (Figure 8-12). 

m Move the cursor back and forth with the arrow keys until 
the words "Index Entry" appear in the Current Selection 
box. 
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Figure 8-12. 

y, different programs use different words! 
and itS! attributes. The definitions give~ 
ost common in the desktop publishing! 

cases, they vary from those in use by! 
rs.' : 

specified in points as ex plained above.! 
rstand the point system to give correct! 

software. Many people refer to small! 

Text 

m Select Edit Special Item from the Edit menu. Select Type of 
Entry: See Also. Move the cursor next to the Secondary 
Entry line and type: Text Attributes and click OK. 

IHSERT/EDIT INDEX ENTRY m 
Type of Entry: See Also 

PriJllary Entry: Attributes 
Pr illlary Scrt Key: 

Secondary Entry: Text Attributesl 
Secondary S(I't Key: 

I Cancel I 

You will see the words "Index-See Also" in the Current Selec
tion Box. 

Because of space limitations, we will not ask you to insert 
additional index entries. Instead, we have done this for you in 
the files you loaded from the Power disk. We have inserted 
additional entries into the text file so you will have enough 
entries to generate a sample index later. If you look closely, 
you will see the degree symbols marking these entries on the 
screen. 
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Stopping point 

Style 

You have learned two of Ventura's most complex features, 
footnoting and indexing. This is a good place to save your work 
and take a break. When you're ready to continue, begin with 
the style section. 

If you are returning to this project after turning off your 
computer, open the chapter C:\TEMP\8BOOK.CHP to 
resume where you left off. In this next section, you will learn 
more about page and chapter counters, and widows and or
phans. 

Verify the page size and layout 
Now you will verify the settings for Page Size & Layout and 
Margins & Columns. You can do this while on any page in the 
document. 

1m Page Orientation: Portrait 
Paper Type & Dimension: Half 
Sides: Double 
Start On: Right Side 

~ Enable Frame mode and select the Page. Then check the 
margins and columns. 

~ Margins & 
Columns 

# of Columns: 1 
Settings For: Right Page 
Column 1: 22,06 picas & points 
Top: 06,00 picas & points 
Bottom: 06,00 picas & points 
Left: 06,00 picas & points 
Right: 04,06 picas & points 

-NOTE: The above settings are for the right page only. The left 
and right margins are reversed for the left page. 
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Build the header 
~ Go to page one. 

~ Select Headers & Footers from the Chapter menu. 

m Choose Define: Right Page Header, Usage: On. Type: 
Des.ign Pr.inc.iples on the Left line and [Pi] on the 
Right line. 

HEADERS & FOOTERS 

Define: 1 Left Page Header I Right Page Header 

I Left Page Footer I I Right Page Footer I 
Usage: II []ff] 
Left: Design Principles ___________ _ 

Center: 

Right: [PIt]II--_____________ _ 

Inserts: I Chapter It I I Page It 1 1 1st Match I 1 Last Match I 
I Text Attr. I 1 Copy To Facing Page 1 

m Without closing the dialog box, choose Define: Left Page 
Header, Usage: On. Type: [Pi] on the Left line and 
Chapter [Ci] on the Right line. Then click OK. 

HEADERS & FOOTERS m 
Define: 't" •• ,m. 1 Right Page Header 1 

1 Left Page Footer I 1 Right Page Footer I 
Usage: II []ff] 
Left: [Pit] 

Center: 

Right: Chapter [CIt]1 

Inserts: 1 Chapter It I 1 Page It I 11 st Match I 1 Last Match I 
1 Text Attr. I 1 Copy To Facing Page I 

1 Cancel I 
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i! Turn off the header on the first page only. 

Update the chapter counter 
In the header you just made, the chapter number is displayed 
as part of the header text. For each consecutive book chapter, 
you must update the chapter counter (Update Counters, 
Chapter menu) so this number is correct. If you do not update 
the counter, the header will read "Chapter I" for every chap
ter. The chapter counter controls both the number and the 
numbering format. 

~ Make sure you are on page one of the chapter. 

i! Select Update Counters from the Chapter menu. 

~ Choose Which Counter: Chapter, Update Method: Restart 
Number, Restart Number: 0006. Do not click OK yet. In the 
next section, you will change the page counter in the same 
dialog box. 

lPDATE COUNTERS 

~ich Counter: eM I This Page I [IE~!;.:I~;I:;.Iii..J [IIiI~;JIij!~!J 

I Initial Page II Initial Table II Initial Figure I 
~date Method: I Previous Nu~ber + 1 1'1,1;1" 

Restart NUl1lber: 8B~ 

timber Forl1lat: 112 

You have restarted the chapter counter at six. When you close 
the Update Counters dialog box the header will now read 
"Chapter 6." If you had chosen, for example, the One, '!\vo 
button, it would read "Chapter Six." If you had chosen I, II, it 
would read "Chapter VI." 
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Update the page counter 
The page counter function is similar to the chapter counter. It 
allows you to reset the current page number to any number 
and override the automatic page number counter. In the fol
lowing example, let's assume that the previous five chapters of 
this book have taken 96 pages. You will, therefore, reset the 
starting page number of Chapter Six to 97. 

m Choose Which Counter: Initial Page, Update Method: Res
tart Number, Restart Number: 0097, and Number Format: 
1,2. Click OK to close the dialog box. 

UPDATE rnUNTERS 

l1ich Counter: I Chapter II This Page I [If.iI~;.I;.i:~Iji.] [IfiI~;:IIfj!~~i] 

,_ •• I Initial Table I I Initial Figure I 
~date Method: I Previous Number + 1 IliI""I" 

Restart Number: BO~ 

fiJtlber Format: 112 

Because you turned off the header on this page, you must go 
to page two to see the new page numbers. 

m Press PgDn to go to page 2. 

Check that the number in the header is 98 (Figure 8-13). 

-NOTE: The page numbers you see at the bottom of the Side
Bar are not affected by the Update Counters dialog box. The 
new page numbers appear only when you print the chapter. 

Widows and orphans 
As we explained in an earlier chapter, a widow is a single line 
of text at the top of the page. An orphan is a single line of text 
at the bottom. The Widows & Orphans dialog box determines 
the minimum number of lines Ventura can leave at the top or 



Widows and orphans 

Figure 8-13. 

itJescnli1Jc Plcet I 
i Th most common page elemQnts used in tnditiona~ 
!am d~Jctop publishing are described below:ft i 
i A'callout is a brief text label used to d~cribe one P~ 
:of an illustration. Callouts are often accompanied by; 
:urowu : 
i A hption is a brief description that labels or d~crib~ 
~e entire illustration. Also refined to as a 'ClJt!inf or ~ 
rifmJ.ft i 
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bottom of a page or column. For this book chapter, turn off the 
widow and orphan control so Ventura has the flexibility to 
place single lines at the top and bottom of the page. 

~ Select Chapter Typography from the Chapter menu. 
Choose Widows (Min. Lines at Top): 1 and Orphans (Min. 
Lines at Bottom): 1. 

Before you close the dialog box, change the position of the 1st 
baseline: 

il Chapter 
Typography 

Move Down to 1st Baseline By: 
Inter-Line 

CHAPTER (DEFAULT) TYPOGRAPHY SETTINGS 

Widows (Min Lines at Top): 1 
Orphans (Min Lines at Bottom): 1 

Column Balance: Off 
Move Down To 1st Baseline By: Inter-Line 

Pair Kerning: On 

~ I Cancel I 
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Changing the position of the text baseline from cap-height to 
inter-line ensures that the text reaches all the way to the 
bottom of the column. 

Tag the first paragraph 
Now that you've completed the overall page format, you will 
fine tune the appearance of the document by changing two 
tags. First you will change the book's first paragraph to in
clude a big first character. Earlier, in Chapter Six, you learned 
to make a big first character rise above the first line. This 
time, you will create a big first character that drops below the 
baseline. This effect is often called a Drop Cap. 

fij Go to page one. 

1m Enable Paragraph mode. 

m Select the first paragraph of the chapter, which was 
pretagged as BodyFirst (Figure 8-14). 

Figure 8-14. 

::;etlmg top-quality books hom a desktop pubhshl~g sys
em reqUIres special know-how m two areas: desIgn and 
~nnting This chapter discusses the theory of deSIgn The 
ollowing chapter, Chapter Seven, outlmes t~,e steps to 

'ake before going to a commerCIal tinter ft 
: This chapter offers comments M the principles of. 
~ook design as tilt>J' app~l' IQdi>S11qppuhlishfng. In som~ 
i::ases, the realities of desktop publishing force change~ 
~om traditional methods, ft I 
1 Design Terminologyl I 

m Special Effects Special Effect: Big First Char 
Space for Big First: Normal 

Selecting normal lets Ventura choose the number of lines the 
character should take up, based on the point size of the big 
first character. You will set that point size next. 
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11 Without leaving the Special Effects dialog box, choose Set 
Font Properties. When the Font dialog box appears, choose 
Style: Bold and Size: 030.0 points. 

Before you exit the Font dialog box, use the Shift option to 
shift the first big character down a point. This fine-tune ad
justment will ensure that the first big character lines up 
properly with the first line of the paragraph. 

II Select Shift: Down. Enter 01.00 fractional pts. 

FOHT SETTIIti FOR BIG FIRST CHARACTER 

:~::~:~::~::~:~::~::~:~::~::~:~:;~m Face :~:~::~::~:~::~::~:~::~::~:~:t:~: ~""""'iiiiii i::~: S~le i::i:: ~: Color Hi 

t Helyetica U,\~ht; lAlite 

Courier 

i!l!!!l!'! ~~~~i= ~~:~~/o!f/Dellli 
• Helyetica Narrow 

Palatino 

CustoM Size: B3B.O points 

Horlllal 
_:i1ri._ 

l:'lt<llit, 
H- Italic 
B- Italic 

Red 
Green 
Blue 
Cyan 
Yellow 
Magenta 

OYel"SCOre: OFF 
Strike -Thru : OFf 

Underline: Off 
Double Under line: Off 

Shift: Down 01.00\ Fractional pts 

Click OK to return to the Special Effects dialog box. Click OK 
again to return to the workspace. 

Change the footnote tag 
Now you will change the attributes of the footnote tag so the 
two tags (Z_FNOT# and Z_FNOT ENTRY) reside on the same 
line. 

~ Go to page seven and select the footnote text (the Z_FNOT 
ENTRY tag) at the bottom of the page. 

II Font Style: N-Italics 
Size: 010.0 points 

m Spacing Inter-Line: 10.00 fractional pts 
In From Left: 01,06 picas & points 

For now, this is the only tag you need to change. 
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Change attribute overrides 
There's one more small detail to complete in the style section. 
You will change the size of the small text (small caps) at
tribute with the Attribute Overrides option. 

m Go to page five. 

The lead-in heads you see on the page (for example, TYPE 
STYLES) were created in Text mode by applying the small 
(capitals) attribute. You can customize the size of the small 
caps attribute and apply it to selected words throughout the 
document. Let's say you wanted to change all the lead-in 
heads from 12 points to 14 points. Normally, you would have 
to scan the document for every occurrence of the lead-in head, 
and change its font to 14 points using Set Font from the 
Side-Bar (Text mode). However, there's an easier method. 
Select the Attribute Overrides option from the Paragraph 
menu and change the default size of the small text attribute. 
Now every occurrence of small text throughout the document 
automatically changes size. 

Tryout this feature for yourself. 

E In Paragraph mode, select the Body Text paragraph that 
includes the small text lead-in head, "TYPE STYLES." 
(Figure 8-15) 

Figure 8-15. 

, typ~~1tm,ft 1 
: Iyp~ siz~ are sp~cified in points as ~xplained above,: 
!y ou must uroierstand the point systm to give correc~ 
instructiOl1s to th~ software, Many peopl~ rehr to small: 
~p~inthe9to 12 point nnge as "oody type, larg~rsiz~~ 
, ed f h d' 'ft ailed 'Hi I ' • I :It 

YPE STYLES Most desktop publishing progmus USE 

'ypeface aro typestyle synonymously to mean one par
icular typedeslgTL Each deSIgn has a name HelveHca IS 
me typestyle, Century Schoolbook IS another; am so on 
o choose a different design hom the page layout pro

,ram, the user s eciheSJI bv name or licks lIs nam" fron, 
,mEnu l' 
: A font is one particular nriety of a typestyle, Ihus~ 
~ost soflware manuals would refer 10 Dulch as a types-l 
Me and 12-poinl Dutch bold italic is a font, Most. 

~~~,~~~,,~!.~,~~~,?~~~,~,~~~,.~~~~.~~.~~.:-:-:~~.~:'.~~.~ 

g Select Attribute Overrides from the Paragraph menu. 
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m Move to the Small Caps Size line and enter 011 points. 
Then click OK. 

"Body Text" ATTRIBUTE OIJERRIDES m 
Line Width: Text-Wide 

Overscore Height: 011.66 Shift t By: 11.94 fractional pts 
Strike-Thru Height: B9.66 93.72 

Underline 1 Height: 139.24 Shift ~ By: 92.52 
Underline 2 Height: 99.66 92.94 

Superscript Size: 9113 Shift t By: 95.64 
Subscript Size: 13113 Shift ~ By: 91.32 

Snall Cap Size: 911\ points 

~ I Cancel I 

Now every occurence of the small text attribute throughout 
the document changes to 11 points. 

Stopping point 
You've reached the stopping point for this chapter. We know 
that we're packing a lot of information into one chapter. Stick 
with us. The next section includes some powerful, valuable 
Ventura features. If you're tired, get up from your desk, 
stretch, and come back when you're refreshed. 

Place the STABLE.TXT file 
If you are continuing after a break, load Ventura and open the 
chapter BBOOK.CHP and go to page four. 

You have finished formattIng the BBOOK.TXT file. Now you 
are ready to place and tag the second text file, BTABLE.TXT. 
To format this file you will use a technique called side-by-side 
paragraphs (what the Ventura manual calls vertical tabs). It's 
a complicated procedure but extremely powerful. Even if it 
seems a bit confusing, try to stick it out to the end of the 
exercise. 
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-NOTE: If you do not use tables in your documents, skip this 
section and go directly to the chapter section. However, if you 
use tables of any kind, we recommend that you learn side-by
side paragraphs. 

Before you place the text, insert a new frame to contain it. 

II Go to page four. 

m Reset the zero point to its original position at the upper left 
corner of the Page by clicking on the 0,0 square in the upper 
left corner of the page. 

~ Enable Frame mode and select Add New Frame. Add a new 
frame that measures 22,06 picas & points wide by 17,06 
picas & points high. Place the upper left corner of the frame 
at position 28,00 picas on the vertical ruler. Stretch the 
frame downwards to position 45,06 picas and over next to 
the right column. The frame will extend slightly below the 
bottom column guide (Figure 8-16). 

Figure 8·16. 

- NOTE: You may want to Turn Column Snap and Line Snap Off 
to help you place the frame. 

mUse Sizing & Scaling to confirm that the frame measures 
22,06 picas & points by 17,06 picas & points. 

Before closing the Sizing & Scaling dialog box, add vertical 
padding to the frame. 
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m Sizing & 
Scaling 

Vertical Padding: 07.00 fractional pts 

Now add a box around the frame. 

m Ruling Box 
Around 

Width: Frame 
Height of Rule 1: 00.05 fractional pts 

Give the frame its own margins. 

m Margins & Number of Columns: 1 
Columns Top: 01,00 picas & points 

Bottom: 01,00 picas & points 
Left: 01,00 picas & points 
Right: 01,00 picas & points 

~ With the frame still selected, place the text file, 
STABLE.TXT, by selecting it from the Assignment List. 

-NOTE: You will not see the entire text file when you first place 
it in the frame. Do not be concerned. Later, when you tag the 
text, it will become visible. 

Create a table 
There are several ways to create tables in Ventura. You can 
use tab settings; you can use Box Text; or you can use the 
technique referred to as vertical tabs in the Reference Guide. 
In this chapter you will learn the vertical tabs method, which 
we prefer to call side-by-side paragraphs. 

We will start by reviewing the process and showing examples. 
Then we will give you a chance to try it yourself. 

To use side-by-side paragraphs, you must do two things. First 
you must properly format the text file. Second, you create a 
separate tag for each column. 

-NOTE: As a general rule, use tab settings when each table 
entry is only a single line. For tables with multi-line entries, it is 
easier to use side-by-side paragraphs, which allows each 
column to have more than one line. 
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Preparing text for side-by-side paragraphs 
To prepare text for side-by-side paragraphs, type each column 
entry as a separate paragraph. The text file you just loaded 
(8TABLE.TXT) is already in the proper format. Do not enter a 
tab stop at the end of an entry. Figure 8-17 shows what the 
text file looks like before loading it into Ventura. 

Figure 8-17. 

Once you create, load, and place the text, you are ready to 
create the tags for each column. 

Spacing with side-by-side paragraphs 
Spacing and Breaks are the two keys to building columns with 
vertical tabs. With In From Left and In from Right Spacing 
you restrict the text to individual columns (Figure 8-18). 

The hard part is calculating the column settings. Start by 
deciding the width of the columns and gutters. In the example 
you will build for this project, we divided the space into three 
equal columns of 07,06 picas & points. Once you know these 
widths, you must translate them into settings for In From Left 
and In From Right. To figure these settings, subtract the 
cumulative column widths from the margins (Figure 8-19). 
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Column In From Righ Column 16,00 picas 
1 1 

In From Left Column In From Righ o 6,00 picas Column 06,00 picas 
2 2 

In From Left Column 16,00 picas Column 
3 3 

Figure 8-18. Figure 8-19. 

Breaks with side-by-side paragraphs 
After using Spacing to confine the text to columns, move to 
Breaks. Change the line breaks to allow all three column tags 
to co-exist on the same line. In the example below, the left 
col umn has a line break before; the center column has no line 
breaks; and the right column has a line break after. Now that 
we've reviewed the key concepts, you are ready to go ahead 
and create the table. 

Add the tag for the first column 
At this point, you will create the tags for all three columns. 

~ Enable Paragraph mode. 

~ Select the paragraph "Inches." 

m Add New Tag 

m Font 

Tag Name to Add: Tbl3Coil 

Face: Helvetica 
Style: Normal 
Size: 010.0 points 
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~ Alignment Horz. Alignment: Center 
Overall Width: Column-Wide 
In/Outdent Width: 00,00 picas & points 

lm Spacing Above: 06.00 fractional pts 
Inter-Line: 12.00 fractional pts 
Add in Above: When Not at Column Top 

Do not close the dialog box yet. You will now create a tem
porary right margin with In From Right Spacing. 

m Make the In From Left Spacing 00,00 picas & points and 
the In From Right Spacing 16,00 picas & points. 

"TbI3CoI1" SPACIHG 

Aboye: 06.001 fractional pts 
Below: 00.00 

Inter-Line: 12.00 fractional pts 
Inter-Paragraph: 00.00 

II] 

Add in Aboye: I Always I ~Jhen Hot at Colunm Top 

Settings For: '"I';g5 I Right Page I 
In FroM Left: 00,00 picas & points 

In FroM Right: 16,00 

Inserts: I Copy To Facing Page I 

I Cancel I 

You just completed the first column. Now create the other two 
tags. You can use the Tb13Col1 tag as a starting point for 
building the second and third column tags. 

m Select the paragraphs ''Picas and Points" and "Points" and 
tag them as Tb13Col1. 

Now change the attributes of both tags. 

Add the Tbl3Col2 tag 
m Select the paragraph "Picas and Points." 

~ Add New Tag 

~ Spacing 

Tag Name to Add: Tb13Co12 

In From Left: 06,00 picas & points 
In From Right: 06,00 picas & points 



Add the Tbl3Col3 tag 8 - 31 

The In From Left Spacing and the In From Right Spacing 
create a temporary left and right margin to restrict the text to 
the center of the page. 

m Breaks Line Break: No 

Add the Tbl3Col3 tag 
Finally, create the tag for the third column. 

m Select the paragraph "Points." 

m Add New Tag 

~ Spacing 

m Breaks 

Tag Name to Add: Tbl3Col3 

In From Left: 16,00 picas & points 
In From Right: 00,00 picas & points 

Line Break: Mter 

Now that you've created the tags for all three columns, you're 
ready to apply them to the rest of the paragraphs in the text 
file. Use Figure 8-20 as your guide to tag the rest of the table. 

Picas and Points Points 

01.00 picas a points 12 points 

1/4 inch 01.06 picas a points 18 points 

1/3 inch 02.00 picas a points 4 points 

1/2 inch 03,00 piCas a points 36 points 

1 inch 06,00 picas a points 72 points 

51/2inches 33,00 picas 8. points 

81/2inches 51.00 picas a points 

11 inches 66,00 picas 8. points 

Figure 8-20. 

To put the final touches on the table, make the column head
ings bold. 

m Enable Text mode. 

~ Select each column heading ("Inches," "Picas and Points," 
and "Points") in turn and make it bold. 
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Pictures 

Chapter 

Pictures 

Congratulations. You made it through one of Ventura's most 
difficult and most useful techniques. Your reward awaits you 
in the next section. 

Since you will not be placing any pictures in this sam pIe 
project, proceed directly to the Chapter section. 

So far you have formatted the text and inserted index entries. 
You are now ready to advance to the Chapter section, where 
you will generate a table of contents (TOC) and an index. To do 
either function, you must first make a publication. The publi
cation would normally include all the chapters in the book. 
For this example, you will include only two chapters: Chapter 
Six, which you completed above, and Chapter Seven, a fully
formatted sample chapter from the Power disk (or typed in 
from Appendix A). 

Prepare for the pu blication 
Before you generate a TOC or index, you must update the 
page and chapte~ counters for every chapter in the publica
tion. If you were to omit this step, the page numbers in the 
TOC and index would be incorrect. 

Add a page to Chapter Six 
Now you will go to the end of Chapter Six (8BOOK.CHP) to 
find the last page number in the chapter . 

.. TIP: When Ventura updates the page number, it displays the 
new number in the header or footer, not in the Side-Bar. 

~ Press the End key to go to the last page in the chapter. 

Note that the page number is 107 and that it is a right-handed 
page. Traditionally, book chapters start on a right-hand page. 
Therefore, to start the next chapter (Chapter Seven) on a right 
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page, you will insert a blank left page as a "spacer" page at the 
end of the Chapter Six. 

~ Insert! Operation: Insert Page After Current 
Remove Page Page 

Now, the last page reads as 108. Chapter Seven will start on 
the right-hand page number 109. 

Save the chapter. 

~ Press Ctrl-S. 

11 Open Chapter Seven (if you have the Power disk) 
Now you will change the starting page number of Chapter 
Seven. 

~ Select Open Chapter from the File menu and open the 
chapter C:\POWER\8PRINT.CHP. 

~ Save the text file as C:\TEMP\8PRINT.TXT. 

~ Load the style sheet C: \ TEMP\8BOOK.STY. 

~ Save the chapter as C:\TEMP\8PRINT.CHP. 

Open Chapter Seven (if you do not have the disk) 
~ Load the text file 8PRINT.TXT from the C:\TEMP sub

directory. 

~ Load the style sheet 8BOOK.STY from the C: \ TEMP sub
directory. 

~ Save the chapter as C:\TEMP\8PRINT.CHP. 

Update the chapter counter 
Now update the chapter counter to make the header read 
"Chapter 7". 

~ Select Update Counters from the Chapter menu. 
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m Select Which Counter: Chapter, Update Method: Previous 
Number + 1, Number Format: 1,2. Do not close the dialog 
box until you also update the page counter. 

lPDATE COUNTERS m 
~ich Counter: eM I This Page I LIi.~A~:.:.I~;.i:~I!i] r..:.IEr~;~IIjj~~~~] 

I Initial Page II Initial Table II Initial Figure I 
Update Method: I Restart NulJlber I Previous Nlllllber + 1 

timber Format: 112 

Update the page counter 
Mter setting the chapter number, reset the first page of the 
chapter. 

~ Select Which Counter: Initial Page, Update Method: Pre
vious Number + 1, Number Format: 1,2. Click OK to close 
the dialog box. 

When you select the initial page counter, Ventura resets the 
first page of the chapter as you specified in the update 
method. By selecting Update Method: Previous Number + 1, 
Ventura makes the first page of Chapter Seven start one page 
after the last page of Chapter Six. The header will not reflect 
the new page and chapter counters until later, when you 
renumber the publication in the Multi-Chapter dialog box. 

Save Chapter Seven before continuing on. 

m Press Ctrl-S. 

Create a publication 
To create the publication, you will use the Multi-Chapter 
dialog box in the Options menu. 
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m Select Multi-Chapter from the Options menu. 

m Select New to start a new publication. 

m Select Add Chapter. 

~ Select the chapter C:\ TEMP\8PRINT.CHP. 

"ULTI-CHAPTER OPERATIONS 

~m!!~!!~!!l!!~!!~mii~!!~!!l!!~!! C: \POW ER \ UN T IT LED . PUB l!!!l!!~!!~!!l!!~H~!!l!!~!!~!!:!!§! 
t C:\TEMP\8PRINT.CHP 

f--

-

• 

New 
Open 
t:l(.).~I~ 

Save ... 
Save As ••• 

Add Chapter' .•. 
HeI"lINt': £:hlJp 

P!'.int ... 
\·II.lkl': Hle: ••• 
I-II.l!{e [Ildex ••• 
HellUAht~I' ••• 
G(.lI-lV All ••• 

I Done 

Now add the second chapter to the list. 

m Select Add Chapter. 
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~ Select the chapter, 8BOOK.CHP, from the C:\TEMP sub
directory. 

The chapter name 8BOOK.CHP is the second item in the list. 

Rearrange the chapter list 
Before saving the publication, you will practice rearranging 
the chapters in the list so that 8BOOK.CHP (Chapter Six) is 
first and 8PRINT.CHP (Chapter Seven) is second. 

m Press and hold down the mouse button over 8BOOK.CHP 
until you see the hand cursor appear. Now drag the 
filename to the top of the list and release the button (see
Figure 8-21). 

Before you save the publication, make sure that none of the 
names are highlighted. Otherwise, Ventura will save only that 
chapter. 
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HUl TI • CHAPTER lPERATIONS 

Figure 8·21. 

New 
Open 
I::l{.lst~ 

Save ••• 
Save As ... 

Add Chapter ••• 
Reflloye Chap 

PI'.lnt .•. 
H(.\I<t~ 'W(:, .. 
I-!(.\l<t~ [ndm( •• , 
Hf.mIJAht~I', , , 
Copy All ... 

~ Select Save As from the dialog box. 

Chapter 

m The Item Selector appears. Use the Backup button to locate 
the C: \ TEMP subdirectory if necessary. On the Selection 
line type the name of the publication: 8BOOK. PUB and click 
OK. Ventura returns you to the Multi-Chapter dialog box. 

Renumber the publication 
Mter making the publication, you can renumber the chapter 
and page counters for every chapter in the publication. This 
will generate the correct page numbers in both the Index and 
the TOC . 

.. NOTE: Make sure that none of the chapter names are high
lighted. Otherwise, Ventura will not let you renumber the publi
cation. 

m While you are in the Multi-Chapter dialog box, choose 
Renumber. When asked if you want to renumber chapters, 
pages, tables, and figures across the entire publication, 
choose Renumber. Ventura displays a message that it is 
renumbering the publication. 

Generate a table of contents 
Now you are ready to generate the TOC. A table of contents 
provides an outline of a book's major topics and sub-topics, 
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along with their page numbers. Ventura generates a TOC in 
two steps. First, it searches the publication for the tag names 
you specify. Second, it generates a text file that shows each 
instance of those tags and the page on which they appear. 

The generated TOC text file can be loaded and formatted like 
any other text file. Ventura assigns the different levels of the 
TOC a generated tag. For example, Level One is tagged as 
Z_TOC LVL 1, level two is Z_TOC LVL 2, etc. As with other 
generated tags, you can change the attributes of the tags to 
achieve the desired effect . 

• While still in Multi-Chapter, select Make TOC. 

HUL TI -CHAPTER (lJERATIOtt8 m 
!!i~11!!!!hl!~i!!!!!~!!!!!m!!!il!!!!~ C: \ TEMP\OBOIl< • PUB ffi!!!!!!!!!!!!!!1!!!!!1!!!!!!!!1!!1!!!!!!! New 

c:~ TEI'IP\8BOO< .CHP Open 
~ C:\ TEI'IP\8PRItiT .CHP .I:::~~~~~ ........ . 

-, 

Sav~}, .• 
Save As ••• 

Add Chapter ••• 
H~~Mve {:hl.~p 

Print ... 
1DF.l~1I 

Make Index ••• ~ 
Renunber .•• 
Copy All ••• 

I Done 

.. TIP: You cannot select the Make TOe option if a single chapter 
is highlighted. 

'The Generate Table of Contents dialog box appears. Notice 
that the name of the current publication is displayed next to 
TOC File except that the last three letters have been changed 
to TOC and the file extension to GEN. This is the default 
name that Ventura assigns to a generated TOC file. Although 
you can change the name of this file, we suggest that you not 
change the three-letter extension GEN. 

WARNING: Make sure that the TOe File line reads e:\TEMP\8BOOKTOe.GEN. If a 
different subdirectory name is displayed, press Esc to clear the line and type in 
C:\ TEMP\8BOOKTOe.GEN. 
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For this project, you will not change the Title String that tells 
Ventura to display the words "Table of Contents" at the top of 
the page. You will, however, make additions to the other levels 
of the TOC. 

= Place the text cursor next to the Level lline and select the 
Inserts: Text Attr. button at the bottom of the dialog box. 

The bracket code <D> appears on the line. 

1m Delete the D and replace it with the letter B. 

The bracket code <B> turns on the Bold text attribute. 

~ Move the cursor past the right bracket and choose the 
Inserts: Chapter # button. 

The bracket code [C#] appears on the line. 

The [C#] code tells Ventura to display the number of the 
chapter. 

~ Now choose Inserts: Tab from the bottom of the dialog box. 

The tab symbol appears on the line. The tab separates the 
chapter number from the next tag name. 

~ Choose Inserts: Tag Text. The code [*tag name] appears on 
the line. Delete the words "tag name." Type in: ChapTi tle 
within the brackets. 

[*ChapTitle] tells Ventura to scan for all occurrences of the tag 
ChapTitle and to list them as levell entries in the TOC. 

1m Move the cursor past the right bracket and choose Inserts: 
Tab. 

The tab separates the entry from the page number that fol
lows. Later in this chapter you will use this tab setting to 
create leader dots between the entries and the page numbers. 

~ Choose Inserts: Page # 

The [P#] code tells Ventura to display the page number on 
which it found this occurrence of the tag you indicated. 

t1 Choose Inserts: Text Attr. 

The bracket code <D> appears on the line. <D> turns off the 
Bold text attribute and returns the font to normal. 
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When the TOe is generated and formatted the first level will 
look similar to Figure 8-22: 

Figure 8-22. 

..................................................................................... 

Table of Contents 
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Insert the codes for second and third levels 
Place the text cursor on the Level 2 and Level 3 lines and type 
in the codes shown in Figure 8-23. Use the buttons at the 
bottom of the dialog box as shortcuts. 

GENERATE TABLE OF CONTENTS 

TOC File: C:\ TEtf>\8BOOKTOC .GEN, ______ _ 
Title String: Table of Contents.~~~.,--___ _ 

Level 1: <B}[Cl:tl+[ttChapTitle]+(Pl:tl(D} ____ _ 
level 2: [*Head11+[P#1,--________ _ 
level 3: [*Heacl21+[P#11-! ________ _ 
Level 4: 
Level 5: 
level 6: 
level 7: 
Level 8: 
level 9: 

Level 19: 

Inserts: I Tag Text I IJ!E] I Chapter I:t I I Page I:t I 
I Text Attr. I 

Figure 8·23. 

m Generate the TOe by clicking the OK button. 
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Ventura displays a message that it is generating the TOC text 
file and shows which chapter files it is scanning. When the 
TOC is finished, you return to the Multi-Chapter dialog box. 
Later you will format this file. For the moment, complete the 
last Multi-Chapter operation. 

Generate an index 
Do you remember the index entries you inserted into the text 
file? Ventura will generate its index based on those references 
(plus some extras we inserted for you in advance). Once the 
index is complete, you will load and format both the index and 
the TOC generated files. 

~ With the Multi-Chapter dialog box still open, select Make 
Index from the Multi-Chapter Side-Bar. 

The Generate Index dialog box appears on the screen. On the 
Index File line Ventura displays the current publication name 
with the last three letters changed to IDX and the extension 
changed to GEN. Do not change this file name extension. 

WARNING: If a different subdirectory name is displayed, change the TOC File line to 
read C:\TEMP\8BOOKIDX.GEN. 

Leave the Title String line as "Index." This tells Ventura to 
display the word "Index" as the heading for the index. 

~ Choose Letter Headings: On. 

When you turn Letter Headings on, you instruct Ventura to 
place an A before the entries starting with A, a B before the B 
index entries, and so forth. 

R Move the cursor to the For Each # line and delete both 
occurrences of the [C#] code and the hyphen (do not delete 
the hyphen between the page number [P#] codes). This tells 
Ventura to display only the page numbers in the completed 
index, not the chapter numbers (Figure 8-24). 

~ Choose OK to generate the index. 

During index generation, Ventura locates the index refer
ences, and builds them into a sorted list with the correspond
ing page numbers. Mter each entry, Ventura inserts a line 
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GENERATE IHDEK 

Index File: C:\TEHP\9BOOKII»(.GEH ______ _ 

Title String: [ndex, __________ _ 

Letter Headings: On 

Before I:ts: .::-:-:-:-~~---------
For Each '*: [P'*J - [pI:IJII--_______ _ 
Between I:ts: J ___________ _ 

After I:Is: 
"See ": See __________ _ 

''See Also": See also _________ _ 

Inserts: ~ I Chapter '* I I Page 1:1 I I Text Attr. I 

Figure 8·24. 

break and a horizontal tab character. After the last entry of a 
letter heading, Ventura inserts a paragraph return. 

The index contains three generated tags: Z_INDEX TITLE, 
Z_INDEX LTR, and Z_INDEX MAIN. Later in this chapter 
you will change the attributes of these generated tags. 

After generating the index, Ventura returns you to the Multi
Chapter dialog box. 

11 Choose Done to exit the Multi-Chapter dialog box. 

m If Ventura asks, choose Save to save the changes you made 
to the publication. 

Format the TOe and the index 
This is a good place to pause and remind ourselves where 
we've been and where we are headed. At this point, you have 
used Ventura to generate "raw" text files. By searching the 
chapter, Ventura was able to find and insert the page numbers 
where each entry can be found. 

With that work out of the way, you can load and format the 
TOC and the Index text files. You will create them as two 
separate chapters using the same style sheet (8BOOK.STY). 
Begin with the table of contents. 
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-NOTE: If you are in a hurry, you can skip over this formatting 
section, since it does not introduce any new skills. However, 
we suggest you read over it, if you plan to do TOGs and 
indexes of your own. For instance, because of the way Ven
tura outputs the index file, you must use Tab Settings to create 
the proper indents. 

Start a new chapter 
Since you are using the same style sheet, you can simply 
"empty out" the current workspace by choosing New from the 
File menu. 

m Select New from the File menu. 

The screen is emptied of text, but Ventura retains the current 
8BOOK.STY style sheet. 

m Enable Frame mode and select the Page. 

m Select Load TextlPicture from the File menu. Select Type of 
File: Text, Text Format: Generated, # of Files: One, and 
Destination: List of Files. 

WARNING: Be sure to select Text Format: Generated rather than ASCII. 

LOAD TEXT/PICTURE m 
Type of File: _I Line-Art I I IJilage I 
Text ForJllat: Iclmllmmlll I ASCII I I WordStar 3 I IIfS 4.8/5.0 I 

I MS-Word I I WordPerfect I I Xyifrite I I B-Bit ASCII I 

I DCR I I MultiHate I I PRN-to' Table I IlfordPerFect 5 

Ilfl'itel' I 

1:1 of Files: .. I Several I 
Destination : Imlllllll I Text Clipboard I LJ!~~f.l[~~:.~;.i:;EJ 

~ I Cancel I 

m Use the Backup button to locate the C:\ TEMP subdirec
tory. Then load the text file 8BOOKTOC.GEN and place it 
on the Page. . 
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m Select Save As to save the chapter as C:\TEMP\BOOK
TOC.CHP. 

Change the Z_TOC TITLE tag 
You will change the text attributes of the generated tags in the 
TOC. Start with the title. 

m Enable Paragraph mode. 

~ Select the paragraph "Table of Contents." (Notice the tag 
name Z_TOC TITLE in the Current Selection Box.) 

~ Font Style: Bold 
Size: 024.0 points 

m Alignment Horz. Alignment: Center 
In/Outdent Width: 00,00 picas & points 

m Spacing Above: 28.00 fractional pts 
Below: 56.00 fractional pts 
Inter-Line: 28.00 fractional pts 

m Breaks Page Break: BeforelUntil Right 

Selecting BeforefUntil Right forces the TOC to start on a 
right-hand page, the traditional placement in books. When 
you are finished, the title should look like Figure 8-25: 

................................................................................. 

Table of Contents! 

j 6oDesignPrinciplest9711 
: D~gn T emllnology+97ft 
1 DescriblrrgPages<98S 
1 MeasuringPages<99ft 
: DescriblrrgType+l0lft 

Figure 8-25. 
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Change the Z_ TOC LVL 1 tag 
fi Select the paragraph "6 Design Principles97." 

m Alignment Horz. Alignment: Left 
In/Outdent Width: 00,06 picas & points 

m Spacing Above: 28.00 fractional pts 
Below: 07.00 fractional pts 
Inter-Line: 14.00 fractional pts 
Add in Above: When Not at Column Top 

You will now use tab settings to position the text across the 
page, as shown in Figure 8-26. 

Ii Tab Settings Tab Number: 1 
Tab Type: Left 
Tab Shown As: Open Space 
Tab Location: 02,00 picas & points 

Tab Number: 2 
Tab Type: Right 
Tab Shown As: Open Space 
Tab Location: 21,09 picas & points 

..................................................................................... 
: : 
: : 

I Table of Contents' , 

i 6+ DesignPrincipl~ W 

1 Dt>SignTerminologyt97ft 
l DescribingPagesf98ft 
: MeasuringPages<99ft 

Figure 8-26. 

Change the Z_TOC LVL 2 tag 
Ii Select the paragraph "Design Terminology97." 
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II Alignment 

m Spacing 

II Tab Settings 

Change the Z_TOC LVL 3 tag 
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Horz. Alignment: Left 
In/Outdent Width: 02,00 picas & points 

Add in Above: When Not at Column Top 

Tab Number: 1 
Tab Type: Right 
Tab Shown As: Leader Char 
Tab Location: 21,09 picas & points 
Leader Char: ... 
Leader Spacing: 3 

II Select the paragraph "Describing Pages98." 

~ Alignment Horz. Alignment: Left 

II Spacing 

m Tab Settings 

Apply the tags 

In/Outdent Width: 04,00 picas & points 

Add in Above: When Not At Column Top 

Tab Number: 1 
Tab Type: Right 
Tab Shown As: Leader Char 
Tab Location: 21,09 picas & points 
Leader Char: ... 
Leader Spacing: 3 

When you are finished, the table of contents should look like 
Figure 8-27: 

Congratulations on completing your first table of contents. 
Now save your work. 

II Press Ctrl-S 

~ Select New from the File menu to create a new chapter for 
the index. Load the generated file 8BOOKlDX.GEN from 
the C:\TEMP subdirectory and place it on the Page. Save 
the chapter as C:\TEMP\8BOOKIDX.CHP. With the text 
file loaded, you're ready to change the tags. 
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Change the Z_INDEX TITLE tag 
m Enable Paragraph mode. Select the title "Index" at the top 

of the page. 

m Font 

m Alignment 

II Spacing 

m Ruling Line 
Below 

Style: Bold 
Size: 024.0 points 

Horz. Alignment: Left 
In/Outdent Width: 00,00 picas & points 

Above: 28.00 fractional pts 
Below: 28.00 fractional pts 
Inter-Line: 21.00 fractional pts 

Width: Column 
Color: Black 
Pattern: Solid 
Space Above Rule 1: 02.00 fractional pts 
Height of Rule 1: 00.25 fractional pts 
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"Z_IHDEX TITLE" RULING LINES BELOit 

Itidth: Colutln 
Color: Black 

Pattern: Solid 
Dashes: Off 

m 

]36 .. , 
Space AboYe Rule 1: lI2 • 00 

Height of Rule 1: lIB.251 Custom Indent: 00.00 L:,~~'.1 [:':.:.1 
Space Below Rule 1: lIB.OO Custo" Width: 00.00 

Height of Rule 2: liB. 00 
Space Below Rule 2: lIB.OO Dash Width: 00.00 

Height of Rule 3: ee.DB Dash Spacing: 00.00 fractional pts 

Space Below Rule 3: liB. 00 • c::::J 
Overall Height: 82 . 25 

Change the Z_INDEX LTR tag 
~ Select the letter "A" at the top of the page. 

11 Font Style: Bold 
Size: 018.0 points 

11 Alignment Horz. Alignment: Left 
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In/Outdent Width: 00,00 picas & points 

~ Spacing: Above: 14.00 fractional pts 
Below: 14.00 fractional pts 
Add in Above: When Not at Column Top 

~ Breaks Keep With Next: Yes 

The Keep With Next option makes sure the letter heading is 
not isolated from the index entries that follow it. 

~ Ruling Line 
Below 

Width: Custom 
Pattern: Solid 
Space Above Rule 1: 02.00 fractional pts 
Height of Rule 1: 00.25 fractional pts 
Custom Width: (+) 48.00 fractional pts 
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"Z_IHDEI< LTR" RULIHG LIHES BElOW 

Width: CustoM 
Color: Black 

Pattern: Solid 
Dashes: Off 

m 

]36.00 
Space AboYe Rule 1: 82.00 

Height of Rule 1: 80.25 CustOM Indent: DB.oo a c:J 
Space Below Rule 1: 00.00 Custo" Width: 40.001 

Height of Rule 2: DO .00 
Space Below Rule 2: 09.00 Dash Width: 00.00 

Height of Rule 3: 09.00 Dash Spacing: 00.00 fractional pts 

Space Below Rule 3: 00.00 a c::J 
Overall Height: 02.25 

Chapter 

Change the Z_INDEX MAIN tag 
The rest of text is tagged Z_INDEX MAIN. Primary and 
Secondary entries are positioned with horizontal tabs. 

m Select the first index entry that begins "Advertising." 

m Font Size: 010.0 points 

m Alignment Horz. Alignment: Left 

m Spacing 

m Tab Settings 

In/Outdent Width: 00,00 picas & points 

Add in Above: When Not at Column Top 

Tab Number: 1 
Tab. Type: Left 
Tab Shown As: Open Space 
Tab Location: 00,00 picas & points 

Tab Number: 2 
Tab Type: Left 
Tab Shown As: Open Space 
Tab Location: 01,06 picas & points 

Tab Number: 3 
Tab Type: Right 
Tab Shown As: Leader Char 
Tab Location: 22,06 picas & points 
Leader Char: ... 
Leader Spacing: 3 

The screen should look like Figure 8-28. 
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When you have completed the changes to the index tags, save 
the chapter. 

II Press Ctrl-S. 

Print the publication 
Now that you've created the TOC, the index and two sample 
chapters, you are ready to print them. First, add the TOC and 
the index to the C: \ TEMP\8BOOK.PUB publication. 

II While still in BOOKIDX.CHP, select Multi-Chapter from 
the Options menu. 

~ Open the C: \ TEMP\8BOOK.PUB publication if it is not 
already open. Select Add Chapter and then choose 
C: \ TEMP\8BOOKTOC.CHP. 

9 Select Add Chapter, and then choose the chapter 
C: \ TEMP\8BOOKIDX.CHP. 

Organize the book chapters by moving the TOC chapter to the 
top of the list. 

~ Drag C:\TEMP\8BOOKTOC.CHP to the top of the publi
cation list. 

~ Make sure none of the files are highlighted. 

II Select Save As to save this publication under the name 
C: \ TEMP \ 8B OOK.PUB. 
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When Ventura asks you if you want to overwrite the existing 
publication, choose Overwrite. 

Leave the Multi-Chapter dialog box open for printing. 

Print crop marks 
Now you will print out all the chapters listed in the publica
tion using the Print function found in the Multi-Chapter 
dialog box. This time you will tell Ventura to print crop marks. 
Ventura is able to print crop marks as long as they reside 
within the live area of the printer (the area of the page on 
which the printer can actually produce marks). Almost all 
laser printers can show crop marks that fall inside a 7xlO in. 
area . 

.. TIP: To find out the exact live area of your printer, print out the 
sample chapter CAPABILI. CHP in the \ TYPESET subdirec
tory. 

00 To Print Which Pages: All 
Crop Marks: On 

Ventura prints out each chapter of the publication in order . 

.. NOTE: This project contains more than 30 pages. It will take 
longer to print than other, shorter sample chapters in this book. 

Tips and techniques 

Book tips 

D The last thing you must do before generating an index and 
TOC, is to udpate the chapter and page numbers in every 
chapter included in the publication. Use Update Counters 
from the Chapter menu to reset the numbering in the 
correct sequence. 

D If you want each chapter to start on a right-hand page (as 
is traditional), check that the preceding chapter ends on a 
I eft-hand page. If not, insert a blank left-hand page at the 
end of the preceding chapter. 
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D Changing page numbers with Update Counters (Chapter 
menu) does not affect the page numbers shown at the bot
tom of the Side-Bar. 

D Some publishers use a single style sheet for the whole book. 
Others create a separate style sheet for each section. Al
though Version 2 of Ventura automatically numbers pages 
sequentially across chapters, it may be tempting to put the 
entire book in one large chapter file. In practice, very large 
chapters can lead to crashes or other problems, especially, if 
there are many pictures involved. 

D Putting the entire book into one chapter file also makes it 
difficult to work in groups. When one person is busy with 
the one and only file, no one else can work on it. For easier 
access and manageability, most books should have separate 
Ventura chapters for every book chapter. 

Table tips 

D Generally, it's best to use tab settings when creating a table 
with single-line entries. For tables with multiple-line 
entries it is easier to use side-by-side paragraphs which 
allow each column to have more than one line. 

D To prepare text for side-by-side paragraphs, make sure you 
enter each table entry as a single line. Enter a carriage 
return instead of a tab at the end of each line. 

D Spacing and Breaks are the key to creating a table. Use In 
From Left and In From Right spacing to restrict text to 
individual columns. Use Breaks to allow multiple tags to 
reside on the same'line. 

Footnote and index tips 

D The footnote separator line is measured from the left edge 
of the page, not from the margin. Only the portion inside 
the margin actually prints. Suppose, for example, that you 
have a five-pica margin. If you wanted a three-pica 
separator line, you would enter a Separator Line Width of 
eight picas (5 + 3 = 8). Only the three-pica portion that is 
inside the margin would print. 
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D If you cannot see the symbols which marks footnotes, 
anchors and index entries, choose Show Tabs & Returns 
from the Options menu. 

D Footnotes occupy a special frame created by Ventura. You 
can change the margins inside this frame, but you cannot 
change the size of the frame. 

D You can insert footnotes, anchors and index entries directly 
into word processing files using the following bracket codes: 
Footnote: <$Ftext> 
Anchor (same page): <$&Anchor name> 
Anchor (below): <$&Anchor name[v]> 
Anchor (above): <$&Anchor name[I\]> 
Fraction: <$Enumerator/denominator> 
Fraction: <$Enumerator over denominator> 
Index: <$IPrimary; Secondary> 

D Indexes and tables of contents are created with Multi
Chapter from the Options menu. 





Chapter Nine 
Skills Checklist 

Theory 
o Technical illustrations for desktop 

publishing 
o Importing AutoCAD drawings into 

Ventura 

Text 
o Assigning tags in Text mode 

o Creating empty paragraphs 

Style 
o How to format numbered lists 
o Adding a page break tag 

o A double rule effect with ruling line 
above 

o A special note tag with ruling box 
around 

o Adding space with a tag 

o Adding spot color to page elements 

Picture 
o Attaching callouts to illustrations 

o Anchoring frames to text references 

o Automatic figure numbering in 
captions 

Chapter 
o Printing spot color overlays 



Chapter Nine 

A Technical Manual 

Theory 

Modern industry has produced a new generation of pub
lishers, writers, and designers, dedicated to creating 

"user-friendly" technical manuals. These manuals are in
strumental in selling and maintaining high-tech equipment, 
from microwaves to machinery to personal computers. In this 
chapter, you will learn some special techniques for producing 
technical documentation with Ventura. The checklist on the 
left gives you an overview of the skills you will learn. 

Technical documentation is a demanding application. Conse
quently, this chapter may require more than one attempt to 
create some of the effects. If you can stick with it, however, you 
will be rewarded with hands-on know ledge of some of 
Ventura's most powerful capabilities. Before starting with the 
project, let's take a moment to examine how Ventura deals 
with technical illustrations. 

Technical illustrations 
Skip this section if you do not use illustrations from line-art 
programs, such as AutoCAD. 

As a general rule, line-art is used for technical drawings and 
illustrations because of its higher quality (see Chapter Five 
for more details on the difference between line-art and im
ages). AutoCAD is one of the most popular line-art programs. 
AutoCAD drawings can be imported into Ventura in four 
different formats (SLD, GEM, HPGL, and PostScript), three 
of which produce line-art. 
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AutoCAD Slide Files (SLD) are image files (bit-mapped 
graphics) produced by taking a "snap shot" of an AutoCAD 
screen. Their quality is only as good as the resolution of the 
screen. Consider using slide files if you have access to a 
monitor with at least a 1,024 x 960 resolution, or if you do not 
require high -quali ty images. Otherwise, you will get better 
results from line-art. 

You can import AutoCAD line drawings in three ways: in 
GEM format (via Ventura's DXFTOGEM utility), in HPGL 
format (Hewlett Packard Graphics Language), or in Encap
sualted PostScript format. 

DXFTOGEM conversion 
Ventura's conversion utility takes AutoCAD DXF files (which 
it cannot read directly) and transforms them into GEM files 
(which it can use in documents). Before using the 
DXFTOGEM conversion, you must produce a DXF drawing 
file in AutoCAD (or any other CAD program that supports the 
DXF drawing interchange format). Mter the DXF file is 
created, use the DOS copy command to copy the file to the 
C: \ VENTURA subdirectory. 

Move to the C: \ Ventura subdirectory. At the DOS prompt, 
type: 

DXFTOGEM F.ilename F.ilename 

First type the command name, followed by the AutoCAD DXF 
file name, a space, and the GEM file name, leaving off the 
three-letter extension. The DXF and the GEM file names can 
be the same or different. For example, here's the command for 
converting a DXF file named SAMPLE.DXF to a GEM file 
named CADTEST.GEM: 

DXFTOGEM SAMPLE CADTEST 

Mter creating the GEM file, copy it to the subdirectory of your 
choice . 

.. TIP: The DXFTOGEM utility is normally located in the C:\ Ven
tura subdirectory. If you cannot find it there, load it from the 
Ventura Utilities disk. 
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You may find that certain AutoCAD shapes are lost during the 
DXFTOGEM conversion. For a complete listing of shapes that 
are converted, see the Xerox Ventura Publisher Reference 
Guide. 

HPGL format 
HPGL is an alternative to the DXFTOGEM conversion. To 
create a HPGL file in AutoCAD, first configure your plotter as 
any Hewlett Packard plotter (for example, the HP 7475). Then 
plot the drawing to a file instead of to the plotter. The result
ing file has a .PLT extension. You can load this file directly 
into Ventura, by selecting Line-Art Format: HPGL in the Load 
TextlPicture dialog box. Simply change the .HPG extension to 
.PLTon the Directory line of the Item Selector before selecting 
a file. 

Encapsulated PostScript 
AutoCAD can also produce a PostScript file, that, when 
modified, can be loaded into Ventura. To create a PostScript 
file in AutoCAD, configure your plotter for the desired resolu
tion (300 dpi for a laser printer, 1270 or 2540 for a 
phototypesetter, etc.) and plot the drawing to a file instead of 
to the printer. The resulting file has a .PLT extension. Before 
you load it in Ventura, you must do two things: change the 
extension from .PLT to .EPS, and change three lines in the 
PostScript file itself. 

To encapsulate an AutoCAD PostScript plot file, you will need 
to edit the file with an ASCII text editor. Begin by recording 
the four sets of numbers on the the bounding box line that is 
second from the end of the file listing. Now delete that line. To 
the top of the file add the following three lines: 

%!PS-Adobe-2.0 EPSF -1.2 
%%BoundingBox: XX XX XXX XXX 
%%EndComments 

Substitute the numbers you recorded from the original bound
ing box line for the Xs in the second line above. Now you are 
ready to load the encapsulated file. Select Load TextlPicture 
from the File menu, and choose Line-Art and PostScript for
mat in the dialog box. 
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Planning the manual 
Whether it deals with a microwave or a microcomputer, the 
primary responsibility of a technical manual is to teach the 
user how to operate and benefit from the system. It must 
include all the technical specifications. It must also help the 
user get started, discover features, and learn both elementary 
,and advanced operations. Finally, it must help people know 
what to do when things go wrong. 

The manual you will create in this chapter includes instruc
tions for assembling and using a laser printer. Its landscape 
format provides space for three columns without crowding the 
text. The three-column format also provides flexibility for 
varying picture sizes and column combinations. On some 
pages, the left column is used for the major heading and 
nothing else. The resulting white space gives the page a more 
open, non-threatening appearance. 

Throughout the manual, lists are identified with bullets, and 
step-by-step instructions are shown with boldface section 
numbers. The instructions are slightly indented from the 
numbers to make them easy to locate on the page. The box 
around the warnings is a visual device to draw attention· to 
important material not included in the main body of text. 

The manual has two standard sizes for illustrations. Smaller 
pictures fit three across. Because they are positioned directly 
above descriptive text, they do not demand captions or cal
louts. On the other hand, a full page illustration needs a 
caption and/or callouts for clarity. 

The ''before'' and "after" illustrations show the manual in the 
planning and final stages. In addition to many of the skills you 
already have learned, you will use the following effects to 
create the technical manual: 

• Column breaks 

• Section numbers 

• Rules around table entries 

• Callouts for illustrations 

• Spot color for emphasis 
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Ventura prep 

II If you have the Power disk 
m If you are continuing from a previous chapter, select New 

from the File menu to clear the work area. 

m Load the ASCII file 9TECH.TXT from the C:\POWER sub
directory. Use File Type/Rename to save it as 
C:\TEMP\9TECHDOC.TXT. Leave the file 9TECH
DOC.TXTon the Page. 

11 Load the style sheet, 9TECH.STY from the C:\PO~R 
subdirectory and save it as C: \ TEMP\9TECHDOC.STY. 

11 Load the GEM Line-Art format files 9-LASER1.GEM, 
9LASER-2.GEM, 9LASER-3.GEM, and 9LASER-4.GEM 
from the C:\POWER subdirectory. 

m Save the chapter as C:\TEMP\9TECHDOC.CHP. 

If you do not have the Power disk 
~ Use your word processor to type in the text file 9TECH. TXT 

from Appendix A. Then save it as C:\TEMP\9TECH
DOC. TXT. 

11 Use Load TextlPicture to load and place the file 9TECH
DOC. TXT on the Page. 

11 Load the &TBL2-L1.STY style sheet from the 
C: \ TYPESET subdirectory. Change the margins and 
columns to match Figure 9-1. Use the tag table in Appendix 
B to change the tags you will need for the project. Then save 
the revised style sheet as C:\TEMP\9TECHDOC.STY. 

~ Since you do not have access to the AutoCAD drawings 
included on the Power Disk, load any four pictures to use as 
substitutes in the picture section of this chapter. 

11 Save the chapter as C:\TEMP\9TECHDOC.CHP. 



Draw crop marks 

Figure 9-1. 

Style 

14,00 picas & points 14,00 picas & points 

02,,00 picas 
& points 
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14,00 picas & points 

You will learn several powerful new functions in the style 
section of this chapter. You will start by learning a fast way to 
draw crop marks. Then you will learn about new tagging 
effects using column breaks, page breaks, and ruling lines. 
You will continue with an example of auto-numbering, a use
ful technique for technical documentation. 

Draw crop marks 
Crop marks designate the live area of the paper. For this 
document, you will draw the crop marks at each corner of the 
Page and instruct Ventura to show them on every page of the 
document. 
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-TIP: It is easier to draw crop marks if you temporarily change 
the margin settings to equal the trim size. Then you can use 
the (temporary) column guides to help you position the lines. 

m Enable Frame mode and select the Underlying Page. Select 
Margins & Columns from the Frame menu. 

~ Choose # of Columns: 1. Make the top and bottom margins 
09,00 picas & points, and the left and right margins 07,06 
picas & points (Figure 9-2). 

Top and bottom mar- fij;f'~~t--=T---
gins: 09,00 picas r···············································································1 

Left and right mar
gins: 07,06 picas 

I The Laser AstroZ~ I 
: : 
i aa",~uo.tllxyz-rr' ! 
:~ : 
~ l 

-I-+---~-+ jllillil~i~I:~~:~~:~~:~~:~~:~~:~~:~~:~~:~~:~~:~~:~~:~~!~ 
: : 
: : 
; ~ 

Figure 9-2. After you change the margins, your page should look like 
this illustration. 

Choose grid settings 
~ Make sure the zero point is reset to the upper left corner of 

the Page. (Click on the 0,0 square at the upper left corner of 
the Page.) 

m With the Page selected, enable Graphics mode. 

'm Select the line tool from the Side-Bar. 

Make the grid settings an integer multiple of the margins so 
the lines automatically snap to the margin. 

~ Grid Settings Grid Snap: On 
Horizontal Spacing: 01,06 picas & points 
Vertical Spacing: 01,06 picas & points 
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m Select the line tool again. Starting from the upper left 
corner of the column margin, draw a 03,00 pica vertical line 
(two snap-grid units) perpendicular to the horizontal 
column guide and toward the edge of the Page (Figure 9-3). 
Press the Alt key as you draw to keep the line absolutely 
straight. 

Figure 9-3. 

-.. NOTE: Don't worry if it takes you a couple of attempts to draw 
the correct line. Drawing with a mouse can be tricky. If you 
make a mistake, simply delete the line (press the Del key) and 
try again. 

Now make sure the line attributes match the following values: 

m Line Attributes Thickness: Thin 
End Styles: (Beginning and End) Square 
Defaults: Save To 

-.. TIP: If you hold down the Shift key while drawing, you can 
continue to draw lines without reselecting the line tool. 

~ Select the line tool. Starting at the upper left corner of the 
column guide draw a 03,00 pica horizontal line (two snap
grid units) perpendicular to the vertical column guide and 
toward the edge of the Page (Figure 9-4). 
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Figure 9·4. 

Repeat the steps above to create crop marks on the other three 
corners on the page. When you are finished, reset the margins 
and columns to their original values. Refer to Figure 9-5 for 
the original margin and column sizes. 

Figure 9·5. 

_ •••••••••••••••••••••••••••••• 1. .••••••••••••• : 

~.'4'00PICti 
: : 
1 '0.08 RCAS 1 : 

! i 
i I 

~ ..................... : ; ......... , ............. : : ............. ,. ....... : 

Mter drawing the crop marks, make them appear on every 
page of the document. 

~ While still in Graphic mode, choose Select All from the 
Graphic menu (or press Ctrl-Q) to select every line shape on 
the Page . 

• Select Show On All Pages from the Graphic menu. 
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Bu ild the footer 
You will complete the chapter format by building the footer. 

11 Select Headers & Footers from the Chapter menu. 

11 Choose Define: Right Page Footer, Usage: On. Move to the 
Left line and choose 1st Match. Delete the words "tag 
name" and type: Headl 

B Move to the Right line and choose Inserts: Page #. 

HEADERS & FOOTERS 

Define: I left Page Header I I Right Page Header I 
I left Page Footer I 

Usage: EI []ill 
Right Page Footer 

left: [(Head1] _____________ _ 

Center: 

Rifllt: [P1t11-1 ______________ _ 

Inserts: I Chapter It I I Page It I I 1st Match I I last Match I 
I Text Att!". I I Copy To Facing Page I 

• Choose Define: Left Page Footer, Usage: On. Move to the 
Left line and choose Inserts: Page #. Move to the Right line 
and type: Laser AstroZ Manual. 

HEADERS & FOOTERS m 
Define: I left Page Header I I Right Page Header I 

l"I'HiM+ I Right Page Footer I 
Usage: Ell Off I 
left: [PIt]1 

Center: 

Rifllt: laser AstroZ Manual 

Inserts: I Chapter It I I Page It I I 1 st Match I I last Match I 
I Text Attr. I I Copy To Facing Page I 

I Cancel I 
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The footer text is automatically formatted as soon as you close 
the dialog box. (The Z_FOOTER tag was predefined in the 
style sheet you loaded at the beginning of the chapter.) 

Raise the footer 
To prevent the footer from being cropped off at print time, you 
must raise it upward on the page. 

am Enable Frame mode. Select the footer frame so you can 
change its margins. 

~ Margins & Top: 02,00 picas & points 
Columns Inserts: Copy To Facing Page 

Now you will turn off the footer on page one. 

am Select Turn Footer Off from the Chapter menu. 

Because a cover page is not normally numbered, you must 
update the page counter so that "page one" starts on the 
second page of the chapter. 

~ Press PgDn to go to page two. 

am Select Update Counters from the Chapter menu. 

~ Choose Which Counter: This Page, Update Method: Restart 
Number, With Number: 0001, Number Format: 1,2. 

The page number in the footer changes to 1 (Figure 9-6). 

~S: IQ'J.DI prtp:n4 by It'll pJ)ri::8N::I'Id 
"""IIIi1o/irw .......,. XVI _ 

r~-M' 

1-

Figure 9·6. 
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-NOTE: If the following pages do not automatically increase, 
you will have to renumber them manual/y. Move to each page 
in turn and select Update Counters from the Chapter menu. 
Choose Which Counter: This Page, Update Method: Previous 
Number + 1, and click OK, until aI/ pages are in the correct 
sequence. 

With the chapter format complete, you can begin to assign 
tags to the text. 

Verify the Body Text settings 
m Press Home to go to the beginning of the chapter. 

m Enable Paragraph mode. 

m Select the paragraph "Thank you for choosing the Laser 
AstroZ .... " 

m Font 

~ Alignment 

1m Spacing 

Face: Times 
Style: Normal 
Color: Black 
Size: 010.0 points 

Horz. Alignment: Left 
Overall Width: Column-Wide 

Above: 12.00 fractional pts 
Inter-Line: 12.00 fractional pts 
Add in Above: When Not At Column Top 

Create a title page with the BodyBreak tag 
To isolate the title page text from the rest of the document, you 
will create an empty paragraph (a paragraph that includes a 
carriage return only) and tag it with the BodyBreak tag. Since 
the BodyBreak tag (which has already been defined in the 
style sheet) includes a page break after, the text following the 
tag will be forced to the next page. 

m Enable Text mode to create the empty paragraph. Place the 
text cursor at the end of the paragraph "Guide to Opera
tions - Model XYZ-11" and press Enter once. 

m Enable Paragraph mode. 
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This text will be 
forced to the next 
page by the Body
Break tag 

Style 

m Select the empty paragraph (click on the paragraph symbol 
(JI) and tag it as BodyBreak (Figure 9-7). 

Guide 10 (Jperalions-

I : 

Figure 9-7. 

The text following the tag moves to the next page (Figure 9-8). 

Guide 10 pperaNons-

,______ _________ 11, ........................................ 1 
~ __ aLl-________ _ 

Figure 9-8. 

With the title page complete, go to the second page to continue 
tagging. 

~ Press PgDn to go to the second page. 
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Change the Head1 tag 
To isolate the Headl tag in the far left column, you will 
include a column break before and after. The Column Break 
Before keeps the heading from slipping back to the previous 
page. The Column Break After forces the text following the 
tag to start at the top of the next column. 

• Select the paragraph "Getting Started." 

• Select Breaks. Choose Column Break: Before & Mter. 

"Head1" BREAKS m 
Page Break: .. I Before I I After I I Before 8 After I 

I Before/Until left I I Before/Until Right I 
Coluliln Break: ~ I Before I I After I I:!MII~IDI. 

line Break: ~ 1:!f.fII I After I I Before R After I 
Next Y Position: III.III!I. I Beside last line of Prey. Para 

Allow Within: Ell ~ 
Keep With Next: I Yes I .. - I Cancel I 

Use the BodyBreak tag 
To start a new page, you will put a page break after the 
BodySmall paragraph at the end of page one. You will first 
create an "empty" paragraph. Then you will assign the Body
Break tag to a function key so you can tag the empty para
graph while you are in Text mode. 

• Enable Text mode. Place the text cursor after the words 
"LOS ANGELES, CA" at the bottom of the page and press 
Enter once (Figure 9-9). 
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rpenfreely. ,. 

~is rm.D1 ~ tIi ~ ~1K::,tkrs :::rd i 
~mlitJ"JK::,ti:fd: ~~, XYZ ~ 

roo.. Los: ~~, CA " 

~ 

Figure 9-9. 

~ Without moving the cursor from its current position, press 
Ctrl-K to bring up the Assign Function Keys dialog box. 

-NOTE: If you press Ctrl-K while you are in Paragraph mode, 
Ventura will ask you if you want to save your changes. 

m Assign the BodyBreak tag to the Fl key. Click OK to close 
the dialog box. 

ASSIGN FUNCTION KEYS 

F1: BodYBreak~ 
F3: Head3 ---
F5: Head5 ---
F7: 
F9: 

F2: Head2 ---
F4: 
F6: listBullet_ 
F8: 

F1B: Body Text ____ 

I Cancel I 

.. NOTE: Do not be concerned if your function key assignments 
do not match ours exactly. 
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II Press F1 to tag the empty paragraph you just typed as 
BodyBreak. 

The text following the tag is pushed to the next page . 

.. TIP: If you accidentally hit the wrong function key while tag
ging, you can usually recover by pressing the correct key 
immediately, before you do anything else. 

About auto-numbering 
For the first two pages, you formatted the manual using 
predefined tags from the style sheet. In the next section, you 
will create some advanced effects by adding several tags. 

Many technical documents include section numbers, outlines, 
or numbered lists. Ventura's automatic numbering can handle 
these chores for you. It can create anything from simple lists 
to multi-level outlines. Rearrange part of the list, and Ventura 
will renumber it for you - automatically. Automatic number
ing includes two basic steps: First, you choose which tags to 
number and what style of numbering to use; second, you 
format the section numbers Ventura has generated. For the 
first step, use the Auto-Numbering dialog box from the Chap
ter menu to choose which tags to number and what style to 
use. For example, Figure 9-10 shows the dialog box settings 
for Head1 displayed in roman numerals (I, II, III, IV, etc.) 

OOTO-NLtlBERIIIl 

Usage: .. I Off I 
Level 1: [*Head1

J
I).II--_______ _ 

Level 2: 
Level 3: 
Level 4: 
Level 5: 
Level 6: 
Level 7: 
Level 8: 
Level 9: 

Level 18: 

Inserts: I Chapter It I [I;TI [E[] ~ I:LTIJ I i J ii I 
I Suppress Previous level I I Text Attr. I IiiiiI 

L...!!...J I Cancel I 

Figure 9·10. 
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When Ventura creates the numbers, it assigns generated tags 
at the same time. The name of the tag depends on the level of 
the numbers. Numbers created at Level 1 are tagged as 
Z_SEC1. Level 2 numbers are tagged as Z_SEC2, and so on. 
Once Ventura has generated and tagged the numbers, you can 
format them as you like. The theory of auto-numbering will 
become clearer after you perform the sam pIe proj ect in this 
chapter. 

To create the numbered list of instructions, you will add a new 
tag named List#. The tag is indented from the margin to make 
room for the section numbers (which you will add below using 
Auto-Numbering). 

m Press PgDn to go to the third page of the chapter. 

m Enable Paragraph mode. 

m Select the paragraph in the second column that begins "Lift 
the release lever .... " 

., Add New Tag 

iI Spacing 

Tag Name to Add: List# 

In From Left: 01,00 picas & points 

Use Shift-Click to select the next two paragraphs shown in 
Figure 9-11 and tag them as List#. 

Figure 9-11. 

Next, we will show you how to use Auto-Numbering to 
generate the numbered list. 
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Using auto-numbering 
To create the numbered list, use Auto-Numbering from the 
Chapter menu. By placing the List# tag on Levell, you in
struct Ventura to place numbers before each paragraph 
tagged as List#. Mter Ventura generates the section numbers, 
you format them to reside on the same line as the List# 
paragraph. 

-NOTE: Although we are teaching a single level list, you can 
use these same basic principles to create multi-level num
bered lists such as outlines. 

m Select Auto-Numbering from the Chapter menu. 

m Choose Usage: On. Move to the Levell line and choose 
Inserts: 1,2. This button defines the number format for the 
list. 

m Delete the words "tag name" and type Li st #, then move 
the cursor past the right bracket and type a period. The 
period separates the automatically generated numbers 
from the text that follows. Click OK. 

OOTO· NII1BER Hil 

Usage: Ell []![] 
Level 1: [ItListlt,1]'1-1 ________ _ 
Level 2: 
Level 3: 
Level 4: 
Level 5: 
Level 6: 
Level 7: 
Level 8: 
Level 9: 

level 10: 

Inserts: I Chapter It I D:Il []!] ~ DJIJ I i, ii I 
I Suppress Previous Level I I Text Rttr. I __ 

~ I Cancel I 

Notice that the numbers (which are tagged as Z_SEC1) and 
the text paragraphs (tagged as List#) appear on separate 
lines. To place both number and paragraph text on the same 
line, you will change the attributes of the Z_SEC1 and List# 
tags (Figure 9-12). 
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Figure 9-12. 

;.t 
: Liftthereleist lever Uld rUse the ! upper put of the printer. 

f·' 
: Lift thegrttllfi>dngmemblycoYlI ! and remoV! the four red S]lletrS.t 

~t 
; Loate the grttll"'ec1einer and 
: remove its protective SOIling lipe. 
: You will use the wire cleaner to clean 
: the C«Oftl .... in the print artJidg~f : 

I .................................................. .! 

Style 

Change the Z_SEC1 tag 
il Select the number 1 (the Z_SEC1 tag). 

11 Font Style: Bold 

m Breaks 

Change the List# tag 

Line Break: Before 
Keep With Next: Yes 

11 Select the first List# paragraph "Lift the release lever and 
raise the upper part of the printer." 

Now you will change the tag to include a line break after. The 
line break after allows the List# and Z_SEC1 tag to reside on 
the same line. 

~ Breaks Line Break: After 

Earlier, you used In From Left Spacing to add a first line 
indent to the List# tag. You can see now how this indent keeps 
the List# paragraphs from touching the numbers. When you 
are finished the list should look like Figure 9-13: 

.. NOTE: If you had created the indent with the In/Outdent option 
in the Alignment dialog box, only the first line of the paragraph 
would have been indented. 
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Figure 9-13. 

~our Lmr AstroZ weighs 73 pounds, so 
~OhOttry to ~ft il witlloul sorneont's 
~Ip.Liftllleprinter~yitslllndlesand 
rlltt it On I clean, s11~le runlce. 

it Lifl 1M release lever Ind nisetlle 
i upperpulofllleprinier 

2 Li1'l tile green fOOns assern~1y cover 
i and remove 1M four red spacers. 

~ LOCite lIle green wire cleinerand 
: remove ils prote~j,.. setling tlpe. 
: You win use lilt wit cluner to clean 
i tile coroJ\l wire in the prinl culril~ 

~ RepllCing the tOIler arlridge 
: cieming slick 

~ Cleaning the corOJ\l wies 
~ Cleaning Ihe guides 
~ Cleaning md ropllcing the 

i bolls 

About loe loner 
iCartridge 
n.. toner mtridgoincludes 
:s..vesasinlc to 1110 printer. 
!itself hIS icolor codol ~u 
hie Ill. level of powder md 
~fprinls.lfyouprintp'ain 
~raphics)111 higllertoner 
~lIgetrnoreprinlsthlnif 
igraphicsll110wer sethng. 

Add a page break 
To complete the page, you will create an empty paragraph and 
tag it as BodyBreak. The text following the tag will move to 
the next page. 

m Enable Text mode. 

m Place the text cursor at the end of the last paragraph in the 
third column " ... replace your toner cartridge." Then press 
Enter once (Figure 9-14). 

m While the text cursor is next to the end of paragraph sym
bol' press F1 to tag the new paragraph as BodyBreak. 

Figure 9-14. 

partrldgel 
he loner mlridgo includes poI'Idor IIld i 
:s..vtslSinlc 10 tllo printer. Theurtridgo: 
fuelf hIS I color coded ~Ir IIld wlll indio : 
illeth.level of poI'Ider .. d the number : 
~f prints. If you print pOin text (no! i 
sraphlcs)It I higher toner seUing, you : 
tMII get rnor.prints thin if you \'tint : 
SnphlcsdI1owerselbng.lf~urprints : 
~.gin to look flded in UtlS, or slr"ked : 
~t Ill •• dges, r.pkc. your toner CIllridgdi 

~ i 



Stopping point 
Let's pause here to summarize where we've been and what lies 
ahead. You certainly have reason to be pleased with yourself. 
In the last few pages, you have been working with two of 
Ventura's most powerful and sophisticated functions, Breaks 
and Auto-Numbering. The ability to associate breaks and 
numbers with tags sets Ventura apart from ordinary 
programs. When you can manipulate these two dialog boxes 
with ease, you will stand out from the crowd. 

Before you stop, check your progress against Figure 9-15. 

Unpacking and 
Setting Up 

UllpacJr.ill8 aM Settin8 Up 

Unpacking 
Your u.ser AstroZ weighs 73 pOUIJds, so 
do not by to lift it wilhout someoae'. 
help. Lift tbeprinterby its handleoand 
place it on a clean, stable surface. 

L Lift the release lever md raise the 
upperplrl of the printer 

2. Lift the green fixing assembly cover 
and nmove the four red spacen. 

3. Locate the green wire cleaner md 
nmove its protective seoling tape. 
You will use the wire elMOer to clean 
the ~roaa wire in the print cartridge. 

The Care of Your 
Printer 
There an> seveml routine maintenance 
procedures you can perform to keep your 
Llser AstroZ running smoothly. You 

shculd be familiarwilh: 

• Rqllacin& the toner cartridse md 
cleaning stick 

• OMOmgthe~nmawUa 

• OMOmg the guides 
• OMOmg and nplacmg the SeparatiOl1 

belts 

About the Toner 
Cartridge 
The toner cartridge includes powder that 
.erv ... as ink to the prmter. The cartridge 
itself has a color coded bar that will indi
cate the level of powder and the number 
of prints. If you printpIain text (not 
graphics) at a higher loner setting, you 
will get more prints than if you print 
graphics at a lower setting. If yourprints 
begin to look faded in areas, or .tteaked 
at the edges, nplace your toner cartridge. 

Figure 9·15 At this stage in the project, page three of your document should look like this. 

L 

If you're planning to stop and relax for awhile, save the docu
ment and exit from Ventura. When you're ready to start again, 
reload Ventura and open the chapter C: \ TEMP\9TECH
DOC.CHP. 
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If you plan to forge ahead, you will discover a well kept secret 
about Auto-Numbering. You will also learn a fancy effect 
created with ruling lines. 

Add the Head4 and Rule tags 
m Press PgDn to go to page four. 

Now get ready to create two new tags: a heading (Head4) and 
a double rule (Rule). The double rule stretches from the end of 
the Head4 paragraph to the right-hand margin, no matter 
how long or how short the Head4 paragraph turns out to be. 
This advanced effect uses two different tags side by side on the 
same line. Figure 9-16 gives an idea of how the effect looks. 

Desk File Edit View Chapter Frane Paragraph Graphic Options 

Figure 9-16. 

II 
II 
l' 

Because this is an advanced effect, we suggest that you save 
the chapter (press Ctrl-S) before you proceed. Then, if you 
make a mistake, you can Abandon the chapter and return to 
where you were the last time you saved. 

You will start by adding the Head4 tag . 

• Enable Paragraph mode. 

m Select the paragraph "Paper Trays, Paper Cassettes." 

Ii Add New Tag 

~ Font 

Tag Name to Add: Head4 

Style: Bold 
Size: 014.0 points 
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1m Alignment 

1m Spacing: 

1m Breaks 

Overall Width: Frame-Wide 

Above: 00.00 fractional pts 
Inter-Line: 18.00 fractional pts 

Page Break: Before 
Keep With Next: No 

Your paragraph should now look like Figure 9-17. 

~~p~';'T';~J'~:'p~'p~;'C;;~'~tl~1f : 
1 1 ~der the Piper clips. r--I 1M 
lPiPerTIl,sl : ,mette inlothe sbl under Ihe 

~fRJ ,.sitita.Bold the printlrty i ~o:t:;:~~:Of;o The 
~o the wide tnd {utd towlrdS the {rOllt i j 
~f the printer.lnstfl the p'as1k pins into: ;NoTE: If yOll WUlt to print 
~efront sbls lbovethe hlnd1e. t : ~ead, pllct the Piper FACE 
: i ~eneath the e1ips.f 

lIEP .... iiiiaalLJ.. ___ ~~Do:.:no::.::.:t onrlold the Piper Irty. : : 

Figure 9-17. 

Style 

The Page Break Before guarantees that Head4 will always 
start on a new page. 

Next you will add the Rule tag. The paragraph tagged as Rule 
will include two characters: a horizontal tab and a paragraph 
return ('ll). With Tab Settings (Paragraph menu), you will set 
the tab location at the right margin of the page. Then you will 
choose Ruling Line Above: Text. In this case, the only text is 
the tab character itself. Ventura extends the rule the length of 
the text - that is, to the tab location at the right margin. 

WARNING: The effect you are learning is a complex one. Do not be concerned if text 
temporarily overlaps as you proceed. Once you complete all the steps, the text will 
realign properly. 

g Enable Text mode. 

D! Verify that Show Tabs & Returns is on from the Options 
menu. 
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m Place the text cursor before the "P" in the word ''Paper 
trays" on the second line. Press Enter once to create an 
empty paragraph (Figure 9-18). 

~~p~'~'T"~~J'~:'p~'p~~'c~~'~';tt~lF !'" .: 

~ ! ~i1perc ass ett I!SII 

~ertlil,sl i ~<elhePIPerinth.ussetl'l1\d :;:; 
: : ~nderth'plJl'l"tlips.rns.rtth. 

Ihewid. end heed lowards the front i :~s:~~!t~:I~I0!:;~~' 
the printer.lnstlt the p'astk pins inlo: 3u.1ls apprOl<irra1ely 110 sheets.! 
!ront slots lbovtth. hindle. f :: 

Figure 9-18. 

Now you will enter the tab character. 

m Place the text cursor in front of the new end of paragraph 
symbol ('1I) and press the tab key once. 

You will see the tab character on -screen (Figure 9-19). 

~~p~'~'T';'~'j~j'~p~~'C~~~';t"j~lF : 
~ ~ ! ~ilpercassettl!SlI 
~ertlil,sl i ~tI tho piper in the umtle l1\d 
: : ~nderth'plJl'l"tlips.rns.rtth. 
~lray ,.silioL Bold the print trly: ~iSS.tle into the slot under the 
~o the wid. end heed towards the front: ~h. printer un1il it stops. Th. 
;1 th'printer.lnstltthe p'astk pins into: llolls approxirrately 110 sheets.! 

1IItait ___ JL.L ____ --..r:~::f::ron:.:.:ts=lot::Slbo=¥t~the hindle. f i: 

Figure 9-19. 
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Now you will change the tab location with Tab Settings in the 
Paragraph menu. 

~ Enable Paragraph mode. 

II Select the paragraph that includes the tab character and 
the end of paragraph symbol (Figure 9-20). 

Figure 9·20. 

~ Add New Tag 

~ Alignment 

~lPKCasstttes" 
i>ktllht Plptr in the ussetll 1114 
jrunderthlptptrc1ips.lnsertthe 
tusetle into the slot under the 
ine printer until it slops. The 
~Ms Ipproxinate1y 110 shetts.t . 

Tag Name to Add: Rule 

Overall Width: Frame-Wide 
First Line: Indent 
Relative Indent: On 
In/Outdent Width: 00,04 picas & points 

The relative indent aligns the beginning of this paragraph 
with the end of the previous paragraph - no matter how long 
or how short the previous paragraph may be. Since you don't 
want the rule to touch the text, you must also specify an extra 
00,04 picas & points indent to separate the rule from the text. 

~ Tab Settings Tab Number: 1 
Tab Type: Right 
Tab Shown As: Open Space 
Tab Location: 46,00 picas & points 

The new tab location moves the paragraph symbol to the right 
margin (Figure 9-21). 
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'.!.:Cassette.1F .. [ ..................................................... ! r .. · ...................... · ...................... · .. 1 

: : 

Figure 9·21. 

jA Quick Tour 
ior the Laser 

troZtJ 

At this point the Head4 and Rule tags still reside on separate 
lines. With the Rule paragraph still selected, use the Breaks 
dialog box to put them on the same line. 

~ Breaks Line Break: Mter 

Add a ruling line above 
You've placed the Rule tag on the same line, but it doesn't 
make much difference yet because nothing is showing in the 
Rule paragraph. Now you will make it visible by creating two 
ruling lines above. 

In the next step you are going to create a double rule that is 
the width of the text. Recall that you created the paragraph 
with a tab stop (which is invisible) instead of actual text. 
Nevertheless, Ventura sees the tab as text. When you make 
the ruling line text-wide, the double rule stretches from the 
end of the Head4 paragraph to the tab location at the right 
margin. 

1m! With the empty paragraph still highlighted, select Ruling 
Line Above. Choose Width: Text. Give Rule 1 a height of 
02.00 fractional pts and make the Space Below Rule 1 
02.00 fractional pts. Give Rule 2 a height of 00.50 fractional 
pts. Make the Space Below Rule 3 negative (-) 09.00 frac
tional pts. Click OK. 
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"Rule" RULII1Ii liliES AIJOIJE 

Width: Text 
Color: Black 

Pattern: Solid 
Dashes: Off 

Space Above Rule 1: OIUIO 
Height of Rule 1: 02.80 

Space Beloit Rule 1: 02.80 
Height of Rule 2: 00.50 

Space Beloit Rule 2: 00.80 
Height of Rule 3: 00.80 

_ 36.00 

Custor. Indent: OO,()O [:~J C:'=] 
Custo" Width: 00 ,00 

Dash Width: OO,()O 
Dash Spacing: 00,00 fractional pts 

Space Beloit Rule 3: ~·~~I [£J a 
Overall Height: 

Style 

The negative value for Space Below Rule 3 shifts the rule 
down from its original location and aligns it with the Head4 
paragraph (Figure 9-22). 

Figure 9-22. 

~~p~';'T';~';i~j;~p~'~'c~;;;il" &;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;~~~ 
: : IInderthePlJlEl"c1ips. lnsertthe piper 
~: aper Illysl 1, ilSSetie into the sl01 111Id~ the front of 

ihe printer 111Itil H slops. The asselle 
r,.tny ,ositio •. Bold the I"int tay 1 ~otds Ipproxil1\ltely 110 sheets.f 
~ the wide end fmd towuds the front : 
1>1 the printer. Insert the pllslic pins into: ~OTE: If you wlnt to print on lettel' 
~h. fronl slotnbo", thelwld1e. I 1 ~ud, pll .. the Plper FACE DOWN 

~OTE: Do not oy~lold the PlJlEl" lray.l i::::::::: .. 

th 

Ille dips.1 /'I .. ing H too full will a.use piper juns : 
~dl"intlfTors.f 1 
: : 

l8Ilul fee( ,aito. Hold the: 
guidewilh lheplaslicbrlCl:·l 

r .. ro/th.print~.Fm : 
I : 

Since you gave the Rule tag a line break after, the double rule 
appears right next to the Head4 tag. 

Add the Note tag 
The Note tag isolates special warnings and procedures inside 
a box. To create the box around the Note tag, you will use the 
Ruling Line Around dialog box. As is often the case with 
Ventura, there is more than one way to create the effect we 
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will show you. You could also achieve a similar effect with 
frames or with Box Text. Each method has its advantages and 
disadvantages. The method we are showing you relies on tag 
attributes. It has the advantage of allowing you to change the 
look of multiple paragraphs throughout the entire document 
by changing a single tag. 

m Select the paragraph that begins "NOTE: Do not overload 
the paper tray ... "in the first column of the page. 

m Add New Tag 

m Spacing 

Tag Name to Add: Note 

In From Left: 01,00 picas & points 
In From Right: 01,00 picas & points 

m Select Ruling Box Around. Choose Width: Column. Give 
Rule 1 a height of 00.06 fractional pts and make the Space 
Below Rule 1: 03.00 fractional pts. 

The Space Below Rule 1 adds extra space between the text 
and the ruling box (Figure 9-23). 

Figure 9-23. 

~thy ,ositio •. Hold the print tray 
to the wide .nd flCed towuds tI\. front 
l>rth.print,r.Jnsert lhepl15tXpins into 
~h' front slols lbonthe Iwldle. f 

NOTE: Do not .verlold the : 
piper hlY. Pl<king H 100 fun wiD i 
aus. plp.r jams Ind print eruM"S.f : 

~-;:=:~·;.-~·~:~:-:~~~.i 
lnanul1feedsuidewithlhepllsbebrtck- : 
~t5 towuds the r .. r of tl\e printer. FICe 1 
~h' nobed side up. f 1 

i...4,.,.rin ... ulfeM.Jnsertone : 
~eetofPlperltltime.G1ideth'Plper 1 
~lonitl\·hIYUllhlilan'i'lnyfur· : 
1her,lhenstop.f 1 

~apl!Jcassettesli 1 

Once the Note tag is defined, you can apply it to the next Note 
paragraph. 

~ Select the paragraph that begins ''NOTE: If you want to 
print on letterhead ... " in the second column and tag it as 
Note. 
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-NOTE: You can force Ventura to keep all of the paragraph 
together by choosing Allow Within: No from the Breaks dialog 
box. Ventura will not allow line breaks within the paragraph. 
Instead, it will move the entire paragraph to the next column or 
page if necessary to keep the paragraph together. However, 
this method has the danger of leaving large gaps of white 
space at the bottom of the previous column. 

Create a second list 
You will now create a second numbered list by tagging three 
paragraphs as List#. 

- NOTE: Because the List# tag has a Line Break After, the three 
paragraphs you tag will shift on top of preceding paragraphs. 
This temporary confusion will be eliminated as soon as you 
renumber the chapter. 

Si Select the following paragraphs and tag them with the 
List# tag. 

"Print tray position ... " 

"Attach the Manual Feed Guide ... " 

"Load Paper in Manual Feed ... " 

To generate numbers for the newly tagged List# paragraphs, 
use Ventura's Renumber Chapter function. 

m Select Renumber Chapter from the Chapter menu or press 
Ctrl-B (Figure 9-24). 

- TIP: Despite its name, Renumber Chapter does not affect 
chapter numbering. It applies only to Auto-Numbering. 
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.lIffiTil~ 

Page Size &: layout ... 
Chapter Typography ... 

....... 0 ......... 0 ••••••••••• 0 .................. 

Update Counters ... 
Auto-Numbering ... 

-~~iI[rl"'l'll. 1111[- :. 
Re-Anchor Frames .. ":\ 

................. 0 ................... 0.0 ........ 

Headers &: Footers ... 
Turn Header Off 
Turn Footer Off 
Footnote Settings ... 

••••••• 0 ••••• 0 ................. 0 ••••••• 0 ... 0 •••• 

Insert/Remove Page ... 
Go to Page ... AG 

Figure 9-24. 

Create multiple lists 
Mter renumbering the chapter, the instructions are num
bered sequentially, but they start with the number four (Fig
ure 9-25). 

Figure 9-25. 

ltRmllrly ,aiti.n. Bold the print 
: trlY so the wide end flCt4 tOWlr4. tho 
: front of the printer.lnsertthe pllsti, 
: pinsintothefrontslolnbovethe 

! 1wId1e.. 

NOn: Do not ovtrlold the 
Jliper hy. I'lcking illoo full wiD 
.. use pipe' jlms Ind ]tinl errors.' 

~'AlIodItIoolIDulhtdgui'" Bold 
: th.rronuIlfttdS_idewith the plutit 
: brawls tOWlrds the reu of lhe ! printer. FIco the ribbed side up. • 

~lLIIiplperi. manullhtd.)1\Se'1 
: one sheet of Jliper III lim~ G~de the 
: pipe' llong the tny _nIB H Cln'l go 
i Inyfurther,lhenslop.f 

Ventura starts with the list with the number four because it 
assumes that the sequence continues from the list on the 
previous page. In some cases, you may want a list that is 
numbered sequentially throughout the chapter. In other 
cases, however, you may want multiple lists that start num-
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bering over again at one. We will show you a quick way to 
restart the numbering. 

Whenever Ventura encounters a Levell tag, it resets the 
numbering for all the lower levels. By putting ordinary Body 
Text at Levell, you trick Ventura into restarting the number
ing for Levels 2 and below. In this case, then, you will use 
Body Text for Levell and List# for Level 2. 

m Select Auto-Numbering from the Chapter menu. 

m Place the text cursor next to the Level 1 line and press Esc 
to clear the line. Choose Inserts: 1,2. Delete the 1, the 
comma, and the words "tag name." Then type: Body Text 

By deleting the 1, you tell Ventura to number Body Text but 
not to show the numbers. In effect, then, you have "invisible" 
numbers. 

~ Move the text cursor next to the Level 2 line. Select Inserts: 
1,2. Remove the words "tag name", but keep the 1 and the 
comma. Then type: List# 

~ Add a period after the right bracket. Click OK. 

OOTO-Nlt1BERING 

Usage: III [[IT] 
Level 1: [ltBody Text) ________ _ 
Level 2: [*listitJ1]'I-~ ________ _ 
Level 3: 
level 4: 
Level 5: 
level 6: 
level 7: 
level 8: 
level 9: 

Level 10: 

Inserts: I Chapter it I o:;r] []]] GEJ ILTIJ I i J ii I 
I Suppress Previous level I I Text Attr. I 

The list now starts over at one (Figure 9-26). 
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Figure 9-26. 

~lImJlrar pesltitn. Bold the print 
: tny SO the wide end flctd towuds the 
: fronlof the printor. Instrttho pkstic 
: pin. into thtfronlslolHbove the l 1wId1e. f 

Non: Do not OYIrlold the 
PIper hy. Puking illoo fun win 
<lusePll*'jlnlSlndprinlorrors.f 

~,AlW. tMlllJlul fHdlUlb. Bold 
: the lI'ilIualfeed goidl with the plastic 
: Incl ... tOI'llI'd. the relT of Ih. 
1 pinttr. Fue the ribbed sjde up. f 

~fLelptper ia manual fHd.lns«1 
: oneshetlof PIper II I timl GUethe 
: PlI*' 11ongtllo tny ontH H can't go 

Inyf1irther,thenstopJ 

-NOTE: The numbers are now tagged as Z_SEC2, since they 
are now on Level 2 in the Auto-Numbering dialog box. If you 
are using the style sheet from the Power disk, this tag has 
already been defined for you. If not, copy the attributes set 
forth for Z_SEC1 earlier in this chapter. 

Add a page break 
When you're finished with Auto-Numbering, you will enter a 
page break after the last Note paragraph to push the rest of 
the text to the next page. Then leave the page as is. In the next 
section you will add frames and pictures to this page. 

~ Enable Text mode. 

~ Place the text cursor at the end of the paragraph ''NOTE: If 
you want to print on letterhead .... " Press Enter (Figure 
9-27). 

m Press Fl to tag the new paragraph as BodyBreak. 

You have formatted the final paragraph in the 9TECH
DOC. TXT file. Before we continue, let's take stock once again. 
You've already learned about breaks and Auto-Numbering. 
Now you are ready to tackle a new feature that will add spark 
and dazzle to your Ventura documents. Get ready for some 
fun. 
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Figure 9-27. 

Adding spot color 
If you have the budget, color can add an extra dimension to 
your visual communication. With color, you have a powerful 
visual aid that can add impact and import to information in a 
document. Color can jazz up a dull report or transform a 
lackluster manual. As you plan for color in your publication, 
don't get lured into the snare many beginners find themselves 
in: placing too many colors in too many shades on a single 
page. You'll find that too many conflicting colors can be garish, 
amateurish and at worse, distracting to your main com
munication. If you are just starting out in design, we suggest 
you stick to one or two colors for your document. 

Without going into all the complexities of color theory, in this 
section we will show you how to define and apply one color. We 
will start with a few basics about color printing. 

-NOTE: If you never use or intend to use color in any of your 
documents, feel free to skip ahead to the pictures section. 

In traditional printing, there are two ways to print color: 
Process color and spot color. Let's look at both in turn. 

In process color printing you run a page through the press 
four times. One time for each primary color (cyan, magenta, 
and yellow) and another time for black. By mixing these four 
colors in different combinations, you get a limitless palette of 



u~saD£e cu£un; 

colors. You would use process color printing to print color 
photographs or illustrations with a range of colors. If you have 
the budget for photography and/or color illustrations, you can 
define over 125 million colors in Ventura and print directly to 
a color printer, such as the QMS ColorScript. 

On the other hand, if you don't have the luxury of a color 
printer, you can still use Ventura to define one or two colors. 
When your document uses only a few colors, you do not use 
process printing. Instead, you use what is known as "spot 
color." Spot color runs a page through the press for each color 
(plus black) that you define on the page. 

Before you give a document to a printer for spot color printing, 
you must create a set of color separations, that is, a separate 
page for each color you define. For instance, let's say you 
wanted to use two colors, black and red. First, you would 
define the colors. In our example, you would apply red to the 
desired text, ruling lines, or graphic shapes and backgrounds 
in the document. (You can apply the color in any dialog box 
that includes color selections.) Second, you would instruct 
Ventura to print out a page for every page element that is black 
and a separate page for every element that is red. The end 
result is a set of color overlays that you can send to an offset 
printer for printing. 

-NOTE: With Ventura's c%r capabilities, you eliminate the 
extra expense of paying an offset printer to make the color 
separations for you. 

So let's get started. In this section you will define and apply a 
color to one page element. Later in the Chapter section, you 
will print out your color overlays. For this example, we will 
assume that you are printing to a black and white printer, not 
a color printer. 

Disable colors 
First you will disable the colors that you will not use - in this 
case, everthing exept red, black, and white. 

~ Enable Paragraph mode. 

~ Select Define Colors from the Paragraph menu. 



~ Click once on the right arrow next to the Color Number line 
to move to color 3. Then choose Color Setting: Disabled. 

DEFINE COLORS m 
Screen Display: Colors 

Color HUPlber: 1 + 1 3 1 + 1 

Color Setting: Disabled 

Color NaPle: 1:,I'een ....................................... . 

Cyan: + \ \::::::::::::::;:;:;:::;:::::;:::::;:::;:::;:;:;:;:::;:;:::;:;:::;:;:;:;:::::;:1 + 1 f.!f.! , f.! % 

Magenta: + 1 I::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::1 + 1 f.lB , B 

Yellow: + 1 j:::;::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::1 + 1 f.!B , B 

Black: + 1::::1 H::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::1 + f.lf.lB , B 

01< I Cancel I 

m Repeat the step above to disable color numbers 4 through 7. 
Then click OK to close the dialog box. 

-NOTE: If you do not disable unused colors, Ventura will print 
out a separate page for each one. 

Assign a color to selected page elements 
Next you will tell Ventura which page elements will be red. 

m Make sure you are on page four. 

m Select the Note in the first column (Figure 9-28). 

~ Select Ruling Box Around from the Paragraph menu. 

m Choose Color: Red and click OK. 
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Figure 9-28. 

ltfl'mllrir ptSHltn. Bold the print i 
: lray .. th. widt truI fuod tOWlrd. thl : 
: frontofthIJlfInItr.!nsertthtpllstic : 
: pln.lntoth.lrcntslolsabove th. : 
i hlndlt. f : 

!z.'AIIIcltlleMaualFMdGuile. : 
i Bold tho manual lted guide with the i 
: pkstic brackolstowuds the rOlt 01 the: 
1 printer. Faco the ribbed side up. f 1 

~1LoIll'i,...inMollllF .. Unwl i 
: one sheel 01 PIper at I timL G~de th. : 
: PIper alongth. lrIy unt~ H <In'! go . ! anylurth.r,thonsiop. f 

"Note" RULING BOX AROlliD 

Width: ColuJin 
Color: Red 

Pattern: Solid 
Dashes: Off 

36.1'11'1 
Space Above Rule 1: 00.881 

Height of Rule 1: 00.86 
Space Below Rule 1: 03.88 

Height of Rule 2: 00.88 
Space Below Rule 2: 00.88 

Height of Rule 3: 00.88 

Custor. Indent: 00. 00 [:~:"] C.:] 
Custor. Width: 00.00 

Dash Width: 00.00 
Dash Spacing: 00.00 fractional pts 

Space Below Rule 3: 00.88 a c:::::J 
Overall Height: 03.86 
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You just changed the color of the ruling box around the note. 
Now you will change the color of the Head4 tag to red. 

m Select the paragraph "Paper Trays, Paper Cassettes" at the 
top of the page. 

m Select Font from the Paragraph menu. Choose Color: Red 
and click OK. 

Notice that the only colors in the dialog box are white, black 
and red, the ones you defined and enabled in the Define Colors 
dialog box. Because of time and space limitations, you will 
only add color to one page. 
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Pictures 

''Head4" FlIIT 

:i::~:~::i::~:~::i::~:~::i::~:~::im Face :~:~::i::~:~::i::~:~::i::~:~::i::~: 

t Helyetica t 
Jines 
Courier 

:I~"I!I:I ~~~~~~ ~~:~~/~De~i 

~:~ Style m~: 

U.\3ht 
Hamal 

• Helyetica Harrow • 
Palatino '----'-_--' '--_------' 

Custo.. Size: 1114.0 points 

OYerSCOre: Off 
Strike· Thru : Off 

Underline: Off 
Double Under line: Off 

Pictures 

Before you print out the color overlays, you will place pictures 
into frames. In this section, you will incorporate illustrations 
by adding new frames and importing AutoCAD pictures. You 
will also learn to anchor frames to text. As with the rest of this 
chapter, you will be learning advanced techniques that may 
take extra time and effort to master completely. 

Add three frames 
Before you place the pictures, you must add the frames to 
contain them. 

m Check that you are on page four. 

~ Reset the zero point to its original position at the upper left 
corner of the Page by clicking on the 0,0 square in the upper 
left corner of the page. Check to make sure that Line snap 
and Column Snap are on. 

m Enable Frame mode. Select Add New Frame from the Side
Bar. 

m Add a frame in the first column, starting from position 13 
picas on the vertical ruler. Stretch it 14,00 picas wide and 
11,00 picas high (Figure 9-29). 
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~~p~'i'T'i'~J's:'Pap~I'CI~s'~i'i~ ~;;;;;;;;;;;;;;;;;;;;;;;;;;;;,;;;;;;~ 

[~:~~] 
~urn,s : 

it. Pri\llray)tSitiln. Bold !he print , 
1 tllyso!hewideendfl~toll'"d'the: 

~ __ aL~ ____ ~~~ 

Figure 9-29. 

-NOTE: You can check the frame's width and height with the 
Sizing & Scaling dialog box. 

To visually separate the frame from the Page, you will add a 
ruling box around. 

mil Ruling Box 
Around 

Width: Frame 
Height of Rule 1: 00.05 fractional pts 

Now you will copy the frame and paste it twice. 

II With the frame still selected, press Shift-Del. 

m Press the Ins key to paste a copy on top of the original. 

~ Press Ins again to insert another copy of the frame. 

~ Move the two copies into position. Make sure the top and 
bottom edges of the new frames line up with the top and 
bottom edge of the original frame (Figure 9-30). 

Place pictures inside the frames 
m Select the left frame and place the file 9LASER-1.GEM 

inside. 

II Select the middle frame and place the file 9LASER-2.GEM 
inside. 

II Select the right frame and place the file 9LASER-3.GEM 
inside (Figure 9-31). 
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Desk File Edit View Chapter Frane Paragraph Graphic Dptions 

I ~,~~j~~!~~!~li:i~j~~!~~j~~:~~!i~c:\TEHP\9fE(jjDiic~dii--(9'fEOOli::sfYq~~!~~!~~!~~j~~!~~!~~!~~j~~!~~ • 
t 

~;p·~·~·T~·~"i~·j~p~·~·c~·~~~i·t~~ r··················································: ~···················································:I 

~iperIrayS 
:1. Prinltny position. Hold Ih. Jrlnt i 
: IllY so the wid •• nd imd IoYNds the : 
: Ironl 01 th. Jrlnter. Insertlhe pkslic : 

! ~:~:to the fronlsbjj Ibove the : 

Figure 9-30. 

:z. AlIDtlellU"IH.dgui.~ Bold 
i th.rnilluilieedguidewith Ih. pllstk 
: bmkels Iowuds Ih. rear of the 
~ printer. Flee the rrobed side up. 

~ LcMJlperiallllJlulfled.l1lSerl 
: ,lim. nli!"lh, 

Desk File Edit View Chapter Frane Paragraph Graphic Dptions 
I ~!§~:§~:~":~§:§":~li:,,,,:,,~:~,,:,,~1::\ jEHP\9fE(jjDiic~dii--(9fEdjiiOC:sfYfT~~:~~j~~:~~:~~:~~:~~:~~:~~:~~ • 

t 

~;p·~~·T~·~·J~·:·p~p~·~·E~;~~i·t~~ : ................................................... : r··················································:1 

rilPerIrays 

it Prinltny position. Hold Ihe Jrlnt , 
: tllYSO the wide end imdtowuds th. : 
: Irontof the Jrlnter.Insertlhepkslic : 

! ~:~:to the iront sbjj lbove the : 

Figure 9-31 . 

~ AtlacktleJMa"IHleagui.~ Bold 
: the rnlllUllieed guid. with Ihe pllstk 
: bmkels Iowuds the rear 01 the 
~ printer. Flee the rrobed side up. 

i1 LcMJlper ia lIIlJIut fled.11ISerI 
: ,lim. {lli!.lh. 

Pictures 

.. NOTE: If you do not have these three pictures from the Power 
Disk, substitute others of your own choosing. 

Size and scale the pictures 
You will use Picture Scaling: By Scale Factors (Sizing & Scal
ing dialog box) to scale the pictures in the frames. Select the 
left-most frame. 
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~ Sizing & 
Scaling 

Picture Scaling: By Scale Factors 
Aspect Ratio: Maintained 
X Offset: + 03,00 picas & points 
Y Offset: + 12,00 picas & points 
Scale Width: 29,00 picas & points 
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Use Figure 9-32 to gauge the scale and aspect ratio for the 
rest of the three frames. 

Desk File Edit Vie\! Ghapter Frane Paragraph Graphic Options 

• ~:§~!~~:~~:~~:~§1~~:~~:~~!~§:~~c:\HMP\9fE(jjDoc~Ctif(9fEdtliOC~8Tv) 1~~!~§:~~:~~:~~:~~:~~:§§:~§:~~ • 
t 

b 
P~p'~~"T~'~'J~:'p~p~';'c;~~~t"i~ : ................................................... ~ ~ ................................................... ~:~::r 

: : ~.-.-.-,-.~.-.-.-.-.-.-.-.-.-.-.-.-.-.-.-.-.-. p' 

Pirue&aing: By Scale Factors 
Aspectllalio: Maintained 

X~ +03,00 picas 
YObet +12.00 picas 

&aIe~29,OOpicas 

t FmIlr.iy position. Hold the p<illt : 
tny ~ the wide end rloed lowlrds Ihe: 
front of the p<illtor.lnsert the p1ls~e : 
pills iIItothe front siotslbove th. : 
hind. : 

Figure 9-32. 

Add a Spacer paragraph 

r::-:::g~~~~:~e-;:c~o-J I Pirue&aing: By Scale Factors 

I ~~~~~~~~ II ~~~!~~ ~ 
~ AltiOlMmoulUeed lUi!e. Hold : 
: the Iril\uli reed guide with the p1lslk : 
: bmbtslol'llrdslher ..... rthe . 
i prinler. File ihe ribbed side up. 

~ LooIpl'" iunlnuUeed.IllS<ft i 
: I tm-.. n,d. !h, : 

~~i~t~r;,[1 
~~~~~~~.~~t~~OlP1sri :~::::S<It. i "t 

When you placed the frames, the text automatically re-flowed 
on the page. Now you will finish the formatting with one 
adjustment - you will add a spacer tag to an empty para
graph in the second column to keep the spacing of the n um
bered items even. 

II Enable Text mode. 

m Place the text cursor after the last period in the first Note 
paragraph in column I (Figure 9-33). Press Enter. Then 
press FlO to tag the empty paragraph as Body Text. 

II Enable Paragraph mode. 

II Select the empty paragraph you just created (which was 
tagged as Body Text). 

II Add New Tag Tag Name to Add: Spacer 
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Figure 9-33. 

,ositiOL Bold the prinl i 
lray so the wide end flM towards In. : 
frontoftheprinter.InsertthepllStie : 
pins into In. fronl slots lbovt Ihe : 
hind.... i 

i NOTE: Do not overload Ihe I piper Iny. Plekil\i illoo fun I'Illl , 
! auseplper jlmsmdprinttrTors.1 : 

r~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~=~~~~'~~~~~~] 

~lAtIorI\lIIt_UlfH' pN •. HoM i 
: th.mlnulf .... guil.with the pluDe : 
: "fillets Iowuds the rear of Ihe : 
: print.. FIe. the n"bbed side up. I : 
: : 
iallad,.per in lIIu.uH .. Insert i 
: oneshttl of piper II I lime.Glile the : 
i ,.per lionS thelray unbl it un'l go i 

l ... l~.~.:~.:.;.:.e~.:~.~, .................... ! 

~ Spacing Add in Above: AI ways 

Pictures 

Unlike Body Text, you want the Spacer tag to keep 12.00 
fractional pts of extra white space at the top of the column. 
The extra space above in the Spacer tag makes the top of all 
three columns line up with each other (Figure 9-34). 

Figure 9-34 . 

f1.IlI'rilotlnyp,ositi,oL Bold the prinl i 
lray so Ihe wide end taM lowards Ihe : 
fronloflheprinler.Insertthepl15tic : 
pins into Ihe fronlslots lbove Ihe : 
hind ... I i 
NOTE: Do nol overload Ihe 
,.per Iny. PlCldl\i il 100 fun I'Illl 
~use .plper jlmS, md "inl ~rrord 

~ 
ZIAIIIdlIllt ... ul CH' pite. HoM 
: the mlnul f .... guile with the pllstic 
: "neketslowudsthermoflhe i printer, Flct the n"bbed side up. I 

3.1Iad,.perinlllul1 CH .. Insert 
i oneshttlof piper II I lime.GliIe the 
: ,.per llong the lray unbl it un'l 110 

l ... ~~~.~~.~~.'.~.:~.:~~~ ................... .. 

.. NOTE: You also did not use Body Text as the spacer because 
Body Text would cause the Auto-Numbering to reset to one. 
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Add the final illustration 
Now you will go to page five and add the frame for the final 
illustration. 

i1 Go to page five. 

m Enable Frame mode. 

= Select Add New Frame. Start the frame at the upper left 
corner of the second column and stretch it 30,00 picas wide 
and 24,00 picas high. You may want to change to reduced 
view to place the frame (Figure 9-35). 

Figure 9-35. 

m With the frame still selected, choose the file 9LASER-
4.GEM from the Assignment List. 

i1 Sizing & 
Scaling 

Add a caption label 

Picture Scaling: By Scale Factors 
Aspect Ratio: Maintained 
X Crop Offset: +08,00 picas & points 
Y Crop Offset: +20,00 picas & points 
Scale Width: 63,00 picas & points 

You are almost finished with the manual. Let's make a few 
more enhancements to the page by including automatic figure 
numbering. 
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m With the frame still selected, choose Anchors & Captions 
from the Frame menu. 

~ Choose Caption: Below. Move to the Label line and type: 
Figure followed by a space. 

m Choose Inserts: Chapter #, type a hyphen and choose In
serts: Figure # and type a period. The code will read [C#l
[F#l . Click OK. 

AHCHOR8 & CAPT HilS 

Anchor: 

Caption: Below 

Label: Figure [C~]·[F~].II--________ _ 

Inserts: I Table ~ I I Fi9l1'e ~IIChapter ~ II Text Attr. I 

Add caption text 
m Enable Text mode. 

~ Place the text cursor in front of the end of file mark inside 
the caption and type: 

The front view of the Laser AstroZ, showing the dis
play panel, the toner cartridge door, the release 
lever, the paper cassette, and the print tray. 

Add a frame anchor 
We promised to show you some advanced picture techniques, 
and frame anchoring is one of the most useful. Frame anchor
ing keeps frames on the same page as the text they refer to. 
Once a frame has been anchored, you can make large addi
tions and deletions to a text file without worry that the frame 
will be displaced from its text reference. It is a two-step 
process: (1) insert an anchor reference into the text file and (2) 
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attach an identical reference to the frame. Once a frame has 
been anchored, you can make large additions or deletions to 
the text without the fear that you will move the frames. The 
Re-Anchor Frames function searches the text file for anchor 
references and then moves frames to the correct pages again. 

As is so often the case, the best way to understand this ad
vanced function is to try it out. Start by placing an anchor 
reference into the text on page five. 

m Place the text cursor after the "Z" in the phrase "A Quick 
Tour of the LaserAstroZ" on page five. 

m Select Ins Special Item (or press Ctrl-C) from the Edit 
menu (Figure 9-36). 

Cut; l'EJXt; lkJ 1 
Copy h:~xt tlk~ 1. 

Paste Text Ins 

R~J!:~nV~J l't:Jxt!FihJ \ \ \ 
File r /Rena!:m, , , 

Figure 9·36. 

e Choose Frame Anchor (or press the F5 key). 

e Move the text cursor to the Frame's Anchor Name line and 
type: 1-1 

B Choose Frame's New Location: Fixed, On Same Page As 
Anchor and click OK. r 

.. NOTE: When Ventura tells you it cannot find the Anchor Frame 
1-1, and asks what you want to do about it, choose Ignore. 
You have not yet added the anchor. 
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INSERT/EDIT ANCHOR 

FraneJs Anchor Haffle: 1·111--__ _ 

Fraroe's Hew Location: Fixed, On Salile Page As Anchor 

I Relative, Below Anchor Line I 

I RelativeJ Above Anchor Line I 
I Relative, Autofflatically At Anchor I 

I Cancel I 

Pictures 

If Show Tabs & Returns is selected, you will see a degree 
symbol C) in the text to indicate the anchor reference. 

'-TIP: Like footnotes and index entries, anchor references can 
be typed directly into text files using a bracket code. See the 
tips at the end of Chapter Eight for details. 

After placing the anchor reference in the text, you will attach 
an identical anchor name to the frame with Anchors & Cap
tions. 

m Enable Frame mode. Select the frame. 

~ Select Anchors & Captions from the Frame menu. 

1m Move the text cursor to the Anchor line and type: 1-1 
(Figure 9-37). 

WARNING: Type the anchor reference exactly the same in both dialog boxes. 
Otherwise, Ventura cannot match the two references. 

Re-anchoring frames 
There is no need to use anchoring until a frame is separated 
from the text reference. Just to see the feature in operation, 
try deleting the frame you just anchored. Move to any other 
page of the document and paste the frame there. 

Now you will try re-anchoring. 
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(fiCIIlRS & CAPmltS 

Rocher: 1-1t-1 __ _ 

Captioo: Below 

label: Figure [C~]-[F~]. _________ _ 

Inserts: I Table ~ I I FiglJ'e ~II Ch~ter ~ II Text Attr. I 

Figure 9·37_ 

BI Select Re-Anchor Frames from the Chapter menu (or press 
Ctrl-B) and choose All Pages. If you press the keyboard 
shortcut, Ctrl-B, you will automatically Re-Anchor Frames 
for all pages. 

The frame returns to the page containing the anchor reference 
in the text. You may need to re-position it slightly. 

Adding callouts 
Ventura's graphics tools are perfect for adding callouts to 
pictures. Using Box Text and lines, you can create annotations 
and arrows. Since graphic shapes stay tied to the parent 
frame, when you move the frame, the callouts move with it. 

Draw Box Text 
To create callouts, you will start by creating the Box Text. 
Then you will type in the actual words, and draw arrows 
pointing to specific features in the picture. First you will set 
the horizontal and vertical grid settings. 

II Enable Graphic mode. Choose the picture frame to make it 
the parent to the shapes you will draw. 

II Grid Settings Grid Snap: On 
Horizontal Spacing: 00,06 picas & points 
Vertical. Spacing: 00,06 picas & points 
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= Select the Box Text tool. Draw a Box Text shape 06,00 picas 
wide and 03,00 picas high. Position it close to where we 
show in Figure 9-38. 

Figure 9-38. 

~ Line Attributes Thickness: None 
Defaults: Save To 

1m Fill Attributes Color: White 
Pattern: Hollow 
Results: Transparent 
Defaults: Save To 

Now add the text part of the callout. 

m Enable Text mode. 

= Place the cursor inside the Box Text and type: D.isplay 
Panel 

Now you will draw an arrow. 

= Enable Graphic mode and make sure the picture frame is 
selected as the parent. Then select the line tool. Starting 
from the end of the word "Panel," draw a line from the text 
to the picture as shown in Figure 9-38. 

- NOTE: Although you could have drawn the arrow before typing 
the words, you would have been forced to guess at the precise 
location. Placing the arrow after typing the cal/out makes 
placement easier. 
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Figure 9-39. 

~ Line Attributes Thickness: Thin 
End Styles: (Beginning) Arrow 
Defaults: Save To 
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Repeat the steps above to add two more callouts as shown in 
Figure 9-40. 

Figure 9-40. 

When you are finished, save the chapter and move on to the 
Chapter section. 
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Chapter 

Chapter 

Now you are ready to print out the chapter and create a set of 
color overlays. You will get two sheets of paper for the color 
overlays on page four. 

m Go to page 4. 

~ Choose To Print form the Chapter menu. 

B Choose Which Pages: All and Spot Color Overlays: On. 
Then click OK. 

B When Ventura asks if you want to print 2 spot overlays per 
page of the chapter, choose Overlays (Figure 9-41). 

PRINT INFORMATION (POSTSCRIPT - UltiMate) [!] 
Which Pages: Current 

F .... om Page: 0004 

~ A .... e you sure you want to print 
STOP 2 spot colo .... oye .... lays per page 

of this chapter? IF not. either 
print just one page for all colors 
or cancel the p .... int request. 

Figure 9·41. 

Deyice Name: POSTSCRIPT 
Output To: COM1: 

-~ 
Cancel 

I Cancel I 

Ventura prints out the manual. When it gets to page four, it 
prints out one sheet for black and one sheet for red. 

-NOTE: If you place the two overlays pages on top of each 
other, you can see the resulting effect. 

Now give yourself a big pat on the back. You made it through 
all nine chapters of Ventura expert training. You should be 
proud of yourself. Now you are ready to show off your talents 
to the world. Get started on those high-powered, award-win
ning designs. 

For all of you who have the ambition and the determination to 
go beyond your own limits, don't stop here. You are just one 



Draw Box Text 9 - 51 

chapter away from becoming a true Ventura master. In Chap
ter Ten, we tackle the advanced features of the Professional 
Extension. If you have the Professional Extension and are 
ready for the challenge, go to the next chapter. 

Tips and techniques 

Text tips 

D You can create a special page break (Body Break) tag that 
includes a Page Break: Mter. To force a page break within 
the text file, tag an empty paragraph with the page break 
tag. All the text following the tag will be forced to the next 
page. 

D Auto-Numbering includes two basic steps: first you choose 
which tags to number and what style of numbering to use. 
Second, you format the numbers that Ventura generates. 

D Initially the generated section number tags have the same 
attributes as body text. You can format them like any para
graph. 

D You can create a traditional outline format (uppercase 
Roman numerals, uppercase letters, lower case Roman, 
and so forth) with the Auto-Numbering dialog box. Insert 
the Suppress Previous Level symbol ([-]) as the first item on 
the Level line. This selection instructs Ventura to suppress 
printing of the higher level numbers. 

D Whenever Ventura encounters a Levell tag, it resets the 
numbering for all the lower levels. 

D Using Body Text to reset numbering will not work properly 
if you want to intersperse Body Text between consecutive 
numbers in the same list. In these cases, you can create a 
special Reset tag. Here's how you do it: First, go to the 
Auto-Numbering dialog box and place the tag name Reset 
on the Level 1 line. Now select an empty paragraph and add 
a tag called Reset. Align the new tag flush right. Set the 
line spacing to a very small amount. Use the Breaks dialog 
to set the Line Breaks to No. In essence, you will create an 
invisible tag that resides on the same line with other para-
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graphs. Its only function is to signal Ventura when to start 
renumbering from one. 

D When a tag with a ruling box around crosses a page or 
column boundary, the paragraph text continues but the 
ruling line does not. To avoid this problem, try creating the 
same effect with Box Textor text inside a frame. 

Picture tips 

D Frame anchoring allows you to tie frames to the text refer
ence they refer to. Once a frame has been anchored you can 
make large additions and deletions to a text file without 
worry that the frame will be displaced from its text refer
ence. 

D Like text references and footnotes, frame anchors can be 
typed directly into the text file in advance using a bracket 
code. The anchor codes are as follows (where anchor name 
is the frame reference name specified in Anchors & Cap
tions): 
Picture frame on same page: <$&anchor name> 
Picture frame below: <$&anchor name[ v]> 
Picture frame above: <$&anchor name[ 1\]> 
Picture frame floats with text <$&anchor name [-]> 

\ 

D Make sure you type the anchor name exactly the same in 
the InsertlEdit Anchor dialog box and the Anchors & Cap
tion dialog box. Otherwise Ventura cannot match the two 
references. 

AfisceHaneousUps 

D You can create a special spacer to insert extra spaces be
tween paragraphs. Simply tag an empty paragraph with 
the above, below, or inter-line spacing desired. 

D It is easier to draw crop marks manually if you temporarily 
reset the page margins to equal the trim size of the paper. 
Then you can use the column guides to help you position 
the marks. 
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Chapter Ten 

The Professional Extension 

Theory 

By completing the first nine chapters of Publishing Power 
you have gained a solid, working knowledge of Ventura. 

Now you are ready to advance beyond the basics to reach a 
higher level of expertise. In Chapter Ten, you will broaden 
your inventory of Ventura skills and techniques as you learn 
the specialized features of Ventura's Professional Extension. 
The checklist on the left gives a preview of the skills you will 
learn in this chapter. 

In the first half of the theory section, we will show you how to 
operate Ventura's Cross Reference feature. In the second half, 
we will cover the principles behind vertical justification and 
Ventura's automatic table generator, two features that bolster 
Ventura's professional publishing capabilities. 

'-NOTE: Because of time and space limitations, we did not 
include complex equation editing in this chapter. We did, how
ever, include a simple example of equation editing in the 
"Insert Fractions" section in Chapter Eight. 

Cross references 
As you begin to work on long documents of your own, you will 
find that keeping track of all the figures, tables, captions, and 
pictures is crucial to the success of the project .. With the 
Professional Extension, Ventura provides a high-powered 
device for creating and updating all the page, chapter, figure, 
table, caption, or section number references in a document. 
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Among other things, the Cross Referencing feature lets you 
keep track of pictures and text as you change a document. 

To help you understand cross referencing, let's apply its basic 
principles to the following hypothetical situation: 

Imagine that you have created a technical manual with fifty 
illustrations. You numbered each frame (with automatic fig
ure numbers) and gave it a Frame Anchor name. Figure 10-1 
shows how the Anchors & Caption dialog box would appear for 
a typical frame in our sample document. 

ANCHORS & CAPTI(liS 

Anchor: 1-1 __ _ 

Captioo : Below 

Label: Figure [FU].II-__________ _ 

Inserts: I Table " II Figll'e H II Chapter " II Text Attr I I 

Figure 10·1. 

In the text, you have also inserted a reference to each ill ustra
tion that reads "See Figure 1," "See Figure 2," and so forth 
(Figure 10-2). 

Now it's time to update the manual. You insert a new illustra
tion on the first page of the document. With Ventura's auto
matic figure numbering, when you add a frame, you ''bump 
up" all the subsequent figure numbers in the document. But 
the "See Figure ... " references in the text keep their old num
bers - which are now inaccurate. Normally you would have to 
renumber each one individually in Text mode. But if you use 
the Cross Reference feature to link each text reference with its 
corresponding frame, Ventura can update the numbers auto
matically. The following steps show how you can make a cross 
reference and link the text reference with a frame. We are 
assuming that you have already inserted frames and given 
them anchor names, as explained in Chapter Nine. 



Cross references 

Figure 10-2. 

bracketstowards the rear of the 
printer. Face the ribbed side up. 

~. Load paper in manual feed. Insert 
i one sheet of paperata time. Glide the 
i paper in the tray until it can't go any 
i further, then stop (See Figure 1-1). 
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-NOTE: The steps be/ow illustrate the theory of cross-refer
encing. Later in the chapter you will have a chance to try some 
hands-on practice. 

• Enable Text mode. 

• Place the text cursor where you want the figure number to 
appear. Typically, you would place the number after the 
word ''Figure'' as in Figure 10-3. 

Figure 10-3. 

onesheetof paperata time. Glfde the i 
paper along the tray until it can't go ! 

anyfurther, then stop (Figure~:~__j __ ~ 
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To insert a cross reference you would: 

• Select Ins Special Item from the Edit menu and choose 
Cross Reference (Figure 10-4). 

Figure 10-4. 

• Move to the At The Name line and type in the name of the 
frame you want to reference. 

-NOTE: Make sure you enter the same name as you entered 
for the Anchor Name line (Anchors & Captions dialog box). 
Otherwise, Ventura won't link up the frame with the cross 
reference. 

• Move to the Refer 1b line and enter the type of reference 
you want to create (Figure 10-5). For our example above, 
you would choose F# to references the figure numbers. 
Click OK to close the dialog box. 

No new numbers appear yet. First you must generate a cross 
reference for the chapter. 'Ib do so, you save the chapter(s) as 
a publication. Then you select Renumber from the Multi
Chapter dialog box. When Ventura renumbers the publica
tion, you will see the correct figure numbers inserted into the 
text (Figure 10-6). 

If cross referencing seems difficult, don't be concerned. 
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Table mode 

10 - 5 

Remember you are learning an advanced application that 
goes beyond everyday skills. It will become clear with practice. 

INSERT/EDIT REFERENCE 

At The Name: 1-1l-1 ___ _ 

Refer To: Ftt 

Figure 10-5. 

Figure 10-6. 

Format: Default 

[][] I Cancel I 

one sheet of paperata time. Glide the i 
paper along the tray until it can't go i 
anyfurther, then stop (Figure 1-1').' I 

In earlier chapters, you learned several methods for creating 
tables. Chapter 'I\vo showed how to format simple, single-line 
tables using Tab Settings. Chapter Eight explained side-by
side paragraphs for complex tables. In this chapter, you will 
learn how to use the Professional Extension's table editor, an 
advanced capability for generating simple or complex tables. 
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The parts of a table 
A table is any text (words or numbers) that is formatted in a 
grid of rows and columns (up to 9999 rows or columns with the 
Professional Extension). Each table is a collection of in
dividual grid units called "cells" (Figure 10-7). 

Desk File Edit Vie\! Chapter Frane Paragraph Graphic Options 

• ":§~:~~:~~:~~:~~:~~:~~:~~:~~:~-i::\ TYPESET\ilH I Tl£il.Ciii--[DfFAuLnfYq~i~~i~~i~~:~~i~~i~~i~~i~~:~~ • 
,. .1' .1'2 .1" .110 I'· .1" I" t 

!. 

I.!. ~ 

I.!, I 
+ Jtttl Ittttl + .. 

Figure 10-7. In Table mode, tables are constructed of individual cells. 

Ventura can place a ruling box around the table and ruling 
lines between each row and column. Or, at your option, you 
can hide or change any or all of the lines (Figure 10-8). 

Figure 10-8. 
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The table editor assigns row and column numbers. This built
in numbering system makes it easy to specify a cell or range of 
cells. For instance, Figure 10-9 shows the row and column 
numbers for a three-row by four-column table. 

Desk File Edit View Chapter Frane Paragraph Graphic Options 

I :~~!~~:~~:~~:~~:~~!~~:~~:~~:~ -f:\TViiESET\TitTiTi.ED.ciii--[DEFiiJn:sfYT~~:~~!~~:~~:~~:~~!~~:~~:~~:~~ • 
,0 .1' .1" I" .110 110 ,13

' ,I" t 

ROCO .. ROCI ROC1 .. ROC2 ROC2 .. ROC3 ROC3 .. ROC4 

RICO .. R1CI R1C1..R1C2 RIC2 .. R1C3 R1C3 .. RIC4 

R2co..R2Cl R2C1..R2C2 R2C2 .. R2C3 R2C3 .. R2C4 

'.!. 

Figure 10-9. 

In Figure 10-9, the grid cell in the upper left corner is 
ROCO ... ROC1, or row zero, column zero through row zero, 
column one. To see the position of a cell, point and click on one 
of its ruling lines. Ventura highlights the selected ruling line 
in gray and displays the range of rows and columns in the 
Current Selection Box (Figure 10-10). 

ROCO .. ROCI ROC1 .. ROC2 ROC2..ROC3 

R1CO .. RICI R1Cl .. RIC2 RIC2..RIC3 

R2CO .. R2CI R2CI .. R2C2 R2C2..R2C3 

Figure 10-10. 
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.. TIP: Ventura sees each grid cell as a box defined by four 
borders. 

Each cell can contain one or more lines of text. In fact, you can 
make every cell a different size. You can also dress up the 
table by adding a tint screen to an individual or group of cells. 
A tint screen adds visual contrast and helps separate diverse 
information . 

.. NOTE: You may not be able to get all of the effects if you do 
not have a PostScript printer. 

You can place a table on the Underlying Page or in a separate 
frame that resides on top of the Page. If your table is exces
sively long, you can instruct Ventura to continue the table 
across a column, a page, or a frame (Figure 10-11). 

Figure 10-11. 

Editing tables 
Mter you generate a table, you can use Ventura's standard 
editing tools to add or delete rows and columns. You start by 
highlighting the cell or range of cells you want to cut or copy. 
Then you select Cut or Copy Row/Column from the Edit menu 
(or press the Shift-Del or Del keys) to copy or cut cells to the 
clipboard. To paste a row or column, select the line between the 
row or column where you want to insert the cell(s) and select 
Paste from the Edit menu (or press the Ins key). 
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.. NOTE: You can select a ruling line even if it is hidden. 

In addition to cut, copy, and paste, Table mode lets you change 
the table specifications and change column widths. 

To change the table settings, click anywhere in the table and 
select Edit Table Settings from the Edit menu (or press Ctrl
D). The InsertlEdit Table dialog box appears. Now you can 
change the # of header rows, the ruling line attributes, and 
the spacing values for the entire table. 

Once you create a table, you cannot change the number of 
rows and columns through the InsertlEdit dialog box. Instead, 
you must add or subtract rows and columns using Ins Row 
and Ins Column from the Assignment List. To do this, you 
place the Table Edit cursor on the ruling line where you want 
to insert the row(s) or column(s). Then you drag the cursor 
across the number of cells you want to insert. If you drag the 
cursor over three rows, you are instructing Ventura to insert 
three rows. If you drag the cursor across two columns, you are 
instructing Ventura to add two columns. Mter selecting the 
number of rows or columns to add, select Ins Row or Ins 
Column from the Assignment List. 

To change the width of a column, click on the column you wish 
to change then select Set Column Widths from the Edit menu. 
The current column number is displayed on the Column Num
ber line (Figure 10-12). 

TABLE COLUMN WIDTHS 

Column Number: I + I I + I 
Width Setting: Variable 

Fixl:ld ~idt;h: (0)00 picas & points 
Variable Width: 00011 proportions 

DO \ Cancel \ 

Figure 10-12. 
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.. NOTE: To change the column number, click on the left or right 
arrows next to the Column Number. 

In the Set Column Width dialog box, you can change the 
column width by a fixed or variable amount. If you choose 
Width Settings: Fixed, Ventura applies the width you specify 
to the selected column. To make the column exactly 06,00 
picas & points wide, you would enter 06,00 for the Fixed 
Width (Figure 10-13). 

TABLE COLUMN WIDTHS 

Colur~n Nur~ber: I + I 1 I + I 
Width Setting: Fixed 

Fixed Width: 06 J 00 picas & points 
!hlr>iah Ie Width: 1 ~WO proportions 

OK I Cancel I 

Figure 10-13. 

On the other hand, if you choose Variable Width, Ventura 
sizes the current column in proportion to all the other columns 
in the table. For instance, if you entered a variable width of 2, 
Ventura would give the current column two proportional units 
of the space left over after creating the fixed columns. Perhaps 
the easiest way to understand variable widths is to use per
centages. Let's say you assign columns 1, 2, and 3 variable 
widths of20, 30, and 50. Ventura will give column 1 20 percent 
of the space, column 2 30 percent, and column 3 50 percent. 
From there, it should be apparent that you could also enter 
widths of 2, 3, and 5 to achieve the same effect. To make things 
easy on yourself, when first learning variable widths, make 
sure that the numbers you enter always add up to a total of10 
or 100 (Figure 10-14). 
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Ilesk File Edit View Chapter FraJIe Paragraph &-aphic Options 
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Figure 10-14. 

To determine the size of each column, Ventura uses the vari
able proportion you enter in the InsertlEdit Table dialog box 
and calculates the relative proportions of the current column 
width, the fixed column widths, and the overall width of the 
table. 

You can also change column widths interactively. In Table 
mode, put the cursor anywhere in the column you want to 
change. Press and hold down the Alt key. A line appears from 
the top to the bottom of the screen (Figure 10-15). Move the 
line to change the position of the right-hand column. 

Figure 10-15. Press and hold the alt key while sliding the mouse to 
interactively change the column width. 
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Table text 

Theory 

Now that you've learned how to set up the physical dimen
sions of a table, let's take a look at the "text" part of tables. For 
every cell in the table Ventura automatically generates a tag 
named Table Text. You can format it with the attributes from 
Paragraph menu or rename it as a different tag. In this 
chapter's table, you will change the text attributes of Table 
Text and add a new tag for the table title. 

Vertical justification 
Vertical justification is a sophisticated typographic technique 
that makes text fill to the bottom of a column, frame, or page. 
Just as horizontal justification aligns text on both right and 
left edges of a column or page, vertical justification aligns text 
with the top and bottom edges of a column or page (Figure 
10-16 and Figure 10-17). 

Figure 10-16. Before applying vertical justification. 

To understand vertical justification, you must first under
stand why Ventura cannot always fill text to the bottom of the 
page. As you know from earlier projects, Ventura flows as 
much text onto a page or frame as possible, then stops. If the 
text file you place does not contain enough text to reach the 
bottom, a large gap is left over. Likewise, gaps are made when 
you force headings to stay with the following text using Keep 
With Next (Breaks menu), and when you prevent single lines 
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Figure 10-17. After applying vertical justification. 

of text at the top or the bottom of the page with the Widows 
and Orphans control (Chapter Typography menu). Further
more, you make extra spaces whenever you arbitrarily insert 
a page or column break (Figure 10-18). 

Figure 10-18. 

To eliminate unattractive "holes" at the bottom of a page, you 
can use the vertical justification control in the Professional 
Extension. Ventura will add space until the text reaches the 
bottom of the column or page according to the rules you define. 
You tell Ventura how much space to add between frames, 
paragraphs, tables, and lines of text. Ventura then adds space, 
to the maximum you specified, in the following order: 
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1. Between frames and the surrounding text 

2. Between paragraphs or between paragraphs and tables 

3. Between individual lines of text 

.. NOTE: During vertical justification, space is always added, 
never subtracted. Vertical justification never moves text across 
the boundary of a page. 

For a preview of each vertical justification control, take a 
moment to read through Table 9-1. The table shows you 
where to find each vertical justification control, which settings 
are available, and what each option does. 

Because vertical justification is an advanced typographic ef
fect, you may not understand the effects of every vertical 
justification control. Don't let that bother you. For now, con
centrate on observing how text flows and reflows on the page 
before and after you turn on vertical justification. Then try 
changing one or another vertical justification setting to see 
the results. As you already know, the best way to understand 
a complex feature is to explore its options on your own. For the 
project in this chapter, you will have the chance to experiment 
with vertical justification as you fine-tune the page format in 
the technical manual. 

Now that you've read through the theory section of the chap
ter, you are prepared for some hands-on practice. In the next 
few sections, you will have a chance to apply the Professional 
Extension's powerful tools to a real-life project. 
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Table 9-1. Vertical Justification Settings 

Menu Setting Option What It Does 

Carding Space added in multiples of Body Text 
inter-line spacing only 

Vert. Just. Within Frame 
Space added in exact amount of space 

Feathering needed for text to reach the bottom of 
the page or column 

Moveable Frame can be moved down and space 

Chapter added below 

Typography Vert. Just. Around Frame 
Frame cannot be moved from its original 

Fixed position. 
Space can be added below frame only 

Vert. Just. Allowed 100.0% Increase or decrease amount of vertical 
justification allowed on each page 

At Top of Frame Enter value Set equal to Body Text inter-
line spacing 

At Bottom of Frame Enter value Set equal to Body Text inter-
line spacing 

Frame Can override global settings from Chap-

Typography Same as Chapter Typography same ter Typography menu for an individual 
frame or inserted page 

Vert. Just. At Top of Para Enter value Set equal to Body Text Above Spacing 
Paragraph 
Typography Vert. Just. At Bottom of Para. Enter value Set equal to Body Text Below Spacing 

Between Lines of Para Enter value Set to zero 

InsertlEdit Same as Paragraph Typography Tables are treated like paragraphs for 
Tables same vertical justification 
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Ventura prep 
For this project you will work with the technical manual you 
created in Chapter Nine of Publishing Power. If you have 
already completed the project in Chapter Nine, follow the 
instructions outlined in the section, "If you completed chapter 
nine." If you did NOT complete Chapter Nine, you can use the 
preformatted chapter supplied on the Power Disk, following 
the instructions in the section "If you have the Power disk." If 
you do not own the Power disk and you did not complete 
Chapter Nine, follow the instructions in the section "If you do 
not have the Power disk." 

-NOTE: We recommend that you finish Chapter Nine before 
you venture any further with the Professional Extension. 
Otherwise, you may find it difficult to follow along. Many skills 
presented in this chapter build on techniques in Chapter Nine. 

II If you have the Power disk 
m Open the chapter C:\POWER\PROFEXT.CHP. 

1m Use Save As New Style to save the style sheet as 
C:\TEMP\PROFEXT.STY. 

1m Use File TypelRename to rename the text file as 
C: \ TEMP \ PROFEXT.TXT. 

m Save the chapter as C:\TEMP\PROFEXT.CHP. 

If you do not have the Power disk 
~ Use your word processor to type in the text file for Chapter 

Ten from Appendix A. Load it in Ventura and save it as 
C: \ TEMP\PROFEXT.TXT. 

~ Load the original style sheet &TBL2-L1.STY from the 
C:\TYPESET subdirectory. Use the tag table for Chapter 
Ten from Appendix A to change the columns and margins 
and the tag definitions you will need for the project. Then \ 
save the revised style sheet as C: \ TEMP\PROFEXT.STY. 

\ 
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Figure 10-19. Those WITHOUT the Power disk must insert the above 
frames into the document. 

m Add frames to pages in the document (Figure 10-19). 

m Save the chapter as C:\TEMP\PROFEXT.CHP. 

If you completed chapter nine 

Text 

m Open the chapter 9TECHDOC.CHP from the C:\TEMP 
subdirectory. 

~ Use Save As New Style to save the style sheet as 
C:\TEMP\PROFEXT.STY. 

~ Use File/Type Rename to rename the text file as 
C: \ TEMP\PROFEXT. TXT. 

m Save the chapter as C: \ TEMP\PROFEXT.CHP. 

How many times have you used your word processor's search 
and replace feature to quickly update information in a text 
file? More than likely, search and replace has become an 
indispensable part of your text editing tool kit. In this section, 
we will show you how to use the Professional Extension's cross 
referencing feature to replace text while you are in Ventura. 

Before you can trigger the replace operation, you must define 
the variable text and the substitute text. Variable text is a 
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word or phrase that changes in the document. For instance, in 
the sample technical manual, the product name, "Laser Astro
Z," is the variable. (The product name will change when the 
XYZ corporation manufacturers a new line of printers next 
month.) The substitute text in our example is the new product 
name, "TurboSpeed-X." When you activate the replace func
tion, the new product name will appear throughout the docu
ment. 

After you define the variable and substitute text, you must 
insert a cross reference marker in the text wherever you want 
the substitute text (the product name) to appear. For instance, 
on page one of the document you would delete the words Laser 
AstroZ, then insert a cross reference in the space between the 
words "the" and "printer" in the first paragraph "Thank you 
for choosing the __ printer from XYZ Corporation." 

- TIP: The cross reference you insert is a hidden text attribute, 
similar to the hidden footnote and index attributes you inserted 
in Chapter Eight. If you want to see the attribute marker (the 
degree symbol) displayed on-screen, make sure you select 
Show Tabs & Returns from the Options menu. -

After all cross reference markers are inserted, you will select 
Renumber from the Multi-Chapter dialog box to activate the 
replace operation. From now on, whenever you want to change 
the product name in the manual, just enter new substitute 
text and Renumber the chapter. 

-NOTE: You can replace different variables within one chapter. 

Now it's time to apply the theory to a practical test. Start by 
defining the text variable. 

m Go to page one (the cover page) of the technical manual. 

1m Enable Text mode. 

~ Place the text cursor before the "T" in the word "The" 
(Figure 10-20). 

1m Select Ins Special Item from the Edit menu. Choose Vari
able Def(or press the F8 key). 
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Figure 10-20. 

~ Move to the Variable Name line and type: Product, which 
is the variable name to which you will refer when you insert 
the cross reference attributes in the text file. 

~ariaole ~arne: ~roduct __ 

Suostitute Jext: lurDo~peea'X:-1 -------11 

-NOTE: When you insert a variable text definition in a text file, 
Ventura generates a hidden attribute and attribute marker (you 
can see the marker, a degree symbol, when Show Tabs & 
Returns is on). By inserting the attribute marker at the begin
ning of the document, you make it easier to locate. 

Now move to the Substitute Text line and type: 
TurboSpeed-X 
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The words Variable Def. appear in the Current Selection Box 
and a degree symbol is displayed on-screen to show the hidden 
text attribute. Later, when you renumber the publication, 
Ventura will insert the name ''TurboSpeed-X,'' at each cross 
reference location. 

Now that you've entered the variable and substitute text, you 
are ready to insert the cross reference markers. 

B While you are in Text mode, delete the name "Laser Astro
Z," on the cover page. (Be careful not to delete the variable 
definition you just inserted.) 

Now you will place a cross reference after the title word 'The" 
on the cover page. 

m Without moving the cursor, select Ins Special Item from the 
Edit menu (Figure 10-21). 

r····································· .. ············: 

:The ~i: 
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, I i 

:::.: 

Figure 10-21. 

~ Choose Cross Reference (or press F6). Move to the At The 
Name line and type: Product 

~ Choose Refer To: V* and click OK (Figure 10-22). 

The word Reference appears in the Current Selection Box and 
a degree symbol is displayed on-screen to show the hidden 
text attribute. 

You will now continue to insert cross references in the docu
ment. 
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m Press PgDn to go to page 2. 

~ Delete the first occurrence of the words "Laser AstroZ," in 
the first paragraph of the second column. Be careful to 
retain the space before and after. (Figure 10-23). 
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Now you will place another cross reference between the words 
"the" and "printer" in the first paragraph. 

m Without moving the text cursor, select Ins Special Item 
from the Edit menu (Figure 10-24). 
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Figure 10-24. 

Text 

m Choose Cross Reference (or press F6). Move to the At The 
Name line and type: Product 

m Choose Refer To: V* and click OK to close the dialog box .. 

Repeat the steps above to insert five more cross references in 
place of the name Laser AstroZ everywhere in the document 
(pages 2, 3, and 5). 

Now that you've inserted all the cross references, you are 
ready to Renumber the chapter. 

~ Save the chapter by pressing Ctrl-S. 

~ Select Multi-Chapter from the Options menu. The chapter 
C:\PROFEXT.CHP appears at the top of the list . 

.. NOTE: If the PROFEXT.CHP chapter is not listed, select New 
to start a new publication. Then choose Add Chapter. Move to 
the C:\TEMP subdirectory and select the chapter PROF
TEXT. CHP. Ventura will return you to the Multi-Chapter dialog 
box and place the PROFEXT.CHP at the top of the list. 

!lm Select Save As to save the publication as 
C: \ TEMP\PROFEXT.PUB. 

Once you've made the publication, you can renumber it . 

.. NOTE: Be sure the chapter is not highlighted. Otherwise, the 
Renumber operation will not be available for selection. 
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@BODYFIRST = <B>Acme Company<D> has an
nounced a new large-screen display compatible 
with Xerox Ventura Publisher. The new B-X-I00 
is the first display to incorporate four graphics 
co-processors. A co-processor is a specialized 
microchip that speeds display speed. The 19-inch 
monitor and add-in graphics adapter will ship in 
the last quarter of this year. 'II 
'II 
@BODYFIRST = <B>The Ventura Classroom<D> 
is now open from 5:00 to 7:00 p.m Tuesday and 
Thursday of every week. A member of the Market
ing Communications Department will be on hand 
during those hours to answer questions and help 
with problems.'II 
'II 
@BODYFIRST = <B>An employee discount<D> 
was announced for the purchase of small com
puters. XYZ, which receives a volume discount on 
its computer purchases, has made arrangements 

ASCII file to create: C:\ TEMP\6NEWS-4. TXT 

@STAFFBOX = Paginations is published quarter
ly for the employees of XYZ Corporation, Los An
geles, CA. Copyright 1989 by XYZ Corporation, all 
rights reserved. Reproduction in whole or in part 

ASCII file to create: C:\ TEMP\6NEWS-5. TXT 

@KICKER = Tip of the month'II 
'II 
@HEAD3 = Preformatting Ventura documents'II 
'II 
@BODYFIRST = Ventura Publisher allows you to 
preformat text files by inserting tags names into 
the original word processing file. By inserting 
these tags in advance, you save the time of paging 
through the document and tagging each text para
graph in Ventura. This is also a handy way to 
divide responsibilities, so writers can tag docu
ments without worrying what the format will look 
like.'II 
'II 
Preformatting is the ultimate time-saver and it's 
not difficult. One simple trick is to program the 
tag names into a keyboard macro processor to 
save typing time. The proper format uses the at 
sign (@) at the left margin followed by the name of 
the tag, an equals sign (=) and the text. Thus, if 
we were using a word processor to preformat this 
article, the title might look like this in the file:'II 
'II 
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to pass this discount on to employees who wish to 
buy computers or related equipment for home use. 

@BODYFIRST = <B>A new desktop publishing
related job position<D> has been created in the 
Engineering Department, which recently an
nounced its intention to convert its entire library 
of technical documentation to electronic form. 
Now the production of technical manuals and 
other technical documentation will be automated 
as well. In accordance with company policy, the 
new position will be filled from within XYZ if 
possible. If no suitable internal candidates 
present themselves within two weeks, the job will 
be advertised in local papers.'II 
'II 
@BODYFIRST = <B>ABC Company<D> has 
released a low-cost document scanner capable of 
sensing and transmitting 16 levels of gray. Priced 
under $3,000, the scanner permits desktop pub
lishers to convert halftones to electronic form. 

without written permission is strictly forbidden. 
The editors welcome submissions, but cannot be 
responsible for manuscripts or their return. 

@HEADLINE 
ments'II 
'II 

Preformatting Ventura docu-

Don't forget the space at both sides of the equals 
sign and don't forget to spell the tag name exactly 
as it appears in the style sheet. Approved XYZ 
style sheets come with a listing of all the tag 
names for handy reference. As you add tags to the 
style sheet, you can capitalize the name or not as 
you prefer. Many people choose to use all capitals, 
or start the name with a symbol such as ! so the 
tags stand out from the text. 'II 
'II 
@HEAD4 = Choosing tag names'II 
'II 
By choosing <169>generic<170> tag names, you 
will find that you can reuse them over and over 
again. For instance, tags like <169>Title,<170> 
<169>List,<170> and <169>Subhead<170> will 
apply to most documents. Then by changing style 
sheets, you can ch~mge the entire format of the 
document.'II 
'II 
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If you don't like the keyboard macro idea, try 
building word processor template meso Load an 
unformatted text file into Ventura and tag it as 
you would normally. When everything is perfect, 
save the chapter (thereby saving the tags into the 
text file.err 
err 
Now make a copy of the me under a new name. 
Remove the text, leaving only the tags. Assuming 
the tag names are self-descriptive, a template 
makes it fill-in-the-blanks simple to create prefor
matted files. To make it even simpler, annotate 
the template with the word processor's hidden 
text feature.err 

ASCII file to create: C:\ TEMP \6 TOC. TXT 

INSIDE err 
'II 
@TOCENTRY 
underway~l'II 

'II 

Chapter Seven 

Training workshops 

ASCII file to create: C:\ TEMP\7DIRECT. TXT 

@HEADSECTION = Manufacturers 'II 
'II 
@HEAD1=A'II 
'II 
@HEAD2 = Adobe, Inc'II 
err 
1870 Embarcadero Rd.<lbPalo Alto, CA 94303'II 
err 
@HEAD3 = Product: 'II 
err 
@ITALKWN = PostScript, Illustrator, Adobe Type 
Libraryerr 
err 
@HEAD3 = Phone:'II 
err 
@ITALSEPARATE = (415) 852-0271 'II 
'II 
@HEAD2 = Allied Linotype Co.err 
err 
425 Oser Ave.<R> Hauppauge, NY 11788err 
err 
@HEAD3 = Product: 'II 
err 
@ITALSEPARATE = Linotronic 100 and 300'II 
err 
@HEAD3 = Phone: 'II 
'II 

Text Files 

'II 
The template method is particularly useful when 
an editor must work with multiple authors. err 
'II 
Authors can also assist in the layout process by 
inserting tags that create space for illustrations. 
If you uses visuals in standard sizes, create a tag 
that leaves the correct amount of space on the 
page. The authors can type in the name of the 
illustration or even its caption. This tagged para
graph creates space where the layout editor will 
want to place the actual frame. The editor can 
delete the tag and insert the frame that will con
tain the illustration. 

@TOCENTRY = Ventura complements CAD~l 'II 
«J[ 
@TOCENTRY = Newsline~2'II 
«J[ 
@TOCENTRY=Tip of the month~3 

@ITALSEPARATE = (516) 434-2016err 
«J[ 
@HEAD2 = Autodesk, Inc. err 
«J[ 
2320 Marinship Way<R>Sausalito, CA 94965«J[ 
«J[ 
@HEAD3 = Product:err 
«J[ 
@ITALKWN = AutoCAD, AutoSketch«J[ 
«J[ 
@HEAD3 = Phone:«J[ 
«J[ 
@ITALSEPARATE = (415) 332-2344«J[ 
err 
@HEAD1=D'II 
«J[ 
@HEAD2 = Datacopy Corp.«J[ 
«J[ 
1215 Terra Bella Ave<R>Mountain View, CA 
94043«J[ 
«J[ 
@HEAD3 = Product:«J[ 
«J[ 
@ITAL KPWTHNXT = Model 730 Scanner'II 
«J[ 
@HEAD3 = Phone:«J[ 
«J[ 
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@ITALSEPARATE = (415) 965-7900CJI 
CJI 
@HEAD2 = Digital Research Inc. CJI 
CJI 
60 Garden Court<R>Monterey, CA 93942CJI 
CJI 
@HEAD3 = Product: CJI 
CJI 
@ITALKWN = GEM Desktop, GEM Draw Plus, 
GEMPaintCJI 
CJI 
@HEAD3 = Phone: CJI 
CJI 
@ITALSEPARATE = (408) 649-3896CJI 
CJI 
@HEAD1 == HCJI 
CJI 
@HEAD2 = Hewlett-PackardCJI 
CJI 
P.O. Box 15<R>Boise, ill 83707CJI 
CJI 
@HEAD3 = Product: CJI 
CJI 
@ITALKWN = LaseIjet Plus, LaseIjet II, Scanjet 
CJI 
CJI 
@HEAD3 = Phone: CJI 
CJI 
@ITALSEPARATE = (208) 323-3869CJI 
CJI 
@HEAD1 = ICJI 
CJI 
@HEAD2 = Imagen CJI 
CJI 
2650 San Tomas Expressway<R>Santa Clara, CA 
95051CJI 
CJI 
@HEAD3 = Product: CJI 
CJI 
@ITALKWN = DDL LanguageCJI 
CJI 
@HEAD3 = Phone:CJI 
CJI 
@ITALSEPARATE = (408) 986-9400CJI 
CJI 
@HEAD1= LCJI 
CJI 
@HEAD2 = Lotus Development Corp. CJI 
CJI 
55 Cambridge Parkway<R>Cambridge, MA 
02142CJI 
CJI 
@HEAD3 = Product: CJI 
CJI 

A-II 

@ITALKWN = Lotus 1-2-3, Symphony, Freelance, 
GraphwriterCJI 
CJI 
@HEAD3 = Phone: CJI 
CJI 
@ITALSEPARATE = (617) 577 -8500CJI 
CJI 
@HEAD1=MCJI 
CJI 
@HEAD2 = Media CyberneticsCJI 
CJI 
8484 Georgia Ave., Ste. 200<R>Silver Spring, MD 
20910CJI 
CJI 
@HEAD3 = Product: CJI 
CJI 
@ITALKWN == Halo Desktop Publishing EditorCJI 
CJI 
@HEAD3 = Phone: CJI 
CJI 
@ITALSEPARATE = (301) 495-3305CJI 
CJI 
@HEAD2 = MicroPublishingCJI 
CJI 
21150 Hawthorne Blvd., Ste. 104<R>Torrance, 
CA90503CJI 
CJI 
@HEAD3 = Product: CJI 
CJI 
@ITALKWN = microPublishing Report N ewslet
ter, Ventura Style SheetsCJI 
CJI 
@HEAD3 = Phone: CJI 
CJI 
@ITALSEPARATE = (213) 376-5724CJI 
CJI 
@HEAD1=RCJI 
CJI 
@HEAD2 = Ricoh Corp.CJI 
CJI 
5 Dedrick Place<R>West Caldwell, NJ 07006CJI 
CJI 
@HEAD3 = Product: CJI 
CJI 
@ITALKWN = IS30 ScannerCJI 
CJI 
@HEAD3 = Phone: CJI 
CJI 
@ITALSEPARATE = (201) 882-2000CJI 
CJI 
@HEAD1 = SCJI 
CJI 
@HEAD2 = Sigma DesignsCJI 
CJI 
46901 Landing Parkway<R>Fremont, CA 94538CJI 
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'II 
@HEAD3 = Product: 'II 
'II 
@ITALKWN = LaserView Display System'II'II 
'II 
@HEAD3 = Phone: 'II 
'II 
@ITALSEPARATE = (415) 770-0 100 'II 
'II 
@HEAD2 = Symsoft'II 
'II 
P.O. Box 477<R>Mountain View, CA94040'II 
'II 
@HEAD3 = Product: 'II 
'II 
@ITALKWN = HotShot'II 
'II 
@HEAD3 = Phone: 'II 
'II 
@ITALSEPARATE = (415) 941-1552'II 
'II 
@HEAD1=T'II 
'II 
@HEAD2 = Tall Tree Systems 'II 
'II 

ASCII file to create: C:\ TEMP\7DIRECT2. TXT 

@HEADSECTION = Products 'II 
'II 
@HEAD1=F'II 
'II 
@HEAD2 = Fonts and Font Software'II 
'II 
@HEAD4 = Adobe Typeface Library'II 
'II 
@COMPANY = Adobe Systems Inc.'II 
'II 
@HEAD3 = PostScript:'II 
'II 
@ITALKWN = Yes'II 
'II 
@HEAD3 = Computers:'II 
'II 
@ITALKWN = Macintosh, IBM PC'II 
'II 
@PHONE = (415) 852-0271 'II 
'II 
@HEAD4 = Conofonts'II 
'II 
@COMPANY = Conographics'II 
'II 
@HEAD3 = PostScript:'II 
Cj[ 
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1120 San Antonio Rd.<R>Palo Alto, CA 94303'II 
'II 
@HEAD3 = Product: 'II 
'II 
@ITALKWN = JLaser Plus'II 
'II 
@HEAD3 = Phone: 'II 
'II 
@ITALSEPARATE = (415) 964-1980'II 
'II 
@HEAD1=V'II 
'II 
@HEAD2 = Verticom, Inc.'II 
'II 
545 Weddell Dr.<R>Sunnyvale, CA 94089-2114'II 
'II 
@HEAD3 = Product: 'II 
'II 
@ITALKWN = Desktop 1280'II 
'II 
@HEAD3 = Phone: 'II 
'II 
@ITALSEPARATE = (408) 747-1222'II 
'II 

@ITALKWN = No'II 
'II 
@HEAD3 = Computers:Cj[ 
'II 
@ITALKWN = IBM PC'II 
'II 
@PHONE = (714) 474 -1188'II 
'II 
@HEAD4 = Fluent Fonts'II 
'II 
@COMPANY = Genny Software Research and 
Development'II 
'II 
@HEAD3 = PostScript:'II 
'II 
@ITALKWN = Yes'II 
'II 
@HEAD3 = Computers:'II 
'II 
@ITALKWN = Macintosh'II 
Cj[ 
@PHONE = (409) 860-5817'II 
'II 
@HEAD4 = Hewlett Packard Soft Fonts'II 
'II 
@COMPANY = Hewlett PackardCj[ 
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~HEAD3 = PostScript:'ll 
'II 
@ITALKWN = No'll 
'II 
@HEAD3 = Computers:1!! 
'II 
@ITALKWN = IBM PC'll 
'II 
@PHONE = (800) 538-87871!! 
I!! 
@HEAD4 = PC Fontwarel!! 

!COMPANY = Bitstreaml!! 

~HEAD3 = PostScript:'ll 
'II 
@ITALKWN = No'll 
I!! 
@HEAD3 = Computers:1!! 
'II 
@ITALKWN = IBM PC'll 
'II 
@PHONE = (617) 497-62221!! 
'II 
@HEAD1=GI!! 

!HEAD2 = Graphics Software I!! 
I!! 
@HEAD4 = AutoCADI!! 
'II 
@COMPANY = Autodesk,Inc. 'II 

!HEAD3 = Ventura Format:'II 
I!! 
@ITALKWN = SLD or GEMI!! 
I!! 
@HEAD3 = Computers:1!! 
I!! 
@ITALKWN = IBM PCI!! 
'II 
@PHONE = (415) 332-23441!! 

~HEAD4 = Desktop Publisher's Graphicsl!! 
'II 
@COMPANY = IMSII!! 
I!! 
@HEAD3 = Ventura Format:1!! 
'II 
@ITALKWN = Image'll 
'II 
@HEAD3 = Computers:1!! 
I!! 
@ITALKWN = IBM PC'll 
'II 

@PHONE = (415) 454-7101'11 
I!! 
@HEAD4 = Halo DPEI!! 

I!! . m 
@COMPANY = Media Cybernetics II 

I!! . 
@HEAD3 = Ventura Format. I!! 
I!! 
@ITALKWN=HaloDPEI!!I!! 
I!! 
@HEAD3 = Computers:1!! 
I!! 
@ITALKWN = IBM PCI!! 
I!! 
@PHONE = (301) 495-33051!! 

!HEAD4 = PC Paintbrush Plus'II 
'II 
@COMPANY = ZSoftl!! 

I!! . 
@HEAD3 = Ventura Format. I!! 

!ITALKWN = PC Paintbrush'll 
I!! 
@HEAD3 = Computers:1!! 
I!! 
@ITALKWN = IBM PCI!! 
I!! 
@PHONE = (404) 980-19501!! 
I!! 
@HEAD1=MI!! 

'II . 
@HEAD2 = Momtorsl!! 

!HEAD4 = Crystal View'll 
I!! 
@COMPANY = Taxan'll 

I!! . m 
@HEAD3 = ResolutIOn: II 
I!! 
@ITALKWN = 1,280 x 9601!! 

!HEAD3 = Display Size:'ll 
I!! 
@ITALKWN = 19 I!! I!! 
I!! 
@PHONE = (818) 810-1291 I!! 

I!! . m 
@HEAD4 = Laservlew II 

!COMPANY = Sigma Design'II 

I!! . m 
@HEAD3 = ResolutIOn: II 
'II 
@ITALKWN = 1,664 x 12001!! 

A-13 
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en 
@HEAD3 = Display Size:en 
en 
@ITALKWN = 19en 
en 
@PHONE = (415) 770-0100en 
en 
@HEAD4 = Viking len 
en 
@COMPANY = Monitermen 
en 
@HEAD3 = Resolution:en 
en 
@ITALKWN = 1,280 x 960en 
en 
@HEAD3 = Display Size:en 
en 
@ITALKWN = 19.6en 
en 
@PHONE = (612) 935-4151en 
en 
@HEAD4 = Wy-700en 
en 
@COMPANY = Wyse Technologyen 
en 
@HEAD3 = Resolution:en 
en 
@ITALKWN = 1,280 x 800en 
en 
@HEAD3 = Display Size:en 
en 
@ITALKWN = 15en 
en 
@PHONE = (408) 433-1000en 
en 
@HEAD1=Sen 
en 
@HEAD2 = Scanners - Graphics and OCRen 
en 
@HEAD4 = Crystal Scan Image Scanner Model 
3001en 
en 
@COMPANY = Taxan Corporation en 
en 
@HEAD3 = Scan Area:en 
en 
@ITALKWN = Platen Feed en 
en 
@HEAD3 = List Price:en 
en 
@ITALKWN = $1,695en 
en 
@PHONE = (818) 810-1291 en 
en 
@HEAD4 = Datacopy 730en 
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en 
@COMPANY = Datacopyen 
en 
@HEAD3 = Scan Area:en 
en 
@ITALKWN = Flatbeden 
en 
@HEAD3 = List Price:en 
en 
@ITALKWN = $1,800en 
en 
@PHONE = (800) 821-2898en 
en 
@HEAD4 = Microtek MS-300Cen 
en 
@COMPANY = Microtek Lab, Inc. en 
en 
@HEAD3 = Scan Area:en 
en 
@ITALKWN = Platen Feeden 
en 
@HEAD3 = List Price:en 
en 
@ITALKWN = $1,795en 
en 
@PHONE = (213) 321-2121 en 
en 
@HEAD4 = The Laser Scanner, Model KS-300en 
en 
@COMPANY = Princeton Graphics Systems en 
en 
@HEAD3 = Scan Area: en 
en 
@ITALKWN = Platen Feeden 
en 
@HEAD3 = List Price:en 
en 
@ITALKWN = $1,095en 
en 
@PHONE = (609) 683-1660en 
en 
@HEAD1 = Uen 
en 
@HEAD2 = Utilities en 
en 
@HEAD4 = PubSeten 
en 
@COMPANY = EDCO Services en 
en 
@HEAD3 = Description:en 
en 
@ITALKWN = Software typesetter driver to send 
Ventura documents directly to your typesetteren 
en 
@HEAD3 = List Price:en 
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'II 
@ITALKWN = $4,233Cj[ 
Cj[ 
@PHONE = (813) 962-7800Cj[ 
Cj[ 
@HEAD4 = VProolboxCj[ 
Cj[ 
@COMPANY = SNA, Inc. Cj[ 
Cj[ 
@HEAD3 = Description:Cj[ 
Cj[ 
@ITALKWN = File management program that 
lets you review the contents of related files and 
style sheetsCj[ 
Cj[ 
@HEAD3 = List Price:Cj[ 
'II 
@ITALKWN = $99Cj[ 
'II 
@PHONE = (609) 683-1237'II 
'II 
@HEAD4 = VP/Saddle'II 
'II 
@COMPANY = The Laser EdgeCj[ 
'II 
@HEAD3 = Description:Cj[ 

Chapter Eight 

A - 15 

Cj[ 
@ITALKWN = Enhanced features for printing 
books and booklets with PostScript PrintersCj[ 
Cj[ 
@HEAD3 = List Price:~ 
Cj[ 
@ITALKWN = $79Cj[ 
Cj[ 
@PHONE = (415) 835-1581 'II 
Cj[ 
@HEAD4 = Headline'll 
Cj[ 
@COMPANY = CorelCj[ 
Cj[ 
@HEAD3 = Description:Cj[ 
Cj[ 
@ITALKWN = Application program which gives 
access to the powerful graphics features of Post
ScriptCj[ 
Cj[ 
@HEAD3 = List Price:~ 
Cj[ 
@ITALKWN = $89Cj[ 
Cj[ 
@PHONE = (613) 728-8200'II 
Cj[ 

ASCII files to create: C:\ TEMP \8BO OK. TXT and C:\TEMP\8PRINT. TXT 

If you do not want to type in the two text files 
below, substitute two text mes of your own and 
rename them as shown above. Text files of five 

ASCII file to create: C:\ TEMP\ BO OK. TXT 

@CHAP# = Chapter SixCj[ 
Cj[ 
@CHAPTITLE = <$IDesign;Design Prin
ciples>Design PrinciplesCj[ 
Cj[ 
@BODYFIRST = Getting top-quality books from a 
desktop publishing system requires special know
how in two areas: design and printing. This chap
ter discusses the theory of design. The following 
chapter, Chapter Seven, outlines the steps to take 
before going to a commercial printer. Cj[ 
'II 
This chapter offers comments on the principles of 
<$IBooks;Book design>book design <Ml>as they 
apply to desktop publishing<D>. In some cases, 
the realities of desktop publishing force changes 
from traditional methods. Cj[ 

pages or longer are best. Save them in ASCII 
format. 

Cj[ 
@HEAD1 = Design TerminologyCj[ 
Cj[ 
If you're new to page design and typography, 
you'll need to learn a few words. You'll encounter 
this vocabulary over and over again in software 
manuals and in conversations with graphic desig
ners and commercial printers. This specialized 
terminology applies to three areas: (1) describing 
pages, (2) measuring pages and (3) describing 
type.Cj[ 
Cj[ 
@HEAD2 <$IDescribing pages>Describing 
Pages Cj[ 
Cj[ 
The most common page elements used in tradi-
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tional and desktop publishing are described 
below:1JI 
IJI 
A <$ICallouts>callout is a brief text label used to 
describe one part of an illustration. Callouts are 
often accompanied by arrows.<MS>1JI 
IJI 
A <$ICaption>caption is a brief description that 
labels or describes the entire illustration. Also 
referred to as a <$ACutline;Caption><Ml>cut
line<D> or a <Ml>legend<D>. 'II 
'II 
The chapter number and chapter title identify the 
section of the book. Often one or both are repeated 
in the header.1JI 
'II 
<$ICrop marks><$SCrop marks;Describing 
Pages>Crop marks are small lines, usually at the 
corner of the live area, that show the offset 
printer where to cut the pages after printing. 
They are also used by the printer to align each 
page correctly. Also called <$ICorner Marks><$A
Corner marks;Crop marks>corner marks, or<Ml> 
<D>trim marks.'II 
'II 
The <$IFolio>folio is the page number.'II 
IJI 
A <$IFooter>footer is a line or two of text that 
appears at the bottom of every page (or almost 
every page). A footer may include the folio (page 
number) or other information. 'II 
'II 
A <$IGutter>gutter is the white space between 
two areas of text. Gutters appear between 
columns on a page. The word also refers to the 
margin between facing pages.<MS>'II 
'II 
A <$IHeader> header is a line or two of text that 
appears at the top of every page (or almost every 
page). A header often includes the title of the 
book, the title of the chapter and/or the 
folio .<MS> <D>Alternating <$IHeader;Alternat
ing headers and footers>headers and footers put 
different information on left and right pages. 
Quite often the header is omitted from the<Ml> 
<D>first page of a chapter.<Ml>1JI1JI 
'II 
A <$IHeading>heading is a few words set off from 
the rest of the text to describe a major section of 
the chapter. Also called a main heading.<B>'II 
'II 
A keyline is a thin rule that shows the printer 
where to position a halftone or other illustration.1JI 
IJI 
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The live area is the area of the page that receives 
ink when printed.1JI 
IJI 
The margins are the white borders that surround 
the live area. Margins must be carefully con
sidered to take into account the look of the book, 
the binding method and the limitations of laser 
printers. IJI 
IJI ; 
A subhead is a few words set off from the rest of 
the text to describe a minor section of the chapter. 
Also called a <Ml>minor heading<D>.1JI 
IJI 
@HEAD2 = Measuring PageslJI 
IJI 
Most Americans are comfortable with inches. But 
for desktop publishing, the method called 
<Ml>printer's measure<D> or <Ml>the point sys
tem<D> is superior. Since type sizes are always 
specified in points, it makes sense to use printer's 
measure for everything on the page so you don't 
waste time converting back and forth. In addition, 
the point system has units that are much smaller 
than inches, so it is rarely necessary to complicate 
things with fractional units. By contrast, using 
inches requires you to make many fractional com
putations.1JI 
'II 
For these reasons, printer's measure is the easiest 
way to talk to a page layout program. (Most 
programs let the user choose between inches, cen
timeters or printer's measure.) The two most im
portant units in printer's measure are 
<Mbpoints<D> and <Ml>picas<D>. 'II 
IJI 
Points are a very small unit, about 1172 inch. 
They are used to measure type sizes and rules. 
The point size of a typeface is is roughly the meas
urement from the highest ascender (the top of a 
<169>b<170> for instance) to the lowest descend
er (the bottom of a <169>g<170». This is only an 
approximation, since point sizes originate from 
the metal body used to carry type in the days 
before phototypesetting. The best way to get 
familiar with point sizes is by example. You'll soon 
develop an eye for the most common sizes.1JI 
IJI 
Picas are a larger unit. Don't confuse them with 
the typewriter style of the same name. They are 
equal to 12 points (about 1/6 inch). Printers and 
typographers use picas to measure lines, margins 
and columns. Figure 6-2 shows a page from this 
book with the measurements expressed in picas 
and points. (The measurements refer to the full
sized page.)1JI 
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'II 
<$IEm Dash>Ems and <$IEn Dash>ens are less 
important but you'll hear them mentioned. Ems 
and ens vary according to the size of the type. In 
12-point type, an em is 12 points. In 18-point type 
it is 18 points, and so on. An en is 1/2 the em. In 
12-point type, then, the en is 6 points; in 18-point 
type it is 9 points, and so on.<MS>'II 
'II 
The em is the basis for spacing. An <Ml>em in
dent<D>, also called an em square, is an indent 
from the left margin equal to the em size <197> 12 
points in 12-point type, 18 points in 18-point type, 
and so on. It is the standard indent for books. 'II 
'II 
The most common use for the em is to describe the 
<Ml>em dash<D>. The em dash is, obviously, the 
length of one em. Em dashes are used to separate 
sentences <197> like this. The most common con
vention is to use the em dash without any space 
between the dash and the word<197>like this. It 
is also acceptable to use the em dash with a space 
on both sides, as has been done in this book.'II 
'II 
En dashes are half the length of the em. They are 
used to represent <169>to<170> between num
bers and words, as in 
<169>1950<196>1955<170> or <169>Figure 1-
2.<170> The hyphen is even shorter yet. It is used 
to <$IHyphenation;Use of en dash>hyphenate 
words. Some desktop publishing programs make 
no distinction between hyphens and en dashes.'II 
'II 
@HEAD2 = Describing Type'll 
'II 
Unfortunately, different programs use different 
words to refer to type and its attributes. The 
definitions given below are the most common in 
the desktop publishing industry. In some cases, 
they vary from those in use by traditional typeset
ters.'II 
'II 
Type sizes are specified in points as explained 
above. You must understand the point system to 
give correct instructions to the software. Many 
people refer to small type in the 9 to 12 point 
range as <$IBody type>body type. Larger sizes 
used for headings is often called <$IDisplay 
Type><$ADisplay Type;Headings>display type.'II 
'II 
<MS>TYPE STYLES.<D> Most desktop publish
ing programs use typeface and typestyle 
synonymously to mean one particular type design. 
Each design has a name. Helvetica is one types
tyle; Century Schoolbook is another; and so on. To 
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choose a different design from the page layout 
program, the user specifies it by name or picks its 
name from a menu. 'II 
'II 
A font is one particular variety of a typestyle. 
Thus, most software manuals would refer to 
Dutch as a typestyle and 12-point Dutch bold 
italic as a font. Most publishing programs have a 
<$IFonts>Font menu item where the user can 
specify all the attributes of the typestyle.'II 
'II 
<MS>KINDS OF TYPE.<D> Different people 
divide type in different groups. Book publishers 
are most likely to use three different kinds: serif, 
sans serif and symbol. Serifs are curlicues that 
decorate the ends of letters, so serif type is distin
guished by these tiny lines. This book uses a serif 
typestyle. Sans is the French word for without, so 
sans serif is type without the curlicues. And sym
bol fonts, sometimes called <$IFonts;Pi fonts>pi 
fonts, contain special characters, symbols, foreign 
language characters and so on.<Ml> 'II 
'II 
There are other kinds of type available from 
desktop publishing systems, including script, cur
sive, shadow, outline and reverse (white letters on 
a black background). These decorative effects can 
be achieved directly in some page layout 
programs. They can also be created in a special 
graphics programs and imported onto the page. 
These unusual typestyles are rarely used in books 
except for covers or chapter openings. 'II 
'II 
<MS>TYPE ATTRIBUTES<D>. The same types
tyle can vary in several ways. <Ml> We ight<D > 
refers to the thickness of the letterstrokes. Most 
desktop publishing programs provide only normal 
and <$IBold><$ABold;Text Attributes>bold. A 
few programs offer light as well. <Ml>Slope<D> 
refers to the slant of the letters, either vertical 
(called normal or roman) or slanted (italic or obli
que). The <Ml>proportion<D> of type is its 
horizontal width. Most desktop publishing 
programs offer only normal proportions. Oc
casionally they also provide access to condensed 
and expanded versions. 'II 
'II 
@HEAD2 = Other Important Terms'll 
'II 
Understanding printer's measure is the most im
portant part of becoming a good desktop designer. 
But you'll also encounter a few other phrases:'II 
'II 
The <$IBaseline>baseline is the invisible line the 
type sits on. Some programs use this term and/or 
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display the baselines as a light gray or dashed 
line on screen. Whether or not the term is used by 
the program, line spacing is measured from 
baseline to baseline. If you were using B-point 
type with 2 points of leading, the baseline to 
baseline measurement would be 10 points (B + 

2).<MS>'lI 
'lI 
Some programs, including Xerox Ventura Pub
lisher, modify this concept slightly. Ventura Pub
lisher considers the baseline to be the bottom of 
the lowest descender rather than the line upon 
which the body of the type rests. 'lI 
'lI 
<MS>PAGE FORMAT<D>. There are four basic 
formats. <Ml>Flush left<D> has an even left mar
gin and a ragged right margin. For this reason it 
is often referred to as ragged right. <Ml>Flush 
right<D> is the reverse: even right margin, 
ragged left margin. <Ml>Justified<D> has even 
margins left and right. <Ml>Centered<D> puts 
each line in the center, leaving both margins 
ragged. Justified is the choice for almost all books. 
Poetry often uses centered lines. Flush left is oc
casionally chosen for special formats. Flush right 
has few applications in <$IBooks;Page for
mat>books outside of titles, tables and charts. 'lI 
'lI 
<$IHyphenation;Hyphenation and justifica
tion>Hyphenation and justification are crucial to 
achieve a typeset look. When justifying lines, 
page layout programs attempt to end lines at the 
space between words. When that is not possible, 
they insert a hyphen, and put part of the word on 
one line and the remainder on the line below. Text 
can be justified without hyphenation, but this for
ces the program to stretch the words too far apart. 
'lI 

The computer program needs to know where it is 
allowed to insert hyphens when needed. Good 
page layout programs insert invisible <$1-
Hyphenation;Discretionary hyphens>discretion
ary hyphens into text files when they are loaded. 
These discretionary hyphens tell the program 
where to divide a word if necessary. By hyphenat
ing a word, the program can fit a few extra char
acters on the line, improving the spacing and ap
pearance. 'lI 
'lI 
@HEAD1 = <$ABooks;Design Guidelines for 
Books><$IDesign;Design Guidelines for 
Books>Design Guidelines for Books'lI 
'lI 
Good page design is inconspicuous <197> it calls 
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attention to the message, not to itself. But just 
because good design isn't loud and flashy doesn't 
mean there isn't a lot going on behind the scenes. 
Definite rules, skills and aesthetic choices go into 
the creation of book pages. Until now, this 
knowledge was the province of specialists. 
Desktop publishing, however, forces untrained 
users to grapple with the same decisions.'lI 
'lI 
Fortunately, there is a way to harness the power 
of desktop publishing <197> <Ml>design<D>. 
Design is a business tool, a way to make words 
more effective. It is often regarded as an innate 
ability <197> you're born with it or you're not. In 
reality, you <MI>can<D> learn the fundamentals 
of good design. Creating straightforward, profes
sional pages just takes a little know-how. You can 
get such pages by consistently applying a few safe 
and sane rules.'lI 
'lI 
@HEAD2 = <$IDesign;Purpose of>The Purpose of 
Page Design'lI 
'lI 
Page design has five goals: 'lI 
'lI 
@BULLET = Attract attention'lI 
'lI 
@BULLET = Please the eye'lI 
'lI 
@BULLET = Provide guideposts'lI 
'lI 
@BULLET = Improve legibility'lI 
'lI 
@BULLET = Make production easier and more 
efficient'lI 
'lI 
<MS>ATTRACTING THE EYE<D>. The atten
tion-grabbing power of design does not playa 
large role in <$IBooks;Book covers>books, except 
on covers. Covers are such a crucial part of 
marketing that they are best left to design profes
sionals. It is valuable to understand, however, 
that cover design can set a book apart on the 
shelves and entice browsers. 'lI 
'lI 
<MS>PLEASING THE EYE<D>. Once again, this 
aspect of design does not have the same crucial 
role in <$IBooks;Book publishing>book publish
ing as in magazine publishing and <$1-
Advertising;Design a pplications>advertising. 
Nevertheless, a book's physical format can add (or 
detract) from its sales appeal. To compete in the 
marketplace, books must meet certain minimum 
standards of design and attractiveness. What's 
more, the book must project the right image for 
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the target market, whether business, educational, 
scientific or mass market. 'II 
'II 
This chapter does not go into the more esoteric 
aspects of pleasing the eye. But it is valuable to 
realize that top-quality books utilize balance, 
symmetry and proportion for aesthetic effect. 
Novice desktop publishers are well-advised not to 
stray too far from time-tested formats. 'II 
'II 
<MS>GUIDlNG THE EYE<D>. A page can be a 
structuring device, a way to organize information. 
The eye needs guideposts or it becomes lost in a 
sea of type. Readers need signals so they don't 
miss key information. Good page design makes 
documents easier to use by providing these visual 
cues. There are three keys to guiding the eye: 
contrast, separation and consistency. 'II 
'II 
Light against dark, small against large, slanted 
against upright, one typestyle against another 
<197> these are all examples of contrast. The eye 
picks up these differences, which provide signals 
and separation. 'II 
'II 
Visual separation tells the eye that something 
new is coming along. You can achieve it with con
trast, with barriers or with formatting. Barriers 
are page elements that stop the eye. The most 
common barrier <197> and generally the best one 
<197> is white space. This book, for example, con
tains extra white space above <$IHeadings>head
ings and subheadings. Rules (lines across the 
page) are another effective barrier. Format can 

ASCII file to create: C:\ TEMP\8PRINT. TXT 

@CHAP# = Chapter Seven'll 
'II 
@CHAPTITLE = Offset Printing From Laser 
Mechanicals 'II 
'II 
@BODYFIRST = This is not a report on printing 
or production. Nevertheless, it will be valuable to 
briefly review the traditional production process. 
We can then examine how that process changes 
for desktop publishing. Our discussion centers 
around laser printers, but much of the advice also 
applies when electronic pages are sent to 
phototypesetting machines. The workflow is the 
same. The difference is that phototypeset pages 
don't need the extra precautions necessary with 
low-resolution laser type. 'II 
'II 
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also provide visual separation. The way text is 
spaced and indented give clues to the reader. The 
more complex the document, the more important 
it is to use formatting to guide the reader <197> 
one reason technical documentation often has 
several levels of indents. Headings, subheadings, 
lists and quotes are often good candidates for spe
cial formatting. 'II 
'II 
But contrast and separation won't accomplish 
their purpose without consistency. Once a rule 
has been established, it should be used 
throughout the book. Every heading, for example, 
should use the same format. 'II 
'II 
<$IDesign;Design Guidelines for Books>Improv
ing legibility is the fourth goal of page design. The 
way text is laid out on the page affects how easy it 
is to read.You must be careful to avoid designs 
that look good on the screen but are difficult to 
read for long stretches.'II 
'II 
Making production easier and more efficient is 
the fmal goal of page design and certainly one of 
the most important. Page designs must take into 
account the realities of to day's desktop publishing 
programs to minimize their weaknesses and play 
up their strengths. Often a few small changes can 
make a format much faster and easier to work 
and/or improve the final printed result. At the 
same time, a page design should be cost-efficient 
<197> for example, by using trim sizes that cor
respond to standard offset press dimensions. 

@HEAD1 = Traditional Book Printing'll 
'II 
Traditionally, book publishers delivered camera-
ready copy to the lithographer (the commercial 
printer). This material was in the form of 
<169>mechanicals.<170> Mechanicals were 
made by pasting type and line art onto stiff 
mounting boards. These mechanicals were then 
photographed to produce printing plates. 'II 
'II 
Photographs were not pasted on the boards. 
Original photographs have continuous tone <197> 
a full range of shades ranging from dark to light. 
Printing is an all or nothing, black or white 
process <197> either there's ink on the page or 
there's not. To simulate continuous tone, a 
photograph must be <Ml>screened<D>. This 
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process converts the photo into a 
<MI>halftone<D>. A halftone breaks the 
photograph into tiny dots. Since the human eye 
perceives closely spaced black dots as gray, a 
halftone permits a printing press to simulate the 
shades of a continuous tone photograph. err 

'II 
Black and white line art can be treated like text 
<197> it does not require a halftone. But con
tinuous tone drawings <197> those with shadings 
and gray tones <197> must be converted into 
halftones before printing. Black and white pic
tures need one halftone. Color photographs need 
four, one for each of the three primary colors and 
one for black. These four halftones are called 
<Ml>color separations<D>. 'II 
err 
The more dots per inch, the better the quality of a 
halftone. Newspapers typically use a screen of 65 
to 85 dpi. Inexpensive books sometimes use 100-
line screens (100 dpi), which give quality that's 
good but not great. Modern photocopiers can 
reproduce screens up to 100 dpi. Most books, how
ever, are printed using the superior resolution of 
133- to 150-line screens. After the half toning 
process, the converted photograph can be recom
bined with the text to form the complete page. 'II 
'II 
How the photographs are combined with the text 
depends on the type of printing. <MI>Getting It 
Printed<D>, an outstanding book for anyone who 
buys printing services, divides the industry into 
two categories: commercial printers and quick 
printers. Commercial printers typically produce 
longer jobs. They produce metal printing plates by 
combining line negatives (negatives of the text 
and the line art) with halftone or separation nega
tives (negatives of photographs). Quick printers 
are sometimes used for short-run books. They 
produce plates directly without an intervening 
negative stage. For this reason, photographs must 
be pasted onto the page in the correct position 
before they are given to a quick printer. Those 
photographs must fIrst be converted to a printable 
form through half toning. err 

'II 
@HEAD1 = The Desktop Workflow'll 
'II 
Desktop publishers do most of their paste-up 
electronically. Then they substitute laser-printed 
pages for mounting boards. Typically, the text is 
laid out first. Then line art is placed on the page, 
since line art can be imported directly into page 
layout programs. 'II 
'II 

@HEAD2 = Preparing Photographs'll 
'II 
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Photographs, on the other hand, must still be 
handled the old-fashioned way. Although page 
layout programs can accept scanned photos, the 
end result is generally not up to the standards of 
book publishers. So a space, or <Ml>window<D> 
is created for each photo. What you do with the 
window depends on whether you are using a com
mercial printer or a quick printer. 'II 
'II 
If you are going to a commercial printer, the win-
dows are left blank. The photographs are given to 
him separately. He makes separate negatives of 
the text (including the windows) and the photos. 
At this time the photographs are screened (con
verted to a halftone) and scaled (re-sized) ifneces
sary. Then the two negatives are combined in a 
process called <Ml>stripping.<D> This method 
produces the best results. It is mandatory for 
color photographs. 'II 
'II 
There is a second, less expensive alternative for 
black and white photos. If you are using a quick 
printer, you must paste the photos onto the page 
directly. However, normal photos won't reproduce, 
so they must fIrst be screened. Rather than creat
ing a halftone negative, as you would for a com
mercial printer, you obtain a halftone <Ml>posi
tive<D>. While it is being screened, the photo is 
also re-sized if necessary. This converted version 
of the photograph is pasted directly onto the laser
printed page, in the window. The combined page 
is given to the lithographer. This method is less 
expensive, because the lithographer no longer has 
to strip the two negatives together. He can take a 
single shot of the combined page and use it to 
create a printing plate. There is, however, some 
loss of image quality (reproducing a photo of a 
photo). There is also the risk that cut lines will 
show. 'II 
'II 
Positive halftones go by several different names, 
including <Ml>PMTs<D>, <Ml>veloxes<D> and 
<Ml>stats.<D> Although there are slight dif
ferences, they all work in the same basic fashion. 
Many books and references state that 100 dpi is 
the best you can expect using the PMT method. In 
fact, knowledgeable printers can obtain results up 
to 120 dpi. The loss in quality, therefore, does not 
have to be great. On the other hand, this second 
alternative does require the desktop publisher to 
do some paste-up. 'II 
'II 
There are two easy ways to obtain a positive 
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halftone. The best is to take the photo to a com
mercial printer or a trade camera shop. (To locate 
trade camera services, look in the yellow pages 
under <169>lithographic negative and plate 
makers.<170» These services turn photos into 
positive halftones for $5 to $15 each. At the same 
time they can resize the photo if necessary. Ask 
them to use fixer during development. Otherwise 
the prints will yellow and fade in a few months. 
When you get the screened PMTs back, check to 
make sure they are printed on pure white paper 
with no chemical stains. 'II 
'II 
If quality is not a concern and the photo is the 
right size already, you can also buy special plastic 
screens. The plastic is pasted on top of the 
photograph on the page. Cost is $3 to $4 per sheet 
from most graphic arts supply houses. You can 
achieve up to 85 dpi or so with this method <197> 
somewhat less than the 100 dpi most experts con
sider the minimum for a professional-quality 
book. You can also use a 85 dpi or 100 dpi 
photocopier screen for <169>homemade<170> 
veloxes. Run the photo through the copier with 
the screen on top. Use the copier's facilities to 
enlarge or reduce. Paste the resulting image 
directly onto the page. <Mf> Warning<D>: quality 
suffers with this method. 'II 
'II 
Use rubber cement to paste photos down. Pay 
extra attention to the edges <197> if they lift up 
they will cause a shadow line on the printed page. 
Use extra glue, then rub off any excess that shows 
after it's dry with a special rubber cement lifter 
available at art supply stores. You can also paste 
line art directly onto the page if you prefer to use 
existing hand drawings rather than creating the 
art with the computer. 'II 
'II 
@HEAD2 = Positioning Photographs'II 
'II 
Whether you strip photos or paste them on the 
page you must create a window. Decide which 
photographs you plan to use, what size they will 
be and where they belong in the text. Using the 
tools of the page layout program, create a box for 
each picture. Make it the exact size you want the 
final photo. Place a thin rule around the box. This 
rule is called the keyline, and it's vital. The lithog
rapher uses it to properly size and position the 
halftone. So will you if you decide to paste positive 
halftones directly onto the page. Normally the 
lithographer will drop out the keyline so it does 
not show on the printed page. If you want the rule 
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to show, specify ''Keyline prints" in your instruc
tions.'II 
'II 
Both the photos and the windows must be careful
ly labeled. Desktop publishers have an advantage 
here. They can use the text editing capabilities of 
the page layout software to insert labels in the 
center of the blank window as they go along. 'II 
'II 
Here's another possibility for creating windows: 
draw a box as before. Now use the page layout 
program to fill the box with black. This solid black 
box is the equivalent of the Rubylith window some 
layout artists use to key photographs to mechani
cals. When the page is photographed by the 
lithographer, the black box leaves a transparent 
window on the film negative. Th~ separately 
prepared halftone negative is positioned behind 
this window. 'II 
'II 
With the keyline method, the lithographer actual
ly cuts the negative along the line before stripping 
in the halftone. This provides the ultimate in 
quality, since there's no intervening layer of film. 
Ask the printing company which method it 
prefers. If you are using the PMT or velox method, 
keylines are the way to go. Why waste toner and 
print time creating black boxes? All you need is 
something to indicate where to paste down the 
velox. 'II 
'II 
@HEAD2 = Scanning and Digitizing'II 
'II 
If the job requires special care, consider using a 
scanner to provide position stats. In traditional 
publishing, a position stat is a photocopy that's 
pasted on the page in the window. It's only func
tion is to show the printer what goes where. If you 
have a scanner, you can accomplish the same 
thing electronically. Digitize the photograph and 
place it in the window using the desktop publish
ing software. Scanned images from to day's tech
nology are not good enough for reproduction. At 
best they produce the equivalent of a 50 to 70 line 
screen. But scanned images are ideal for proofing 
purposes. They allow you and the lithographer to 
accurately visualize how the final page will look. 
Scanned position stats are the ultimate in con
venience and safety. It's virtually impossible to 
put the wrong picture on the page when you can 
look at a sample. But they may be too much 
trouble for all but the most demanding projects. 
Most scanners still cost over $1000. Creating 
scanned images requires extra time and effort. 
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And storing the results demands lots of space on 
the hard disk. en 
en 
If there's one thing a commercial printer wants 
it's consistency <197> consistent density and con
sistent placement. Density refers to the type. 
Placement refer.s to the position of folios, rules, 
column tops and bottoms, captions, key lines and 
other repeating page elements. They must be in 
the same place from page to page. Consider a rule 
at the top of the page. If the desktop publisher 
places it inconsistently, the lithographer will be 
unable to use it to align pages. The rule will 
<169>jump<170> up and down as the reader 
pages through the book. And it may not match up 
across the top of facing pages. en 
en 
@HEAD1 = Crop Marksen 
en 
While using the page layout program, you can 
take several steps to make life easier for the 
lithographer. One is to add keylines for photos, as 
discussed above. Another is to place crop marks 
on each page. Crop marks are also known as 
<169>register<170> or < 169>corner<170> marks. 
These tiny lines help the lithographer position the 
page. Lithographers can work without crop 
marks. In such cases, they try to line up each page 
by using the folio or a rule as the 
<169>anchor.<170> Some lithographers also sug
gest avoiding ragged right margins. Ragged right 
is a good effect for certain brochures and newslet
ters, but it's generally inappropriate for books. If 
margins are even and consistent, the lithographer 
can use them to help position the pages. But com
mercial printers are happier when they can work 
from crop marks. Most prefer hairline rules 
placed just outside the live area. However, some 
lithographers like register marks placed inside 
the trim area. Ask in advance, then use your page 
layout program to produce the marks. en 
en 
The specifics of creating crop marks depends on 
the software. In Ventura Publisher, for example, 
lines placed on the Underlying Page appear on 
every page of the document. Most software pack
ages have a similar <169>Master Page,<170> 
<169>Repeating Page<170> or <169>Underlying 
Page<170> feature to place crop marks 
throughout the manuscript.en 
en 
@HEAD1 = Screen Tintsen 
en 
Most page layout programs provide screen tints. A 
screen is a pattern of tiny dots. With black ink, 
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the dots make an area look gray. With colored ink 
they give a light tint. Lithographers use percent
ages to describe the amount of ink laid down. A 
10% screen is very light; a 90% screen is very 
dark. Screen tints are used to highlight an area, 
to set text apart and to accent charts and graphs. 
Often type is <Ml>overprinted<D> <197> laid 
down on top of the tint. en 
en 
Short-run publishers who use quick printers must 
supply complete mechanicals. They must, there
fore, put the screen tint on the page themselves. 
One alternative is to use the page layout program. 
Trouble is, the dots produced by laser printers are 
too large for top-quality screens. There's no prob
lem if the screen if simply used as a pattern to fIll 
in a pie chart or a graph. But if type is difficult to 
read when placed on top of a coarse screen. The 
smaller the type, the harder it is to read. To mini
mize problems, use screens of 20% or less (if the 
program doesn't specify percentages, use one of 
the two lightest shades). Keep the type as large as 
possible <197> 14 points or bigger if possible. An 
alternative is to buy tint material from an art 
supply store and paste it over the area to be 
screened. Use this option if you must put small 
type inside a large screened area. Buy tint 
material with the highest resolution you can find. 
en 
en 
Publishers who use commercial printers should 
the printer do the screen. Indicate the area to be 
screened. Use a non-reproducing blue pencil, a 
stick-on Post-It note or write the instructions on 
top of a see-through tissue overlay. en 
en 
@HEAD1 = Color printingen 
en 
Multicolored documents are created in several 
passes through the printing press. Each time 
another color is added to a page, it must be sent 
through the press again. The lithographer must 
have a separate plate for each color. Normally, the 
commercial printer makes these color separa
tions. It costs extra, of course. But desktop pub
lishers can easily create their own separations, 
thereby saving money and time. The process 
described here works for spot color. Continuous 
tone color photographs must still be handled 
using traditional methods. en 
en 
The method relies on the ability of some software 
to specify the color of different text elements. It is 
most effective with programs such as Xerox Ven
tura Publisher that use style sheets <197> docu-
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ment formatting guidelines that can be prepared 
once and used over and over again. This report 
describes a method for Ventura Publisher, but it 
can be 
adapted to other programs as well. en 
'lI 
Let's use a two-color example. The same prin
ciples would apply for more than two colors. Con
sider, for instance, black text with blue headings. 
Start by creating the document as normal. The 
style sheet for this step will have all text elements 
specified as black. Now create another style sheet 
for each color. These style sheets will be identical 
to the first except for the color of the text ele
ments. 'lI 
'lI 
To create a color separation for the black text, 
specify that all the headings (all the blue text) 
should print in white. By changing the color to 
white, the text disappears<197>white text on 
white paper is invisible. The beauty of this 
method is that the invisible headings are still on 
the page. Consequently, the position of the page 
elements does not change. The overlay for each 
color will match up with the others. 'lI 
'lI 
The third and final style sheet reverses the 
process. All the headings print in black. Every
thing else is set to print in white. When you print 
this version out on the laser printer, it shows only 
the text that is to be printed in blue ink. The 
lithographer will match the two separations to 
create a composite page with the black and the 
blue text in perfect registration. 'lI 
'lI 
The beauty of the system described here is its 
speed and ease-of-use. The only real investment 
in time is to create the two extra style sheets. 
Once these have been prepared, the user can cre
ate color separations in moments just by calling 
up the different style sheets and printing out the 
separate versions. If your page layout program 
does not have these capabilities, you can simulate 
the effect by manually deleting text, as long as 
you do so without changing the position of any
thing on the page. Naturally, you can also use the 
traditional method. Specify which elements are to 
be what color and let the printer prepare the 
separations. 'lI 
'lI 
@HEAD1 = Covers en 
'lI 
Some publishers may be tempted to produce 
covers using laser mechanicals. It is not recom
mended. Most covers use display type on slick 
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stock. That's simply too demanding for the 300 dpi 
resolution of laser printers. The imperfections 
stand out. The design of the cover is also an issue. 
Most publishers are unlikely to do as good a job as 
a professional designer. Buyers judge books by 
their covers, especially wholesalers, distributors 
and retailers. If those individuals aren't im
pressed, your books will never get on the shelves 
for readers to find. The most common failing of 
small independent publishers is to put a good 
book inside a shoddy, amateurish cover. en 
en 
If you insist on producing camera ready art for the 
cover, send the file to a phototypesetter for high 
resolution output. And be sure to calculate care
fully for the spine. You must know the number of 
pages and the bulk of the paper (the pages per 
inch) to figure the correct width. Printers say it is 
very difficult to correct for an improperly-sized 
spine. 'lI 
en 
@HEADI = Adjusting Page Counten 
en 
Desktop publishing differs from traditional 
publishing in another key aspect <197> the 
ability to make last minute changes. That 
capability can be put to good use to make the 
books you publish mesh properly with the work 
customs of commercial printers. 'lI 
en 
The final page count is vitally important to a book 
printing job, and desktop publishers are ideally 
suited to adapt to the constraints of the printing 
industry. Lithographers print in signatures of 16 
and 32 pages. You can save money by working 
within these limitations. coor planning can force 
the lithographer to add a <169>bastard 
eight<170> (an undersized, eight-page signature). 
This extra work can add a surprising amount to 
the total print bill. 'lI 
en 
And it's unnecessary, since desktop publishing 
gives you the control to tailor books to the right 
size. If the final page count is not a multiple of 16, 
make changes until it fits. Often a small change 
creates a substantial difference by the time it 
ripples through the entire manuscript. To shorten 
a book, try removing words and lines. Add 
hyphens to shorten paragraphs. Expand margins 
slightly. Reduce the size of illustrations. Go down 
a point size or two. Or try a different types
tyle<197>some take more space than others, even 
when set at the same size and line spacing.'lI 
'lI 
In other cases, you might want to up the page 



A - 24 

count. For instance, you might be able to increase 
156 pages to 160 by removing a single line from 
each page. An added bonus would be more white 
space and a more readable manuscript. Or you 
could add illustrations, or make existing illustra
tions slightly larger. As long as you need extra 
pages to fill up the signature anyway, consider 
adding some order cards at the back, or a page or 
two of sales copy and testimonials at the front. 'll 
'll 
@HEADl = Improving the Look of Laser-printed 
Pages'll 
'll 
Several advanced techniques can boost the 
quality of pages printed from laser mechanicals. 
Although desktop laser printers can create im
pressive documents, the density and resolution of 
the type simply isn't up to the standards oftradi
tional phototypesetters. Nowhere is this more ap
parent than when laser output is used as 
mechanicals for offset printing. Three problems 
occur most often:'ll 
'll 
@BULLET = Washed out areas <197> sections or 
even entire pages that have a pale gray, washed
out appearance'll 
'll 
@BULLET = Broken letters <197> characters 
where small sections have dropped out'll 
'll 
@BULLET = The jaggies <197> rough, uneven 
edges a:g,d diagonals caused by the low resolution 
of laser printers'll 
'll 
Fortunately, there are tricks and techniques that 
improve the quality of pages printed from laser 
mechanicals. 'll 
'll 
@HEAD2 = Improving Mechanicals'll 
'll 
<MS>SELECTING THE RIGHT TYPEFACE<D> 
is the first step. Some typefaces are more suitable 
than others for offset reproduction. If you produce 
more than one or two books each year, experiment 
with different typefaces. It may be cost effective to 
purchase additional fonts, either from the original 
supplier or from an outside company. As a bonus, 
your documents will not have the all-to-familiar 
<169>Times-Roman body, Helvetica head
lines<170> look that is common to 90% of all 
desktop publishing documents. 'll 
'll 
Getting dark, dense type is the next challenge. 
Laser printers, unfortunately, are plagued by 
drop outs and washed out, gray areas. Sometimes, 
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the problem lies with the toner or the toner 
cartridge. It also has to do with the _way printers 
work. Some laser printer engines are better than 
others at creating solid black areas. The Canon 
CX engine at the heart of most first- generation 
laser printers was notorious for weak, gray let
ters. If your printer has a front panel control of 
any kind, put it on the darkest setting. Many pros 
also suggest removing the toner cartridge and 
rotating it. This may overcome clumping and clot
ting and help achieve a uniform print quality 
across the page. And cartridges work better than 
others. When you find one that creates dense, 
dark type, set it aside and save it for special print 
jobs. 'll 
'll 
It's best to have type as dark and dense as pos-
sible. Nevertheless, if all the pages are slightly 
pale, most lithographers can compensate. What 
they hate is type that fluctuates from page to page 
or, worst of all, within each page. Check each page 
before the job goes to the lithographer. Reprint 
any pages that aren't consistent. 'll 
'll 
<MS>SPRAYING WITH A MATTE FIXA
TIVE<D> usually causes laser-printed pages to 
<169>darken up.<170> Not only does the fixative 
make black areas appear darker, it also protects 
the pages. Fixative helps prevent smears, 
fingerprints and flaking. The aerosol cans are 
sold at art supply stores. To the best of our 
knowledge, any fixative suitable for charcoal 
drawings will also work with laser-printed 
pages.'ll 
'll 
<MS>SPECIAL LASER PRINTER PAPER <D>is 
sometimes recommended for laser mechanicals. 
The theory is that this paper has whiter whites 
and blacker blacks. It also has a smoother even 
coating that makes it easier for the camera 
operator to produce a good negative. Warning: 
Some desktop publishers complain that certain 
coated laser papers jam repeatedly in laser 
printers. Buy a small sample and test first.'ll 
'll 
Special paper may be an especially good idea for 
publishers who create galleys with the laser 
printer and paste them up using traditional 
methods. Some special papers contain wax hold
out that minimizes problems from waxing and 
paste-up. Be aware, however, that coated papers 
must be treated with care. The laser-printer type 
tends to crack and fall off if coated pages are bent, 
folded or stacked. 'll 
Ijf 
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<MS>PHOTOREDUCTION<D> is a difficult 
technique, but it also has great potential for im
proving pages from laser mechanicals. Reducing 
an image makes flaws less apparent. (Conversely, 
enlarging magnifies flaws. That's why you should 
never enlarge laser type). By reducing laser type, 
you increase its apparent resolution. Most laser 
printers create type at 300 dpi. Researchers think 
the human eye loses its ability to distinguish in
dividual dots at about 450 dpi. (By way of com
parison, graphic arts-quality phototypesetters 
produce 900 dpi or higher.)'II 
'II 
It would seem an obvious step, then, to create 
pages at a larger size and reduce them down. In 
practice, this method creates problems. You can, 
for example, start with 18 point type and 
photo reduce it to 10 points. Unfortunately, the 
letterspacing and line spacing will be incorrect. 
Although subtle, these spacing problems begin to 
be noticeable when type is reduced more than 10 
percent or so. In addition, fine lines or dot pat
terns may end up too thin to print, or disappear 
altogether. You may not want to make a small face 
even smaller or decrease the margins too much. 'II 
'II 
Careful planning is essential to make sure every
thing fits properly on the page after the 
photoreduction. As anyone who has sized photos 
already knows, its easy to make mistakes. Basi
cally, it's just another step and one that many 
publishers don't want to bother with. 'II 
'II 
<MS>THERE IS A SIMPLER METHOD<D> for 
pages where the live area is 5 x 7 or smaller. Start 
by laying out the page exactly as you would other
wise. Use normal linespacing, letters pacing and 
type sizes. At print time, however, use the Print 
dialog box to enlarge. The laser printer will in
crease by the percentage you specify. (Note: Some 
programs cannot perform this enlargement func
tion. Others require a separate, add-on pro
gram.)'II 
'II 
Now take the enlarged page to the lithographer 
and instruct him to reduce back down to the 
original size. Since these are the dimensions you 
originally worked with, everything will be exactly 
as you saw it on the screen. The letterspacing, 
margins, and so on will be correct, but the type 
will be at a higher apparent resolution.'II 
'II 
Why doesn't this technique work for pages larger 
than 5 x 7? Today's laser printers accept 8 112 x 11 
paper, but they can only print to within an inch or 
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so of the margin, for an effective live area of only 
7 112 x 10. You can enlarge a 5 x 7 page up to about 
150% before you run out of room. When you bring 
this 150% enlargement back down to the original 
5 X 7, you will have achieved an effective resolu
tion of 450 dpi. 'II 
'II 
This photoreduction technique can distinctly im
prove the look of a page. One Southern California 
publishing company, for example, wanted to 
produce a final live area of 3 3/4 x 6. Through trial 
and error, they discovered they could enlarge by 
165% before coming up against the laser printer's 
<169>dead zone.<170> By bringing this enlarge
ment back down to the original size, they 
achieved an apparent resolution approaching 500 
dpi.'II 
'II 
What if you must produce pages larger than 5 x 7? 
Access to an 11 x 17 printer is one answer. The 
Dataproducts LZR-2665 is a PostScript com
patible laser printer that produces 11 x 17 pages 
at 26 ppm. At $17,900, it's too high-priced for most 
desktop publishers, but you may be able to find a 
service bureau or print center to output final copy 
for a page charge. 'II 
'II 
@HEAD2 = The Lithographer Can Help 

So far we've covered how the publisher should 
prepare laser mechanicals. In addition, the lithog
rapher can take steps to improve the final out
put. 'II 
'II 
<MS>ALTERING THE EXPOSURE<D> is one 
relatively simple technique. The kind of altera
tion depends on whether the lithographer creates 
a positive or a negative. In either case, the idea is 
the same: to alter the exposure so the type looks 
darker. For the traditional, high-quality method 
involving a film negative, a 10 percent underex
posure is generally enough to help <169>fill 
in<170> the type. 'II 
'II 
Discuss this concept with the lithographer. Most 
of them are more familiar with the same proce
dure done in reverse. For example, when creating 
negatives, camera operators will often 
<Ml>over<D>expose. This causes tiny specks and 
dots to disappear and become white. Sometimes 
operators refer to a <169>dropout<170> halftone, 
since the overexposure causes imperfections and 
small details to drop out. If the operator knows 
how to alter exposure for dropouts, ask if he can 
do the same thing in reverse to make the type 
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denser. One warning: When you darken the type, 
you also darken dirt, dust and other imperfections 
that would normally disappear. Both the publish
er and the lithographer must take exceptional 
care to make sure the mechanicals are spotless. 'lI 
'lI 
<MS>THE PAPER STOCK<D> can also make a 
difference. Work with the lithographer to select 
the paper that gives the best look for the money. 

Chapter Eight 

ASCII file to create: C:\TEMP\8TABLE.TXT 

Inches'lI 
'lI 
Picas and Points'lI 
'lI 
Points'lI 
'II 
1/6 inch'lI 
'lI 
01,00 picas & points'lI 
'lI 
12 points'lI 
'lI 
114 inch'lI 
'lI 
01,06 picas & points'lI 
'lI 
18 points'II 
'lI 
113 inch'lI 
'II 
02,00 picas & points'lI 
'lI 
4 points'II 
'lI 

Chapter Nine 

Text Files 

There may not be much point in going to expen
sive coated stock. Slick paper only brings out the 
shortcomings of laser type by making jagged 
edges and drop outs more visible. On the other 
hand, cheap newsprint will cause the ink to 
spread, making characters even fuzzier. A good 
grade of uncoated book stock is probably the best 
bet. Ask the lithographer to run some tests and 
give his suggestions. 

1/2 inch'lI 
'lI 
03,00 picas & points'lI 
'lI 
36 points'lI 
'lI 
1 inch'lI 
'lI 
06,00 picas & points'lI 
'lI 
72 points'lI 
'lI 
5 112 inches'lI 
'lI 
33,00 picas & points'lI 
'lI 
8 112 inches 'II 
'lI 
51,00 picas & points 'II 
'lI 
11 inches'lI 
'lI 
66,00 picas & points 'lI 
'lI 

ASCII file to create: C:\ TEMP\9TECHDOC. TXT 

@TITLE = The Laser AstroZ'lI 
'lI 
@TITLESUB = Guide to Operations < 197> Model 
XYZ-ll'lI 
'lI 
@HEAD1 = Getting Started'lI 
'lI 

@HEAD2 = A Word to Owners'lI 
'lI 
Thank you for choosing the Laser AstroZ printer 
from XYZ Corporation. This high quality laser 
printer gives you the flexibility and power for all 
your desktop publishing needs. The Laser AstroZ 
comes standard with PostScript, as well as 
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Hewlett-Packard PCL and HPGL for programs 
you still use that are non-PostScript compatible. 'II 
'II 
@HEAD3 = Introduction'II 
'II 
First we'll show you hot to unpack and install 
your Laser AstroZ printer. You should carefully 
check to make sure you have the following items:'II 
'II 
@LISTBULLET = ONE IBM PC DISKETTE in 
5-V4" format'li 
'II 
@LISTBULLET = A PRINT TRAY and manual 
feed guide'II 
'II 
@LISTBULLET A PAPER CASSETTE and 
toner cartridge 'II 
'II 
@HEAD2 = You and Your Printer'II 
'II 
Before you install your printer, make sure it is 
located in a well-ventilated area away from direct 
sunlight. Check to make sure that your office's 
electrical wiring is adequate. The line voltage 
should not vary from the factory warrantied volt
age marked on the back of the printer. Avoid plac
ing the printer in an office with abrupt changes in 
temperature. Do not place the printer near open 
faucets, heaters, air conditioners, humidifiers, or 
radiators. 'II 
'II 
Place the printer on a flat surface 8-9 inches away 
from the wall. Leave enough room in the front for 
the cartridge door to open freely. 'II 
'II 
@BODYSMALL = This manual prepared by the 
publications and communications department, 
XYZ Corporation, Los Angeles, CA. 'II 
'II 
@HEADI = Unpacking and Setting Up'II 
'II 
@HEAD2 = Unpacking'II 
'II 
Your Laser AstroZ weighs 73 pounds, so do not try 
to lift it without someone's help. Lift the printer 
by its handles and place it on a clean, stable 
surface. 'II 
'II 
Lift the release lever and raise the upper part of 
the printer'II 
'II 
Lift the green fixing assembly cover and remove 
the four red spacers. 'll 
en 
Locate the green wire cleaner and remove its 
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protective sealing tape. You will use the wire 
cleaner to clean the corona wire in the print 
cartridge.en 
en 
@HEAD2 = The Care of Your Printeren 
en 
There are several routine maintenance proce
dures you can perform to keep your Laser AstroZ 
running smoothly. You should be familiar with:'II 
'II 
@LISTBULLET = Replacing the toner cartridge 
and cleaning sticken 
en 
@LISTBULLET = Cleaning the corona wires'II 
en 
@LISTBULLET = Cleaning the guides'II 
'II 
@LISTBULLET = Cleaning and replacing the 
separation belts'II 
'II 
@HEAD2 = About the 'lbner Cartridge'li 
'II 
The toner cartridge includes powder that serves 
as ink to the printer. The cartridge itself has a 
color coded bar that will indicate the level of pow
der and the number of prints. If you print plain 
text (not graphics) at a higher toner setting, you 
will get more prints than if you print graphics at a 
lower setting. If your prints begin to look faded in 
areas, or streaked at the edges, replace your toner 
cartridge.'II 
'II 
Paper Trays, Paper Cassettes 'II 
'II 
@HEAD5 = Paper Trays'II 
'II 
<B>Print tray position<D>. Hold the print tray so 
the wide end faced towards the front of the 
printer. Insert the plastic pins into the front slots 
above the handle.'II 
en 
NOTE: Do not overload the paper tray. Packing it 
too full will cause paper jams and print errors.'II 
'II 
<B>Attach the manual feed guide<D>. Hold the 
manual feed guide with the plastic brackets 
towards the rear of the printer. Face the ribbed 
side up.'II 
'II 
<B>Load paper in manual feed.<D> Insert one 
sheet of paper at a time. Glide the paper along the 
tray until it can't go any further, then stop. 'll 
en 
@HEAD5 = Paper Cassettesen 
en 
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Place the paper in the cassette and push it under 
the paper clips. Insert the paper cassette into the 
slot under the front of the printer until it stops. 
The cassette holds approximately 110 sheets.'11 
'II 

Chapter Ten 

ASCII file to create: C:I TEMPIPROFEXT. TXT 

@TITLE = The Laser AstroZ'II 
'II 
@TITLESUB = Guide to Operations<197> Model 
XYZ-11'11 
'II 
@BODYBREAK = 'II 
'II 
@HEAD1 = Getting Started'll 
'II 
@HEAD2 = A Word to Owners'll 
'II 
Thank you for choosing the Laser AstroZ printer 
from XYZ Corporation. This high quality laser 
printer gives you the flexibility and power for all 
your desktop publishing needs. The Laser AstroZ 
comes standard with PostScript, as well as 
Hewlett-Packard PCL and HPGL for programs 
you still use that are non-PostScript compatible. 'II 
'II 
@HEAD3 = Introduction'll 
'II 
First we'll show you hot to unpack and install 
your Laser AstroZ printer. You should carefully 
check to make sure you have the following items: 'II 
'II 
@LISTBULLET = ONE IBM PC DISKETTE in 
5-1/4" format'll 
'II 
@LISTBULLET = A PRINT TRAY and manual 
feed guide'll 
'II 
@LISTBULLET A PAPER CASSETTE and 
toner cartridge'll 
'II 
@HEAD2 = You and Your Printer'll 
'II 
Before you install your printer, make sure it is 
located in a well-ventilated area away from direct 
sunlight. Check to make sure that your office's 
electrical wiring is adequate. The line voltage 
should not vary from the factory warrantied volt
age marked on the back of the printer. Avoid plac
ing the printer in an office with abrupt changes in 
temperature. Do not place the printer near open 

Text Files 

NOTE: If you want to print on letterhead, place 
the paper FACE DOWN beneath the clips. 'II 
'II 
@HEAD1 = A Quick Tour of the Laser AstroZ 

faucets, heaters, air conditioners, humidifiers, or 
radiators. 'II 
'II 
Place the printer on a flat surface 8-9 inches away 
from the wall. Leave enough room in the front for 
the cartridge door to open freely. 'II 
'II 
@BODYSMALL = This manual prepared by the 
publications and communications department, 
XYZ Corporation, Los Angeles, CA'II 
'II 
@BODYBREAK = 'II 
'II 
@HEAD1 = Unpacking and Setting Up'll 
'II 
@HEAD2 = Unpacking'll 
'II 
Your Laser AstroZ weighs 73 pounds, so do not try 
to lift it without someone's help. Lift the printer 
by its handles and place it on a clean, stable 
surface. 'II 
'II 
@LIST# = Lift the release lever and raise the 
upper part of the printer'll 
'II 
@LIST# = Lift the green fixing assembly cover 
and remove the four red spacers. 'II 
'II 
@LIST# = Locate the green wire cleaner and 
remove its protective sealing tape. You will use 
the wire cleaner to clean the corona wire in the 
print cartridge. 'II 
'II 
@HEAD2 = The Care of Your Printer'll 
'II 
There are several routine maintenance proce
dures you can perform to keep your Laser AstroZ 
running smoothly. You should be familiar with:'11 
'II 
@LISTBULLET = Replacing the toner cartridge 
and cleaning stick'll 
'II 
@LISTBULLET = Cleaning the corona wires'll 
'II 
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@LISTBULLET = Cleaning the guidesen 
en 
@LISTBULLET = Cleaning and replacing the 
separation belts en 
en 
@HEAD2 = About the Toner Cartridgeen 
en 
The toner cartridge includes powder that serves 
as ink to the printer. The cartridge itself has a 
color coded bar that will indicate the level of pow
der and the number of prints. If you print plain 
text (not graphics) at a higher toner setting, you 
will get more prints than if you print graphics at a 
lower setting. If your prints begin to look faded in 
areas, or streaked at the edges, replace your toner 
cartridge.en 
en 
@BODYBREAK = en 
en 
@HEAD4 = Paper Trays, Paper Cassettesen 
en 
@RULE =~en 
en 
@HEAD5 = Paper Traysen 
en 
@LIST# = <B>Print tray position<D>. Hold the 
print tray so the wide end faced towards the front 
of the printer. Insert the plastic pins into the front 
slots above the handle. en 
en 
@NOTE = NOTE: Do not overload the paper tray. 
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Packing it too full will cause paper jams and print 
errors. en 
en 
@SPACER=en 
en 
@LIST# = <B>Attach the manual feed guide<D>. 
Hold the manual feed guide with the plastic 
brackets towards the rear of the printer. Face the 
ribbed side up. en 
en 
@LIST# = <B>Load paper in manual feed.<D> 
Insert one sheet of paper at a time. Glide the 
paper along the tray until it can't go any further, 
then stop. en 
en 
@HEAD5 = Paper Cassettesen 
en 
Place the paper in the cassette and push it under 
the paper clips. Insert the paper cassette into the 
slot under the front of the printer until it stops. 
The cassette holds approximately 110 sheets.en 
en 
@NOTE = NOTE: If you want to print on letter-
head, place the paper FACE DOWN beneath the 
clips.en 
en 
@BODYBREAK = en 
en 
@HEAD 1 = A Quick Tour of the Laser Astro-
Z<$&l-l> 
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Tag Tables 

If you do not have the Power disk, you can construct the 
sample style sheets using the tag tables below. Each tag table 
includes the settings for the Page (e.g., page size and layout, 
margins and columns, etc.) and the settings for each tag in the 
style sheet. The tag tables omit all settings that are identical 
to the Body Text tag. So if a tag has the same Font as Body 
Text, the Font for that tag is not included in the list. Just 
make it the same as Body Text. 

To create the style sheets, open a blank chapter, load the 
DEFAULT.STY style sheet from the \ TYPESET subdirectory 
and load a sample text file onto the Page. (Make sure the text 
file you load does not contain any predefined tag names - or 
they will become part of the style sheet.) Change the Page 
settings first using the Chapter and Frame menus. Then go 
on to creating the tags. 

Start with the Body Text tag. Select a paragraph and modify 
its font, alignment, spacing, and so forth until it matches the 
settings Body Text in the tag table. Once the Body Text tag is 
completed, begin to add new tags, one at a time, for each tag 
name in the table. In Paragraph mode, select any Body Text 
paragraph, then choose Add New Tag. Enter the new tag 
name. Then modify the tag's font, alignment, spacing, etc., 
until it matches the settings in the tag table. 

After you have completed all the tags in a style sheet, select 
Save As New Style (File menu). Save the new style sheet in 
the C:\TEMP subdirectory with the name we give below. 
Then abandon the chapter. 
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C:\POWER\4FORM.STY 

Save as C:\TEMP\4INVOICE.STY 

Underlying Page Settings 

Page Size & Layout 
Orientation: 
Paper Type: 

Margins & Columns 

Portrait 
Letter, 8.5 x 11 in. 

# of Columns: 1 
Settings For Left Page 
Top: 06,00 picas & pts. 
Bottom: 06,00 picas & pts. 
Left: 07,06 picas & pts. 
Right: 07,06 picas & pts. 
Widths/Gutters-I: 36,00 picas & pts. 

Tag Setti ngs 

Body Text 

Font 
Face: 
Size: 

Alignment 
Horz. Alignment: 
Vert. Alignment: 
Text Rotation: 
Hyphenation: 
Successive Hyphens: 
Overall Width: 

Spacing 
Above: 
Below: 
Inter-Line: 
Inter-Paragraph: 
Add in Above: 

Breaks 
Page Break: 
Column Break: 
Line Break: 

Logo 
Font 
Size: 

Helvetica 
12 points 

Left 
'lbp 
None 
Off 
2 
Column-Wide 

07.00 fractional pts 
00.00 fractional pts 
14.00 fractional pts 
00.00 fractional pts 
Always 

No 
No 
Before 

18 points 

Sides: Single 

Settings For Right Page 
Top: 06,00 picas & pts. 
Bottom: 06,00 picas & pts. 
Left: 07,06 picas & pts. 
Right: 07,06 picas & pts. 
Widths/Gutters-I: 36,00 picas & pts. 

Style: 
Color: 

First Line: 
Relative Indent: 
In/Outdent Width: 
In/Outdent Ht.: 
In Fm. Rt. to Dec.: 

In Fm. Left (L): 
In Fm. Right (L): 
In Fm. Left (R): 
In Fm. Right (R): 

Next Y Position: 
Allow Within: 
Keep With Next: 

Style: 

Normal 
Black 

Indent 
Off 
00,00 picas & pts. 
1 
00,00 picas & pts. 

00,00 picas & pts. 
00,00 picas & pts. 
00,00 picas & pts. 
00,00 picas & pts. 

Normal 
Yes 
No 

Bold 
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Alignment 
Harz. Alignment: Center 

Spacing 
Above: 00.00 fractional pts Add in Above: When Not at C.T. 
Inter-Line: 24.00 fractional pts 

Label 
Font 
Size: 10 points 

Alignment 
Harz. Alignment: Center Vert. Alignment: Middle 

Spacing 
Above: 00.00 fractional pts Inter-Line: 12.00 fractional pts 

Breaks 
Keep With Next: Yes 

Z_BOXTEXT 

Spacing 
Above: 03.00 fractional pts In Fm. Left (L): 00,06 picas & pts. 
Inter-Line: 12.00 fractional pts In Fm. Left (R): 00,06 picas & pts. 

Balance 
Font 
Style: Bold 

Alignment 
Horz. Alignment: Decimal In Fm. Rt. to Dec.: 05,06 picas & pts. 

Spacing 
Above: 03.00 fractional pts Inter-Line: 12.00' fractional pts 

Address 
Font 
Style: B-Italic 

Spacing 
Above: 10.00 fractional pts 

LabelBlack 
Font 
Size: 10 points Style: Bold 

Alignment 
Horz. Alignment: Center 

Spacing 
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Above: 04.00 fractional pts Inter-Line: 12.00 fractional pts 

Breaks 
Keep With Next: Yes 

LabelLeft 
Font 
Size: 10 points 

Alignment 
Vert. Alignment: Middle In/Outdent Width: 00,06 picas & pts. 

Spacing 
Above: 00.00 fractional pts Inter-Line: 12.00 fractional pts 

Breaks 
Keep With Next: Yes 

LabelLine 
Font 
Size: 10 points 

Alignment 
Vert. Alignment: Middle 

Spacing 
Above: 00.00 fractional pts Inter-Line: 12.00 fractional pts 

Breaks 
Keep With Next: Yes 

Tab Settings 
Leader Char: 95 Auto-Leader: On 
Leader Spacing: 0 

LogoAddress 
Alignment 
Horz. Alignment: Center 

Spacing 
Above: 00.00 fractional pts Add in Above: When Not at C.T. 

ListDecimal 
Alignment 
Horz. Alignment: Decimal In Fm. Rt. to Dec.: 03,00 picas & pts. 

Spacing 
Above: 03.00 fractional pts Inter-Line: 12.00 fractional pts 
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Tab Settings 

LabelLine 
Tab Number 2: 
Tab Number 3: 
Tab Number 4: 
Tab Number 5: 
Tab Number 6: 
Tab Number 7: 
Tab Number 8: 
Tab Number 9: 

Left, 06,00, 32 
Left, 09,00, 32 
Left, 12,00, 32 
Left, 15,00, 32 
Left, 18,00, 32 
Left, 21,00, 32 
Left, 24,00, 32 
Left, 27,00, 32 

Tab Number 10: 
Tab Number 11: 
Tab Number 12: 
Tab Number 13: 
Tab Number 14: 
Tab Number 15: 
Tab Number 16: 

Left, 30,00, 32 
Left, 33,00, 32 
Left, 36,00, 32 
Left, 39,00, 32 
Left, 42,00, 32 
Left, 45,00, 32 
Left, 48,00, 32 
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C:\POWER\5AD.STY 

Save as C:\TEMP\SMAILER.STY 

Base Page Settings 

Page Size & Layout 
Orientation: 
Paper Type: 

Margins & Columns 

Portrait 
Letter, 8.5 x 11 in. 

# of Columns: 1 
Settings For Left Page 
Top: 03,00 picas & pts. 
Bottom: 03,00 picas & pts. 
Left: 03,00 picas & pts. 
Right: 03,00 picas & pts. 
Widths/Gutters-I: 45,00 picas & pts. 

Tag Settings 

Body Text 

Font 
Face: 
Size: 

Alignment 
Horz. Alignment: 
Vert. Alignment: 
Text Rotation: 
Hyphenation: 
Successive Hyphens: 
Overall Width: 

Spacing 
Above: 
Below: 
Inter-Line: 
Inter-Paragraph: 
Add in Above: 

Breaks 
Page Break: 
Column Break: 
Line Break: 

Address 
Font 
Size: 

Times 
14 points 

Justified 
'lbp 
None 
USENGLSH 
2 
Column-Wide 

00.00 fractional pts 
00.00 fractional pts 
16.00 fractional pts 
00.00 fractional pts 
When Not at C.T. 

No 
No 
Before 

10 points 

Sides: 
Start On: 
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Double 
Right Side 

Settings For Right Page 
Top: 03,00 picas & pts. 
Bottom: 03,00 picas & pts. 
Left: 03,00 picas & pts. 
Right: 03,00 picas & pts. 
Widths/Gutters-I: 45,00 picas & pts. 

Style: 
Color: 

First Line: 
Relative Indent: 
In/Outdent Width: 
In/Outdent Ht.: 
In Fm. Rt. to Dec.: 

In Fm. Left (L): 
In Fm. Right (L): 
In Fm. Left (R): 
In Fm. Right (R): 

Next Y Position: 
Allow Wi thin: 
Keep With Next: 

Normal 
Black 

Indent 
Off 
00,00 picas & pts. 
1 
00,00 picas & pts. 

00,00 picas & pts. 
00,00 picas & pts. 
00,00 picas & pts. 
00,00 picas & pts. 

Normal 
Yes 
No 
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Spacing 
Inter-Line: 
In Fm. Left (L): 

Head3 
Font 
Size: 

Alignment 
Horz. Alignment: 

Spacing 
Above: 
Inter-Line: 

12.00 fractional pts 
02,00 picas & pts. 

24 points 

Center 

60.00 fractional pts 
30.00 fractional pts 

Paragraph Typography 
Tracking: 0.025 Ems Tighter 

Head! 
Font 
Face: 
Size: 

Alignment 
Horz. Alignment: 
Hyphenation: 

Spacing 
Inter-Line: 

Helvetica 
74 points 

Center 
Off 

74.00 fractional pts 

Paragraph Typography 
Automatic Pair Kerning:On 
Letter Spacing: Off 

Head2 
Font 
Face: 
Size: 

Alignment 
Horz. Alignment: 
Hyphenation: 

Spacing 
Inter-Line: 

Tab Settings 
Leader Char: 

Helvetica 
20 points 

Left 
Off 

28.00 fractional pts 

32 
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In Fm. Left (R): 02,00 picas & pts. 

Style: Bold 

Add in Above: Always 

Vert. Just. At Top ofPara:0.833 inches 

Style: Bold 

Overall Width: Frame-Wide 

Tracking: 0.040 Ems Tighter 

Style: B-Italic 

Overall Width: Frame-Wide 

Leader Spacing: o 
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He a dRotate 
Font 
Size: 24 points Style: Bold 

Alignment 
Horz. Alignment: Center Text Rotation: 180 

Spacing 
Above: 60.00 fractional pts Add in Above: Always 
Inter-Line: 30.00 fractional pts 

Paragraph Typography 
Tracking: 0.025 Ems Tighter 

BodyCenter 
Font 
Size: 8 points 

Alignment 
Horz. Alignment: Center Overall Width: Frame-Wide 

Spacing 
Above: 08.00 fractional pts Add in Above: Always 
Inter-Line: 08.00 fractional pts 

Tab Settings 

Head2 
Tab Number 1: Center, 17,06,32 Tab Number 2: Right, 35,06, 32 
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C:\POWER\6NEWSLET.STY 

Save as C:\TEMP\6NEWS.STY 

Base Page Settings 

Page Size & Layout 
Orientation: 
Paper Type: 

Margins & Columns 

Portrait 
Letter, 8.5 x 11 in. 

# of Columns: 3 
Settings For Left Page 
Top: 04,06 picas & pts. 
Bottom: 06,00 picas & pts. 
Left: 04,06 picas & pts. 
Right: 04,06 picas & pts. 
Widths/Gutters-I: 13,00/01,06 pcs & pts 
Widths/Gutters-2: 13,00/01,06 pcs & pts 
Widths/Gutters-3: 13,00 picas & pts. 

Tag Settings 

Body Text 

Font 
Face: 
Size: 

Alignment 
Horz. Alignment: 
Vert. Alignment: 
Text Rotation: 
Hyphenation: 
Successive Hyphens: 
Overall Width: 

Spacing 
Above: 
Below: 
Inter-Line: 
Inter-Paragraph: 
Add in Above: 

Breaks 
Page Break: 
Column Break: 
Line Break: 

Times 
10 points 

Justified 
Top 
None 
USENGLSH 
3 
Column-Wide 

00.00 fractional pts 
00.00 fractional pts 
12.00 fractional pts 
00.00 fractional pts 
When Not at C.T. 

No 
No 
Before 

Sides: 
Start On: 

Double 
Right Side 

Settings For Right Page 
Top: 04,06 picas & pts. 
Bottom: 06,00 picas & pts. 
Left: 04,06 picas & pts. 
Right: 04,06 picas & pts. 
Widths/Gutters-I: 13,00/01,06 pcs & pts 
Widths/Gutters-2: 13,00101,06 pcs & pts 
Widths/Gutters-3: 13,00 picas & pts. 

Style: 
Color: 

First Line: 
Relative Indent: 
In/Outdent Width: 
In/Outdent Ht.: 
In Fm. Rt. to Dec.: 

In Fm. Left (L): 
In Fm. Right (L): 
In Fm. Left (R): 
In Fm. Right (R): 

Next Y Position: 
Allow Within: 
Keep With Next: 

Normal 
Black 

Indent 
Off 
01,00 picas & pts. 
1 
00,00 picas & pts. 

00,00 picas & pts. 
00,00 picas & pts. 
00,00 picas & pts. 
00,00 picas & pts. 

Normal 
Yes 
No 
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Byline 
Font 
Style: 

Alignment 
Horz. Alignment: 
Hyphenation: 

Spacing 
Above: 

N-Italic 

Left 
Off 

12.00 fractional pts 

Paragraph Typography 
Letter Spacing: Off 

Z_FOOTER 
Font 
Style: N-Italic 

Alignment 
Horz. Alignment: Left 
Hyphenation: Off 

Spacing 
Above: 06.00 fractional pts 
Inter-Line: 12.00 fractional pts 

Ruling Line Above 
Width: Frame 
Color: Black 
Pattern: Solid 
Dashes: Off 
Space Above Rule 1: 00.00 fractional pts 
Height of Rule 1: 00.12 fractional pts 

Kicker 
Font 
Face: Helvetica 
Size: 12 points 

Alignment 
Horz. Alignment: Left 

Spacing 
Add in Above: Always 

Attribute Overrides 
Superscript Size: 10 pointsl05.64 fractional 
pts 

Appendix B 

In/Outdent Width: 00,00 picas & pts. 

In/Outdent Width: 00,00 picas & pts. 

Add in Above: Always 

Space Below Rule 1: 06.00 fractional pts 
Height of Rule 2: 00.00 fractional pts 
Space Below Rule 2: 00.00 fractional pts 
Height of Rule 3: 00.00 fractional pts 
Space Below Rule 3: 00.00 fractional pts 

Style: N-Italic 

In/Outdent Width: 00,00 picas & pts. 

Subscript Size: 10 pointslO1.32 
fractional pts 

Small Cap Size: 10 points 
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Ruling Line Below 
Width: Text Space Below Rule 1: 00.00 fractional pts 
Color: Black Height of Rule 2: 00.00 fractional pts 
Pattern: Solid Space Below Rule 2: 00.00 fractional pts 
Dashes: Off Height of Rule 3: 00.00 fractional pts 
Space Above Rule 1: 02.00 fractional pts Space Below Rule 3: 00.00 fractional pts 
Height of Rule 1: 00.06 fractional pts 

Head! 
Font 
Size: 36 points Style: Bold 

Alignment 
Horz. Alignment: Left Overall Width: Frame-Wide 
Hyphenation: Off In/Outdent Width: 00,00 picas & pts. 
Successive Hyphens: Off 

Spacing 
Above: 18.00 fractional pts Add in Above: Always 
Inter-Line: 36.00 fractional pts 

Paragraph Typography 
Letter Spacing: Off Tracking: 0.030 Ems Tighter 

Head2 
Font 
Size: 24 points Style: Bold 

Alignment 
Horz. Alignment: Left Overall Width: Frame-Wide 
Hyphenation: Off In/Outdent Width: 00,00 picas & pts. 
Successive Hyphens: Off 

Spacing 
Above: 12.00 fractional pts Inter-Line: 24.00 fractional pts 
Below: 12.00 fractional pts Add in Above: Always 

Breaks 
Allow Wi thin: No Keep With Next: Yes 

Paragraph Typography 
Letter Spacing: Off Tracking: 0.030 Ems Tighter 

Z_CAPTION 

Font 
Face: Helvetica 

Alignment 
In/Outdent Width: 00,00 picas & pts. 

Spacing 
Above: 12.00 fractional pts Add in Above: Always 
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Z_BOXTEXT 
Font 
Face: Helvetica Style: Bold 
Size: 8 points 

Alignment 
Horz. Alignment: Right In/Outdent Width: 00,00 picas & pts. 

Spacing 
Above: 03.00 fractional pts In Fm. Right (L): 00,04 picas & pts. 
Add in Above: Always In Fm. Right (R): 00,04 picas & pts. 

Stafffiox 
Alignment 
In/Outdent Width: 00,00 picas & pts. 

Spacing 
Above: 12.00 fractional pts 

TOCEntry 
Font 
Face: Helvetica Style: Bold 

Alignment 
Horz. Alignment: Left In/Outdent Width: 00,00 picas & pts. 
Hyphenation: Off 

Spacing 
Above: 06.00 fractional pts In Fm. Left (R): 00,06 picas & pts. 
In Fm. Left (L): 00,06 picas & pts. In Fm. Right (R): 02,00 picas & pts. 
In Fm. Right (L): 02,00 picas & pts. 

Tab Settings 
Leader Char: 46 

BodyFirst 
Alignment 
In/Outdent Width: 00,00 picas & pts. 

Spacing 
Above: 12.00 fractional pts Add in Above: Always 

JumpLeft 
Font 
Style: N-Italic 

Alignment 
Horz. Alignment: Left In/Outdent Width: 00,00 picas & pts. 
Successive Hyphens: Off 
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JumpRight 
Font 
Style: N-Italic 

Alignment 
Horz. Alignment: Right In/Outdent Width: 00,00 picas & pts. 
Successive Hyphens: Off 

Spacing 
Add in Above: Always In Fm. Right (R): 01,00 picas & pts. 
In Fm. Right (L): 01,00 picas & pts. 

CalTitle 
Font 
Size: 14 points Style: Bold 

Alignment 
Horz. Alignment: Center In/Outdent Width: 00,00 picas & pts. 
Hyphenation: Off 

Spacing 
Add in Above: Always 

CalDays 
Font 
Face: Helvetica Style: Bold 

Alignment 
Horz. Alignment: Center In/Outdent Width: 00,00 picas & pts. 
Hyphenation: Off 

Spacing 
Above: 06.00 fractional pts Add in Above: Always 

Deckhead 
Font 
Size: 12 points Style: Bold 

Alignment 
Hyphenation: Off In/Outdent Width: 00,00 picas & pts. 
Overall Width: Frame-Wide 

Spacing 
Add in Above: Always 

Breaks 
Allow Within: No 
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Ruling Line Above 
Width: Frame Space Below Rule 1: 05.75 fractional pts 
Color: Black Height of Rule 2: 00.00 fractional pts 
Pattern: Solid Space Below Rule 2: 00.00 fractional pts 
Dashes: Off Height of Rule 3: 00.00 fractional pts 
Space Above Rule 1: 00.00 fractional pts Space Below Rule 3: 00.00 fractional pts 
Height of Rule 1: 00.25 fractional pts 

Ruling Line Below 
Width: Frame Space Below Rule 1: 00.00 fractional pts 
Color: Black Height of Rule 2: 00.00 fractional pts 
Pattern: Solid Space Below Rule 2: 00.00 fractional pts 
Dashes: Off Height of Rule 3: 00.00 fractional pts 
Space Above Rule 1: 05.75 fractional pts Space Below Rule 3: 00.00 fractional pts 
Height of Rule 1: 00.25 fractional pts 

Head4 
Font 
Size: 12 points Style: Bold 

Alignment 
Horz. Alignment: Left In/Outdent Width: 00,00 picas & pts. 
Hyphenation: Off 

Spacing 
Above: 12.00 fractional pts 

Breaks 
Keep With Next: Yes 

Head3 
Font 
Size: 24 points Style: Bold 

Alignment 
Horz. Alignment: Left Overall Width: Frame-Wide 
Hyphenation: Off In/Outdent Width: 00,00 picas & pts. 
Successive Hyphens: Off 

Spacing 
Above: 12.00 fractional pts Add in Above: Always 
Below: 12.00 fractional pts In Fm. Left (L): 01,00 picas & pts. 
Inter-Line: 24.00 fractional pts In Fm. Left (R): 01,00 picas & pts. 

Breaks 
Allow Wi thin: No Keep With Next: Yes 

Paragraph Typography 
Letter Spacing: Off Tracking: 0.030 Ems Tighter 



Tag Tables 

Tab Settings 

TOCEntry 
Tab Number 1: 

B -15 

Left, 12,00, 46 
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C:\POWER\7LIST.STV 

Save as C:\TEMP\7DIREC.T .. STY 

Base Page Settings 

Page Size & Layout 
Orientation: 
Paper Type: 

Margins & Columns 

Landscape 
Letter, 8.5 x 11 in. 

# of Columns: 3 
Settings For Left Page 
Top: 06,00 picas & pts. 
Bottom: 06,00 picas & pts. 
Left: 10,00 picas & pts. 
Right: 08,00 picas & pts. 
Widths/Gutters-I: 14,08/02,00 pes & pts 
Widths/Gutters-2: 14,08/02,00 pes & pts 
Widths/Gutters-3: 14,08 picas & pts. 

Tag Settings 

Body Text 

Font 
Face: 
Size: 

Alignment 
Horz. Alignment: 
Vert. Alignment: 
Text Rotation: 
Hyphenation: 
Successive Hyphens: 
Overall Width: 

Spacing 
Above: 
Below: 
Inter-Line: 

Breaks 
Page Break: 
Column Break: 
Line Break: 

Font 
Face: 

Times 
10 points 

Justified 
'lbp 
None 
USENGLSH 
2 
Column-Wide 

00.00 fractional pts 
00.00 fractional pts 
12.00 fractional pts 

No 
No 
Before 

Helvetica 

Sides: 
Start On: 

Double 
Right Side 

Settings For Right Page 
Top: 06,00 picas & pts. 
Bottom: 06,00 picas & pts. 
Left: 08,00 picas & pts. 
Right: 10,00 picas & pts. 
Widths/Gutters-I: 14,08/02,00 pcs & pts 
Widths/Gutters-2: 14,08/02,00 pcs & pts 
Widths/Gutters-3: 14,08 picas & pts. 

Style: 
Color: 

First Line: 
Relative Indent: 
In/Outdent Width: 
In/Outdent Ht.: 
In Fm. Rt. to Dec.: 

Inter-Paragraph: 
Add in Above: 

Next Y Position: 
Allow Wi thin: 
Keep With Next: 

Size: 

Normal 
Black 

Indent 
Off 
00,00 picas & pts. 
1 
00,00 picas & pts. 

00.00 fractional pts 
When Not at C.T. 

Normal 
Yes 
No ( 

8 points 
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Alignment 
Horz. Alignment: Left Hyphenation: Off 

Spacing 
Inter-Line: 09.60 fractional pts Add in Above: Always 

Ruling Line Above 
Width: Margin Space Below Rule 1: 02.00 fractional pts 
Color: Black Height of Rule 2: 00.00 fractional pts 
Pattern: Solid Space Below Rule 2: 00.00 fractional pts 
Dashes: Off Height of Rule 3: 00.00 fractional pts 
Space Above Rule 1: 00.00 fractional pts Space Below Rule 3: 00.00 fractional pts 
Height of Rule 1: 00.50 fractional pts 

Phone 
. Spacing 
Add in Above: Always 

Head! 
Alignment 
Hyphenation: Off 

Head2 
Alignment 
Hyphenation: Off 

Breaks 
Allow Within: No 

Company 
Spacing 
Add in Above: Always 

Breaks 
Keep With Next: Yes 

Head3 
Spacing 
Add in Above: Always 

Head4 
Font 
Size: 11 points Style: Bold 

Alignment 
Horz. Alignment: Left In/Outdent Width: 01,00 picas & pts. 
First Line: Outdent 
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Spacing 
Above: 

Breaks 
Keep With Next: 

Special Effects 
Special Effect: 
Bullet Char: 
Indent After Bullet: 

HeadSection 
Alignment 
Hyphenation: 

12.00 fractional pts 

Yes 

Bullet 
175 
01,00 picas & pts. 

Off 

Paragraph Typography 
Tracking: 0.020 Ems Tighter 

ItalSeparate 
Spacing 
Add in Above: 

ThumbTab 
Font 
Face: 
Size: 

Alignment 
Horz. Alignment: 

Spacing 
Add in Above: 

Breaks 
Keep With Next: 

Always 

Helvetica 
14 points 

Center 

Always 

Yes 

Face: 
Size: 
Color: 

Overall Width: 

Style: 
Color: 

Hyphenation: 

Times 
11 points 
Black 

Appendix B 

Frame-Wide 

Bold 
White 

Off 
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C:\POWER\8DESIGN.STY 

Save as C:\TEMP\8BOOK.STV 

Base Page Settings 

Page Size & Layout 
Orientation: 
Paper Type: 

Margins & Columns 

Portrait 
Half, 5.5 x 8.5 in. 

# of Columns: 1 
Settings For Left Page 
Top: 06,00 picas & pts. 
Bottom: 06,00 picas & pts. 
Left: 04,06 picas & pts. 
Right: 06,00 picas & pts. 
Widths/Gutters-I: 22,06 picas & pts. 

Tag Settings 

Body Text 

Font 
Face: 
Size: 

Alignment 
Horz. Alignment: 
Vert. Alignment: 
Text Rotation: 
Hyphenation: 
Successive Hyphens: 
Overall Width: 

Spacing 
Above: 
Below: 
Inter-Line: 

Breaks 
Page Break: 
Column Break: 
Line Break: 

Headl 
Font 
Size: 

Times 
12 points 

Justified 
Top 
None 
USENGLSH 
3 
Column-Wide 

00.00 fractional pts 
00.00 fractional pts 
14.00 fractional pts 

No 
No 
Before 

18 points 

Sides: 
Start On: 

Double 
Right Side 

B -19 

Settings For Right Page 
Top: 06,00 picas & pts. 
Bottom: 06,00 picas & pts. 
Left: 06,00 picas & pts. 
Right: 04,06 picas & pts. 
Widths/Gutters-I: 22,06 picas & pts. 

Style: 
Color: 

First Line: 
Relative Indent: 
In/Outdent Width: 
In/Outdent Ht.: 
In Fm. Rt. to Dec.: 

Inter-Paragraph: 
Add in Above: 

Next Y Position: 
Allow Within: 
Keep With Next: 

Style: 

Normal 
Black 

Indent 
Off 
01,00 picas & pts. 
1 
00,00 picas & pts. 

00.00 fractional pts 
Always 

Normal 
Yes 
No 

Bold 
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Alignment 
Horz. Alignment: Center In/Outdent Width: 00,00 picas & pts. 
Hyphenation: Off 

Spacing 
Above: 42.00 fractional pts Inter-Line: 18.00 fractional pts 
Below: 18.00 fractional pts Add in Above: When Not at C.T. 

Breaks 
Allow Wi thin: No Keep With Next: Yes 

Head.2 
Font 
Size: 14 points Style: B-Italic 

Alignment 
Horz. Alignment: Left In/Outdent Width: 00,00 picas & pts. 
Hyphenation: Off 

Spacing 
Above: 21.00 fractional pts Add in Above: When Not at C.T. 
Below: 07.00 fractional pts 

Breaks 
Allow Within: No Keep With Next: Yes 

Bullet 
Spacing 
Above: 07.00 fractional pts Below: 07.00 fractional pts 

Breaks 
Line Break: Before & After 

Special Effects 
Special Effect: Bullet Face: Times 
Bullet Char: 195 Size: 12 points 
Indent After Bullet: 01,06 picas & pts. Color: Black 

Z_HEADER 

Alignment 
Horz. Alignment: Left In/Outdent Width: 00,00 picas & pts. 
Hyphenation: Off 

BodyBreak 
Alignment 
In/Outdent Width: 00,00 picas & pts. 

Breaks 
Page Break: After 
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BodyFirst 
Alignment 
In/Outdent Width: 

Spacing 
Above: 

Chap# 
Font 
Size: 

Alignment 
Horz. Alignment: 
Hyphenation: 

Breaks 
Page Break: 
Allow Within: 

Ruling Line Below 
Width: 
Color: 
Pattern: 
Dashes: 
Space Above Rule 1: 
Height of Rule 1: 
Space Below Rule 1: 

ChapTitle 
Font 
Size: 

Alignment 
Horz. Alignment: 
Hyphenation: 

Spacing 
Above: 

Breaks 
Allow Wi thin: 

00,00 picas & pts. 

42.00 fractional pts 

14 points 

Center 
Off 

BeforelUntil Right 
No 

Custom 
Black 
Solid 
Off 
00.00 fractional pts 
01.02 fractional pts 
00.00 fractional pts 

30 points 

Center 
Off 

98.00 fractional pts 

No 

Paragraph Typography 
Tracking: 0.050 Ems Tighter 
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Style: B-Italic 

Overall Width: Frame-Wide 
In/Outdent Width: 00,00 picas & pts. 

Keep With Next: Yes 

Height of Rule 2: 00.00 fractional pts 
Space Below Rule 2: 00.00 fractional pts 
Height of Rule 3: 00.00 fractional pts 
Space Below Rule 3: 00.00 fractional pts 
Custom Indent: 05,00 picas & pts. 
Custom Width: 12,00 picas & pts. 

Style: Bold 

In/Outdent Width: 00,00 picas & pts. 

Inter-Line: 36.00 fractional pts 

Keep With Next: Yes 
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C:\POWER\8PRINT.STV 

Save as C:\TEMP\8PRINT.STY 

Base Page Settings 

Page Size & Layout 
Orientation: 
Paper Type: 

Auto-Numbering 

Margins & Columns 

Portrait 
Half, 5.5 x 8.5 in. 

# of Columns: 1 
Settings For Left Page 
Top: 06,00 picas & pts. 
Bottom: 06,00 picas & pts. 
Left: 04,06 picas & pts. 
Right: 06,00 picas & pts. 
Widths/Gutters-I: 22,06 picas & pts. 

Tag Settings 

Body Text 
Font 
Face: 
Size: 

Alignment 
Horz. Alignment: 
Vert. Alignment: 
Text Rotation: 
Hyphenation: 
Successive Hyphens: 
Overall Width: 

Spacing 
Above: 
Below: 
Inter-Line: 

Breaks 
Page Break: 
Column Break: 
Line Break: 

Headl 
Font 
Size: 

Times 
12 points 

Justified 
Top 
None 
USENGLSH 
3 
Column-Wide 

00.00 fractional pts 
00.00 fractional pts 
14.00 fractional pts 

No 
No 
Before 

18 points 

Sides: 
Start On: 

Appendix B 

Double 
Right Side 

Settings For Right Page 
Top: 06,00 picas & pts. 
Bottom: 06,00 picas & pts. 
Left: 06,00 picas & pts. 
Right: 04,06 picas & pts. 
Widths/Gutters-I: 22,06 picas & pts. 

Style: 
Color: 

First Line: 
Relative Indent: 
In/Outdent Width: 
In/Outdent Ht.: 
In Fm. Rt. to Dec.: 

Inter-Paragraph: 
Add in Above: 

Next Y Position: 
Allow Wi thin: 
Keep With Next: 

Style: 

Normal 
Black 

Indent 
Off 
01,00 picas & pts. 
1 
00,00 picas & pts. 

00.00 fractional pts 
Always 

Normal 
Yes 
No 

Bold 



Tag Tables B - 23 

Alignment 
Horz. Alignment: Center In/Outdent Width: 00,00 picas & pts. 
Hyphenation: Off 

Spacing 
Above: 42.00 fractional pts Inter-Line: 18.00 fractional pts 
Below: 18.00 fractional pts Add in Above: When Not at C.T. 

Breaks 
Allow Wi thin: No Keep With Next: Yes 

Head.2 
Font 
Size: 14 points Style: B-Italic 

Alignment 
Horz. Alignment: Left In/Outdent Width: 00,00 picas & pts. 
Hyphenation: Off 

Spacing 
Above: 21.00 fractional pts Add in Above: When Not at C.T. 
Below: 07.00 fractional pts 

Breaks 
Allow Within: No Keep With Next: Yes 

Bullet 
Spacing 
Above: 07.00 fractional pts Inter-Line: 14.00 fractional pts 
Below: 07.00 fractional pts 

Breaks 
Line Break: Before & After 

Special Effects 
Special Effect: Bullet Face: Times 
Bullet Char: 195 Size: 12 points 
Indent After Bullet: 01,06 picas & pts. Color: Black 

Z_HEADER 
Alignment 
Horz. Alignment: Left In/Outdent Width: 00,00 picas & pts. 
Hyphenation: Off 

BodyBreak 
Font 
Size: 10 points 

Alignment 
In/Outdent Width: 00,00 picas & pts. 
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Spacing 
Inter-Line: 12.00 fractional pts 

Breaks 
Page Break: After 

BodyFirst 
Alignment 
In/Outdent Width: 00,00 picas & pts. 

Spacing 
Above: 42.00 fractional pts 

Special Effects 
Special Effect: Big First Char Size: 30 points 
Space for Big First: 2 lines Color: Black 
Face: Times Shift: Down 01.00 fractional pts 

Chap# 
Font 
Size: 14 points Style: B-Italic 

Alignment 
Horz. Alignment: Center Overall Width: Frame-Wide 
Hyphenation: Off In/Outdent Width: 00,00 picas & pts. 

Breaks 
Page Break: BeforelUntil Right Keep With Next: Yes 
Allow Within: No 

Ruling Line Below 
Width: Custom Height of Rule 2: 00.00 fractional pts 
Color: Black Space Below Rule 2: 00.00 fractional pts 
Pattern: Solid Height of Rule 3: 00.00 fractional pts 
Dashes: Off Space Below Rule 3: 00.00 fractional pts 
Space Above Rule 1: 00.00 fractional pts Custom Indent: 05,00 picas & pts. 
Height of Rule 1: 01.02 fractional pts Custom Width: 12,00 picas & pts. 
Space Below Rule 1: 00.00 fractional pts 

ChapTitle 
Font 
Size: 30 points Style: Bold 

Alignment 
Horz. Alignment: Center In/Outdent Width: 00,00 picas & pts. 
Hyphenation: Off 

Spacing 
Above: 98.00 fractional pts Inter-Line: 36.00 fractional pts 

Breaks 
Allow Within: No Keep With Next: Yes 
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C:\POWER\9TECH.STY 

Save as C:\TEMP\9TECHDOC.STY 

Base Page Settings 
Page Size & Layout 
Orientation: 
Paper Type: 

Margins & Columns 

Landscape 
Letter, 8.5 x 11 in. 

# of Columns: 3 
Settings For Left Page 
Top: 11,00 picas & pts. 
Bottom: 13,00 picas & pts. 
Left: 09,06 picas & pts. 
Right: 10,06 picas & pts. 
Widths/Gutters-I: 14,00102,00 pcs & pts 
Widths/Gutters-2: 14,00102,00 pcs & pts 
Widths/Gutters-3: 14,00 picas & pts. 

Tag Settings 

Body Text 

Font 
Face: 
Size: 

Alignment 
Horz. Alignment: 
Vert. Alignment: 
Text Rotation: 
Hyphenation: 
Successive Hyphens: 
Overall Width: 

Spacing 
Above: 
Below: 
Inter-Line: 

Breaks 
Page Break: 
Column Break: 
Line Break: 

Font 
Size: 

Times 
10 points 

Left 
'lbp 
None 
USENGLSH 
2 
Column-Wide 

12.00 fractional pts 
00.00 fractional pts 
12.00 fractional pts 

No 
No 
Before 

12 points 

Sides: 
Start On: 

Double 
Right Side 

Settings For Right Page 
'lbp: 11,00 picas & pts. 
Bottom: 13,00 picas & pts. 
Left: 10,06 picas & pts. 
Right: 09,06 picas & pts. 
Widths/Gutters-I: 14,00102,00 pcs & pts 
Widths/Gutters-2: 14,00102,00 pcs & pts 
Widths/Gutters-3: 14,00 picas & pts. 

Style: 
Color: 

First Line: 
Relative Indent: 
In/Outdent Width: 
In/Outdent Ht.: 
In Fm. Rt. to Dec.: 

Inter-Paragraph: 
Add in Above: 

Next Y Position: 
Allow Within: 
Keep With Next: 

Style: 

Normal 
Black 

Indent 
Off 
00,00 picas & pts. 
1 
00,00 picas & pts. 

00.00 fractional pts 
When Not at C.T. 

Normal 
Yes 
No 

B-Italic 
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Alignment 
Horz. Alignment: Justified 

Spacing 
Above: 06.00 fractional pts Add in Above: Always 

Z_LABELCAP 
Alignment 
Horz. Alignment: Center Hyphenation: Off 

Spacing 
Above: 00.00 fractional pts 

Z_FOOTER 
Font 
Style: N-Italic 

Alignment 
Hyphenation: Off 

Spacing 
Above: 00.00 fractional pts Add in Above: Always 

Title 
Font 
Size: 60 points Style: Bold 

Alignment 
Horz. Alignment: Center Overall Width: Frame-Wide 
Hyphenation: Off 

Spacing 
Above: 48.00 fractional pts Inter-Line: 60.00 fractional pts 
Below: 48.00 fractional pts Add in Above: Always 

Head! 
Font 
Size: 24 points Style: Bold 

Alignment 
Hyphenation: Off 

Spacing 
Above: 24.00 fractional pts Inter-Line: 24.00 fractional pts 
Below: 12.00 fractional pts 

Head2 
Font 
Size: 18 points Style: B-Italic 
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Alignment 
Hyphenation: Off 

Spacing 
Above: 24.00 fractional pts Inter-Line: 18.00 fractional pts 

Breaks 
Keep With Next: Yes 

Head3 
Font 
Face: Helvetica Style: Bold 
Size: 12 points 

Head5 
Font 
Size: 12 points Style: Bold 

Spacing 
Add in Above: Always 

Breaks 
Keep With Next: Yes 

Z_CAPTION 
Font 
Style: N-Italic 

Alignment 
Relative Indent: On In/Outdent Width: 00,04 picas & pts. 

Spacing 
Above: 00.00 fractional pts 

Breaks 
Line Break: After 

Z_SEC2 

Font 
Style: Bold 

Spacing 
Add in Above: Always 

Breaks 
Keep With Next: Yes 

BodyBreak 
Alignment 
Horz. Alignment: Justified 
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Spacing 
Above: 00.00 fractional pts Inter-Line: 02.00 fractional pts 

Breaks 
Page Break: After 

BodySmal1 
Font 
Face: Helvetica Size: 8 points 

Spacing 
Below: 12.00 fractional pts Inter-Line: 10.00 fractional pts 

ListBullet 
Spacing 
Above: 00.00 fractional pts 

Special Effects 
Special Effect: Bullet Face: Times 
Bullet Char: 195 Size: 12 points 
Indent After Bullet: 01,00 picas & pts. Color: Black 

Title Sub 
Font 
Face: Helvetica Style: B-Italic 
Size: 24 points 

Alignment 
Horz. Alignment: Center Overall Width: Frame-Wide 
Hyphenation: Off 

Spacing 
Above: 24.00 fractional pts Inter-Line: 24.00 fractional pts 
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C:\POWER\PROFEXT.STV 

Save as C:\TEMP\PROFEXT.STY 

Base Page Settings 
Page Size & Layout 
Orientation: 
Paper Type: 

Auto-Numbering 
Levell: 

Margins & Columns 

Landscape 
Letter, 8.5 x 11 in. 

[*Body Text] 

:# of Columns: 3 
Settings For Left Page 
Top: 11,00 picas & pts. 
Bottom: 13,00 picas & pts. 
Left: 09,06 picas & pts. 
Right: 10,06 picas & pts. 
Widths/Gutters-1: 14,00/02,00 picas & pts. 
Widths/Gutters-2: 14,00/02,00 picas & pts. 
Widths/Gutters-3: 14,00 picas & pts. 

Color Settings 
Screen Display: Shades of Gray 
Color Number 0 (White):(OOO.O, 000.0, 
000.0, 000.0) 

Tag Settings 

Body Text 
Font 
Face: 
Size: 

Alignment 
Horz. Alignment: 
Vert. Alignment: 
Text Rotation: 
Hyphenation: 
Successive Hyphens: 
Overall Width: 

Spacing 
Above: 
Below: 
Inter-Line: 

Times 
10 points 

Left 
Top, 
None 
USENGLSH 
2 
Column-Wide 

12.00 fractional pts 
00.00 fractional pts 
12.00 fractional pts 

Sides: 
Start On: 

Level 2: 

Double 
Right Side 

[*List#,l]. 

Settings For Right Page 
Top: 11,00 picas & pts. 
Bottom: 13,00 picas & pts. 
Left: 10,06 picas & pts. 
Right: 09,06 picas & pts. 
Widths/Gutters-1: 14,00/02,00 picas & pts. 
Widths/Gutters-2: 14,00/02,00 picas & pts. 
Widths/Gutters-3: 14,00 picas & pts. 

Color Number 1 (Black):(100.0, 100.0, 
100.0, 000.0) 
Color Number 2 (Red): (000.0, 100.0, 100.0, 
000.0) 

Style: 
Color: 

First Line: 
Relative Indent: 
In/Outdent Width: 
In/Outdent Ht.: 
In Fm. Rt. to Dec.: 

Inter-Paragraph: 
Add in Above: 

Normal 
Black 

Indent 
Off 
00,00 picas & pts. 
1 
00,00 picas & pts. 

00.00 fractional pts 
When Not at C.T. 
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Breaks 
Page Break: No Next Y Position: Normal 
Column Break: No Allow Within: Yes 
Line Break: Before Keep With Next: No 

Z_LABELFIG 
Font 
Size: 12 points Style: B-Italic 

Alignment 
Horz. Alignment: Justified 

Spacing 
Above: 06.00 fractional pts Add in Above: Always 

Z_LABELCAP 
Alignment 
Horz. Alignment: Center Hyphenation: Off 

Spacing 
Above: 00.00 fractional pts 

Z_FOOTER 
Font 
Style: N-ltalic 

Alignment 
Hyphenation: Off 

Spacing 
Above: 00.00 fractional pts Add in Above: Always 

Title 
Font 
Size: 60 points Style: Bold 

Alignment 
Horz. Alignment: Center Overall Width: Frame-Wide 
Hyphenation: Off 

Spacing 
Above: 48.00 fractional pts Inter-Line: 60.00 fractional pts 
Below: 48.00 fractional pts Add in Above: Always 

Head! 
Font 
Size: 24 points Style: Bold 

Alignment 
Hyphenation: Off 
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Spacing 
Above: 24.00 fractional pts Inter-Line: 24.00 fractional pts 
Below: 12.00 fractional pts 

Breaks 
Column Break: Before & After 

Head2 
Font 
Size: 18 points Style: B-Italic 

Alignment 
Hyphenation: Off 

Spacing 
Above: 24.00 fractional pts Inter-Line: 18.00 fractional pts 

Breaks 
Keep With Next: Yes 

Head3 
Font 
Face: Helvetica Style: Bold 
Size: 12 points 

Head5 
Font 
Size: 12 points Style: Bold 

Spacing 
Add in Above: Always 

Breaks 
Keep With Next: Yes 

Z_CAPTION 
Font 
Style: N-Italic 

Alignment 
Relative Indent: On In/Outdent Width: 00,04 picas & pts. 

Spacing 
Above: 00.00 fractional pts 

Breaks 
Line Break: After 

Z_SEC2 

Font 
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Style: Bold 

Spacing 
Add in Above: Always 

Breaks 
Keep With Next: Yes 

BodyBreak 
Alignment 
Horz. Alignment: Justified 

Spacing 
Above: 00.00 fractional pts Inter-Line: 02.00 fractional pts 

Breaks 
Page Break: After 

BodySmal1 
Font 
Face: Helvetica Size: 8 points 

Spacing 
Below: 12.00 fractional pts Inter-Line: 10.00 fractional pts 

Lis tBulle t 
Spacing 
Above: 00.00 fractional pts 

Special Effects 
Special Effect: Bullet Face: Times 
Bullet Char: 195 Size: 12 points 
Indent After Bullet: 01,00 picas & pts. Color: Black 

TitleSub 
Font 
Face: Helvetica Style: B-Italic 
Size: 24 points 

Alignment 
Horz. Alignment: Center Overall Width: Frame-Wide 
Hyphenation: Off 

Spacing 
Above: 24.00 fractional pts Inter-Line: 24.00 fractional pts 

List# 
Spacing 
In Fm. Left (L): 01,00 picas & pts. In Fm. Left (R): 01,00 picas & pts. 
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Breaks 
Line Break: After 

Z_SECI 
Font 
Style: Bold 

Breaks 
Keep With Next: Yes 

Head4 
Font 
Size: 14 points Color: Red 
Style: Bold 

Alignment 
Overall Width: Frame-Wide 

Spacing 
Above: 00.00 fractional pts Inter-Line: 18.00 fractional pts 

Breaks 
Page Break: Before 

Rule 
Font 
Size: 12 points Style: Bold 

Alignment 
Overall Width: Frame-Wide In/Outdent Width: 00,04 picas & pts. 
Relative Indent: On 

Spacing 
Add in Above: Always 

Breaks 
Line Break: After Keep With Next: Yes 

Ruling Line Above 
Width: Text Space Below Rule 1: 02.00 fractional pts 
Color: Black Height of Rule 2: 00.50 fractional pts 
Pattern: Solid Space Below Rule 2: 00.00 fractional pts 
Dashes: Off Height of Rule 3: 00.00 fractional pts 
Space Above Rule 1: 00.00 fractional pts Space Below Rule 3: 09.00 fractional pts 
Height of Rule 1: 02.00 fractional pts 

Note 
Spacing 
In Fm. Left (L): 01,00 picas & pts. In Fm. Left (R): 01,00 picas & pts. 
In Fm. Right (L): 01,00 picas & pts. In Fm. Right (R): 01,00 picas & pts. 
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Ruling Box Around 
Width: 
Color: 
Pattern: 
Dashes: 
Space Above Rule 1: 
Height of Rule 1: 

Spacer 
Spacing 
Add in Above: 

Alignment 

Column 
Red 
Solid 
Off 
00.00 fractional pts 
00.06 fractional pts 

Always 

Hyphenation: Off 

Tab Settings 

Rule 
Tab Number 1: Right, 46,00, 32 

Space Below Rule 1: 
Height of Rule 2: 
Space Below Rule 2: 
Height of Rule 3: 
Space Below Rule 3: 

Appendix B 

03.00 fractional pts 
00.00 fractional pts 
00.00 fractional pts 
00.00 fractional pts 
00.00 fractional pts 
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The Power Disk 

The Power disk contains text files, style sheets, and chapter 
files for use with the sample projects in Publishing Power 
With Ventura. You may obtain as many original copies of the 
Power disk as you need by using the order form at the back of 
this book, or by phoning the number shown on the form. 

The Power disk requires Xerox Ventura Publisher Version 2.0 
or 2.0 Professional Extension, and PC-DOS/MS-DOS 2.0 or 
higher. 

Benefits of the disk 

Disclaimer 

The Power disk saves time. It allows you to get right to the 
heart of the sample projects by using prepared text files, style 
sheets, and chapter files. It contains many pages of text that 
you would otherwise need to type on your own. In addition, it 
includes style sheets with predefined tags, margins, columns, 
and other basics. Because the style sheets are partially en
coded, you can focus on the specific topics at hand, without the 
need to recreate basic parameters before you can start. 

The Power disk is subject to change at any time without 
notice. It is provided on an as-is basis, as a convenience. New 
Riders Publishing is not liable or responsible to any person or 
entity with respect to any loss or damage in connection with or 
arising from the use of the disk. 
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Installing the disk 
Before starting, make a copy of the disk using the DOS utility 
DISKCOPY. (DISKCOPY will duplicate the subdirectories 
and the files. If you prefer to use the COpy command, you 
must create the subdirectories on your own and copy the 
correct files to the correct subdirectories.) Store the original in 
a safe place and use the cOpy as the working disk. 

The Power disk is copyrighted. It is intended for your personal 
use. It may not be sold o:r transferred for profit. 

Mter making a copy, you are ready to install the files onto the 
hard disk. You should begin by scanning the README.1ST 
file on the disk for possible changes or corrections: 

1m Turn on your system. 

= When you see the DOS prompt, put the working Power disk 
in drive A: 

1m Change to the A: drive by typing: 

A: [Enter] 

m To view the README. 1ST file, type: 

HELP [Enter] 

~ Alternatively, you can type: 

TYPE README. 1ST [Enter] 

1m To stop the screen from scrolling, type Ctrl-S. Type Ctrl-S 
again to resume scrolling. 

1m To produce a printout of the file, turn on your printer and 
type: 

COpy README.1ST PRN [Enter] 

Installing on hard disk C: 
You may install the Power disk with a simple DOS COpy 
procedure provided (1) that your hard disk is designated as C: 
and (2) that you are able to set up a separate C: \POWER 
subdirectory. 

If you do not meet both conditions, you must perform the 
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additional procedure below titled "If your hard disk is desig
nated other than C:." 

WARNING: If you use DOS COpy to move the files from the Power disk to any place 
other than C:\POWER without following the additional procedures explained below, 
the sample chapters may not work properly. 

To install the Power disk, you will perform two steps: 

1. create a C:\POWER subdirectory and 

2. copy the files from the floppy to the C:\POWER subdirec
tory. 

Here are the steps to take: 

m Move to the C: disk by typing: 

C: [Enter] 

m At the C: prompt, type: 

MD \POWER 
CD\POWER 

m Put the working Power disk in drive A: and type: 

COpy A:*.* 

The installation is complete. Remove the working Power disk 
from the A: drive and store it in a safe place. You may proceed 
to Chapter One and begin work. 

If your hard disk is designated other than C: 
If your hard disk is named other than C:, you must perform an 
additional Multi-Chapter function before you can begin work 
with the Power disk. 

For instance, your hard disk may be designated as D:. Or, you 
may already have a C:\POWER subdirectory to which you do 
not wish to add any additional files. In either case, you can use 
the Power disk, but only if you use the Multi-Chapter proce
dures explained below. 

Ventura's chapters contain pointers that tell the program 
where to find the files it needs. The sample chapters on the 
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Power disk point to the C:\POWER subdirectory. If you place 
them anywhere else, you must change their pointers before 
they will work properly. To do that, you must use Multi-Chap
ter from the Options menu while in Ventura. 

The first step is to decide where you want to place the Power 
files. For illustration, we will assume that you wish to place 
them in a subdirectory called D:\SAMPLE. In the instruction 
below, substitute your actual disk drive and subdirectory 
wherever you see D:\SAMPLE. 

WARNING: You must follow the installation instructions in the order shown below. 
Otherwise, we cannot guarantee proper operation of the sample chapters. 

~ Change to the D: disk by typing: 

D: [Enter] 

m At the D: prompt, type: 

MD \SAMPLE 
CD \SAMPLE 

m Put the working Power disk in drive A: and do not remove 
it until the end of this procedure. Type: 

COPY A:*.* 

11 Load Ventura Publisher. Once it is on the screen, select 
Multi-Chapter from the Options menu. You do not need to 
open a chapter first. 

m If there is a chapter highlighted in the Multi-Chapter 
dialog box, deselect it by clicking anywhere else inside the 
dialog box. 

a Select Open from the list at the side of the dialog box. The 
Item Selector will appear. 

a Move the cursor to the Directory line. Press Esc to clear the 
line and type: 

A:\CHAPTERS\*.PUB [Enter] 

Ventura looks on the A: drive for publications. An Item Selec
tor appears. It shows only one publication, called 
POWER.PUB. 
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tID Click on POWER.PUB to select it. Click OK. 

The Multi-Chapter dialog box now shows a list of the chapters 
that make up the publication. 

tID Select Copy All from the list at the right side of the dialog 
box. 

The Copy All dialog box appears. At the top is a Source section. 
Confirm that it shows the publication A:\CHAP
TERS\POWER.PUB. 

m Move the cursor to the line labeled PUB & CHPs. Press Esc 
to clear the line. Type in the name of your destination 
subdirectory. For example: 

D: \ SAMPLE 

m Click once on the button titled Make All Directories the 
Same As the First. 

All the lines now read D: \ SAMPLE. 

m Click OK. 

WARNING: As Ventura copies the files, you will see one or more of the following 
messages. Respond by choosing the uppermost button, as explained below. 

Ventura displays several messages like the one below: 

D:\SAMPLE\6NEWSLET.CHP already exists on the tar
get drive. Do you wish to overwrite the old ver
sion, keep the old file, or cancel the archive 
process? 

m Choose Overwrite (the uppermost button). 

You may also see this message: 

This file could not be found: CIVENTURA\OUT
PUT.WID. Do you wish to skip over it or retry 
with a new disk, or cancel the archive process? 

m Choose Skip (the uppermost button). 

When Ventura has finished copying, it returns you to the 
Multi- Chapter dialog box. 

m Click on Done. 
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Remove the Power disk from the A: drive. You are ready to 
begin work. 

-NOTE: See Chapter One for more information about Ventura 
files and pOinters. See Chapters Three and Seven for hands
on practice with Multi-Chapter. 
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Colophon 

Not only do we produce books about Ventura at New Riders, 
we also produce books with Ventura. Consequently, people 
often ask us about our favorites: op.r favorite equipment, our 
favorite software, our favorite production tricks and techni
ques. We included this brief appendix to answer some of those 
questions. 

Perhaps the most important advice we have to offer concerns 
the management of the production process. Some of the big
gest problems with Ventura arise not from the software, but 
from lack of organization and standardization. We use a 
variety of techniques to make it easier to produce pages with 
Ventura in a workgroup environment: 

• Standard tag names 

• Standard file naming conventions for every file that goes 
into the document 

• Standard subdirectory naming and organization across dif
ferent computers 

• A standard chapter template so headers, crop marks, frame 
sizes, and other repeating elements are identical from 
chapter to chapter 

• A style guide for authors and editors that covers tagging, 
file naming, spelling, grammar, and other basics 

• A tag that shows the latest date of the style sheet, so we 
don't accidentally use an old version 
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• An ID line at the top of text files to identify the file name 
and date. This information is placed in a footer that falls 
outside the trim margin. That way, we can glance at the 
bottom of the page and immediately know which version of 
the document we are looking at 

These procedures have brought numerous benefits: 

• We can recognize files at a glance just by their name and 
extension 

• Authors can pretag manuscripts so we have less pretagging 
to do 

• Authors can mark the manuscripts with the position, file 
name, and a description of the pictures they want. The 
layout editor merely has to load the right file into the right 
frame 

• We can use DOS to archive and copy chapters between 
machines (because the subdirectory organization is 
identical) 

• Any layout operator can work on any project, because the 
procedures are the same 

We developed some of these ideas on our own. Many of them, 
however, are borrowed from editors and experts around the 
country who have been kind enough to share their favorite 
tricks and tips. Our production management techniques are 
described in detail in our book New Writing, a style guide and 
procedures handbook for desktop publishing. See the ordering 
section for more information on this book. 

Software and hardware 
Our job was made easier this time around by several new or 
improved tools. At the top of the list is Ventura 2.0 Profes
sional Extension. In our experience, this new version is much 
less prone to bugs and crashes. We employed many of its new 
features. Our favorites include: 

• EMS support for faster formatting and fewer crashes 

• Table mode for quick, easy preparation of tables 
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• Enhancements to Graphic mode so callouts and other il-
lustrations are easier to produce 

We are also experimenting with the new cross referencing and 
frame anchoring features available in the Professional Exten
sion' but we have not yet fully integrated them into our 
production system. 

We captured the screen shots with Hotshot Graphics from 
Symsoft. This combination screen capture/graphics 
editor/graphics library program continues to expand and im
prove with each new edition. 

We also made extensive use of LaserTorq, a print spooling 
utility from LaserTools. You can print your chapters to a disk 
or (RAM disk) and LaserTorq will then spool them to the 
printer in the background. Meanwhile, you get your keyboard 
back so you can go on working without waiting for the printer 
to stop. Unfortunately, we did not have enough memory to 
permit us to use LaserTorq with very large chapters. 

In addition, we also made use of our own third-party program, 
Desktop Manager. This utility works "inside" Ventura to add 
new dialog boxes and new features. We can track the status of 
projects, check the contents and size of files, get automatic 
timed backup, and much more, all without leaving the Ven
tura work session. Best of all, from a production standpoint, is 
the ability to copy, move, rename, or delete any file, chapter, or 
publication within Ventura. Until we had Desktop Manager, 
we had to leave Ventura to rename a graphics file; or to 
archive a chapter without also sending the width file to the 
hard disk; or to delete a chapter and its associated files. Now 
we can do all these tasks (and many more) within Ventura. 

The manuscript was created with Microsoft Word. We used 
Ventura to convert to WordStar format for in-house editing. 

We couldn't have gotten by without our big screen monitors 
from Verticom and Moniterm. Verticom no longer makes 
monitors for desktop publishing (although they are still sell
ing in the CAD arena), but Moniterm is still active. 

Our computers are Premium 286 models from AST equipped 
with 1- 2MB of RAM and 40MB hard disks. When you routine
ly produce 700-page books with 500 illustrations, you soon 



D -4 Production details 

come to wish for the speed of a 386-based computer and the 
storage capacity of 100MB+ hard drives. We hope to upgrade 
soon. We are also still searching for the ideal backup solution. 
At the moment, we still use 1.2 MB floppies. 

Production details 
The camera-ready pages for this book were produced on a 
300-dpi laser printer. 

The main text is 11/13 Century Schoolbook. Display type is 
Helvetica Bold. Captions and tables are Helvetica Narrow. 

Printing: Web offset, R.R. Donnelley & Sons, Indiana. 



Index 

A 

Abandon 1-29 
publications 1-65 
recovering from mistakesl-53 

Abbreviated Format 1-53, 3-37 
Above Spacing 1-43, 1-51, 1-66 

See also Spacing 
Add Chapter 3-64 
Add New Frame 1-58,3-23,3-32 
Add New Tag 2-29 
Adding a Caption 2-51, 3-59 
Adding a Frame 2-41, 3-23 
Adding a New Printer 3-63 
Adding a New Tag 2-28,2-49, 

2-56 
Adding a Page Break 2-30 2-56 
Adding a Picture 2-41 ' 
Addition Button 1-9 
Adobe Illustrator 5-1 
An Advertising Flyer 5-1 ° 
Aligning Text Frame-Wide 2-27 
Alignment 

decimal 4-46 
frame-wide 2-27,6-41, 7-17 
indents 2-26, 2-56 
middle 4-43 
relative indent: on 7-44, 9-26 
rotated 5-32 

Allow Within: No 9-30 
Alt Key 2-5, 4-51, 5-7, 5-26, 5-30, 

5-57, 10-11 
Anchors & Captions 2-51, 2-57, 

3-59, 3-70, 6-52, 9-43 

See also InsertlE di t Anchors 
Applying Tags 1-39, 2-25 

to an empty paragraph 2-31 
Arrow Keys 

finding hidden attributes 2-17 
ASCII Files 

converting to other formats 6-8 
creating 7-2 
typing in 7-7 

Aspect Ratio: Distorted 5-6, 6-51 
Aspect Ratio: Maintained 3-59 5-6 

5-55 ' , 
Assign a Color 9-36 

Assign Function Keys 3-50, 3-53, 
3-68, 9-16 

Assigning a File Extension 1-24 
Assignment List 1-9, 1-39 
Attribute Overrides 8-24 
Attributes, Text 2-5, 2-15, 2-18 

bold 6-27, 10-34 
hidden 10-18 
in headers 4-17 
italics 2-16, 6-27 
normal 6-30 
paste 2-21 
removing 2-18,2-21 
small 6-28, 8-24 

Auto-Adjustments 1-52, 2-8 
Auto-Leader 4-44 
Auto-Numbering 9-17, 9-19, 9-51 

creating outlines 9-51 
with multiple lists 9-31 

AutoCAD 5-1, 9-1 
DXFTOGEM conversion 9-2 
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encapsulated postscript format 9-2 
HPGL format 9-2 
slide file format 9-2 

Automatic Figure Numbering 9-43 
Automatic Invoice Numbering 4- 13 
Automatic Pair Kerning 5-46, 5-47 

implementing 5-49,5-59 

B 
Backing Up 

a chapter 1-5, 1-63 
a publication 1-5, 3-64 
See( also Copying 
See also Multi-Chapter 

Backspace Key 1-22 
Backup Button 1-23, 1-67 

moving to subdirectories 1-17 
Backup Files 1-27 
Balancing Columns 2-25, 2-56, 3-20 
Banner Headline 6-41,6-62 
Below Spacing 1-43, 1-51, 1-66, 

2-28,3-48 
See also Spacing 

Big First Character 6-6, 6-44, 6-62, 
8-22 

Bit-Mapped Images 
See Pictures 

Body Text 
formatting first in a document 
1-40, 2-25, 6-32 
inter-line spacing 1-66, 10-36 
removing a tag to 3-58 

Boldface Lead-ins 6-6 
A Book 8-3 

parts of 8-1 
Book Tips 8-50 
Box Character 6-47 

copy 6-48 
cut 6-48 
paste 6-48 

Box Text 1-9, 4-7 
adding text to 4-38 

B-B 

changing fill attributes 4-26, 4-47 
changing line attributes 4-25, 4-49 
copy 4-26, 4-34, 6-55 
cut 4-24 
deselecting 4-47 
drawing 4-24, 5-13, 9- l17 
effects 4-7 
end styles 4-50 
modifying the Z_BOXTEXT tag 4-9, 
4-42 
moving 4-27, 4-54 
paste 4-27, 4-35 
resizing 4-24,4-28 
tips 5-56 
versus frame text 4-8 
versus rectangles 4-9 

Box Text Tips 4-54, 5-56 
Bracket Codes 2-5, 2-17, 8-52, 9-46 
Breaks 2-25, 2-30, 2-32 

allow within: no 9-30 
keep with next 2-35, 2-39, 2-56, 
7-20, 7-22 to 7-24 
page 2-32 
with side-by-side paragraphs 8-28 

Bring to Front 5-56 
Bullets 2-37, 2-39 

See also Special Effects 
Business Documents 

an advertising flyer 5-10 
an invoice 4-12 
a book 8-3 
a directory 7-6 
a single-column report 1-7 
a technical manual 9-5 
a three-column newsletter 6-6 
a two-column newsletter 3-13 
a two-column proposal 2-8 

By Scale Factors 5-4, 5-6, 5-55 
aspect ratio distorted 5-6 
aspect ratio maintained 5-6, 5-55 



c-c 

c 
A Calendar 6-6, 6-52 
Callouts 4-7, 4-54, 9-5, 9-47 
Canceling a Dialog Box 1-11 
Caption File 3-28, 3-30, 4-8, 6-61 
Caption Labels 3-59, 3-70 
Captions 2-56 

adding 2-51, 3-5, 3-59,6-52, 9-43 
automatic figure numbering 3-59 
9-43 ' 
defini tion of 3-5 
formatting 2-53 
label 3-59 
modifying 3-60 
overwri ting 5-37 
sizing and scaling 2-52, 2-54 
text in 2-53, 6-52 

Carding 10-36 
Cells 10-6 

adding text to 10-32 
contents of 10-8 
editing 10-43 
joining 10-28 
specifying 10-6 

Changing Column Formats 2-23 
Changing Page Numbers 4-21 4-52 

8-20, 8-32 ' , 
Chapter Counter 8-19, 8-32 
Chapter Files 

backing up 1-5, 1-63 
defini tion of 1-1 
opening 1-5, 1-49 
parts of 1-1 
pointers in 1-1, 1-5, 1-63 
printing 1-62 
renaming 1-27, 3-16 
restoring 1-27 
saving 1-28, 1-62, 3-22 
where Ventura stores 1-2 

Chapter Menu 1-31 

Chapter Templates 6-59, 7-33 to 
7-35 
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Chapter Tips 1-67, 3-70, 6-60, 6-63 
Chapter Typography 3-19, 6-11 

column balance 2-25 
move down to 1st baseline by 3-20 
6-35,8-22 ' 
overriding 5-44 
pair kerning 5-47 
vertical justification allowed 10-37 
vertical justification around frame 
10-35 
widows and orphans 3-20 8-20 

Clipboard 2-19,2-21, 2-56, 3-3, 3-34, 
3-67,4-26 to 4- 28, 5-39, 6-48 

Codes, Typographic 2-5, 2-17, 4-19, 
5-11, 5-25, 5-59, 6-27 

Color 
See Spot Color 

Color Printing 
process color 9-34 
spot color 9-34 

Column Balance 2-25, 2-56 3-20 
5-46 ' , 

Column Break: Before & After 9-15 
Column Breaks 9-5 
Column Guides 1-10, 3-23 
Column Snap 2-41, 3-23, 4-4, 5-15, 

5-45 
Columns 

balancing 2-25, 3-20 
calculating side-by-side paragraphs 
8-28 

changing number of2-23, 5-22,6-14 
making equal widths 2-24, 2-56 
unequal 5-22 

Conversion 
DXFTOGEM 9-2 
of file formats 6-7, 6-61 
to typographic characters 2-8 

Copy All 1-64, 3-66 
Copy Box Character 6-48 
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Copy Box Text 6-55 
Copy Column 10-8 
Copy Fitting 5-46 
Copy Frames 3-34 
Copy Graphic 4-26, 4-31, 4-34, 5-40 
Copy Row 10-8 
Copy Text 2-15, 2-19, 2-21, 2-55 
Copy To Facing Page 3-17, 3-19 
Copying 

a chapter 1-5 
a publication 1-5 
See also Backing Up 
See also Multi-Chapter 

Copyright Symbol 2-5 
Correcting Typing Mistakes 1-22, 

3-29 
Creating a Publication 1-63, 3-64, 

3-70, 10-40 
Creating a Title Page 9-13 
Creating ASCII Files 7-2 
Creating Multiple Lists 9-31 
Creating Subdirectories in Ventura 
1-14 
Creating Technical Illustrations 9-1 
Crop Marks 7-6, 7-9, 7-43, 8-3, 9-7 

built-in vs. hand-drawn 7-11 
changing margins to draw 9-8 
printing 8-50 

Cropping Pictures 5-4 
images, bit-mapped 5-7 
line-art 5-7 
x, y offset 5-7 

Cross Referencing 10-1 to 10-3, 
10-42 
substitute text 10-17 
variable text 10-17 

Ctrl-[ 5-26 
Ctrl-] 5-26 
Ctrl-B 9-30 
Ctrl-C 6-46 
Ctrl-E 1-30 
Ctrl-Enter 4-40, 5-26 

Ctrl-Hyphen 5-51, 5-57 
Ctrl-K 3-51, 3-53, 3-69, 9-16 
Ctrl-N 1-30 
Ctrl-Q 4-52, 4-55, 7-11 
Ctrl-R 1-30 
Ctrl-S 1-28, 1-62, 3-23 
Ctrl-Shift-[ 6-27 
Ctrl-Shift-] 6-27 
Ctrl-Shift-F 6-42 
Ctrl-Shift-T 6-42 
Ctrl-T 2-19 

D-D 

Ctrl-X 1-11, 2-54, 3-24, 3-34, 3-57, 
5-12 

Ctrl-Z 5-39 
Current Selection Box 1-10, 1-55, 

2-18 
displaying file name 1-20 

Custom Rules 7-21 
Cut Box Character 6-48 
Cut Column 10-8 
Cut Frames 1-60, 3-24, 3-34 
Cut Graphic 4-24, 4-27 
Cut Row 10-8 
Cut Text 2-15, 2-19, 2-21, 2-55 

D 

Dashed Rules 6-20, 6-61 
Database Program 

generating a directory from 7-1, 7-3 
pretagging in 7-1 to 7-3 

Decimal Alignment 4-46 
Deckhead 3-55 
Define Colors 9-35 
Del Key 1-22, 3-34, 4-24 
Delete Frames 1-60, 3-24,3-34 
Delete Graphic 4-24,4-27 
Delete Tables 10-43 
Delete Text 2·.15, 2-19, 2-21 
Deselecting Graphic 4-29 
Dialog Box 
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cancelling choices 1-11 
enter key 1-11 
help menus 1-11 
measurement units 1-11 
OK button 1-11 
recalling last 2-54 
saving choices 1-11 
text attr. button 4-18 

Diamond 1-23 
A Directory 7-6 
Directory Line 1-23, 1-67 
Disable Colors 9-35 
Discretionary Hyphens 5-51, 5-57 
Display Generated Tags 2-40 
Display Type 3-40 
Documents 

See Business Documents 
DOS 1-16, 1-67 

copy command 1-5, 1-15, 1-63, 1-67 
rename command 1-26, 2-13 
starting Ventura from 1-8 
using Multi-Chapter instead of 1-5 

Double Rule 9-23, 9-27 
Double-Clicking 2-10 
Double-Sides 3-17, 5-15 
Dragging the Mouse 3-1 
Drawing Box Text 4-24, 5-18 to 

5-21, 9-47 
Drawing Multiple Frames 3-32 
Drop Cap 

See Big First Character 
Drop Shadows 5-37 

E 
Edit Fractions 8-11 
Editing Text 1-66; 2-15, 2-19, 2-21, 

2-55,5-32 
Effects 

arrow 4-50 
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underscore 4-44 
automatic numbering in header 4-13 
balanced columns 2-25 
banner headline 2-28, 6-41, 6-62 
big first character 6-6, 6-44, 8-22 
boldface lead-in heads 6-6, 6-28 
box text 4-7, 5-11 
bullet 2-37, 2-39 
call outs 4-7, 4-54, 9-5, 9-47 
column breaks 9-5 
creating a calendar 6-6, 6-52 to 
6-57,6-59 
creating a dateline 3-41 
creating a title page 2-26 
creating chapter templates 6-59 to 
6-61, 6-63, 7-33 to 7-35 
crop marks 7-6, 7-9, 7-43, 9-7 
custom rule 3-54, 6-6, 7-21 
deckhead 3-55 
dotted tear line 4-13, 4-36, 4-44 
double rule 6-6,6-43, 9-23, 9-27 
drop cap 8-22 
drop shadows 5-11, 5-37 
end of article symbol 6-46 
fold line 6-20 
hollow box 6-46 
jump text 6-23, 6-27 
kerning headlines 5-11, 5-46, 6-33 
kicker 3-43 
lead-in paragraph 3-46 
letter spacing 5-50 
logo 3-37, 6-33 
nameplate 3-37 
note 9-28 
number lists 4-46 
outlines 9-51 
overlapping graphics 4-8 
page break 2-30, 2-32 
pull quote 6-25, 6-43, 6-61 
reverse type 4-13, 7-6, 7-16, 7-18, 
7-43 
rotated text 5-32 
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ruling box around frame 2-45, 5-22 
ruling lines in tables 10-44 
secondary margins 1-48 
section numbers 9-5 
small cap lead-in heads 8-24 
snap-to grid 4-13 
solid box 6-46 
spacer tag 9-41 
spot color 9-5 
table of contents 3-28, 8-36 
tables with horizontal tabs 2-45 
tags residing on same line 3-42, 
3-69,6-39, 6-48, 7-23, 7-44 
teaser 5-25 
text aligned across columns 1-47, 
3-22,5-47, 6-12 
text runarounds 5-11, 5-42, 5-43, 
5-56 
thumb tabs 7-6, 7-25 
tint screens 4-13, 4-47, 6-6, 6-14 
tracking headlines 3-38, 3-40, 6-33, 
6-37 

two-column format 2-23 
typographic fractions 8-10 

Ellipsis 5-11, 5-25 
Em Dash 2-5, 2-8, 5-11, 5-26 

converting from hyphens 2-8 
Em Space 3-40 
Empty Paragraph 2-31,9-13, 9-15 
En Dash 7-13 
Encapsulated PostScript 5-57 

creating 5-53 
displaying 5-3, 5-37 
placing 5-3, 5-36 

End Key 1-29 
End of Article Symbol 6-46 
End of File Marker 2-52,3-28,4-7, 

4-24,6-23 
tagging the 4-45 

End Styles 4-26 
Enlarged View 1-30, 5-16 
Enter Key 

closing a dialog box 1-11 
EPS 

See Encapsulated PostScript 
Esc Key 1-22 
Extensions 

assigning 1-2, 1-24, 5-55, 8-37 

F 
Feathering 10-35 

F-F 

Figure Numbering, Automatic 9-43 
Figure Space 6-42 
File Management 

pictures 5-2 
problems encountered in 1-15 
renaming and relocating files 1-2, 
1-14,2-11 
storing files in subdirectories 1-14 

File TypelRename 1-21, 2-11,3-15, 
6-7, 6-9, 6-23 
ti ps for using 1-66 

File Types 
CAP 1-2 
CHP 1-2 
CIF 1-2 
IMG 1-2 
VGR 1-2 

Files 
backing up 1-3 
extensions 1-2, 1-24 
loading 1-16, 1-25, 1-49, 2-10, 3-14 
managing 1-1, 1-14, 1-67 
removing from frame 2-13 
renaming and relocating 1-2,1-15, 
1-21, 1-26, 2-11, 2-55, 6-8, 6-61 
restoring 1-27 
selecting in Item Selector 1-18,2-10 
spreadsheet 2-41 
See also Chapter Files 
See also Graphics Files 
See also Picture Files 
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See also Program Files 
See also Text Files 

Fill Attributes 
changing 4-26, 4-47 
saving 4-26, 4-56 

Fill Patterns 6-14, 7-29 
Fit in Frame 3-59, 5-4 

aspect ratio distorted 5-5, 6-51 
aspect ratio maintained 5-5 

Flow Text Around: Off 5-42 
Fold Line 6-20 
Font Dialog Box 

for non-PostScript printer 1-41 
for PostScript Printer 1-41 

Fonts 
shifting up/down 8-23 
with non-PostScript printer 1-41 
with PostScript printer 1-41 

Fontware 3-37 
Footers 2-56 

building 2-23, 2-40, 7-12, 9-11 
changing the frame margin of 7-14, 
9-12 
changing the position with spacing 
7-15 
inserting page numbers in 2-23 
live 7-6, 7-12, 7-43 
turning off for first page 2-23 

Footnote 
changing the frame margin of 8-10 
changing the position with spacing 
8-10 
deleting 8-10 
inserting 8-6 
separator line 8-6 
setting the format of 8-6 
text of 8-8 
tips 8-51 
See also Ins Special Item 

Footnote Settings 8-6 
Formatting a Generated Tag 2-53 
Formatting Tables 
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horizontal tabs 2-45, 2-49, 2-57 
side-by-side paragraphs 8-27 
See also Tables 

Formula, 'rhe Ventura -xi 
See also The Ventura Formula 

Fractions 
editing 8-11 
inserting 8-10 
See also Ins Special Item 

Frame Background 6-14 
See also Fill Patterns 

Frame Menu 1-31 
Frame Mode 1-9 

enabling 1-20, 1-36, 3-1 
Frame Text 3-30 

versus box text 4-8 
Frame Tips 3-67, 4-54, 6-62 
Frame Typography 6-35 

for copy fitting 5-44 
Frame-Wide Alignment 2-27, 6-41, 

7-17 
Frames 

adding 1-58, 2-41, 3-32, 5-16 
adding an anchor to 9-44 
adding captions to 3-5 
adding columns to 3-4 
adding margins to 2-44,3-4,7-27, 
7-43 
aligning on page 1-60, 3-9 
blank frame 1-10 
chaining text files between 3-4, 3-9, 
6-21 
changing the order of 3-10 
copy 3-34, 3-67 
creating text runarounds with 5-44, 
5-56 
cut 1-60, 3-24, 3-34 
fill patterns 6-6,6-14, 6-62, 7-29 
grid settings in 4-7, 5-37 
jump text 3-26, 3-30 
moving 1-60,3-2, 3-34,3-67 
overlapping 3-3 
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padding 1-60 
parent 4-2 
paste 3-3, 3-34 
placing pictures in 2-41 
placing text in 1-19,2-41, 3-1, 3-7, 
3-9, 3-68, 6-20 
re-anchoring 9-46 
removing text from 2-13 
repeating 7-25, 7-31 
ruling lines around 6-62 
selecting 3-1, 3-67, 5-57 
sizing and scaling 1-59, 2-42, 3-1, 
3-24, 3-34, 3-59, 3- 67, 5-4, 5-16 
typing text in 3-28, 3-30, 3-35, 3-68, 
5-13,6-61 
versus the Page 3-1, 3-7 

Function Keys 3-50, 3-53, 3-68 
tagging with 3-52 
tips for naming 3-52 

G 

GEM Draw 5-2 
GEMIHALO DPE 3-15 
Generated Tags 1-39, 2-40, 2-53, 

2-56, 3-53, 3-60,4-9,4-42, 8-9, 8-37, 
8-41, 8-43, 9-12, 9-18, 10-12 

Generating a Table of Contents 8-3, 
8-36, 8-38, 8-40 

Generating an Index 8-3,8-12 
Generating Pretagged Files 7-1 
Go to Page 6-20 
Graphic 

box text 4-1,4-7 
bring to front 5-56 
circles 4-1 
clipboard 4-28, 5-39 
copy 4-26, 4-31, 4-34, 5-39 
cut 4-24, 4-27 
deselecting 4-29, 4-47 
drawing several shapes 4-30 

end styles 4-26 
fill attributes 4-26 
line attributes 4-25, 4-49 
lines 4-1, 4-50 
moving shapes 4-27,6-62 
overlapping 4-8 
parent frame 4-2 
paste 4-26, 4-31, 4-35, 5-39 
rectangles 4-1, 5-37, 7-9 
resizing 4-24,4-28 
select all 4-52 
send to back 5-38, 5-56 

G-H 

show on all pages 4-3, 4-52, 4-55, 
7-11, 9-10 

Graphic Mode 1-9,4-1 
enabling 4-23 
if selected while loading text 1-19 
key points of 4-2 to 4-4 

Graphic Tips 4-55 
The Grid System 6-1 
Grid Settings 4-4, 5-18, 5-37, 7-9 

horizontal 4-23 
vertical 4-23 

Grid Snap: On 4-24 
Grid, Snap-To 3-9, 4-4 to 4-6, 4-13, 

4-55, 5-56 
Ground Rules 

making your system match vii 
Gutters 

entering 2-24, 3-17 

H 
Half-Size Format 8-3 
Handles 

See Sizing Buttons 
Header Rows 10-9 
Headers 2-56 

automatic numbering in 4-13 
building 4-17 
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changing the position with spacing 
7-15 
copy to facing page 3-19 
entering text in 4-17 
inserting page numbers in 1-35, 
3-19,4-19 
live 7-43 
modifying the Z_HEADER tag 3-53 
resetting after margins change 1-37 
text attributes in 4-17 
turning off for first page 1-35, 3-19 

Headers & Footers 2-23, 2-40 
1st Match 7-13 

Help Menus 1-11 
Hide All Pictures 5-53 
Hide Tabs & Returns 2-30 
Hollow Box 6-46 

changing size of 6-47 
Home Key 1-29 
Horizontal Spacing 

See Spacing 
Horizontal Tabs 2-45 
Hyphenation 

dictionary 5-57 
manual 5-51 
preventing 5-57 
turning off for display type 1-51 

Hyphens 
converting to em dash 2-8 
discretionary 5-51, 5-57 
placing in text files 1-16 

I-Beam 2-15 
Images, Bit-Mapped 

See Pictures 
In From Left Spacing 1-48,2-39, 

3-43, 3-47, 3-69, 6-49, 8-28, 9-20 
See also Spacing 
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In From Right Spacing 1-48, 3-43, 
3-69, 6-49, 8-28 
See also Spacing 

Indents 2-26, 2-56 
Index 

generating 8-3, 8-12 
levels of 8-12 
primary entry 8-13 
secondary entry 8-13 
see also references 8-13 

Ins Column 10-9 
Ins Key 2-19, 3-34, 4-27,4-35 
Ins New Table 10-25, 10-43 
Ins Row 10-9, 10-33 
Ins Special Item 6-46 

box character 6-47 
cross reference 10-4, 10-21 
footnote 8-8 
fraction 8-11 
frame anchor 9-45 
index entry 8-13 
reference 7-28, 7-37 
variable def 10-18 

Inserts 
1st Match 7-13 
Last Match 7-43 

Insert Frames 3-3, 3-34 
Insert Graphic 4-27, 5-39 
Insert Text 2-15, 2-19 
InsertlEdit Anchor 9-44, 9-52 
InsertlEdit Table 10-8, 10-11, 10-24, 

10-43 
InsertlRemove Page 3-32 
Inserting a Footnote 8-6 
Inserting a Fraction 8-10 
Inserting a Page 3-32, 4-52, 5-21 
Inserting a Reference Marker 7-29 
Inserting an Index Entry 8-13 

See also Ins Special Item 
Inserting Cross References 10-3, 

10-18, 10-42 



E-10 

Inserting Discretionary Hyphens 
5-51 

Inserting Typographic Codes 2-4, 
4-19,5-11 

Installing a Second Printer 3-70 
Inter-Col. Rules 3-18 
Inter-Line Spacing 1-43, 1-47, 1-51, 

1-60, 1-66 
See also Spacing 

Inter-Paragraph Spacing 1-66, 2-28 
See also Spacing 

Interactive Tracking 6-34 
An Invoice 4-12 
Italics 

when to use 2-16 
Item Selector 1-17 

J 

backup button 1-17, 1-67 
diamond 1-17 
directory line 1-23, 1-67 
selection line 1-19 

Join Cells 10-28 
Jump Text 3-26, 3-30, 6-12, 6-23, 

6-27 

K 
Keep With Next 2-35, 2-39, 2-56, 

7-20, 7-22 to 7-24 
Kerning 6-33 

automatic pair 5-46, 5-57 
defini tion of 5-46 
in text mode 5-48 
manual 5-46, 5-48 
on-screen 5-49, 5-57 
tables 5-46 

Keyboard Mode 
accidentally enabling 1-30 

Keyboard Shortcuts 2-19 
alt Key 2-5, 5-7, 5-26, 5-30 
backspace 1-22 
ctrl-[ 5-26 
ctrl-] 5-26 
ctrl-b 9-30 
ctrl-c 6-46 
ctrl-e 1-30 
ctrl-enter 4-40,5-26 
ctrl-hyphen 5-51, 5-57 
ctrl-k 3-51, 3-53 
ctrl-n 1-30 
ctrl-q 4-52, 4-55 
ctrl-r 1-30 
ctrl-s 1-28, 3-23 
ctrl-shift-[ 6-27 
ctrl-shift-] 6-27 
ctrl-shift-f 6-42 
ctrl-shift-t 6-42 
ctrl-t 2-19 

J-L 

ctrl-x 1-11, 2-54, 3-24, 3-34, 3-57, 
5-12 
ctrl-z 5-39 
del 1-22, 2-19, 2-55, 3-34 
end 1-29 
esc 1-22 
function keys 3-50 
home 1-29 
ins 2-19, 2-55 
pgdn 1-21, 1-29 
pgup 1-29 
shift key 4-30 
shift-click 1-55, 1-57, 2-18, 2-34, 2-56 
shift-del 2-19, 2-55 

Kicker 3-43 

L 
Landscape Format 7-6, 9-5 
Lead-in Heads 6-28, 8-24 
Lead-in Paragraph 3-46 ' 
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Leader Dots 3-48, 3-69 
Letter Spacing 5-50 
Line Attributes 

adding an arrow 4-50 
changing 4-25, 4-49 
end styles 4-26 
saving 4-25, 4-56 

Line Break: Mter 3-42, 7-24 
Line Break: Before 3-43, 7-23 
Line Break: No 8-31 
Line Breaks 1-38, 4-40, 5-26 

versus paragraphs 7-3 
Line Snap 2-41, 3-23, 4-4, 5-15, 

5-43, 6-12 
Line-Art 

See Pictures 
Lines 4-50 
Lists 9-5, 9-17 to 9-19, 9-31 

creating 9-5 
Live Headers and Footers 7-6, 7-12, 

7-43 
steps for creating 7-13 

Load Diff. Style 1-22 
Load Different Width Table 3-63 
Load TextlPicture 1-25, 2-55 
Loading a Picture File 1-25, 3-15 
Loading a Style Sheet 1-22 
Loading a Text File 1-16, 2-41 
Loading Several Files 2-10 
Logo 3-37, 6-33 
Loose Lines 5-51 

reducing 5-51 

M 
MacDraw 5-2 
Make Equal Widths Button 2-24 
Make TOC 8-37 
Making Columns Equal Widths 
2-24,2-56 
Managing Files 1-1, 1-14, 1-67 
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Margins 
changing 1-36, 3-17 
creating temporary 1-48, 8-31 
resetting the header after changing 
1-37 
rule of thumb for creating 1-37 

Margins & Columns 1-36, 2-23, 5-22 
copy to facing page 3-17 
in frames 2-44, 3-4, 6-14 

Markers, On-Screen 2-17, 2-19 
displaying 2-30 

Maximum and Minimum Space 
Values 5-50 
Measurement Units 1-11 

changing in dialog box'l-36 
Measuring Indents 2-26 
Measuring System 

picas and points 2-2 
Menus 

drop down 1-8 
selecting 1-8 

MicroSoft Word Format 6-8 
Middle Alignment 4-43 
Mode Selector 1-8 

frame mode 1-8 
graphic mode 1-8 
paragraph mode 1-8 
text mode 1-8 

Modifying Tags 1-30,2-25 
Mouse 1-18, 3-2 

using viii 
Move Down to 1st Baseline By 3-22, 

5-44, 6-35, 8-22 
defini tion of 3-20 

Multi-Chapter 1-63 
for backing up a chapter 1-5,1-63 
for backing up a publication 1-5, 
1-63, 3-64, 3-70 
make TOC 8-37 
printing with 1-62,3-64, 3-66, 7-39, 
10-39 



E-12 

renumbering a publication 7-39, 
10-4, 10-22 
See also Backing Up 
See also Copying 

MultiMate Format 6-8 

N 
Nameplate 3-37 
New 1-8, 4-13 

when to use 2-10 
Newsletter-Style Layout 3-1, 3-7, 

3-9, 3-11, 3-17, 3-20, 3-22, 3-37, 
3-68, 6-1, 6-6, 6-21, 6-52, 6-62 

Normal View 1-30, 5-16 
Number Lists 4-46 

o 
Object-Oriented Graphics 

See Pictures 
OK Button 1-11 
On-Screen Kerning 5-49, 5-57 
One-Column Report 1-7 
Open and Closed Quotes 6-27 

converting from standard quotes 
2-5,2-8 

Open Chapter 1-49 
Options Menu 1-11 

starting configuration 1-11 
OUTPUT. WID 3-64 

p 

Padding 
setting to body text inter-line 1-60, 
6-62 
vertical 1-47, 1-60, 6-26 

The Page 

as parent to graphic 4-2 
definition of 1-10, 3-6, 3-68 
double-sides 1-32 

N-P 

if selected while loading text 1-19, 
2-11,5-12 
moving around 1-29 
placing text on 1-19, 1-21, 3-7 
removing files from 2-13 
selecting 1-20 
single-sides 1-32 
sizing and scaling 1-32, 3-6, 3-68 
versus frames 3-1, 3-7 
viewing 1-29 

Page Break 2-32, 2-56 
adding a 2-22, 2-30 

Page Break: After 2-30,9-51 
Page Break: Before 7-17, 9-24 
Page Break: BeforelUntil Right 7-17 
Page Counter 8-20, 8-32 
Page Layout Strategy 1-31, 2-22, 

3-1, 3-7, 3-9, 3-17, 3-22, 4-12, 4-17, 
5-10, 5-15, 5-57, 6-3, 6-32 

Page Numbers 1-10 
changing 4-20,4-52, 8-20, 8-32 
in thumb tabs 7-6, 7-28 
inserting in footers 1-35 
inserting in headers 1-35, 3-19,4-19 
linking across chapters 7-38 
on double-sided pages 3-17 
See also Page Counter 

Page Size & Layout 1-32 
defining the page with 1-10 
double-Sides 3-17, 5-15 
half-size format 7-12, 8-3 
landscape format 7-6,9-5 

Pair Kerning: On 5-47 
Paper Type & Dimension 7-12 
Parafiltr Code 2-4, 2-55, 7-42 
Paragraph 

definition of 1-38 
empty 2-31 
lead-in 3-46 
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tagging the wrong 2-27 
using line breaks in 1-38 
versus line breaks 7-3 

Paragraph Menu 1-31 
Paragraph Mode 1-9 

enabling 1-40 
if selected while loading text 1-19 
when to use 2-16, 2-55 

Paragraph Typography 3-39, 6-33 
at bottom of paragraph 10-38 
at top of paragraph 10-38 
automatic pair kerning 5-47 

Paste Box Character 6-48 
Paste Column 10-8 
Paste Frames 3-3, 3-34 
Paste Graphic 4-26, 4-31, 4-35, 5-39 
Paste Row 10-8 
Paste Text 2-15, 2-19, 2-55 
PC Paintbrush 5-1 
PgDn Key 1-21, 1-29 
PgUp Key 1-29 
Picture Files 

how Ventura manages 5-2 
loading 1-25, 1-49, 5-2 
renaming and relocating 1-26, 2-13 

Picture Tips 2-57, 3-70, 5-55, 6-62, 
9-52 

Pictures 
Adobe Illustrator 5-1 
AutoCAD 5-1 
cropping 5-4, 5-7 
encapsulated postscript 5-3, 5-37 
GEM Draw 5-2 
hiding 5-56 
images, bit-mapped 5-2, 5-4 
line-art 5-2 to 5-4, 5-36, 9-1 
MacDraw 5-2 
object-oriented 5-2 
PC Paintbrush 5-1 
sizing and scaling 5-4 to 5-6, 5-42, 
5-55, 6-51 

Placing Text in Frames 1-19 
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Placing Text on the Page 1-19, 1-21 
Planning 

an advertising flyer 5-10 
a book 8-3 
a directory 7-6 
an invoice 4-12 
a one-column report 1-7 
a technical manual 9-5 
a three-column newsletter 6-6 
a two-column newsletter 3-13 
a two-column proposal 2-8 

The Point System 2-2 
Pointers 

changing 1-5, 1-63, 1-67 
storing 1-1, 1-16, 5-55 

Pop-Up Menus 1-11 
PostScript Printer 

creating Encapsulated Postscript 
files with 5-3 

fonts used with 1-41, 3-37 
if you do not have 1-41, 1-62, 3-37, 
6-33 
installing as a second printer viii, 
1-41 
overlapping graphics 4-8 
using the book with viii 

The Power Disk 
if you do not own ix, 1-8 
if you own 1-8 
installing ix, 1-8 
orderingix 

Preformatting Text 2-3 to 2-5, 2-55, 
8-1 

Pretagging Text 7-1 
rules for 7-2 
tips 7-42 

Print Spooler 10-39 
Printer Ports, Changing 3-63 
Printer's Measure 2-2 

picas 2-2 
points 2-2 

Printing 1-62 
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1st to last 6-59, 7-41 
crop marks 7-11, 8-3, 8-50 
current page 2-54, 2-57, 4-53 
hidden pictures 5-53 
last to 1st 3-61, 3-70, 7-41 
number of copies 4-53 
publications 8-49, 10-41 
selected pages 3-61 
spot color 9-34, 9-50 
to file 5-53, 10-39 
which pages 6-59 

The Professional Extension 
if you have installed vi to vii 

Publications 
abandoning 1-65 
backing up 3-64 
creating 1-63, 3-64, 3-70, 8-34, 10-40 
definition of 1-63, 3-64 
linking page numbers across 
chapters 7-38 
new 8-34 
printing 8-49, 10-41 
rearrange chapter list in 8-35 
renumbering 7-39, 7-44, 8-36, 10-18, 
10-22 
saving 3-65, 10-22 

Pull Quote 6-25, 6-43, 6-61 

Q 

Quit 
without saving 1-16 

Quotes 
true typographic 2-5 

R 

Re-Anchoring Frames 9-46 
Rearrange Chapter List 8-35 

Q-R 

Recalling the Last Dialog Box 2-54, 
3-24 

Rectangles 4-9, 5-37, 7-9 
Reduced View 1-30 
Reducing Loose Lines 5-51 
Reference 7-28, 7-37 
Registered Sign 5-11 
Relative Indent: On 7-44,9-26 
Remove Selected Tag 3-58 
Remove TextlFile 2-12, 3-15,6-7 
Removing Ruling Lines 2-34 
Removing Text from Frames 2-12, 

3-15 
Rename Tag 3-57 
Renaming and Relocating Files 1-2, 

1-21, 1-26,2-11, 2-13, 3-15, 3-30, 
6-8,6-61 

Renumber a Publication 7-39, 7-44, 
8-36, 10-4, 10-18, 10-22 

Renumber Chapter 9-30 
Repeating Frame 7-25, 7-31 

editing a 7-31 
Resetting the Zero Point 2-42, 4-21, 

4-37 
Reverse Type 4-13, 7-6, 7-16, 7-18, 

7-43 
if you cannot print 7-16,7-18, 7-22 

Rotated Text 5-32 
Rows and Columns in Tables 10-6 

copy 10-8 
cut 10-8 
paste 10-8 

Rulers 
changing units 1-58 
displaying 1-58 

Rules 
changing attributes in tables 10-43 
custom 3-54, 6-6, 6-38, 7-21 
dashed 6-20, 6-61 
double 6-6, 9-23, 9-27, 10-43 
hidden 10-43 
inter~column 3-18 
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margin-wide 6-50 
normal 10-43 
single 10-43 
space below rule 3 7-18, 7-22, 7-43, 
9-27 
thick 10-43 
vertical 3-18 

Rules of Thumb 
adding a new tag 2-29 
alignment versus spacing 2-39 
for building style sheets 1-31, 2-25, 
3-17, 5-15 
for creating side-by-side paragraphs 
8-27 
for entering margins & columns 5-22 
for vertical justification 10-13 
keep with next 2-36 
placing text in pictures 6-21 
preformatting text 2-4 
pretagging text in a database 7-2 

Ruling Box Around 2-45, 3-26, 5-22, 
9-28 
tables 10-6 
when crossing a page or column 9-30 

Ruling Line Above 7-21 
creating reverse type with 7-16 
custom width 3-54, 6-38 
dashed 6-20, 6-61 
margin 6-50 
text 9-24 

Ruling Line Below 
margin 6-50 
removing 2-34 
text 3-44 

s 
Save 1-28, 3-22 
SaveAs 1-67 
Save As New Style 1-24 
Save To 4-26, 4-56, 5-56 

Saving Chapter Files 1-28 
Scanned Images 5-2, 5-56 
Screen Fonts 3-63 
Scroll Arrows 1-18 
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moving around the page with 1-29 
Scroll Bars 

moving around the page with 1-29 
Scroll Box 1-18 
Section Numbers 

See Lists 
Select All Graphics 4-52 
Selecting Files 1-19, 2-10 
Selecting Multiple Paragraphs 2-38 
Selecting the Page 1-20 
Selection Line 1-19 
Send to Back 5-38, 5-56 
Separator Line for Footnote 8-6 
Set Column Width 10-43 

fixed width 10-10 
variable width 10-10 

Set Font 2-15, 6-34 
kerning with 5-48 

Set Preferences 1-13, 2-40 
auto-adjustments 1-52 
hide all pictures 5-53 
keep backup files 1-27 
on-screen kerning 5-49 
starting configuration 1-13 

Set Printer Info 3-62, 10-39 
adding a new printer 3-63 
changing printer ports 3-63, 5-54 
changing width tables 3-63 
output.wid 3-64 
screen fon ts 3~63 
switching printers viii, 1-41, 1-62, 
3-37, 3-63, 3-70 

Set Ruler 1-58 
Set Tint 10-30 
Setting Tabs 2-50 
Shapes 

See Graphic 
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Shift Key 3-32 
for drawing 9-9 

Shift-Click 1-55, 1-57, 2-18, 2-34, 
2-38, 2-56, 3-67 

Shift-Del 2-19, 4-34, 5-39 
Shortcuts, Keyboard 

See Keyboard Shortcuts 
Show Column Guides 6-7 
Show Loose Lines 5-51 
Show On All Pages 4-3, 4-52, 4-55, 

7-11,9-10 
Show Tabs & Returns 2-30, 3-43, 

5-32 
Show This Picture 3-59 
Side-By-Side Paragraphs 8-3 

calculating column widths 8-28 
preparing text for 8-28 

Sizing & Scaling 2-42, 2-57, 3-34, 
5-16,5-42 
aspect ratio maintained 3-59 
cropping pictures 5-7 
fit in frame 3-59, 5-4 
flow text around 5-42 
frames 3-24 
pictures 5-4 
tips for using 5-7 
upper left y 5-16 

Sizing Buttons 1-10, 1-20, 3-1, 4-2, 
4-28 

Snap-To Grid 3-9, 4-4 to 4-6, 4-13, 
4-55,5-56 

Solid Box 6-46 
Space Below Rule 1 9-29 
Space Below Rule 3 7-18, 7-22, 7-43, 

9-27 
Space Between Columns 10-27 
Space Between Rows 10-27 
Space For Big First: Custom 6-44 
Space For Big First: Normal 6-45, 

6-62,8-22 

Spacing 
at bottom of frame 10-37 
at top of frame 10-37 
between lines 1-43 
between paragraphs 1-43 

s-s 

body text inter-line spacing 1-47, 
1-66, 2-25, 3-22 
changing the position of footnotes 
with 8-10 
changing the position of headers 
and footers with 7-15 
dialog box 1-43 
eliminating space at the top of a 
page or column 1-43,1-46 
horizontal spacing 1-43, 1-48 
how auto-adjustments affect 1-52 
in from left 1-48,2-39, 3-47 
in from right 1-48 
maintaining standard spacing 1-47, 
10-27, 10-36 
padding 1-47 
tips for above spacing 1-43, 1-51, 
1-66 
tips for below spacing 1-43, 1-51, 
1-66, 2-28, 3-48 
ti ps for in from left and in from 
right 1-48, 3-43, 3-69, 6-49, 8-28, 
9-20 
tips for inter-line spacing 1-43, 1-47, 
1-51, 1-66 
tips for inter-paragraph spacing 
1-43, 1-66, 2-28 
versus alignment 2-39 
vertical justification 10-13,10-17, 
10-19, 10-27 to 10-31, 10-33, 10-35 
vertical spacing 1-43, 1-47, 1-51, 
3-22 
with side-by-side paragraphs 8-28 

Special Effects 
big first character 6-44, 6-62, 8-22 
bullet 2-37, 2-39 
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Spooler, Print 10-39 
Spot Color 9-5 

adding 9-34 
printing 9-34 
printing overlays 9-50 

Spot Color Printing 9-35 
Spreadsheet File 2-41 

preformatting 2-10 
Starting a New Chapter 1-8, 4-13 
Style Sheets 

contents of 1-31 
defini tion of 1-31 
modifying 1-40 
renaming and relocating 1-24, 1-66 
rules of thumb 1-31 

Style Tips 1-66, 2-56, 3-69, 6-61 
Subdirectories 

T 

creating in Ventura 1-14, 1-22 
displayed in item selector 1-17 
moving to 1-17, 1-23 

Tab Settings 2-45, 2-47, 2-50, 2-57, 
3-48, 3-69, 5-33, 6-39, 9-26 
auto-leader 4-44 
creating an underscore 4-44 
measuring locations from margin 
2-47,6-40 
turning off 2-57 

Table Editor 
See Tables 

Table Mode vii, 10-5 
Table of Contents 3-28 

generating a 8-3, 8-36, 8-38, 8-40 
Table Text 10-12, 10-27, 10-30, 10-43 
Table Tips 8-51, 10-43 
Tables 

adding rows 10-33 
adding tint screen 10-29 
cells 10-6, 10-43 
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changing column number 10-10 
changing column widths 10-9 to 
10-11 
changing header rows 10-9 
changing lines 10-6 
changing rule attributes 10-9 
changing settings 10-9 
changing spacing values 10-9 
creating with table mode 10-5, 
10-24, 10-26 
creating with horizontal tabs 2-45 
creating with side-by-side 
paragraphs 8-27 
deleting 10-43 
editing 10-8 
hiding lines 10-6 
joining cells 10-28 
rows and columns in 10-6 
ruling box around 10-6 
ruling lines between 10-6 
set column width dialog box 10-10 
setting the tint of 10-8, 10-30 
space above 10-27 
space around 10-27 
space below 10-27 
space between columns 10-27 
space between rows 10-27 
text in 10-12, 10-30, 10-43 
the parts of 10-6 
tips 10-43 

Tag Tables 4-15 
Tagging the Wrong Paragraph 2-27 
Tags 

adding new 2-28, 2-49, 2-56 
applying 1-39,2-25 
applying to empty paragraph 2-31 
applying with function keys 3-50, 
3-68 
definition of 1-31, 1-39 
generated 1-39,2-40, 2-53, 2-56, 
3-60, 4-9, 4-42 
in a database program 7-1 
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modifying 1-30, 1-38, 1-40, 1-54, 2-25 
removing 3-56, 3-58 
renaming 3-56 
residing on same line 3-42, 3-69, 
6-39,6-48, 7-23, 7-44 

Teaser 5-25 
A Technical Manual 9-5 
Technical Illustrations, Creating 9-1 
Templates 

See Chapter Templates 
Temporary Margins 

wi th in from left and in from right 
spacing 8-31 

Temporary Memory 
See eli pboard 

Text 
adding to box text 4-38 
aligning across columns 1-47, 3-22, 
5-45,6-12 
at top of column or page 3-20 
attributes 2-5, 2-15, 2-18, 2-21 
clipboard 2-19, 2-21 
copy 2-15, 2-19, 2-21, 2-55 
copy fitting 5-43 
correcting mistakes 1-22, 3-29 
cut 2-15, 2-19, 2-21, 2-55 
editing 2-15, 2-19, 2-21, 2-55 
hidden attributes in 2- 18 
in captions 2-53, 6-52, 6-61 
in tables 10-12, 10-30, 10-43 
inserting typographic characters 
2-5 
locating hidden attributes 2-18 
paste 2-15, 2-19, 2-55 
preformatting 1-66, 2-3 to 2-5, 7-1, 
8-1 
replacing in Ventura 10-17 
rotated 5-32 
runarounds 5-11, 5-42, 5-56 
stored in caption file 3-28, 3-30, 3-35 
tips 3-68, 10-42 

T-T 

typing into frames 3-28, 3-30, 3-35, 
3-68, 5-13 
vertical 7-28 
white 7-17, 7-29 
See also Editing Text 
See also Word Processing 

Text Attr. Button 4-18 
Text Files 

generating TOC 8-40 
loading 1-16, 2-11 
placing in frames 1-19, 2-41, 3-1, 
3-7, 3-27, 3-68, 5-13, 6-20 
placing on the Page 1-19, 3-7 
pretagging 7-1 
renaming and relocating 1-21, 2-11, 
3-15, 5-12 
selecting in item selector 1-19 

Text Mode 1-9 
enabling 2-15 
if selected while loading text 1-19 
kerning in 5-48 
tagging in 3-50 to 3-53, 3-68 
when to use 2-16, 2-55 

Text of Footnote 8-8 
Text Tips 1-66, 2-55, 6-43, 6-61, 

9-51,10-42 
Thin Space 6-42 
Third-Party Utilities 1-26, 3-37 
A Three-Column Newsletter 6-6 
Three- Column Format 6-2, 9-5 
Thumb Tabs 7-6, 7-25 

steps for creating 7-25 
Thumbnail Sketch 4-12 
Tiff Format 5-4 
Tint Screens 4-13, 4-47, 6-14, 10-8, 

10-29 
Tips 

book 8- 50 
box text 4-54, 5-56 
chapter 1-67, 3-70, 6-60, 6-63 
footnote 8-51 
frame 3-67, 4-54, 6-62 



u-v 

graphic 4-55 
other 7-43, 10-44 
picture 2-57, 3-70, 5-55, 6-62, 9-52 
style 1-66,2-56, 3-69, 6-61 
table 8-51, 10- 43 
text 1-66, 2-55, 6-43, 6-61 9-51 
10-42 ' , 
vertical justification 10-44 

Title Bar 1-8, 1-24 
To Print 2-54, 2- 57, 3-61 
Tracking 3-38, 6-33, 6-37, 6-62 

defini tion of 3- 40 
interactive 6-34 

Trim Marks 
See Crop Marks 

Tum Column Snap Off 3-23 
Turn Footer Orf 2-23 
Turn Header Off 1-35 
Tum Line Snap Off 3-23 
Two-Column Newsletter 3- 13 
Two-Column Proposal 2-8 
Type Sizes 

measuring 2-2 
Typographic Characters 2-5 

bracket codes 2-5, 2-17 
copyright symbol 2-5 
ellipsis 5-11, 5-25 
em dash 2-5, 2-8, 5-11, 5-26 
en dash 7-13 

u 
Underlying Page 

See The Page 
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Update Counters 4-20,4-52, 7-38, 
8-19, 8-32, 9-12 

Update Method 
previous number + 1 8-34 

Update Tag List 3-50, 3-69 
Upper Left X 5-16 
Upper Left Y 5-16 
User Interface 1-8 

addition button 1-9 
assignment list 1-9 
column guides 1-10 
current selection box 1-10 
dialog box 1-10 
menus 1-8 
mode selector 1-8 
mouse button 1-18 
the page 1-10 
page number 1-10 
scroll arrows 1-8, 1-18 
scroll bars 1-8 
scroll box 1-18 
sizing buttons 1-10 
title bar 1-8 

fractions 8-10 
ope,n and closed quotes 2-5, 2-8, 6-27 V 
regIstered sign 5-11, 5-30 

Typographic Effects 3-19 
big first character 6-6, 6-44 
kerning 5-11, 5-46, 6-33 
letter spacing 5-50 
move down to 1st baseline by 6-35 
reverse type 4-13 
tracking 3-38, 3-40, 6-33, 6-37 6-62 
vertical justification 10-13 10~17 
10-19 to 10-23, 10-27 to 10~32, 10~35 

Variable Definition 10-18 
The Ventura Formula x 1-1 1-16 , , , 

1-29, 2-14, 3-16,4-17 
getting you out of trouble xi 
rules for building a document x 

Ventura Prep 1-15 
file managmen t operations ix 
for book 8-4 
for directory 7-7 
for invoice 4-13 
for one-column report 1-15 
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for professional extension 10-16 
for two-column newsletter 3-13 
for two-column proposal 2-10 
for three-column newsletter 6-7 
rules ix, 4-14 

Vertical Alignment 4-43 
Vertical Justification 10-1, 10-13, 

10-17, 10-19 to 10-23, 10-27 to 
10-31, 10-33 
allowed 10-37 
applying 10-35 
carding 10-36 
feathering 10-36 
rules for 10-13 
spacing at bottom of frame 10-37 
spacing at top of frame 10-37 
tips 10-44 

Vertical Justification Around Frame 
10-35 

Vertical Justification At Top of 
Paragraph 10-38 

Vertical Justification Within Frame 
10-35 

Vertical Padding 6-26, 6-62 
Vertical Rules 3-18 
Vertical Spacing 

See Spacing 
Vertical Tabs 

See Side-By-Side Paragraphs 
Vertical Text 7-28 
View Menu 1-30 
Viewing the Page 1-30 

w 
When Not At Column Top 1-43, 1-46 
Which Counter 

chapter 8-19 
initial page 4-21, 8-34 
this page 4-21 

w-z 

Widows and Orphans 3-20, 5-44, 
8-20 

Width Tables 3-63, 3-70, 10-44 
Windows Metafile Format 5-4 
Word Processing 

x 

converting file formats 6-7 
inserting the parafiltr code 2-4,2-55 
inserting typographic characters 
2-5,2-17 
macros 2-6, 7-2 
preformatting text in 2-3 to 2-5, 2-55 
search and replace 2-4, 10-17 

X Offset 5-7 

y 

Y Offset 5-7 

z 
Z_BOXTEXT 4-9 
Z_CAPTION 2-53 
Z_DOUBLE 10-44 
Z_FNOT ENTRY 8-9 
Z_FNOT# 8-9 
Z_FOOTER 2-40, 9-12 
Z_HEADER 2-40, 3-53 
Z_INDEX LTR 8-41 
Z_INDEX MAIN 8-41 
Z_INDEX TITLE 8-41 
Z_LABEL CAP 3-60, 3-70 
Z_SEC19-18 
Z_SEC29-18 
Z_SINGLE 10-44 
Z_TOC LVL 1 8-37 



z-z 

Z_TOC LVL 2 8-37 
Z_TOC LVL 3 8-45 
Z_TOC TITLE 8-43 
Zapf Dingbats 6-46 
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Zero Point 
resetting 1-58, 2-42, 3-23, 4-21, 
4-37, 5-16, 5-18, 5-56 

Zooming in on the Page 1-30, 3-29 





New Riders Library 

Bestselling how-to books, reference guides, learning materials, 
and companion disks for corporate and technical publishing 
from the desktop. Use the postage-free card at the back of the 
book to order today. 

INSIDE XEROX VENTURA PUBLISHER 
A Guide to Professional-Quality Desktop Publishing on 
themMPC 
James Cavuoto and Jesse Berst 
704 pages, 330 illustrations 
ISBN 0-934035-59-B $24.95 
2nd Edition 

The best reference guide to Ventura Publisher is now even better! Inside Xerox 
Ventura Publisher, 2nd Edition, has been completely rewritten for Ventura 
Publisher Version 2 and includes more of what readers have asked for: more 
hands-on examples, more easy-to-use charts, and more time-saving tips and 
tricks. 

PUBLISHING POWER WITH VENTURA 
The Complete Teaching Guide to Xerox Ventura 
Publisher 
Martha Lubow and Jesse Berst 
624 pages, 230 illustrations 
ISBN 0-934035-61-X $27.95 
2nd Edition 

Unlock the inner secrets of Ventura Pu blisher Version 2 with this well-written 
tutorial. You'll learn how to create your own great-looking business documents 
by producing the "real world" documents presented in this book. These 
documents include reports, newsletters, directories, technical manuals, and 
books. Companion software is available. 

DESK'l'OP MANAGER 
ISBN: 0-934035-34-2 $99.95 
Supports Version 1 and 2 

Desktop Manager is the desktop accessory software for IBM and compatible 
personal computers that helps your manage your Ventura Publisher 
documents, running transparently from within the Ventura Publisher 
environment. A multifunction software utility, Desktop Manager provides file 
management, timed backup, document control, style sheet settings, and report 
generation. This essential utility program comes complete with an lBO-page 
guide. 

For fast service, call a New Riders Sales Representative 
now at (818) 991·5392 



INSIDE Xerox Ventura Publisher 

STYLE SHEETS FOR BUSINESS DOCUMENTS 
(Book and Disk Set) . 
Martha Lubow and Jesse Berst 
320 pages, 150 illustrations 
ISBN 0-934035-22-9 $39.95 
Supports Version 1 and 2 

Introducing a cure for the common document-Style Sheets for Business 
Documents. This book and disk set contains more than 30 predesigned 
Ventura Publisher templates for creating top-quality business documents. 
Style sheets are presented for proposals, reports, marketing materials, ads, 
brochures, and correspondence. More than 100 pages of design tips and tricks 
are also included. 

STYLE SHEETS FOR TECHNICAL 
DOCUMENTS 
(Book and Disk Set) 
By Byron Canfield and Chad Canty 
320 Pages 150 illustrations 
ISBN: 0-934035-29-6 $39.95 
Su pports Version 1 and 2 

Get the maximum out of Ventura Publisher with these advanced technical 
document formats. This book/disk combination presents more than 25 
ready-to-use templates for creating technical documents and books. Also 
includes techniques for creating pictures and tables, plus advanced tips for 
modifying formats to fit your needs. 

STYLE SHEETS FOR NEWSLETTERS 
(Book and Disk Set) 
By Martha Lubow and Polly Pattison 
320 Pages over 150 illustrations 
ISBN: 0-934035-31-8 $39.95 
Supports Version 1 and 2 

This book and disk set presents more than 25 pre designed Ventura Publisher 
templates for creating one-, two-, three-, and four-column newsletters. Just 
open the chapter template, load in your own text, and print. A complete 
description of every style sheet and key tag for all chapter templates is also 
included. 

For fast service, call a New Riders Sales Representative 
now at (818) 991-5392 



NEW WRITING 
By Jesse Berst 
320 Pages over 150 illustrations 
ISBN: 0-934035-27-X $9.95 

New Riders Library 

The essential handbook for the modern writer and editor. New Writing shows 
you how to save production time by preformatting documents. Learn to 
manage your files, styles and style sheets. Also presented are the elements of 
style you need to succeed in today's desktop publishing arena. Companion 
software is available. 

New Riders Library also 
includes books on AutoCAD 

INSIDE AUTO CAD 
D. Raker and H. Rice 
750 pages, over 400 illustrations 
ISBN: 0-93403549-0 $29.95 

INSIDE AutoCAD, the best selling book on AutoCAD, is entirely new and 
rewritten for AutoCAD's 3D Release 10. This easy-to-understand book serves 
as both a tutorial and a lasting reference guide. 

INSIDE AUTOLISP 
J. Smith and R. Gesner 
672 pages, over 150 illustrations 
ISBN: 0-934035474 $29.95 

Introducing the most comprehensive book on AutoLISP for AutoCAD Release 
10. Learn AutoLISP commands and functions and write your own custom 
Auto LISP programs. 

INSIDE AUTOSKETCH 
By Frank Lenk 
240 pages, over 120 illustrations 
ISBN: 0-934035-20-2 $17.95 

INSIDEAutoSketch gives you real-life mechanical parts, drawing schematics, 
and architectural drawings. 

For fast service, call a New Riders Sales Representative 
now at (818) 991-5392 



New Riders Library 

CUSTOWUZINGAUTOCAD 
J. Smith and R. Gesner 
480 pages, over 100 illustrations 
ISBN: 0-934035-45-8 $27.95 

Uncover the hidden secrets of Auto CAD's 3D Release 10 in this all new edition. 
Discover the anatomy of an AutoCAD menu and build a custom menu from 
start to rmish. 

AUTOCAD FOR ARCmTECTS AND ENGINEERS 
John Albright and Elizabeth Schaeffer 
480 pages, over 160 illustrations 
ISBN: 0-934035-53-9 $29.95 

Learn by doing a typical AEC project using high-powered design development 
with AutoCAD Release 10. Learn to construct working drawings using 
techniques from real life AEC projects. 

STEPPING INTO AUTOCAD 
By Mark Merickel 
380 pages, over 140 illustrations 
ISBN: 0-934035-51-2 $29.95 

This popular tutorial has been completely rewritten with new exercises for 
Release 10. The book is organized to lead you step by step from the basics to 
practical tips on customizing AutoCAD for technical drafting. 

AUTOCAD QUICK REFERENCE GUIDE 
By Dorothy Kent 
180 pages, over 50 illustrations 
ISBN: 0-934035-57-1 $11.95 

All essential AutoCAD functions and commands are aITanged alphabetically 
and described injust a few paragraphs. 

THE AUTODESK FlLE 
Written and Edited by John Walker 
608 pages 
ISBN 0-934035-63-6 $24.95 

The unvarnished history of Autodesk, Inc. the company behind AutoCAD. 
Read the original memos, letters and reports that trace the rise of Autodesk, 
from start-up to their present position as the number one CAD software 
company in the world. 

For fast service, call a New Riders Sales Representative 
now at (818) 991-5392 



Order from New Riders Publishing Today 

Yes, please send me the productivity-boosting material I have 
checked below. Make check payable to New Riders Publishing. 

Name ______________________________________ _ 

o Check enclosed. 
Company:-------------------------------------o Charge to my credit card: 

o Visa 0 Mastercard 
Address: ____________________________________ __ 

Card # _____________________________ __ City: _________________________ _ 

Expiration: __________________________________ _ State ____________________ ~Zip: 

Signature: ___________________________________ _ 
Phone: ____________________________________ _ 

The easiest way to order is to pick-up the phone and call (818) 
991·5392 between 9:00 AM and 5:00 PM PST. Please have your 
credit card readily available and your order can be placed in a 
snap I 

Quantity Description of Item Unit Cost Total Cost 

~ 

Inside Xerox Ventura Publisher 2nd Edition 

Publishing Power with Ventura 2nd Edition 

Publishing Power Disk 

Style Sheets for Business Documents-Book/Disk Set 

Style Sheets for Newsletters-BooklDisk Set 

Style Sheets for Technical Documents-BooklDisk Set 

Desktop Manager for Xerox Ventura Publisher 

New Writing 

New Writing - Desktop Utility Disk 

COOKIES (Put the fun back in your computer) 

Send to: 

New Riders Publishing 
P.O. Box 4846 

Thousand Oaks, CA 91360 
(818) 991·5392 

Shipping and Handling: see 
information below. 

Sales Tax: California please 
add 6.5% sales tax. 

TOTAL: 

$24.95 

$27.95 

$14.95 

$39.95 

$39.95 

$39.95 

$99.95 

$ 9.95 

$ 7.95 

$ 6.95 

Shipping and Handling: $3.50 for the first book and $1.00 for each additional book. Floppy disk add $1.50 for shipping and 
handling. Add $15.00 per book for overseas shipping and handling. If you have to have it NOW, we can ship product to you in 
24 to 48 hours. For an additional $5.00 RUSH CHARGE for processing plus the actual cost of air freight, you'll be able to receive 
your item over night or in 2 days. 

New Riders Publishing P.O. Box 4846 Thousand Oaks, CA 91360 (818) 991·5392 
F~(818)991·9263 





Order from New Riders Publishing Today! 

Yes, please send me the productivity-boosting 
material I have checked below. Make check 
payable to New Riders Publishing. 

Name: _________________ ___ 

Company: __________________________ __ 

o Check enclosed. Address: __________________________ __ 

o Charge to my credit card: City: ________________________________ _ 

o VISA 0 MasterCard State: ________________ ZIP: ________ __ 
Card # ______________________________ __ Phone: _____________________ __ 

Expiration: _______________ _ The easiest way to order is to pick up the phone and call (818) 
991-5392 between 9:00 AM and 5:00 PM PST. Please have your 
credit card readily available and your order can be placed in a 
snap! 

Signature: ________________ __ 

Quantity Description of Item Unit Cost Total Cost 

Inside Xerox Ventura Publisher, 2nd Edition S29.95 

Publishing Power with Ventura, 2nd Edition 527.95 

Publishing Power Disk 514.95 

Style Sheets for. Business Documents-- Book/Disk Set 539.95 

Style Sheets for Newsletters-Book/Disk Set 839.95 

Style Sheets for Technical Documents-- Book/Disk Set 839.95 

Desktop Manager for Xerox Ventura Publisher 599.95 

New Writing 8 9.95 

New Writing- Desktop Utility Disk 5 7.95 

COOKIES (Put the fun back in your computer) 8 6.95 

~ 
Send to: Shipping and Handling: 

See information below. 

New Riders Publishing Sales Tax: California please 
P.O. Box 4846 add 6.5% sales tax. 

Thousand Oaks, CA 91360 
(818)991-5392 TOTAL 

Shipping and Handling: 53.50 for the first book and 51.00 for each additional book. Floppy disk add 51.50 for shipping and 
handling. Add S 15.00 per book for overseas shipping and handling. If you have to have it NOW, we can ship product to 
you in 24 to 48 hours. For an additional 55.00 RUSH CHARGE for processing plus the actual cost of air freight, you'll be 
able to receive your item overnight or in 2 days. PP2E 

New Riders Publishing P.O. Box 4846 Thousand Oaks, CA 91360 (818) 991-5392 
FAX (818) 991-9263 



To order: Fill in the reverse side, fold,· and mail 

BUSINESS REPLY MAIL 
FIRST CLASS PERMIT NO. 53 THOUSAND OAKS, CA 

POSTAGE WILL BE PAID BY ADDRESSEE 

NEW RIDERS PUBLISHING 

P.O. Box 4846-P 

Thousand Oaks, CA 91360 

NO POSTAGE 
NECESSARY IF 
MAILED IN THE 

UNITED STATES 



ISBN 0-934035-61-X 

90000 

9 780934035613 

PUBLISHING POWER 
WITH VENTURA 

An In.-Depth Guide to Mastering 
Ventura Version 2 

Learn the secrets the professionals use to 
make good looking documents fast. 

• Create and design Reports, Proposals, 
Newsletters, Invoices, Flyers, Directories, 
Books, and more! 

• Make high-powered business documents, 
just follow the sample screens! 

• Overflowing with time saving Tips and 
Tricks on Xerox Ventura Version 2. 

Other books talk about productivity-this 
book delivers it. Only Publishing Power 
provides the right tools for serious Xerox 
Ventura users. 

Optional Disk Available 

$27.95 U.S. ISBN 0-934035-6J-X 


